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CHAPTER

ONE

NEXUS 6.9

NEXUS is Wood’s asset integrity management software suite that improves productivity, removes data duplication and
provides real-time asset information both at site and office.

The NEXUS software suite offers the following features:

• Storage of live asset information during operation

• Anomaly tracking from initial discovery to close out

• Storage of inspection and condition-monitoring data

• Real-time calculations to predict and analyse common integrity issues

• Routines to automate reporting on current integrity status and integrity management strategy

• Dynamic risk assessment from real-time data/inspection results

• Planning for fixed interval and bespoke risk-based inspection (RBI) scheduling

NEXUS can integrate with various computerised maintenance management systems (CMMS) to help you reduce data
duplication and improve productivity.

The NEXUS software suite provides the following solutions:

NEXUS IC
NEXUS Integrity Centre (NEXUS IC) is the core desktop application of NEXUS. It is a software that you
can install on-premise to get access to all the main asset integrity managemement features that NEXUS
offers. For more information, see NEXUS IC Overview.

IC-INSPECTION
An on-line eventing software application optimised for use in the off-shore environment. For more infor-
mation, see IC-Inspection.

IC-INSPECTOR
A tablet application optimised for inspection data collection using an iPad, Android or Windows tablet.
For more information, see IC-Inspector.

IC-RECORDER
NEXUS IC’s digital video recorder software application that works seamlessly with IC-Inspection. For
more information, see IC-Recorder.

IC-WEB
A web-based version of NEXUS IC, which aims to replicate the functionality of NEXUS IC in a web
browser. For more information, see IC-Web.

REST Service
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A service that provides an API consisting of a set of HTTP endpoints (methods) with the ability to create,
retrieve, edit, or delete access to information stored in a NEXUS IC database. For more information, see
REST Service Specifications.

Expert Systems
Database configurations for NEXUS IC that are managed by subject matter experts within Wood and are
maintained to the latest standards/codes and best industry practice. For more information, see Expert
Systems Overview.

For detailed information about how the different components of NEXUS work together and how you use NEXUS in
your asset integrity management process, see NEXUS Components and NEXUS Workflow.

A PDF version of this documentation is available at https://docs.nexusic.com/6.9/nexus.pdf.

ã See also

• NEXUS Components

• NEXUS Workflow

• NEXUS Feature Matrix

• General Information

• NEXUS Support

• Legal Information

• Glossary
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CHAPTER

TWO

NEXUS COMPONENTS

The figure below shows how the different components of NEXUS work together. Click the elements of the graphic to
navigate to the documentation of the specific component.
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CHAPTER

THREE

NEXUS WORKFLOW

The figure below depicts the basic workflow of using NEXUS in your asset integrity management process:
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3.1 Asset Data Management
In NEXUS, you can create hierarchies of assets (asset trees) where nodes represent individual assets and all data in the
database can be linked to them. You can then record asset information in Asset Information Groups (AIGs) and store
sensor data as required. You can maintain asset trees in NEXUS IC and IC-Web. For more information, see Asset Data
Management.

3.2 Planning/Scheduling
During the Planning/Scheduling phase, you plan the actual inspection or maintenance work by setting up tasks to be
carried out (see Tasks). Each task in NEXUS must be assigned to a workpack, which is used to group tasks and events.
NEXUS also provides planning template functionality, which allows you to automatically set up future workpacks
through the use of planning tasks that repeat on either a fixed or dynamic (calculated) frequency.

Results from various assessments (risk assessment, condition assessment, and so on) can be used to drive calculated
task frequencies and dynamically update future workpacks.

You can create tasks, workpacks and planning templates in both NEXUS IC and IC-Web. For more information, see
Planning and Workpacks.

3.3 Inspection/Maintenance
Events are data records from an inspection or maintenance activity for a specific asset. IC-Inspector and IC-Inspection
are designed to facilitate recording of event data in the field. NEXUS IC and IC-Web can be used to review, edit and
enter event data from anywhere.

One or more findings can be raised on each event (manually or automatically) to highlight possible concerns or signif-
icant observations associated with that event. You can create findings in IC-Inspection, NEXUS IC, or IC-Web.

For more information, see Inspection.

3.4 Anomaly Management
Findings are reviewed to determine if they need to be escalated and linked to an anomaly. In NEXUS, you can create
actions from anomalies, assign them to people or set their due dates as required. As a result of an anomaly action, you
can create follow-up tasks in workpacks or ongoing monitoring tasks in planning templates.

You can create anomalies in NEXUS IC and IC-Web. For more information, see Anomaly Management.

ò Note

This is a highly simplified workflow and does not cover all the functionality that NEXUS offers. For
detailed information about all the functions, see the documentation of the individual solutions.
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ã See also

• NEXUS IC

• IC-Web

• IC-Inspection

• IC-Inspector

• IC-Recorder

3.4. Anomaly Management 7
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CHAPTER

FOUR

NEXUS FEATURE MATRIX

The following figures show the features supported by different NEXUS solutions. You can also see which features are
available in Software as a Service (SaaS) and on-premise deployments.

4.1 Generic Features
The following generic user features are supported across the different NEXUS solutions and deployments:

4.2 Configuration/Administration Features
The following configuration or administration features are supported across the different NEXUS solutions and deploy-
ments:
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CHAPTER

FIVE

NEXUS IC OVERVIEW

NEXUS Integrity Centre (NEXUS IC) is the core desktop platform of NEXUS. It allows you to get access to all the
main asset integrity management features that NEXUS offers.

5.1 Prerequisites
Before using NEXUS IC, ensure that you have set up the software as described in the Deployment.

5.2 NEXUS IC Functions
In NEXUS IC, you can use various features and functions. Hover over or click the tiles below for more information.
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5.3 NEXUS IC Screen
For an overview of the NEXUS IC user interface, see NEXUS IC Screen.

5.3.1 NEXUS IC Screen
The NEXUS IC interface consists of several key components designed to support efficient navigation and task execution.

5.3.1.1 Main Menu

The main menu provides access to configuration and system-level functions, including:

• Database Settings: Manage database connections, user settings, and system-level operations. See Database.

• Configuration Options: Adjust application-level settings and preferences. See Configuration.

• Tools Menu: Access utilities that influence or monitor general application behaviour. See Tools.

If you need help, you can use the Help menu to access the documentation or to contact NEXUS Support.

5.3.1.2 Main Screens

The sidebar allows access to various functional screens within NEXUS IC, each supporting specific asset integration
management tasks.

The following main screens are available:
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Screen Description Screen Description
DASH-
BOARDS

Displays the output from any report template that you have con-
figured in the report template library and marked as a Dashboard.
For more information, see Dashboards.

Using the Dashboard

ASSETS Allows you to access the asset tree where you can view and man-
age all the asset information stored in the NEXUS IC database.
For more information, see Asset Data Management.

ASSETS Screen

LIBRARY Allows you to manage library items. Library items are electronic
documents that can be linked to data and data types in NEXUS
IC. For more information, see Library.

Library

PLANNING Shows tasks against their asset, in calendar form. You can
maintain tasks, planning templates, risks or shutdowns from this
screen. For more information, see Planning and Workpacks.

PLANNING Screen

WORK-
PACKS

Allows you to maintain workpacks, which are collections of tasks
or events. For more information, see Workpacks.

WORKPACKS Screen

INSPEC-
TION

You can upload, analyse, chart and review inspection event data
from this screen. For more information, see Inspection.

INSPECTION Screen

ANOMA-
LIES

You can maintain anomalies from this screen. Anomalies are
records that identify discrete items or areas of concern. For more
information, see Anomaly Management.

ANOMALIES Screen

ò Note

Certain screens and tabs on the NEXUS IC interface may be hidden if the user lacks the necessary
permissions for the underlying tables. For more information, see Permission Requirements for User
Interface Elements.

5.3.1.3 Asset Tree

The asset tree appears on the ASSETS, PLANNING, and INSPECTION screens of NEXUS IC and may be visible
in various dialogs. Traffic lights can be enabled in the asset tree to display preconfigured traffic lighting values for the
asset nodes within the tree. For more information, see Asset Tree.

5.3.1.4 Status Bar

The status bar, located at the bottom of the NEXUS IC interface, displays key system and session information including
the connected database server and name, number of users and active jobs, connection latency, memory usage, software
version, and database schema number. For more information, see Using the Status Bar.

5.3. NEXUS IC Screen 15
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CHAPTER

SIX

GETTING STARTED

Before you start using NEXUS IC, check out the following sections to get up and running:

Log In to NEXUS IC
Access the system using your credentials. For more information, see Log In to NEXUS IC.

Familiarise Yourself with the Interface
Explore the layout, grid operations, search tools, and navigation features. For more information, see Familiarise
Yourself with the Interface.

Set Up Default Preferences
Configure default settings, views units, and other settings to match your workflow. For more information, see Set
Up Default Preferences.

6.1 Log In to NEXUS IC
All users must log in to access NEXUS IC. The login process differs depending on the deployment type:

• SaaS Users
Log in and authenticate via the hosted environment using Single Sign-On (SSO). For more information, see SaaS
Login.

• On-Premises Users
Log in using credentials provided by your company’s NEXUS administrator. When you log in for the first time,
you must connect to the database. For more information, see Connect to Database.

6.2 Familiarise Yourself with the Interface
Understanding the layout and core functions of NEXUS IC is essential for efficient use.

Interface Overview
Learn the structure of the main workspace, including the main screens, toolbars, and menus. See NEXUS IC Screen.

Working with Grids
Understand how to use common grid functions, including sorting, filtering, grouping, and customising data grids. See
Using the Grid.
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Searching
Learn how to locate data efficiently using various search tools available in NEXUS IC. See Searching.

6.3 Set Up Default Preferences
Before using NEXUS IC, it’s recommended to tailor the application to match your personal preferences. See the
sections below:

6.3.1 Set Default Unit Group
You can choose the system of measurement used for displaying units in NEXUS IC (for example, metric, US custom-
ary).

To set the default unit group:

1. In the menu, navigate to Database → Your Profile. . . .

2. In the Profile dialog, open the Profile tab.

3. Under Display Options, click the ellipsis (. . . ) button in the Unit Group field.

4. In the Select Unit Group dialog, select the preferred unit group and click OK.

5. Click OK in the Profile dialog to save your changes.

For information about customising unit groups, see Configure Unit Groups.

6.3.2 Select Favourite Reports
You can mark frequently used reports as favourites for quick access during report generation. These will appear under
the Favourites node in the Reports toolbar:

To add favourite reports:

1. In the menu, navigate to Database → Your Profile. . . .

2. In the Profile dialog, open the Favourite Reports tab.
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3. Click the Include button in the toolbar.

4. In the Select Report Templates dialog, choose the required reports and click OK.

5. Click OK in the Profile dialog to save your changes.

ò Note

You can also remove reports from your favourites by clicking the Exclude toolbar button for the
selected report.

For more information about generating reports, see Reports.

6.3.3 Customise Your Grids
Each grid in NEXUS IC can be customised independently to suit your workflow. You can choose which columns to
display or hide, and organise records into collapsible groups for easier navigation and analysis.

For detailed instructions, see Customise and Grouping.

6.3. Set Up Default Preferences 19
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CHAPTER

SEVEN

SETUP AND CONFIGURATION

7.1 Database
You can perform tasks related to the database under the Database menu option as follows:

• Database → Connect

• Database → Reopen

• Database → Backup

• Database → Subscriber

• Database → Expert Systems

• Database → Close

• Database → Your Profile

• Database → Change Password

• Database → Audit Log

• Database → Security

• Database → Properties

• Database → Export Repository

• Database → Show/Hide Status Bar

7.1.1 Connect
7.1.1.1 Connect to Database

Before you start using NEXUS IC, you must connect to a database.

ò Note

This process is not required for hosted clients (SaaS), as the database is automatically connected.

To connect to the database, follow the steps below.

1. In the menu, navigate to Database → Connect.
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ò Note

If you have connected to this database before, use Reopen instead.

2. Specify the name of a database server.

A database server running on the same machine as IntegrityCentre may be called ‘.’ or ‘localhost’, or
may have a name like ‘.\sqlexpress’. Your IT administrator may provide you a database server name.
We recommend that you use the server name to avoid issues with the software license validation.

3. Under Connect using, you usually use the default setting, Current User. This uses your Windows
domain credentials to connect to the SQL Server. Note that NEXUS IC does not look or store a copy
of your Windows domain password.

4. Click Next.
5. Select whether you want to create a new blank database, connect to an existing database, or restore a

Create a Backup. Click Next.

6. Depending on your situation, you can proceed as follows:

• If this database has a user account with your Windows domain credentials (see Manage User
Security and Permissions) you should be immediately connected.
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• If not, you will be asked for a NEXUS user name and password (which may not be the same
as your Windows domain user name and password). This will be the case for offshore subsea
inspection deployments.

7. If this is your first run of NEXUS IC 6, you won’t have yet set a restore path, so you will be asked for
one. This needs to be a folder that you can read/write, and that the SQL Server process can read.

This may be a UNC path (like ‘\\MyServer\MyShare’) or if the database server and NEXUS IC
are running on the same machine it may be a Windows path (like ‘C:\Database Backups’).

When the path is valid (that is, it is visible to both Integrity Centre and the database server) the
text will go black and the red warning message will disappear.

If you enter a path that is valid for Integrity Centre but not the database server, you will see
different red error text:

If you are unable to work around this error by choosing an appropriate folder, you probably
have a deployment problem, relating to SQL Server service accounts and/or permissions.

8. If you have chosen to restore a database from backup, you will be shown details of the backup file.

a. Click Next to begin the restore.

7.1. Database 23
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b. You can track the progress of the restoration in the progress bar.

c. Once NEXUS IC tells you the restore has been completed, click Connect.

7.1.1.1.1 Schema Update

If a schema update is required, NEXUS IC will ask you if you want to proceed. Schema updates are only ever required
when a major update is being applied to a database. For example, opening a v6.8 database with a v6.9 executable will
prompt the user for a schema update.

³ Caution

Schema updates are irreversible, that is, any old backup files (including the one you just restored from)
will continue to exist, but this running copy of the database can never be downgraded, and thus can
never again be opened by old copies of NEXUS IC.

This is not a problem when everybody is using the same version of NEXUS IC and you are confident
there will never be a need to roll back to an older version. The circumstances that require caution are
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those where you might be running a newer version than others, or there is a substantial chance that you
will want to roll back to an older version.

Schema 7.596 is NEXUS IC 5; schema numbers that begin with ‘8’ are NEXUS IC 6. Updates from 7.596 may take
some time. We recommend that you start it in the evening and check the results in the morning as it doesn’t need
watching.

Refer to Version Upgrade Information for major version upgrade information.

Use this menu option to connect to a database. For more information, see Connect to Database. If you have connected
to this database before, instead, use Reopen as described below.

7.1.2 Reopen
Choose a database that you have opened in the past from this list to re-open it. If you have filled in Windows domain
credentials (see Security, below) you should be immediately connected. If not, you will be asked for a NEXUS user
name and password (which may not be the same as your Windows domain user name and password). Clicking the ‘eye’
next to the password field will temporarily reveal the text in the field.

7.1.3 Backup
Use this menu option to create a backup for your database. For more information, see Create a Backup.

7.1.3.1 Create a Backup

You can create a backup of your NEXUS database any time, which allows you to restore your database later based on
the backup file that you created. Your IT department may have a system of scheduled backups, thus, you may not need
to create a backup on a regular basis. However, from time to time when you are about to do something hard to reverse
in a database, such as deleting data, it is recommended that you take a backup first.

7.1.3.1.1 Prerequisites

Before you start, you can set up the default network path for backing up or restoring data under Tools → Options →
General. For more information, see Setting Up Network Path for Backup/Restore.

7.1. Database 25
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7.1.3.1.2 Procedure

To create a backup, proceed as follows:

1. In the menu, navigate to Database → Backup. . . .

2. In the Database Backup Wizard, specify the network path and the name for the backup file.

The dialog offers you a default network path and name, which you can keep or overwrite as required.

ò Note

For hosted clients (SaaS), the network path and backup file name is predefined and cannot be changed.

3. The system checks the validity of the specified path and highlights the text as follows:

• If the path is invalid, the text appears in red colour and a message is displayed:

• If the path is valid, the Wizard takes you directly to the screen that allows you to specify the name and path of
the backup file and the text appears in black colour:
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ò Note

To make the path valid, ensure the following:

• The path must be accessible to both the database server and to Integrity Centre. This
may be a UNC path (like ‘\\MyServer\MyShare’) or if the database server and In-
tegrity Centre are running on the same machine it may be a Windows path (like
‘C:\Database Backups’).

• The database server process must have permission to read and write the folder in
question.

• The user account requires read/write permissions to both the share (for UNC paths)
and the folder.

4. Click Next.
The system creates the backup file in the folder that you specified.

ò Note

During backup, a checksum is embedded in the file using an SQL Server feature. When you
restore the database from a file created in NEXUS (see Connect to Database), a validation is
performed using the SQL Server checksum to ensure that the file is not corrupted.

5. Click Open Folder to open Windows Explorer with your new backup file selected.

� Hint

You can set up the system to offer you the creation of a backup file whenever you start NEXUS. To do
that, under Tools → Options → General, tick the Prompt to Backup Database on Startup checkbox.
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7.1.4 Subscriber
Use this menu option to create, synchronize, or view subscriber databases. For more information, see Manage Sub-
scriber Databases.

7.1.4.1 Manage Subscriber Databases

Database synchronisation is based around the concept of master and subscriber databases:

• A master database is the primary database of an organisation. You can create one or more subscriber databases
from a master database. You can make changes to the master database whilst there are active subscriber databases.

• A subscriber database is created from a master database and can be edited off-site and subsequently synchro-
nised back into the master database. A subscriber database can only be synchronised with a master database (that
is, you cannot synchronise two subscriber databases together).
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7.1.4.1.1 Create a Subscriber Database

You can either create subscriber database as a backup file, or via a direct connection to the off-site MS SQL Server. In
most cases, subscriber databases are created by the backup file (manual) method, the backup file is then restored to the
off-site MS SQL Server.

To create a subscriber database, proceed as follows:

1. Select Database → Subscriber → New.

2. Specify a name for your new subscriber database.

3. Click OK.

ò Result

NEXUS IC creates the subscriber as a database backup file. Once a subscriber database has
been created, it will appear in Database → Subscriber → View.

7.1.4.1.2 Synchronise a Subscriber

All changes made to a subscriber database need to be synchronised back with the master database. To synchronise a
live subscriber database, do the following:

1. Ensure that the active database in NEXUS IC is the master database.

2. Navigate to Database → Subscriber → Synchronise.

ò Result

The Connect to Database wizard appears. This is for the subscriber database.

4. If your subscriber is already present on a database server, then connect to it. If not, restore it under
a different name from your main database. If you have the subscriber as a *.nexus-backup file, you
must specify a temporary location to restore the backup to so that the synchroniser can work with it.

ò Note

During synchronisation, no other users can be connected to the database.

5. Resolve conflicts if required. In the below picture, an asset has been renamed from ‘10” PL’ to ‘10”
PL m1’ in the master, and similarly renamed to ‘10” PL t2’ in the subscriber. The Resolve Conflicts
dialog requires that you tell it which change we want to keep. You can click the Use Master or Use
Subscriber buttons to resolve all conflicts at once, and/or resolve conflicts individually.

ò Result

Once you have chosen a resolution for all conflicts, the Next button becomes available.
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6. Click Next.
7. Once the synchronisation is complete, click Commit. Other users may now connect to the database again.

ò Note

Changes made to the following tables in a subscriber will not be synchronised back to the master:

• Email

• Report Schedule (hosted clients only)

• Map Server

. Attention

Ensure that none of the machines essential to the sync shut themselves down due to power management settings.
This includes the NEXUS IC machine and the SQL Server machine. If you are accessing NEXUS IC via Re-
moteApp, similarly ensure that your client PC will not shut down. If you do lose connection to the RemoteApp
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instance, you (by default) have 15 minutes to re-establish it (from the same or from a different client machine).
Consider the following:

• If your network is subject to interruptions, try running NEXUS IC on the same PC that is running your SQL
Server.

• If your location is subject to power failures, try running NEXUS IC on a laptop.

• If you are running Windows 10, try temporarily pausing Windows updates: Start → Settings → Update &
Security → Windows Update → Advanced options, and set a “Pause until” date.

7.1.5 Expert Systems
7.1.5.1 Manage Expert Systems

The expert systems functionality allows you to export configurations for asset types, asset information groups, event
forms, functions, report templates, shortcuts, risk models, charts, and so on, out of one database and import it into
another.

This process can be accomplished in one of the following two ways:

• Clients can subscribe to one ore more expert systems as required. Expert systems are basically a central library
of “base configuration” databases and the subscription allows for the clients’ own database to be periodically
updated from the base configuration databases. Expert system databases are maintained by a committee of
Wood engineers. When new changes are made to the code, the “base configuration” database is updated and
the changes to the configuration are pushed out to all the subscribers. For more information, see Expert Systems
Overview.

• Configuration elements can be ported between databases using template files without reliance on the subscription
model.

Configuration tables that can be included as part of the template are:

– Asset types and asset type icons

– Asset and sub asset information groups (AIGs and sub-AIGs)

– Event and sub-event definitions

– AIG and event form and grid layouts

– Anomaly triggers

– Workflows

– Global lookup tables and items

– Lookup lists and items

– Unit groups and units

– Functions

– Charts

– Risk models and risk charts

– Report templates
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7.1.5.1.1 Creating and Deploying Expert Systems and Versions

The basic process of creating new expert systems or new expert system versions and deploying them in another database
is the following:

1. You create a new expert system in the source database from which you want to export the configurations. For
more information, see Create Expert Systems and Versions.

2. If the client has subscribed to the expert system and has access to Internet, then in the client management database,
the new expert system has to be assigned to the client and the new version has to be made available. For more
information, see Make Expert System Version Available to Client.

3. In the destination database, you import the expert system as required. For more information, see Deploy Expert
Systems and Versions.

7.1.5.1.2 Worked Examples

See the following worked examples for a step-by-step guide on:

• Creating a new expert system and porting it to another database using an offline template: Example: Create and
Deploy Expert System Using Offline Template

• Creating a new version for an expert system and deploying it in a destination database using online subscription:
Example: Create and Deploy Expert System Version Using Online Subscription

ã See also

• Create Expert Systems and Versions

• Make Expert System Version Available to Client

• Deploy Expert Systems and Versions

• Example: Create and Deploy Expert System Using Offline Template

• Example: Create and Deploy Expert System Version Using Online Subscription

7.1.5.1.2.1 Create Expert Systems and Versions

You create a new expert system or a new expert system version in the source database from which you want to export
the expert system.

7.1.5.1.2.2 Procedure

1. If you create a new expert system, add the new expert system entry.

a. From the menu, navigate to Database → Expert Systems.. and choose Add.

b. Enter a name that identifies the expert system, an owner, and in the Comments field, provide a brief de-
scription about the purpose and content of the expert system configuration.

c. Click OK to save the expert system.

2. Add elements to the expert system as required.

a. Select the new expert system from the Expert Systems dialog and click Edit.
b. Choose which elements you want to include in the expert system in one of the following ways:
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• Choosing asset types on the Asset Type tab. When you select asset types, NEXUS will determine all
the associated AIGs, event definitions, functions, report templates that are linked to that asset type and
will include all those items in your template.

• Choosing specific elements on the Advanced tab. This allows you to pick and choose which items of
this database you want to include in your template. Based on your selection, NEXUS will still ensure
that all associated AIGs, event definitions, functions, report templates linked to the items you have
selected will be included in your template.

c. Click OK to save the expert system.

3. Add a version to the expert system.

a. Select the new expert system from the Expert Systems dialog.

b. In the bottom part of the dialog, under Versions, choose Add.

c. Enter a description for this version in the Comments field. The date and version number is auto-populated.

d. Click OK to save the version.

4. Make the new expert system or expert system version available for the client to import. You can do this in one
of the ways described below:

• Save to Offline Template
You can save the created expert system version into an offline template, which can then be imported man-
ually to the client’s database. To do that, proceed as follows:

a. In the Expert Systems dialog, under Versions, click Save Template.

b. Select the destination folder where you want to save the template and enter the name of the expert
system. Keep the extension as *.expertsystem.

c. Click Save.

ò Result

The expert system data file is created and can be imported into the destination database as described in
* Deploy Expert Systems and Versions.

• Publish
If the client has subscribed to the expert system and has Internet access, you can publish the new expert
system version. This can then be downloaded to the client’s database from the Internet. To do that, in the
Expert Systems dialog, under Versions, click Publish.

ò Result

The new expert system or expert system version is added to the Wood client management database
(NEXUS_Clients), which you can see under the Expert Systems hierarchy when you open the Feature
Related asset view. A signature is automatically generated for a new expert system. Before the customer
can deploy the new expert system version, it must be made available to the client as described in Make
Expert System Version Available to Client.

ã See also

• Make Expert System Version Available to Client
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• Deploy Expert Systems and Versions

• Example: Create and Deploy Expert System Using Offline Template

• Example: Create and Deploy Expert System Version Using Online Subscription

7.1.5.1.2.3 Make Expert System Version Available to Client

If the client has subscribed to an expert system, in the client management database (NEXUS_Clients), the new expert
system version must be made available for clients. In case of a new expert system, it also has to be assigned to the client
first.

7.1.5.1.2.4 Prerequisites

The expert system or expert system version has been created and published in the source database as described in Create
Expert Systems and Versions.

7.1.5.1.2.5 Procedure

1. Open the client management database (NEXUS_Clients).

2. In case it is a new expert system, assign the expert system to the client:

a. Choose the Default View asset view and navigate to the client’s database.

b. Select the client’s database and from the toolbar, choose Assets → Add → Linked Asset (With Chil-
dren)/Linked Asset (Without Children).

c. Choose the Feature Related asset view and from the Expert Systems hierarchy, select the expert system
that you want to assign to the client.

d. Click OK.

e. Make sure that the expert system appears as a sub-node under the client’s database node in the asset hier-
archy.

3. Select the relevant expert system from the asset hierarchy.

4. On the Asset Information tab, under Versions, double-click the new version of the database or select it and
choose Edit.

5. In the dialog that opens, change the value of the Available to Clients field to Yes and click OK.

ò Result

The new expert system is now available for download in the client’s database. It can now be deployed as
described in Deploy Expert Systems and Versions.

ã See also

• Create Expert Systems and Versions

• Deploy Expert Systems and Versions

• Example: Create and Deploy Expert System Using Offline Template

• Example: Create and Deploy Expert System Version Using Online Subscription
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7.1.5.1.2.6 Deploy Expert Systems and Versions

Once new expert systems or expert system versions are available, in the destination database, you can import them as
described below.

7.1.5.1.2.7 Prerequisites

• The expert system or expert system version has been created and published in the source database as described
in Create Expert Systems and Versions.

• In case the client has subscribed to the expert system, the new version must have been made available to the client
as described in Make Expert System Version Available to Client.

7.1.5.1.2.8 Procedure

The process of importing a new expert system or expert system version depends on whether you use an offline template
or you subscribed to the expert system:

7.1.5.1.2.9 Importing Expert System from an Offline Template

1. In the destination database, navigate to Database → Expert Systems.. from the menu.

2. In the Expert Systems dialog, click Import → Template File...

3. Navigate to the expert systems file that you want to import.

4. Click Open.

ò Result

NEXUS retrieves the configuration template and makes the required changes in the destination database. It
applies all the new or changed elements but it does not touch elements that are unchanged or exist in your
database additionally.

5. Close and reopen the database for the changes to take effect.

7.1.5.1.2.10 Downloading Expert System Version Using Online Subscription

1. In the destination database, navigate to Database → Expert Systems.. from the menu.

2. In the Expert Systems dialog, click Import → Download.

3. Select the expert system version that you want to import.

4. In the Summary of Items to Import dialog, you can review all the elements that are included in the
expert system. In the State column, you can filter the results to see all the elements or only elements
that differ from the elements that exist in your database.

5. Click Import.

ò Result

NEXUS retrieves the configuration template via the internet and makes the required changes
in the destination database. It applies all the new or changed elements but it does not touch
elements that are unchanged or exist in your database additionally.

6. Close and reopen the database for the changes to take effect.
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� Tip

You can view the version history of imported expert systems in the Update History section at the bottom of the
Expert Systems dialog (found under Database → Expert Systems..). This section shows the specific versions that
have been applied, when they were applied, and any additional details available about them.

ã See also

• Create Expert Systems and Versions

• Make Expert System Version Available to Client

• Example: Create and Deploy Expert System Using Offline Template

• Example: Create and Deploy Expert System Version Using Online Subscription

7.1.5.1.2.11 Example: Create and Deploy Expert System Using Offline Template

This example shows the end-to-end process of creating a new expert system, exporting it to a template and importing
it in the destination database.

7.1.5.1.2.12 Procedure

1. Open the source database and from the menu, navigate to Database → Expert Systems...

2. Create the new expert system.

a. Choose Add .

b. Enter a name that identifies the expert system, the name of the owner, and in the Comments field, provide

a brief description about the purpose and content of the expert system configuration .

c. Click OK to save the expert system .
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3. Add elements to the expert system as required.

a. Select the new expert system from the Expert Systems dialog .

b. click Edit .

c. Select the elements you want to include in the expert system either on the Asset Type or the Advanced

tabs .

d. Click OK to save the expert system .
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4. Add a version to the expert system.

a. Select the expert system from the Expert Systems dialog .

b. In the bottom part of the dialog, under Versions, choose Add .

c. Enter a description for this version in the Comments field. The date and version number is auto-populated

.

d. Click OK to save the version .
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5. Save the created expert system version into an offline template.

a. In the Expert Systems dialog, under Versions, click Save Template.

b. Select the destination folder where you want to save the template and enter the name of the expert system.
Keep the extension as *.expertsystem.

c. Click Save.
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6. Open the destination database and navigate to Database → Expert Systems.. from the menu.

7. In the Expert Systems dialog, click Import → Template File...

8. Navigate to the expert systems file that you want to import.

9. Click Open.

ò Result

NEXUS retrieves the configuration template and makes the required changes in the destination database. It
applies all the new or changed elements but it does not touch elements that are unchanged or exist in your
database additionally.

10. Close and reopen the database for the changes to take effect.

ã See also

• Create Expert Systems and Versions
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• Make Expert System Version Available to Client

• Deploy Expert Systems and Versions

• Example: Create and Deploy Expert System Version Using Online Subscription

7.1.5.1.2.13 Example: Create and Deploy Expert System Version Using Online Subscription

This example shows the end-to-end process of updating an existing expert system, creating a new version for it, making
it available to clients in the client management system and deploying it in the destination database.

7.1.5.1.2.14 Prerequisites

You have previously created the expert system and in the client management system, it has been assigned to the client
(that is, it appears as a sub-node under the client’s database node in the asset hierarchy).

7.1.5.1.2.15 Procedure

1. Open the source database and from the menu, navigate to Database → Expert Systems...

2. Add changes to the expert system as required.

a. Select the expert system from the Expert Systems dialog .

b. click Edit .

c. Select the elements you want to include in the expert system on the Asset Type or the Advanced

tabs .

d. Click OK to save the expert system .

4. Add a new version to the expert system.

a. Select the expert system from the Expert Systems dialog .

b. In the bottom part of the dialog, under Versions, choose Add .
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c. Enter a description for this version in the Comments field. The date and version number is

auto-populated .

d. Click OK to save the version .

5. Publish the new version of the expert system by clicking Publish in the toolbar under Versions.
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ò Result

The new expert system version is added to the Wood client management database
(NEXUS_Clients).

6. Open the client management database (NEXUS_Clients) and make the version available for clients.

a. Select the relevant expert system from the asset hierarchy .

b. On the Asset Information tab, under Versions, double-click the new version of the

database or select it and choose Edit .

c. In the dialog that opens, change the value of the Available to Clients field to Yes .

d. Click OK .
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ò Result

The new expert system is now available for download in the client’s database.

7. Open the destination database and navigate to Database → Expert Systems.. from the menu.

8. In the Expert Systems dialog, click Import → Download.

9. Select the expert system version that you want to import.

10. In the Summary of Items to Import dialog, you can review all the elements that are included in the
expert system. In the State column, you can filter the results to see all the elements or only elements
that differ from the elements that exist in your database.

11. Click Import.
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ò Result

NEXUS retrieves the configuration template via the internet and makes the required changes
in the destination database. It applies all the new or changed elements but it does not touch
elements that are unchanged or exist in your database additionally.

12. Close and reopen the database for the changes to take effect.

ã See also

• Create Expert Systems and Versions

• Make Expert System Version Available to Client

• Deploy Expert Systems and Versions

• Example: Create and Deploy Expert System Using Offline Template

Use this menu option to create and manage expert systems. For more information, see Manage Expert Systems.

7.1.6 Close
If you want to open a new database, close the currently open one first. Integrity Centre only allows you to have one
database open at a time. If you would like two databases open at once, launch a second copy of Integrity Centre.

7.1.7 Your Profile
Under Database → Your Profile, you can do the following:

• You can view and/or change details about your own NEXUS user account on the Profile tab. If unit groups (that
is, metric versus US weights and measures) are defined in your database, you can select your preferred unit group
here.

• On the Settings tab:

– You can view your user settings for specific functionalities within NEXUS.

– You can revert these settings to the default setting by selecting the relevant items in the list and choosing
the Revert toolbar button.

– You can copy the selected user settings to the settings of another user by choosing Copy to User and
selecting a user from the dialog that appears.

– You can set the selected settings as the default for all users by choosing Set Default.
– You can export the settings to a file or send them in an email by choosing Export.

• On the Favourite Reports tab, you can also select reports to be added to your Favourites, which you can then
access under the Reports toolbar button (see Reports). To add a report to your favourites, choose Include and
select the relevant report from the dialog. You can use the Exclude button to remove the selected reports from
your favourites.

7.1.8 Change Password
To change your own NEXUS password, use this menu option. If you are using Windows credentials, this option is not
useful or necessary, and will be greyed out.
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7.1.9 Properties
This dialog allows you to view or edit a variety of values specific to your database. These include client name, client
logo, paths for videos, a variety of default colours associated with drawings, a variety of settings associated with 3D
drawings or risk models. For more information about the fields, see Properties Dialog.

You can also set up the email host that allows NEXUS IC to send emails (for example, to email a generated report or
the contents of any of the grids). For more information, see Set Up Email.

The License tab contains details of your license key. As part of Software Based Licensing, this is where you will enter
that license information.

7.1.9.1 Set Up Email

To ensure that NEXUS can send emails (for example, email a generated report or the contents of any of
the grids), you must ensure the following:

• The NEXUS database must have an email host configured.

• You must define the email address for the recipient user.

7.1.9.1.1 Set Up Email Host

NEXUS’ SMTP host settings must be configured to enable the email functionality.

For Software as a Service (SaaS) customers, the email host is preconfigured. For customers using NEXUS
on-premises, the email host must be set up as follows:

1. Navigate to Database → Properties from the main menu.

2. Go to the Email tab.

3. Configure the email host credentials, including Host, Sender, Username, Password, Port,
Enable SSL. SMTP settings are specific to your email provider.

ò Note

We recommend that the NEXUS IC email account is set up by your company’s IT
team and all email activities are generated from this generic account. Contact your IT
department for information on the Host, Username, Password, Port and SSL settings.
If you are using a Wood email address, contact Wood IT for more information on this.
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4. If required, you can send a test email using the Send Test Email button.

5. Click OK to save your settings.

7.1.9.1.2 Set Up Recipient’s Email Address

To define the email addresses of users to whom you may want to send emails, proceed as follows:

1. Navigate to Database → Security from the main menu.

2. Select the user to whom you want to send emails to .

3. Click Edit .

4. Enter the email address on the Personnel tab page .

5. Click OK .

The email address appears in the Email column in the Security Settings dialog .
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7.1.10 Audit Log
This dialog shows you a list of user sessions with details about the changes performed during their sessions. For more
information about how to interpret the dialog, see Audit Log Dialog.

7.1.11 Security
You can create users and user groups and set up their permissions as described in Manage User Security and Permis-
sions.

7.1.11.1 Manage User Security and Permissions

Before users can start using NEXUS, an administrator must create new users for them in NEXUS IC and assign the
required permissions to them.

See the following documentation for detailed information about user management and permissions:

• User Management

• Permissions

7.1.11.1.1 User Management

Under Database → Security. . . , you can create new users, user groups, set up Single Sign-On (SSO) or force reset
passwords as described below.
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7.1.11.1.1.1 Create a New User

1. In the menu, navigate to Database → Security. . . .

2. On the Users tab, choose Add.

3. In the Add Personnel dialog, on the Personnel tab, enter the name of the user and any other personal
details (such as address, email, phone number, position) as required.

4. On the Login tab, do the following:

• Specify the login name, which will be used as a username when logging in. For example, if the
name of the user is “Sample User”, the login name can be “sample.user”.

• Tick the Enabled checkbox and create a password for the user using the Change Password
button. If you want the user to change their password upon login, tick the Force Password
Reset checkbox.

• If required, you can also enable Single Sign-On (SSO) on this tab (see Set Up Single Sign-On
(SSO)).

7. On the Member Of tab, select the security group to which you want to assign the new user (if
required).

8. If required, you can define user-specific permissions on the Permissions tab (see Set Up Permissions
for User/User Group).

9. Click OK.

7.1.11.1.1.2 Create a New User Group

1. In the menu, navigate to Database → Security. . . .

2. On the Groups tab, choose Add.

3. In the Add Security Group dialog, on the Security Group tab, enter the name of the user group and if required,
a description.

4. On the Permissions tab, set up the permissions as required (see Set Up Permissions for User/User Group).

5. Click OK.

7.1.11.1.1.3 Set Up Single Sign-On (SSO)

You can configure a user to use Window domain credentials to log in to Integrity Centre. This is smoother as users
will not need to enter a separate password when they start Integrity Centre — instead Integrity Centre will query the
domain controller to check the user’s credentials. To configure this:

1. Edit the user and go to the Login tab.

2. Click the button under ‘Windows User’.

3. In the resulting ‘Select User’ dialog, you may need to click Locations and select Entire Directory.

4. Type the user’s full or partial Windows login name, and click Check Names, choose the appropriate
name from the list and click OK.

ò Note

• This configuration is relevant for on-premises deployment only. For information about setting
up SSO for Software as a Service (SaaS), see Software as a Service (SaaS) Deployment.
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• Windows domain credentials may not work when you are away from the Windows domain.

� Tip

You can always bypass the automatic connection to the database using domain credentials by holding
down the Shift key as Integrity Centre starts up.

7.1.11.1.1.4 Force Reset Password

If you are not using SSO, you can force a user to reset their NEXUS password on their next login. (You would typically
do this when you have just created a user account and have set a temporary password.) On their next login, the user
will be required to enter their old password and then choose a new one before they can proceed.

To enable this feature, under Database→ Security. . . , go to the Login tab and tick the Force Password Reset checkbox.

7.1.11.1.2 Permissions

In general, permissions are applied at the table level, whether it is a dynamic or system table. Special permissions can
be used if necessary. For more information, see Generic Permissions.

ò Note

Some screens or tabs on the NEXUS IC interface are only visible if the user has the necessary permis-
sions for the underlying tables. For more information, see Permission Requirements for User Interface
Elements.

You can also set up permissions at the asset view level. For more information, see Asset View-Specific Permissions.

7.1.11.1.2.1 Generic Permissions

Generic permissions are managed on a table-by-table basis, rather than on a screen-by-screen basis. For example, if
you want a user to be able to add or delete assets, you should edit the user or the user’s group and give them Read /
Write permission on the system table ‘Asset’. If you want to enable this user or group only to view assets but not to
add or delete them, give the user or group Read permission.

You can set up permissions on business objects, which can be either dynamic tables (tables defined by client or expert
system) or core system tables.

In addition to setting up permissions on specific tables, you can set up Special Permissions. For more information, see
Special Permissions.

You set up all these permissions on the Permissions tab of the Edit Personnel dialog (see Set Up Permissions for
User/User Group):
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7.1.11.1.2.2 Inheritance of Permissions

Each user has their own permissions, plus they inherit the permissions of any user group they are a member of. If a
user has their own permissions, these override the permissions they inherit from any user group.

When multiple permission levels apply, they are prioritised as follows:

Priority Permission Level
1 User-specific permission
2 Permissions inherited from user group

7.1.11.1.2.3 Determining Permissions

To figure out the permission for an item, NEXUS proceeds as follows:

1. It retrieves the permissions specific for the user for the relevant business object (dynamic or system table).

2. If no user-specific permissions have been set up, it checks the same permissions of all groups the user is a member
of. If the user is a member of several groups with different permission settings, it determines the permission based
on the permission types (see below).
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3. If there are no resultant permissions set, then NEXUS checks if there is a Special Permission that can be applied.
For example, if an Asset Information form has no explicit permissions (because it is set to Inherited), then
NEXUS will use the Asset Information special permission.

7.1.11.1.2.4 Permission Types

The following types of permissions can be applied:

Permission
Type

Description

Read/Write Allows a user to both view and modify the contents of a table or item. This permission is additive
and overwrites Read and Inherited.

Read Allows a user to view the contents of a table or item but not make any changes. This permission
is additive and overwrites Inherited.

Inherited It means that no specific permissions have been applied for this security item, for this user or user
group. In case of a user, permissions will be inherited from the user group as described above.
In case of a user group, Inherited means that no permissions are set up, that is, the permission
will be Deny All.

Deny Denies Write permissions. This permission is subtractive and overwrites Read/Write and In-
herited.

Deny All Denies Read/Write permissions. This permission is subtractive and overwrites all other permis-
sion types.

For example, if a user is a member of several user groups, and their permission in one user group is Read, in the other
it’s Read/Write, then Read/Write will apply. If, however, the permission is Deny All in any of the user groups, Deny
All will apply.

³ Caution

• To log in to the database, a NEXUS login must have Read permissions (as a minimum) to the
Personnel table, so ensure that Business Object → System Table → Security Permissions is set
to Read for all users.

• Setting Deny All on the Special Permission Security will disable the Database → Security main
menu item, regardless of what permissions have been set on the security permissions tables.

7.1.11.1.2.5 Special Permissions

Special permissions can be used in case there’s no relevant business object (dynamic or system table) for which the
permissions can be applied to, or, if you want to apply permissions to specific types of system tables in general when
there’s no permission set up for specific tables. See below for more information about each special permission:
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Special Per-
mission

Description

Asset Informa-
tion

Applies as the default permission for any AIG or Sub AIG business objects where the AIG or
Sub AIG table permission itself is set to Inherited.

Database
Backup

Permission for creating database backups. There’s no relevant system table business object.

Database Over-
write

Permission for overwriting the database. There’s no relevant system table business object.

Events Applies as the default permission for any Event, Sub Event, Continuous Event and Survey Data
dynamic table business objects where the permission is set to Inherited.
This special permission does not include the core Event system tables (such as Event, Bookmark,
Multimedia). These are covered under the Event node of the System Table business objects only.

Global Tables Applies as the default permission for any Global Table business objects where the permission is
set to Inherited.
This pertains only to the data within the Global Tables. Security permissions for the configu-
ration of Global Tables are managed in the Table Definition node of the System Table business
object.

Jobs Manage-
ment

Permission for using the Job Management Console. There’s no relevant system table business
object.

Licensing Permission for managing licences. There’s no relevant system table business object.
Manage Set-
tings

Permission for configuring the NEXUS database. There’s no relevant system table business
object.

Risk Models Applies as the default permission for any Risk Model business objects where the permission is
set to Inherited. This does not include the Risk Assessment system table.

Security Applies as the default permission if the permission of the Security Permissions system business
object is set to Inherited.

Sensors Applies as the default permission for any Sensor business objects where the permission is set to
Inherited.
This pertains only to the data within the Sensor Tables. Security permissions for the configura-
tion of Sensors are managed in the Table Definition node of the System Table business object.

Upgrade
Schema

Permission for performing schema update. There’s no relevant system table business object.

7.1.11.1.2.6 Set Up Permissions for User/User Group

Once you have a user or user group created in your database, you can assign permissions to them as described below.
By default, most permissions are inherited based on the permission management rules described above.

1. In the menu, navigate to Database → Security. . . .

2. On the Users or Groups tab, select the relevant user or user group and click Edit in the toolbar, or just double-
click the item to open the dialog for editing.

3. In the dialog that appears, go to the Permissions tab.

4. Select either a business object or a special permission for which you want to make permission settings.

5. Right-click the selected item and in the drop-down menu, select the required permission under Permission.

For example, if you want to change the Security permissions for a user group from Deny All to Read / Write,
proceed as follows:
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6. Click OK.

7.1.11.1.2.7 Permission Requirements for User Interface Elements

Certain screens and tabs on the NEXUS IC interface are hidden if the user lacks the necessary permissions for the
underlying tables.

To ensure visibility, the following screens and tabs require at least read access to the specified system tables:
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Screen Tab SYSTEM TABLE
ASSETS Drawings Library
ASSETS Library Library
ASSETS Asset History Asset -> Asset History
ASSETS Anomalies Anomaly
ASSETS Risk Risk Model, Risk Model -> Risk Assessment
ASSETS Planning Templates Planning Template
LIBRARY (main
screen)

n/a Library

PLANNING (main
screen)

n/a Workpack -> Task

PLANNING Tasks Workpack -> Task
PLANNING Risk Risk Model, Risk Model -> Risk Assessment
PLANNING Shutdowns Workpack -> Shutdown
WORKPACKS (main
screen)

n/a Workpack

WORKPACKS Tasks Workpack -> Task
WORKPACKS Risk Risk Model, Risk Model -> Risk Assessment
WORKPACKS Shutdowns Workpack -> Shutdown
ANOMALIES (main
screen)

n/a Anomaly

ANOMALIES Actions Anomaly -> Anomaly Action
ANOMALIES Findings Anomaly -> Finding
ANOMALIES Library Library

7.1.11.1.2.8 Asset View-Specific Permissions

Asset security is a feature that allows even more granular control of access to information than our generic permission
settings do. It allows you to set what asset views in your database you want each user to have access to.

Asset security works on the principle that all users have access to everything by default, and then database admins
remove access as necessary. Restricting access is as simple as creating an asset view that contains the parts of the
hierarchy to be restricted, and then setting appropriate access rules on that asset view. Parts of the hierarchy can appear
in multiple views with multiple security rules and the rules will be applied across all of their views.

7.1.11.1.2.9 Example

Suppose you have the following asset hierarchy:

You want to restrict access to the “Offshore” part of the hierarchy by making it visible to Offshore Engineers but block
access to Onshore Engineers. To do that, make settings as follows:

1. Log in as an administrator.

2. Ensure that you have created user groups for “Offshore Engineers” and “Onshore Engineers”.

3. On the ASSETS screen, create a new Asset View (see Asset Views) and give it a helpful name, such as “Offshore
assets - Offshore Engineers only”.
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4. Display the new Asset View by clicking Asset Views → Offshore assets - Offshore Engineers only.

5. Insert the Offshore part of the hierarchy as a link:

a. Choose Assets → Add → Linked Asset (With Children) from the toolbar.

b. Select the relevant offshore asset and click OK.

6. Set the permissions on this asset view as follows:

a. Choose Asset Views → Edit.

b. On the Permissions tab, click Add.

c. Set appropriate permissions for each user group:

• For Offshore Engineers, set the permissions to “Read/Write” to give them full access.

• For Onshore Engineers, set the permissions to “Deny All” to block these users.

ò Result

The Offshore Engineers will have full access to that part of the tree, and Onshore Engineers will
have no access. This access will be applied across asset views, so that Onshore Engineers will not
be able to circumvent their restrictions by switching to a different asset view. If people who are
blocked from assets try to view them, they will see the following:

ò Note

• In setting up asset level security rules, a user will have the lowest access they have set up.

• If you remove a user group’s access from the “Default View”, it will give them no access to any assets (as
they now have deny access on all assets).

• If a user belongs to multiple user groups, and one of the groups has access in one view but another group
does not have access, then the user will not have access to the assets. The rule is that the most restrictive
permission is applied.

• Giving a user Read-Only access is the same as Deny Write (in this context).

Asset security also applies to Library items. If a library item is connected to an asset that the user has no permission
to read and/or write, then the user will similarly have no permission to view and/or edit that library item.

Note that asset security is likely to have an impact on performance, because NEXUS IC must look up every asset to
check its security before it can be displayed to the user.

7.1.12 Export Repository
Use this menu option to export all library items (including drawings) and event multimedia. (In previous versions, this
option also exported survey data, but survey data in version 6 is no longer stored in the same way and is therefore not
exported from this menu option.)
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7.1.13 Show/Hide Status Bar
Under Database → Show/Hide Status Bar, you can toggle the status bar at the bottom of the main screen of NEXUS
IC on or off. For more information about the status bar, see Using the Status Bar.

7.2 Configuration

7.2.1 General Configuration
7.2.1.1 Configure Boolean Types

Under Configuration → General → Boolean Types, you can set up boolean type values for Yes/No fields.

By default, Yes/No fields in NEXUS have the values Yes or No. However, if you need values different from Yes/No,
you can define different boolean types under Configuration → General → Boolean Types. For example, if you have a
field called “Secure?”, you can assign a boolean type to the field with the values Secure and Not secure.

7.2.1.1.1 Creating Boolean Types

To create a new boolean type, proceed as follows:

1. Choose Add.

2. Enter the name of the new boolean type.

3. Click OK.

4. Select the boolean type that you’ve just created and click Edit.
5. Set up the values of the boolean type on the Values tab. A boolean type can have two or three values: one for the

true state, one for the false state, and an optional third state for “null” (neither checked nor unchecked state). A
field with a boolean type assigned to it will appear as a combo box where the user can select from the predefined
values from a drop-down list.

6. If you want a boolean field to have just two states, tick the Required checkbox for that field.

7.2.1.2 Configure Chart Templates

7.2.1.2.1 Charts and Drawings

You can put a drawing behind a chart template. This is useful when the chart template shows event data — you can
show that event data right on a drawing or photo of the asset itself.

You can also show regions (points, lines, shapes) from events on a chart template, and you can show multimedia
(photos) on a chart template.

Configuring this involves visiting several different areas of NEXUS IC, so it is documented here, rather than in any
specific area.

7.2.1.2.1.1 Configuring an Event Type to include a shape

First, take a database backup.

Then go to Configure Event Types. Ensure that a sub-event is created, and that in the bottom half of the configuration
dialog it has two numeric fields called X and Y.

Still in Configure Event Types, select the event you want to show as a polygon, series of lines, or point on the chart
template. In the bottom half of the configuration dialog, ensure that it has a field of type Table Link. Edit this field. On
its Field Definition page, ensure that its Sub AIG/Event is set to the sub-event you created in the previous step.
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On its Field Layout page, look at its Editor Type. If you would like this to show on the chart template as a series of line
segments (i.e. as an open curve, good for representing cracks, scratches, etc) select Graphical Markup (Line). If you
would like it to show as a point, select Graphical Markup (Point). If you would like it to show as a polygon (i.e. a
closed curve), select Graphical Markup (Region).

7.2.1.2.1.2 Configuring the Chart Template to support Drawings and Event shapes

Go to Configure Chart Templates. Edit the chart template you want to show events on. Ensure that Show Drawings is
checked.

Still on that Chart Template, in the bottom half of the dialog, ensure that the Chart Template has a Series for the Event
Type that you want to display on the chart. Edit the Series. Ensure that its Series Type is set to match the Editor
Type that you picked for the Event’s Table Link field: Points for Graphical Markup (Point); Polygon for Graphical
Markup (Region); Polyline for Graphical Markup (Line). On the Series’ Axis page, ensure that it has an X and a Y
axis. Edit each Axis. For the X Axis, ensure that the Parameters (Inputs) value is set to the X field of the Sub Event.
For the Y Axis, similarly ensure it is set to the Y field of the Sub Event.

7.2.1.2.1.3 Configuring a Drawing to support display behind a Chart Template

Go to Drawings, click Edit Layers, add a rectangle layer, change its type to Coordinates, set an Asset for that layer, set
left/right/top/bottom for that layer.

On the Inspections screen, in the Charts pane, select the Chart Template. Click the Drawings button/menu and pick
the Drawing from the list.

At least one event must have event shape data on it for the Chart Template to show the Drawing — the Chart Template
zooms to Event data, not to the coordinates layer. If that Event’s Shape is completely outside the Coordinates you
selected for the drawing Layer, the Drawing may not be visible.

Once the image is set up correctly in the Chart Template, it will also show in the Event shape editor.

7.2.1.2.1.4 Photos in Events onto Chart Templates

You can have a multimedia (e.g. a photo) on the event’s shape layer. In shape layer editor in Event Details, click
Multimedia then pick photo. You can move and size the photo.

Mouse wheel zoom may not work in the Event shape editor. This is a focus issue related to Windows. Use the magnify+
and magnify- buttons instead.

When you change an Event’s shape, the Chart Template may not automatically refresh in 6.0. Click off the asset and
back on to force a refresh.

7.2.1.2.2 Configure Axes for a Chart Template Series

When you edit a series (see Maintain Series for Chart Templates), you can configure one or more axes for it on the
Axis tab.

ò Note

This tab isn’t visible when you’ve just added a series. Click OK and then Edit to make the tab visible.

Each axis must have a name. If your chart has several series, you may wish to give the X axis the same name in each
series, and give the Y axis the same name in each series.
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7.2.1.2.2.1 Axis Kind

The kind of an axis reflects the way the axis is graphically represented in the chart.

You can use the following axis kinds:

Axis Kind Description
X Axis <explanation>. Time and KP are both common choices for X Axis field.
X2 Axis Useful for things that cover a span of time or a distance of KP. For example, you could

set your X Axis to pull from Event.Start - KP and your X2 Axis to pull from Event.End
- KP. If your chart covers a period of years, the displayed chart will attempt to pick axis
ticks on the first day of the month or first day of the year.

Y Axis <explanation>
Z Axis <explanation>
Z2 Axis <explanation>
Colour
Axis

<explanation>

Split Series
Axis

Allows you to split data on one series into several series by some field you choose, such
as Asset or Workpack. For example, if you have data in several different workpacks,
and you’d like each workpack represented on your chart as a separate series, add a Split
Series axis, and set its Parameters (Inputs) to Event.Workpack. Similarly, if you’d like
to split data from different assets into different series, you would choose Event.Asset for
your input.
Splitting by asset is only useful when you filter to include child assets in your event
listing, and have selected an asset that has children. Otherwise, all the data in the listing
will by definition be from just one asset. The series will each show separately in the
chart legend, and the user can make individual series visible/invisible.

Split Chart
Axis

Works the same way as Split Series Axes, except that instead of your data appearing
as several series on one chart, they will instead appear as a series of charts, one above
another. Any other series on the chart that don’t have a Split Chart axis will appear on
all of the split charts.

For an X/Y chart, you may have two axes, but charts may have more axes, up to one each of the kinds listed below.

Depending on the series type, you can use different axis kinds as follows:
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Series Type Axes
3D Events series Used to represent events along the pipeline, with:

• Z and Z2 axes representing the start and end of each individual event
• a Y axis representing the diameter with which that event should be drawn

(diameter is inflated slightly “for free”, to make the events stand out from
the pipeline)

• a Split Series axis (see below), which is typically used to separate different
event types into separate series

• a Colour axis, to determine the colour to paint each event.

3D Mesh series Used to represent the seabed. The Z axis is used to represent the KP (i.e. the
distance along the pipeline). The X axis is used to represent the distance away
from the pipeline. The Y axis is used to represent the vertical distance, to show
the actual variation in the seabed.

3D Pipeline se-
ries

Used to represent the pipeline itself, and has Z and Z2 axes which represent the
start KP and end KP of the whole pipeline. It also has a Y axis, which represents
the diameter of the whole pipeline.

Anomaly Trig-
ger series

Similar to Horizontal Line series. When you specify a value field for this series,
NEXUS does not pull data directly from that field. Instead, it looks for anomaly
triggers configured on that field, and shows one horizontal line for each trigger. If
there are several different triggers on this field (perhaps with different severities or
codes), you will get several different lines. The vertical position of each horizon-
tal line is determined by the trigger value. If there are different trigger values for
different horizontal positions (for example, a pipeline might have different allow-
able span lengths at different KP ranges), you can add an X axis of type Auto and
NEXUS will behave appropriately.

Bars series X, X2 and Y axes. X and X2 are used to define the left and right edge of each bar.
Bezier Lines
Point and Line
series

Only X and Y axes

Bubble series Only X and Y axes. If there are multiple points at the same location in a bubble
series, the resulting bubble will be drawn larger.

Contour series Can be used to show contour lines for some “height” value, as seen in a topographic
map or an isobaric weather chart. <explain axis settings>

Donut or Pie
Chart series

Use an X Axis to give the name of each pie slice, and a Y Axis to set the size of
each slice. Donut and pie charts don’t really have an X or Y axes, so in this case,
axes represent a different meaning. Optionally, you can also add a Colour axis
to specify the colour of each slice. If your chart represents event counts, Table
Definition.Colour might be a good choice. If you don’t specify a Colour axis,
NEXUS randomly uses a different colour for each slice.

Gantt series X, X2 and Y axes. X and X2 are used to define the beginning and end of each
horizontal Gantt line. If you have a Split Series axis on a Gantt series, ticking
the Gantt series’ Show Stacked checkbox will show each separate split value in
its own vertical space. If you untick Show Stacked, the split series will share
vertical space. For example, if your Split Series splits on Event Type, ticking
Show Stacked will give a row for each event type; unticking it will combine all
event types in one row. However, you can still distinguish event types by colour,
and can make individual series visible/invisible.

Gauge and
Gauge Indicator
series

These series are designed to be used together. A Gauge series is like the top half
of a donut chart, in a half-circle. Gauge series have X and Y axes: X is used to
define the order in which entries should be shown in, and Y sets the size of each
slice. A colour axis is also typically used. The Gauge Indicator series is the needle
showing the value on the scale, and has a Y axis for value, and X axis for label.
Tip: Create a Global Table to define the Gauge series colour, order and values.

Heat Map series Similar to Contour series, but shows the “height” value as a colour axis, instead
of as a series of colour lines. You can combine a Contour series and a Heat Map
series on a single chart, to give two different representations of the same data.
<explain axis settings>

Histogram series Only X and Y axes. X is used to define the centre of each bar.
Horizontal Line
series

Only a Y axis

Polygon and
Polyline series

These series are very similar. Polygon is a “closed curve”, where we connect the
last point back to the first. They are useful where events have defined shapes (for
example, delamination on a concrete wall). See Charts and Drawings for more
details. Polyline is an “open curve”. <explain axis settings>

Vertical Line se-
ries

Only an X axis

60 Chapter 7. Setup and Configuration



NEXUS Documentation, Release 6.9.xxxxx.0

You can add a Split Series axis, Split Chart axis or Colour axis to almost any chart series. For example, a Split Series
axis on a Histogram series will give a stacked bar chart.

Example
You want to use some piece of event data to set the Y value of points on your chart. In this case, you
would add a Series of type Points, and within that, you would add an Axis of kind Y Axis, with an
axis type of Field, then select the database field you want to use for your Y values. You’d also pick
something for your X position: you’d add another Axis to your Series, with kind X Axis, and then
choose whatever type and other details were appropriate.

7.2.1.2.2.2 Axis Type

The type of an axis reflects the source of data to be represented using the given axis.

You can use the axis types below as follows:

Axis Type Usage
Auto <explanation>. Useful in conjunction with a calculation type axis with the Solver func-

tion element.
Average An aggregate axis type. <explanation>
Calcula-
tion

Specify a function (see Configure Functions), and specify inputs for that function. You
could equivalently create that function as a field on your form, and then use the Field type,
but sometimes you only want the function in the chart, and you don’t want it cluttering
up your form.

Count An aggregate axis type. <explanation>
Field The simplest axis type. Specify a field from a table that you want the chart series to pull

data from.
Sum An aggregate axis type. <explanation>

Example
You have wall thickness depletion as a percentage, and you want a chart showing how often each
percentage occurs. Set up an Auto axis, ranging from 0 to 100, and set up the other axis as a Calcu-
lation type. In the function you select for that Calculation axis, include a Solver element. NEXUS
IC will call your solver function many times, for different points along your axis range, and those
values will get plotted on your chart. As your Auto axis’ range increases, the step size increases, but
not proportionately. This means that if you choose a very wide range (for example, 1 to 1000000),
then your Solver function may get called a very large number of times. That may take a long time.

7.2.1.2.2.3 Sensor Clock

When configuring a date/time axis for a chart of sensor data, you cannot pick the Clock value as usual. In general, when
configuring Clock for an Event table, you can just pick Event.Start Clock and/or Event.End Clock. However, Sensor
has no analogous “parent” table, so you can’t do this. You can’t pick Clock directly from the specific sensor table either;
although the sensor table has Clock and Asset fields, they don’t show up in the picker because they’re key fields. (Asset
is a foreign key, except of course in the Asset table, where it’s the primary key. And keys of type date/time are special;
they count as foreign everywhere.)

That is, to configure a date/time axis for a chart of sensor data, proceed as follows:

1. Set up your other axis first (typically the Y axis), which refers to the sensor table data field.

2. Set up your date/time axis (typically an X axis). Instead of entering a value under Parameters (Inputs), go to
Parameters (Values) and enter the special value :Clock (including the colon) in the value - any field.

3. Click OK.
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When you come back to edit this axis, you’ll find Clock (without colon) filled in under Parameters (Inputs), showing
that NEXUS has understood that you want a Clock field, and has found the relevant sensor table to pick it from.

7.2.1.2.3 Configure Pipeline View Chart

The Pipeline View chart is displayed on the INSPECTION screen on the Charts tab and it shows various events on
a pipeline. The Pipeline View chart template is predelivered for NEXUS IC, however, to ensure that the pipeline and
its events are displayed correctly in the Pipeline View chart, you must make a number of settings as described below.

7.2.1.2.3.1 Procedure

1. Ensure that you have an Asset Information Group (AIG) that stores your pipeline data and contains
the following fields:

• Pipeline Start KP

• Pipeline End KP

• Outside Diameter

For more information about setting up an AIG, see Configure Asset Information Groups.

ò Note

To make sure that there is actual pipeline data to be displayed in the chart, you must define values
for these fields when maintaining this AIG.

2. Configure the Pipeline View chart template under Configuration → General → Chart Templates as
follows:

a. The axes of the Pipeline series must refer to the corresponding pipeline data AIG fields:

• The Start KP (Z) axis must refer to the Pipeline Start KP AIG field:
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• The End KP (Z2) axis must refer to the Pipeline End KP AIG field:

• The Pipeline Diameter (Y) axis must refer to the Outside Diameter AIG field:
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b. Similarly, the axes of the Events series must refer to the corresponding event fields and the
pipeline diameter field:

• The KP (Z) axis must refer to the Event Start KP field:

• The KP (Z2) axis must refer to the Event End KP AIG field:
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• The Pipeline Diameter (Y) axis must refer to the Outside Diameter AIG field:

c. If you have imported post-processed profile data into the database, you can also perform field
mapping for the Seabed series as required.

ò Note

Except for mapping fields, do not change other preconfigured values for the axes.

3. To ensure that NEXUS can determine the position of the event on the pipeline, map the Position -
KP usage item to the relevant survey data field in the database under Configuration → Events →
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Features. The survey data field that you map to the Position - KP usage must correspond to the
survey data field that stores the start and end KP values:

ò Note

To make sure that there is actual event data to be displayed in the chart, you must have
defined values for the Start KP and End KP fields in your survey data under Configuration
→ Events → Survey Sets.

4. Once you have completed all the steps, close and reopen the database for the changes to take effect.

ò Note

In IC-Inspection, you may need to make a few more additional steps to get the chart dis-
played correctly. For more information, see Displaying Pipeline Views.

7.2.1.2.3.2 Result

The Pipeline View chart is now displayed correctly on the Charts tab including pipeline and events data:
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Under Configuration → General → Chart Templates, you can add, edit and delete chart templates and assign series to
them.

These templates can then be visible on the Charts tab of the INSPECTION screen and in Configure Report Templates.
Charts can also appear on the Charts tab of the ASSET screen and as part of dashboard reports on the Dashboard tab
of the ASSET screen as well as on the DASHBOARDS screen. Note that charts will only be displayed on the Charts
tab if they are relevant to the selected data set (for example, inspection data charts on the INSPECTION screen, asset
data if you’ve selected a relevant asset, and so on).

On the Configuration - Chart Templates dialog, you can do the following:

• In the top half of the dialog, you can create, edit, or delete chart templates (see Create Chart Templates).

• In the bottom half of the dialog, you can add, edit or delete series within a chart template (see Maintain Series
for Chart Templates).

7.2.1.2.4 Create Chart Templates

To create a new chart template, proceed as follows:

1. Click the Add button at the top of the Configuration - Chart Templates dialog.

2. On the Chart Template tab, give your new chart template a name and define other attributes as required (see
Add/Edit Chart Template Dialog).

3. Assign at least one series to a chart template. For more information, see Maintain Series for Chart Templates.

4. For each series, assign one or more axes. For more information, see Configure Axes for a Chart Template Series.

5. If required, you can also set up a drawing or image as the background of the chart. For more information, see
Charts and Drawings.

To edit an existing chart template, select it and click Edit, or just double-click it.

7.2.1.2.5 Maintain Series for Chart Templates

You can add/edit/delete a chart template’s series in one of the following ways:

• By editing the chart template and clicking on the Series tab

• By using the bottom half of the main Configuration - Chart Templates dialog.

At the bottom right of the screen, you can see a preview. As you add or edit a series, random sample data is displayed
in this preview to show you conceptually what your chart will look like. If you have chosen options that cause the chart
to have a legend, the legend is interactive: you can mouse over a legend item to highlight the corresponding item in the
chart, and you can click legend items to toggle the corresponding chart item off/on.
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When you add or edit a series, you’ll need to give it a name and define other parameters as required (see Add/Edit Series
Dialog).

7.2.1.2.5.1 Configuring Axes

You also need to configure one or more axes for a series as described in Configure Axes for a Chart Template Series.

7.2.1.2.6 Load/Save Chart Templates

Clicking Save Template will save the selected Chart Template and related details to a .chart file. NEXUS IC will find
all items related to this Chart Template (asset information forms, event definitions, chart templates, lookup tables, etc),
and will present a dialog listing all the dependencies it’s found, with a checkbox for each row. Untick any that you don’t
want saved with your Chart Template.

This Chart Template can then be loaded into this or another database via Load Template. Note that if the previously
saved Chart Template still exists in this database, Load Template will overwrite that existing Chart Template — it will
not create a new copy of it. Similarly with any other elements saved in the .chart file: asset information fields, lookup
tables, etc.

7.2.1.2.7 Predelivered Chart Templates

The Pipeline View chart template is predelivered for NEXUS IC. It is a 3D view, and uses the Y Axis to represent the
diameter of the pipeline. If you don’t set a Y Axis value of some kind, you won’t see a pipeline. Since it uses Y for
diameter, it uses Z Axis and Z2 Axis to represent distance along the pipeline. As with X and X2, the two different axis
types are used to represent the start and end of an item on the “chart”. For more information about all the configurations
required to have the Pipeline View chart displayed correctly, see Configure Pipeline View Chart.

ã See also

• Charts and Drawings

• Configure Axes for a Chart Template Series

• Configure Pipeline View Chart

• Add/Edit Chart Template Dialog

7.2.1.3 Configure Company

Company entries can be used to group personnel (to show what company a given person works for) and schedules (to
show what company will be carrying out a particular scope of work). If you have defined company entries, you can
assign them to users, for example, under Database → Security. . . .

7.2.1.4 Configure Functions

7.2.1.4.1 Function Elements

You can access function elements when you create or edit a function under Configuration → General → Functions and
you expand ELEMENTS on the Elements tab.
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7.2.1.4.1.1 Bitwise / Logical Operation

These are similar to Operation elements, but carry out bitwise operations. Bitwise / Logical Operation elements can be
configured for And, Or, Xor (eXclusive Or), or Not. You should set the Result Type of a Bitwise / Logical Operation
to “Whole Number”. They differ from Any True and All True in that Bitwise / Logical Operations work on all bits of a
whole number, rather than just on a yes/no basis. For example, 1010 AND 1001 = 1000; 1010 OR 1001 = 1011; etc.

7.2.1.4.1.2 Case

This is a decision function element. It evaluates a list of conditions and returns one of multiple possible result ex-
pressions. If the Case input does not equal any of the defined conditions, then the Default is returned. The concept is
similar to switch statements in many programming languages, or nested IF functions in Excel.
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In the above example, the Case object is configured so that:

• When Input Variable matches Option 1, Result 1 will be output. (This is indeed the path taken in this case.)

• When Input Variable matches Option 2, Result 2 will be output.

• When Input Variable does not match any of the “When” options, the Default, Result if no Match, will be returned.

7.2.1.4.1.3 Colour

Colour function elements are like a Constant element, but they are always whole numbers. When you edit a Colour, it
presents you with a colour picker. Click the arrow to choose a colour from the list, or click the button to choose
a custom colour.
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7.2.1.4.1.4 Compare Two Inputs

This is a decision function element. It compares two inputs (comparators) and returns one of two values depending
on whether the inputs match. Comparisons available in the Compare decision include: Equals (=), Not equals (<>),
Greater than (>), Less than (<), Greater Than or Equal (>=), Less Than or Equal (<=).

7.2.1.4.1.5 Concatenate

This is similar to the Operation element, but is designed to concatenate several inputs together (converting them to
alphanumeric if necessary) and give an alphanumeric as an output. You should set the result type of a Concatenate
element to “Alphanumeric”.

The Format property can be used to control how values are converted to strings, and how the final concatenated string
appears. (Programmers may find this similar to the concept of printf format strings in C.) If the input is a whole number,
you can put %d in the format string at the point where you’d like that whole number to appear. If the input is a numeric,
you can put %f. You can put other text in the string literally as desired, and to get a % symbol, put %%.

For example, the format string “There are %d apples, which fill %f%% of the basket” would result in the output “There
are 1 apples, which fill 12.34% of the basket”. If your input types don’t match the format string you’ve specified, you’ll
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get an error message. So in this example, we’ve assumed that the first input is a whole number. If it was in fact a
numeric, you’d see an error like “Format is invalid for the inputs.”

You can put a number between the “%” and the letter to specify the width. If the number turns out to be less characters
than the width you’ve specified, it will be padded with spaces. You can put a “.” after that width (or just directly before
the “%”) followed by a precision, to specify the number of decimal places for a numeric. So “%2d” might result in an
output like “ 1” and “%.3f” might result in an output like “12.340”.

You can use types other than “d” for whole numbers and “f” for numerics. Find below the possible types:

Type Output
d Decimal. Input must be a whole number.
u Unsigned decimal. If the input is negative, it will be shown as positive. Input must be a whole

number.
e Scientific. You will get an output like “1.234E1”
f Fixed. You will get an output like “12.34”.
g General. You will get a fixed or scientific output, whichever is shorter.
n Number. You will get a number with thousand separators, like “123,456.78”.
m Money. You will get a currency output, formatted as specified by your settings in the Windows

control panel.
s String. If one of your inputs is a string, you can use “%s” to put it in the format string: “There

are %d %s, which fill %f%% of the %s”. If you specify a precision, like “%.3s”, the string
will be limited to at most that many characters and any remainder will be truncated.

x Hexadecimal. Input must be a whole number.

7.2.1.4.1.6 Constant

Constant function elements are used when a data value is known and will remain the same for every situation where the
function is run. When defining a Constant, you need to supply a name for the constant, the value of the Constant and
the field type. Constants (like Input function elements) can be alphanumeric, numbers, boolean values (true or false),
or date/time values.
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7.2.1.4.1.7 Electronic Corrosion Engineer (ECE)

If you drop an ECE element into a function, it will call Wood’s proprietary ECE library. Specify the ECE Result Type to
determine which value it will return an estimate for. ECE is a separately licensed feature; contact support@nexusic.com
for details.

The following ECE result types are available:

• Bottom of Line Corrosion Rate

• Top of Line Corrosion Rate

• Fe concentration

• pH

• Pitting Corrosion Rate

The input parameters can be linked to Asset Information Fields to allow the calculation to work automatically for all
assessed assets.

The required input parameter units are:

• Start Pressure - bar

• End Pressure - bar

• Start Temperature - °C

• End Temperature - °C

• Liquid Holdup - %

• Inlet Pressure - bar

• Inlet Temperature - °C

• Oil Density - °API (API gravity)

• Section Length - m (metres)

• Inside Diameter - m (metres)

• H2S Concentration - Mole %

• CO2 Concentration - Mole %

• Percentage Carbon - Mole %

• Chloride - g/l (Grams per litre)

• Acetic Acid - ppmw (Parts per million by weight)

• Bicarbonate - ppmw (Parts per million by weight)

• Gas Production Rate – MMSm3/d (million metric standard cubic metres per day)

• Oil Production Rate - m3/d (Cubic metres per day)
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• Water Production Rate - m3/d (Cubic metres per day)

• Fe Concentration - moles/litre

The Section Start Fe Concentration field is optional and can be null. When it is null, supersaturated = true. This
relates to the dissolved iron concentration in the water at the inlet, which may be low in Fe, or may be supersaturated
with iron carbonate. There are two options:

• The default setting is supersaturated, assuming that the water has been flowing through carbon steel equipment
for some distance before entering the flowline: this would be appropriate if the fluids come from a well completed
with carbon steel production tubing, for example.

• When most of the water comes from condensation from water vapour in gas, this setting should be changed to
none, which can lead to increased corrosion rates for a short distance at the inlet region. This would be appropriate
for a gas overhead line from a separator vessel, for example.

7.2.1.4.1.8 Error

In version 6, the function builder includes the concept of errors. You can see errors, for example, when dividing by
zero or by feeding an element an input of a type it did not expect.

However, you can also deliberately include errors. For example, suppose you have a function whose input must not be
0. You can add a comparison that compares that input to 0, and if true, it returns the value of an Error element. If you
set the Error value inside the Error element to “Oh no! An 0!”, then when the function has its input set to 0, the user
will see that error message output.

The advantage of using an Error element is that it can give a textual description to the user explaining what is wrong
without changing the output type of the function — the output of the function might still be of type Numeric. This
means that if this function’s output is in turn consumed by other functions, those functions will get a Numeric value as
they expected. In this way, functions can chain to other functions, while also giving descriptive messages to the user.
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7.2.1.4.1.9 Function

You can embed an entire other function into this function using the Function element. This is the same as dragging in
a system function or a user function from under FUNCTIONS on the Elements tab.

When editing the parameters of the function element, you can select the required function from the Function field. You
can select either a system function or a user function as described below:

• System Functions
System functions are predelivered functions and are listed with the Function Category System. For infor-
mation about the available system functions, see System Functions.

• User Functions
User functions are functions that have been defined by the users. They can be further categorised by type.

7.2.1.4.1.10 Function Parameter

A function parameter is an input to the function. For example, in a function that calculates the circumference of a circle
given a radius value, you can add a Function Parameter element, that provides the ability to enter a value for the radius.
This value is then multiplied by 2 and by the value of pi to calculate the circumference of the circle. When defining
a Function Parameter, you need to give it a name and a data type. Function Parameters may be alphanumeric, whole
numbers, real numbers, boolean values (true or false), dates, times, or combined date/time values.

If you tick “Allow Null Inputs”, you can specify a default value to be used when the input is null.

7.2.1.4.1.11 Is Anomalous

You can use this element to check, within a function, if a particular event field causes any Anomaly Triggers to fire. Its
input should be an event Header_ID.
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7.2.1.4.1.12 Lookup

Returns a summarised value from various sources of data within the NEXUS IC database.

For instance, if you need to fetch an asset information field from an asset, you can select that asset information field as
the Result Field, and connect the asset input to a function parameter that will be fed from the asset.

For information about setting up the fields for a lookup function, see Edit Lookup Dialog.

7.2.1.4.1.13 Lookup Optimisation

Lookups may be executed a large number of times, so we recommend that you configure them so that NEXUS can best
optimise their execution. Consider the following lookup optimisation tips:

• Aggregates and Filters: Aggregates (for example, “Max”) perform better than Filters (for example, “highest”).
Additionally, “=” is more optimisable than “<,” “>”, “<=,” or “>=” in Filters.

• Caching Results: Results may be cached, so subsequent lookups in a particular circumstance may be faster
than the first lookup. When the return value of a function is deterministic, NEXUS IC caches the result for
a given set of inputs. For instance, consider a function that adds two numbers: 1 plus 2 always equals 3. In
this case, NEXUS IC stores this result in its cache. When the same calculation is needed again, the system
retrieves the value directly from the cache, avoiding redundant recalculation. However, when a function involves
a Lookup, caching behaviour changes. NEXUS IC will cache the Lookup result only if it is confident that the
outcome remains deterministic. In other words, if you rerun the function with the same inputs, it will consistently
produce identical outputs. Lookups tied to dynamic data (such as finding the closest event to a specific date) may
not exhibit this determinism. If events are added, deleted, or their dates change, the Lookup result could vary.
To ensure deterministic results and thus enhance performance, consider organising each lookup into separate
functions (see Function). If your main function contains several Lookups and runs slowly, create individual
functions for each Lookup. Then replace the Lookups in your main function with calls to these new simple
functions. By doing so, NEXUS IC can optimise caching separately for each function.

• Avoid Slow Aggregates: In time-critical scenarios, avoid aggregates across tables, aggregates across fields ref-
erencing other tables, and aggregates across slow fields.

• Small Tables: In case of small tables (typically containing a few hundred rows) that are frequently accessed,
NEXUS IC efficiently caches all rows. These cached entries remain available throughout the entire application
run. If any value within the table changes, the cache entries are appropriately expired and then re-cached when
requested by a function. Additionally, NEXUS IC may clear parts of its cache if it runs low on memory.
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7.2.1.4.1.14 Matrix

This is a decision function element. It evaluates a number of inputs and returns the looked-up value. You can add more
inputs with the +Column Input and +Row Input buttons. If you have several column inputs or several row inputs,
they must all be matched for that cell to be picked. That effectively means that this is an n dimensional matrix. The
2-dimensional case (with one column input and one row input) is the simplest and most common, but if you require
more dimensions, add inputs that are needed.

When no cells are matched, the Default Value will be used. You must ensure that the result type of the Default Value
is the same as the result type of the Matrix.

7.2.1.4.1.15 Notes

Notes are used when building functions for reference and documentation purposes. Notes are placed in the Function
Builder workspace. You can use Notes whenever you think a function is not self-explanatory, or when you want to refer
to a standard, document changes to a function, and so on.
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7.2.1.4.1.16 Operation

Operation function elements provide data manipulation functions. Operators take input data from various sources such
as Input, Constant or Decision elements, or even other system or user-defined functions. You can drag in as many inputs
as you like to an Operation. You can use the following operation types:

• Addition, Subtraction, Multiplication, Division, Modulus and Power are all arithmetic operations. Note that
Modulus only works with whole numbers as inputs.

• Minimum, Maximum and Average take the minimum or maximum or average of all their inputs. (If some inputs
to a Minimum, Maximum or Average are null, those null inputs will be ignored.)

• Coalesce works the same as SQL’s COALESCE operator: if the first input is not null, it will return that first input.
If the first input is null, it will look at the second input. It will keep looking along its inputs until it finds one that
is not null. If all are null, it returns null.

• Any True and All True are logical operations. They expect inputs of type Yes/No, and you should set their output
type to Yes/No.

In case you use more than two inputs, the behaviour may not be obvious. We recommend that you experiment with it
and confirm that it works as expected.

7.2.1.4.1.17 Range

This is a decision function element. The Range element is similar to the Case element, except that you specify a range
of input values for each case, rather than a single specific value.

Range evaluates a numeric input against a series of numeric ranges and returns the found value. For each range, you
specify the Lower (>=) and Upper (<=) as numeric values, and then choose a Result from the available inputs.

A Range element needs at least three inputs:

• One to supply the Case value that will be used to decide which range is matched (if any)

• One for the Default Value that will be used if no range is matched

• One to define a result for the first range
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If you want more than one range, add more than three inputs. If you want to reuse one input several times, drag that
input onto the Range element several times. If multiple ranges match the input, the first matched range will be used, so
if your ranges are 1 to 5 and 2 to 6, only inputs of greater than 5 will match the second range.

7.2.1.4.1.18 Risk (Deprecated)

Returns the aggregate risk value for an asset and all its children in a particular asset view. The Risk function element
takes the risk assessment ID (RMC_ID) as the input and returns the risk result as an alphanumeric value. This function
element has been deprecated and will be removed in later versions. We recommend that you use the Lookup element
instead.

7.2.1.4.1.19 Solver

The solver element is used within charts to solve for a particular input parameter of a function. See Chart Template
Axis Type for details.
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ã See also

• System Functions

• Configure Functions

7.2.1.4.2 System Functions

You can access system functions when you create or edit a function under Configuration → General → Functions and
on the Elements tab, you expand FUNCTIONS –> SYSTEM.

System functions are predefined by NEXUS and cannot be edited, however, you can use them as they are or when you
build your own functions. System function elements in the NEXUS IC database can be broken up into character/string
functions, mathematical functions and other functions. See below for more details about some of the main functions:

7.2.1.4.2.1 Character/String Functions

Func-
tion

Description Example of Use

ASCII Returns the ASCII code value of the leftmost character of a
character expression.

ASCII(‘Alphabet’) = 65

Chr Converts an ASCII code to a character. CHR(65) = ‘A’
InStr Returns the starting position of the specified expression in a

character string.
INSTR(‘CORPORATE FLOOR’,’OR’,
3) = 14
INSTR(‘CORPORATE FLOOR’,’OR’,
1) = 2

Len Returns the number of characters of the given string expres-
sion.

LEN(‘Alphabet’) = 8

Length Same as LEN. LENGTH(‘Alphabet’) = 8
Lower Returns a character expression after converting uppercase

character data to lowercase.
LOWER(‘Alphabet’) = ‘alphabet’

LTrim Returns a character expression after removing leading blanks. LTRIM(’ Alphabet’) = ‘Alphabet
Re-
place

Replaces all occurrences of the 2nd given string in the 1st
string with a 3rd string.

REPLACE(‘Alphabet’,’ph’,’f’) = ‘Alfa-
bet’

RTrim Returns a character string after truncating all trailing blanks. RTRIM(‘Alphabet ‘) = ‘Alphabet’
SubStr Returns a part of a character expression. SUBSTRING (‘Alphabet’,0,6) = ‘Alpha’
Upper Returns a character expression with lowercase character data

converted to uppercase.
UPPER(‘Alphabet’) = ‘ALPHABET’
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7.2.1.4.2.2 Mathematical Functions

Func-
tion

Description Example of Use

Abs Returns the absolute, positive value of the given numeric ex-
pression.

ABS(-15) = 15

ACos Returns the angle, in radians, whose cosine is the given value. ACOS(.3) = 1.26610367
ASin Returns the angle, in radians, whose sine is the given value. ASIN(.3) = .304692654
ATan Returns the angle in radians whose tangent is the given value. ATAN(.3) = .291456794
Ceiling Returns the smallest integer greater than, or equal to, the given

numeric expression.
CEILING(15.7) = 16

Cos Returns the trigonometric cosine of the given angle (in radi-
ans).

COS(180 * 3.14159265359/180) = -1

Erf Gaussian Error function. See https://en.wikipedia.org/wiki/
Error_function

ERF(0) = 0

Exp
(10^x)

Returns the exponential value of the given numeric expres-
sion.

EXP(4) = 54.59815

Exp
(e^x)

Returns the exponential value of the given numeric expres-
sion.

EXP(4) = 54.59815

Floor Returns the largest integer less than or equal to the given nu-
meric expression.

FLOOR(15.7) = 15

InvErf Inverse Gaussian Error Function INVERF (0.25) = 0.225312071859631
IsNum-
ber

Returns true if the Alphanumeric input can be converted to a
Whole Number.

ISNUMBER(“three”) = false

IsNu-
meric

Returns true if the Alphanumeric input can be converted to a
Numeric.

ISNUMERIC(“three point one four”) =
false

Ln(x) Returns the natural logarithm of the given numeric expression. LN(95) = 4.55387689
Log(x) Returns the base-10 logarithm of the given numeric expres-

sion.
LOG(100) = 2

Log_b(x) Returns the base-b logarithm of the given numeric expression. LOG_B(2, 256) = 8
Round Returns a numeric expression, rounded to the nearest whole

number.
ROUND(15.193) = 15

RoundTo Returns a numeric expression, rounded to the specified length
or precision.

ROUNDTO(15.193,1) = 15.2
ROUNDTO(15.193,-1) = 20

Sign Returns the positive (+1), zero (0), or negative (-1) sign of the
given expression.

SIGN(- 15) = - 1

Sin Returns the trigonometric sine of the given angle (in radians). SIN(30 * 3.14159265359/180) = .5
SqRt Returns the square of the given expression. SQRT(26) = 5.09901951
Tan Returns the tangent of the input expression. TAN(135 * 3.14159265359/180) = -1
ToNu-
meric

Converts the input to a numeric data type. (Use Concatenate
to go the other way.)

TONUMERIC(‘123’) = 123
TONUMERIC(TODATE(‘22 April
2005’)) = 38462

Trunc Returns n truncated to a whole number. TRUNC(15.79) = 15.7
TruncTo Returns n truncated to m decimal places. m can be negative. TRUNCTO(15.79,1) = 15.7

TRUNCTO(15.79,-1) = 10
Uni-
tExam-
ple

Used under the hood to provide examples in Configuration →
General → Configure Unit Types

n/a
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7.2.1.4.2.3 Compare Functions

There are a variety of Compare functions (“Compare A = B”, “Compare A < B”, “Compare (A = B and C = D) or (E
in (F, G, H) and I = J)”, etc.) They all compare the various inputs in the way described in the function name.

7.2.1.4.2.4 Date/Time Functions

Func-
tion

Description Example of Use

Cur-
rent-
Date

Returns the current system date. CURRENTDATE( ) = <Today’s current
date>

Cur-
rent-
Date-
Time

Returns the current system date and time. CURRENTDATE( ) = <Today’s current
date and time>

DateD-
iff (Day
Of
Month)

Returns the difference between the day-of-month of two dates.
Returns a whole number from -30 to +30.

DATEDIFF (DAY OF MONTH)(2005-
04-22, 2006-06-12) = 10

Date-
Diff
(Days)

Returns the number of days between two dates. DATEDIFF (DAYS)(2005-04-22, 2006-
06-12) = -416

Date-
Diff
(Month
of
Year)

Returns the difference between the month-of-year of two
dates. Returns a whole number from -11 to +11.

DATEDIFF (MONTH OF
YEAR)(2005-04-22, 2006-06-12)
= -2

Date-
Diff
(Months)

Returns the number of months between two dates. DATEDIFF (MONTHS)(2005-04-22,
2006-06-12) = -13.667

Date-
Diff
(Years)

Returns the number of years between two dates. DATEDIFF (YEARS)(2005-04-22,
2006-06-12) = -1.139

Day Returns the Day part of a date. DAY(2005-04-22) = 22
LastIn-
spec-
tion-
Date

Returns the last inspection date for a component. N/A

Month Returns the Month part of a date. MONTH(2005-04-22) = 4
NextIn-
spec-
tion-
Date

Returns the next inspection date for a component. N/A

ToDate Converts the input value to date data type. TODATE(38462) = 2005-04-22
TODATE(‘22 April 2005’) = 2005-04-
22

Year Returns the Year part of a date. YEAR(2005-04-22) = 2005

82 Chapter 7. Setup and Configuration



NEXUS Documentation, Release 6.9.xxxxx.0

7.2.1.4.2.5 Special System Functions

Function Description Example of Use
System -
Anomaly -
Risk Score

Used to set up the anomaly risk matrix. Calculates the
actual risk score of each anomaly. The result of this func-
tion is a number that will be used to position the anomaly
in the corresponding square inside the risk matrix.

See Set Up Anomaly Risk Matrix.

System - Audit
Log Change
Item

Extracts and provides the name of a row from
Sync_Change.

SYSTEM - AUDIT LOG CHANGE
ITEM (3806961) = (2024-Wellsite
A) Coating Assessment on Wood /
Offshore / 24” PL

System - Audit
Log Change
Summary

Extracts and provides a summary of all change fields
from the Sync_Change row.

SYSTEM - AUDIT LOG CHANGE
SUMMARY (3806961) = Event: “”
-> “Coating Assessment #48”, Is
Completed: “No” -> “Yes”

7.2.1.4.2.6 Other Functions

Func-
tion

Description Example of Use

IsNull ISNULL(A, B) returns A if A is not null; or B if A is null.
The syntax for this function is ISNULL(check_expression, re-
placement_value), where check_expression is the expression
to be checked, and replacement_value is the expression to be
returned if check_expression is NULL. check_expression can
be of any type. replacement_value must have the same type
as check_expression.
Note that an alphanumeric field that contains an empty string
is not null — to set the field value back to null, click the “X”
button at the right of the field.

ISNULL(<null>, 10) = 10
ISNULL(30,10) = 30

Linear
Inter-
pola-
tion

Specify Ymin, Ymax, Xmin and Xmax, and for a given Xset,
this function will return Yset.
Note: Xmin, Xmax, and Xset cannot have date data type as
their input. If you need to interpolate between dates, then first
convert the date inputs to a numeric data type.

LINEAR INTERPOLATION(0,0, 2,4,
1) = 2

Length Calculates length from two parameters, i.e. ABS(Param2 -
Param1)

LENGTH(5.418 – 6.254) = 0.836

PassThru Returns parameter value without modifying its display type. PASSTHRU(‘Alphabet’) = ‘Alphabet’
PASSTHRU(123) = 123

Under Configuration → General → Functions, you can create, edit and delete functions.

The Functions dialog enables you to build and edit customised calculations (called functions) that can be used in other
areas of NEXUS IC, such as Asset Information Groups (AIGs) fields, Event fields and Report Sources. You can drag
and drop elements into the Function Editor, then connect the elements together to define the way in which data flows
through your function.

Functions are integral to NEXUS IC. Functions are used within risk models (defining models, matrices and parameters),
they are also used in asset information fields (for example, corrosion rates, retirement dates, pressures, wall thicknesses)
and event definitions (for example, functions to calculate remaining wall thickness or span lengths).
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7.2.1.4.3 Create Functions

To add a new function, proceed as follows:

1. Click the Add button at the top of the Configuration - Functions dialog.

2. Give your new function a name and (optionally) a category.

3. In the bottom half of the dialog, click next to ELEMENTS to expand the list, and drag a function parameter
from the ELEMENTS tree to the design area at the right. All functions are required to have at least one function
parameter. For information about the individual function elements, see Function Elements.

4. Drag other elements as desired. For example, if you want to create a function for converting temperature from
Kelvin to Celsius, you add the following elements:

• A function parameter for capturing the value to be converted in Kelvin

• A constant element for the value 273.15

• An operator element for subtracting the constant value from the value in Kelvin

• A result element for the value in Celsius
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5. Double-click each element to define their parameters. The available parameters depend on the type of the ele-
ment, but in general, you can define a name, a type, unit, default value and so on. In our temperature conversion
example, you can make the following settings:

• Function Parameter
– Name: Kelvin

– Type: Numeric

– Unit: Kelvin

• Constant:
– Name: 273.15

– Type: Numeric

– Value: 273.15

• Operation
– Name: Subtraction

– Operation: Subtraction

– Type: Numeric

• Result
– Name: Result
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– Type: Numeric

– Unit: Celsius

� Tip

You can right-click an element and use the context menu options to view, edit or delete it.

6. Once elements in the design are in place, you can connect two elements by dragging from the output square at
the bottom of one element to a second element. Your drag must begin on the source element’s output square, but
can end anywhere in the target element (not just on its input squares).

ò Note

• You can replace an existing connection by dragging from an output square to the specific input square
whose connection you want to replace.

• You can break an existing connection by dragging it off an input square and dropping it on a blank part
of the design area.
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• You can connect one output to multiple inputs; there is no limit to the number of places you can connect
a single output to.

7. To view “on the fly” values for your function, click the Show Results button.

8. You can also enter Input Values at the bottom of the Tests tab. The function will be evaluated using the input
values you specify. If you give an element an input of a type it is not expecting, instead of a green result you will
see a yellow error message at the bottom of that element, explaining the type mismatch. You will similarly get
yellow error messages for other error cases, such as division by zero. These errors are only visible if the Show
Results button is selected.

9. Click OK to save the function.

7.2.1.4.4 Manage Functions

You can use the standard grid functions in the Configuration → Functions dialog as follows:

• To edit an existing function, double-click the function or select it and click Edit.
• To delete existing functions, select them in the dialog and click the Delete button at the top of the dialog. You

can also right-click the function and select Delete from the context menu.

• To export functions, see Export for full description of the Export menu item.

• To see if a function is being used elsewhere in the application, click Connections.
Functions and function elements in NEXUS IC 6 are unit aware: if you have a function with two inputs leading to
an Addition operation, and one function has units in metres while the other has units in millimetres, NEXUS IC will
correctly deduce that one number needs to be scaled by a factor of 1000 before the two numbers are added. (Which
direction the scaling happens depends on the output unit you select for the Addition element.) For many function
elements, you can select the output unit. (Note that NEXUS IC isn’t dimensionally aware: if you divide a length by a
time, it won’t understand that the result is a velocity.)

7.2.1.4.5 View Statistics

NEXUS IC provides detailed performance statistics for individual function elements, which can be shown as a hint
when you hover over an item with your mouse. These statistics include:

• Number of function calls

• Total, average, maximum, and minimum computation time

• Time to retrieve function parameters

• Total time including parameter retrieval

To display this data, navigate to Configuration → Functions, and if the function has been called and its results cached,
the results will be revealed when hovering over a function element.

When editing a function, statistics are only shown if you enable the Show Statistics option and then hover over an
element.
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7.2.1.4.6 Handling Null Values

Null values can significantly affect calculations and comparisons.

General Behaviour
• Arithmetic Operations: Any calculation involving a null will return null. Example: 2 + null = null

• Comparisons: Any comparison involving a null will return false. Note that this includes comparing null to
null, which also returns the value defined for the False case in a Comparison element. This behavior aligns with
standard practices in the IT industry for handling nulls in data.

Exceptions
In some cases, it’s required to produce a numeric value despite the presence of some nulls. When using operations
such as minimum, maximum, or average, null values are excluded from the calculation. For instance, the average of 1
and null is 1. However, if all inputs are null, the result will also be null.

ò Note

When working with lookups, it’s important to handle null inputs carefully. If a lookup filter is set to null, NEXUS
will attempt to find a row matching that null value. This can be inefficient, especially with large datasets. To avoid
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performance issues, always validate lookup inputs and filters, and skip the lookup if the filters are invalid or null.

7.2.1.4.7 Test Functions

You can test the performance of a function on specific values by entering Input Values at the bottom of the Tests tab
for the function to be evaluated on, before clicking Show Results and hovering over the function element.

You can write test cases for your functions, under the Tests tab. Test cases let you test a function as you create it, and
storing your tests within the function lets you verify that a function still does what it did when you created it, and let
you re-validate a function after changes. When writing tests, we recommend that you write at least one that returns a
valid result, and if it’s possible for your function to return an error (see Error), write at least one test for each possible
error case.

To generate a test report, navigate to Configuration → Functions, highlight all the functions in the function list to
be tested, and select Execute Tests. This calls the functions and the list of the functions and their test results will be
shown in the Function Tests dialog. The grid will show the columns Name, Comments, Test Result, Actual Result, and
Pass/Fail for each function.

7.2.1.4.8 Save/Load Function Templates

Clicking Save Template will save the selected function and related details to a .function file. NEXUS IC will find all
items related to this function (asset information forms, event definitions, chart templates, lookup tables, and so on),
and will present a dialog listing all the dependencies it has found, with a checkbox for each row. Untick any that you
don’t want to be saved with your function.

This function can then be loaded into this or another database via Load Template. Note that if the previously saved
function still exists in this database, Load Template will overwrite that existing function and it will not create a new
copy of it. This is similar for any other elements saved in the .function file: asset information fields, lookup tables, and
so on.

ã See also

• Function Elements

• System Functions

7.2.1.5 Configure Global Tables

Global tables allow you to look up data based on another field or fields. Global tables can be used to store a series of
data (for example, properties of different materials, piping schedule data), which can be then referenced from fields in
Asset Information Group (AIG) forms to get the required input values.

You can configure global tables under Configuration → General → Global Tables. Much of their configuration is
similar to Configure Asset Information Groups or Configure Event Types, but the way they are used is quite different.

7.2.1.5.1 Using Global Tables

Once you have configured global tables, you can use them in the following ways:

• You can link them to an AIG by adding an AIG field with field type Global Table Link and referring to the global
table. In this case, on the AIG form, the fields of the global table will appear as drop-down lists with fixed values
to choose from, where the available fields and field values will depend on your selection of values in the other
fields of the global table. For more information, see Global Table Link Field.

For an example of how to configure a global table for use as a global table link, see Example: Configure Global
Table for Global Table Link.
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• You can configure AIG fields with field type Global Lookup (global lookup fields), from which you can link to
specific fields within the global table and on the AIG form and set up a function to get the field value based on
the values of these other fields. For more information, see Global Lookup Field. Note that global lookup fields
are distinct from lookup list fields. Lookup lists let the user choose from a drop-down list, whereas global lookup
fields are more like a calculation, filling in a value without the user taking any action, and without the user being
able to later modify that value.

For an example of how to configure a global table for use in a global lookup field, see Example: Configure Global
Table for Global Lookup List.

7.2.1.5.2 Create Global Tables

The basic process of creating a new global table is the following:

1. Click Add at the top of the Configuration - Global Tables dialog and choose Lookup Table.

2. Specify the main parameters of the table in the Add Table Definition dialog. For more information, see Add/Edit
Table Definition Dialog.

When setting up the table, you can also use some standard buttons from the top toolbar of the Configuration -
Global Tables dialog (see Using the Grid). In addition, you can:

• Use the Field Order button to move a field up or down in the form or grid. For example, if you want to
place a field between two other fields in the form, select Form . . . from the drop-down list, and in the
Form Field Order dialog, you can move the field with the Move Up or Move Down buttons available in
the toolbar.

• Check the dependency map using the Map button.

3. Add new fields to the table by choosing Add from the middle toolbar of the Configuration - Global Tables
dialog.

4. Specify the main parameters of the fields in the Add Field Definition dialog. For more information, see Add/Edit
Field Definition Dialog.

When setting up the fields, you can also use some standard buttons from the middle toolbar of the Configuration
- Global Tables dialog (see Using the Grid).

5. Enter data for each field of the global table either by manually adding data (Add button) or importing data from
an Excel or text file (Import button) from the bottom part of the Configuration - Global Tables dialog. You
can add a series of data as required.

ã See also

• Example: Configure Global Table for Global Table Link

• Example: Assign Global Table Link to AIG

• Example: Configure Global Table for Global Lookup List

• Example: Set Up Global Lookup Field
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7.2.1.5.2.1 Set Up Workflow Rules

If you want a field’s properties to be controlled by other data, you can set up workflow rules for the field. You can set
up workflow rules for fields in an Asset Information Group (AIG), a global table, or an event form.

To set up a workflow rule for a field, proceed as follows:

1. Start editing the required field in either of the following ways:

• In case of an AIG field, choose Configuration → Assets → Information from the main menu,
select the relevant AIG form in the top of the dialog and double-click the required field from the
bottom of the dialog or select it and choose Edit.

• In case of a global table field, choose Configuration → General → Global Tables from the main
menu, select the relevant global table in the top of the dialog and double-click the required field
from the middle part of the dialog or select it and choose Edit.

• In case of field in an event form, choose Configuration → Events → Event Types from the main
menu, select the relevant event type in the top of the dialog and double-click the required field
from the bottom of the dialog or select it and choose Edit.

2. In the Edit Field Definition dialog (see Add/Edit Field Definition Dialog), go the the Workflow
Rules tab.

3. Choose Add to create a new workflow rule, or, if you want to change an existing workflow rule, select
it and choose Edit.

4. On the Field Trigger tab, enter a name for the workflow rule and in the Trigger Type field, select
the required trigger type from the following options:

Trigger
Type

Description

Clear
Field
Value on
Form

Automatically empties out a field’s value when a specific condition is met,
for example, you can use it to make two fields mutually exclusive, so that
users can fill in one field or the other, but not both.

Set Field
Readonly
on Form

Sets the field to read-only in case a specific condition is met.

Set Field
Required
on Form

Marks a field as required in case a specific condition is met.

Set Field
Visibility
on Form

Use this trigger type if you want a field to be visible only when some other
field is filled in (or vice versa). If the assigned function returns a Yes value,
the field will be visible, when No, the field will be invisible.

Validate
Field
Value

Validates the value the user has entered in the field, for example, if it is re-
quired in a specific format or if it matches another configured set of items.
If the assigned function returns a Yes value, the field value is considered
valid, if it returns No, the value is considered invalid and a yellow exclama-

tion mark ( ) will appear next to the field.

5. On the Function tab, choose a function that returns a Yes/No value.

There are a set of system functions that you can use, which means that you don’t need to create custom
functions:

• Compare - Is Null
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• Compare - Is Not Null

• Compare A = B

• Compare A <> B

6. Click OK to save your changes.

ò Note

Workflow rules are run when forms are viewed interactively, but are not applied during imports. If you
have ticked the Required checkbox on the Field Definition tab of the Edit Field Definition dialog,
this will be enforced during imports, that is, rows that are missing required fields will be rejected. But
if a workflow rule makes a field required, this will not be enforced during imports.

7.2.1.5.2.2 Example: Configure Global Table for Global Table Link

The steps below show an example for setting up a global table that can be used in an Asset Information Group (AIG)
using the Global Table Link field type. Once you have configured the global table, you can then assign it to the AIG as
described in Example: Assign Global Table Link to AIG.

7.2.1.5.2.3 Process

1. From the menu, choose Configuration → General → Global Tables.

2. Add a new global table.

a. To add a new global table, click Add and select Lookup Table from the drop-down menu.

b. In the Add Table Definition dialog, enter the table name and category of the table in the Name

and Category fields .

c. Click OK to save the new global table .
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3. Configure global table fields.

Now that the global table has been created, you can add its fields. These will be points of user input where the
user may choose from a list of predefined values. When creating a global table for use with a global table link,
the first field will be a lookup list that lists the values based on which the remaining fields are filtered. Since the
rest of the fields are dependant on this first lookup list field, they must be of type alphanumeric.

The steps and the screenshot below show the setup of the first field:

a. Click Add from the middle toolbar to add a new field .

b. Enter the field name in the Name field , and select Lookup List from the drop-down list under

the Field Type field .

c. Link the field to a lookup list by clicking the ellipses in to the Lookup List field .

d. In the Select Lookup List dialog, proceed in either of the following ways:

• Create a new lookup list to be used in your global table. If you create a new lookup list,
proceed to step 4.

• Select an existing lookup list if that suits your purposes. In this case, proceed to step 5.

4. Create a lookup list.

To create a new lookup list, proceed as follows:

a. Click Add in the Select Lookup List dialog

b. Enter a name and category for the lookup list as required.
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c. Click OK.

d. Start adding items to the lookup list by selecting it and clicking Edit .

e. On the Items tab, enter the lookup list items. These items will be any values you would
like to be included in the first drop-down list in the global table form, which will then filter the
options in the subsequent drop-down fields.

f. Click OK to save these changes .

g. Add other lookup list items as required.

h. After adding the lookup list items, you can see all the items in the Edit Lookup List dialog as
shown below. Click OK to save these changes and return to the Configuration - Global Tables
dialog.

5. Create the remaining global table fields.
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Now you can create the rest of the global table fields. For each of these remaining fields, use the field type
Alphanumeric.

6. Adjust the form field order.

To order the fields correctly in the form, you can adjust their order as follows:

a. Choose Field Order -> Form from the top toolbar of the Configuration - Global Tables dialog.

b. Use the Move Down and Move Up buttons to change the order of the fields.

c. Click OK to save your changes.

The screenshot below shows the fields after re-ordering. You can see the Form Layout preview on the right of
the screenshot:
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In this example, the Facility field will be presented first, giving the user a list of facility locations to choose from.
The second field to appear in the form will be Main Area, and its options will be based on the user’s selection in
the Facility field. Sub Area and Location will also be filtered based on the previous fields. This results in the
last field in the form, Location, which will provide the most filtered and refined options available for selection.

7. Change the form field layout.

If you want to reformat how the fields are arranged, for example, each on a new line, or two fields per line, and
so on, you can change these settings for each field as follows:

a. Select all the fields (CTRL + Click or SHIFT + Click) .

b. Click Edit .

c. On the Field Layout tab , enter the number of columns you would like each field to take up

.

d. In the Category field, click the ellipses to access the Category dialog and choose how many
columns wide the form will be.
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In this example, we choose Columns = 2 in the Field Layout, and Columns = 2 in the Category layout,
setting each field on its own line:

8. Import the global table data.

Now the global table is ready for data to be imported. The data sheet defines how each global table link field
relates by listing each possible combination of entries into the form. See the example EXCEL data sheet below.
Note that the headers correspond to the names of the global table fields:

To import the sheet, proceed as follows:

a. Click Import under Data from the bottom toolbar.

b. In the import wizard select the file to be imported and go through the steps as required.
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7.2.1.5.2.4 Result

Once your data has been imported successfully, the Configuration - Global Tables dialog should look like the screen-
shot below. Note the order of the fields, the form fields formatted for one field per line, and the global table data visible
under Data:
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You can now link the global table to an AIG form as described in Example: Assign Global Table Link to AIG.

7.2.1.5.2.5 Example: Configure Global Table for Global Lookup List

In this example, we set up a global table that contains a series of data for the possible combinations of outside diameter
and nominal pipeline size (NPS) of a pipeline. We then want to refer to the data of this global table in an asset
information group (AIG) called Pipeline and set up a global lookup field for the Outside Diameter field on this AIG.
This global lookup field will return the value for the Outside Diameter field by:

• Checking the value of the NPS (Inch) field on the same AIG

• Using a Compare function to find a match between the value of the NPS (Inch) field and an outside diameter
value stored in the global table

• Return the first matching outside diameter value to the Outside Diameter field

The process below shows how you can configure a global table that can be used for this example. You can then set up
the global lookup field as described in Example: Set Up Global Lookup Field.

7.2.1.5.2.6 Process

1. From the menu, choose Configuration → General → Global Tables.

2. Add a new global table.

a. To add a new global table, click Add and select Lookup Table from the drop-down menu.
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b. In the Add Table Definition dialog, enter the table name and category of the table in the Name

and Category fields .

c. Click OK to save the new global table .

3. Configure global table fields.

Now that the global table has been created, you can add its fields. These fields will store the data of the possible
outside diameters and the nominal pipeline sizes in mm and inches. In this example, the Pipeline AIG already
contains the NPS (Inch) field, which is associated with the lookup list Nominal Pipeline Size. This lookup list
contains the possible values of nominal pipeline sizes in inches. We first create a global table field that refers to
this lookup list.

a. Click Add from the middle toolbar to add a new field .

b. Enter the field name in the Name field , and select Lookup List from the drop-down list under

the Field Type field .

c. Click the ellipses in the Lookup List field and select the lookup list Nominal Pipeline Size.
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d. Click OK to save the global table field .

4. Create the remaining global table fields.

Now you can create the rest of the global table fields for the nominal pipeline size in mm, and the outside diameter
fields in mm and inches. For each of these remaining fields, use the field type Numeric.
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5. If required, you can adjust the form field order or the form field layout.

For information about how to do that, you can check the relevant steps described in Example: Configure Global
Table for Global Table Link.

6. Add data to the fields of the global table.

Choose Add in the bottom toolbar to enter the possible values of the fields one by one. Alternatively, you can
import data from a file using the Import button.

102 Chapter 7. Setup and Configuration



NEXUS Documentation, Release 6.9.xxxxx.0

7.2.1.5.2.7 Result

You now have a global table with the possible combinations of values for outside diameter and nominal pipeline size
defined. You can set up a global lookup field for the outside diameter as described in Example: Set Up Global Lookup
Field.

7.2.1.6 Configure Lookup Lists

Under Configuration → General → Lookup Lists, you can create, edit and delete lookup lists.

Lookup lists store information used repeatedly throughout the application, ensuring that this data is stored uniformly.
Lookup lists can be referenced from asset information forms (see Configure Asset Information Groups), event forms
(see Event) and global table forms (see Global Table), where a lookup list field will show as a drop-down list, from
which the user can pick an item.

Lookup lists are particularly useful for restricting a subjective assessment to a limited set of predefined values. For
example, a lookup list is an ideal way to ensure consistency in the assessment of a concept like ‘priority’. If you define
lookup list items ‘High’, ‘Medium’ and ‘Low’ (with associated values of three, two and one respectively) in a lookup
list called ‘Priority’, you can restrict users to select values from a predefined priority schema.
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7.2.1.6.1 Create a Lookup List

To add a new lookup list, proceed as follows:

1. Click the Add button at the top of the Configuration - Lookup Lists dialog.

2. Give your new lookup list a name and (optionally) a category.

3. Click OK to save the lookup list.

4. Add items to the lookup list in either of the following ways:

• Edit the new lookup list and define the new items on the Items tab of the Edit Lookup List dialog.
This tab is only visible once you saved the new lookup list.

• Select the lookup list and choose Add in the bottom part of the Configuration - Lookup Lists dialog.

5. Define the parameters for the lookup list items. For more information, see Add/Edit Lookup List Item
Dialog.

6. Click OK to save the lookup list items.

ã See also

Configuration - Lookup Lists Dialog

7.2.1.7 Configure Map Servers

Map servers are used by the Map tab on the INSPECTIONS screen.

If you have your own geographic information system (GIS) system, you can specify its tile server URL under Config-
uration → General → Map Servers to make your own GIS available in NEXUS IC’s maps tab. Your GIS must offer
map tiles in the way NEXUS IC is designed to consume them. For more details, contact NEXUS Support.

7.2.1.7.1 Server List

See below for the current map servers in use by NEXUS:
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Map Server URL Updated
ESRI - World Im-
agery

https://server.arcgisonline.com/arcgis/rest/services/World_
Imagery/MapServer

6th May 2022

ESRI - World Ocean
Base

https://server.arcgisonline.com/arcgis/rest/services/Ocean_
Basemap/MapServer

6th May 2022

ESRI - World Physi-
cal Map

https://server.arcgisonline.com/arcgis/rest/services/World_
Physical_Map/MapServer

6th May 2022

ESRI - World Street
Map

https://server.arcgisonline.com/arcgis/rest/services/World_Street_
Map/MapServer

6th May 2022

ESRI - World Ter-
rain

https://server.arcgisonline.com/arcgis/rest/services/World_
Terrain_Base/MapServer

6th May 2022

ESRI - World Topo-
graphic

https://server.arcgisonline.com/arcgis/rest/services/World_Topo_
Map/MapServer

6th May 2022

Your selection in the Enable field determines whether the map server is available from under the Map Layers button
on the Map tab.

7.2.1.8 Configure Traffic Lights

Traffic lights are displayed as coloured dots next to each asset in the asset tree. You can display traffic lights in the asset
tree by selecting the relevant traffic lighting from under the Traffic Lighting toolbar button (see Traffic Lighting).

You set up the traffic lighting rules under Configuration → General → Traffic Lights.

NEXUS predelivers the Traffic Lights asset information group (AIG), which centralises all the asset information fields
you plan to use for traffic lights and allows you to glance at all the traffic lights for a given asset at once. You can also
set up colour fields for traffic lights here.

7.2.1.8.1 Set up Traffic Lighting Rules

You can set up traffic lighting rules using one of the two methods described below:

7.2.1.8.1.1 Create Traffic Lights Using AIG Colour Fields

On the Traffic Lights AIG, you can define colour fields with functions, which can calculate the traffic light colour to
be applied based on the rules that you defined. In this case, when setting up a traffic lighting rule, you can refer to this
colour field. Follow the procedure below if you use this method:

1. Choose Configuration → General → Traffic Lights from the menu.

2. Choose Add from the top toolbar.

3. Enter data as required in the Add Traffic Light dialog (see Configuration - Traffic Lights Dialog), and in the
Colour Field field, ensure that you select the colour field that you defined in your AIG.

4. Save your entries.

7.2.1.8.1.2 Create Traffic Lights Using Overlay Values

If you do not define a colour field, you can manually define overlay values in the bottom part of the Configuration -
Traffic Lights dialog for the selected traffic light. By defining overlay values, you specify the traffic light colours to
be applied based on the different values of the Value Field of the traffic light. If you’re using overlays, follow the steps
below to set up a new traffic lighting rule:

1. Choose Configuration → General → Traffic Lights from the menu.

7.2. Configuration 105

https://server.arcgisonline.com/arcgis/rest/services/World_Imagery/MapServer
https://server.arcgisonline.com/arcgis/rest/services/World_Imagery/MapServer
https://server.arcgisonline.com/arcgis/rest/services/Ocean_Basemap/MapServer
https://server.arcgisonline.com/arcgis/rest/services/Ocean_Basemap/MapServer
https://server.arcgisonline.com/arcgis/rest/services/World_Physical_Map/MapServer
https://server.arcgisonline.com/arcgis/rest/services/World_Physical_Map/MapServer
https://server.arcgisonline.com/arcgis/rest/services/World_Street_Map/MapServer
https://server.arcgisonline.com/arcgis/rest/services/World_Street_Map/MapServer
https://server.arcgisonline.com/arcgis/rest/services/World_Terrain_Base/MapServer
https://server.arcgisonline.com/arcgis/rest/services/World_Terrain_Base/MapServer
https://server.arcgisonline.com/arcgis/rest/services/World_Topo_Map/MapServer
https://server.arcgisonline.com/arcgis/rest/services/World_Topo_Map/MapServer


NEXUS Documentation, Release 6.9.xxxxx.0

2. Choose Add from the top toolbar.

3. Enter data as required in the Add Traffic Light dialog (see Configuration - Traffic Lights Dialog), and ensure
that you leave the Colour Field field empty.

4. Save your entries.

5. Select the traffic light you’ve just created and choose Add from the bottom toolbar to define the first overlay value
item.

6. Enter data as required in the Add Overlay Value dialog (see Add/Edit Overlay Value Dialog).

7. Save your entries.

8. Follow step 5-7 above to set up other overlay values for different traffic light colours.

7.2.1.8.2 Set up Permissions

You can set up permissions for traffic lights to control which users and groups have access to display which traffic
lights. Setting up permissions is optional, if you set no permissions, all users will by default have access to all traffic
lights by default.

To configure permissions for traffic lights, proceed as follows:

1. Edit a traffic light.

2. Choose the Permissions tab.

3. Click Add.

4. Double-click an empty field under User / Group and pick a user or group.

5. Under Permission, use the drop-down list to select a permission:

• If you select Read Only or Deny Write, the user (or group of users) will be able to use that traffic light, but
cannot edit it.

• If you select Read/Write, the user will be able to use that traffic light, and also edit it.

• If you select Deny All, the user will not be able to select the traffic light for viewing, and won’t be able to
edit it either.

Be sure not to deny access to all users, or you’ll wind up with a traffic light nobody can delete. See Manage User
Security and Permissions for more information on how different permissions interact.

6. Save your entries.

ã See also

Configuration - Traffic Lights Dialog

7.2.1.9 Configure Unit Types

The unit type reflects the type of quantity that is being measured, for example, area, time or mass.

Under Configuration → General → Unit Types, you can create, edit and delete unit types.

Unit types make NEXUS IC unit-aware, and allow you to switch units in a field.

The NEXUS IC database comes pre-populated with a standard set of unit types and units. When a unit is assigned to
an asset information group field, the value can be converted to any other unit that belongs to the same unit type.

Numeric fields that are defined with a unit group appear in the asset information group with a blue label. To convert
the value to a different unit type, click and select the unit type.
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7.2.1.9.1 Maintaining Unit Types

You can maintain unit types in the top part of the Configuration - Unit Type dialog.

To assign and maintain units within a unit type, use the bottom part of the dialog.

For each unit type, you must maintain a reference unit. When you add units to a unit type, you must define the conversion
rate in the Gradient field, which tells the system how to perform conversions between the unit and the reference unit.

7.2.1.10 Configure Unit Groups

Unit groups reflect the system of measurement that you use for measuring units.

Under Configuration → General → Unit Groups, you can create, edit and delete unit groups. Users can then select
their required unit group under Database → Your Profile. . . (see Your Profile).

Unit groups allow you to quickly switch to different systems of measurement, for example, switching between metric
and US weights and measures.

By default, the NEXUS IC database is preconfigured with the following two unit groups:

• Metric

• US Weights and Measures

If required, you can create additional unit groups (for example, cgs and MKS, Potrzebie). When editing these unit
groups, you can change which units belong to this unit group on the Units tab.

7.2.1.10.1 Automatic Conversion Between Unit Groups

When a user views a field and the default unit for that field is not in the currently selected unit group, that field is
instead displayed in the closest unit that is in the currently selected unit group. That is, if a field has an underlying unit
of centimetres, and the user has selected the “US Weights and Measures” unit group, that field will instead be displayed
in inches.

7.2.1.11 Configure Providers

Connections allows you to create point-to-point connections to external databases. Connection types shown in the
following table:

7.2.1.11.1 Definitions

Connection Type Description
Push where changes made in NEXUS are sent to the external field, but not vice versa
Pull where changes made in the external table are pulled into the field in NEXUS.
Push & Pull where changes made in either the external table or in NEXUS are propagated to the other

There are three steps to setting up a point-to-point connection. They are:

1. Set up the Provider
2. Set up the Tables; and

3. Set up the Columns.
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7.2.1.11.2 Setting up the Provider

1. Click on Configuration → General → Providers

2. Click Add from the Configuration - Providers toolbar.

3. In the Add External Provider dialog, enter a descriptive Name for the Provider (eg. MAXIMO)

4. Choose the Provider Type (currently supports Oracle, MSSQL Server and Excel). Based on the Provider Type
selected, you will be presented with further options (eg. if you choose Oracle type, then you will need to enter
the Oracle Easy Connect String; if you choose Excel type, then you will need to enter the full path to the Excel
file; and if you choose MSSQL Server you will be required to enter the Server Address, Database Name and
other Authentication information.)

7.2.1.12 Configure Connections

7.2.1.12.1 Setting up the Tables

Source Name

When you are adding a new Table, click on OK after you have chosen the Provider. When you relaunch the dialog,
the list of available Sources will be available for selection from a dropdown list.

1. Click on Configuration → General → Connections

2. Click Add from the Configuration - Connections toolbar.

3. In the External Table dialog, click on the Ellipsis ( ) button to choose the Provider set up previously, and enter
a Name for the Table (eg. Workpack).

4. Enter the Source Name, this will be the database table name or for Excel the named table (eg. Workorder).

5. The Primary Key is the column or field defined in the External table which will be used to match to field in
NEXUS IC which identifies the row to be updated. The values in the chosen field must be unique (eg. Name).

6. Check or uncheck Allow Insert determines if NEXUS will insert rows into the External Table or the NEXUS
table.

7.2.1.12.2 Setting up the Columns

1. Click on Configuration → General → Connections

2. Click Add from the bottom toolbar in the Configuration - Tables dialog.

3. In the Add External Field Map dialog, click on the Ellipsis ( ) button to choose the Table set up previously.

4. The External Field Name will be the name of the Excel column or the name of the field in the MSSQL Server
table.

5. The Primary Key Field is a column or field defined in the NEXUS IC database which will be used to match to
the Primary Key field in the External table.

6. Choose which direction the data is to be passed from the Sync Direction dropdown list.

7. Finally, click on the Internal Field ellipsis button to choose a field in NEXUS which is mapped to the External
field column.
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7.2.1.13 Configure Attributes

Under Configuration → General → Attributes, you can extend the following system tables with additional fields. The
identifiers in brackets indicate the primary key for each table:

• Anomaly (Anomaly_ID)

• Anomaly Action (Action_ID)

• Library (Library_ID)

• Planning Template (LTIP_ID)

• Task (Task_ID)

• Workpack (Workpack_ID)

When you extend any of these tables, an additional Attributes tab will appear in the corresponding create/edit dialog.
This tab allows users to fill in the fields you have configured.

Additionally, you will be able to:

• Select these fields in Simple Sources when configuring report templates

• Select these fields when configuring chart templates

• Users can populate these fields via an import

ò Note

Calculated fields within an Attributes table can only directly reference other fields from the same table.
If your calculation inputs require data from a different table, you need to implement an intermediate
lookup function. This function should retrieve the required field using available input parameters.

For example, when extending the Anomaly table, you might have a calculated field that requires asset
details not stored directly in that Attributes table. In this case, you would create a sub-function that
uses the Attribute’s primary key (Anomaly_ID) to retrieve the related Component_ID, and then use
that to look up the required data from the appropriate source table.

7.2.1.13.1 Add Custom Fields to System Tables

1. Under Configuration → General → Attributes, select the system table that you want to extend at the top of the
Configuration - Attributes dialog.

2. To add a new field, choose Add from the bottom toolbar of the Configuration - Attributes dialog.

The Add Field Definition dialog appears.

ò Note

When you create the field for the first time, not all tabs are visible in the dialog. Save the field, select it and
click Edit to return to the dialog with all the tabs visible.

3. Specify the main field parameters in the Add/Edit Field Definition dialog.

In this dialog, you can define the main properties of the field, configure its layout, assign functions, set up
workflow rules, and so on. For more information, see Add/Edit Field Definition Dialog.
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ò Note

For Attributes, not all field types are supported.

4. Click OK to save your changes.

7.2.1.13.2 Configure Field Order

You can specify the order of your custom fields as they appear on a grid or a form. This can be done either on the Field
Layout tab of the Add/Edit Field Definition dialog (see Add/Edit Field Definition Dialog), or within the Configura-
tion - Attributes dialog by following these steps:

1. At the top of the Configuration - Attributes dialog, select the relevant system table.

2. From the toolbar, choose Field Order and select whether you want to specify the order within a form or a grid.

3. In the dialog that appears, select a field as required and choose either Move Down or Move Up to adjust its
position within the form or grid.

4. Choose OK to save your changes.

7.2.1.13.3 View Dependency Map

The dependency map is a visual representation of an Asset Information Group (AIG), Event Type’s, or global table’s
dependencies.

You can access the dependency map by choosing Map in the toolbar of the configuration dialogs when configuring
AIGs (see Configure Asset Information Groups), event types (see Configure Event Types) or global tables (see Configure
Global Tables).

The map is represented as a series of interlinked fields grouped in columns, each column representing the AIG/Event
Type/Global Table to which the fields belong.

The map is hierarchically arranged from left to right, with the target AIG/Event Type/Global Table located in the
left-most column, and its dependencies and sub-dependencies located to the right.

You can also toggle the view using the following buttons at the top of the dialog:

• Show Duplicates: If this button is switched on, and a field has a reference to another field in the same AIG/Event
Type/Global Table, the field and the AIG/Event Type/Global Table will be displayed again in a separate column.
If you switch this button off, the fields will be displayed only once and any self-referential dependencies will
be displayed as a closed loop in a single column. For example, if you have a field called Absolute Pressure in
the Piping AIG, which has references to two other fields from the same Piping AIG, the dependency map is
displayed as follows:

– Show Duplicates button ON:
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– Show Duplicates button OFF:
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• Show Local References: If this button is switched on, and a field has a reference to another field within the same
AIG/Event Type/Global Table, this dependency will be displayed on the map. If you switch this button off, these
self-referential dependencies will not be displayed at all. See how the example mentioned above is displayed
when toggling this button on or off:

– Show Local References button ON:
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– Show Local References button OFF:
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7.2.1.14 Configure Shortcuts

Under Configuration → General → Shortcuts, you can create, edit and delete shortcuts.

Shortcuts are a series of steps all grouped together into one menu item. They are similar to Excel macros. Editing a
shortcut is analogous to editing a function.

³ Caution

We suggest that you thoroughly test shortcuts prior to use in a production environment. A shortcut can
have a destructive effect on a NEXUS database if not tested properly.

In the Configuration - Shortcuts dialog, you can see all shortcuts in the database and a visual preview of the compo-
nents making up the selected shortcut. You can use the standard grid functions (see Using the Grid) in the dialog to
edit, delete, import, export shortcuts or check their connections.
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ò Note

To get your new or edited shortcuts to refresh, you will need to close and reopen your database.

7.2.1.14.1 Create Shortcuts

The basic process of creating a new shortcut is the following:

1. Click Add at the top of the Configuration - Shortcuts dialog and enter its name.

2. If required, assign a category to the shortcut. For more information, see Shortcut Categories.

3. Optionally, enter a description. The shortcut description is a text field that stores a summary of what the function
does and how it may be used.

4. Add shortcut elements (see Shortcut Elements) as follows:

a. Under INPUTS, select the required element and choose Add, or select the element and drag it to the grey
section of the shortcut editor screen area (right-hand side).

b. Edit the element or double-click it to define its parameters.
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c. Under ACTIONS, select the required element and choose Add, or select the element and drag it to the
white section of the shortcut editor screen area (left-hand side).

d. In the dialog that opens, define the element’s parameters.

5. Enable the shortcut by selecting Yes in the Enabled field.

6. Click OK.

7. Close and reopen the database.

7.2.1.14.1.1 Worked Examples

See the following worked examples for information about how you can set up shortcuts for specific cases:

• Set up a Shortcut to Send an Email

• Set up a Shortcut to Publish to Documentum

7.2.1.14.2 Save/Load Shortcut Templates

In the Configuration - Shortcuts dialog, you can click Save Template to save the shortcut and related details to a
.shortcut file. NEXUS IC will find all items related to this shortcut (functions, asset information forms, event definitions,
chart templates, lookup tables, etc), and will display a dialog listing all the dependencies it’s found, with a checkbox
for each row. Untick any that you don’t want to be saved with your shortcut.

To load a previously saved .shortcut template, click Load Template. Note that if the previously saved shortcut still
exists in this database, Load Template will overwrite that existing Shortcut and it will not create a new copy of it. This
works similarly for any other elements saved in the template file: asset information fields, functions, and so on.

7.2.1.14.3 Enable/Disable a Shortcut

When you create a shortcut, it will not be available (not visible in the toolbar) until you enable it using the Enabled
field in the Add/Edit Shortcut dialog. Once enabled, the shortcut will be visible under the Shortcuts toolbar button.
Enabling or disabling a shortcut requires closing and reopening the database for changes to take effect.

7.2.1.14.4 Multi-select

You can have multi-selected rows feeding into your shortcut, so the user can select several items in a grid and then
run your shortcut. But user selection dialogs launched within the shortcut are single-select. If the user multi-selects
and runs a shortcut that has a selection dialog, an Apply to All checkbox appears at the bottom left of the selection
dialog. If the user ticks this checkbox, their selection will apply to all remaining runs of the shortcut. If they don’t,
their selection will be used for this run, and the selection dialog will be shown again for the next run.

Within an input, the From option of Retrieve Focused Item is inherently multi-select: your shortcut actually gets run
once for each selected item.

7.2.1.14.5 Shortcut Categories

Shortcuts can be put into categories. If a shortcut’s category matches the name of an existing button menu, then the
shortcut menu item will be placed in that menu.

You can set up shortcut categories under Configuration → General → Shortcut Categories.

For example, if a shortcut is placed in a category called Assets, then on the ASSETS screen, this shortcut will be placed
under the Assets toolbar button. The INSPECTION screen also has an Assets toolbar button, so the shortcut will also
be placed under the Assets menu on that screen.
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If the shortcut was instead placed in a category called Asset Views, then on the ASSETS screen, it would be placed
under the Asset Views toolbar button. The INSPECTION screen has no such toolbar button, so instead, it would be
placed under a toolbar button called Shortcuts.
Shortcuts do show when appropriate on other panes within a screen. For example, shortcuts that act on an asset will
appear on the Children pane on the ASSETS screen. But shortcuts will not appear on Picker dialogs that work on that
type. That is, if you edit a drawing layer and pick an asset for that layer, you won’t see shortcuts.

When shortcuts appear in a list within a context menu (accessible via right-click) or under a toolbar menu option, you
can see them grouped based on the assigned shortcut categories.

7.2.1.14.6 Shortcut Elements

The shortcut editor contains the following two types of elements:

• Actions

Actions appear in the white centre part of the shortcut editor screen area. An action can have inputs and outputs.

• Inputs

Inputs appear in the grey part of the shortcut editor screen area on the right-hand side. Inputs can have an action.

These two items are very similar as some inputs may perform an action and some actions may be able to act as an input,
but they are categorised and displayed in the editor based on what their primary purpose is.

7.2.1.14.6.1 Actions

Name Description
Concatenate String This action builds a string using a set of inputs and the result can then be used as an input

into another element.
Documentum This action uploads library items and documents to Documentum.
Email This action generates an email.
Function This action executes a NEXUS function, the output of the function can be used as an input

into another element.
Insert Row This action is used to create a new row in a business object.
Set Value This action sets the value of a variable.
Update Row This action updates a row in a business object. You can use it to show a dialog to the user,

by setting the action’s style to Allow User to Edit.

7.2.1.14.6.2 Inputs

Constant A constant value, used as an input to an action.
Input Row This forms the basis of where a shortcut exists and is triggered.
Null Used to represent a NULL constant. For example, when using the Update Row action to set

a field to NULL.
Password Used to store an encrypted password. Currently used in the Documentum element.
Variable Holds temporary information within the shortcut, used as an input to an action.

If you select the Input Row option, the value you define in the From field determines when the shortcut is available:

• On Add/On Edit/On Delete

If you choose one of these options, the shortcut runs every time a row is added to/edited/deleted in the selected ob-
ject, that is, database table. In these three cases, the shortcut is only executed when the row is added/edited/deleted
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by our software, be it NEXUS IC, IC-Inspection or the REST service used by IC-Web, IC-Inspector and third
parties.

• Retrieve Focused Item

If you choose this option, the shortcut appears as a menu option on grids for the relevant object. For example,
if the object is the Anomaly table, your shortcut appears as a menu item on the toolbar above the anomaly table
on the ANOMALIES screen, on the ASSETS screen and on any dialog where the user is selecting an anomaly.
With this option, the shortcut works only if there is at least one item in the grid.

• Prompt User to Select Row

If you select this option, a picker dialog is displayed on the appropriate database table when the shortcut runs,
prompting the user to select a row.

• Prompt User to Select One or More Rows

Selecting this option displays a picker dialog on the appropriate database table when the shortcut runs, allowing
the user to select one or multiple rows. The shortcut will then be executed for each selected row.

• On New Row

This option is similar to the Retrieve Focused Item option but also works when there are no items in the grid.
However, since it won’t have any data at the time of creation, it cannot prefill data based on a selected row.

The name you set for your input will be used as a title text on a user selection dialog.

ã See also

• Set up a Shortcut to Send an Email

• Set up a Shortcut to Publish to Documentum

7.2.1.14.6.3 Set up a Shortcut to Send an Email

The following process shows an example for setting up a shortcut that sends an email when data in an Asset Information
Group (AIG) is edited and saved. In this example, we want NEXUS to generate an email each time when any data is
edited on the Pipeline AIG.

7.2.1.14.6.4 Prerequisites

Ensure that you have set up your NEXUS email host settings and recipient email addresses. For more information, see
Set Up Email.

7.2.1.14.6.5 Process

1. From the menu, choose Configuration → General → Shortcuts and click Add in the Configuration - Shortcuts
dialog.

2. Enter the name (mandatory) and category (optional) of the shortcut as required. You can also specify a descrip-
tion.

3. Set up the shortcut trigger. The trigger for sending the email will be data updates in the AIG titled Pipeline. For
this, we need an Input Row element.

a. Under INPUTS, choose the Input Row element and drag it to the grey shortcut editor screen area .

b. Double-click the new Input Row element .
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c. Define the element’s properties as follows :

• Name: Specify a unique name for the triggering element.

• From: Choose On Edit from the drop-down list.

• Object: Click the and select the AIG Pipeline from the list of tables.

d. Click OK .

4. Similarly to the step above, add a Constant input element to define the email recipient. Define its properties as
follows:

• Name: Enter Email Recipient so that the element can be identified later.

• Type: Specify Alphanumeric.

• Value: Enter the email address to which you want to send the emails. If required, you can specify multiple
email addresses separated by a comma or semicolon.
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5. Add another Constant input element to specify the subject line. Define its properties as follows:

• Name: Enter Subject Line so that the element can be identified later.

• Type: Specify Alphanumeric.

• Value: Enter the text that you want to appear in the subject line of the email, in this case, Pipeline data has
changed.

6. Set up the body text of the email by adding a Concatenate String action element. We want the body text to
include the data of the pipeline AIG fields that have been changed.
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a. Under ACTIONS, choose the Concatenate String element and drag it to the white shortcut editor screen

area .

b. Enter the name of the shortcut element so that it can be identified later .

c. Click the + button in the bottom right hand corner of the dialog .

d. Choose New Item .

e. In the New Shortcut Element dialog, define the element’s properties as follows:

• Element Type: Select Field from Row. This indicates that the element will retrieve data from a field in a
table row.

• Row: Select Pipeline Row. This refers to the Input Row element that you created for the shortcut trigger.

• Field: Select Pipeline Name. This refers to the field within the AIG, whose changes you want to track with
this shortcut.

• Return: Select Display Value. This will return the display value of a field, not the functional value. The
functional value is usually a unique identifier in the database table, which is not visible to the end users.
The display value is the user-friendly name of the field selected above.

• Name: This field is automatically filled by the system based on your selections above.
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f. Click OK.

7. Set up the final action of sending the email by adding a new Email action element. Use the other shortcut
elements defined above as input parameters:

• Name: Enter Send Email so that the element can be identified later.

• Recipient: Select Email Recipient, which refers to the constant input element that you defined for the
recipient.

• Subject: Select Subject Line, which refers to the constant input element that you defined for the subject
line.

• Body: Select Email Body, which refers to the Concatenate String action element that you defined in the
previous step.
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8. The shortcut is set up with all the parameters required. Enable the shortcut by selecting Yes in the Enabled field.

9. Click OK.
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10. Close and reopen the database for your new shortcut to take effect.

11. To test this functionality, change some data in the Pipeline AIG and save your changes.

ã See also

Configure Shortcuts

7.2.1.14.6.6 Set up a Shortcut to Publish to Documentum

The Documentum tool can be used to upload library items and documents to Documentum. Documentum is a secure
hosting service that can be used for document management, collaboration, search and classification of documents. This
example shows how you can use the tool in NEXUS by configuring a shortcut to prepare the document and relevant
metadata for upload. Once the shortcut has been created, a new toolbar button will be available on the LIBRARY
screen that allows you to publish the selected library item to Documentum.

ò Note

• You must completely close and reopen NEXUS when you make any change to a shortcut. Short-
cuts do not refresh.

• We recommend that you regularly save the shortcut (click OK) and reopen the editing window
as you progress through the setup process. This saves any progress you have made and ensures
that changes are not lost.

7.2.1.14.6.7 Prerequisites

Before you set up the shortcut, you must have the following functions available:

• A function that returns the Asset ID of the asset to which a specific library item belongs:
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• A function that returns the current date.

7.2.1.14.6.8 Process

1. From the menu, choose Configuration → General → Shortcuts and click Add in the Configuration - Shortcuts
dialog.

2. Enter the name (mandatory) and category (optional) of the shortcut as required. You can also specify a descrip-
tion. In this example:

• Name: Publish to Documentum

• Category: Documentum

• Description: Upload a Nexus library item to predefined Documentum service.

3. Set up the shortcut trigger, which will be the library item that you want to be uploaded to Documentum. For this,
you need to add an Input Row input element.

a. Under INPUTS, choose the Input Row element and drag it to the grey shortcut editor screen area .

b. Double-click the new Input Row element .

c. Define the element’s properties as follows :

• Name: Specify a unique name for the triggering element, for example, Library Item.

• From: Choose Retrieve Focused Item from the drop-down list.
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• Object: Click the and select the Library system table.

Optionally, you can add Filters for the client-specific Documentum workflow.

d. Click OK .

4. Similarly to the step above, add Constant input elements with the following properties:

Name Type Value
Field Name Alphanumeric Asset Field
Published By Alphanumeric NEXUS IC
Approved Alphanumeric Approved
Department Alphanumeric Integrity
Yes Yes / No Yes
Folder Path Alphanumeric {example repository folder}
UserName Alphanumeric pims
Documentum REST URL Alphanumeric {http://example_URL}
Respository Alphanumeric EDMS_PROD
Cabinet Alphanumeric Knowledge Repository
Object type Alphanumeric ad_tcio_document

5. Similarly to the steps above, add a Password input element. This will store the password to your Documentum
service.
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6. Add a Function action element to return the Asset ID. This will take in the functional value of the library item
in the Input Row, that is, the document being uploaded to Documentum. Based on this functional value, this
function outputs the asset ID of the asset to which the library item belongs.

a. Under ACTIONS, choose the Function element and drag it to the white shortcut editor screen area .

b. Define the element’s properties as follows :

• Name: Enter a name to identify the function, for example, Return Asset ID from Library Connection.

• Function: Select the predefined function that returns the asset ID (see Prerequisites).

c. Click OK .
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7. Similarly to the step above, add a Function action element with the properties below to return the current date.
The date will be used as a parameter in the Documentum submission.

• Name: Enter a name to identify the function, for example, Current Date.

• Function: Select the predefined function that returns the current date (see Prerequisites).

8. Add a Documentum action element. This connector uses the data supplied by the rest of the shortcut to upload to
the Documentum service. Select the shortcut elements that you have created before to define its parameters:
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9. The shortcut is set up with all the parameters required. Enable the shortcut by selecting Yes in the Enabled field.
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10. Click OK.

11. Close and reopen the database for your new shortcut to take effect.

12. To test this functionality, go to the LIBRARY screen, select a library item and choose the new Shortcuts ->
Publish to Documentum toolbar button.
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ã See also

Configure Shortcuts

7.2.1.15 Configure Workflows

Under Configuration → General → Workflows, you can define workflows by setting up permissions for specific user
groups, which determine what changes they are allowed to make in the values of given system table fields.

The available system table fields for which you can set up permissions are predefined, that is, you can configure only
those fields that are listed in the Configuration - Workflows dialog.

7.2.1.15.1 Example: Define Workflow for Status Field in Anomaly Actions

For anomaly actions, the Status field can have the following values:

• Proposed

• Approved

• Assigned

• Completed

• Rejected
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You want to allow data entry users (user assigned to Data Entry Users group under Database → Security. . . ) to
change the value of this field as follows:

• Change the value to Proposed if the field has no value

• Change the value to Assigned if the original value of the field is Approved

• Change the value to Completed if the original value of the field is Approved or Assigned

You do not want to allow this user to change the status to Approved or Rejected from any statuses.

In this case, make settings as follows:

1. Choose Configuration → General → Workflows from the menu.

2. In the Configuration - Workflows dialog, select the system table field Anomaly Action - Status .

3. Choose Define Workflow .

4. Select the Data Entry Users tab .

5. In the NEW STATUS ALLOWED columns, select to which values the user is allowed to change the

original value, if the original value is as indicated in the CURRENT STATUS column :

CURRENT STATUS NEW STATUS ALLOWED
Null Proposed
Approved Assigned, Completed
Assigned Completed

6. Click OK .
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When you choose Configuration→General from the main menu of NEXUS IC, you can make settings for the following:

• Configure Boolean Types

• Configure Chart Templates

• Configure Company

• Configure Functions

• Configure Global Tables

• Configure Lookup Lists

• Configure Map Servers

• Configure Traffic Lights

• Configure Unit Types

• Configure Unit Groups

• Configure Providers

• Configure Connections

• Configure Attributes

• Configure Shortcuts

• Shortcut Categories

• Configure Workflows

7.2.2 Configure Assets
When you choose Configuration → Assets from the main menu of NEXUS IC, you can configure asset-specific func-
tions as described below:

• Configure Asset Information Groups
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• Configure Asset Types

• Configure Features

• Configure Sensors

• Configure Risk Charts

• Configure Risk Models

7.2.2.1 Configure Asset Information Groups

Under Configuration → Assets → Information, you can create and configure Asset Information Group (AIG) forms
(see Asset Information Groups (AIGs)). You can then use these forms to record data against assets.

You can create the following types of forms here:

• An Asset Information Group (AIG) form (see Asset Information Group (AIG)) has a one-to-one relationship
with an asset. Once an AIG is created, you must assign the AIG to an asset type (see Configure Asset Types). This
ensures that when you select an asset with that particular asset type, the AIG will be available for selection under
the Group toolbar button on the Asset Information tab. You can then enter data into that AIG form against that
particular asset.

• A Sub Asset Information Group (sub AIG) form (see Sub Asset Information Group (Sub AIG)) is a table within
an AIG form, which allows you to have multiple rows within the AIG. This means that multiple records can be
created as part of a single instance of an AIG.

You can maintain AIGs and sub AIGs from the Configuration - Information dialog as follows:

• In the top half of this dialog, you can add, edit and delete AIG or sub AIG forms. You can use the standard
toolbar functions for maintaining the forms (see Using the Grid). In addition, you can:

– Use the Field Order button to move a field up or down in the form or grid. For example, if you want to
place a field between two other fields in the form, select Form . . . from the drop-down list, and in the
Form Field Order dialog, you can move the field with the Move Up or Move Down buttons available in
the toolbar.

Using the IC-Inspector. . . item under this button, you can also define the order of asset information fields
that appear under ASSET INFORMATION when checking task information in IC-Inspector.

– Check the dependency map using the Map button (see View Dependency Map).

• In the bottom half, you can add, edit or delete fields within AIG or sub AIG forms and use the standard toolbar
functions for maintaining the fields within the forms (see Using the Grid). You can also review how fields appear
in the form or grid layouts.

7.2.2.1.1 Create AIG/Sub AIG Forms

See the steps below for the basic process of creating a new AIG or sub AIG form:

1. Under Configuration → Assets → Information, click Add at the top of the Configuration - Infor-

mation dialog .

2. Select whether you want to create a new AIG or a sub AIG form .

The Add Table Definition dialog appears. The title of the dialog reflects that form data is stored in
tables in NEXUS IC.
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3. Specify the main table parameters in the Add Table Definition dialog . For more information,
see Add/Edit Table Definition Dialog.

ò Note

When you create the table for the first time, not all tabs are visible in the dialog. Save the
table, select it and click Edit to return to the dialog with all the tabs visible.

4. Click OK.

5. Add new fields to the table by choosing Add from the bottom toolbar of the Configuration - Infor-

mation dialog .

The Add Field Definition dialog appears.
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ò Note

When you create the field for the first time, not all tabs are visible in the dialog. Save
the field, select it and click Edit to return to the dialog with all the tabs visible.

6. Specify the main field parameters in the Add/Edit Field Definition dialog .

In this dialog, you can define the main properties of the field, configure its layout, assign functions,
set up workflow rules and anomaly triggers, and so on. For more information, see Add/Edit Field
Definition Dialog, Set Up Anomaly Triggers and Set Up Workflow Rules.

7. Click OK.

7.2.2.1.2 View Dependency Map

The dependency map is a visual representation of an Asset Information Group (AIG), Event Type’s, or global table’s
dependencies.

You can access the dependency map by choosing Map in the toolbar of the configuration dialogs when configuring
AIGs (see Configure Asset Information Groups), event types (see Configure Event Types) or global tables (see Configure
Global Tables).

The map is represented as a series of interlinked fields grouped in columns, each column representing the AIG/Event
Type/Global Table to which the fields belong.

The map is hierarchically arranged from left to right, with the target AIG/Event Type/Global Table located in the
left-most column, and its dependencies and sub-dependencies located to the right.

You can also toggle the view using the following buttons at the top of the dialog:

• Show Duplicates: If this button is switched on, and a field has a reference to another field in the same AIG/Event
Type/Global Table, the field and the AIG/Event Type/Global Table will be displayed again in a separate column.
If you switch this button off, the fields will be displayed only once and any self-referential dependencies will
be displayed as a closed loop in a single column. For example, if you have a field called Absolute Pressure in
the Piping AIG, which has references to two other fields from the same Piping AIG, the dependency map is
displayed as follows:

– Show Duplicates button ON:
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– Show Duplicates button OFF:
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• Show Local References: If this button is switched on, and a field has a reference to another field within the same
AIG/Event Type/Global Table, this dependency will be displayed on the map. If you switch this button off, these
self-referential dependencies will not be displayed at all. See how the example mentioned above is displayed
when toggling this button on or off:

– Show Local References button ON:
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– Show Local References button OFF:
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7.2.2.1.3 Example

For an example about how to add a new global table lookup field to an existing AIG, see Example: Set Up Global
Lookup Field. For an example about how you can use a global table as a global table link in an AIG, see Example:
Assign Global Table Link to AIG.

7.2.2.1.3.1 Set Up Anomaly Triggers

You can set up anomaly triggers for fields in an Asset Information Group (AIG) or an event form. When an anomaly

trigger is violated, a yellow exclamation mark ( ) will appear next to the field.

ò Note

You can also set up asset-specific anomaly triggers. For more information, see Set Up Anomaly Triggers
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for Assets.

To set up a generic anomaly trigger for a field, proceed as follows:

1. Start editing the required field in either of the following ways:

• In case of an AIG field, choose Configuration → Assets → Information from the main menu,
select the relevant AIG form in the top of the dialog and double-click the required field from the
bottom of the dialog or select it and choose Edit.

• In case of field in an event form, choose Configuration → Events → Event Types from the main
menu, select the relevant event type in the top of the dialog and double-click the required field
from the bottom of the dialog or select it and choose Edit.

2. In the Edit Field Definition dialog (see Add/Edit Field Definition Dialog), go the the Anomaly
Triggers tab.

3. Choose Add to create a new anomaly trigger, or, if you want to change an existing anomaly trigger,
select it and choose Edit.

4. Enter data as follows:
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Field/Checkbox
Name

Description

Type Describe the case when the anomaly should be triggered.
Error
Message

If you want to set up an error message to be shown when the anomaly is triggered,
you can define its text here.

Enabled Tick this checkbox to activate the trigger. In this case, the value of the event field
will be checked against this trigger. If this checkbox is not ticked, the trigger is
ignored.

Date
From/Date
To

You can optionally specify a date range for an anomaly trigger. If you specify only
Date From, the trigger will apply only to event data from that date forward. If you
set only Date To, the trigger will apply only to event data till that date or earlier. If
you set both, the trigger will apply only to event data within the specified range. In
this way, you can change triggers to reflect new conditions, without causing spurious
warnings on historical data. For example, if you decrease the operating pressure of
an asset, this might decrease the minimum allowable wall thickness. Rather than
editing the existing anomaly trigger, you can set a “To” date on that old trigger, and
add a new trigger with a “From” date.

Lower
Bound

Specify a constant value. If the field’s value is below this constant value, the
anomaly will be triggered.

Lower
Bound
(Field)

Specify a field whose value should be compared to the value of this field. If the
current field’s value is below the value of the field that you specify here, the anomaly
will be triggered. For example, if this field is Measured Wall Thickness, the system
might trigger an anomaly if its value is less than the value of the Minimum Allowable
Wall Thickness.

Upper
Bound

Specify a constant value. If the field’s value is above this constant value, the
anomaly will be triggered.

Upper
Bound
(Field)

Specify a field whose value should be compared to the value of this field. If the cur-
rent field’s value is above the value of the field that you specify here, the anomaly
will be triggered. For example, if this field is Measured Wall Thickness, the system
might trigger an anomaly if its value is more than the value of the Maximum Allow-
able Wall Thickness.

Include
Boundary

Controls whether exact matches cause the anomaly to be triggered. For example, if
you have set a trigger to “Fail when inside Upper/Lower bounds”, your lower bound
is 1 and your upper bound is 9, your selection in this field determines whether the
anomaly is triggered if the value is “1 < x < 9” or if it is “1 <= x <= 9”. If you select
Yes, the anomaly is triggered also if the value of the field is equal to the upper or
lower bounds.

Code Specifies the code that indicates the type of the anomaly (see Code).
Severity You can set several triggers on a single field, with a variety of different codes and/or

severities (see Severity). If that anomaly trigger is violated on an event field, a
finding of that code and severity will automatically be created. Severities let you
equate dissimilar problems, for example, you can decide that a problem in one field
is of the same severity as a problem in a different field.

5. Click OK to save your changes.

ò Note

• For Lookup List fields, the comparison is performed based on the lookup list item’s
value, not its comment. For example, if you have a lookup list titled Anode Depletion,
and its first entry has value “25” and comment “0 to 25% depleted”, NEXUS will use
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the “25” for purposes of determining whether an anomaly should be triggered.

• For Yes/No fields, you can set the anomaly to be triggered on any combination of Yes,
No or blank, however, you can’t compare it to another field.

• If you delete an anomaly trigger, findings created from it won’t be deleted. If you
want to delete all findings created from an anomaly trigger, don’t delete the anomaly
trigger. Instead, modify it so that no data will be marked as anomalous (for example,
you can set it to only flag data between -2 and -1 on a field with no negative values),
then run the anomaly triggers functionality. Then, as a second step, you can delete
the anomaly trigger.

ã See also

• Run Anomaly Triggers

• Set Up Anomaly Triggers for Assets

• Add/Edit Field Definition Dialog

7.2.2.1.3.2 Example: Set Up Global Lookup Field

The example below shows how you can set up a global lookup field on an Asset Information Group (AIG) form. In this
example, we create a global lookup field for the Outside Diameter (mm) field in an asset information group (AIG)
called Pipeline and we want the value of this field to be determined based on the following:

• The value of another AIG field called NPS (Inch)
• The reference values specified in a global table, which contains a series of data for the possible combinations of

outside diameter and nominal pipeline size (NPS) data of a pipeline.

7.2.2.1.3.3 Prerequisites

• Before configuring the AIG field, you must construct the global table that contains the reference values for outside
diameter and NPS data. For a guide on how to set up the global table for this example, see Example: Configure
Global Table for Global Table Link.

• You have created the AIG form Pipeline, which already contains the NPS (Inch) field.

7.2.2.1.3.4 Process

1. Under Configuration → Assets → Information, select the Pipeline AIG to which you want to add the new field

.

2. Choose Add from the bottom toolbar to add a new field for outside diameter.

3. Enter the name of the field and in the Field Type field, select Global Lookup .

As soon as you select the field type, the Function tab appears in the dialog.

4. In the Linked Field field, click to select the global table field whose value you want to return to this field

. In this case, it will be the Outside Diameter (mm) field in the Nominal Pipe Sizes lookup table .

5. Click OK .
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See the image below for the steps above:

6. On the Functions tab, set up the function as follows:

a. In the Function field, select the system function Compare A = B.

b. Under Parameters (Input), in the A - any field, click to select the NPS (Inch) field under the Pipeline

AIG.

c. Under Parameters (Input), in the B - any field, click to select the Nominal Pipeline Size (in) field under

the Nominal Pipe Sizes lookup table.

This function ensures that when the user enters a value in the NPS (Inch) field of the Pipeline AIG,
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the system calculates the value of the Outside Diameter (mm) field as follows:

1. It retrieves the value of the NPS (Inch) AIG field (“A” value in the function).

2. It compares this value with the values of the Nominal Pipeline Size (in) field in the Nominal
Pipe Sizes global table (“B” value in the function).

3. If there’s a match, that is, it finds a Nominal Pipeline Size (in) value in the global table that is
equal to the AIG field value, the function returns Yes.

4. In this case, the value of the Outside Diameter (mm) field in the corresponding row of the
Nominal Pipe Sizes global table will be retrieved and output to the Outside Diameter (mm)
field in the AIG form.

7. Click OK.

7.2.2.1.3.5 Result

The value of the Outside Diameter (mm) field is calculated and appears on the Pipeline AIG based on the value of
the NPS (Inch) field. When clicking in the Outside Diameter (mm) field, the NPS (Inch) is highlighted in dark grey
colour to show that it’s a dependent field.

You can check the global table based on which the value was determined when you click on the icon in the Outside
Diameter (mm) field. In the Matched column, you can see in which row of the global table the match was found. To
check the function behind the calculation, click Inspect in the View Global Table Lookup dialog that opened.
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7.2.2.1.3.6 Example: Assign Global Table Link to AIG

The example below shows how you can use a global table as a global table link in an Asset Information Group (AIG).

7.2.2.1.3.7 Prerequisites

Before implementing a global table link in an AIG, you must construct a global table adequate for your purposes. This
involves creating fields that relate to field data in such a way that each form field can be selected to progressively narrow
the selection of values until the user is presented with a final value, or a filtered group of values to select from. The
final value will be displayed in the AIG.

For a guide on how to set up the global table for this example, see Example: Configure Global Table for Global Table
Link.

7.2.2.1.3.8 Process

1. Create a new AIG field definition as follows:

a. Under Configuration → Assets → Information, select the AIG to which you want to add the new field and

choose Add from the bottom toolbar.

b. In the Field Type field, select Global Table Link .

c. In the Global Table field, select your global table.

d. Tick the Validation Required checkbox .

e. Click OK .
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2. If you haven’t already edited the field layout of the global table fields, you can do so from here.

a. On the Field Layout tab, enter the number of columns you would like to display in the form in the Columns
field.

b. You can also untick Show Caption under Form to hide the label of the AIG field. The label above the form
will match the category name.

In this example, we choose 2 columns.

c. Create and apply a category that also has the number of columns set to 2, and is called Location.

3. On the ASSETS screen, select an asset of the asset type you want your AIG to be enabled on.

4. Choose Assets → Edit → Asset Type Properties from the toolbar.

7.2. Configuration 147



NEXUS Documentation, Release 6.9.xxxxx.0

5. In the Edit Asset Type dialog, navigate to the Asset Information Groups tab and select your AIG in the list.
You can select multiple rows.
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5. On the ASSETS screen, select your asset again and on the Asset Information tab, select your AIG from the list
of AIGs under the Group: [AIG] button.

7.2.2.1.3.9 Result

The AIG displays the questionnaire form with the global table fields. When you navigate through the form, the system
finds a global table row by narrowing down the range of possible results that correspond to the combination of field
values. In practice, this is similar to a questionnaire that progresses one question at a time, until the result field is shown.
The screenshot below shows the questionnaire in a completed state. The result drop-down list contains the possible
values according to the specified answers. Choosing a result stores a reference to it in the AIG.
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7.2.2.2 Configure Asset Types

Under Configuration → Assets → Types, you can set up asset types as follows:

• Create asset types (see Create an Asset Type)

• Assign Asset Information Groups (AIGs) to asset types (see Assign AIGs to an Asset Type)

• Assign event definitions to asset types (see Assign Event Types to Asset Type)

• Assign survey data to asset types (see Assign Survey Data to Asset Type)

• Assign risk models to asset types (see Assign Risk Models to Asset Type)

• Assign library items to asset types (see Assign Library Items to Asset Type)

You must assign an asset type to each asset in the asset tree (see Edit Assets and Asset Types). The asset type determines
what AIGs, event definitions, survey data groups, risk models or library items are applicable to particular assets.

� Tip

You can also edit asset types and make assignments to it by choosing Assets → Edit → Asset Type
Properties . . . from the main toolbar on the ASSETS screen. It triggers the same Edit Asset Type
dialog that is referenced below.

7.2.2.2.1 Create an Asset Type

To create a new asset type, proceed as follows:

1. Under Configuration → Assets → Types, click Add at the top of the Configuration - Types
dialog.

2. Enter the following data:

150 Chapter 7. Setup and Configuration



NEXUS Documentation, Release 6.9.xxxxx.0

Field/Checkbox
Name

Description

Name A name that uniquely identifies the asset type.
Category The category of the asset type if you want to group asset types into categories.
Descrip-
tion

You can optionally provide more descriptive information about the asset type. This
can be a maximum of 100 characters.

Asset Icon Icon (16×16 px) representing the asset type in the asset tree. Click the ellipsis (. . . )
to select an icon. If none is selected, the default icon is used.
Tip: When selecting an icon, you can click Connections to see which asset types
already use the icon.

Prevent
Dupli-
cates

If ticked, assets of this type must have unique names. This means that you will not
be able to create two assets with the same name under this asset type.

Is Pri-
mary
Asset
Type

Marks this asset type as a primary grouping category. This setting can be used for
reporting, dashboards and functions to organise and group assets.

3. Click OK to save your changes.

ò Result
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The new asset type appears in the Configuration - Types dialog. When you edit it, additional tabs
become available for assigning AIGs, event types, survey data, risk models and library items.

7.2.2.2.2 Assign AIGs to an Asset Type

If you assign an AIG to an asset type and you select an asset with that asset type in the asset tree, then that AIG will be
available for editing under the Groups toolbar option on the Asset Information tab.

To assign an AIG to the asset type, proceed as follows:

1. Under Configuration → Assets → Types, select the relevant asset type.

2. Choose Edit to launch the Edit Asset Type dialog.

3. On the Asset Information Groups tab, choose Include.

4. Select the required AIG from the list and click OK.

5. Click OK in the Edit Asset Type dialog.

7.2.2.2.3 Assign Event Types to Asset Type

If you assign an event type (see Configure Event Types) to an asset type, then, on the INSPECTION screen, you can
create events only with that event type for the particular asset with that asset type. For example, on the Event Listing
tab, when you click Add Event, only the assigned event types will be available for selection when you create a new
event. Also, you can import only events with the assigned event types.

To assign an event type to the asset type, proceed as follows:

1. Under Configuration → Assets → Types, select the relevant asset type.

2. Choose Edit to launch the Edit Asset Type dialog.

3. On the Events tab, choose Include.

4. Select the required events from the list and click OK.

5. Click OK in the Edit Asset Type dialog.

7.2.2.2.4 Assign Survey Data to Asset Type

If you assign a survey data form (see Configure Event Types) to an asset type, then survey data of that type can be
logged against assets of that type.

To assign a survey data form to an asset type, proceed as follows:

1. Under Configuration → Assets → Types, select the relevant asset type.

2. Choose Edit to launch the Edit Asset Type dialog.

3. On the Survey Data tab, choose Include.

4. Select the required survey data form from the list and click OK.

5. Click OK in the Edit Asset Type dialog.
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7.2.2.2.5 Assign Risk Models to Asset Type

If you assign risk models to an asset type, then you can assign only those risk models to assets with that particular asset
type. That is, on the Risk tab, when you click Assign to <name of asset>, you can choose only from the risk models
that have been assigned to that asset type. For more information, see Assign Risk Models and Scenarios.

To assign a risk model to the asset type, proceed as follows:

1. Under Configuration → Assets → Types, select the relevant asset type.

2. Choose Edit to launch the Edit Asset Type dialog.

3. On the Risk Models tab, select the required risk models from the list. You can choose Select All to select all
items in the list or Clear Selection to remove a selection.

4. Click OK in the Edit Asset Type dialog.

7.2.2.2.6 Assign Library Items to Asset Type

If you assign a library item to an asset type and you select an asset with that asset type in the asset tree, then the assigned
library items will be available on the Library tab for that asset.

To assign a library item to the asset type, proceed as follows:

1. Under Configuration → Assets → Types, select the relevant asset type.

2. Choose Edit to launch the Edit Asset Type dialog.

3. On the Library tab, choose Add.

4. In the Add Library dialog, specify the main properties and upload the required library item. For
detailed information, see Add/Edit Library Dialog.

5. Click OK in the Edit Asset Type dialog.

For more information about managing library items, see Library Items.

ã See also

• Edit Assets and Asset Types

7.2.2.3 Configure Features

So that some features can work properly, NEXUS IC needs to know where to get data from for specific purposes. To
ensure this, you must define the source Asset Information Group (AIG) fields that NEXUS can use to get information
for the following usages:
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Usage Description
As Built - Order, As Built - East-
ing, As Built - Northing

Sub AIG fields used by the Map feature to show an as-built pipeline track.

Asset - Abbreviation This field is now redundant but may be used in the future. Leave it blank.
Asset - Serial Number Used to connect NEXUS IC assets to elements in a 3D drawing.
Asset - Tag This field is used to store QR code data. When IC-Inspector scans a QR code

or bar code, the task list will be filtered to show only tasks that contain the
scanned code.

Coordinates - Datum, Coordi-
nates - UTM Zone

Used by the Map feature to fetch real-world maps from OpenStreetMap,
ESRI, and so on.

DVR - Relative Folder: Used by your video recorder to specify the relative folder to record video into
for each asset. For more information, see Specify Project Path for Recording.

Feature - Start, Feature - End,
Feature - Name, Feature - Cate-
gory

These fields are now redundant but may be used in the future. Leave them
blank.

Pipeline Section - KP - Start,
Pipeline Section - KP - End

Parameters required for the Pipeline View chart.

These usages are predelivered and cannot be modified.

To assign source AIG fields to these usages, proceed as follows:

1. Navigate to Configuration → Assets → Features.

2. Select the required usage in the list and click Edit.
3. Select the relevant AIG field from the dialog and click OK.

7.2.2.4 Configure Sensors

Under Configuration → Assets → Sensors, you configure sensor data forms.

Sensor data is recorded against assets, at a series of points in time (for example, once per hour). (This feature was
known as monitored data in NEXUS IC 5.)

You can maintain sensor data forms from the Configuration - Sensors dialog as follows:

• In the top half of this dialog, you can add, edit and delete sensor forms. You can use the standard toolbar functions
for maintaining the forms (see Using the Grid). In addition, you can:

– Use the Field Order button to move a field up or down in the form or grid. For example, if you want to
place a field between two other fields in the form, select Form . . . from the drop-down list, and in the
Form Field Order dialog, you can move the field with the Move Up or Move Down buttons available in
the toolbar.

– Check the dependency map using the Map button (see View Dependency Map).

• In the bottom half, you can add, edit or delete fields within the sensor data forms and use the standard toolbar
functions for maintaining the fields within the forms (see Using the Grid). You can also review how fields appear
in the form or grid layouts.

Note that the Clock field is part of each sensor data form by default. Typically, a sensor will only have a single nu-
meric field configured. However, if your sensor data type has more than one field, then the Sparkline chart shown
on the sensors grid will display the data from the field that is ordered first. See Sensors for more information on
the Sensor Sparkline chart.
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7.2.2.4.1 Create Sensor Data Forms

See the steps below for the basic process of creating a new sensor data form:

1. Under Configuration → Assets → Sensors, click :menuselection:`Add –> Sensor` at the

top of the Configuration - Information dialog .

The Add Table Definition dialog appears. The title of the dialog reflects that form data is
stored in tables in NEXUS IC.

2. Specify the main table parameters in the Add Table Definition dialog . For more
information, see Add/Edit Table Definition Dialog.

ò Note

When you create the table for the first time, not all tabs are visible in the dialog.
Save the table, select it and click Edit to return to the dialog with all the tabs
visible.

3. Click OK.

4. Add new fields to the table by choosing Add from the bottom toolbar of the Configuration

- Information dialog .

The Add Field Definition dialog appears.
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ò Note

When you create the field for the first time, not all tabs are visible in the dialog.
Save the field, select it and click Edit to return to the dialog with all the tabs
visible.

5. Specify the main field parameters in the Add Field Definition dialog . For more in-
formation, see Add/Edit Field Definition Dialog.

6. Click OK.

7.2.2.4.2 View Dependency Map

The dependency map is a visual representation of an Asset Information Group (AIG), Event Type’s, or global table’s
dependencies.

You can access the dependency map by choosing Map in the toolbar of the configuration dialogs when configuring
AIGs (see Configure Asset Information Groups), event types (see Configure Event Types) or global tables (see Configure
Global Tables).

The map is represented as a series of interlinked fields grouped in columns, each column representing the AIG/Event
Type/Global Table to which the fields belong.
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The map is hierarchically arranged from left to right, with the target AIG/Event Type/Global Table located in the
left-most column, and its dependencies and sub-dependencies located to the right.

You can also toggle the view using the following buttons at the top of the dialog:

• Show Duplicates: If this button is switched on, and a field has a reference to another field in the same AIG/Event
Type/Global Table, the field and the AIG/Event Type/Global Table will be displayed again in a separate column.
If you switch this button off, the fields will be displayed only once and any self-referential dependencies will
be displayed as a closed loop in a single column. For example, if you have a field called Absolute Pressure in
the Piping AIG, which has references to two other fields from the same Piping AIG, the dependency map is
displayed as follows:

– Show Duplicates button ON:

– Show Duplicates button OFF:
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• Show Local References: If this button is switched on, and a field has a reference to another field within the same
AIG/Event Type/Global Table, this dependency will be displayed on the map. If you switch this button off, these
self-referential dependencies will not be displayed at all. See how the example mentioned above is displayed
when toggling this button on or off:

– Show Local References button ON:
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– Show Local References button OFF:
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7.2.2.5 Configure Risk Charts

The first step of setting up a risk model is configuring a risk chart, where the risk results can be displayed on. You
create risk charts under Configuration → Assets → Risk Charts.

One chart can be used by several risk models (see risk models).

Risk matrixes are displayed on the ASSETS screen, on the Risk tab (see Risk).

7.2.2.5.1 Set Up a Risk Chart

The following example shows the steps of setting up a new risk chart:

1. Under Configuration → Assets → Risk Charts, click Add at the top of the Configuration - Risk Charts dialog.

2. In the Add Risk Chart dialog, enter a name that uniquely identifies the risk chart.

3. Specify the X and Y axis parameters as follows:
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Field Name Description
X Axis Title Specifies the title of the X axis.
X Axis
Granula-
tion

Indicates to how many squares you want to split up the X axis (width).

X Axis
Ticks

Indicates the name of each square on the X axis. Enter the values separated by semicolon.
For example, if your risk chart is 5x5, your X axis ticks can be defined as “A;B;C;D;E”, or
“Negligible;Mild;Moderate;Major;Severe”, whatever your risk model requires.

Y Axis Title Specifies the title of the Y axis.
Y Axis
Granula-
tion

Indicates to how many squares you want to split up the Y axis (height).

Y Axis
Ticks

Indicates the name of each square on the Y axis. Enter the values separated by semicolon.
For example, if your risk chart is 5x5, your Y axis ticks can be defined as “1;2;3;4;5”, or
“None;Low;Medium;High;Extreme”, whatever your risk model requires.

4. Under Chart, set up the risk colours and numbers as follows:

• Right-click a cell to set the colour. Choose a predefined colour or choose Custom to get a colour picker
dialog.

• Click within the cell to enter a whole number risk value. The higher the number, the more severe the risk
is.
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ã See also

Configure Risk Models

7.2.2.6 Configure Risk Models

The Risk technology within NEXUS IC provides a powerful framework so that you can configure formalised risk
assessment and RBI methodologies (for example, API 581 BRD, DNV-RP-G101, AS 2885.1, AS 4360) or set up
custom risk models of any level of complexity (that is, corporate risk models, internally workshopped models, or
tailored/customised models to suit specific issues or situations).

You create and configure risk models under Configuration → Assets → Risk Models.
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Once you have created a risk model, you can assign it to asset types (see Assign Risk Models to Asset Type and Assign
Asset Types to a Risk Model) and then to individual assets (see Assign Risk Models and Scenarios).

You can see what assets have a particular risk model assigned by clicking on the risk model, then clicking the Connec-
tions button.

7.2.2.6.1 Risk Model Hierarchy

The concept of risk models is hierarchical: the final risk value is comprised of n Categories. Each Category value is
comprised of n Factors. Each Factor value is comprised of n Calculations, Pass Thrus, Values and Factors.

Each of these entities (Category, Factor, etc.) is displayed in the bottom half of the Configuration - Risk Models
dialog in a hierarchical structure tree, with each level expandable and collapsible.

A risk model is made up of three top-level categories:

Risk Model Cate-
gory

Description

Risk This category contains the risk model functionality based on which the actual risk value is
determined. Beneath Risk, you can add Factors, and below Factors, you can add Calcu-
lations, Pass Thrus, Values and more Factors. For each Factor, you set up a function and
ultimately, the function assigned to the main Risk element combines all the factor functions
beneath it.

X Value Determines the location of the risk value on the X axis.
Y Value Determines the location of the risk value on the Y axis.

For detailed information about setting up a risk model, see the process below.

7.2.2.6.2 Create Risk Models

7.2.2.6.2.1 Prerequisites

You have defined a risk chart based on which the risk model can be set up (see Configure Risk Charts).

7.2.2.6.2.2 Process

1. Under Configuration → Assets → Risk Models, click Add at the top of the Configuration - Risk Models dialog.

2. In the Add Risk Model dialog, enter data as follows:

• Specify a name that uniquely identifies the risk model.

• Select the risk chart that you want to use for your risk model (as defined in Configure Risk Charts).

• If required, select a model status (whether it’s final or in development) and categorise your risk model.

3. In the bottom half of the Configuration - Risk Models dialog, set up the three main risk model categories:

a. Set up the Risk category, which contains the actual functionality of your risk model and determines how
the risk value is determined.

1. Define at least one factor under the Risk node by selecting the node and choosing Add →
Factor from the bottom toolbar.
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2. Under each factor, create children based on which the value of the risk factor can be deter-
mined. To do that, select the factor and choose the required child type from under the Add

toolbar button.

You can create the following types of children under a factor:

• Another factor
• A pass through field, in which case, you can select a field from an Asset Information

Group (AIG) form and have its value passed through to the risk model.

• A value, in which case, you can directly determine a specific value to be used in the
risk model.

• A calculation, in which case, you define a function for determining the value for the
risk model.

3. As soon as you create a child under a factor, a function is automatically assigned to the factor.
To ensure that the result value is determined correctly, edit the function of the factor by click-
ing the function and selecting at the end of the row and setting up the connection between
the function elements, for example:
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4. Once you have set up each factor under the Risk node, configure the function of the main
Risk node too, by clicking the function and selecting at the end of the row and setting up
the connection between the function elements, for example:
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b. Set up the X Value category, which determines the location of the risk value on the X axis. To do that, edit
the X Value row and assign a function that returns a value between 0 and 1 based on your requirements.

The return value 0 locates the risk value at the far left end of the X axis, and value 1 locates the value
at the far right end of the axis.

For example, if based on your risk chart, you have the Consequence values A, B, C, D, E on your X
axis, then you can assign a function that returns the values as follows:
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c. Similarly to the step above, set up the Y Value category, which determines the location of the risk value
on the Y axis. To do that, edit the Y Value row and assign a function that returns a value between 0 and 1
based on your requirements.

The return value 0 locates the risk value at the bottom end of the Y axis, and value 1 locates the value
at the top end of the axis.

7.2.2.6.3 Assign Asset Types to a Risk Model

Once you have created a risk model, you can assign asset types to it, which allows you to restrict which asset types can
have access to certain risk models. That is, on the ASSETS screen, on the Risk tab, when you click Assign to <name
of asset>, you can choose only from the risk models that have been assigned to that asset type. For more information,
see Assign Risk Models and Scenarios.

To assign asset types to a risk model, proceed as follows:

1. Under Configuration → Assets → Risk Models, select the relevant risk model in the top half of the dialog.

2. Choose Edit to launch the Edit Risk Model dialog.

3. On the Asset Types tab, select the required asset types.

4. Click OK.

ã See also

• Risk

• Assign Risk Models and Scenarios

• Configure Risk Charts

• Assign Risk Models to Asset Type
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7.2.3 Configure Planning Data
When you choose Configuration → Planning from the main menu of NEXUS IC, you can configure functions related
to planning tasks or workpacks as described below.

7.2.3.1 Cost Codes

Under this item, you can define the list of cost codes which workpacks can be allocated to. When you edit a workpack
on the WORKPACKS screen, from the Cost Code field, you can select from the values that have been defined here.

Cost code allocation can be useful if it ties in with an external CMMS.

7.2.3.2 Schedule Types

You can optionally define a list of schedule types that can be assigned to planning tasks for grouping, filtering or
reporting purposes.

7.2.3.3 Task Categories

You can set up task categories to group tasks. If your database contains different kinds of data, for example, some
below-water and some above-water data, you can create one task category for “Above water” and another for “Below
water”. Or, you can separate “below water” into “ROV” and “Diver”.

7.2.3.4 Task Status

You can define a list of statuses that can be assigned to tasks for user-defined categorisation. For example, it can contain
entries describing why a task could not be completed, such as item inaccessible, item non-existent, task is a duplicate,
and so on.

7.2.3.5 Workpack Groups

You can create workpack groups to group your workpacks for filtering, searching, reporting or any other purposes. You
can assign workpack groups to workpacks on the Workpacks screen.

7.2.3.6 Workpack Revisions

You can define revisions for workpacks, which can indicate at what stage the workpack is in, for example, planning
stage, completed, and so on. In this configuration dialog, you can also do the following:

• Assign a number to a specific workpack revision (Level field)

• Indicate whether you want the workpack with the specific revision to be updated by planning template changes

• Set all workpacks with the given revision to read-only.

By default, the grid on the Workpacks screen is grouped by Revision.

7.2.4 Configure Events
When you choose Configuration → Events from the main menu of NEXUS IC, you can configure event-specific func-
tions as described below:

• Configure Event Types

• Configure Features

• Configure Mutually Exclusive Events

• Configure Remotely Operated Vehicles (ROVs)

• Configure Survey Sets
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7.2.4.1 Configure Event Types

Under Configuration → Events → Event Types, you can create and configure event forms. You can then use these forms
to record event data.

You can create the following types of forms here:

Event Form
Type

Description

Event Events represent a single point in time and space, or a short range of time and/or space. For example,
a form to capture details about an anode’s current state would be an event.

Sub Event A Sub Event appears within one of the other types of form, and can contain multiple records for a
single instance of its owning form. For example, a CP Reading event form might have a sub event
form on it for registering several readings; a Seabed Profile continuous event form might have a sub
event form on it for recording a range of cross-profile depths. Sub Event types are not supported
by IC-Inspector.

Survey Data A Survey Data form captures information like location (Easting, Northing, and so on), KP, CP
(for example, CP Reading, Field Gradient) and so on. Survey Data such as KP, Easting, Northing,
Latitude, Longitude and Elevation is logged into a Survey Set. Each Event has a reference to a
Survey Set. The positional data contained is retrieved from the Survey Set, matching on the Date
Time Stamp in the Survey Set and the Date Time Stamp (Start Clock) of the event. Survey Set data
is imported inherently with any Import Events. The inspection data import templates are formatted
with the required columns. It is also possible to import Survey Set Data independent of event
records. To edit individual survey data points, go to Configuration → Events → Configure Survey
Sets.

Continuous
Event

A Continuous Event is for capturing periodic data. For example, on a subsea pipeline inspection,
you might capture seabed information every n metres. Continuous events do not normally appear
in the Event Listing, unless you specifically filter for them.

You can maintain event forms from the Configuration - Event Types dialog as follows:

• In the top half of this dialog, you can add, edit and delete event forms. You can use the standard toolbar functions
for maintaining the forms (see Using the Grid). In addition, you can:

– Use the Field Order button to move a field up or down in the form or grid. For example, if you want to
place a field between two other fields in the form, select Form . . . from the drop-down list, and in the
Form Field Order dialog, you can move the field with the Move Up or Move Down buttons available in
the toolbar.

Using the IC-Inspector. . . item under this button, you can also define the order of fields that appear on the
Event Details screen in IC-Inspector.

– Check the dependency map using the Map button (see View Dependency Map).

• In the bottom half, you can add, edit or delete fields within the forms and use the standard toolbar functions for
maintaining the fields within the forms (see Using the Grid). You can also review how fields appear in the form
or grid layouts and set up workflow rules and anomaly triggers for specific fields in the form.

7.2.4.1.1 Create Event Forms

See the steps below for the basic process of creating a new event form:

1. Under Configuration → Events → Event Types, click Add at the top of the Configuration - Infor-

mation dialog .

2. Select the type of event form that you want to create .

7.2. Configuration 169



NEXUS Documentation, Release 6.9.xxxxx.0

The Add Table Definition dialog appears. The title of the dialog reflects that form data is stored in
tables in NEXUS IC.

3. Specify the main table parameters in the Add Table Definition dialog . For more information,
see Add/Edit Table Definition Dialog.

ò Note

When you create the table for the first time, not all tabs are visible in the dialog. Save the
table, select it and click Edit to return to the dialog with all the tabs visible.

4. Click OK.

5. Add new fields to the table by choosing Add from the bottom toolbar of the Configuration - Event

Types dialog .

The Add Field Definition dialog appears.
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ò Note

When you create the field for the first time, not all tabs are visible in the dialog. Save
the field, select it and click Edit to return to the dialog with all the tabs visible.

6. Specify the main field parameters in the Add/Edit Field Definition dialog .

In this dialog, you can define the main properties of the field, configure its layout, assign functions,
set up workflow rules and anomaly triggers, and so on. For more information, see Add/Edit Field
Definition Dialog.

7. Click OK.

7.2.4.1.2 View Dependency Map

The dependency map is a visual representation of an Asset Information Group (AIG), Event Type’s, or global table’s
dependencies.

You can access the dependency map by choosing Map in the toolbar of the configuration dialogs when configuring
AIGs (see Configure Asset Information Groups), event types (see Configure Event Types) or global tables (see Configure
Global Tables).
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The map is represented as a series of interlinked fields grouped in columns, each column representing the AIG/Event
Type/Global Table to which the fields belong.

The map is hierarchically arranged from left to right, with the target AIG/Event Type/Global Table located in the
left-most column, and its dependencies and sub-dependencies located to the right.

You can also toggle the view using the following buttons at the top of the dialog:

• Show Duplicates: If this button is switched on, and a field has a reference to another field in the same AIG/Event
Type/Global Table, the field and the AIG/Event Type/Global Table will be displayed again in a separate column.
If you switch this button off, the fields will be displayed only once and any self-referential dependencies will
be displayed as a closed loop in a single column. For example, if you have a field called Absolute Pressure in
the Piping AIG, which has references to two other fields from the same Piping AIG, the dependency map is
displayed as follows:

– Show Duplicates button ON:
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– Show Duplicates button OFF:
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• Show Local References: If this button is switched on, and a field has a reference to another field within the same
AIG/Event Type/Global Table, this dependency will be displayed on the map. If you switch this button off, these
self-referential dependencies will not be displayed at all. See how the example mentioned above is displayed
when toggling this button on or off:

– Show Local References button ON:
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– Show Local References button OFF:
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ã See also

• Enable Images with Graphical Markup for Event Fields

• Set Up Anomaly Triggers

• Set Up Workflow Rules

7.2.4.1.2.1 Enable Images with Graphical Markup for Event Fields

You can display multimedia images in event forms. To do that, you must configure the relevant field in the event type
as follows:

1. In the menu, go to Configuration → Events → Event Types.

2. Select the relevant event type in the top half of the dialog.
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3. In the bottom half of the dialog, select an existing field or create a new field that will contain the image.

4. On the Field Definition tab, enter data as required (see Add/Edit Field Definition Dialog) and ensure that you
enter data as follows:

• Select the value Table Link in the Field Type field.

• In the Sub AIG/Event field, select a sub-event that contains two numeric fields called X and Y.

5. On the Field Layout tab, in the Editor Type field, select how you want to create graphical markups on the image:

• Graphical Markup (Line) - Choose this option if you would like to draw a series of line segments on the
image (that is, as an open curve, good for representing cracks, scratches, and so on)

• Graphical Markup (Point) - Choose this option if you want to draw points.

• Graphical Markup (Region) - Choose this option if you would like to create a markup as a polygon (that is,
a closed curve).

ã See also

• Configure Event Types

• Edit Events

7.2.4.2 Configure Features

Under Configuration → Events → Features, you can set which field is the source for various position information, used
by the Pipeline View. Usually, you select Survey fields for the position fields. You can assign fields to the following
usages:

Usage Description
Position - KP Populates the Start - KP and End - KP fields on the INSPECTION screen,

and used in KP-based charts and pipeline charts.
Position - Easting Populates the Position - Easting field on the INSPECTION screen, and

used in the Pipeline View chart.
Position - Northing Populates the Position - Northing field on the INSPECTION screen, and

used in the Pipeline View chart.
Position - Depth Populates the Position - Depth field on the INSPECTION screen, and used

in the Pipeline View chart.
Position - Heading Populates the Position - Heading field on the INSPECTION screen, and

used in the Pipeline View chart.
Longitudinal Profile - Top of Pipe Used in the Profile chart.
Longitudinal Profile - Bottom of
Pipe

Used in the Profile chart.

Longitudinal Profile - Left Seabed Used in the Profile chart.
Longitudinal Profile - Right
Seabed

Used in the Profile chart.

These usages are predelivered and cannot be modified.

To assign source fields to these usages, proceed as follows:

1. Navigate to Configuration → Events → Features.

2. Select the required usage in the list and click Edit.
3. Select the relevant field from the dialog and click OK.
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7.2.4.3 Configure Mutually Exclusive Events

Under Configuration → Events → Mutually Exclusive Events, you can specify groups of events that should not be
allowed to run at the same time.

7.2.4.3.1 Example

You have a Span event and a Buried event. Where a pipeline is buried, it cannot be in a span; where a pipeline is in
span, it cannot be buried. To represent this, you can do the following:

1. Create a Mutually Exclusive Group called Span/Buried by choosing Add in the top half of the Con-
figuration - Mutually Exclusive Events dialog.

2. Within that group, add two event types for Span and Buried by selecting the group and choosing Add
in the bottom half of the Configuration - Mutually Exclusive Events dialog.

ò Result

When you launch a Span event in IC-Inspection, if there is a Buried event running, it will be saved and closed.
Similarly, if you launch a Buried event while a Span event is open, the Span event will be saved and closed.
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7.2.4.4 Configure Remotely Operated Vehicles (ROVs)

Under Configuration → Events → ROVs, you can add, edit, or delete Remotely Operated Vehicles (ROVs).

ROVs are useful for simultaneous operations in IC-Inspection. Whenever you have (or might have) two ROVs in the
water at once (or more generally, two separate sources of video at once, even if one or more of those sources is not
actually a ROV), you should add a ROV for each source. A single multi-channel source, such as several cameras on
one ROV should be represented by just one ROV.

Each ROV can be associated with one or more survey sets, which are in turn associated with events.

Then, when NEXUS IC plays back video for review, it can play the correct channels of video for that event. Similarly,
the Pipeline View chart can show correct data.

7.2.4.5 Configure Survey Sets

Survey sets are used to group survey data associated with inspections. For example, you might create a survey set
named 2018 Inspection Campaign or Pipeline A 2018 Inspection to organise data collected during those periods. For
more information, see Survey Data Processing.

To manage survey sets, navigate to Configuration → Events → Survey Sets. From the Configuration - Survey Sets
dialog, you can:

• Add new survey sets

• Edit existing survey sets

• Delete survey sets

Standard toolbar buttons and grid functions are available in this dialog (see Using the Grid).

7.2.4.5.1 Create Survey Sets

In the Configuration - Survey Sets dialog, you can create survey sets in the following ways:

• Add: Click the Add button in the top toolbar and enter a name for the survey set. Optionally, select an ROV (or
pig/diver) if the survey data was captured using a specific device. This is especially important for dual operations
where multiple devices recorded survey or video data simultaneously.

• Import: Click the Import button to load survey data into the survey set (see Import Events). In the Import
Survey Data dialog, click Example at the bottom to download a sample import sheet.

ò Note

For large datasets, importing from a text file (for example, tab-separated or comma-separated values) is typ-
ically faster than using Excel.

7.2.4.5.2 View/Maintain Survey Data in a Survey Set

In the bottom part of the dialog, you can see a list of dates when survey data was recorded. If you click on a day, you
will see survey data logged on that day on the right-hand side. The grid listing each survey row is linked to the chart
below, that is, if you click on a survey point in one, it will be highlighted in the other. You can multi-select, too.

From this part of the dialog, you can use the toolbar buttons to do the following:

• Add: Add a single survey row

• Edit: Modify selected survey rows

• Delete: Remove selected survey rows
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• Export: Export all survey data entries for the given day

ò Note

Any events that were relying on those rows may not have valid survey data after your updates. If there
is another row within the +3/-2 second threshold, the event will use that instead, but if not, the event
may now simply have no Easting, Northing, and so on.
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ã See also

Survey Data Processing

7.2.5 Configure Anomalies
When you choose Configuration → Anomalies from the main menu of NEXUS IC, you can configure functions related
to anomalies as described below.

7.2.5.1 Checklists

This feature was designed to enable assigning checklists to findings, which could remind inspectors to carry out specific
activities. This feature is not supported at the moment.

7.2.5.2 Codes

Under this menu option, you can define codes for identifying the type of findings or anomalies, for example, DB
(Debris). For further categorisation, you can optionally assign anomaly categories (see Code Categories) to these
codes.

7.2.5.3 Code Categories

You can set up anomaly code categories to group codes (see above). If your database contains different kinds of data,
for example, some below-water and some above-water data, you can create one code category for “Above water” and
another for “Below water”. You can then assign these code categories to codes under Configuration → Anomalies →
Codes.

7.2.5.4 Priorities

You can set up a list of priorities for classifying anomalies based on their priority, for example, “Level 5 - Extreme”,
. . . , “Level 1 - None”.

7.2.5.5 Sets

You can define sets for grouping anomalies, which can be useful for sorting, filtering or reporting as required.

7.2.5.6 Severities

You can create a list of severities that can be assigned to anomalies and findings.

When you set up anomaly triggers on fields, you can assign a severity to it. You can set several triggers on a single
field, with a variety of different severities. If that anomaly trigger is violated on an event field, a finding of that code
and severity will automatically be created. Severities let you equate dissimilar problems, for example, you can decide
that a problem in one field is of the same severity as a problem in a different field.

7.2.5.7 Status

You can define a list of statuses that can be assigned to anomalies. This can reflect the current situation with the
anomaly, for example, “Rectified - Closed”, “Not Anomalous - Closed”, “Monitor”, “Temporary Repair”, and so on.

7.2.5.8 Action Status

You can define a list of statuses that can be assigned to specific actions associated with anomalies. This can reflect the
current situation with the action. The default action statuses are “Approved”, “Assigned”, “Completed”, “Proposed”,
and “Rejected”, but you can customise these to meet your needs.

7.2. Configuration 181



NEXUS Documentation, Release 6.9.xxxxx.0

7.2.5.9 Action Types

Under this menu option, you can set up action types that can be assigned to anomaly actions. From the same dialog,
you can then link a specific event type to the action type. This enables creating a task for an anomaly action on the
ANOMALIES screen. If an event type is linked to the action type of a specific action on the Actions tab, the menu
option Shortcuts → Assign Task will be enabled for the specific anomaly action on this tab and you can assign tasks
with that particular event type to the action.

If an anomaly action doesn’t have an action type assigned to it, or its action type is not linked to an event type, you
cannot assign tasks to it and the menu option will be disabled.

7.2.5.10 Finding Status

You can define a list of internal statuses for findings to reflect their current situation in the workflow. These statuses
can be assigned when creating or editing findings, which can be useful when reviewing findings on the INSPECTION
or ANOMALIES screens.

7.2.6 Configure Reports and Dashboards
When you choose Configuration → Reports and Dashboards from the main menu of NEXUS IC, you can set up report
categories, report statuses and report templates as described below:

• Configure Report Categories

• Configure Report Statuses

• Configure Report Templates

ã See also

Dashboards and Reports

7.2.6.1 Configure Report Categories

Under Configuration → Reports and Dashboards → Categories, you can create, edit and delete report categories,
which can then be assigned to report templates. Categories are a way of grouping report templates. You can also
enable or disable report categories by ticking or unticking the Enabled checkbox in the Add/Edit Report Category
dialog:
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When you generate a report in NEXUS using the Reports toolbar button, the available report templates are grouped
according to the categories assigned to them. Only enabled report categories are available:

ò Note

There are two special report categories: No Category (when a report has not been assigned to any
categories) and Favourites. You can configure what appears in Favourites under Database → Your
Profile.
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7.2.6.2 Configure Report Statuses

Under Configuration → Reports and Dashboards → Statuses, you can create, edit and delete report statuses, which can
then be assigned to report templates. Statuses can be used to indicate the progress of the report template, for example,
“Work in Progress”, “Final”, and so on.

7.2.6.3 Configure Report Templates

Under Configuration → Reports and Dashboards → Templates, you can create, edit and delete report templates. These
templates can be used to generate reports throughout NEXUS IC.

In your final report template, you want to present user-visible information like headings, text, tables, drawings, and so
on. To power these, you will need Simple Sources to query data from the database. To power any custom columns in
the sources, you will need functions.

NEXUS IC’s design lets you create these things in whatever order is convenient to you: you can create all your functions
first, then your sources, then the user-visible elements; or you can rough out your report in an empty state by starting
with the user-visible elements, and then go on to create the Simple Sources under them, and then create the functions
needed for those sources. And it’s usually easier to work in this latter way: create your report from the top down.

See below for more information:

• Create/Edit Report Templates

• Set Up Styles for Report Templates

• Set Up Schedules for Report Templates

• Set a Report Template as a Dashboard

7.2.6.3.1 Create/Edit Report Templates

See the steps below for the basic process of creating or maintaining a report template:

1. Choose Configuration → Reports and Dashboards → Templates from the menu.

In the Configuration - Templates dialog, you can perform the following actions:

• You can use the standard toolbar functions to add, edit, delete report templates or customize the dialog view
as required (see Using the Grid).

• You can load a previously saved report template. Note that if the previously saved report template still
exists in this database, the Load Template function will overwrite that existing report template and it will
not create a new copy of it. Similarly with any other elements saved in the template file, for example, asset
information fields, functions, and so on.

• You can save the report template and related details to a .report file. NEXUS IC will find all items related to
this report template (functions, asset information forms, event definitions, chart templates, lookup tables,
and so on), and will present a dialog listing all the dependencies it’s found, with a checkbox for each row.
Untick any that you don’t want saved with your report template.

• You can set up schedules for report templates (SaaS-only feature). For more information, see Set Up Sched-
ules for Report Templates.

• You can generate the actual report to RTF, HTML or Excel format.

• You can set the selected report template as a dashboard. For more information, see Set a Report Template
as a Dashboard.

• You can set up the common style to be applied for all the report templates. For more information, see Set
Up Styles for Report Templates.
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2. To create a new report template, choose Add. To edit an existing report template, double-click it or select it and
choose Edit.

3. In the Add/Edit Report Template dialog, ensure that the main parameters of the report template are defined.
For more information, see Add/Edit Report Template Dialog.

4. Under the Template Definition section of the dialog, maintain the report layout as required:

• To define the actual size and layout of the report output, double-click the top Report Layout
node on the right-hand side of the dialog and select whether the required size is A3 or A4 and if
the layout should be portrait or landscape. This setting is used until you change the layout in a
sub-element, for example, in a page break.

• To add a new element, select it from the Available Elements screen area and either drag and drop
it to the required location under the Report Layout node, or choose Add, which will insert the
element above the node that was selected in the Report Layout structure. For detailed information
about the available elements, see Elements and Sources.

• To edit the parameters of an element, either double-click it, or select it and choose Edit.
• To move an element in the Report Layout structure, either drag and drop it, or select it and use

the Move Up/Move Down options from the toolbar.

• You can retrieve elements from other reports and add them to your report layout by choosing the
Retrieve Element toolbar button and selecting the element from the required report template.

ò Note

Most of the visual elements in the report require a source element to retrieve data from. To ensure
that a visual element can retrieve data from a source element, the source element must be added
to the Report Layout structure and it must be in the same element group.

5. To customise the selection parameters for the report, click Parameters. These parameters will appear in a
selection dialog when you start generating the report. They are configured when you create a simple source with
a filter that includes a User parameter. Using this toolbar button, you can customise the appearance of these user
parameters in the dialog, such as their order, field label texts, and the width of the fields.

6. Once you have set up the structure of the report, you can generate a test report using the Generate toolbar button.
Note, however, that when you generate the report within this dialog, no selection parameters will be displayed
even if you have set up parameters for the report. To generate the report with the selection parameters, use the
Generate function from the Configuration -Templates dialog instead.

7. Click OK to save the report template and close the dialog.

7.2.6.3.2 Set Up Styles for Report Templates

You can define the look and feel of the final report by pre-defining the fonts and colours for the various styles in the
report. These styles apply to all the report templates in the Configuration - Templates dialog.

To edit the styles used in reports, proceed as follows:

1. Click the Styles toolbar button in the Configuration - Templates dialog.

The Styles dialog opens that shows all the default and added styles. Styles can be relevant for specific elements
of the report, such as heading, table rows, footer, TOC, or they can be, for example, a background colour that you
can use to fill specific elements. Default styles are delivered for specific report elements as their name suggests.

2. Choose the style that you want to edit from the list and double-click it or select it and choose Edit.
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3. Change the default values as required. You can update various properties, such as font, colours, spaces, padding,
alignment, borders.

4. Click OK to save your changes.

Many of these styles are applied automatically to report elements where appropriate. For example, “Table Heading”
gets applied to headings in tables (including Category bands), “Table Event Rows” gets applied to even-numbered data
rows in tables, and so on.

For Pivot tables, the following styles will be automatically applied (if they exist):

• Table Heading for headings

• Table Row Odd and Table Row Even for odd and even rows

• Number for cells that contain numbers

• Total for total cells

• Total Number for total cells that contain numbers

Styles are applied to report elements additively, meaning default styles are applied first, then overwritten where element
styles are embedded in the content field.

ò Note

• Excel reports will ignore many style settings, in favour of using Excel’s own style settings. Excel
does not respect the Default Style, but does respect the embedded Style selection in the content.

• In an RTF report, if the NEXUS style name matches the name of a style used by default in Word
or that appears in your .dotx Word template file, the generated text will appear in that Word style,
so you can use Word’s styling tools to modify it once the report has been generated.

• The Orientation setting, for orientations other than Normal, is poorly supported by many web
browsers. It is known to be supported correctly by Chrome and Safari. For RTF reports, Word
will correctly draw the text in the Up or Down direction, but will incorrectly calculate the height
and width of that text, and therefore you may find vertical text wrapped unpleasantly.

For an example of changing styles, see 3. Change the style of the headings.

7.2.6.3.2.1 Style Prefix

You can use style prefixes for table elements (tables of data, vertical tables, pivot tables). There are a set of preconfigured
table styles, which you can use or update if required. However, if you want to use different styles for different tables,
you can set up a new style with a prefix, and apply that style to specific tables as required. In this case, when you edit
the properties of that table, you can enter the prefix in the Style Prefix field, and during report generation, instead of
the default table styles, your new style will be used for that specific table.

For an example of how to create and apply a style prefix, see 4. Create a new style for even rows.

7.2.6.3.3 Set Up Schedules for Report Templates

If your database is hosted on a Wood Cloud server, you will see the Schedules toolbar button. Here you can configure
scheduled reports to automatically run periodically, sending the output to users by email.
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7.2.6.3.3.1 Add A New Scheduled Report

To create a new scheduled report, proceed as follows:

1. In the Configuration - Templates dialog, click Schedules to bring up the Scheduled Reports dialog.

2. In this dialog, click Add to add a new scheduled report.

3. In the dialog that appears, enter data as follows:

Field Description
Name You must specify a name for the scheduled report.
Report Select the report template based on which you want to generate the

scheduled reports.
Enabled Tick this checkbox to ensure enabling the scheduled report genera-

tion. If you untick this checkbox, no scheduled reports will be gen-
erated until you enable it again.

Recipients Add one or more recipients as a comma-separated list.
Run As Select the name of the person that the report will be generated under.
Include Date/Time in
Filename

To include the date and time of generation in the report filename,
select the Include Date/Time in Filename checkbox. To leave it out
from the filename, leave it deselected.
Example:

• Without Date/Time: test.rtf
• With Date/Time: 2020-10-02 1012 test.rtf

Start Specify the date and time when the scheduled report should be gen-
erated first.

Repeat Select the frequency for generating the scheduled report.
Note: The system calculates future report dates based on the Start
date and the selected frequency. For example:

• If the Start date is 1 January and the frequency is monthly, the
next report will be generated on 1 February.

• If the Start date is 31 January and the frequency is monthly, the
report will be generated on the last day of each relevant month,
such as 28 February, 31 March, 30 April, and so on.

• If the frequency is quarterly and the Start date is 31 March, the
report will run on the last day of each quarter, with the next
report generated on 30 June.

Function The Function dialog allows you to select a function to determine
the report generation’s behaviour upon being called at the scheduled
time. The function will return either a Yes or No as its result. If Yes,
the report is generated and the job is marked as completed. If No,
the report is not generated, and the job is also marked as completed.
The function must not have any parameters.

4. Click OK.

7.2.6.3.3.2 Regenerate Last Report Run

If you want to regenerate the report on an ad hoc basis before the next scheduled run-time, choose the Clear Last
Run toolbar button in the Scheduled Reports dialog. This will generate the report again without affecting the original
schedule. The Last Run Time value will be updated with the current date and time but the Next Run Time value remains
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unchanged.

7.2.6.3.4 Set a Report Template as a Dashboard

You can mark a particular report template as a dashboard report in the following ways:

• If you want the report template to be available as a dashboard on the DASHBOARD screen, edit the template
from the Configuration - Templates dialog and tick the Dashboard Report checkbox. In this case, Section

Heading, Multimedia Thumbnails and Table of Contents types will be marked with a sign to indicate that
these elements will not be displayed in a dashboard template.

• If you want the report template to be available as an asset dashboard on the Dashboard tab of the ASSETS
screen, edit the template from the Configuration - Templates dialog and tick the Asset Dashboard checkbox.
In this case, each time you view an asset on the ASSETS screen, with the Dashboard tab visible, your selected
dashboard template will be available for selection and the dashboard that you selected last will be executed.
Ensure that the template you use does not take long to execute, else, every time you change assets with the
Dashboard tab visible, you need to wait for the dashboard to be generated. Also, in order for a dashboard report
to reflect the selected asset in the asset hierarchy, it needs to have a simple source (see Sources) in it, which
retrieves VN_ID from a user input parameter.

ã See also

• Elements

• Sources

• Configure Reports and Dashboards

• Example: Set Up Anomaly Summary Report Template

• Example: Set Up Asset Integrity Report Template

• Example: Set Up Workpack Report Template

7.2.6.3.4.1 Elements

Elements appear in the bottom left part of the Add/Edit Report Template dialog under the ELEMENTS node. These
are the visual elements of the report, which actually appear in the report output, with the exception of the Element
Group.

You can edit the parameters of elements either by double-clicking them in the Report Layout structure or by selecting
them and choosing Edit from the toolbar.

ò Chart Template

This element allows you to insert preconfigured chart templates (see Chart Template) in your report template.

When you configure this element, make settings as follows:

• You must select a source. You can only select sources that have been added to the Report Layout
structure and if the chart template is part of an element group, the source must be included in the
same element group.

• Select the chart template that you want to include. The available chart templates in the drop-down
list are determined by the system by checking which chart template refers to the table that you
selected as a source above. You can only select from those chart templates that have a reference
to the Source that you selected (for example, they use data from that table for one of their axes).
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• Select whether you want to display a caption in front of the chart template in the report.

• Specify the width and height of the chart template as you want it to appear in the report.

ò Note

If you have a chart with a legend, and the legend can appear in a single row at the bottom of the
chart, it will be displayed there. If it cannot fit in a single row and it takes less then a third of the
available width, it will appear on the right-hand side of the chart. That is, if you set a relatively
narrow chart width (less than 400 or so, depending on the length of text in the legend items), the
legend may not appear at all.

For an example about how to use chart templates, see Add Page Break, Charts of Templates.

ò Comments

This element has no effect on the output report. It is intended for use by report designers to document the report
template itself.

ò Drawing Details

This element allows you to insert library items or drawings in your report template.

When you configure this element, make settings as follows:

• You must select a source. You can only select sources that have been added to the Report Layout
structure and if the drawing details element is part of an element group, the source must be
included in the same element group. For this element, you typically select the Library or Drawing
table.

• In the Caption Field field, select the field from which you want to retrieve the text under the
drawing. This can be Name from the Library table, or may be a function column.

• If you select Automatically Rotate for Page, the system will rotate the library item to fit the
layout of the report. For instance, if the report page has a portrait layout but the library item,
which is a PDF document, has a landscape layout, the system will rotate the library item to fit the
portrait layout of the report page.

• Under View Options (Layers), you can specify whether you want to display layers or traffic lights
on the drawings.

– If you select Display All Layers or Display Layers Linked to Assets in Asset Source, additional
selection fields are displayed:

∗ You must select the Asset Source from which layer data should be retrieved. You can
only select sources that have been added to the Report Layout structure and if the drawing
details element is part of an element group, the source must be included in the same
element group. Typically, the source that you select here should be linked to the Asset
table.

∗ In the Asset Field, Name Field and Colour Field fields, you specify the fields within
that Source to be used for the Asset (for example, the Component_ID), the Name (such
as Asset.Name, or any other field that will be meaningful), and optionally the Colour.
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– If you select Display Traffic Lights on Layers, you can select a preconfigured traffic light,
whose colours can be displayed on the layers of the drawing.

ò Note

• If your library item includes multiple pages (for example, a PDF document), only the first
page of this library item will be inserted in the report.

• Using layers or traffic lighting on layers in your drawings doesn’t work with relative assets.
It only works with specifically selected assets in your layers.

For an example of using this report template element, see Add Drawing Details and Extended Simple Source with
Filters.

ò Element Group

Element groups are used to repeat data for a series of records or to group sections of a report. For example, you can
use element groups to tabulate anomalies for a series of workpacks. You can also use Conditions in an element
group to make the group and all its contents only appear if the conditions are matched.

When you edit an element group, you have the following options in the Edit Element Group dialog:

Field/Checkbox
Name

Description

Name We recommend that you specify a name that reflects the content of the element group.
Allow
Excluding
Group
from Ex-
port

If selected, then when the report is being generated, the user will have the option to
exclude the output contained within this group to the report. For example, you may
set up an element group that outputs all Isometrics data for an asset. This typically
takes some time to export, so the user can choose NOT to include the Isometrics in
the generation of the report output.

Source If you’re using the element group to repeat data, or you want to specify conditions
for it, you’ll need to select a source for it, which must be a source inserted outside the
element group. Sources inserted inside the element group can be used only by the
elements within the element group.

Sort Col-
umn/Sort
Order

Allows you to set up sorting data based on a specific column in the source table and
specify if you want the order to be ascending or descending. When there are multiple
values for a group, those values will be displayed in the order specified. For example,
if your source is “Workpack”, you are sorting based on “Workpack.Name”, and you
have workpacks “2017 Inspection”, “2018 Inspection” and “2019 Inspection”, then
they will be displayed in that order in your report regardless of the order they might
have in the underlying database table. If you select the Repeat Elements checkbox,
the repeated elements will appear in the order specified in the Element Group. How-
ever, if the checkbox is not selected but the field is used in a Paragraph or Heading
element, the field’s multiple values will all be displayed at that point in the Paragraph
or Heading in the order specified in the Element Group. If the field has a single value,
sort order is irrelevant.

Repeat El-
ements

If selected, all the report elements within this element group will be run once for each
row in the source.

Action This field appears if the Repeat Elements checkbox is selected. This allows you to
control how elements are repeated based on the rows in the source. You can set up
repeating the elements for all the rows or only if there are no rows in the source, or
choose to set up conditions for repeating reporting elements only if specific condi-
tions are met or not met.

Condi-
tions

This field appears if you selected either of the options with conditions in the Action
field. Click the button to add, edit or delete conditions. Conditions can be on a
field in the source, or on the number of rows in the source, or the index of the row.
You can also compare row values (=. <, >, <=, >=, <>, contains) to a constant value.
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You can drop elements, including Simple Sources, into the Element Group. On the Filters tab of a Simple Source
within an Element Group, you can choose Group as a parameter, which will compare the field you have selected to
the value in the current row of the Element Group’s Source.

� Tip

You can use the Element Group element to make it easier to copy a group of elements to another
part of this report template. Once you have added the required elements to the element group, you
can use the Copy toolbar button to copy the group and then the Paste button to insert it to the report
template structure.

You can find several examples of using Element Groups in the following worked examples:

• Example: Set Up Anomaly Summary Report Template

• Example: Set Up Asset Integrity Report Template

• Example: Set Up Workpack Report Template

For an example of using a looping Element Group, see Create Simple Source with Filters and Looping Element
Group.

ò Multimedia Thumbnails

This element allows you to insert multimedia thumbnails in your report template.

When you configure this element, make settings as follows:

• You must select a source. You can only select sources that have been added to the Report Layout
structure and if the multimedia thumbnail is part of an element group, the source must be included
in the same element group. For this element, you typically select the Multimedia table.

• In the Caption Field field, select Name to ensure that the caption text is retrieved from the Name
field of the Multimedia table. You may also select a function column that returns details about
the event type and event number.

• In the Repository Field, specify the field that contains the image in the database. For the Multi-
media table, select Image in this field.

• In the Columns field, specify in how many columns you want images to be displayed.

• Select whether you want to display a caption above the image in the report.

• Specify the width and height of the image as you want it to appear in the report. The aspect ratio
of the thumbnails reflects the thumbnail dimensions you enter. In order to maintain the aspect
ratio of images, only set one dimension, Width or Height, and leave the other dimension as 0 or
blank.

ò Note

• Multimedia Thumbnails are not supported in Dashboard reports.
• When you put a multimedia thumbnail element in your report template, an additional se-

lection parameter is added automatically. This is useful when you set up multiple columns
to display images in the output but you have less images in the last row then the number of
columns. In this case, you can select the Merge Last Row to Centre Images for Multiple
Columns checkbox to merge the last row of the columns and display the images in the centre
of the page.
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For an example of using this report template element, see Add Multimedia Thumbnails with Element Group, Page
Break, Section Heading.

ò Page Break

With the Page Break element, you can force the upcoming elements to a new page in RTF, or to a new worksheet
in Excel, and in addition, you can make the following settings for the layout of the report below the element:

• You can define in how many columns you want data to be displayed.

• You can define a header and a footer for the pages below that. You can right-click to select from a predefined
set of system fields, database fields or style settings to be inserted. Note that in the HTML output, only the
header is considered.

• You can specify the layout (landscape or portrait) and the size (A3 and A4).

• For an Excel output, you can define the title of the new worksheet by specifying it as the name of the page
break. If you put a field in [square brackets] in the page break’s Name, the field will be substituted with its
value in the usual way. This is particularly useful if the page break is inside an element group with the Repeat
Elements option enabled; you can enter the value for this particular repeat as the page break name.

Settings that you make here persist until the next Page Break or Section Break element.

For example, you want risk charts to be displayed in a new page in RTF and you want them to be displayed in two
columns. You want to use a header and a footer with specific settings and you want the page layout to be landscape.
You make settings as follows:

1. Before the relevant Risk Chart element, add or edit the Page Break element in the Report Layout
structure.

2. In the Edit Page Break dialog, make settings as follows:
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• You enter the name Risk Charts, which will not be visible in the RTF or HTML output,
but this name will used for the new worksheet in the Excel output.

• Since you want to display the risk charts in two columns, enter 2 in the Section
Columns field.

• In the Header section, you want to display header data in two columns, thus, you create
2 rows for that, one for each column:

– In the first column, you want to add the company logo, so you right-click and select
Client Logo from the System Fields drop-down list.

– In the second column, you want to add a title “Risk Charts for <Asset>”, where
<Asset> is a variable and contains the Asset name and location. You want this
to appear with the style that you defined for Heading 1. Thus, you add a new
row and you right-click to select Heading 1 from the Set Style drop-down list.
You then enter “Risk Charts for” and right-click to select Database Fields → Risk
Assessment → Asset.

• In the Footer section, you want to display footer data also in two columns, thus, you
create 2 rows for that, one for each column:

– In the first column, you want to see when and by whom the report was generated.
For this, you want to apply the style that you defined for Footer. Thus, you right-
click and select Footer from the Set Style drop-down list. You then enter “Gen-
erated by NEXUS IC on” and right-click to select Date from the System Fields
drop-down list.

– In the second column, you want to display the current page number out of the total
number of pages.. For this, you add a new row and enter “Page [Current Page]
of [Total Pages]”, where you choose [Current Page] and [Total Pages] from the
System Fields drop-down list available by right-clicking.

• In the Layout field, select Landscape.

3. Click OK to apply the changes.

ò Result

When you generate the output, the new page will look in the RTF output as follows:
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ò Pivot Table

Pivot tables are conceptually similar to pivot tables in Excel. They aggregate data from many rows of a data source
into just a few rows, according to the rules you set up. For example, you can add a table that shows how many tasks
are in each of your workpacks, you can even break the table up by task completion, and so on.

When you create or edit a pivot table, you have the following options on the Properties tab of the Edit Pivot Table
dialog:

Field/Checkbox
Name

Description

Name We recommend that you specify a name that reflects the content of the pivot table.
To customize the table name in your rendered report, you can right-click in the Name
field and choose fields from the drop-down menu that appears. If the Show Caption
checkbox is selected, the selected fields will be incorporated into the title of the table.
This is especially useful when the table is inside an element group with the Repeat
Elements option enabled, as you can include the value for that particular repeat in
the table name.

Descrip-
tion

You can provide additional information about the pivot table in this field. This content
will appear in the Description column of the Configuration - Templates dialog.

Show Cap-
tion

If you select this checkbox, the table’s name will be shown above the table in the
generated report.

Show
Column
Totals

Enabling this option adds an extra row at the bottom of the table showing the aggre-
gate of values in each column.

Show Row
Totals

Enabling this option adds an extra column with the aggregate of each row. If you
have several Values, it will add several columns, one showing the aggregate of each.

Show Zero
Values

By default, this option is enabled and zero values are shown in the output. If you
disable this option, any values that would have shown “0” will be replaced with a
blank. This makes it easy to spot data in a sparsely populated grid.

Show
Rows
with All
Zero/Blank
Values

By default, this option enabled and if a row contains “0” value or no value at all, it
will be shown in the output. If you disable this option, these rows will be hidden.
This limits the pivot table to only rows which have aggregate data.

Show
Dash In-
stead of
“NaN”

By default, this option is enabled and if a cell has a value that is “Not a Number”
(“NaN”), a dash will be shown in that cell. If disabled, the output will appear as
“NaN”.

Fit Win-
dow

If you select this checkbox, NEXUS will limit the width of the table generated to
fit the width of the page in RTF or the browser window in HTML. However, if you
deselect this checkbox, the table will be as narrow or as wide as is necessary to display
all the data. Note that Microsoft Word’s RTF reader may not respect this setting
properly. To ensure proper formatting, save the document in .docx format by clicking
“Save As” in Word.

Style Pre-
fix

This field allows you to define a Style Prefix.

Source Select the source which the pivot table should retrieve data from. You can only select
sources that have been added to the Report Layout structure and if the pivot table is
part of an element group, the source must be included in the same element group.
Selecting a source for a pivot table is mandatory.
You can also have a more complex source: for example, if you only wanted to see
incomplete tasks, you would put a filter in your Simple Source for Is Completed not
equal to true. If you wanted to use a single Simple Source to show both all tasks and
all completed tasks, then instead of filtering the Simple Source, you would add an
extra field to it, with a function that returns 1 if the task is complete and 0 if it is not.
Then you would add a Values row to Sum that function.

Rows In this screen area, you add the fields based on which you want to group the rows of
your table. The values of these fields will appear then in the left-hand side column
of the pivot table.
Choose Add to add a new field row and select a field from the drop-down list. The
available fields are the fields from the database table that you selected as a source.
For example, if you wanted to see how many tasks were in each workpack, you would
set up a Simple Source on the Task table, and under Rows, you would choose Work-
pack as the Row field to pivot on. If you wanted that broken up by task completion,
you would choose Workpack and Is Completed as Rows. The table would then con-
tain two rows for each workpack that had both complete and incomplete tasks.
Adding field rows to a pivot table is mandatory.

Columns Optionally, you can break down data into additional categories and display them in
separate columns. For example, you have a pivot table for Anomalies where you
have a row for each anomaly ID and you calculate the number of anomalies for each
anomaly code in each row. You want to split this data and see the count separately
for the different closed-out statuses of the anomaly, which can be either ‘Open’ or
‘Closed’. In this case, you add the field Closed Out in this Column area and in
the output, you will see two columns: Open and Closed, with the total number of
anomalies for each closed-out status displayed separately in two different columns.

Values In this screen area, you define the main criteria based on which the system should
calculate the output values. Choose Add and define the following parameters:

• Field**: Select the field for which you want to perform the Aggregate function,
for example, if you want a simple count of tasks, choose Task_ID here. In most
of the cases, you select the unique identifier for the table, for example, header
ID, anomaly ID, finding ID.

• Aggregate: Select the function that you want to perform, for example, Count if
you want to calculate the number of tasks in a workpack. This function will be
performed for each cell in the table separately for each row.

• Aggregate (Total): This is the value shown under Column Totals or Row Totals
(if selected). Often you want the same aggregate for cells within the table and
for end-of-row or end-of-column values (for example, for a Value where you’ve
chosen Average, you want Totals to also be Average, giving a grand mean), but
sometimes you want the Total value to have a different aggregate from cells
within the table.

• Name: Enter the name that you want to appear as the column header. For ex-
ample, for counting tasks, you can enter a name such as ‘Number of Tasks’.

• Sort Order: Specify the order by which to sort the aggregate values. This will
order the rows of the table by either Ascending or Descending order and will
only order by the first column of aggregate values.

Specifying value entries for a pivot table is mandatory. You can also specify several
different Values entries. For example, you can add a second Values entry on ‘Approx
Timing’, with an Aggregate of Sum, and a name like ‘Total Time Estimate’. Each
additional Values entry will result in an extra column in the output table.
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The Styles tab lets you set conditional Styles for this table. In your Conditions, set Field to [Column Name],
Comparison to Contains, and Value to the column name. This is because as far as the pivot table is concerned, it’s
not using the underlying data source column — it’s using a new pivot table column with a similar name.

Example

You want to create a pivot table for Anomalies, where you want to see the number of anomalies for each anomaly
code. You also want to see the number of anomalies broken down based on the priority of the anomalies and you
want to see the total number of anomalies for each anomaly code and each priority. In this case, you make settings
in the Edit Pivot Table dialog as follows:

• You tick the Show Row Totals and Show Column Totals checkboxes.

• You select the Anomaly table as a source.

• You add a row field for anomaly codes (Code).

• You add the column field Priority.

• You add a Value entry for the field Anomaly_ID and select Count for both Aggregate values.
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In this case, the pivot table in the report output appears as follows:

For further examples of using pivot tables, see Example: Set Up Workpack Report Template.

ò Risk Chart

This element allows you to insert preconfigured risk charts in your report template.

When you configure this element, make settings as follows:

• You must select a source. You can only select sources that have been added to the Report Layout structure
and if the risk chart is part of an element group, the source must be included in the same element group. Note
the following:

– Most often, you use the Risk Assessment table as a source for your risk models.

– You can also use the Anomaly table, in which case, each anomaly’s risk score is used to
place it on the diagram. Anomalies do not have a Likelihood or Consequence to give them
an X/Y position on the diagram, they only have a risk score. So if your diagram has several
squares with the same risk score (as is usually the case), your anomalies will be placed in
the left-most such square. That is, risk-assessed assets are placed in a particular square, but
anomalies are merely placed in a particular band. To make this risk model work, you must
have made the following settings:

∗ You must have specified the risk chart in the Anomaly Risk Chart field on the Database
tab under Database → Properties.

∗ You must have set up the System - Anomaly - Risk Score function that calculates the
risk score for each anomaly.

For more information, see Set Up Anomaly Risk Matrix.

• Select whether you want to display a caption in front of the risk chart in the report.
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• Select the Show Count checkbox if you want to show the number of risk results in each square that has risk
results. If you do not select this option, you will only see a dot in each square that has one or more risk results.

• Specify the width and height of the risk chart as you want it to appear in the report.

For an example of using risk charts, see Add Risk Charts with Element Group, Page Break, Section Heading.

ò Section Break

Similar to Page Break above, but it does not force a new page and does not let you choose paper size and orientation.

ò Section Heading

This element lets you set up headings in your report. You can configure section headings as follows:

• In the Name field, enter the name of the section heading to identify the heading within the Report Layout
structure. This text does not appear in the actual report output.

• Right-click within the Content field to insert a list of fields and styles, or simply type text. This will appear
as the actual section heading text in the report output.

• Select the Include in Table of Contents checkbox to have this section heading appear in the Table of Con-
tents.

• In the Default Style field, select the preconfigured style that you want to apply for the section heading. For
more information about the preconfigured styles, see Styles.

Section headings are applicable only for RTF and HTML outputs. Section Headings are not supported in Dashboard
reports, you can use a Text (Paragraph) element instead.

You can find several examples of using Section Headings in the following worked examples:

• Example: Set Up Anomaly Summary Report Template

• Example: Set Up Asset Integrity Report Template

• Example: Set Up Workpack Report Template

ò Table of Contents

The Table of Contents element inserts a hyperlinked Table of Contents in the report output. In HTML outputs, any
section headings will appear with “Top of report” hyperlink.

To configure the appearance of table headings, use the elements starting with TOC in your generic report style
configurations (see Styles).

This element is applicable only to RTF and HTML outputs. Table of Contents elements are not supported in
Dashboard reports.

ò Note

In the RTF output, you must right-click and update the table of contents to ensure that page numbers
appear correctly.
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For an example of using this report template element, see Insert Table of Contents, Verify Output.

ò Table of Data

The Table of Data element outputs a simple table with columns and rows and retrieves data from a Source assigned
to it.

When you create or edit a table of data, you have the following options in the Edit Table of Data dialog:

• Properties tab:

Field/Checkbox
Name

Description

Name We recommend that you specify a name that reflects the content of the table of
data. To customize the table name in your rendered report, you can right-click in
the Name field and choose fields from the drop-down menu that appears. If the
Show Caption checkbox is selected, the selected fields will be incorporated into
the title of the table. This is especially useful when the table is inside an element
group with the Repeat Elements option enabled, as you can include the value
for that particular repeat in the table name.

Descrip-
tion

You can provide additional information about the table of data in this field. This
content will appear in the Description column of the Configuration - Templates
dialog.

Show
Caption

If you select this checkbox, the table’s name will be shown above the table in the
generated report.

Fit Win-
dow

If you select this checkbox, NEXUS will limit the width of the table generated to
fit the width of the page in RTF or the browser window in HTML. However, If
you deselect this checkbox, the table will be as narrow or as wide as is necessary
to display all the data. Note that Microsoft Word’s RTF reader may not respect
this setting properly. To ensure proper formatting, save the document in .docx
format by clicking “Save As” in Word.

Hide
Columns
with No
Values

If you select this checkbox, any column that is entirely empty will be omitted
from the output report.

Merge
Cells for
Rows
with
Equal
Values

If you select this checkbox, the report output will minimise repetition of infor-
mation by merging any adjacent matching cells in the table. If you don’t select
it, adjacent matching cells will not be merged. Note that this setting is ignored
in Excel outputs.

Show
Table if
Empty

If you select this checkbox, empty tables will still be displayed with column
names without data. Otherwise, empty tables will be entirely omitted from the
report.

Style Pre-
fix

This field allows you to define a Style Prefix.

Source Select the source which the table of data should retrieve data from. You can
only select sources that have been added to the Report Layout structure and if
the table of data is part of an element group, the source must be included in
the same element group. If you click OK after selecting a Source, a drop-down
arrow appears next to the Table of Data. This shows the Simple Source you
have attached to the table. This is the same object as the Simple Source shown
elsewhere in the tree. If you change one instance of the simple source, it will
make changes to the other. If the Simple Source is connected to several tables,
for example, Drawing Details, Chart Templates, or Risk Charts, making changes
to any one will make changes to all.
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The following image shows the right-click option available from the Name field:

• Layout tab:

The top half of this tab lists all the columns that will be included in the table. You can do the following here:

– Choose which columns are visible in the report by selecting the relevant option from the Visible column.
You can choose Include All or Exclude All to make all the columns in the list visible or invisible,
respectively.

– Assign columns to a category. If you place several columns in the same category, they will be grouped
together and the category headers will be visible in the generated report. Note that categories are only
considered in the HTML and RTF outputs, they are ignored in the Excel output.

– Define the alignment of content within the cell for each column.

If the Show Data button is set to All Data, NEXUS will display data from the table specified in this table’s
source, complete with any extra columns you may have added. This can give context and make it easier to
understand what the final generated table will look like.

³ Caution

If the table contains many rows, this may take up to 5 seconds. After this time, NEXUS will
stop fetching additional rows, and will display only the rows that it has fetched.

The bottom part of the tab shows how the columns will be displayed in the output. You can perform the
following actions here:

– Drag and drop column headings to reorder them in your table.

– Click on one or more column headings to sort by that column. Shift-click a column to add it; Ctrl-click
a column to subtract it from the set of columns we’ll sort on. Click or shift-click a column a second
time to change sort direction.

– You can change the width of columns by hovering the mouse over the right edge of the column header,
and then either double-clicking or by clicking and dragging the column to a new width. This will change
the column widths in the generated report.

• Styles tab:

You can use this tab to highlight table cells or rows, use particular fonts, sizes or colours, change spacing, and
to change the lines used to draw the table. You can choose a style here to be used when particular conditions
are matched. You can also add a legend to explain what a special formatting refers to, which will appear
under the table.

A style can be applied to a row or to a cell. If you want it to apply to a cell, be sure to set your condition
to include “[COLUMN NAME] equals” in addition to the value you actually want to filter on, in order to
restrict the filter to just that cell.
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For example, you want to highlight cells where the Priority column value is High with red colour. In this
case, you do the following:

1. On the Styles tab page, click Add.

2. In the Applies To column, select Cell from the drop-down list.

3. Double-click in the Conditions column and click the ellipsis , which opens the Edit Conditions
dialog.

4. Add two conditions, one for the COLUMN NAME field that equals to Priority and one for the COLUMN
VALUE field that equals to High:

5. Click OK.

6. Back on the Styles tab, in the Style column, select the Fill - Red style.

7. In the Legend Label column, enter High Priority Anomalies. The red colour and this text will be added
as a legend at the bottom of the table.

8. Click OK.

ò Result

When you generate the output, in the Priority column, cells with the value High will be highlighted
by red:
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9. Let’s say that you also want to highlight the Asset Name cell for the items that have the Priority value
High. In this case, follow the process above except that you create one condition for the COLUMN
NAME field that equals to Name and one for the Priority field that equals to High:

ò Result

In this case, when you generate the output, the corresponding Name cell will be high-
lighted with red too:

ò Note

To add/edit/delete styles that you can apply, go back to the Configuration - Templates dialog and
choose the Styles toolbar button.

For an example of using this report template element, see Create Table of Data for Anomaly List, Apply Styles.

ò Text (Paragraph)

Text entered in the Content field will be displayed as text in the report output. You can enter your text directly or
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you can use the right-click menu to insert:

• System fields, such as date, logo, image, and so on

• Database fields, which you can choose from a single source that the element can access (that is, the source
has been added to the Report Layout structure and is in the same element group)

• Styles to be applied to the paragraph text. If you insert a style element, any text that appears after that element
will have that specific style applied until the next style element. By default, the Body style will be applied.
For more information about the preconfigured styles, see Style).

Note that some styles are only applicable to specific output types, for example, heading styles are only applicable
to RTF and HTML outputs, but not to Excel outputs.

For examples of using this report template element, see Example: Set Up Workpack Report Template.

ò Vertical Table

The Vertical Table element is similar to the Table of Data element, but rotated by 90 degrees. In a Vertical Table,
the left-most column contains the ‘column headers’.

Vertical Tables are useful when you have a single record with lots of fields in it, for example, a checklist item or an
event definition with lots of fields.

The settings for a Vertical Table are the same as the settings for a Table of Data element. For more information, see
the description of the Table of Data element above. The only difference is that in the case of a Vertical Table, you
can set the width of the header column by setting a Header Width (%) value, which determines the percentage of
the header column width as compared to the width of the whole table.

Entering 2 or more Number of Header Columns arranges the output fields in a form-like layout. This is most
commonly used when you are outputting the details of a single record.

In the example below, the Vertical Table is included in an element group that loops on each anomaly. The Vertical
Table has a single source assigned, which is filtered on the Anomaly ID field of the Anomaly table and the number
of header columns is set to two:
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For an example of using this report template element, see Create Section Heading, Vertical Table with Extended
Simple Source.

ã See also

• Configure Report Templates

• Sources

• Configure Reports and Dashboards

• Example: Set Up Anomaly Summary Report Template

• Example: Set Up Asset Integrity Report Template

• Example: Set Up Workpack Report Template

7.2.6.3.4.2 Sources

Sources appear in the bottom left part of the Add/Edit Report Template dialog under the SOURCES node. Sources
are the links between the database data and the visual elements.

Most of the visual elements in the report require a source element to retrieve data from. To ensure that a visual element
can retrieve data from a source element, the source element must be added to the Report Layout structure and it must
be in the same element group.

You can edit the parameters of sources either by double-clicking them in the Report Layout structure or by selecting
them and choosing Edit from the toolbar.

ò Note

A source without a parent source or table will be displayed with a question mark indicator over its icon.
This is an easy way to identify sources that have not been set up or are no longer in use.

ò Distinct Source

Sometimes, you want only a subset of a table’s rows, showing each value, or a combination of values, just once. In
this case, you create a distinct source that references a simple source.

For example, you want a table with a list of asset types that are actually in use, but this might be different from the
full list from the Asset Location table. In this case, you proceed as follows:

1. Create a Simple Source and set its table to Asset Location.

2. Create a Distinct Source and make the following settings:

• Set its Source to your simple source.

• Select the Asset Type column.
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3. Create a Table of Data and set its source to your distinct source.

ò Result

The Distinct Source returns one row for each value of asset type found in
the Asset Location table.

� Tip

Another way of grouping rows is using a pivot table.
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ò Parameter Source

If you want to use parameters specified by the user in headings, text, and so on, add a Parameter Source. You don’t
need one of these to use parameters in simple source filters.

ò Simple Source

Simple sources are the most frequently used sources in report templates. Each single source must be linked to a
table, which you can do on the Properties tab of the Edit Simple Source dialog. The table you choose will depend
on the data you want to show, for example, if you want to display GVI event data, you choose your GVI event table.
If you want to display data about events overall, you would choose the Event table.

Optionally, you can add additional fields to the source or set up filters as required (see below for more information).

Manage Fields
In addition to the fields that are included in the selected source table, you can add additional fields to the source,
which can be a field from another table, or a new field that contains the result of a function. You can do that on
the Fields tab of the Edit Simple Source dialog. The Fields tab shows all the fields in the selected source table
(visible when the Show Local Columns button is selected), plus, any extra fields that you have added.

To add a new field, proceed as follows:

1. On the Fields tab of the Edit Simple Source dialog, choose Add.

2. In the toolbar, choose Input and select one of the following options:

• Field. . . , if you want to add a new field from another table. This adds a new field with the type Simple
Column (Existing Field).

• Function. . . , if you want to add a new field that contains the result of a function. This adds a new field
with the type Function (Result from a Function).

3. From the dialog that pops up, select the field or function as required.

4. Click OK to save your changes.

You can delete only fields that you have added, you cannot delete local fields from the selected source table.

Set Up Filters
You can set up filters for the simple source on the Filters tab of the Edit Simple Source dialog. This allows you to
control which rows are returned from the table.

To set up a filter for a simple source, on the Filter tab of the Edit Simple Source dialog, proceed as follows:

1. In the Fields column, select the field based on which you want to set up your filter:

• If you want to use a field from the local source table, select the field from the drop-down list.

• If you want to use a field from another table, choose to pick the field you want from any
table.

2. In the Comparison and Not columns, select the operation that you want to perform for filtering.

Operator Description
= Use this operator if you want the value of the field to be exactly the same as the

value you select in the Value column. If you want to test whether a key is null,
just use ‘=’ as the comparison, and leave the value blank.

<, >, <=
and >=

These operators are only meaningful for numeric and whole number types.

Is Child
Of

This is a special operator that is only available if you selected the VN_ID field
of the Asset Location table. VN_ID is the unique identifier of an asset in the
hierarchy. If you select this field with the Is Child Of operator, and as a Value,
you select an asset in the hierarchy, then the simple source returns the asset
together with all its children in that hierarchy.

in This operator is similar to = (equal), however, in this case, you can multiselect
items in the Value column, that is, you can pick several items that the field can
be equal to.

like This is basically a “contains” operator and is relevant only for alphanumeric
fields. If you use this operator, then in the Value column, you can use ‘%’
(percent) to match several unknown characters, and ‘_’ (underscore) to match
a single unknown character. For example, if you specify _VI, it would match
‘GVI’ and ‘CVI’; if you enter PL %, it would match ‘PL Anode’, ‘PL Damage’,
and so on.

7.2. Configuration 205



NEXUS Documentation, Release 6.9.xxxxx.0

If you select the checkbox in the Not column in conjunction with the selected operator, the oppo-
site function of the operator will be used for filtering. For example, if you select the checkbox in
the Not column and you select the = operator in the Comparison column, the system will filter
for the values that are NOT equal to the selected value.

3. In the Parameters column, specify how you want the values for the filter to be selected. You
have the following options:

Parame-
ter

Description

None This option allows you to immediately select the value from the Value column
of this dialog.

User If you select this option, the user will be able to select the value from a dialog
upon executing the report. The field that you selected will be a selection field and
the user must select a value for that before the actual report output is generated.
if you choose ‘=’ for your Comparison, the user will be able to choose one item;
if you choose ‘in’, the user will be able to choose several items.

Group This option has meaning only if this Simple Source is inside an Element Group.
If you choose this option, then this filter will pick its value from the Simple
Source used for the Element Group.

4. In the Value column, assign a value to your filter as required. If this is a string or a numeric or a
whole number field, you can simply type a value in. If your filter field is a key to another table,
you can use the to pick a value. For example, in the Event table, the fields Asset, Event Type,
Survey Set and Workpack are keys to other tables. If your source table is Event, and your filter is
on the Workpack field, clicking the button will bring up a list of workpacks to pick from.

5. In the Actions column, you can add additional filters or remove filters as required by choosing
the + or - button respectively.

6. If required, you can connect your filters by grouping them and using the All or Any connectors.
If you have multiple filters, you’ll see a drop-down list at the left and you can choose one of the
following options:

• If you select All, then all the filter criteria must be met for data to be returned.

• If you select Any, then if any criterion is met, data will be returned. (All and Any are equiv-
alent to SQL’s AND and OR.)

You can construct more complex combinations by grouping rows. To do that, use the Shift and/or
Ctrl keys on the keyboard, click filters to multi-select and click Group. The rows you selected will
be joined together into a group with their own Any/All filter, and that group will be connected
to other groups with a separate Any/All connector. By choosing your grouping and choosing
Any/All as appropriate, you can construct any logical expression you desire. You can ungroup
rows by selecting a row within a group and clicking Ungroup.

Example

You want the simple source to return assets within the Asset Location table, which fulfil the
following conditions:

• In the asset hierarchy, they are under the Offshore node AND

– They either have the characters PL in their asset name OR

– They have the asset type Pipeline, Pipeline Section, Platform or Topside Structure
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In this case, you create the filters as shown below:

That is, you create the filters as follows:

1. You create a filter for the field VN_ID within the Asset Location table, with Comparison
Is Child Of and Value Offshore.

2. You add a filter for the field Name within the Asset Location table, with Comparison
like and Value %PL%.

3. You add a filter for the field Asset Type within the Asset Location table, with Compar-
ison in and Values Pipeline, Pipeline Section, Platform or Topside Structure.

4. You group the filters for VN_ID and Asset Type (select them and choose Group) and set
their connectors to Any. You leave their connection to the first filter with the connector
All.

Special Fields
There are special fields that can be useful for reports run using the Reports toolbar button from specific
screens in NEXUS IC:

Screen Special Field
ASSETS VN_ID
LIBRARY Library_ID
PLANNING VN_ID
WORKPACKS Workpack_ID
INSPECTION Header_ID or Finding_ID (depending on what is visible)
ANOMALY Anomaly_ID

If you select one of these special fields when you set up the filter for your source and you select the
User parameter option, then when a user runs your report template from the appropriate screen, the
currently selected item will be pre-populated into the parameter in the report generation dialog.

For example, if you set up a report template with the Anomaly_ID field, then when the user runs your
template from the ANOMALY screen, the currently selected anomaly will be automatically selected
in the report generation dialog.

ò Union Source

A Union Source lets you join together results from several other Sources, much like SQL’s UNION ALL. In the
Union Source, select the sources you’d like to pull data from. Only columns that are common to all selected sources
will be passed through to any element that consumes the Union Source. So if you chose two tables, both of which
had a Name column, your Union Source would have a Name column.

ò Note

When configuring a Union Source, ensure that every source being unioned is named differently,
otherwise when saving and loading a report template, the sources within the Union Source will not
all be retained.
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ã See also

• Configure Report Templates

• Elements

• Configure Reports and Dashboards

• Example: Set Up Anomaly Summary Report Template

• Example: Set Up Asset Integrity Report Template

• Example: Set Up Workpack Report Template

7.2.6.3.4.3 Example: Set Up Anomaly Summary Report Template

In this example, we create a report template called “Anomaly Summary”, which demonstrates the usage of the following
report template elements:

• Report layout with header and footer

• Table of data with specific formatting and styles

• Section breaks and page breaks

• Chart templates

• Table of Contents

This example guides you through the following steps:

1. Create Template, Set Layout, Add Header, Footer, Title
2. Create Table of Data for Anomaly List, Apply Styles
3. Create Table of Data for Anomaly Actions, Use Style Prefix
4. Add Page Break, Charts of Templates
5. Insert Table of Contents, Verify Output

7.2.6.3.4.4 Create Template, Set Layout, Add Header, Footer, Title

As a first step, you create the report template, set up its size and layout, create a Section Break to define header and
footer and add a Section Heading to add a title. See the detailed steps below:

1. Create a new report template and specify the report layout.
2. Insert a Section Break to set up the header and footer of the report.
3. Add a level-1 Section Heading.

7.2.6.3.4.5 Process

7.2.6.3.4.6 1. Create a new report template and specify the report layout.

1. In NEXUS IC, choose Configuration → Reports and Dashboards → Templates from the menu.
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2. Choose Add to create a new report template.

3. In the top half of the Add Report Template dialog, specify the name, status and category of the report as follows:

• Name: Enter Example: Anomaly Summary

• Status (optional): Select from the list of preconfigured statuses (see Configure Report Statuses), for exam-
ple, Under Construction.

• Category (optional): Select from the list of preconfigured categories (see Configure Report Categories),
for example, Anomaly.

4. Under the Template Definition section of the dialog, configure the size and layout of the report by double-clicking
the top Report Layout node on the right-hand side of the dialog. In this example, we select layout Landscape
and page size A3.
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ò Note

This size and layout settings will prevail until the next page break element, where you can overwrite
these settings.

7.2.6.3.4.7 2. Insert a Section Break to set up the header and footer of the report.

You want to add a logo and the name of the report in the header of the report (2 columns) and in the footer, you want
to add the generation date and software version in one column and the current page number in the second column. To
do this, follow the steps below:

1. Under the Template Definition section of the Add Report Template dialog, select the
Section Break element from under the ELEMENTS node and drag it under the Report
Layout node on the right-hand side of the dialog. Alternatively, you can select the element

and choose Add from the toolbar.

2. Double-click the Section Break element that you have inserted under Report Layout or

select it and choose Edit.

3. Enter a name and description as required and leave the value 1 for Section Column.

4. In the header, you want the logo in one column and the title of the report in another column,

thus, in the Header area of the dialog you enter 2 rows :

a. Right-click in the editor area of Header and choose System Fields → Client Logo.

b. Press Enter to create a new row.

c. You want to style the text of the report title with the predefined style Heading 1, so
right-click and choose Set Style → Heading 1.

d. Enter the name of the report Anomaly Summary Report.

5. In the footer, you want the generation date and software version in one column and the
current page number out of the total page in the second column, thus, in the Footer area

of the dialog you enter 2 rows :

a. In the editor area of Footer, right-click to select the predefined Footer style and select
Set Style → Footer.

b. Enter Generated on.

c. Right-click and select System Fields → Generation Date.

d. Enter using.

e. Right-click and select System Fields → Version.

f. Press Enter to create a new row and enter Page.

g. Right-click and select System Fields → Current Page.

6. Click OK.
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7.2.6.3.4.8 3. Add a level-1 Section Heading.

To add a main title to the report, with Heading 1 style, proceed as follows:

1. Add a Section Heading element to the Report Layout structure (see insertion methods
above).

2. Double-click the element in the structure to edit it.

3. Enter a name that identifies the element in the structure. This text does not appear in the
actual report output.

4. Enter the text of the heading that you want to see in the output in the Content field. This
time, we just want to use the heading Anomaly Summary, but you can use right-click in
this field if you want to add a variable.

5. Select the Include in Table of Contents checkbox to have this section heading appear in
the Table of Contents.

6. In the Default Style field, select Heading 1, which is a preconfigured style that can be
applied for level-1 section headings. If required, you can set up your own style and apply
that instead (see Styles).

7. Click OK.
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Proceed to Next Step

7.2.6.3.4.9 Create Table of Data for Anomaly List, Apply Styles

In this step, you create a Table of Data that lists our anomalies. For that, you create the following:

• An Element Group to include all the tables for anomalies

• A level-2 Section Heading to be included in the output before the table

• A Simple Source for the Anomaly system table, from which the Table of Data can retrieve data

• The actual table of data for the Anomaly List applying different styles to it

See the detailed steps below:

1. Insert an Element Group for the anomaly tables.
2. Insert a level-2 Section Heading for the list of anomalies.
3. Insert a Simple Source for Anomalies.
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4. Insert a Table of Data element for Anomaly Listing.
5. Apply a colour to specific rows of the table.
6. Apply a colour to specific cells of the table.

7.2.6.3.4.10 Prerequisites

You have completed the following step:

• Create Template, Set Layout, Add Header, Footer, Title

7.2.6.3.4.11 Process

7.2.6.3.4.12 1. Insert an Element Group for the anomaly tables.

This element will contain the anomaly tables that we’re going to create.

1. Add an Element Group element to the Report Layout structure (see insertion methods in previous steps).

� Tip

If the element is not inserted to the right location in the element structure, use the Move Up or Move Down
buttons in the toolbar to move them to the correct place.

2. Double-click the element in the structure to edit it.

3. Enter the name Anomaly Tables, which will identify the element in the structure. You do not need to make other
settings for the element group right now.

4. Click OK.

7.2.6.3.4.13 2. Insert a level-2 Section Heading for the list of anomalies.

1. Add a Section Heading element to the Report Layout structure so that it is included within the
Anomaly Tables element group.

2. Double-click the element in the structure to edit it.

3. Enter a name that identifies the element in the structure, for example, Anomaly List Heading 2. This
text does not appear in the actual report output.

4. Enter the text of the heading that you want to see in the output in the Content field. This time, we
just want to use the heading List of Anomalies, but you can use right-click in this field if you want to
add a variable.

5. Select the Include in Table of Contents checkbox to have this section heading appear in the Table
of Contents.

6. In the Default Style field, select Heading 2, which is a preconfigured style that can be applied for
level-2 section headings. If required, you can set up your own style and apply that instead (see Styles).

7. Click OK.
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7.2.6.3.4.14 3. Insert a Simple Source for Anomalies.

This simple source will be used as the data source for the anomaly list Table of Data that we are going to create.

1. Add a Simple Source element to the Report Layout structure so that it is included within the
Anomaly Tables element group. The Simple Source element is located under the SOURCES node

within the Template Definition section of the dialog.

ò Note

You must insert the simple source within the element group, else, you cannot refer to it from
the other elements of the element group.

2. Double-click the Simple Source element in the structure to edit it.

3. Specify the name Anomaly* for the simple source.
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4. In the Table field, click the ellipsis to select the System Table Anomaly.

5. Click OK.

7.2.6.3.4.15 4. Insert a Table of Data element for Anomaly Listing.

1. Add a Table of Data element to the Report Layout structure so that it is included within the Anomaly Tables
element group and it is below the Section Heading element.

2. Double-click the element in the structure to edit it.

3. On the Properties tab, make settings as follows:

• Name: Enter Anomaly Listing

• Description: Enter a descriptive text, such as List of anomalies from Anomaly table

• Tick the following checkboxes:

– Show Caption
– Fit Window
– Hide Columns with No Values

• Source: Select the Anomaly source from the drop-down list. The available values in this field are retrieved
from the sources that have been created under the current element group.

4. On the Layout tab, make settings for the column visibility, the category into which a column is assigned to and
the layout as follows:
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• Change the visibility of the Action Overdue column to Yes and the Assigned To column to No by changing
the respective values in the Visible column. This will ensure that the table will include the Action Overdue

column, but it will not include the Assigned To column in the output.

• Change the category of the Action Overdue column to Anomaly Details. You can do that by directly
overwriting the current value in the Category column. This will change the category in the layout of the

table in the RTF and HTML output. Categories are not visible in the Excel output.

• At the bottom of the tab, you can see the layout of the table as it will appear in the output. Drag the Anomaly
Number column before the Name column so that it appears as the first column within the Anomaly Details

category.

• Click the Asset column title. You can see that an arrow appears next to the column title. It indicates that

the rows of the table will be sorted based on the values of the Asset column.

5. Click OK.

7.2.6.3.4.16 5. Apply a colour to specific rows of the table.

In the table of data, you want to highlight each row that contains an anomaly with the code CR (Crack) with orange
colour. To do that, proceed as follows:

1. Double-click the Table of Data element in the structure to edit it again.

2. Go to the Styles tab.

3. Choose Add.

4. In the Applies To column, select Row.
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5. Double-click in the Conditions column and click the ellipsis , which opens the Edit Conditions
dialog.

6. In that dialog, choose Add.

7. Double-click in the respective columns to make the following settings:

• Field column: Select the Code field

• Comparison column: Select =

• Value column: Click the ellipsis and select CR (Crack).

8. Click OK.

9. Back on the Styles tab, in the Style column, select Fill – Orange to change the colour of the row to
orange.

ò Note

The available styles are preconfigured. You can adjust or create new styles as described
in Set Up Styles for Report Templates

10. In the Legend Label column, enter CR Anomalies. The orange colour and this text will be added as
a legend at the bottom of the table.

11. Click OK.

ò Result

In the output, the row of the anomaly with the code CR is now highlighted with orange colour and a
legend is added at the bottom of the table:
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7.2.6.3.4.17 6. Apply a colour to specific cells of the table.

Now, we want to highlight cells where the Priority column value is High with red colour. Still in the Edit Table of
Data dialog for the Anomaly Listing table of data, proceed as follows:

1. On the Styles tab page, click Add.

2. In the Applies To column, select Cell from the drop-down list.

3. Double-click in the Conditions column and click the ellipsis , which opens the Edit Conditions dialog.

4. Add two conditions, one for the COLUMN NAME field that equals to Priority and one for the COLUMN VALUE
field that equals to High:

5. Click OK.

6. Back on the Styles tab, in the Style column, select the Fill - Red style.

7. In the Legend Label column, enter High Priority Anomalies. The red colour and this text will be added as a
legend at the bottom of the table.

8. Click OK.

ò Result

When you generate the output, in the Priority column, cells with the value High will be highlighted by red:
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9. Let’s say that you also want to highlight the Asset Name cell for the items that have the Priority value High. In
this case, follow the process above except that you create one condition for the COLUMN NAME field that equals
to Name and one for the Priority field that equals to High:

ò Result

In this case, when you generate the output, the corresponding Name cell will be highlighted with
red too:
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ò Note

To add/edit/delete styles that you can apply, go back to the Configuration - Templates dialog and choose
the Styles toolbar button.

Proceed to Next Step

7.2.6.3.4.18 Create Table of Data for Anomaly Actions, Use Style Prefix

In this step, you create a Table of Data to list the anomaly actions and you want to use a Style Prefix to apply a specific
colour to even rows.

For that, you create the following:

• A level-2 Section Heading to be included in the output before the table

• A Simple Source for the Anomaly Actions system table, from which the Table of Data can retrieve data

• The actual table of data for the Anomaly Actions applying a Style Prefix to it

See the detailed steps below:

1. Insert a level-2 Section Heading for the list of anomaly actions.
2. Insert a Simple Source for Anomaly Actions.
3. Insert a Table of Data element for Anomaly Actions.
4. Create a new style for even rows.
5. Apply the New style prefix to your Table of Data.

7.2.6.3.4.19 Prerequisites

You have completed the following steps:

• Create Template, Set Layout, Add Header, Footer, Title

• Create Table of Data for Anomaly List, Apply Styles

220 Chapter 7. Setup and Configuration



NEXUS Documentation, Release 6.9.xxxxx.0

7.2.6.3.4.20 Process

In this example, you work in the same Anomaly Tables Element Group that you have created in the previous step.

7.2.6.3.4.21 1. Insert a level-2 Section Heading for the list of anomaly actions.

1. Add a Section Heading element to the Report Layout structure so that it is included within the Anomaly Tables
element group.

2. Double-click the element in the structure to edit it.

3. Enter a name that identifies the element in the structure, for example, Anomaly List Heading 2. This text does
not appear in the actual report output.

4. Enter the text of the heading that you want to see in the output in the Content field. This time, we just want to
use the heading Anomaly Actions, but you can use right-click in this field if you want to add a variable.

5. Select the Include in Table of Contents checkbox to have this section heading appear in the Table of Contents.

6. In the Default Style field, select Heading 2, which is a preconfigured style that can be applied for level-2 section
headings. If required, you can set up your own style and apply that instead (see Styles).

7. Click OK.
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7.2.6.3.4.22 2. Insert a Simple Source for Anomaly Actions.

This simple source will be used as the data source for the anomaly actions Table of Data that we are going to create.

1. Add a Simple Source element to the Report Layout structure so that it is included within the
Anomaly Tables element group. The Simple Source element is located under the SOURCES node
within the Template Definition section of the dialog.

ò Note

You must insert the simple source within the element group, else, you cannot refer to it from
the other elements of the element group.

2. Double-click the Simple Source element in the structure to edit it.

3. Specify the name Anomaly Action* for the simple source.

4. In the Table field, click the ellipsis to select the System Table Anomaly Action.

5. Click OK.
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7.2.6.3.4.23 3. Insert a Table of Data element for Anomaly Actions.

1. Add a Table of Data element to the Report Layout structure so that it is included within the Anomaly Tables
element group and it is below the Section Heading element that you created for Anomaly Actions.

2. Double-click the element in the structure to edit it.

3. On the Properties tab, make settings as follows:

7.2. Configuration 223



NEXUS Documentation, Release 6.9.xxxxx.0

• Name: Enter Anomaly Actions

• Description: Enter a descriptive text, such as List of anomaly actions from Anomaly Action table

• Tick the following checkboxes:

– Show Caption
– Fit Window
– Hide Columns with No Values

• Source: Select the Anomaly Action source from the drop-down list. The available values in this field are
retrieved from the sources that have been created under the current element group.

4. On the Layout tab, you can hide columns or rearrange the layout as required, see the previous example for more
information.

5. Click OK.

7.2.6.3.4.24 4. Create a new style for even rows.

The default colour for odd rows is white and for even rows, it is grey. In this example, you want to change the colour
of even rows to light blue. To do that, follow the steps below:

1. Click OK to save your changes to the report template and go back to the Configuration - Templates dialog.

2. Choose the Styles toolbar button.

3. Choose Add to define a new style for even rows.

4. Specify a name, which includes the name of the default style plus a prefix, for example, “New Table Even Rows”.
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In this case, the prefix is “New” and “Table Even Rows” is the same as the name of the default style.

5. In the properties of the “New Table Even Rows” style, change the Background Colour field value to a light blue

colour.

If you do not change the other values, the default “Table Even Rows” style will be applied for the rest of the
settings.

6. Click OK.

7.2.6.3.4.25 5. Apply the New style prefix to your Table of Data.

1. Double-click your report template to edit it again.

2. Edit the Anomaly Actions Table of Data, to which you want to apply the new style (double-click it
or select it and choose Edit).

3. Enter New in the Style Prefix field.

4. Click OK.
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ò Result

When you generate the output, it now contains the table with the new style:

Proceed to Next Step

7.2.6.3.4.26 Add Page Break, Charts of Templates

In this step, you create a Charts of Templates that show data regarding your anomalies. You want to display the two
charts next to each other, in two columns. For that, you create the following:

• An Element Group to include all the Chart Templates

• A level-2 Section Heading to be included in the output before the charts

• A Simple Source for the Anomaly system table, from which the Chart Templages can retrieve data

• The actual chart templates
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See the detailed steps below:

1. Insert an Element Group for the charts.
2. Add a Page Break element to place the charts on a new page and set up its layout.
3. Insert a level-2 Section Heading for the charts.
4. Insert a Simple Source for Anomalies.
5. Insert a Chart Template for Anomalies By Severity (by Year)
6. Insert a Chart Template for Anomalies -v- Code

7.2.6.3.4.27 Prerequisites

You have completed the following steps:

• Create Template, Set Layout, Add Header, Footer, Title

7.2.6.3.4.28 Process

7.2.6.3.4.29 1. Insert an Element Group for the charts.

This element will contain the charts that we’re going to create.

1. Add an Element Group element to the Report Layout structure. It should be on the same level as the element
group you created for the table of data.

� Tip

If the element is not inserted to the right location in the element structure, use the Move Up or Move Down
buttons in the toolbar to move them to the correct place.

2. Double-click the element in the structure to edit it.

3. Enter the name Charts, which will identify the element in the structure. You do not need to make other settings
for the element group right now.

4. Click OK.

7.2.6.3.4.30 2. Add a Page Break element to place the charts on a new page and set up its layout.

You want the charts to appear on a new page and next to each other in two columns. To do that, proceed as follows:

1. Add a Page Break element to the Report Layout structure so that it is included within the Charts element
group.

2. Double-click the element in the structure to edit it.

3. Enter a name that identifies the element in the structure, for example, Page Break - 2 column.

4. In the Section Columns field, enter 2.

5. In the Header and Footer fields, enter the same values that you used for the Section Break above, so that they
are the same on the new page.

6. Under Page, select the Landscape for the Layout and A4 for Page Size.

7. Click OK.
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7.2.6.3.4.31 3. Insert a level-2 Section Heading for the charts.

1. Add a Section Heading element to the Report Layout structure so that it is included within the Charts element
group.

2. Double-click the element in the structure to edit it.

3. Enter a name that identifies the element in the structure, for example, Charts Heading 2. This text does not
appear in the actual report output.

4. Enter the text of the heading that you want to see in the output in the Content field. This time, we just want to
use the heading Anomaly Charts, but you can use right-click in this field if you want to add a variable.
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5. Select the Include in Table of Contents checkbox to have this section heading appear in the Table of Contents.

6. In the Default Style field, select Heading 2, which is a preconfigured style that can be applied for level-2 section
headings. If required, you can set up your own style and apply that instead (see Styles).

7. Click OK.

7.2.6.3.4.32 4. Insert a Simple Source for Anomalies.

This simple source will be used as the data source for the chart templates that we are going to create. To do this, follow
the same steps as described in 3. Insert a Simple Source for Anomalies., but insert the simple source within the Charts
element group.

1. Add a Simple Source element to the Report Layout structure so that it is included within the Charts
element group. The Simple Source element is located under the SOURCES node within the Tem-
plate Definition section of the dialog.
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ò Note

You must insert the simple source within the element group, else, you cannot refer to it from
the other elements of the element group.

2. Double-click the Simple Source element in the structure to edit it.

3. Specify the name Anomaly* for the simple source.

4. In the Table field, click the ellipsis to select the System Table Anomaly.

5. Click OK.

7.2.6.3.4.33 5. Insert a Chart Template for Anomalies By Severity (by Year)

1. Add a Chart Template element to the Report Layout structure so that it is included within the Charts element
group.

2. Double-click the element in the structure to edit it.

3. Enter data as follows:

• Name: Enter Anomalies By Severity (by Year) or any name that identifies the element in the structure.

• Source: Select Anomaly source

• Chart Template: Select Anomalies By Severity (by Year). The available chart templates in the drop-down
list are determined by the system by checking which chart templates refer to the table that you selected as
a source above. You can only select from those chart templates that have a reference to the source that you
selected (for example, they use data from that table for one of their axes).

• Width: 500

• Height: 400
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7.2.6.3.4.34 6. Insert a Chart Template for Anomalies -v- Code

Follow the same process as in the previous step to insert another chart template but with the following data:

• Name: Enter Anomalies -v- Code or any name that identifies the element in the structure.

• Source: Select Anomaly source

• Chart Template: Select Anomalies -v- Code.

• Width: 500

• Height: 400

ò Result
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When you generate the output, you can see that the chart templates are inserted next to each other in
two columns:

Proceed to Next Step

7.2.6.3.4.35 Insert Table of Contents, Verify Output

In this step, you insert a Table of Contents element and check if the output complies with your requirements.

See the detailed steps below:

1. Insert a Table of Contents element.
2. Generate an output to check the final output of the report.

7.2.6.3.4.36 Prerequisites

You have completed the following steps:

• Create Template, Set Layout, Add Header, Footer, Title

• Create Table of Data for Anomaly List, Apply Styles

• Create Table of Data for Anomaly Actions, Use Style Prefix

• Add Page Break, Charts of Templates

7.2.6.3.4.37 Process

7.2.6.3.4.38 1. Insert a Table of Contents element.

Drag the Table of Contents element or select it and choose Add to insert it in the Report Layout structure. Ensure that
it is the first node within the structure:
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ò Note

• The Table of Contents element is applicable only to RTF and HTML outputs.

• The formatting of the Table of Contents element depends on your settings for the
elements starting with TOC in your generic report style configurations (see Styles).
You can adjust the look of each heading level as required. For example, for Heading
2 in the TOC, you edit the style TOC Heading 2 and add a left padding value “30”.

• In the RTF output, you must right-click and update the table of contents to ensure
that page numbers appear correctly.

7.2.6.3.4.39 2. Generate an output to check the final output of the report.

To generate the output, proceed as follows:

1. In the Edit Report Template dialog, choose OK to close the dialog and save your changes.

2. Back in the Configuration - Templates dialog, select the report template and choose the Generate
toolbar button.

3. Select the required output format from the drop-down, which can be either RTF, HTML, or Microsoft
Excel.

4. Select a report destination, which, in this case, will be File.

5. Choose Commit.
6. Close the Configuration - Templates dialog.

7. Wait until the report output is generated. The progress is indicated at the bottom of the main NEXUS
IC screen.

8. Once the generation is complete, click the Save icon to download and save the report.
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9. Select the destination and open the file.

10. If you generated an RTF output, right-click the Table of Contents and choose Update Field to ensure
that page numbers appear correctly.

11. Review the report to verify it meets your expectations.

7.2.6.3.4.40 Example: Set Up Asset Integrity Report Template

In this example, we create a report template called “Asset Integrity Report”, which demonstrates the usage of the
following report template elements:

• Element group with looping

• Simple source with filters, additional fields

• Vertical table

• Risk chart

• Multimedia

• Selection parameters

This example guides you through the following steps:

1. Create Template, Set Layout, Add Title
2. Create Simple Source with Filters and Looping Element Group
3. Create Section Heading, Vertical Table with Extended Simple Source
4. Add Risk Charts with Element Group, Page Break, Section Heading
5. Add Multimedia Thumbnails with Element Group, Page Break, Section Heading
6. Insert Table of Contents, Configure Selection Parameters, Verify Output

7.2.6.3.4.41 Create Template, Set Layout, Add Title

As a first step, you create the report template, set up its size and layout and add a Section Heading to add a title. See
the detailed steps below:

1. Create a new report template and specify the report layout.
2. Add a level-1 Section Heading.
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7.2.6.3.4.42 Process

7.2.6.3.4.43 1. Create a new report template and specify the report layout.

1. In NEXUS IC, choose Configuration → Reports and Dashboards → Templates from the menu.

2. Choose Add to create a new report template.

3. In the top half of the Add Report Template dialog, specify the name, status and category of the report as follows:

• Name: Enter Example: Asset Integrity Report

• Status (optional): Select from the list of preconfigured statuses (see Configure Report Statuses), for exam-
ple, Under Construction.

• Category (optional): Select from the list of preconfigured categories (see Configure Report Categories),
for example, Asset.

4. Under the Template Definition section of the dialog, configure the size and layout of the report by double-clicking
the top Report Layout node on the right-hand side of the dialog. In this example, we select layout Landscape
and page size A4.

5. Choose OK.
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ò Note

This size and layout settings will prevail until the next page break element, where you can overwrite
these settings.

7.2.6.3.4.44 2. Add a level-1 Section Heading.

To add a main title to the report, with Heading 1 style, proceed as follows:

1. Add a Section Heading element to the Report Layout structure (drag it or select it and choose Add).

2. Double-click the element in the structure to edit it.

3. Enter a name that identifies the element in the structure. This text does not appear in the actual report output.

4. Enter the text of the heading that you want to see in the output in the Content field. This time, we just want to
use the heading Asset Integrity Report, but you can use right-click in this field if you want to add a variable.

5. Select the Include in Table of Contents checkbox to have this section heading appear in the Table of Contents.

6. In the Default Style field, select Heading 1, which is a preconfigured style that can be applied for level-1 section
headings. If required, you can set up your own style and apply that instead (see Styles).

7. Click OK.

Proceed to Next Step

7.2.6.3.4.45 Create Simple Source with Filters and Looping Element Group

In our Asset Integrity Report, we want to display some data from the Pipeline AIG for specific assets. For each relevant
asset, we want to see a vertical table that shows these pipeline data.

For this, we need an element group that loops on assets and contains a vertical table that retrieves data from the Pipeline
AIG. The vertical table will then be filled with pipeline data for each filtered asset one by one when the report is
generated.

In this step, you create a looping element group, which is linked to a simple source that filters the relevant assets. You
can then create the actual vertical table in the next step.

See the detailed steps below:

1. Insert a simple source for Asset Location.
2. Add an asset tree filter to the Asset Location simple source.
3. Add filters for asset name and asset type.
4. Insert an element group that loops on assets.

7.2.6.3.4.46 Prerequisites

You have completed the following step:

• Create Template, Set Layout, Add Title

7.2.6.3.4.47 Process

7.2.6.3.4.48 1. Insert a simple source for Asset Location.

1. Add a Simple Source element to the Report Layout structure (drag or select it and choose Add). The Simple

Source element is located under the SOURCES node within the Template Definition section of the dialog.
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2. Double-click the Simple Source element in the structure to edit it.

3. On the Properties tab, specify the name Anomaly* for the simple source.

4. In the Table field, click the ellipsis to select the System Table Anomaly.

5. Click OK.

7.2.6.3.4.49 2. Add an asset tree filter to the Asset Location simple source.

We want to allow the user to filter based on a specific branch of the asset tree. When generating the report, the user
will see a selection dialog where they can select the required asset tree branch.

To do that, update the simple source as follows:

1. Double-click the Asset Location Simple Source and go to the Filters tab.

2. Under Field, use the drop-down list to select the VN_ID field.

ò Note

• The drop-down list includes all the fields from the Asset Location table that is linked to this simple
source.

• VN_ID is the unique identifier of an asset in the hierarchy. When you select this field, an additional
value becomes available under Comparison, called Is Child Of.

3. Under Comparison, choose Is Child Of, which allows returning assets under a specific node within the asset
tree.

4. Under Parameter, select User, which indicates that the user has to select the specific VN_ID value when gen-
erating the report.

5. Under Value, enter VN_ID.
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6. Choose OK.

7.2.6.3.4.50 3. Add filters for asset name and asset type.

In addition to the filtering added to the Asset Location simple source above, we want to filter on assets that fulfill either
of the following criteria:

• They have PL in their asset name

• They have the asset type Pipeline, Pipeline Section, Piping Circuit or Piping Line

1. Still on the Filters tab of the Edit Simple Source dialog, click the + (plus) sign at the end of the first
filter to create a new filter.

2. Specify the following values for the filter:

• Field: Since we want to filter assets that have PL in their asset name, select the Name field from
the drop-down list.

• Comparison: Select Like, which is a “contains” operator relevant for alphanumeric fields.

• Value: Enter %PL%, which refers to any name that contains PL.

We now have the second filter set up.

3. Click the + (plus) sign at the end of the second filter to create a new filter.

4. Specify the following values for the filter:

• Field: Since we want to filter assets based on their asset type, select the Asset Type field
from the drop-down list.

• Comparison: Select In, which allows multiple selections for asset type, that is, this
would return any asset that has either of the selected asset types.

• Value: Use the ellipsis to select the asset types Pipeline, Pipeline Section, Piping
Circuit and Piping Line.
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We now have the third filter set up.

5. While we want the first filter for VN_ID to be always applied, at the same time, we want EITHER the
second OR the third filter to be applied. That is, we want assets to be returned if either they have PL
in their asset name, or they have the specified asset types. To make this possible, we need to group
the second and third filter with an Any connector:

a. Under Field, select the checkboxes next to the second and third filters. The Group and Ungroup
toolbar buttons become available.

b. Choose Group.

c. A new grouping is created for these two filters, with a drop-down option. Select Any.

d. Choose OK.

7.2.6.3.4.51 4. Insert an element group that loops on assets.

1. Add an Element Group element to the Report Layout structure right after the Section Heading.

� Tip

If the element is not inserted to the right location in the element structure, use the Move Up or Move Down
buttons in the toolbar to move them to the correct place.

2. Double-click the element in the structure to edit it.
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3. Enter data as follows:

• Name: Enter a descriptive name, such as Loop on Each Asset.

• Source: Select the Asset Location source that you created in the previous step.

• Sourt Column: Select, for example, Asset, which means that data will be sorted based on the Asset column
of the Asset Location table.

• Sourt Order: Select Ascending.

• Repeat Elements: Tick the checkbox.

• Action: Select All Rows to repeat elements for all the rows in the source.

4. Click OK.

Proceed to Next Step
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7.2.6.3.4.52 Create Section Heading, Vertical Table with Extended Simple Source

In this step, you create a Vertical Table that retrieves data from a Simple Source linked to the Pipeline AIG and has
additional fields added to it. Since the Vertical Table is in a looping element group, it will be repeated for each asset
that the element group loops on. You also want to create a section heading that shows the asset full location as the title
for each table.

For that, you create the following:

• A level-2 Section Heading to be included in the output before the tables and has a variable for the asset location
in its content.

• A Simple Source that gets data from the Pipeline Asset Information table plus you add extra fields to it from
other tables. The Vertical Table will retrieve data from this Simple Source.

• The actual vertical table

See the detailed steps below:

1. Insert a Simple Source for Pipeline AIG and add an extra field.
2. Add an extra field to the Simple Source.
3. Insert a level-2 Section Heading for the vertical tables.
4. Insert a Vertical Table for pipeline data.

7.2.6.3.4.53 Prerequisites

You have completed the following steps:

• Create Template, Set Layout, Add Title

• Create Simple Source with Filters and Looping Element Group

7.2.6.3.4.54 Process

In this example, you work in the Loop on Each Asset Element Group that you have created in the previous step.

7.2.6.3.4.55 1. Insert a Simple Source for Pipeline AIG and add an extra field.

This Simple Source will be used as the data source for the Vertical Table that we are going to create. We link this Simple
Source to the Pipeline Asset Information table, however, that table doesn’t contain the Full Location field, which we
want to show in the table as well as in the Section Heading for each table, so we need to extend the Simple Source with
that field.

1. Add a Simple Source element to the Report Layout structure so that it is included within the Loop
on Each Asset element group. The Simple Source element is located under the SOURCES node
within the Template Definition section of the dialog.

ò Note

You must insert the simple source within the element group, else, you cannot refer to it from
the other elements of the element group.

2. Double-click the Simple Source element in the structure to edit it.

3. Specify the name Pipeline AIG* for the simple source.

4. In the Table field, click the ellipsis to select the Asset Information Table Pipeline.
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5. On the Filters tab, add a filter for VN_ID similarly to the Simple Source you created for the Asset
Location Element Group, but now, use the parameter Group to ensure that the VN_ID is determined
from the Simple Source used for the Element Group, which was the Asset Location Simple Source.

7.2.6.3.4.56 2. Add an extra field to the Simple Source.

1. Still in the Edit Simple Source dialog, go to the Fields tab.

If the Show Local Columns button is enabled, you can see the list of all fields that the linked Pipeline table
contains.

2. Click Add to add an extra field to the Simple Source.

You can see that a Simple Column entry has been added but with no field selected.

3. Right-click the row, or choose Input from the toolbar and choose Field. . . , which brings up a new dialog.

4. Select the Full Location field under the Asset Location system table.

5. Click OK.
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7.2.6.3.4.57 3. Insert a level-2 Section Heading for the vertical tables.

You want to create a heading for each vertical table, which shows the Full Location value for each asset that the given
vertical table is related to. Since you have added this field to the Simple Source you created in the previous step, you
can refer to it from the Section Heading element.

1. Add a Section Heading element to the Report Layout structure so that it is included within the Loop on Each
Asset element group.

2. Double-click the element in the structure to edit it.

3. Enter a name that identifies the element in the structure, for example, Section Heading 2 - Full Location. This
text does not appear in the actual report output.

4. Right-click in the Content field and choose Database Fields → Pipeline AIG → Full Location to select the field
that you have added to the Simple Source earlier.

5. Select the Include in Table of Contents checkbox to have this section heading appear in the Table of Contents.

6. In the Default Style field, select Heading 2, which is a preconfigured style that can be applied for level-2 section
headings. If required, you can set up your own style and apply that instead (see Styles).

7. Click OK.
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7.2.6.3.4.58 4. Insert a Vertical Table for pipeline data.

1. Add a Vertical Table element to the Report Layout structure so that it is included within the Loop
on Each Asset element group and it is below the Section Heading element that you created in the
previous step.

2. Double-click the element in the structure to edit it.

3. On the Properties tab, make settings as follows:

• Name: Enter Pipeline Data for then right-click and select Database Fields → Pipeline AIG →
Full Location so that the name of the table, which will be used as a caption, includes the full
location of the asset to which the table is related to.

• Tick the following checkboxes:

– Show Caption
– Fit Window

• Header Width (%): Enter 40, which means that the width of the header column will be 40%
of the width of the whole table width.
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• Number of Header Columns: Enter 2, so that the fields of the table are arranged in two
columns. Using more columns is recommended when you have lots of fields to display.

• Source: Select the Pipeline AIG source from the drop-down list. The available values in this
field are retrieved from the sources that have been created under the current element group.

4. On the Layout tab, you can hide columns or rearrange the layout as required.

5. Click OK.

ò Result

When you generate the output, you are prompted to select a branch in the asset tree and in the output,
you can see that vertical tables are inserted for each relevant asset containing data from the Pipeline
AIG as well as the extra Full Location* field that you have added. Data is arranged in two columns
and the headings and captions show the full location of the asset:
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Proceed to Next Step

7.2.6.3.4.59 Add Risk Charts with Element Group, Page Break, Section Heading

In the next part of the report, you want to include two risk charts based on different risk models and you want to include
them next to each other on a new page. For that, you create the following:

• An Element Group to include all the Risk Charts

• A Page Break element with 2 columns

• A level-2 Section Heading to be included in the output before the risk charts

• A Simple Source for the Risk Assessment system table, filtering for Generic Qualitative risk models

• A Simple Source for the Risk Assessment system table, filtering for API 580 Qualitative risk models

• The actual crisk charts

See the detailed steps below:

1. Insert an Element Group for the risk charts.
2. Add a Page Break element to place the charts on a new page and set up its layout.
3. Insert a level-2 Section Heading for the risk charts.
4. Insert a Simple Source for the Generic Qualitative Risk Model.
5. Insert a Simple Source for the API 580 Qualitative Risk Model.
6. Insert a Generic Qualitative Risk Model.
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7. Insert an API 580 Qualitative Risk Model.

7.2.6.3.4.60 Prerequisites

You have completed the following steps:

• Create Template, Set Layout, Add Title

7.2.6.3.4.61 Process

7.2.6.3.4.62 1. Insert an Element Group for the risk charts.

This element will contain the charts that we’re going to create.

1. Add an Element Group element to the Report Layout structure. It should be on the same level as the element
group you created for the looping element group.

� Tip

If the element is not inserted to the right location in the element structure, use the Move Up or Move Down
buttons in the toolbar to move them to the correct place.

2. Double-click the element in the structure to edit it.

3. Enter the name Risk Charts, which will identify the element in the structure. You do not need to make other
settings for the element group right now.

4. Click OK.

7.2.6.3.4.63 2. Add a Page Break element to place the charts on a new page and set up its layout.

You want the risk charts to appear on a new page and next to each other in two columns. To do that, proceed as follows:

1. Add a Page Break element to the Report Layout structure so that it is included within the Risk Charts element
group.

2. Double-click the element in the structure to edit it.

3. Enter a name that identifies the element in the structure, for example, Page Break - 2 column.

4. In the Section Columns field, enter 2.

5. Under Page, select the Landscape for the Layout and A4 for Page Size.

6. Click OK.

7.2.6.3.4.64 3. Insert a level-2 Section Heading for the risk charts.

1. Add a Section Heading element to the Report Layout structure so that it is included within the Charts element
group.

2. Double-click the element in the structure to edit it.

3. Enter a name that identifies the element in the structure, for example, Charts Heading 2. This text does not
appear in the actual report output.

4. Enter the text of the heading that you want to see in the output in the Content field. This time, we just want to
use the heading Risk Charts, but you can use right-click in this field if you want to add a variable.

5. Select the Include in Table of Contents checkbox to have this section heading appear in the Table of Contents.
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6. In the Default Style field, select Heading 2, which is a preconfigured style that can be applied for level-2 section
headings. If required, you can set up your own style and apply that instead (see Styles).

7. Click OK.

7.2.6.3.4.65 4. Insert a Simple Source for the Generic Qualitative Risk Model.

This simple source will be used as the data source for the Generic Qualitative risk model that we are going to create.

1. Add a Simple Source element to the Report Layout structure so that it is included within the Risk
Charts element group. The Simple Source element is located under the SOURCES node within
the Template Definition section of the dialog.

ò Note

You must insert the simple source within the element group, else, you cannot refer to it from
the other elements of the element group.

2. Double-click the Simple Source element in the structure to edit it.

3. Specify the name Risk Assessment Generic* for the simple source.

4. In the Table field, click the ellipsis to select the System Table Risk Assessment.
5. On the Filters tab, create 2 new filters:

• A filter for user parameter VN_ID, in the same way as described in 2. Add an asset tree filter to
the Asset Location simple source..

• Another filter with the following data:

– Field: Risk Model

– Comparison: =

– Parameter: None

– Value: Generic Qualitative

6. Click OK.
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7.2.6.3.4.66 5. Insert a Simple Source for the API 580 Qualitative Risk Model.

This simple source will be used as the data source for the API 580 Qualitative risk model that we are going to create.

1. Add a Simple Source element to the Report Layout structure so that it is included within the Risk
Charts element group. The Simple Source element is located under the SOURCES node within
the Template Definition section of the dialog.

ò Note

You must insert the simple source within the element group, else, you cannot refer to it from
the other elements of the element group.

2. Double-click the Simple Source element in the structure to edit it.

3. Specify the name Risk Assessment API 580* for the simple source.

4. In the Table field, click the ellipsis to select the System Table Risk Assessment.
5. On the Filters tab, create 2 new filters:

• A filter for user parameter VN_ID, in the same way as described in 2. Add an asset tree filter to
the Asset Location simple source..

• Another filter with the following data:

– Field: Risk Model

– Comparison: =

– Parameter: None

– Value: API 580 Qualitative

6. Click OK.

7.2.6.3.4.67 6. Insert a Generic Qualitative Risk Model.

1. Add a Risk Model element to the Report Layout structure so that it is included within the ** Risk Charts**
element group.

2. Double-click the element in the structure to edit it.

3. Enter data as follows:

• Name: Enter Risk Chart Generic or any name that identifies the element in the structure.
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• Source: Select Risk Chart Generic source

• Show Caption: Tick to add the name of the risk chart as a caption

• Show Count: Tick to show the number of risk results in each square that has risk results.

• Width: 400

• Height: 400

4. Click OK.
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7.2.6.3.4.68 7. Insert an API 580 Qualitative Risk Model.

1. Add a Risk Model element to the Report Layout structure so that it is included within the ** Risk Charts**
element group.

2. Double-click the element in the structure to edit it.

3. Enter data as follows:

• Name: Enter Risk Chart API 580 or any name that identifies the element in the structure.

• Source: Select Risk Chart API 580 source

• Show Caption: Tick to add the name of the risk chart as a caption

• Show Count: Tick to show the number of risk results in each square that has risk results.

• Width: 400

• Height: 400

4. Click OK.

ò Result

When you generate the output, you can see that the risk charts are inserted next to each other in two
columns:
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Proceed to Next Step

7.2.6.3.4.69 Add Multimedia Thumbnails with Element Group, Page Break, Section Heading

In this step, you add a Multimedia Thumbnails element to your report template, to insert the images associated with
the relevant asset into the report. For that, you create the following:

• An Element Group to include the Multimedia Thumbnail element with a parameter that allows excluding this
part of the report during report generation

• A Page Break element with 1 column

• A level-2 Section Heading to be included in the output before the images

• A Simple Source for the Multimedia system table

• The actual Multimedia Thumbnail element

See the detailed steps below:

1. Insert an Element Group for the Multimedia Thumbnails.
2. Add a Page Break element to place the images on a new page and set up its layout.
3. Insert a level-2 Section Heading for the images.
4. Insert a Simple Source for Multimedia.
5. Insert a Multimedia Thumbnail element.

7.2.6.3.4.70 Prerequisites

You have completed the following steps:

• Create Template, Set Layout, Add Title

7.2.6.3.4.71 Process

7.2.6.3.4.72 1. Insert an Element Group for the Multimedia Thumbnails.

1. Add an Element Group element to the Report Layout structure. It should be on the same level as the element
groups you created for the other element groups.
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� Tip

If the element is not inserted to the right location in the element structure, use the Move Up or Move Down
buttons in the toolbar to move them to the correct place.

2. Double-click the element in the structure to edit it.

3. Enter the name Risk Charts, which will identify the element in the structure.

4. Select the Allow Excluding Group from Export checkbox to enable a selection parameter during report gen-
eration. This allows users to exclude this element group from the report output when they start generating the
report. This feature is particularly useful when you have numerous images that take a long time to generate, and
you want to quickly review other parts of the report.

5. Click OK.

7.2.6.3.4.73 2. Add a Page Break element to place the images on a new page and set up its layout.

You want the multimedia thumbnails to appear on a new page. To do that, proceed as follows:

1. Add a Page Break element to the Report Layout structure so that it is included within the Multimedia element
group.

2. Double-click the element in the structure to edit it.

3. Enter a name that identifies the element in the structure, for example, Page Break - 1 column.

4. In the Section Columns field, enter 1.

5. Under Page, select the Landscape for the Layout and A4 for Page Size.

6. Click OK.

7.2.6.3.4.74 3. Insert a level-2 Section Heading for the images.

1. Add a Section Heading element to the Report Layout structure so that it is included within the Multimedia
element group.

2. Double-click the element in the structure to edit it.

3. Enter a name that identifies the element in the structure, for example, Multimedia Heading 2. This text does not
appear in the actual report output.

4. Enter the text of the heading that you want to see in the output in the Content field. This time, we just want to
use the heading Images.

5. Select the Include in Table of Contents checkbox to have this section heading appear in the Table of Contents.

6. In the Default Style field, select Heading 2, which is a preconfigured style that can be applied for level-2 section
headings. If required, you can set up your own style and apply that instead (see Styles).

7. Click OK.

7.2.6.3.4.75 4. Insert a Simple Source for Multimedia.

This simple source will be used as the data source for the Multimedia Thumbnails element that we are going to create.

1. Add a Simple Source element to the Report Layout structure so that it is included within the Mul-
timedia element group. The Simple Source element is located under the SOURCES node within
the Template Definition section of the dialog.
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ò Note

You must insert the simple source within the element group, else, you cannot refer to it from
the other elements of the element group.

2. Double-click the Simple Source element in the structure to edit it.

3. Specify the name Multimedia* for the simple source.

4. In the Table field, click the ellipsis to select the System Table Multimedia.

5. On the Filters tab, create a filter for user parameter VN_ID, following the same steps outlined in 2.
Add an asset tree filter to the Asset Location simple source.. This will allow the user to select the
asset hierarchy branch for which they want to include the associated images in the report output.

6. Click OK.

7.2.6.3.4.76 5. Insert a Multimedia Thumbnail element.

1. Add a Multimedia Thumbnails element to the Report Layout structure so that it is in-
cluded within the Multimedia element group.

2. Double-click the element in the structure to edit it.

3. Enter data as follows:

• Name: You can keep Multimedia Thumbnails or any name that identifies the element
in the structure.

• Source: Select Multimedia source

• Caption Field: Select Name, which indicates that the caption text is retrieved from
the Name field of the Multimedia table.
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• Repository Field: Select Image, which is the field that contains the image in the
database.

• Columns: Enter 3, because we want to get the image thumbnails displayed in three
columns in the report output.

• Thumbnail Width: Enter, for example, 320

• Thumbnail Height: Leave it empty or 0. To maintain the aspect ratio of images, only
set one dimension.

4. Click OK.

ò Note

When you put a multimedia thumbnail element in your report template, an additional se-
lection parameter is added automatically. This is useful when you set up multiple columns
to display images in the output but you have less images in the last row then the number of
columns. In this case, you can select the Merge Last Row to Centre Images for Multi-
ple Columns checkbox to merge the last row of the columns and display the images in the
centre of the page.

ò Result

When you generate the output, you can see that multimedia thumbnails are inserted in three columns:
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Proceed to Next Step

7.2.6.3.4.77 Insert Table of Contents, Configure Selection Parameters, Verify Output

In this step, you insert a Table of Contents element and check if the output complies with your requirements.

See the detailed steps below:

1. Insert a Table of Contents element.
2. Configure Selection Parameters for Report Generation.
3. Generate an output to check the final output of the report.

7.2.6.3.4.78 Prerequisites

You have completed the following steps:

• Create Template, Set Layout, Add Title

• Create Simple Source with Filters and Looping Element Group

• Create Section Heading, Vertical Table with Extended Simple Source

• Add Risk Charts with Element Group, Page Break, Section Heading

• Add Multimedia Thumbnails with Element Group, Page Break, Section Heading

7.2.6.3.4.79 Process

7.2.6.3.4.80 1. Insert a Table of Contents element.

Drag the Table of Contents element or select it and choose Add to insert it in the Report Layout structure. Ensure that
it is the first node within the structure:
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ò Note

• The Table of Contents element is applicable only to RTF and HTML outputs.

• The formatting of the Table of Contents element depends on your settings for the
elements starting with TOC in your generic report style configurations (see Styles).
You can adjust the look of each heading level as required. For example, for Heading
2 in the TOC, you edit the style TOC Heading 2 and add a left padding value “30”.

• In the RTF output, you must right-click and update the table of contents to ensure
that page numbers appear correctly.

7.2.6.3.4.81 2. Configure Selection Parameters for Report Generation.

While creating this report template, we created two user parameters. When generating the report, users are prompted
to make selections for these parameters before the output is created:

• We created filters with user parameter for the Asset Location VN_ID field when configuring some of the Simple
Sources (for example, in step 2. Add an asset tree filter to the Asset Location simple source.).

• We inserted a Multimedia Thumbnail element, which automatically adds the Merge Last Row to Centre Images
for Multiple Columns checkbox to the selection parameters (see 5. Insert a Multimedia Thumbnail element.).

When generating the report from the Configuration - Templates dialog, the following selection dialog is displayed
before the output is created:
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The field label VN_ID is not user-friendly, so we want to change this text, also, we want the fields to take the full
2-column width of the dialog and appear below each other. To do that, proceed as follows:

1. In the Edit Report Template dialog for our report template, choose Parameters.

2. In the Edit Parameters dialog, double-click the VN_ID row or select it and choose Edit.
3. In the Edit Report Parameters dialog, make settings as follows:

• Parameter Name: This is an internal text to identify the parameter, so you can leave it as is.

• Name: Enter the text that you want to display as a field label, for example, Branch of Asset Tree.

• Order: You want this parameter to appear first, so you either leave it 0 and set 1 for the next
parameter, or you enter 1 and set 2 for the next one.

• Columns: The current setting is 1, which means that the width of the field is 1-column within
the 2-column dialog. You want the field to take the full width, so you change this value to 2.

4. Click OK.
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5. Back in the Edit Parameters dialog, double-click the MergeLastRow row or select it and choose

Edit.
6. In the Edit Report Parameters dialog, you can leave the current texts as they are, just change the

values of the following fields:

• Order: You want this parameter to appear second, so you enter a larger number than
the number you used for the previous parameter.

• Columns: The current setting is 1, which means that the width of the field is 1-column
within the 2-column dialog. You want the field to take the full width, so you change
this value to 2.

7. Click OK.

ò Result

When you generate the output, the updated selection parameters appear as follows:
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7.2.6.3.4.82 3. Generate an output to check the final output of the report.

To generate the output, proceed as follows:

1. In the Edit Report Template dialog, choose OK to close the dialog and save your changes.

2. Back in the Configuration - Templates dialog, select the report template and choose the Generate
toolbar button.

3. Select the required output format from the drop-down, which can be either RTF, HTML, or Microsoft
Excel.

4. Select a report destination, which, in this case, will be File.

5. Choose Commit.
6. Close the Configuration - Templates dialog.

7. Wait until the report output is generated. The progress is indicated at the bottom of the main NEXUS
IC screen.

8. Once the generation is complete, click the Save icon to download and save the report.

9. Select the destination and open the file.

10. If you generated an RTF output, right-click the Table of Contents and choose Update Field to ensure
that page numbers appear correctly.

11. Review the report to verify it meets your expectations.

7.2.6.3.4.83 Example: Set Up Workpack Report Template

In this example, we create a report template called “Workpack Report”, which demonstrates the usage of the following
report template elements:

• Section Heading with style change

• Pivot Table

• Text (Paragraph)

• Table of Data with Distinct Source

• Drawing Details

This example guides you through the following steps:
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1. Create Template, Set Layout, Add Title and Change Heading Style
2. Add Pivot Table for Tasks with Text, Extended Simple Source with Filter
3. Add Pivot Table for Findings with Text, Simple Source with Filter
4. Add Table of Data for Event Types with Distinct Source
5. Add Drawing Details and Extended Simple Source with Filters
6. Insert Table of Contents, Verify Output

7.2.6.3.4.84 Create Template, Set Layout, Add Title and Change Heading Style

As a first step, you create the report template, set up its size and layout and insert a Section Heading to add a title. See
the detailed steps below:

1. Create a new report template and specify the report layout.
2. Add a level-1 Section Heading.
3. Change the style of the headings.

7.2.6.3.4.85 Process

7.2.6.3.4.86 1. Create a new report template and specify the report layout.

1. In NEXUS IC, choose Configuration → Reports and Dashboards → Templates from the menu.

2. Choose Add to create a new report template.

3. In the top half of the Add Report Template dialog, specify the name, status and category of the report as follows:

• Name: Enter Example: Workpack Report

• Status (optional): Select from the list of preconfigured statuses (see Configure Report Statuses), for exam-
ple, Under Construction.

• Category (optional): Select from the list of preconfigured categories (see Configure Report Categories),
for example, Workpack.

4. Under the Template Definition section of the dialog, configure the size and layout of the report by double-clicking
the top Report Layout node on the right-hand side of the dialog. In this example, we select layout Portrait and
page size A4.

5. Choose OK.
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ò Note

This size and layout settings will prevail until the next page break element, where you can overwrite
these settings.

7.2.6.3.4.87 2. Add a level-1 Section Heading.

To add a main title to the report, with Heading 1 style, proceed as follows:

1. Add a Section Heading element to the Report Layout structure (drag it or select it and choose Add).

2. Double-click the element in the structure to edit it.

3. Enter a name that identifies the element in the structure. This text does not appear in the actual report output.

4. Enter the text of the heading that you want to see in the output in the Content field. This time, we just want to
use the heading Workpack Report, but you can use right-click in this field if you want to add a variable.
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5. Select the Include in Table of Contents checkbox to have this section heading appear in the Table of Contents.

6. In the Default Style field, select Heading 1, which is a preconfigured style that can be applied for level-1 section
headings. If required, you can set up your own style and apply that instead (see Styles).

7. Click OK.

7.2.6.3.4.88 3. Change the style of the headings.

You want to change the appearance of the headings used in the report. You want to change the font size and font colour
of Heading 1 and Heading 2.

1. Click OK to save your changes and close the Add Report Template dialog. This takes you back to
the Configuration - Templates dialog.

2. Choose Styles from the toolbar. This opens the Styles dialog.

3. From the list of styles, double-click Heading 1 or select it and choose Edit.
4. Change the Font Size value to 16.

5. Change the Text Colour to another colour, for example, Navy.

6. Click OK to save your changes.

7. From the list of styles, double-click Heading 2* or select it and choose **Edit.
8. Change the Font Size value to 13.

9. Change the Text Colour to another colour, for example, Navy.

10. Click OK to save your changes.
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ò Result

The updated Heading 1 and Heading 2 styles are now applied to all the report templates in the Con-
figuration - Templates dialog.

Proceed to Next Step

7.2.6.3.4.89 Add Pivot Table for Tasks with Text, Extended Simple Source with Filter

In the first part of the report, we want to insert a pivot table that shows the number of tasks by asset type and event type
in a workpack selected by the user during report generation. We want to add a heading and a description before the
table. To do that, we create the following elements:

• An Element Group to include the pivot table, text and heading

• A level-2 Section Heading

• A Text (Paragraph) element to include a description

• A Simple Source for the Task system table, which we extend with the Asset Type field and add a filter for
Workpack ID as a user parameter.

• The actual Pivot Table

See the detailed steps below:

1. Insert an Element Group.
2. Insert a level-2 Section Heading for the pivot table.
3. Insert a Simple Source for the Pivot Table.
4. Insert a Text (Paragraph) element for introduction.
5. Insert a Pivot Table for Tasks.

7.2.6.3.4.90 Prerequisites

You have completed the following steps:

• Create Template, Set Layout, Add Title and Change Heading Style

7.2.6.3.4.91 Process

7.2.6.3.4.92 1. Insert an Element Group.

This element will contain the heading, text, pivot table and simple source that we are going to create for this section of
the report.

1. Add an Element Group element to the Report Layout structure.

2. Double-click the element in the structure to edit it.

3. Enter the name Tasks, which will identify the element in the structure. You do not need to make other settings
for the element group right now.

4. Click OK.
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7.2.6.3.4.93 2. Insert a level-2 Section Heading for the pivot table.

1. Add a Section Heading element to the Report Layout structure so that it is included within the Tasks element
group.

2. Double-click the element in the structure to edit it.

3. Enter a name that identifies the element in the structure, for example, Task List Heading 2. This text does not
appear in the actual report output.

4. Enter the text of the heading that you want to see in the output in the Content field, for example, Number of
Tasks by Asset Type and Event Type.

5. Select the Include in Table of Contents checkbox to have this section heading appear in the Table of Contents.

6. In the Default Style field, select Heading 2, which is a preconfigured style that can be applied for level-2 section
headings. If required, you can set up your own style and apply that instead (see Styles).

7. Click OK.

7.2.6.3.4.94 3. Insert a Simple Source for the Pivot Table.

This simple source will be used as the data source for the pivot table that calculates the number of tasks by asset type
and event type in a user-specified workpack. Since the Task system table that we are going to assign doesn’t contain
the Asset Type field, we will extend the simple source with that and we also set up a filter with a user parameter for
Workpack ID. When generating the report, the user can then select the required workpack in a selection dialog.

1. Add a Simple Source element to the Report Layout structure so that it is included within the Tasks
element group. The Simple Source element is located under the SOURCES node within the Tem-
plate Definition section of the dialog.

ò Note

You must insert the simple source within the element group, else, you cannot refer to it from
the other elements of the element group.

2. Double-click the Simple Source element in the structure to edit it.

3. Specify the name Task Listing* for the simple source.

4. In the Table field, click the ellipsis to select the System Table Task.

5. On the Fields tab, add an extra field as follows:

a. Click Add to add an extra field to the Simple Source.

You can see that a Simple Column entry has been added but with no field selected.

b. Right-click the row, or choose Input from the toolbar and choose Field. . . , which brings up a
new dialog.

c. Select the Asset Type field under the Asset Location system table.

6. On the Filters tab, create a new filter with the following data:

• Field: Workpack (available from the drop-down list since it’s a field within the source)

• Comparison: =

• Parameter: User

• Value: Workpack_ID
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7. Click OK.

7.2.6.3.4.95 4. Insert a Text (Paragraph) element for introduction.

You want to insert an introductory text to the report before the pivot table. You want this text to include the workpack
ID that the user selects when generating the report, thus, it has to be a variable. To do that, you add a Text (Paragraph)
element as shown below:

1. Add a Text (Paragraph) element to the Report Layout structure so that it is included within the Tasks element
group and it comes after the Section Heading element.

2. Double-click the new element in the structure to edit it.

3. In the Content field, enter text as follows:

a. Enter The following table shows the number of tasks by asset type and event type in the workpack .

b. Right-click and choose Parameters → Workpack (Workpack_ID) to select the user parameter that you have
added to the Simple Source earlier.

4. Click OK.

266 Chapter 7. Setup and Configuration



NEXUS Documentation, Release 6.9.xxxxx.0

7.2.6.3.4.96 5. Insert a Pivot Table for Tasks.

We want the pivot table to show the number of tasks by asset type and event type in the workpack that the user selected.

1. Add a Pivot Table element to the Report Layout structure so that it is included within the Tasks element group.

2. Double-click the element in the structure to edit it.

3. In the top part of the Edit Pivot Table dialog, enter data as follows:

• Name: Enter Task List or any name that identifies the element in the structure.

• Description: Tasks by Asset Type and Event Type

• Show Caption: Tick to add the name of the pivot table as a caption.

• Show Column Totals: Tick to add a row that shows the total number for each column.

• Show Row Totals: Tick to add a column that shows the total number for each row.

• Show Zero Values: Tick to show values even if it is 0. If you disable this option, any values that would
have shown “0” will be replaced with a blank.
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• Show Rows with All Zero/Blank Values: Tick so that if a row contains “0” value or no value at all, it will
be shown in the output.

• Style Prefix: Enter New to use the style that you have set up in the example for Anomaly Summary Report,
see 4. Create a new style for even rows..

• Source: Select Task Listing.

4. Under the Pivot section of the dialog, make settings as follows:

a. In the Rows section, choose Add.

b. Double-click in the new row that has been added and select Asset Type. The available fields in the drop-
down list are retrieved from the Source that you have selected above. This setting determines that the rows
of the pivot table will correspond to the values of the Asset Type field.

c. In the Column section, choose Add.

d. Double-click in the new row that has been added and select Event Type. This determines that the columns
of the pivot table will correspond to the values of the Event Type field.

e. In the Values section, we set up what we want to be calculated and based on which field. In our case, we
want to count the number of tasks, so the field based on which we want to perform the calculation will
be Task_ID, which is unique to each task record. Thus, make settings for the corresponding columns as
follows:

• Field: Select Task_ID.

• Aggregate: Select Count.

• Aggregate (Total): Select Count.

• Name: Enter No. Tasks. If you calculate row totals, this will be shown as the title of the column
heading.

5. Click OK.
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ò Result

When you generate the output, you can see that the pivot table has been inserted with the new style and
shows the calculated number of tasks for each asset type and event type combination. The text above
the pivot table shows the workpack ID that you selected when generating the report.
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Proceed to Next Step

7.2.6.3.4.97 Add Pivot Table for Findings with Text, Simple Source with Filter

We now want to insert a pivot table that shows the number of findings by specific codes in a workpack selected by the
user during report generation. We want to add a heading and a description before the table. To do that, we create the
following elements:

• An Element Group for Findings, which will include the pivot table, text and heading. We will use this element
group later for another findings-related element too.

• A level-2 Section Heading

• A Text (Paragraph) element to include a description

• A Simple Source for the Finding system table, to which we add a filter for Workpack ID as a user parameter.

• The actual Pivot Table

See the detailed steps below:

1. Insert an Element Group.
2. Insert a level-2 Section Heading for the pivot table.
3. Insert a Simple Source for the Pivot Table.
4. Insert a Text (Paragraph) element for introduction.
5. Insert a Pivot Table for Findings.

7.2.6.3.4.98 Prerequisites

You have completed the following steps:

• Create Template, Set Layout, Add Title and Change Heading Style

7.2.6.3.4.99 Process

7.2.6.3.4.100 1. Insert an Element Group.

This element will contain the heading, text, pivot table and simple source that we are going to create for this section of
the report.

1. Add an Element Group element to the Report Layout structure. It should be on the same level as the element
group you created for tasks.
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� Tip

If the element is not inserted to the right location in the element structure, use the Move Up or Move Down
buttons in the toolbar to move them to the correct place.

2. Double-click the element in the structure to edit it.

3. Enter the name Findings, which will identify the element in the structure. You do not need to make other settings
for the element group right now.

4. Click OK.

7.2.6.3.4.101 2. Insert a level-2 Section Heading for the pivot table.

1. Add a Section Heading element to the Report Layout structure so that it is included within the Findings element
group.

2. Double-click the element in the structure to edit it.

3. Enter a name that identifies the element in the structure, for example, Findings Heading 2. This text does not
appear in the actual report output.

4. Enter the text of the heading that you want to see in the output in the Content field, for example, Number of
Findings per Code.

5. Select the Include in Table of Contents checkbox to have this section heading appear in the Table of Contents.

6. In the Default Style field, select Heading 2, which is a preconfigured style that can be applied for level-2 section
headings. If required, you can set up your own style and apply that instead (see Styles).

7. Click OK.

7.2.6.3.4.102 3. Insert a Simple Source for the Pivot Table.

This simple source will be used as the data source for the pivot table that calculates the number of findings per code in
a user-specified workpack. We also set up a filter with a user parameter for Workpack ID to allow users selecting the
required workpack during report generation.

1. Add a Simple Source element to the Report Layout structure so that it is included within the Find-
ings element group. The Simple Source element is located under the SOURCES node within the
Template Definition section of the dialog.

ò Note

You must insert the simple source within the element group, else, you cannot refer to it from
the other elements of the element group.

2. Double-click the Simple Source element in the structure to edit it.

3. Specify the name Finding* for the simple source.

4. In the Table field, click the ellipsis to select the System Table Finding.

5. On the Filters tab, create a new filter with the following data:

• Field: Workpack (available from the drop-down list since it’s a field within the source)

• Comparison: =
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• Parameter: User

• Value: Workpack_ID

6. Click OK.

7.2.6.3.4.103 4. Insert a Text (Paragraph) element for introduction.

You want to insert an introductory text to the report before the pivot table. You want this text to include the workpack
ID that the user selects when generating the report, thus, it has to be a variable. To do that, you add a Text (Paragraph)
element as shown below:

1. Add a Text (Paragraph) element to the Report Layout structure so that it is included within the Findings
element group and it comes after the Section Heading element.

2. Double-click the new element in the structure to edit it.

3. In the Content field, enter text as follows:

a. Enter The following table shows the number of findings for each code within the workpack .

b. Right-click and choose Parameters → Workpack (Workpack_ID) to select the user parameter that you have
added to the Simple Source earlier.

4. Click OK.

7.2.6.3.4.104 5. Insert a Pivot Table for Findings.

We want the pivot table to show the number of findings per codes in the workpack that the user selected.

1. Add a Pivot Table element to the Report Layout structure so that it is included within the Findings element
group.

2. Double-click the element in the structure to edit it.

3. In the top part of the Edit Pivot Table dialog, enter data as follows:

• Name: Enter Number of Findings per Code or any name that identifies the element in the structure.

• Show Caption: Tick to add the name of the pivot table as a caption.

• Show Column Totals: Tick to add a row that shows the total number for each column.

• Show Zero Values: Tick to show values even if it is 0. If you disable this option, any values that would
have shown “0” will be replaced with a blank.

• Show Rows with All Zero/Blank Values: Tick so that if a row contains “0” value or no value at all, it will
be shown in the output.

• Source: Select Finding.
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4. Under the Pivot section of the dialog, make settings as follows:

a. In the Rows section, choose Add.

b. Double-click in the new row that has been added and select Code. The available fields in the drop-down
list are retrieved from the Source that you have selected above. This setting determines that the rows of the
pivot table will correspond to the values of the Code field.

c. In the Values section, we set up what we want to be calculated and based on which field. In our case, we
want to count the number of findings, so the field based on which we want to perform the calculation will
be Finding_ID, which is unique to each finding record. Thus, make settings for the corresponding columns
as follows:

• Field: Select Task_ID.

• Aggregate: Select Count.

• Aggregate (Total): Select Count.

• Name: Enter No. Finding. Since we now have only one parameter based on which we calculate the
values (Code), this will be the title of the column that shows the numbers for each code.

5. Click OK.

7.2. Configuration 273



NEXUS Documentation, Release 6.9.xxxxx.0

ò Result

When you generate the output, you can see that the pivot table has been inserted and it shows the
calculated number of findings for each code within the workpack. The text above the pivot table shows
the workpack ID that you selected when generating the report.
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Proceed to Next Step

7.2.6.3.4.105 Add Table of Data for Event Types with Distinct Source

In this step, we work in the same Findings Element Group as in the previous step, but now we want to create a table
that lists all the event types that are related to the findings in a selected workpack. For this, we’ll need a distinct source
that returns the Event Type field values within the Finding Simple Source (created in the previous step). In this step,
we create the following elements:

• A level-2 Section Heading

• A Text (Paragraph) element to include a description

• A Distinct Source

• The actual Table of Data

See the detailed steps below:

1. Insert a level-2 Section Heading for the Table of Data.
2. Insert a Text (Paragraph) element for introduction.
3. Insert a Distinct Source for the Table of Data.
4. Insert a Table of Data for Event Types.

7.2.6.3.4.106 Prerequisites

You have completed the following steps:

• Create Template, Set Layout, Add Title and Change Heading Style

• Add Pivot Table for Findings with Text, Simple Source with Filter

7.2.6.3.4.107 Process

7.2.6.3.4.108 1. Insert a level-2 Section Heading for the Table of Data.

1. Add a Section Heading element to the Report Layout structure so that it is included within the Findings element
group.

2. Double-click the element in the structure to edit it.

3. Enter a name that identifies the element in the structure, for example, Event Types Heading 2. This text does not
appear in the actual report output.
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4. Enter the text of the heading that you want to see in the output in the Content field, for example, Relevant Event
Types.

5. Select the Include in Table of Contents checkbox to have this section heading appear in the Table of Contents.

6. In the Default Style field, select Heading 2, which is a preconfigured style that can be applied for level-2 section
headings. If required, you can set up your own style and apply that instead (see Styles).

7. Click OK.

7.2.6.3.4.109 2. Insert a Text (Paragraph) element for introduction.

You want to insert an introductory text to the report before the Table of Data. You want this text to include the workpack
ID that the user selects when generating the report, thus, it has to be a variable. To do that, you add a Text (Paragraph)
element as shown below:

1. Add a Text (Paragraph) element to the Report Layout structure so that it is included within the Findings
element group and it comes after the Section Heading element.

2. Double-click the new element in the structure to edit it.

3. In the Content field, enter text as follows:

a. Enter See below the list of event types that are related to the findings in workpack .

b. Right-click and choose Parameters → Workpack (Workpack_ID) to select the user parameter that you have
added to the Finding Simple Source earlier.

4. Click OK.

7.2.6.3.4.110 3. Insert a Distinct Source for the Table of Data.

The Distinct Source will use data from the Finding Simple Source, restricting it to the Event Type field.

1. Add a Distinct Source element to the Report Layout structure so that it is included within the
Findings element group. The Distinct Source element is located under the SOURCES node within
the Template Definition section of the dialog.

ò Note

You must insert the distinct source within the element group, else, you cannot refer to it
from the other elements of the element group.

2. Double-click the Distinct Source element in the structure to edit it.

3. Specify the name Distinct Source for Event Types*.

4. In the Source field, select the Finding Simple Source. The available values in this drop-down list
are the Simple Sources that are within the same Element Group.

5. In the Columns field, select Event Type from the fields within the Finding source.

6. Click OK.
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7.2.6.3.4.111 4. Insert a Table of Data for Event Types.

We want the Table of Data to show the list of event types associated with the findings in the selected workpack.

1. Add a Table of Data element to the Report Layout structure so that it is included within the Findings element
group after the relevant Text (Paragraph) element.

2. Double-click the element in the structure to edit it.

3. On the Properties tab, make settings as follows

• Name: Enter Distinct Event Types or any name that identifies the element in the structure.

• Select the Hide Columns with No Values checkbox, leave the other checkboxes deselected.

• Source: Select Distinct Event Types.

4. On the Layout tab, change the value of Alignment to Left.

5. Click OK.
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ò Result

When you generate the output, you can see that a table has been added that shows the event types
associated with the findings in the selected workpack. The text above the table shows the workpack ID
that you selected when generating the report.

Proceed to Next Step
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7.2.6.3.4.112 Add Drawing Details and Extended Simple Source with Filters

We want to insert drawings associated with assets that the user can select upon report generation. We also want to
include layers on the drawings and a heading before the drawings. To do that, we create the following elements:

• An Element Group for Drawings to include the Drawing Details element with a parameter that allows excluding
this part of the report during report generation

• A level-2 Section Heading

• A Simple Source for the Drawing system table, from which the Drawing Details element can retrieve data. We
extend the source with a field for Drawing Name so that it can be used for the caption. We also add a filter
for VN_ID (Asset Location) as a user parameter so that the user can select the required asset tree branch when
generating the report.

• A Simple Source for the Asset system table, which will be used to retrieve data for the layers of the drawings.
We extend this table with a few fields required for the layers and also add a filter for VN_ID (Asset Location) as
a user parameter.

• The actual Drawing Details element.

See the detailed steps below:

1. Insert an Element Group.
2. Insert a level-2 Section Heading for the drawings.
3. Insert a Simple Source for the Drawings.
4. Insert a Simple Source for Asset.
5. Insert a Text (Paragraph) element for introduction.
6. Insert the Drawing Details element.

7.2.6.3.4.113 Prerequisites

You have completed the following steps:

• Create Template, Set Layout, Add Title and Change Heading Style

7.2.6.3.4.114 Process

7.2.6.3.4.115 1. Insert an Element Group.

This element will contain the heading, drawing details and simple sources that we are going to create for this section
of the report.

1. Add an Element Group element to the Report Layout structure. It should be on the same level as the element
groups that you created earlier.

� Tip

If the element is not inserted to the right location in the element structure, use the Move Up or Move Down
buttons in the toolbar to move them to the correct place.

2. Double-click the element in the structure to edit it.

3. Enter the name Drawings, which will identify the element in the structure.

4. Select the Allow Excluding Group from Export checkbox to enable a selection parameter during report gen-
eration. This allows users to exclude this element group from the report output when they start generating the
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report. This feature is particularly useful when you have numerous drawings that take a long time to generate,
and you want to quickly review other parts of the report.

5. Click OK.

7.2.6.3.4.116 2. Insert a level-2 Section Heading for the drawings.

1. Add a Section Heading element to the Report Layout structure so that it is included within the Drawings
element group.

2. Double-click the element in the structure to edit it.

3. Enter a name that identifies the element in the structure, for example, Drawings Heading 2. This text does not
appear in the actual report output.

4. Enter the text of the heading that you want to see in the output in the Content field, for example, Drawings.

5. Select the Include in Table of Contents checkbox to have this section heading appear in the Table of Contents.

6. In the Default Style field, select Heading 2, which is a preconfigured style that can be applied for level-2 section
headings. If required, you can set up your own style and apply that instead (see Styles).

7. Click OK.

7.2.6.3.4.117 3. Insert a Simple Source for the Drawings.

This simple source will be used as the data source for the Drawing Details element and will refer to the Drawing system
table. Since we want to use the name of the drawing as the caption, we add the extra field Name from the Library system
table. We also set up an asset tree filter with a user parameter for VN_ID to allow the user to filter based on a specific
branch of the asset tree. When generating the report, the user will see a selection dialog where they can select the
required asset tree branch.

1. Add a Simple Source element to the Report Layout structure so that it is included within the Draw-
ings element group. The Simple Source element is located under the SOURCES node within the
Template Definition section of the dialog.

ò Note

You must insert the simple source within the element group, else, you cannot refer to it from
the other elements of the element group.

2. Double-click the Simple Source element in the structure to edit it.

3. Specify the name Drawing* for the simple source.

4. In the Table field, click the ellipsis to select the System Table Drawing.

5. On the Fields tab, add an extra field as follows:

a. Click Add to add an extra field to the Simple Source.

You can see that a Simple Column entry has been added but with no field selected.

b. Right-click the row, or choose Input from the toolbar and choose Field. . . , which brings
up a new dialog.

c. Select the Name field under the Library* system table.

d. Since the name appears as Library, double-click in the Field / Alias field for the new
row and overwrite the name to Drawing Name.
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6. On the Filters tab, create a new filter with the following data:

• Field: Click the ellipsis and select the VN_ID field from under the Asset Location system
table.

• Comparison: Is Child Of*

• Parameter: User

• Value: VN_ID

7. Click OK.

7.2.6.3.4.118 4. Insert a Simple Source for Asset.

We want to display layers on the drawings, which will require some asset data, thus, we need to insert a simple source
that links to the Asset Location system table. We also need to extend the simple source with additional fields for Asset
Name, Asset Component ID and Traffic Light colour. Similarly to the step above, we also set up an asset tree filter with
a user parameter for VN_ID to allow the user to filter based on a specific branch of the asset tree.

1. Add a Simple Source element to the Report Layout structure so that it is included within the Draw-
ings element group.

ò Note

You must insert the simple source within the element group, else, you cannot refer to it from
the other elements of the element group.

2. Double-click the Simple Source element in the structure to edit it.

3. Specify the name Asset* for the simple source.

4. In the Table field, click the ellipsis to select the System Table Asset Location.

5. On the Fields tab, add extra fields as follows:

a. Click Add to add an extra field to the Simple Source.

You can see that a Simple Column entry has been added but with no field selected.
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b. Right-click the row, or choose Input from the toolbar and choose Field. . . , which brings
up a new dialog.

c. Select the Component_ID field under the Asset system table.

d. Double-click in the Field / Alias field for the new row and overwrite the name to Com-
ponent ID.

e. Add two other fields in the same way:

• A row for the Name field under the Asset system table, overwrite name to Asset
Name.

• A row for the Rolled Up (Colour) field from the Traffic Lights system table.

6. On the Filters tab, create a new filter with the following data:

• Field: Click the ellipsis and select the VN_ID field from under the Asset Location system
table.

• Comparison: Is Child Of*

• Parameter: User

• Value: VN_ID

7. Click OK.

7.2.6.3.4.119 5. Insert a Text (Paragraph) element for introduction.

You want to insert an introductory text to the report before the drawings. You want this text to include the Asset
Location ID (VN_ID) that the user selects when generating the report, thus, it has to be a variable. To do that, you add
a Text (Paragraph) element as shown below:

1. Add a Text (Paragraph) element to the Report Layout structure so that it is included within the Drawings
element group and it comes after the Section Heading element.

2. Double-click the new element in the structure to edit it.

3. In the Content field, enter text as follows:

a. Enter See below the drawings associated with Asset “.

b. Right-click and choose Parameters → VN_ID to select the user parameter that you have added
to the Simple Sources earlier.

c. Continue entering the text: “” and its children:”

That is, the text that you have added looks like this: “See below the drawings associated with Asset
“[PARAM VN_ID]” and its children:”

4. Click OK.
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7.2.6.3.4.120 6. Insert the Drawing Details element.

1. Add a Drawing Details element to the Report Layout structure so that it is included within the Drawings
element group and it is under the Text (Paragraph) element.

2. Double-click the element in the structure to edit it.

3. In the Edit Drawing Details dialog, enter data as follows:

• Name: Enter Drawing Details or any name that identifies the element in the structure.

• Source: Select the Drawing source, which you have created earlier.

• Caption Field: Select the field Drawing Name, which you have added to the simple source earlier.

• Automatically Rotate for Page: Leave it selected.

• DPI Scale: Leave the value 1.

• View Options: Select Display All Layers. Additional fields become available for selection.

• Asset Source: Select the Asset source, which you have created earlier. This will be used to retrieve infor-
mation for the layers.

• Asset Field: Select the field Component_ID, which you have added to the simple source earlier.

• Name Field: Select the field Asset Name, which you have added to the simple source earlier.

• Colour Field: Select the field Rolled up (Colour), which you have added to the simple source earlier.

4. Click OK.

report.template.workpack.drawing_details |
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ò Result

When you generate the output, you can see that the drawings have been inserted including the layers
The text above the drawings shows the VN_ID that you selected when generating the report.

Proceed to Next Step

7.2.6.3.4.121 Insert Table of Contents, Verify Output

In this step, you insert a Table of Contents element and check if the output complies with your requirements.

See the detailed steps below:

1. Insert a Table of Contents element.
2. Generate an output to check the final output of the report.

7.2.6.3.4.122 Prerequisites

You have completed the following steps:

• Create Template, Set Layout, Add Title and Change Heading Style

• Add Pivot Table for Tasks with Text, Extended Simple Source with Filter

• Add Pivot Table for Findings with Text, Simple Source with Filter

• Add Table of Data for Event Types with Distinct Source

• Add Drawing Details and Extended Simple Source with Filters
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7.2.6.3.4.123 Process

7.2.6.3.4.124 1. Insert a Table of Contents element.

Drag the Table of Contents element or select it and choose Add to insert it in the Report Layout structure. Ensure that
it is the first node within the structure:

ò Note

• The Table of Contents element is applicable only to RTF and HTML outputs.

• The formatting of the Table of Contents element depends on your settings for the
elements starting with TOC in your generic report style configurations (see Styles).
You can adjust the look of each heading level as required. For example, for Heading
2 in the TOC, you edit the style TOC Heading 2 and add a left padding value “30”.

• In the RTF output, you must right-click and update the table of contents to ensure
that page numbers appear correctly.

7.2.6.3.4.125 2. Generate an output to check the final output of the report.

To generate the output, proceed as follows:

1. In the Edit Report Template dialog, choose OK to close the dialog and save your changes.

2. Back in the Configuration - Templates dialog, select the report template and choose the Generate
toolbar button.

3. Select the required output format from the drop-down, which can be either RTF, HTML, or Microsoft
Excel.

4. Select a report destination, which, in this case, will be File.

5. Choose Commit.
6. Close the Configuration - Templates dialog.

7. Wait until the report output is generated. The progress is indicated at the bottom of the main NEXUS
IC screen.
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8. Once the generation is complete, click the Save icon to download and save the report.

9. Select the destination and open the file.

10. If you generated an RTF output, right-click the Table of Contents and choose Update Field to ensure
that page numbers appear correctly.

11. Review the report to verify it meets your expectations.

You can make configurations for NEXUS from the Configuration menu of NEXUS IC.

When you select Configuration from the main menu, you can make settings for the following:

• General Configuration

• Configure Assets

• Configure Planning Data

• Configure Events

• Configure Anomalies

• Configure Reports and Dashboards

³ Caution

We advise that you take caution when making changes in your configurations, especially for Configure
Chart Templates, Configure Functions, Configure Connections, Configure Shortcuts, Configure Asset
Information Groups, Configure Sensors, Configure Risk Charts, Configure Risk Models, and Configure
Event Types. Before making changes in these areas, we suggest that you take a database backup. Also,
before deleting anything, we recommend that you check Connections.

7.3 Tools

7.3.1 Options
Under Tools → Options, you can make some generic settings related to the applications.

All options and settings in this dialog are currently user-specific. The options and settings are stored in the windows
folder: C:\Users\[USER_NAME]\AppData\Roaming\NEXUS
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Under Options, you can make settings as follows:

Tab Settings
General You can make configurations for database backup, specify the cache and export folders. For

information about setting up the network path for backup and restore, see Setting Up Network
Path for Backup/Restore.

Spell Checking You can enable spell checking and specify the relevant dictionary to be used as well as any
custom words that you want to add to the dictionary. These words are then ignored during spell
checking.

Inspection You can make settings for capturing videos during inspections (for example, specifying the image
format, image capture naming or JPEG quality, as well as enabling automatically switching to
video time and sync KP) and assign keybindings to actions to be used on the Inspections Review
screen. For more information, see Setting Up Keybindings.

7.3.1.1 Setting Up Network Path for Backup/Restore

You specify the network path for backing up or restoring data in the Network path for backup/restore field under Tools
→ Options → General.

This path must be accessible to both the database server and to NEXUS IC. This may be a UNC path (like ‘\\My-
Server\MyShare’) or if the database server and NEXUS IC are running on the same machine, it may be a Windows
path (like ‘C:\Database Backups’).

When the path is valid (that is, it is visible to both Integrity Centre and the database server) it will have no border. If
the path is invalid, a yellow border will be shown around the field.

Example valid path:

Example invalid path:

� Tip

The database server process must have permission to read and write to the folder. If the path is shown as invalid,
check the permissions of the user account that the database server service is running under.

7.3.1.2 Setting Up Keybindings

Inspection keybindings allow the user to assign function keys and numeric keypad keys as shortcuts to common review
actions within the INSPECTION screen.

You can define keybindings under Tools → Options → Inspection.

7.3. Tools 287



NEXUS Documentation, Release 6.9.xxxxx.0

Click on the Restore Defaults button to pre-populate common keybindings.

To assign a keybinding to an action, proceed as follows:

1. Select the Action.

2. Double-click in the Keybinding column and click on the Ellipsis button.

3. Press the key (or key combination) that you want to assign to the currently selected action. The keybinding will
then be displayed in the grid.

7.3.2 Video. . .
The Configuration - Video dialog lists all parsed video files that exist in the folders defined in the Database → Prop-
erties → Global Video Path field and the Database → Properties → Temporary Inspection Video Path folders.

From this dialog, you can:

• Add, edit, or delete video files

If there are videos listed that no longer exist (for example because you have used Windows Explorer to move or
delete them), you should remove them from this list too, using the Delete button. You can use multi-select for
deleting several files at once.

• Export video files to HTML, RTF or Text and save or send them via e-mail (see Export)

• Customise the layout of the grid (see Customise)

• Play a selected video file

• Open the folder location of the selected video file in Windows Explorer.

Note that the Open Location button is only enabled for non-cloud based storage locations.

• Upload video files, which copies video files from the Temporary Inspection Video Path to the Global Video
Path.

This is typically used to copy inspection video returned from an inspection campaign to the master video storage
location. The Upload process gives you the option to delete, rename, or retain the local video files (this could be
on a USB HDD) after the Upload has finished. Additionally, you can elect to encode the video files to the native
streamable H.264 file format during the copy process. To successfully upload, video file names must reflect one
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of the accepted filename formats. If NEXUS IC cannot parse the start time of the video from the file name, then
the video will not upload.

ã See also

Managing Videos

7.3.3 Parse Video
Clicking on an item in the Parse Video drop-down menu causes NEXUS IC to read video and image files and store
their properties (such as start time and duration) in the database. The datetime properties of the video and image files
are the links to the events in the Inspection screen.

• Choosing Global Video parses all video and image files in the Global Video Path. (Typically you would use this
option onshore.)

• Choosing Temporary Video parses all files in the Temporary Inspection Video Path. Files ending in ‘.uploaded’
will be ignored. (Typically you would use this option offshore.)

• Choosing All Video parses all files in both those locations.

The parsed videos and images will appear in the Tools → Video. . . dialog (see above).

As files are parsed, start time data will be read from the filename. After the parse completes, any files whose start time
could not be read will be shown in a list. These files will be present in the Configuration - Video dialog but cannot be
uploaded until their names are edited to match one of the accepted filename formats.

ã See also

Managing Videos

Under the Tools menu, you can access some tools and options for influencing or checking the generic behaviour of the
application.

The Tools menu is available for NEXUS IC and IC-Inspection, however, in IC-Inspection, not all options are available.

Under Tools, you can access the following:

• Options (see Options)

• Video.. (see Video. . . )

• Parse Video (see Parse Video)

Before you start using NEXUS IC, you must set it up as described in Deployment.

From the main menu of NEXUS IC, you can make settings for, adjust, or check the way NEXUS IC works, including:

• Performing tasks related to the database (see Database)

• Configuring the NEXUS IC database (see Configuration)

• Using the Tools menu for influencing or checking the generic behaviour of the application (see Tools)
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CHAPTER

EIGHT

GENERAL FEATURES

The topics below describe features that are relevant for NEXUS IC in general.

• Searching

• Checking History

• Using the Grid

• Using the Status Bar

• Validating Data

• Unhandled Exceptions

Some features are also relevant for IC-Inspection, see General Features in IC-Inspection for information about the
differences.

8.1 Searching
In NEXUS IC, you can perform a database-wide search or an asset-specific search within an asset tree.

• Perform Database-Wide Search
To search for a term in the whole NEXUS IC database, follow the steps below:

1. In the top-right corner of the main screen, type text into the search box.

2. Press ENTER or click the icon.

3. Check the results in the Search Results dialog.

ò Note

– Anomaly codes and numbers can be searched. For example, if you have an anomaly with code AN and
number 1, a search for “AN-1” will return this anomaly in the search results.

– If you’ve typed a text in the search box, you can cancel it anytime by selecting .

• Perform Asset Search
On the ASSETS, PLANNING or INSPECTION screens, you can search for an asset in the database from the
asset tree as follows:

1. Ensure that the asset tree has focus and type the searchable text on the keyboard. As a result, a search box
appears at the bottom of the asset tree. You can also press Ctrl+F to make the search box visible.

2. Press ENTER or click the icon.
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3. Check the results in the Search Results dialog.

ò Note

– If you’ve typed a text in the search box, you can cancel it anytime by selecting or pressing ESC.

– If you’re in the Search Results dialog, pressing ESC twice closes both the Search Results dialog and
the search box under the asset tree.

To carry out further searches, type new text in either the Search Results dialog or the search box, and press ENTER.

� Tip

• You can use ‘_’ (underscore) as a wildcard to represent a single character.

• The Search Results dialog is non-modal, that is, you can keep it open and still work on NEXUS
IC’s main screen. You can, for example, drag the dialog to the bottom left corner of the screen
and leave it open until you close NEXUS IC.
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8.1.1 Use Search Filters
You can limit your search parameters to a specific table to speed up search times and reduce unnecessary search results.

To do this, precede your search terms with ::, followed by the table name you would like to search: ::[Table]
[Search term]. Table names with spaces must be enclosed in quotations. See the table below for a list of frequently
searched tables.

Examples
• To search only assets for the string ‘PSV-1005’, type ::Asset PSV-1005.

• To search only anomalies for the string ‘AW @ 10” PL’, type ::Anomaly AW @ 10" PL.

Similarly, if you want to search data only within a specific Asset Information Group (AIG) or a specific event, precede
the search term with ::, followed by the name of the AIG or event. If the AIG or event name has spaces in it, enclose it
in quotations. For example, to search for the material type ASTM A516 Grade 70N within the AIG Vessel Data, enter
the search parameter ::"Vessel Data" ASTM A516 Grade 70N:

You can use the following common search parameters to search data within specific tables:

Category Search Parameters
Inspections ::[Event Name], ::Finding, ::Commentary, ::Multimedia
Assets ::Asset, ::[AIG Name], ::“Asset History”
Anomalies ::Anomaly, ::“Anomaly Action”, ::Finding
Library ::Library
Planning ::Workpack, ::Task, ::“Planning Template”, ::Shutdown
Miscellaneous ::“Report Template”, ::”Table Definition”, ::”Field Definition”,

::”Function Definition”

Filtering your search results is especially useful in large databases for which global searching takes a long time.
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8.1.2 Result Categories
In the Search Results dialog, results are broken into categories (for example, ANOMALY, ASSET, FINDING in the
screenshot below). Categories are shown in capital letters. Categories with many results initially appear rolled up and
categories with only a few results are automatically expanded.

8.1.3 Navigate to Search Result Items
From the Search Results dialog, you can navigate to a selected item in the search results in one of the following ways:

• Double-click on any result that isn’t a category.

• Select an item and choose Navigate To in the toolbar.

• Right-click an item and select Navigate To.. from the drop-down list.

When navigating to an item, NEXUS IC takes you to the appropriate place in NEXUS IC. For example, if you navigate
to a specific asset, NEXUS IC switches to the Asset Data Management screen and focuses the asset in question. For
results that are not available on the main NEXUS IC screen but are available in a Configuration dialog, NEXUS IC
opens that dialog and shows the selected item.

When NEXUS IC has opened a dialog to show you a search result, these dialogs are modal, that is, you won’t be able
to access the Search Results dialog until you close the dialog.

8.1.4 Edit Items from Search Results
You can start editing items directly from the Search Results dialog. You can do that in one of the following ways:

• Select an item and choose Edit in the toolbar.

• Right-click an item and select Edit from the drop-down list.
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8.1.5 Searching in Different Solutions
While NEXUS IC performs a database-wide search, IC-Inspection performs a search on a subset of the database.
NEXUS IC has a Search box at the top right. IC-Web instead has a search box above the asset tree, which searches
only asset names.

For information about searching in IC-Inspection, see General Features in IC-Inspection.

8.1.6 Autocomplete

In case you see a record lookup editor (a text box with a ellipsis button and clear button at the right), you can
type the first few letters of the entry you want to match, and NEXUS will fill that value without having to click and
pick a value from the picker dialog.

This method is most suitable when you are certain of the text of the value you want to pick, and where there are not
many values with the same first few letters (“Anode 001”, “Anode 002”, etc). For other cases, Find As You Type, below,
may be more suitable.

8.1.7 Find As You Type
In most grids, you can use the Find As You Type feature to filter items in the grid based on the text that you typed. In
this case, you start typing on any active grid to trigger the filter. For more information, see Find As You Type.

ã See also

Filtering

8.2 Checking History
With each editable dialog, there is a tabbed page titled History which shows all changes made to the record. The History
tab is similar to the Changes dialog in the Audit Log.
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The left section lists in tabular form all changes made to a record:

• Operation - Insert indicates the creation or addition of a record, Update indicates that the data was changed
from a pre-existing value to a new value, and Delete indicates the deletion of a record.

• Date Changed - Shows the date and time the change was made in the database. The table is ordered chronolog-
ically by default.

• The Table Definition column can be added via Customise to show which table the change was applied to.

The right section displays the name of the user, the form and the values of each field relevant to the change. Fields

within the form that were changed are marked with a blue highlight. For an ‘Update’, the following tabs will be
displayed:

• Original Values - Makes visible the values as they were prior to the change, with the changed values visible by

hovering over the .

• Changed Values - Makes visible the values as they were after the change, with their original values visible by

hovering over the .

• Summary - The summary will show all changes within the change record in an easy to read, written format.

For changes with Operation type Insert, the following tab will be displayed in place of Original Values:
• Form - Shows the form and field values in the initial state, as it was created.

See also Audit Log.
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8.3 Using the Grid
Grids are a core component of many screens in both NEXUS IC and IC-Inspection. The topics below describe
common functionality available across grids, helping you interact with and manage data.

• Add, Edit, Delete (see Add/Edit/Delete)

Create new records, modify existing entries, or remove items directly within the grid.

• Connections (see Connections)

View items that are linked to the active record and manage them through editing, copying, or revealing unlinked
items.

• Import (see Import)

Bring external data into the grid and bulk update data stored in the database.

• Export (see Export)

Extract grid data for use outside the application.

• Reports (see Reports)

Generate reports based on preconfigured report templates.

• Customise (see Customise)

Adjust grid layout and column visibility.

• Multi-Edit (see Multi-Edit)

Apply changes to multiple selected records simultaneously, saving time and reducing manual effort.

• Sorting (see Sorting)

Sort grid data by one or more columns to organise information.

• Find As You Type (see Find As You Type)

Quickly locate records within the grid by typing directly into the active grid.

• Filtering (see Filtering)

Narrow down visible records using filters based on column values or conditions.

• Grouping (see Grouping)

Organise records into collapsible groups based on shared attributes.

• Right-Clicking (see Right-Clicking)

Access context-specific actions and shortcuts by right-clicking on grid rows.

• Unit Conversion (see Unit Conversion)

View and convert measurement units directly within the grid.

8.3.1 Add/Edit/Delete

Most grids in NEXUS IC have toolbar buttons for adding ( ), editing ( ) and deleting ( ) items.

If there is insufficient space for some or all of the captions, you will see buttons without captions. If you have read-only
permissions on a specific item, you will see a View button instead of an Edit button.
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• Add
Adds a new item.

• Edit
Edits the selected items in the grid.

• Delete
Deletes the selected items in the grid.

� Tip

• You can use keyboard shortcuts to perform an Add, Edit or Delete action:

– Add - Insert key

– Edit - Enter key

– Delete - Delete key

To use the shortcut keys, ensure that the grid you want to edit has focus. To set focus to a grid,
click on a row or empty area inside the grid.

• Most grids support multi-edit, which can be used to bulk edit/delete items (see Multi-Edit for
more information).

8.3.2 Connections
The Connections toolbar button allows you to view items that are linked to the active record. It displays elements that
have a reference or connection to the selected record.

However, it follows a one-way relationship: it only shows items that depend on the active record, not the reverse. For
example, if you’re examining connections for an event, it will show related items such as multimedia and findings.
However, it won’t display the asset that the event is on because the event is connected to the asset, not the asset to the
event.

In the Connections dialog, you can perform the following actions:

• You can edit the selected connections using the Edit button. This triggers a dialog to edit the selected connection.
For example, if it’s an anomaly record, the Edit Anomaly dialog opens, if it’s a task, the Edit Task dialog opens,
and so on.

• You can copy the text of the selected connection to the clipboard.

• If any selected items have no connections, a Show All button will be visible in the toolbar. Selecting this button
will reveal a root node called NO CONNECTIONS that contains all the connectionless source items. Unselect-
ing the button will hide connectionless items from the connections list. See the image below for the Show All
button and results outlined in red.
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In case of checking connections for Sub Asset Information records, connections show all field definition nodes in the
format of [Table Name].[Field Name]. The exception is if the direct parent is the Field Definition Table, in this case,
only [Field Name] will be used. The field definition format is shown outlined in red in the screenshot below:

� Hint

If you are considering deleting an asset or assets from the asset tree, we recommend first checking what data might
be linked to that asset. To do this, from the ASSETS screen, right click on any asset in the asset tree and choose
Connections from the context menu. The Connections dialog will appear categorising and listing all data elements
which have a reference or connection to the selected asset.
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8.3.3 Import
The Import functionality enables you to bulk update data stored in the database. There are numerous Import buttons
throughout NEXUS IC — the Import button on the ASSETS screen allows you to import assets and asset information
(see Import Assets), the Import button on the LIBRARY screen allows you to import library types, the Import button
on the Library tab within the LIBRARY screen allows you to import library items, and so on.

The format of the Excel workbook needs to be specific. We recommend that you use the Example button (shown
below) to generate an Excel template in a format suitable for importing data.

The Import Template generated using the Example button will highlight fields that have been flagged as Required
fields, set up lookup lists and provide information on the format and field type in the grey rows as shown here:
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³ Caution

It’s essential to understand that during the import process, the SQL server generates Row and Table Locks. As a
result, other users accessing NEXUS IC might perceive the application as unresponsive. However, once the import
completes and the data is committed, these locks are released. Subsequently, other users can resume using NEXUS
IC without any issues.

8.3.3.1 Import Files

ò Prepare Data for Import

Before you start the import, you must prepare the files in the required format. Compatible file types include .zip,
.xlsx (Excel), .csv, and .txt. Zip files can contain the xlsx/csv/txt file plus any additional files, for example, multi-
media images or electronic documents for importing into the library.

� Tip

• For very large imports, saving your Excel file as a .csv and then importing from the .csv may
be faster.

• The Asset Location.Full Location data can be defined in one of the following ways
(you can use only one option, not both):

– As a single column, where each level of the asset location is separated by the string “ /
“, for example, ‘My Field / My Platform / My Member’

– As multiple columns, where each level of the asset location is stored in a separate
sequential column, that is, for each node in the hierarchy, you create a separate column
with the name Asset Location.Full Location and with one asset hierarchy level
in each.

ò Note

Importing directly from .xlsx files is not supported for SaaS customers using the new virtualisation
technology (see SaaS Using Single Sign-On (SSO)). We recommend using .csv files instead.

Sub-Rows in Import Sheet
Sometimes a single row may have several sub-rows. For example, an AIG row might have several sub-AIG rows;
or an event might have several findings or several multimedia images or both. When this occurs, you must create
separate rows in the import sheet for each sub-item, with different “detail” values in each.

For example, if you have several multimedia images to import against a single event, your Excel sheet should
have several rows that are identical except for the Multimedia.Name and Multimedia.Image columns. If you have
specified an event number, and you use the same event number on each row, NEXUS will only create the event
once, but will create several multimedia items. If you do not specify an event number, NEXUS will instead create
several different events with one multimedia item each.

You can also leave event fields blank for all except the last row. Under the hood, NEXUS is importing each Excel
row into the event, and only the last Excel row imported will “stick”. Note that if your event has a finding, you
should not repeat the finding data on each event row; if you do, NEXUS will create one finding for each Excel row
that has finding data filled in.

In some cases, you do want multiple findings on one event, and in that case you must fill in several rows as ap-
propriate. Similarly for sub-event data or sub-AIG data: if you want several different sub-events or sub-AIG rows
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imported, you should repeat the event row or AIG row with different sub-event or sub-AIG data in each case. If you
are repeating an Excel row for another reason and you do not want several sub-event or sub-AIG rows imported,
you should fill in sub-event or sub-AIG data in only one of the Excel rows.

� Tip

You can find the next available event number for a given event type by creating an event of that type
using Add Event, noting the event number, then deleting that event. If you want the next available
event numbers for several event types, create a report template with a Simple Source on table Event
and a Pivot Table with a pivot row on Event Type and a value field on Event Number with aggregate
Max, then add 1.

ò Perform Data Import

1. Choose Import from the toolbar.

2. In the Import File dialog, choose to navigate to the file that you want to import and select it.

ò Note

By default, the dialog shows only CSV files.

3. If required, you can also verify the date and time format in this dialog and you can choose whether
you want to skip blank cells:

• If you select skipping blank cells, then any cells that are blank will be ignored during the
import.

• If you do not select skipping blank cells, then blank cells will update any existing data and
make it blank.

4. Click Next.

ò Result

The system reads the import file and uses the <table name>.<field name> naming con-
vention to map the headers in the import file to database fields in the NEXUS system.

5. In the Configure Import dialog, you can review the mapping proposed by the system and make
changes, if required:

• In the top Field row, you can see the fields to which the system proposes to map the column
headers from the import file. You can manually change the default mapping option for each
column by clicking on the title of the column in the top Field row and selecting one of the
following options:

– Don’t Import - Does not import the selected column to the database.

– Common Fields - Allows you to select common fields in the database to which you want
to map the selected column instead of the database field proposed by the system.

– Other . . . - Allows you to search and select a field from a list of your field definitions as
required.
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Note that if the system couldn’t match a column to a database field for some reason, the
column is displayed in red colour. By default, the system does not map these columns, you
can manually map them if required.

• In case there are required fields in the database for which the system couldn’t find any values
in your import sheet, the system prompts you to set these values in this dialog. In this case,
the relevant fields will be displayed on the right-hand side of the dialog under Required
Fields, where you have the option to set the value globally for this import as required.

• Under Settings, you can specify how many header rows your import sheet contains. For
example, you may have the table name as the first header row and the field name in the
second header row, in which case, instead of having a column title like Asset Location.
Asset View, you’d have a header row for Asset Location and second header row for Asset
View.

• If your import file contains multiple worksheets, ensure that you select the correct worksheet
in the Worksheet field.

Note that if the field type is set to change for an existing field, the import will abort as data loss
may occur.

6. Click Next.

ò Result

The system tests every single row in the import file and shows if there are any issues with
importing. You can abort the test import at any time by clicking Skip.

7. Once the import test is finished, you can see a log that shows any errors or warnings that the
system may have found during test import. In case of errors, you cannot proceed with the import
and the Import button will be inactive. In this case, you must rectify the errors in the import file
and start the import process again.

� Tip

You can copy and select import results from the dialog for review. For instance, it can be
helpful to paste all errors into a spreadsheet to make it simpler to methodically update them.

8. If the import test is finished without errors, you can click Import to complete the process.
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ò Result

Depending on your client, the following happens:
• If using a SaaS client, the import job is offloaded to the SaaS server and is started

remotely. It is then possible to close the current NEXUS IC session while the active
import job continues.

• If using a non-SaaS client, the import job is executed in the current NEXUS IC session
and you may continue using NEXUS IC. Closing the current NEXUS IC session will
cancel the active import job.

In both cases, the UI will refresh intermittently throughout the import, and there will be
delays between the import finishing and final refresh as NEXUS IC does not directly monitor
changes.

ò Note

When importing inspection event data, anomaly triggers are checked during the import and
findings created automatically from data which falls outside the data bounds.

6. Check the status and result of the import in the Job Management Console, which records the
status and history of all import jobs. The import job banner at the bottom of the window shows
the status of the import job and provides the option to dismiss the job or check the details. You
can double-click the job, which triggers a dialog that summarises the import. From this dialog,
you can click Details to show how many rows have been added to various forms or tables. If you
have multiple rows in your import sheet that update the same row, these rows will be counted
by the test import individually, whereas the final import statistics will only show 1 updated row.
You can also save the summary to file.

� Tip

• We highly recommend that you scrutinise the summary to ensure that the import has
performed the actions that you expected. Take note of the total rows for a specific item,
that is, add together the number added and updated and make sure that is equal to the
number you expect.

• If the importer encounters a completely blank row in an Excel file, it will stop import-
ing at that point, even if there are non-blank rows further down. This can provide an
easy way to test an import sheet: set it up, and then after just one or two rows of data,
insert a blank. Run the import to see if it’s doing what you expect, and if so, delete the
blank and run again. Similarly, if the importer encounters a blank column in an Excel
file, columns to the right of this will not be imported.

ò Note

During an import, NEXUS communicates with Excel in the background. NEXUS com-
mands Excel to open the file you want to import, and asks Excel what’s in each cell. If you
use Excel to modify the file while we’re importing it, even if you don’t hit Save, you may
confuse the import process. The same happens if you take a variety of other actions, such as
Save As, closing the Excel, and so on. If you see the error text “Call was rejected by callee”,
it means that Excel has stopped answering calls from NEXUS.
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8.3.4 Export
The Export toolbar option is available on various screens throughout NEXUS IC. It allows you to export the contents
of the active grid into multiple formats, including HTML, RTF, and CSV (Text).

ò Note

The Export button available on grids is different from the custom export functionality available for
assets (see Custom Export Assets) and events (see Custom Export Events). The custom export func-
tionality launches the Export wizard that allows you to select a subset of asset or event data for export.

To perform the export, follow the steps below:

1. Click the Export toolbar button.

2. Choose the required format for exporting the grid data. You have the following options:

• Export → HTML: Saves the data as an HTML file.

• Export → RTF: Saves the data as a Rich Text Format file.

• Export → Text: Saves the data as a CSV (comma-separated values) file.

3. Select one of the following options for exporting the grid contents:

• File: Save the exported data to your computer. Use the Save As dialog to choose a folder and filename,
then click Save..

• Email: Send the exported data via email. The file will be sent to the email address associated with your
current NEXUS IC login.

8.3.5 Reports
The Reports toolbar button enables you to generate a report based on a report template that has been configured in
the NEXUS IC database. The drop-down menu on the Reports toolbar button displays each of the report categories,
and a submenu listing each of the report templates assigned to that category. For information on configuring report
templates, see Configure Report Templates.

For detailed information about the report functionality, see Reports.

8.3.6 Customise
The Customise toolbar button enables you to control which columns appear in the active grid and how rows are dis-
played.

These settings are saved for each user and will be remembered next time the user logs into NEXUS IC.

ò Note

The settings are saved to a file called Integrity Centre.Settings in C:\Users\[USER_NAME]\AppData\
Roaming\NEXUS.

Under the Customise toolbar button, you have the following options:
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• Asset Format
Choose what appears in the Asset column:

– Name Only: Displays only the asset name.

– Location Only: Displays the full location of the asset.

– Name and Location: Displays both name and full location.

ò Note

This option is available only if the Asset column is present. Sorting in this column is always based on the
Full Location, even if only the name is shown.

• Columns
Select columns that you want to be displayed or deselect columns that you want to hide from the grid. You can
also hide columns by right-clicking the column header and choosing Hide from the context menu.
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• Reset to Default
Restores the original column layout and sizes.

• Apply Best Fit
Automatically resizes visible columns for optimal display.

8.3.7 Multi-Edit
Most grids in NEXUS IC enables you to edit and delete multiple rows in a single action.

8.3.7.1 Select Multiple Rows

You can select several rows at once in the following ways:

• To select a consecutive group of rows, click the first item, press and hold down the Shift key, and then click the
last item.

• To select non-consecutive rows, press and hold down the Ctrl key, and then click each item that you want to
select.

8.3.7.2 Edit Multiple Rows

To edit several rows at once, proceed as follows:

1. Select the rows that you want to edit (see above).

2. Click the Edit toolbar button.

3. In the edit dialog that appears, update any values as required.

Note the following:

• Fields that are unedited will retain their original values for all selected rows (even when the data differs
from row to row).

• If you edit a field value in this dialog, an (Undo) icon appears directly to the right-hand side of the
edited field. If you click this icon, the field value will be reverted back to its original value.

4. Click OK to apply all changes to the edited fields for all selected rows.

8.3.7.3 Delete Multiple Rows

To delete several rows at once, proceed as follows:

1. Select the rows that you want to delete (see above).

2. Click the Delete toolbar button.

3. In the confirmation dialog that appears, you can check any connections that the items under deletion have.

4. Click Delete to confirm deletion or Cancel to abort it.

ã See also

• Sorting

• Filtering

• Grouping
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8.3.8 Sorting
All grids in NEXUS IC provide the user the ability to sort by one or more columns.

8.3.8.1 Sorting by a single column

Click anywhere in the column heading to sort by that column. Down arrow indicates descending order, Up arrow
indicates ascending order.

8.3.8.2 Sorting by one or more columns

Shift + Click in any column heading to sort by that column. Down arrow indicates descending order, Up arrow indicates
ascending order. Shift + Click in another column to apply a second sort.

8.3.9 Find As You Type
In most grids in NEXUS IC, if the grid has focus and you type on the keyboard, the grid will filter for the text you have
typed. For example, if you are active on a grid screen and you type “Pipe” (without the quote marks), all rows in that
grid that contain “Pipe” will be shown, and other rows will be temporarily hidden.

Find As You Type searches all text fields, which includes the Name column and any other text fields in the grid. It does
not include any fields of type Lookup List. A blue arrow in their column header indicates which fields are included in
the search.

You can dismiss the Find As You Type search box by clicking at the right side of the find box. You can also dismiss
it by pressing the Escape key. Note though that if the Find As You Type box doesn’t have focus, and you’re in a dialog,
pressing Escape cancels the whole dialog. You can manually bring up the Find As You Type box by pressing Ctrl-F.

8.3.9.1 Find As You Type in Asset Trees

If you want to use Find As You Type on assets, you can do that from the following places:

• On the ASSETS → Children tab.

• In dialogs where the asset tree appears and you can select assets from the hierarchy.

When filtering a tree, unmatched rows will not disappear, instead, they will be greyed out. This ensures that you can
still expand nodes to reach child nodes that may be included in your filter.

If you are in a dialog that allows you to select multiple assets (for example, Copy Assessment feature on the Risk tab,
Filter → Asset on the ANOMALIES Screen, etc.), then any assets that are not matched in your filter will be unselected.
In this case, you can use Select Children as follows:

1. Select your root asset.

2. Type the text that you want to filter for, for example, the asset type.

3. Click Select Children.

4. See that all the assets that match your filter are selected.
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ò Note

When you’re using Find As You Type in an asset tree on the ASSETS, PLANNING or INSPECTION
screens, instead of filtering, you can perform an actual search for the assets. For more information, see
Searching.

8.3. Using the Grid 309



NEXUS Documentation, Release 6.9.xxxxx.0

8.3.10 Filtering
All grids in NEXUS IC allow users to apply one or more filters to individual columns, helping to narrow down the
displayed data.

8.3.10.1 Applying a column filter

1. Hover over a column header. The header will be highlighted in blue, and a filter dropdown icon will appear (as
shown below).

2. Click the dropdown icon to display a list of unique values for that column.

3. Select one or more checkboxes to filter the column based on the selected values.

ò Note

Filters are not saved between sessions. When you close and reopen NEXUS IC, all filters will be cleared.

See also: Find As You Type.

8.3.11 Grouping
You can organise rows in the grid by grouping them based on the values of one or more columns. This helps create a
structured, hierarchical view that makes data analysis easier.

8.3.11.1 Grouping by a Column

To group rows by a specific column:

1. Right-click the column header you wish to group by.

2. Select Group from the context menu.
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Once a column is selected for grouping, a grouping panel appears at the top of the grid. This panel displays the active
groupings and allows you to manage them.

8.3.11.2 Managing Groupings

From the grouping panel, you can:

• Add additional grouping levels by clicking the plus [+] icon and selecting more columns.

• Remove a grouping by clicking the close [×] icon next to the column name.

8.3.11.3 Example: Grouping Anomaly Records

Suppose you have a grid displaying anomaly records. To better analyse the data, you want to apply two levels of
grouping:

1. First level: Group by Asset Type.

2. Second level: Within each asset type, group by Priority.

The resulting grid will display a hierarchical structure:

• Top-level groups are based on Asset Type.

• Within each asset type, records are further grouped by Priority.

The grouping panel at the top reflects this structure, showing both levels of grouping in order.

ã See also

• Customise

• Sorting

• Filtering

• Find As You Type

8.3. Using the Grid 311



NEXUS Documentation, Release 6.9.xxxxx.0

8.3.12 Right-Clicking
Most grids in NEXUS IC support the right-click functionality.

Right-clicking an item within the grid opens a context menu, typically containing some or all toolbar menu options.
The action you select from this context menu will apply only to the item you right-clicked.

8.3.13 Unit Conversion
When a column in the grid contains values expressed in a specific unit, you can convert those values to a different unit
directly within the interface.

To convert units:

1. Right-click the column header.

2. Hover over the Unit option in the context menu.

3. Select the desired unit from the list.

The values in the column will be automatically converted to the selected unit.
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8.4 Using the Status Bar
The Status Bar at the bottom of the main NEXUS IC window provides real-time system and session information. It
includes:

• The database server you are connected to

• The name of the database you are connected to

• The number of currently connected users

• The number of active jobs. This refers to the number of background jobs currently running (e.g., imports, re-
ports). For more information, see Job Management Console.

• An estimate of how fast the connection to this database server is (latency)

• The memory used/available. When memory available is small compared to memory used, you are running low.
In this circumstance, NEXUS IC may start clearing parts of its cache in order to avoid running out of memory.
You can force a complete emptying of cache by closing the application and restarting.

• Software Version

• Database schema number

You can hover the mouse over several items in the status bar to reveal additional information through tooltips.
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� Tip

You can right-click on the data shown in the status bar and click Copy to Clipboard to copy the tooltip content.

You can toggle the status bar on/off using the Database → Show/Hide Status Bar menu option.

8.4.1 Job Management Console
When a job is initiated - such as an import, report generation, or video parsing - a blue ribbon appears above the Status
Bar. This ribbon provides:

• Live job progress

• Options to dismiss the job

• Access to download artifacts (if available)

You can open the Job Management Console in two ways:

• Click the number of active jobs in the Status Bar.

• Click the number of undismissed jobs in the blue ribbon above the Status Bar.

In this dialog, you can view more detailed information on each job’s progress, including jobs that are currently running
or have been dismissed. These jobs may include imports, reports, or video parsing tasks.

SaaS clients can have their jobs offloaded for generation on another server. These jobs are visible in the Job Manage-
ment Console. Reports will be generated in the Cloud and downloaded from the Job Management Console after their
completion.

The Console includes a toolbar that allows you to interact with jobs. The functionality of each button varies depending
on the job type. The table below outlines the behaviour of each toolbar button across different job types:
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Tool-
bar
Button

Report Jobs Import Jobs Video Parsing Jobs

View Allows you to download the
generated report.

Shows the import summary,
errors, and/or warnings.

Shows the completion time
and any information, warn-
ing, or error messages.

Save
Arti-
facts

Does not have any artifacts. Allows you to save the
source import files (csv or
xlsx)

Does not have any artifacts.

Dis-
miss

Hides the blue ribbon notifi-
cation above the Status Bar.

Hides the blue ribbon notifi-
cation above the Status Bar.

Hides the blue ribbon notifi-
cation above the Status Bar.

Abort Aborts the report job if pos-
sible.

Aborts the import job.
The import job saves data
incrementally, so aborting
will only stop further data
from being imported into
the database.

Aborts the video parsing job
if possible.

8.5 Validating Data
A number of data validation rules can be defined to ensure data quality within the NEXUS database. These are applied
on the individual data fields contained within “Asset Information” or “Event” forms.

8.5.1 Required
Any data field of any field type can be set to be “Required”. This means that, when adding a new record, this field
must be filled before the record can be saved. Typically fields should be set to “Required” when they provide essential
information or are used as an input to critical calculations. Required fields are clearly identified on the form.

Hovering your mouse over the provides the hint: “Design Life is a required field and must have a value specified”

This requirement is also enforced during any data import. The user is unable to proceed with the import until the
column with the ‘required’ field is present in the import sheet. Import sheets created by NEXUS identify required
fields with a red column in MSExcel.
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8.5.2 Maximum & Minimum
Numeric and Whole Number data fields can have Maximum and Minimum values set. This means that, when adding
a new record, values in this field must be within range before the record can be saved.

Typically maximum and minimum values should be set to ensure data quality for fields where ranges are consistent for
all assets. For example; a percentage field must be between 0 and 100.

Fields with out of range data are clearly identified on the form.

Hovering your mouse over the provides the hint: “Design Life must be less than or equal to 90” or “Design Life
must be greater than or equal to 0”

8.5.3 Lookup Lists
Look List fields by their very nature enforce selection of valid data and provide consistency.

8.5.4 Anomaly Triggers
Data input onto Event forms are additionally subject to Anomaly Triggers. These are validation checks that define
anomalous readings and are used to trigger the automatic creation of Findings of a given type and severity.

For more information, see Set Up Anomaly Triggers.

Fields with out-of-range data are clearly identified on the form.

8.5.5 Data quality alerts
Even with the most rigorous of data validation regimes it is sometimes possible for inaccurate data to be entered.
Data quality checks can additionally be established for calculation results by means of Traffic Lights and Reports. For
example, a “Remaining Life” traffic light could be configured to shown any negative values as red. Simply turning on
the traffic light enables you to spot and investigate any potential data issues.
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8.6 Unhandled Exceptions
In many places in NEXUS IC, when something goes wrong you’ll receive a polite message explaining the problem. But
occasionally you’ll run into an unhandled error. In this circumstance, NEXUS will show you an “Unhandled Exception”
message and will attempt to send a crashlog to our bug tracking server. (No personally identifying information is
tracked, and nothing about your usage can be tracked back to you.) If you click the Details button, you will see a
Windows Explorer window with the .crashlogz file highlighted. This is the same data that is sent to us automatically,
but if the computer in question is not connected to the internet, we may ask you to mail us that file.

When you see an “Unhandled Exception” message, it may be helpful to us if you send an email to support@nexusic.com
telling us the steps you took that led you to the error dialog. (Some of the time the crashlog alone is enough to tell
us exactly where the error lies and how to fix it; sometimes not.) It’s helpful if you do this immediately after you
see the error, or if you include enough information for us to figure out which crashlog you are talking about — since
the crashlog is anonymised, if you don’t proactively tell us about your problem, we often don’t know who it’s from.
Emailing us also lets us reply to you when we’ve fixed the issue so that we can, for example, offer you a new build with
the bug removed.
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CHAPTER

NINE

DASHBOARDS AND REPORTS

You can display and export data stored in NEXUS using the report and dashboard functionality:

• Dashboards are basically reports that allow you to display the output of a report on the DASHBOARDS screen
or on the Dashboard tab of the ASSETS screen. For more information, see Dashboards.

• Using reports, you can export data from NEXUS into an RTF, HTML, or Excel file. For more information, see
Reports.

ã See also

• Configure Report Templates

• Dashboards

• Reports

9.1 Dashboards
Dashboards display the output from any report template that has been configured in the report template library and
marked as a Dashboard. For example, you can choose report templates that summarise data in the database, or that
show statistics on anomalies or risk.

You can view dashboards on the DASHBOARDS screen or on the Dashboards tab on the ASSETS screen (see Asset
Dashboards).

When you log in NEXUS IC for the first time, you will be presented with the DASHBOARDS screen. On subsequent
logins, NEXUS IC will open to the screen that was active when you logged out.

ò Note

If you make changes to data, the dashboard will not be refreshed to show those changes automatically.
You’ll need to click the Refresh button.

9.1.1 Prerequisites
To make report templates available as dashboards, the following configurations must have been done:

• A report template must exist under Configuration → Reports and Dashboards → Templates. For more informa-
tion, see Configure Report Templates.

• The report template must have been set as a dashboard in your configuration settings under Configuration →
Reports and Dashboards → Templates. For more information, see Set a Report Template as a Dashboard.
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9.1.2 Using the Dashboard
To select a dashboard template:

1. Click the Dashboard toolbar button on the DASHBOARDS screen.

2. From the drop-down list, choose the required template.

Templates are grouped by the report categories as per your configuration settings (Configure Reports and Dashboards).

ò Note

If the report template linked to the dashboard includes user-configurable parameters, the Parameters
toolbar button will be active. You can click this button to adjust the selection parameters as needed.
The selected values are automatically saved in your user profile settings under the Report category
(see Your Profile).

Dashboard Actions
On the dashboard, you can perform various actions depending on the specific report element:

Charts For charts (including risk charts), you can click on a data point to get a list of rows that
make up that point, or a form showing the single row represented by that cell.
You can click a legend item to show or hide data related to that legend item in the chart.
If you hover over a legend item, the chart shows only the related data.
Hovering over a chart element will show a tooltip with relevant information. This func-
tionality is similar to that of charts on the Charts tab. Note that hover tooltips are not
visible on the Risk Matrix or Tables report elements.

Tables Tables have a blue ellipsis at the top right. You can view or edit the contents of a
table row by double-clicking the row or selecting the row, clicking the blue ellipsis, and
choosing Edit.

Pivot Ta-
bles

Pivot tables have a little blue ellipsis on each cell that contains a number. Clicking
that ellipsis will show either a grid with a list of all the rows that make up the number
in that cell, or a form showing the single row represented by that cell. If you have edit
permission on the relevant table, you can make changes here and click OK to save them.

Example Dashboard
The image below shows an example dashboard and highlights the actions available for this specific template:
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ã See also

• Set a Report Template as a Dashboard

• Configure Report Templates

• Asset Dashboards

9.2 Reports
The report functionality allows you to export data from NEXUS into an RTF, HTML, or Excel file.

You can generate reports in NEXUS IC using the Report toolbar button, which is available in multiple screens across
NEXUS IC. The functionality is the same on all screens.

ò Note

Selecting large datasets may cause reports to run more slowly. When in doubt, try using a smaller
dataset.

Report templates are saved into a report category. Whilst additional report categories can be configured (see Configure
Report Categories), a standard NEXUS IC database includes the following default report categories:

• Anomaly

• Archived

• Asset
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• Miscellaneous

• Risk

• Schedule

• Workpack

There are two special report categories: No Category (when a report has not been assigned to any categories) and
Favourites. You can configure what appears in Favourites under Database → Your Profile.

9.2.1 Prerequisites
To be able to generate reports, you must ensure the following:

• Report templates must have been configured (see Configure Reports and Dashboards and Configure Report
Templates).

• If you want to send the output via an email, the email account properties must have been set up (see Set Up
Email).

For Software as a Service (SaaS) customers, these settings come predelivered as part of the service.

9.2.2 Generate Reports
To generate a report, follow the steps below:

1. On the relevant screen, choose Reports → <Report Template Category> → <Report Template> →
<Format>, where <Report Template Category> and <Report Template> are the ones set up in your
configurations (see above) and <Format> can be either RTF, HTML, or Excel format:

2. In the dialog that appears, select the destination where you want to export the report.
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You can choose one of the following options:

• Saving the file to your local drive, or, in case of a Software as a Service (SaaS) envi-
ronment, to a remote drive linked to your account. Once you have generated the report,
it will be available for download from the bottom of the screen:

• Sending the report to one or more email addresses. By default, the system proposes the
email address linked to your user account, which you can overwrite as required. The
email address linked to your account can be changed as described in Set Up Email.
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ò Note

If you do not receive the report in an email after generating it, check in the
job banner whether the job progress is complete and if so, check your junk
email folder. This issue may also occur if the report file size exceeds your
organisation’s size limit for email attachments.

• If there are additional shortcuts configured in your database (see Configure Shortcuts),
you can perform additional actions, such as saving the file to the library. If you can
use the Save to Library shortcut, the generated report will be available from the LI-
BRARY screen of NEXUS IC. If you select this option, you must select the library
type and the NEXUS element to which you want to connect the report.

ò Note

In case additional selection parameters have been set up in your report template configurations,
you may be asked to specify additional details before being able to generate the output. The report
engine defaults these parameters to the values you selected the last time you ran the report. These
selections are saved in your user profile settings under the Report category (see Your Profile).

3. Choose Generate.

ò Result

The report is generated and sent to the destination that you specified. Report jobs are listed
in the Job Management Console. Here you can view the progress and history of Import and
Report jobs and download any reports you’ve previously generated.

9.2.3 Worksheet Naming
In case of an Excel output, the name of the first worksheet will be the name of the actual report template, truncated to
31 characters. If you used a Page Break element in your report template, a new worksheet will be created in Excel. The
name of the new worksheet will be the name of the Page Break element.
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CHAPTER

TEN

ASSET DATA MANAGEMENT

In NEXUS IC, you can store and manage all information related to your assets. To do that, you set up a hierarchical
view of your assets, called asset tree and you link all required data to specific assets in the asset tree. You can view and
manage all your asset data on the ASSETS screen of NEXUS IC (see ASSETS Screen).

10.1 Managing Asset Data
In NEXUS IC, you can manage your asset data as follows:

• You set up your asset tree where each node represents a specific asset in a hierarchical view. From the asset tree,
you can also set up asset-specific anomaly triggers and display traffic lights for the assets in the tree as required.
For more information, see Asset Tree.

• You define asset-specific data on the Asset Information tab, where information is grouped into Asset Informa-
tion Groups (AIGs). AIGs are preconfigured groups of asset information fields and are accessible on the Asset
Information tab if the AIG has been assigned to the asset type of the selected asset. For more information, see
Asset Information Groups (AIGs).

• You can link 2D or 3D drawings to your assets and add or edit layers to them. For more information, see Drawings.

• You can attach library items to your assets. For more information, see Library.

• You can record key historical events against an asset. For more information, see Asset History.

• You can manage anomaly records specific to the selected asset (and optionally, its children). For more informa-
tion, see Anomalies.

• You can review risk assessment results for the selected asset and its children in preconfigured risk matrixes and
assign risk models or scenarios to assets as required. For more information, see Risk.

• You can review sensor data logged for the selected asset and its children. For more information, see Sensors.

• You can maintain planning templates specific to the selected asset. For more information, see Planning Tem-
plates.

• You can display or maintain asset information data for multiple assets under the same parent node. For more
information, see Children.

• You can review charts that are associated with the selected asset’s asset type. For more information, see Charts.

10.2 Searching Assets
On the ASSETS, PLANNING or INSPECTION screens, you can search for an asset in the database directly from the
asset tree. For more information, see Searching.

325



NEXUS Documentation, Release 6.9.xxxxx.0

10.2.1 ASSETS Screen
The ASSETS screen has the following three main parts:

• The asset tree, which is a hierarchical view of all your assets (see Asset Tree)

• The toolbar on the top of the screen area (see Assets Toolbar)

• The following tabs:
– Dashboard (see Asset Dashboards)

– Asset Information (see Asset Information Groups (AIGs))

– Drawings (see Drawings)

– Library (see Library)

– Asset History (see Asset History)

– Anomalies (see Anomalies)

– Risk (see Risk)

– Sensors (see Sensors)

– Planning Templates (see Planning Templates)

– Children (see Children)

– Charts (see Charts)

� Tip

• The asset selection is persistent between the ASSETS and INSPECTION screens, that is, if you choose an
asset on the ASSETS screen and change the screen to INSPECTION, the same asset will be selected and
vice versa.
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• If you exit out of NEXUS and open the application, it will reopen the application on the same location that
you exited last time.

10.2.1.1 Assets Toolbar

Elements of the Assets toolbar are available from multiple screens and dialogs in NEXUS IC.

The Assets toolbar button allows you to add, edit, delete and move assets to and from the hierarchy. Additional navi-
gation and filtering capabilities are also provided from this toolbar.
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Toolbar Option Description
Back Allows you to return to assets that you had previously selected in the asset

tree.
Forward Allows you to return to assets that you had previously selected in the asset

tree, after you’ve used the Back button.
Assets → Add → Asset Adds a new child asset to the asset currently selected in the hierarchy.
Assets→ Add→ Root As-
set

Adds a new root level asset into the active Asset View. A root level asset
is an asset that does not have a parent asset.

Assets → Add → Linked
Asset (With Children)

Adds a link to an existing asset including all its children. An asset tree will
be displayed to allow selection of the asset to link as a child to the currently
selected asset.

Assets → Add → Linked
Asset (Without Children)

Adds a link to an existing asset, without any of its children. An asset tree
will be displayed to allow selection of the asset to link as a child to the
currently selected asset.

Assets → Edit → Asset
Properties

Changes the name or asset type of the currently selected asset or
adds/removes the Primary Asset flag.

Assets → Edit → Asset
Type Properties

Allows you to edit the asset type of the currently selected asset, for exam-
ple, change its name or change what AIGs, event types and survey types it
is associated with.

Assets → Delete Deletes or unlinks the selected asset. If the asset exists in multiple places, it
removes only the asset at the current location, it doesn’t delete all locations
where the asset exists. Click on the Connections button to view dependant
records of the current asset.

Assets → Show Asset
Type

Toggles the display of the asset type in the hierarchy.

Assets → Expand Chil-
dren

Expands all subnodes (children, grandchildren) of the selected asset. You
can also press the * key on the numeric keypad.

Assets → Collapse Chil-
dren

Collapses all subnodes (children, grandchildren) of the selected asset.

Assets → Copy to Clip-
board

Copies either the asset name or full hierarchy location of the selected asset
to the clipboard.

Assets → Move → To. . . Moves the selected asset and inserts it as a child under the node that you
select in the asset hierarchy.

Assets → Move → To
Root

Repositions the selected asset in the asset tree so that it becomes a root
asset.

Assets → Show on Draw-
ing

Shows a list of drawings that have this asset as a layer. Click on a menu
item to go to that drawing. If the drawing name has “(Different Asset)”
after it, the drawing you will be taken to is not available on the current
asset; thus, when you select the menu option, you will not only be taken
to that layer on that drawing, you will also be navigated to the new asset.
You can get back by using the Back toolbar button.

Assets → Other Loca-
tions

Shows a list of other locations that this asset exists in on the asset tree
(including in other Asset Views). Click on a menu item to navigate there.
If this asset does not appear in any other locations, you will not see any
items in this list.

Assets → Connections See Connections for information about the Connections function.
Assets → Anomaly Trig-
gers

See Set Up Anomaly Triggers for Assets for information about the Anomaly
Triggers function.

Assets → Coordinates Allows you to define the baseline coordinates for survey points relevant
for the asset. You can define coordinates for several survey points. In this
case, on the INSPECTION screen, on the Map tab, a line is displayed,
which connects the survey points defined.

Assets → Retire Equip-
ment

See Retire Equipment for detailed information on this function.

Assets → Rotate Equip-
ment

See Rotate Equipment for detailed information on this function.

Asset Views See Asset Views for detailed information on the Asset Views toolbar option.
Traffic Lighting See Traffic Lighting for detailed description of the Traffic Lighting toolbar

option.
Import See Import Assets for detailed information about the import function. The

MS Excel Import Template details the required format for importing li-
brary items.

Custom Export See Custom Export Assets for information about exporting assets and asset
information data.

Reports See Reports for information about the Reports toolbar option.
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10.2.2 Asset Tree
The asset tree is a central part of the NEXUS IC application. Most data stored in NEXUS IC is linked back to an asset
in the asset hierarchy, including (but not limited to) risk assessments, anomalies, drawings, library items, inspection
data and inspection schedules.

Assets are presented to the end-user in a hierarchical tree view, where each asset may have a single parent, and multiple
children or siblings. Each asset is also assigned an asset type. There is no limit to the number of levels that can be
configured in the asset hierarchy, however, from a usability perspective, Wood recommends keeping the hierarchy levels
to less than 10 (this is for guidance purposes only).

The asset tree appears on several screens and dialogs within NEXUS IC (for example, ASSETS Screen, Planning and
Workpacks, Inspection). If you click on an asset to select it in one of those screens, it will be selected in all of those
screens. The selected asset and its view are also remembered between sessions, that is, when you next open NEXUS
IC, it will automatically return to the same asset and asset view that were open in your last session.

� Tip

• Ctrl+C copies the name of the currently selected asset to the clipboard.

• Ctrl+Shift+C copies the full asset path of the currently selected asset to the clipboard.

• You can directly search for an asset in the asset tree by simply typing the search term when the
asset tree is active or by pressing Ctrl+F. For more information about searching, see Searching.

10.2.2.1 Asset Views

You can set up several different asset trees for your assets depending on your requirements using asset views and you
can switch between these asset tree views by selecting the required view from the Asset Views menu in the toolbar.
For more information, see Asset Views.

10.2.2.2 Maintain Asset Trees and Asset Nodes

You can access asset-tree-related functions on the ASSETS screen through the Assets toolbar menu or by right-clicking
on the selected asset node. See below for more information about these functions:

• Create Assets

• Edit Assets and Asset Types

• Move Assets

• Retire Equipment

• Rotate Equipment

• Set Up Anomaly Triggers for Assets

10.2.2.3 Import and Export Asset Trees

You can import and export your asset trees, nodes within the asset trees and the related asset information data using
the standard import and export functionality. For more information, see Import Assets and Custom Export Assets.

10.2.2.4 Traffic Lighting

You can display preconfigured traffic lighting values for the asset nodes in your asset tree. For more information, see
Traffic Lighting.

See an example asset tree below with traffic lighting enabled:
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10.2.2.4.1 Asset Views

The Asset Views functionality can be used to isolate asset trees from one another, to view only a filtered list of assets,
or to arrange assets differently. In case you have set up multiple asset views, you can switch between the different asset
tree views using the Asset Views toolbar menu wherever the asset tree appears.

You can maintain asset views on the ASSETS screen of NEXUS IC as follows:

• You can create a new asset view by choosing Asset Views → Add from the toolbar. Enter the name of the asset
view and a descriptive comment (for informational and reporting purposes only). Once created, you can build the
new asset tree following the standard asset tree maintenance steps (see Maintain Asset Trees and Asset Nodes).

• You can update the properties of the currently selected asset view any time by choosing Asset Views → Edit from
the toolbar.

• You can delete the currently selected asset view by choosing Asset Views → Delete from the toolbar.

ò Note

Deleting an asset view will delete all the assets contained within that view, regardless of whether those assets
exist in other asset views.

330 Chapter 10. Asset Data Management



NEXUS Documentation, Release 6.9.xxxxx.0

10.2.2.4.1.1 Example

• Create an asset view titled “Subsea” which contains all subsea assets and a second view titled “SPE” which
contains all topside Static Pressure Equipment assets.

• Create an asset view titled “Pressure Relief Devices” which contains only the PRD assets in the “SPE” view. In
this example, the PRDs are Linked from the SPE asset view.

10.2.2.4.2 Create Assets

To store your assets’ data in NEXUS, you set up an asset tree by creating a hierarchy of asset nodes on the ASSETS
screen.

You can manually create nodes in the asset tree in one of the following ways:

10.2.2.4.2.1 Create a Root Asset

When you create a root asset, the asset is created at the top level of the hierarchy without a parent node. To create an
asset at root level, proceed as follows:

1. Choose Assets → Add → Root Asset from the toolbar on the ASSETS screen.

2. In the Add Asset dialog, specify the name of the asset (mandatory) and assign an asset type as required.

You can also indicate if this is a primary asset. This attribute can then be used for grouping your assets or in
reporting.

3. Click OK.

10.2.2.4.2.2 Create an Asset Under a Parent Node

When you create an asset under another parent asset, the new node is created as the last node under the selected asset.
Proceed as follows:

1. Select the asset under which you want to insert the new asset.

2. Access the Add Asset dialog in either of the following ways:

• Choose Assets → Add → Root Asset from the toolbar on the ASSETS screen.

• Right-click the asset and select Add from the context menu.

2. In the Add Asset dialog, specify the name of the asset (mandatory) and assign an asset type as
required.

You can also indicate if this is a primary asset. This attribute can then be used for grouping your
assets or in reporting.

3. Click OK.

10.2.2.4.2.3 Insert Linked Asset With Children

When you insert a linked asset under a parent asset with its children, you select an existing asset, which is then inserted
as a child under the selected asset, including all its children. Proceed as follows:

1. Select the asset under which you want to insert the new asset.

2. Choose Assets → Add → Linked Asset (With Children) from the toolbar on the ASSETS screen.

3. In the dialog that appears, select the asset that you want to include from the asset tree. If required, you can switch
the asset view using the Asset Views toolbar button.

4. Click OK.
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10.2.2.4.2.4 Insert Linked Asset Without Children

When you insert a linked asset under a parent asset without its children, you select an existing asset, which is then
inserted as a child under the selected asset, without its children. Proceed as follows:

1. Select the asset under which you want to insert the new asset.

2. Choose Assets → Add → Linked Asset (Without Children) from the toolbar on the ASSETS screen.

3. In the dialog that appears, select the asset that you want to include from the asset tree. If required, you can switch
the asset view using the Asset Views toolbar button.

4. Click OK.

10.2.2.4.3 Edit Assets and Asset Types

You can edit the properties of existing assets and asset types, or change their assignments any time after they have been
created.

10.2.2.4.3.1 Edit Assets

You can change an existing asset’s name, assign new asset types to it, or modify the Primary Asset indicator settings.

You can edit these properties in one of the following ways:

• Choose Assets → Edit → Asset Properties . . . from the toolbar on the ASSETS screen.

• Right-click the asset and select Edit from the context menu.

10.2.2.4.3.2 Edit Asset Types

You can change an existing asset type’s properties or assign AIGs, event definitions, survey data groups, risk models or
library items to it. To do that, you make changes in the Edit Asset Type dialog as described in Configure Asset Types.

You can access this dialog in one of the following ways:

• Navigate to Configuration → Assets → Types from the main menu.

• Choose Assets → Edit → Asset Type Properties from the toolbar on the ASSETS screen.

10.2.2.4.4 Move Assets

You can move an asset within the asset tree as follows:

• Move it under another parent within the asset tree. In this case, proceed as follows:

1. Select the asset that you want to move.

2. Choose Move → To. . . either from the drop-down menu of the Assets toolbar button or from
the context menu of the asset (available by right-clicking the asset).

3. In the dialog that appears, select the asset under which you want to insert the asset node. If
required, you can switch the asset view using the Asset Views toolbar button.

4. Click OK.

• Make the asset a new root-level asset within the asset tree. In this case, proceed as follows:

1. Select the asset that you want to move.

2. Choose Move → To Root either from the drop-down menu of the Assets toolbar button or from
the context menu of the asset (available by right-clicking the asset).

3. In the confirmation dialog, click Reparent.
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If the asset that you have chosen to move has children, then the child assets will be moved along with the selected asset.

� Tip

• Ctrl-R is available as a shortcut key to initiate the move.

• Cursor up and down move between assets in the picker dialog. Cursor left and right close and open sub-trees.

• Press Enter to complete or Escape to cancel the dialog.

10.2.2.4.5 Retire Equipment

When you retire an equipment, you change the location of the selected asset in the asset tree. Changing the asset
location in the asset tree creates records on the Asset History tab for the asset itself as well as the source parent, to
record details of the relocation.

To retire an equipment, proceed as follows:

1. Select the relevant asset node in the asset tree.

2. Choose the Retire Equipment menu option either from the Assets toolbar menu or from the right-
click context menu of the node.

3. In the dialog that is displayed, select the destination parent asset from the asset tree.

4. Click OK.

ò Result

The asset tree is refreshed and the asset will be selected in the tree under the new location.

ò Note

The Retire Equipment menu item is a Shortcut. As such, if necessary, it can be debugged using the Shortcut
debugger. When you select the menu item, hold down the Control key on the keyboard. The Select Asset dialog
will be displayed, but will be followed by the Debug Shortcut dialog. You can step through shortcut items one at
a time, which may help to narrow down any problems.

10.2.2.4.6 Rotate Equipment

When you rotate an equipment, you swap the location of the selected asset with another asset of the same type. Swapping
assets will exchange their location in the asset tree and create records on the Asset History tab for both assets, to record
details of the exchange.

To retire an equipment, proceed as follows:

1. Select the relevant asset node in the asset tree.

2. Choose the Rotate Equipment menu option either from the Assets toolbar menu or from the right-
click context menu of the node.
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3. In the dialog that is displayed, select another asset of the same type from the asset tree. Assets that
are not of the same type will be greyed out in the tree.

4. Click OK.

ò Result

The asset tree is refreshed and the swapped asset will be selected in the tree.

ò Note

• The Rotate Equipment menu item will only be enabled if the selected asset has an asset type.

• You cannot rotate an asset with one of its children.

• The Rotate Equipment menu item is a Shortcut. As such, if necessary, it can be debugged using the Shortcut
debugger. When you select the menu item, hold down the Control key on the keyboard. The Select Asset
dialog will be displayed, but will be followed by the Debug Shortcut dialog. You can step through shortcut
items one at a time, which may help to narrow down any problems.

This functionality is most commonly used for PRDs where they are “rotated” out for valves that have been tested and
prepared for service.

10.2.2.4.7 Set Up Anomaly Triggers for Assets

You can set up asset-specific anomaly triggers for fields directly from the asset tree. In case you create an asset-specific
anomaly trigger, it will be relevant for the selected asset only.

Generic anomaly triggers (independent of assets) are set up in Configure Asset Information Groups and Configure
Event Types. If you have both an asset-specific and a generic anomaly trigger on the same field, for assets with the
asset-specific trigger, only the asset-specific trigger will apply. For assets with only a generic trigger, only the generic
trigger will apply.

ò Note

Asset-specific anomaly triggers are specific to their asset and they do not automatically apply to an
asset’s children.

To set up an anomaly trigger for an asset field from the asset tree, proceed as follows:

1. Select the relevant asset node from the asset tree.

2. Choose the Anomaly Triggers . . . menu option either from the Assets toolbar menu or from the right-click
context menu of the node.

3. In the dialog that is displayed, choose Add.

4. In the Add Anomaly Triggers dialog, select the field for which you want to apply the anomaly trigger and specify
the anomaly trigger parameters as required. These parameters are the same as the ones that you define when you
set up the generic anomaly triggers on the Anomaly Triggers tab of the Add/Edit Field Definition dialog. For
more information, see Set Up Anomaly Triggers.

5. Click OK to apply your changes.
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10.2.2.4.8 Import Assets

You can import or bulk update data stored in the Asset Information Groups (AIGs) by choosing Import from the toolbar
on the ASSETS screen.

The format of the Excel workbook needs to be specific. We recommend that you generate an Excel export using the
Custom Export Assets functionality, to generate the workbook in the correct format for importing data.

It is possible to create new asset hierarchies by importing assets with hierarchy structures that don’t already exist. In
doing so, new parent assets will be created. In case this is not the desired result, the Test Import will throw a warning.

³ Caution

While imports are being carried out, transactions are now committed every 50 rows from the source
import sheet, so table locking will be heavily reduced from v6.7 onwards. However, this higher fre-
quency of transaction commits may cause other users’ NEXUS sessions to “refresh” the imported data,
depending on the type of data other users have in their cache and the type of data being imported.

10.2.2.4.8.1 Import Files

ò Prepare Data for Import

Before you start the import, you must prepare the files in the required format. Compatible file types include .zip,
.xlsx (Excel), .csv, and .txt. Zip files can contain the xlsx/csv/txt file plus any additional files, for example, multi-
media images or electronic documents for importing into the library.

� Tip

• For very large imports, saving your Excel file as a .csv and then importing from the .csv may
be faster.

• The Asset Location.Full Location data can be defined in one of the following ways
(you can use only one option, not both):

– As a single column, where each level of the asset location is separated by the string “ /
“, for example, ‘My Field / My Platform / My Member’

– As multiple columns, where each level of the asset location is stored in a separate
sequential column, that is, for each node in the hierarchy, you create a separate column
with the name Asset Location.Full Location and with one asset hierarchy level
in each.

ò Note

Importing directly from .xlsx files is not supported for SaaS customers using the new virtualisation
technology (see SaaS Using Single Sign-On (SSO)). We recommend using .csv files instead.

Sub-Rows in Import Sheet
Sometimes a single row may have several sub-rows. For example, an AIG row might have several sub-AIG rows;
or an event might have several findings or several multimedia images or both. When this occurs, you must create
separate rows in the import sheet for each sub-item, with different “detail” values in each.

For example, if you have several multimedia images to import against a single event, your Excel sheet should
have several rows that are identical except for the Multimedia.Name and Multimedia.Image columns. If you have
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specified an event number, and you use the same event number on each row, NEXUS will only create the event
once, but will create several multimedia items. If you do not specify an event number, NEXUS will instead create
several different events with one multimedia item each.

You can also leave event fields blank for all except the last row. Under the hood, NEXUS is importing each Excel
row into the event, and only the last Excel row imported will “stick”. Note that if your event has a finding, you
should not repeat the finding data on each event row; if you do, NEXUS will create one finding for each Excel row
that has finding data filled in.

In some cases, you do want multiple findings on one event, and in that case you must fill in several rows as ap-
propriate. Similarly for sub-event data or sub-AIG data: if you want several different sub-events or sub-AIG rows
imported, you should repeat the event row or AIG row with different sub-event or sub-AIG data in each case. If you
are repeating an Excel row for another reason and you do not want several sub-event or sub-AIG rows imported,
you should fill in sub-event or sub-AIG data in only one of the Excel rows.

� Tip

You can find the next available event number for a given event type by creating an event of that type
using Add Event, noting the event number, then deleting that event. If you want the next available
event numbers for several event types, create a report template with a Simple Source on table Event
and a Pivot Table with a pivot row on Event Type and a value field on Event Number with aggregate
Max, then add 1.

ò Perform Data Import

1. Choose Import from the toolbar.

2. In the Import File dialog, choose to navigate to the file that you want to import and select it.

ò Note

By default, the dialog shows only CSV files.

3. If required, you can also verify the date and time format in this dialog and you can choose whether
you want to skip blank cells:

• If you select skipping blank cells, then any cells that are blank will be ignored during the
import.

• If you do not select skipping blank cells, then blank cells will update any existing data and
make it blank.

4. Click Next.

ò Result

The system reads the import file and uses the <table name>.<field name> naming con-
vention to map the headers in the import file to database fields in the NEXUS system.

5. In the Configure Import dialog, you can review the mapping proposed by the system and make
changes, if required:

• In the top Field row, you can see the fields to which the system proposes to map the column
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headers from the import file. You can manually change the default mapping option for each
column by clicking on the title of the column in the top Field row and selecting one of the
following options:

– Don’t Import - Does not import the selected column to the database.

– Common Fields - Allows you to select common fields in the database to which you want
to map the selected column instead of the database field proposed by the system.

– Other . . . - Allows you to search and select a field from a list of your field definitions as
required.

Note that if the system couldn’t match a column to a database field for some reason, the
column is displayed in red colour. By default, the system does not map these columns, you
can manually map them if required.

• In case there are required fields in the database for which the system couldn’t find any values
in your import sheet, the system prompts you to set these values in this dialog. In this case,
the relevant fields will be displayed on the right-hand side of the dialog under Required
Fields, where you have the option to set the value globally for this import as required.

• Under Settings, you can specify how many header rows your import sheet contains. For
example, you may have the table name as the first header row and the field name in the
second header row, in which case, instead of having a column title like Asset Location.
Asset View, you’d have a header row for Asset Location and second header row for Asset
View.

• If your import file contains multiple worksheets, ensure that you select the correct worksheet
in the Worksheet field.

Note that if the field type is set to change for an existing field, the import will abort as data loss
may occur.

6. Click Next.

ò Result

The system tests every single row in the import file and shows if there are any issues with
importing. You can abort the test import at any time by clicking Skip.

7. Once the import test is finished, you can see a log that shows any errors or warnings that the
system may have found during test import. In case of errors, you cannot proceed with the import
and the Import button will be inactive. In this case, you must rectify the errors in the import file
and start the import process again.
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� Tip

You can copy and select import results from the dialog for review. For instance, it can be
helpful to paste all errors into a spreadsheet to make it simpler to methodically update them.

8. If the import test is finished without errors, you can click Import to complete the process.

ò Result

Depending on your client, the following happens:
• If using a SaaS client, the import job is offloaded to the SaaS server and is started

remotely. It is then possible to close the current NEXUS IC session while the active
import job continues.

• If using a non-SaaS client, the import job is executed in the current NEXUS IC session
and you may continue using NEXUS IC. Closing the current NEXUS IC session will
cancel the active import job.

In both cases, the UI will refresh intermittently throughout the import, and there will be
delays between the import finishing and final refresh as NEXUS IC does not directly monitor
changes.

ò Note

When importing inspection event data, anomaly triggers are checked during the import and
findings created automatically from data which falls outside the data bounds.

6. Check the status and result of the import in the Job Management Console, which records the
status and history of all import jobs. The import job banner at the bottom of the window shows
the status of the import job and provides the option to dismiss the job or check the details. You
can double-click the job, which triggers a dialog that summarises the import. From this dialog,
you can click Details to show how many rows have been added to various forms or tables. If you
have multiple rows in your import sheet that update the same row, these rows will be counted
by the test import individually, whereas the final import statistics will only show 1 updated row.
You can also save the summary to file.

� Tip

• We highly recommend that you scrutinise the summary to ensure that the import has
performed the actions that you expected. Take note of the total rows for a specific item,
that is, add together the number added and updated and make sure that is equal to the
number you expect.

• If the importer encounters a completely blank row in an Excel file, it will stop import-
ing at that point, even if there are non-blank rows further down. This can provide an
easy way to test an import sheet: set it up, and then after just one or two rows of data,
insert a blank. Run the import to see if it’s doing what you expect, and if so, delete the
blank and run again. Similarly, if the importer encounters a blank column in an Excel
file, columns to the right of this will not be imported.

338 Chapter 10. Asset Data Management



NEXUS Documentation, Release 6.9.xxxxx.0

ò Note

During an import, NEXUS communicates with Excel in the background. NEXUS com-
mands Excel to open the file you want to import, and asks Excel what’s in each cell. If you
use Excel to modify the file while we’re importing it, even if you don’t hit Save, you may
confuse the import process. The same happens if you take a variety of other actions, such as
Save As, closing the Excel, and so on. If you see the error text “Call was rejected by callee”,
it means that Excel has stopped answering calls from NEXUS.

10.2.2.4.9 Custom Export Assets

The Custom Export functionality allows you to choose a subset of assets and associated Asset Information Groups
(AIGs) and export their data to an Excel file.

You can perform custom export by choosing Custom Export from the toolbar on the ASSETS screen.

The format in which the data is exported to Excel is the same format in which the data can be reimported (see Import
Assets for more information on importing data from Excel).

� Hint

The format in which data is exported is the same format in which the data can be reimported. Thus,
it’s recommended that you create your import files based on the format produced by a custom export.
For example, you can use the “Custom Export” wizard to export the operating properties of a Process
Stream. Update the operating temperature and pressure in the Excel sheet, then reimport the data.

10.2.2.4.9.1 Perform Custom Export

1. On the ASSETS screen, choose Custom Export from the toolbar.

ò Result

The Asset Export Wizard opens.

2. Specify the name of the file and the location where you want it to be saved to. NEXUS proposes a default path
and name, which you can overwrite as required.

3. Click Next.
4. In the next dialog, specify the export options:
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Field Description
Columns Select one of the following options:

• All columns - includes all the relevant columns in the exported file.
• All visible columns - columns that have the Visible Grid or Visible Form options

ticked will be exported. Workflow rules affecting field visibility will not be run.
• User selected - you can select which columns to include in the export. A subsequent

dialog will be shown later select those columns.

Asset Loca-
tion

Select one of the following options:
• Single column - the location of the assets will be included in a single column, each

node separated by “ / “ (note the space), for example, “Field / Asset / Elevation /
Member / Anode”

• Multiple columns - each node in the asset location hierarchy will have its own column
in the exported file.

Calculated
fields

Indicate whether you want to include calculated fields in the export.

Sub Asset In-
formation

Indicate whether you want to include Sub-AIG data in the export.

Hide Lookup
Lists

Extra worksheets are created for each Lookup List used in the forms. You can choose to
hide these worksheets.

Date Specify the formatting of dates in the exported file.
Time Specify the formatting of times in the exported file.
Cell format-
ting

If you select this option, some cell formatting options will be applied, for example, cells
with invalid values will be shown in red, cells not relevant to this AIG or event form will
be greyed out, and so on.

5. Click Next.
6. In the next dialog, choose the Asset View and select which subset of assets you want to include in the export.

ò Note

Use the Select Children and Unselect Children toolbar buttons to include and exclude the visible and non-
visible child assets. Simply selecting an asset at the top level will not automatically select all the child assets
beneath it.

7. Click Next.
8. In the next dialog, select which AIGs you want to include in the exported file.

9. Click Export.

ò Result

The system generates the Excel file to the location that you specified. If required, you can choose to open the
document immediately.
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� Hint

• The column order within the exported sheet is determined by the grid column order set within each form
under Configuration → Assets → Information (see Configure Asset Information Groups).

• The exported Excel sheet contains a Legend tab, which shows the meaning of various cell and row colours.

10.2.2.4.10 Traffic Lighting

The Traffic Lighting functionality displays pre-defined coloured dots for each asset in case traffic lighting is configured.
The legend is shown at the bottom of the asset hierarchy and displays the name of the traffic lighting rule and what
each of the colours signify. Hovering over the traffic lighting with the mouse displays a pop-up hint of the value of the
traffic light. See below for an example:

Note that because the Traffic Light field must be calculated for every asset, NEXUS IC may be slower with a traffic
light turned on than it is with no traffic light turned on. However, since NEXUS IC caches results, you should only
experience this slowness the first time you view a given group of assets.

Traffic lighting can also be displayed on Drawings Links. For example, if an asset has a region defined on a drawing,
and there is a traffic light colour assigned to that asset, then the region will be displayed in that colour. The display of
traffic lighting on drawings is switched on and off from the Drawing Toolbar.

For information about setting up the traffic lighting rules, see Configure Traffic Lights.

The Traffic Lighting toolbar button shows the list of configured traffic lighting rules. By default, the following traffic
lighting rules are available:

• Traffic Lighting → None
Clears all existing traffic lighting rules from the asset hierarchy.
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• Traffic Lighting → Anomalies
Shows traffic lights based on the Anomalies traffic lighting rules.

• Traffic Lighting → Risk
Shows traffic lights based on the Risk traffic lighting rules.

• Traffic Lighting → Active Workpack
Opens the Select Workpack selection dialog from which you can choose a workpack.

10.2.3 Asset Information Groups (AIGs)
Asset Information Groups (AIGs) are preconfigured sets of fields used to record asset-specific data. You can access
and manage AIGs on the Asset Information tab, which is available on both the ASSETS and INSPECTION screens.
The functionality is identical in both locations.

Before entering data, ensure that:

• The AIG has been set up (see Configure Asset Information Groups)

• The AIG has been assigned to the asset type of the selected asset (see Assign AIGs to an Asset Type)

10.2.3.1 Using the Asset Information Tab

To learn about the different field types available on this tab, see Field Types.

You can interact with the Asset Information tab using the tab’s toolbar options:

• Select or switch AIGs: Click the Group toolbar button and select the required AIG.

• Navigate between AIGs: Use the arrow buttons next to the Group button. Navigation follows the order defined
in the asset type configuration (see Ordering groups).

• Toggle tab location: Click the button to move the tab:

– Among other asset tabs (for example, Dashboard, Drawings)
– To the bottom of the window, below the other tabs.

This allows you to view asset information alongside other data or maximise the window space for the data you’re
interested in.

• Save or discard changes: After making changes, the Save and Revert buttons become active, which you
can use to save or discard your changes. If you switch assets without saving or reverting, your changes will be
saved automatically.
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• View history: Click the History button to open the History dialog for the current AIG on the selected asset.
(see Checking History).

For detailed information about editing AIGs, see Edit AIGs (Individually/in Bulk).

� Tip

If you are navigating through the asset tree and the Asset Information tab is not important, you can
select a different tab, such as Library. This prevents asset information from being loaded, which can
be useful if the asset information involves extensive calculations.

10.2.3.2 Ordering groups

The order of asset information groups determines which group is shown by default. When switching to a new asset on
the ASSET screen, the previously active group will remain active if it also belongs to the new asset. If the previous
group is no longer applicable, the default AIG (ordered highest on the list) will be shown.

To reorder AIGs:

1. Go to Configuration → Assets → Configure Asset Types

2. Edit the relevant asset type.

3. Go to the Asset Information Groups tab.

4. Adjust the order using the up/down buttons.

10.2.3.3 Field Types

For information about the various field types available in an AIG form, see Field Types.

10.2.3.4 Sub-Asset Information Groups

Often, you will need to record a list or table of information for a single asset. For example, you might have a list of
various threats that apply to this asset, along with their severity levels.

To represent this, we use a sub-form within the form.

ò Note

To view sub-asset groups for multiple assets, use the Children tab to select multiple sub-asset infor-
mation groups. This provides the ability to bulk update sub-asset information across multiple assets
simultaneously.

You can use Add, Edit, and Delete to add, edit, or remove rows.

By ctrl-clicking sub-asset information rows, you can edit or remove multiple rows at once. See the screenshot below
for an example:
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ã See also

• Edit AIGs (Individually/in Bulk)

• Field Types

10.2.3.4.1 Field Types

You can find various field types in an Asset Information Group (AIG). See below for a description of each.
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10.2.3.4.1.1 Unit-Aware Numeric Field

When numeric fields are configured in an AIG, you have an option to define a base unit type for that field. By default,
the base unit type is displayed to all users, however, each user has the option to view the numerical value in that field
in a different unit type. The menu item in bold indicates the default unit.

Unit-aware numerical fields are identified by the label after the field name that states the unit type in blue text.

To view a different unit type in the asset information group, click on the unit label and choose an alternate unit type
from the popup menu. Note that NEXUS IC will “remember” your preferred unit type and display that next time you
login to NEXUS IC.
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10.2.3.4.1.2 Calculated Field

Calculated fields are those where the value displayed is derived by a function that has been configured in the database
(see Configure Functions).

Calculated fields are identified by the icon.

To view the function for the calculated field, click on the icon to launch the View Function Calculation dialog.

346 Chapter 10. Asset Data Management



NEXUS Documentation, Release 6.9.xxxxx.0

Note that you cannot edit the function from this dialog. You can, however, right-click on any element and select View
to view its internal details.

� Hint

When focus is on a calculated field (by clicking in it with the mouse or tabbing into it), any other fields
on the same form which are inputs into the function, are highlighted a darker grey colour. You can
also see a function’s inputs by clicking on the icon. An input parameter will be labelled “Source
- Constant” if it is being given a constant value rather than a value from a field; or “Source - Field”
followed by the table name and the field name.

In the example shown below, the ‘Adjusted Safety Consequence’ calculated field has inputs from ‘Asset Area Location’
and ‘Safety Consequence’.
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10.2.3.4.1.3 Passthru Field

Passthru fields show data from another field on the same asset. A passthru field has a icon at its right-hand side.
Clicking this button shows a dialog telling you what form and field the passthru is pulling information from.

10.2.3.4.1.4 Global Table Link Field

A Global Table Link field enables linking of a global table to an AIG. NEXUS-IC applies filters progressively (guided
by the user) until the desired table row is linked to the AIG. All values for the selected global table field are displayed
in a drop-down list, where the user can select the required value, similar to a lookup list.

For information about configuring global tables, see Configure Global Tables.

When adding or editing a Global Table Link, it will be displayed as a pseudo form. This is built based on:

• The fields that are visible in the Global Table form

• The order of fields visible in the Global Table form

For each field, NEXUS IC displays a drop-down list with the distinct set of values for that field. The first drop-down
list allows you to choose from all values available to that field. Once this is entered, the second field will include all
distinct values from rows where the first field value matches what the user has chosen, and so on. If a field list only
contains one value, it will be preselected automatically. This process continues until the user has chosen a value for
each drop-down list, and thus filtered the global table row that will ultimately have its value persisted.

When importing or exporting a Global Table Link, the fields will be represented in the document as data separated by
‘/’ characters. For example:

Asset Loca-
tion.Full Location

Asset Type.Name Component Damage Global Table Link.Component Damage

Wood Company Material / Insulation Failure / Degraded

Note that if a field called ‘Name’ is present in the global table, the values in that column will be used in place of the
automated value for importing, reporting and displaying in the grid. If a ‘Name’ column is configured, it should be
made invisible on the form via the Field Layout options.

See Example: Assign Global Table Link to AIG for more information.

10.2.3.4.1.5 Global Lookup Field

Global Lookup fields are fields whose value is returned from a global table matrix table. Lookup values are passed
into the comparison function and the first value which meets the specified criteria is returned as the value for that field.
For information about configuring global tables, see Configure Global Tables.

Global Lookup fields are identified by the icon.

Click on the icon to launch the View Global Table Lookup dialog. This dialog highlights which row matched
the Global lookup criteria and is being displayed in the field. Click the Inspect button to see the Compare function
evaluation for the focused row.
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10.2.3.4.2 Edit AIGs (Individually/in Bulk)

You can specify and store all asset-specific data in Asset Information Groups (AIGs). You edit AIGs on the Asset
Information tab of the ASSETS screen. For more details about the tab, see Asset Information Groups (AIGs).

10.2.3.4.2.1 Prerequisites

• You have configured AIGs (see Configure Asset Information Groups).

• You have defined asset types and assigned AIGs to them (see Assign AIGs to an Asset Type).

• You have assigned the relevant asset type to the asset (see Edit Assets and Asset Types).

10.2.3.4.2.2 Processes

ò Edit AIG for Individual Asset Node

You can edit the AIG of individual asset nodes as follows:

1. On the ASSETS screen, select the asset in the asset tree.

2. Go to the Asset Information tab.

3. Select the required AIG from under the Group: toolbar button.

4. Edit the fields on the AIG form as required. For more information about this tab, see Asset Information
Groups (AIGs).

5. Save your entries.
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ò Note

• If you navigate away from the screen without saving your entries, your changes will be automati-
cally saved.

• If you do not want to save the changes you made, choose the Revert toolbar button.

ò Edit AIGs for Assets in Bulk

You can edit the AIGs of multiple assets in bulk as follows:

1. On the ASSETS screen, navigate to the high-level asset node that contains all the assets for which
you want to update the AIG data.

2. Go to the Children tab.

3. Under Filters, choose Show All Children.

4. If required, you can filter your assets. For example, you can filter your assets based on the asset
type in the Asset Type column:

5. Choose Groups from the toolbar and select the AIG that you want to edit.
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ò Result

The AIG fields get added to the view. If required, you can further filter, group or sort
your assets based on the AIG field values.

6. Select all the items that you want to update from the displayed assets (for example, you can use
CTRL+A to select all items), and click Edit.
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ò Result

A dialog appears that contains all the fields of the selected AIG. In case the assets have
different values for a given field, the value appears as (multiple values).

7. Edit the field values in the AIG as required. For more information about this tab, see Asset
Information Groups (AIGs).

8. Click OK to apply the changes.

ò Note

To be able to edit AIG data for multiple assets, you must have exactly one asset information group
selected under Groups, and the assets you select must all be of types that have that AIG assigned
to them.
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ò Changes by Other Users

If a change is made in another copy of NEXUS IC or IC-Inspection to data on a form you are viewing, you will see
a message saying that this item has been modified by another user.

You can do the following:

• Click Refresh to load their changes into your copy of the application. This will discard any changes you have
made.

• Click the Save button to save your changes. This will overwrite the changes the other user has made,
meaning that they in turn will see this message, and have the opportunity to refresh or save.

This feature applies generally throughout NEXUS IC and IC-Inspection, but asset information is perhaps the most
common place to see it.

10.2.4 Asset Dashboards
The Dashboards tab on the ASSETS screen shows you the output of any of the pre-configured report templates in the
database that has been marked as an asset dashboard.

10.2.4.1 Prerequisites

To make report templates available as asset dashboards, the following configurations must have been done:

• A report template must exist under Configuration → Reports and Dashboards → Templates. For more informa-
tion, see Configure Report Templates.

• The report template must have been set as an asset dashboard in your configuration settings under Configuration
→ Reports and Dashboards → Templates. For more information, see Set a Report Template as a Dashboard.

ò Note

For the asset dashboard report, choose a report template that requires an asset as a report parameter.

10.2.4.2 Using the Dashboard

To choose which dashboard template is shown, click the Dashboard toolbar button, and select the required template
from the drop-down list. Templates are grouped by the report categories as per your configuration settings (Configure
Reports and Dashboards).

As compared to the DASHBOARDS screen, on the Dashboard tab of the ASSETS screen, the dashboard report
recognises what asset is currently selected in the asset tree and updates the contents of the dashboard report based on
the selected asset.

Asset dashboards work in the same way as the generic dashboard on the DASHBOARDS screen. For more information
about the dashboard functionality, see Dashboards.
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ã See also

• Set a Report Template as a Dashboard

• Configure Report Templates

• Dashboards

10.2.5 Drawings
In NEXUS, library items with a library item type of either Drawings or Photographs and Negatives are treated
as drawings and can be viewed and managed from the Drawings tab on the ASSETS screen.

For description about all the toolbar options, see Drawings Toolbar.

For information about how to use this tab and the different actions you can perform with the drawing functionality, see
Manage Drawings.

10.2.5.1 Drawings Toolbar

10.2.5.1.1 2D Drawings Toolbar

Toolbar Option Description
Add Allows you to add a new drawing. For more information, see Add Draw-

ings. When you add a new drawing, the Add/Edit Library dialog opens,
where you can define its properties. For more information, see Add/Edit
Library Dialog.

Edit Allows you to edit the properties of the current drawing. From this dialog
you can also Add and Edit connections to the drawing. When you edit
a drawing, the Add/Edit Library dialog opens, where you can view or
define its properties. For more information, see Add/Edit Library Dialog.

Delete Deletes or unlinks the drawing from the asset. Delete deletes the library
item from NEXUS. Unlink removes the link to the asset, but keeps the
library item.

Launch Opens the drawing on the local machine using the default viewer.
Drawing Type You can select which library types appear here. To control what appears

on this list, go to Library, edit the library types in question, and tick or
untick Show As Drawings.

Include Parents If you tick Include Parents, drawings on this asset’s parents will be shown
in the thumbnail list for you to select.

Copy to Clipboard Copies the drawing to your clipboard at the current scale and offset shown.
The drawing thumbnail and layers will also be included.

Information Toggles a panel at the bottom of the Drawings tab showing EXIF data for
the drawing. Information is shown only for drawings with EXIF data.

Thumbnails Toggles a panel at the right side of the Drawings tab showing thumbnails
for all the images associated with the selected asset. You can customise
the layout of this panel using the Customise button in its toolbar.
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10.2.5.1.1.1 Layers Menu

Toolbar Option Description
Layers → Extract Layers On a PDF drawing with comments/annotations, the Extract Layers tool

will be enabled. Click this to extract and create layers for each annotation
on the drawing. If the annotation matches an existing asset name in the
asset hierarchy, the layers will be automatically linked to their correspond-
ing assets.

Layers → Edit Layers Click this to add, edit or delete layers on drawings. A ‘layer’ is a region,
or a button, or a caption, drawn on the drawing. When you click this menu
option, the Add/Edit Layer dialog opens, where you can maintain its prop-
erties. For more information, see Add/Edit Layer Dialog. For information
about creating and editing layers, see Create Layers and Edit Layers.

Layers → Save Saves the changes (add/edit/deletions) that you’ve done to layers on this
drawing and exits Edit Layers mode. This option is only available if you’ve
made changes.

Layers → Cancel Cancels the changes (add/edit/deletions) that you’ve done to layers on this
drawing.

Layers → Layer proper-
ties

Shows the properties of the currently selected layers. Different types of
layer have different properties. Pick a different item from the Layer Type
drop-down to change this layer to another type. You can set a Colour,
which will be shown in the shape’s border, and shown translucent in the
shape’s area. Opacity sets how translucent — 0 is completely transparent;
100 is completely opaque.

Layers → Delete Layer Deletes the layer off the drawing.
Layers → Create Layer If you’re partway through creating, for example, a Polygon layer (see be-

low), you can right-click and choose Create Layer (or press Enter) to com-
plete the shape. This will take you to the Layer Properties dialog for your
new layer.

Layers → Cancel Point If you don’t like the point you’ve just left-clicked to create, you can right-
click it and choose Cancel Point (or press Shift-Ctrl-P).

Layers → Cancel Layer If you don’t like the layer you’re partway through creating, you can right-
click it and choose Cancel Layer (or press Escape).

Layers → Copy Select a layer using the Selection Tool (see below), then right-click and
choose Copy (or press Ctrl-C). This will copy the region to NEXUS IC’s
internal clipboard.

Layers → Paste Paste the layer you copied above by right-clicking and choosing Paste (or
Ctrl-V). NEXUS will paste the layer in, offset a little from the original.
Then click inside the layer with the left mouse button and drag the layer to
its desired location.

Layers → Select All Selects all the layers on the drawing.

� Tip

Using ‘Select All’ is useful way to reposition or delete mul-
tiple layers. You can also select multiple layers by holding
down the Ctrl key and clicking each layer.

Layers → Clear Selection Unselects all the layers. This is useful, for example, if you want to unselect
the selected layer so you can see the colours of all layers at once. (The
selected layer is shown in pale blue; Clear Selection means no layer is so
shown.)
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10.2.5.1.1.2 Layer Tools

Toolbar Option Description
Selection Tool Click this, and when you click on a layer in the drawing, you’ll be selecting

it. Ctrl-click to select additional layers. You can click inside a layer and
drag to move layers. Click-dragging a point will move just that point.

Rectangle Click this, then click-drag to create a rectangular region on the drawing.
Once complete, you can drag the four corners of the rectangle separately
so that it’s not a rectangle anymore.

Polygon Click this to start drawing a polygon region. Each click in the drawing will
add a point to your polygon. Press Enter or right-click and choose Create
Layer to complete the polygon.

Ellipse Click this, then click-drag to create an ellipse region on the drawing. Once
complete, this is turned into a 50-sided polygon.

Line Region This tool is useful for putting regions on P&IDs etc., where you have a
thin, possibly branching line and you want to put a narrow region over it.
Click the Line Region button, then left-click on an end of the line you
want to trace, left-click at the next point that it turns a corner, etc. As with
Rectangle, when you complete (by pressing Enter or right-clicking and
choosing Complete Layer), the layer is a region and you can adjust all its
corners independently.

Caption Click this, then click in the drawing at the top left of where you would
like your caption to appear. In the Layer Properties dialog, type some
Caption text. Optionally choose a Caption Colour and a Caption Angle.
Blank or 0 gives ordinary horizontal text.

Button Click this, then click in the drawing at the top left of where you would
like your caption to appear. In the Layer Properties dialog, type some
Caption text. If you type no text, you will get a very small button, because
the button sizes to fit the text.
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10.2.5.1.1.3 View Menu

Toolbar Option Description
View → Fit Width Changes the pan and zoom on the drawing so that it fits within the width

available on the Drawings tab.
View → Fit Height Changes the pan and zoom on the drawing so that it fits within the height

available in the Drawings tab.
View → Default Size Sets zoom to 100%. This may or may not fit in your Drawings tab, de-

pending on how big the drawing is.
View → Zoom In Zoom In.
View → Zoom Out Zoom Out.
View → Zoom Selection Click this, then in the drawing click and drag a rectangle. NEXUS IC will

then zoom to the area you’ve selected.
View → Increase Caption
Size

Increases the size of all captions on the drawing: on captions, buttons, and
regions.

View → Decrease Cap-
tion Size

Decreases similarly.

View → Caption → . . . If you select Default, captions will display the text you have set in Layer
Properties. If you select Asset Information or Event, NEXUS IC will
display a picker. You pick a field, and NEXUS IC will use values from
that field to fill captions. This only works for layers that have an asset set
in Layer Properties.

10.2.5.1.1.4 Layer Colour Menu

Toolbar Option Description
Layer Colour → Default Shows layers on drawings in the colours that you have selected in the Prop-

erties of each layer.
Layer Colour → Traffic
Lighting

Shows layers on drawings in the colours specified by the currently selected
Traffic Light.

Layer Colour → Trans-
parent

Shows layers on drawings as just an outline, in the colours that you have
selected in the Properties of each layer.

Layer Colour → Un-
known Asset

Shows layers that have an asset in the Known Asset Colour, and layers
that don’t have an asset assigned in the Missing Asset Colour. You can
configure these in Database → Properties.

10.2.5.1.2 3D Drawings Toolbar

3D drawings get different items on their toolbar. Add, Edit, Delete and Colour are as described above.
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Toolbar Option Description
Rotate When selected, dragging on the 3D drawing will change the “camera” an-

gle. When unselected, dragging on the drawing will pan.
Wireframe / Hidden Lines
/ Smooth Shading / Flat
Shading

Select between the options to control rendering of the drawing. Some op-
tions prioritize speed, while others focus on aesthetics. For some drawings,
Wireframe may not show anything.

Information Toggles a panel at the bottom of the Drawings tab showing information for
the selected region of the drawing.

Coordinates Toggles the display of coordinates at the bottom right of the drawing, show-
ing the mouse location.

10.2.5.1.2.1 View Menu

For 3D drawings, the View menu option contains extra items:

Toolbar Option Description
View → Rotate Same as the Rotate button.
View → View Direction Select one of 10 viewing directions. You can get to any of these viewing

directions via the Rotate button, but this is faster.
View → Viewports For a 3D drawing, available viewports will be displayed on this menu.
View → 3D Styles Same as the Wireframe / Hidden Lines / Smooth Shading / Flat Shading

buttons.
View → Hint → . . . Similar to View → Caption → . . . , but information will be displayed as a

mouse-over hint on the region you’re currently on, rather than as captions.
View → Show → . . .

• Information and Coordinates are the same as their respective but-
tons.

• Grid may or may not show a grid, depending on the drawing.
• Axis will show/hide the axis orientation arrows at the bottom left of

the Drawings tab.
• North Arrow may or may not show an arrow illustrating the North

direction, depending on the drawing.

ã See also

• Manage Drawings

• Add/Edit Library Dialog

• Add/Edit Layer Dialog

10.2.5.2 Manage Drawings

NEXUS IC allows you to upload and edit drawings for each asset and add layers to these drawings as required.

ò Note

NEXUS IC supports the following image formats: GIF, JPG, JPEG, JFIF, TIF, BMP, PNG, PDF, DWG,
CGM, DXF, SVG, WMF and EMF.

358 Chapter 10. Asset Data Management



NEXUS Documentation, Release 6.9.xxxxx.0

You manage drawings on the Drawings tab of the ASSETS screen. For detailed information about this screen, see
Drawings.

For detailed information about the functionality and the actions you can perform, see the following sections:

• Add Drawings

• Manage Layers in Drawings

• 3D Drawings

10.2.5.2.1 Add Drawings

You can add a new drawing to an asset in one of the following ways:

• You can drag image files from your file explorer onto the Drawings tab of the ASSETS screen. If you drag and
drop a single file, the Add Library dialog appears, where you can enter data as required. If you drag and drop
multiple files, they will simply be added.

ò Note

The drag and drop functionality is not supported in remote environments (for example, Remote Desktop).

• You can add drawings from the Drawings tab of the ASSETS screen as follows:

1. Choose Add from the toolbar.

Since drawings are essentially Library records in NEXUS, the Add Library dialog appears.

2. In the Add Library dialog, select the library type and enter the name of the drawing.

ò Note

To ensure that the drawing (library item) appears on the Drawings tab, you must select a library type
for which you have selected the Show as Drawings checkbox when you have set up the library type
(see Add Library Types).

3. Enter other parameters as required (see Add/Edit Library Dialog for more information), and click the At-
tachment button to select the image file that you want to upload.

In most cases, you use the Import option for adding the attachments. The Link option works only in
on-premise environment and only items on network drives can be linked.

4. Click OK.

ã See also

• Manage Drawings

• Manage Layers in Drawings

• 3D Drawings
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10.2.5.2.2 Manage Layers in Drawings

Layers are marked-up regions on a drawing that can show specific information or contain links to other data. The layers
functionality allows you to:

• Add links from parts of a drawing to assets in the asset hierarchy

• Add links from parts of a drawing to other drawings

• Display captions with specific text on a drawing

• Highlight parts of drawings with colours or add traffic light colours to them

• Display Asset Information Group (AIG) field values for specific parts of the drawing

10.2.5.2.2.1 Create Layers

You can add a new layer to a drawing using one of the following methods:

10.2.5.2.2.2 Create Layers from the Toolbar

1. On the ASSETS screen, select the asset in the asset tree that contains the drawing to which you want to add
layers.

2. Go to the Drawings tab and select the required drawing.

3. From the toolbar of the Drawings tab, choose Layers → Edit Layers or right-click the drawing and choose Edit
Layers from the context menu. This step opens the layer editing mode with additional toolbar options. These
new options are also available from the context menu when right-clicking the drawing.

4. Select the required tool from the new options and draw the layer to the drawing as required. For information
about the available tools, see Layer Tools.

5. If you’re creating a polygon or line region, once you have added all the points of the region, press Enter or
right-click and choose Create Layer from the context menu. This step is not required for the other layer types.

6. In the Add Layer dialog that appears, specify the parameters of the new layer. You can define the type, colour,
and opacity of the layer, add a caption to it and add links to assets, relative assets or other drawings as required.
For more information, see Add/Edit Layer Dialog.

7. Click OK.

8. Once you have created all the layers for the drawing, choose Layers → Save from the toolbar of the Drawings
tab.

10.2.5.2.2.3 Create Layers Using Drag & Drop

1. On the ASSETS screen, select the asset in the asset tree that contains the drawing you want to modify.

2. Go to the Drawings tab and select the required drawing.

3. In the asset tree, locate the asset for which you want to create a layer. Drag and drop it onto the drawing canvas
at the desired location.

4. In the Add Layer dialog that appears, specify the parameters of the new layer (see Add/Edit Layer Dialog). The
selected asset is automatically populated in the Asset and Caption fields.
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5. Click OK.

A new layer is added to the drawing with a rectangular region.

� Tip

To create a layer with a different shape, first create the layer using the toolbar method described in Create
Layers from the Toolbar. Then, add the direct asset reference via drag and drop (see Add Asset Reference
Using Drag & Drop).

6. Adjust the position and shape of the layer as needed.

7. Choose Layers → Save from the toolbar to save your changes.

10.2.5.2.2.4 Create Layers by Extracting from PDF

If a PDF drawing contains comments or annotations, you can have NEXUS automatically create layers for them using
the Extract Layers function. To do that, follow the steps below:

1. Select the PDF drawing on the Drawings tab of the ASSETS screen.

2. From the toolbar of the Drawings tab, choose Layers → Extract Layers.

3. In the dialog that appears, select one of the following options:

• Choose All Layers if you want to create layers for all the texts that NEXUS finds in the PDF drawings.

• Choose Asset Exists if you want to create layers only for those texts that exactly match the name of an
existing asset in the asset tree.

ò Result

The layers are automatically created for the annotations of the drawing. If the system could find an asset
with the same name as the annotation text, it automatically adds a link to the asset as a Relative Asset (see
Relative Asset Reference). If you selected All Layers and the system couldn’t find an asset with the same
name, the layer will be created without links to any assets.

4. If required, you can edit the properties of the layers (see Edit Layers).

5. Choose Layers → Save from the toolbar of the Drawings tab to save your changes.

10.2.5.2.2.5 Edit Layers

10.2.5.2.2.6 Edit Layer Properties

You can edit an existing layer on a drawing as follows:

1. On the Drawings tab, select the required drawing.

2. Hover over the drawing layer that you want to change.

3. From the toolbar of the Drawings tab, choose Layers → Edit Layers or right-click the layer and choose Edit
Layers from the context menu. This step opens the layer editing mode.
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4. Select the layer and from the toolbar of the Drawings tab, choose Layers → Layer Properties or right-click the
layer and choose Layer Properties from the context menu.

5. In the Edit Layer dialog that appears, update the parameters of the layer as required. For more information, see
Add/Edit Layer Dialog.

6. Click OK.

7. Once you have finalised your changes, choose Layers → Save from the toolbar of the Drawings tab.

10.2.5.2.2.7 Add Asset Reference Using Drag & Drop

You can add a direct asset reference (see Direct Asset Reference) to an existing layer by dragging and dropping an asset
from the asset tree onto the layer:

1. On the Drawings tab, select the drawing that contains the target layer.

2. In the asset tree, locate the asset you want to reference and drag it onto the layer.

3. In the Edit Layer dialog that appears, update the parameters of the layer as required (see Add/Edit Layer Dialog).
The selected asset is automatically populated in the Asset and Caption fields.

4. Click OK.

5. To finalise your changes, choose Layers → Save from the toolbar.

10.2.5.2.2.8 Link from Layers to Assets

You can link to assets from a layer when you create or edit layers (see Create Layers or Edit Layers).

You can create asset references in two ways:

10.2.5.2.2.9 Direct Asset Reference

In this case, the asset is specified in the Asset field of the Add/Edit Layer dialog (see Add/Edit Layer Dialog). When
you use direct asset reference, you can directly navigate to an asset in the asset hierarchy from the layer of the drawing
and vice versa, you can navigate from the asset in the asset tree to the actual layer of the drawing from the context menu
(right-click) of the asset:
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10.2.5.2.2.10 Relative Asset Reference

In this case, instead of specifying a particular asset, a text is defined in the Relative Asset field of the Add/Edit Layer
dialog (see Add/Edit Layer Dialog). NEXUS searches for child assets that match that name under the asset for which
the drawing is displayed for. In case multiple assets are found, the user can navigate from the layer of the drawing
by selecting the relevant asset from the context menu (right-click) of the asset. However, in case of relative asset
references, you’re not able to navigate from the asset in the asset tree to the drawing layer. Also, you cannot display
AIG field values on drawing layers if the layer has only a relative asset reference.

For example, if you specify AN1 in the Relative Asset field, and you have several child assets with the name AN1 under
the relevant asset, you’ll have the following navigation options when clicking the layer on the drawing:
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ò Note

In case you extract layers from a PDF drawing, the layers are assigned relative asset references and not direct ones.

10.2.5.2.2.11 Link from Layers to Drawings

You can link to other drawings from a layer when you create or edit layers (see Create Layers or Edit Layers). This
option is available if you have also set up a direct asset reference (see Direct Asset Reference) and you have specified
the asset that has the drawing you want to link to. In this case, the Associated Drawing field becomes available in the
Add/Edit Layer dialog (see Add/Edit Layer Dialog) where you can select the required drawing.

When navigating to the other drawing, you’re also directed to the relevant asset in the asset tree.

10.2.5.2.2.12 Display AIG Field Values on Drawings

You can display actual values of specific AIG fields as a caption of drawing layers. This option is available if you have
set up a direct asset reference (see Direct Asset Reference) and you have specified the asset that has the AIG field whose
value you want to get displayed.

You can display AIG field values on drawings in one of the following ways:

• You can select the AIG field in the Associated Field field of the Add/Edit Layer dialog when you create or edit
layers (see Create Layers or Edit Layers). In this case, the Asset field must contain the asset that has the AIG
with the associated field.

• If you have specified a direct asset reference to a layer, you can display the value of any of its AIG fields by
right-clicking the relevant field label on the Asset Information pane, and selecting Display on drawing:
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The value of the AIG field is now indicated on the drawing:

10.2.5.2.2.13 Change Layer Colours on Drawings

By default, the system displays the colour that you have set up for the layer when creating or editing the layer (see
Create Layers or Edit Layers). You can change the default layer colours by selecting the required option from the
Layer Colour toolbar menu. You have the following options:

• Display the currently selected traffic light colours on drawing layers

• Display the layer colour only in the outline of the layer, instead of filling it with colour (transparent layer)
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• Display unknown assets, in which case, layers that have an asset are shown in the Known Asset Colour, and
layers that don’t have an asset assigned are displayed in the Missing Asset Colour. You can configure these
under Database → Properties.

For example, if you want to have traffic light colours displayed on the layers of the drawing, select the relevant traffic
light from above the asset tree on the left and choose Layer Colour → Traffic Light from the toolbar of the Drawings
tab. The layers of the drawing get the colour of the selected traffic light:

ã See also

• Manage Drawings

• Add/Edit Layer Dialog

10.2.5.2.3 3D Drawings

Three-dimensional drawings are different from standard drawings and there are additional editing and viewing options
available when you have a 3D drawing (see 3D Drawings Toolbar).

For information about configuring 3D drawing objects to link to assets in the asset hierarchy, see the sections below:

• 3D Drawing Setup Example

• 3D Drawing Preparation in Autocad

10.2.5.2.3.1 3D Drawing Setup Example

There is some configuration required to be able to link assets in the NEXUS IC hierarchy to objects in a 3D drawing.
Once configured successfully, you will be able to:

1. Hover over the object in the 3D Drawing to view the NEXUS IC asset name.
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2. Click on an object in the 3D drawing to auto navigate to that asset in the NEXUS IC asset hierarchy.

3. Display traffic lighting on the 3D drawing objects.

³ Caution

For optimal performance, an OpenGL graphics card is required on the client machine for this functionality. 3D
drawings can take a considerable time to load. We recommend that 3D drawings are simplified as much as possible
to reduce file size and load times.

10.2.5.2.3.2 Step 1

The first step is to ensure that the 3D Drawing is configured with an Asset Serial Number attribute.

Using Autocad, create a block which represents a single asset in the NEXUS IC asset hierarchy. For each block, define
an attribute (using the ATTDEF command) and populate the attribute with the “Asset Serial Number”.

In this example, the attribute in the 3D drawing is titled EXTERNAL.REFERENCE.3D.DRAWING.TAG. The follow-
ing images illustrate the attributes in Autocad and in NEXUS IC.
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For detailed instructions on how to prepare an Autocad drawing, refer to 3D Drawing Preparation in Autocad.

10.2.5.2.3.3 Step 2

Go to Database → Properties → 3D Drawings. Type in the 3D Drawing Attribute name which contains
the Asset Serial Number information. In this example, the attribute in the 3D drawing is titled EXTER-
NAL.REFERENCE.3D.DRAWING.TAG.
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10.2.5.2.3.4 Step 3

Go to Database → Properties → 3D Drawings. Select a colour to be displayed for any block where the attribute is
defined, but there is no corresponding match in the asset hierarchy in NEXUS.

10.2.5.2.3.5 Step 4

Go to Configuration → Assets → Features to edit the field. In this example, the AIG field Asset - Serial Number has
the 3D Drawing TAG field set, located in the AIG titled External Reference.
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10.2.5.2.3.6 Step 5

Ensure that the Asset Serial Number data is populated in the specified AIG field and that the data matches that in the
Asset Serial Attribute in the 3D drawing.
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10.2.5.2.3.7 3D Drawing Preparation in Autocad

In order to prepare a 3D drawing follow the steps below:

1. Create the required attributes in Autocad

a) In Autocad type ATTDEF, the following form will open
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b) Check the Invisible mode and uncheck the Lock position mode

c) Uncheck the Specify on-screen and leave the coordinates X:0, Y:0, Z:0

d) In the Tag textbox, type the name of the attribute (e.g. EXTER-
NAL.REFERENCE.3D.DRAWING.TAG)

e) Press OK button

f) Repeat steps a – e for each attribute to be created

2. Create blocks with attributes

a) In Autocad type BLOCK, the following form will open
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b) Type the block name (preferred to be the object component unique ID)

c) Click on Select objects
d) Select the attributes created in step 1

e) Select the object required

f) Press OK button

3. Fill out the attributes values. The value will be filled with the unique identifier that will be used by NEXUS IC

4. Repeat steps 1 – 3 for each object in the Autocad drawing

The above steps could be time consuming, therefore an AUTOLISP (one of the Autocad scripting languages) has been
developed to automate the attribute and block creation as well as the attributes value population. You will need to
download the AUTOLISP file NEXUS_REF.lsp.

This file can be used to automatically do the steps for creating a 3D drawing using Autocad. The steps to use the
AUTOLISP are as follow:

1. Open the drawing in Autocad

2. Go to the Manage tab and click on Load Application
3. Select the “NEXUS_REF.lsp” file

4. Press the Load button

5. Press the Close button
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6. In the command line type the following command: (NEXUS_REF)

In order to use this AUTOLISP, it is required that each object in the drawing to be on a separate layer. These layers
should be named as the external reference name (e.g. Leg_B1). The script will do the following:

1. Create attribute with the name “EXTERNAL.REFERENCE.3D.DRAWING.TAG”

2. Create a block for one object, setting the block name to be the same as the object’s layer name

3. Populate the attribute value with the object’s layer name

4. Loop on all the objects and repeat steps 1 - 3

You can download a sample 3D drawing from here.

This sample Autocad drawing can be used in conjunction with the Autoslip file for further clarification.

10.2.6 Library
This functionality is also available on the LIBRARY screen. On the ASSETS screen, you can view all the library items
for a particular asset.

Library items are electronic documents that can be linked to data and data types in NEXUS IC using connections (see
Library Connections).
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The electronic documents can be uploaded directly into the NEXUS IC database, or can be referenced using URL or
UNC paths.

10.2.6.1 Manage Library Items

You can manage library items from several screens within NEXUS IC, including:

• Library Items tab on the LIBRARY screen (see Library)

• Library tab on the ASSETS screen (see Library)

• Library tab on the INSPECTION screen (see INSPECTION)

• Library tab on the ANOMALIES screen (see ANOMALIES)

• Library tab under Configuration → General → Functions → Edit Function Definition

• Library tab on the Edit Asset Type dialog under Configuration → Assets → Types

• Library tab on the Edit Table Definition dialog under Configuration → Events → Event Types →
Edit Table Information

Example
If you upload company piping specifications to the NEXUS IC Library and assign it to the asset type
“Pipework”, the piping specifications will be available from the Library* tab of the ASSETS screen when-
ever the active asset is of type “Pipework”.

You can also maintain library items on the Library pane of IC-Inspection.

You use the standard toolbar functions on the Library/Library Items tab to add, edit, delete, import, export library items
or customise the grid layout. For more information about these functions, see Using the Grid.

ò Note

• You can edit the properties of the selected library item from the toolbar, but not the document
itself.

• Deleting a library item will also delete all its associated connections.

• The Export option only exports the grid contents, not the actual library documents.

See below for more information about some actions you can perform on library items:

ò Add Library Items

To create a new library item, proceed as follows:
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1. Start adding a new library item in one of the following ways:

• On the Library/Library Items tab, choose Add from the toolbar.

• Drag files from your file explorer onto the Library/Library Items tab.

ò Note

Drag-and-drop is not supported in remote environments (e.g., Remote Desktop).

2. Depending on the screen from which you accessed the Library tab, you may be prompted to select a con-
nection type. You can connect a library item to different types of data records:

Screen Connection Type
ASSETS

• Asset
• Asset Type

INSPECTION
• Asset
• Asset Type
• Event
• Event Type
• Workpack

ANOMALIES
• Anomaly
• Asset

ò Note

If you’re adding a library item from the LIBRARY screen, you add the connection to a data record from
the Connections tab after you have created the library item. For more information, see Add Library
Connections.

3. In the Add/Edit Library dialog, select the library type, enter a name for the library item (mandatory) and
enter other parameters as required. For information about filling in all the parameters, see Add/Edit Library
Dialog.

• If the document is to be uploaded into NEXUS IC, then click on the Attachment button, else enter a
Hyperlink location.

• When adding an attachment, you can either Import or Link it:

– If you import, the item will be saved to the database. If you subsequently change the original on
disk, the item in the database will not change to match.

– If you link the item, then when you change the original on your disk, the next time you view the
item within NEXUS IC, you’ll see the updated item.
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ò Note

• NEXUS IC still loads a copy of a linked item into the NEXUS database. This ensures
that if the original is unavailable (for example, because you are away from your network),
NEXUS IC can display the cached copy.
When you view the item, if the original has been updated, the database cached copy is
updated too. You can’t link items that are on your local hard disk, only items on network
drives can be linked. The Link feature is designed to keep you up-to-date with items
that may have been changed by others, and that is not possible on your local drive.

• If you drag and drop multiple files, they will be added, and then multi-selected in the
grid. You can then click Edit to multi-edit them (see Multi-Edit). Drag and drop will
import items, not link them.

4. Click OK.

On the LIBRARY screen, you can view the details of the library item by selecting it and checking the Details
tab under the Library Items tab.

ò Edit Library Items

To edit an existing library item, proceed as follows:

1. On the Library/Library Items tab, select the library item.

2. Choose Edit from the toolbar.

3. In the Edit Library dialog, update data as required. For more information, see Add/Edit Library Dialog.

4. Click OK to save your changes.

ò Delete Library Items

To delete an existing library item, proceed as follows:

1. On the Library/Library Items tab, select the library item.

2. Choose Delete from the toolbar.
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3. In the confirmation dialog, click Check Connections if you want to review any connections to this library
item before deletion.

4. If you want to proceed deleting the library item, click Delete, else, choose Cancel.

ò Launch Library Items

Use the Launch toolbar button to launch library items on the local machine. By default, NEXUS only launches
files with the following extensions: doc, docx, xls, xlsx, jpg, png, jpeg, jfif, bmp, tiff, gif, mpg, mp3, wav, ppt, pptx,
txt, pdf, emf, zip, dwg, avi, rtf, mp4, csv.

� Hint

Use the Space Bar on your keyboard to launch the currently selected library item.

Note that if the local machine does not have an associated viewer for the document type (for example, AutoCad
viewer for DWG type), then the document can not be launched.

ò Email Library Items

Use the Email toolbar button to send an email message with the selected library items attached to it.
You can select multiple library items to be sent in the same email message. Note that you must have
properly configured your email settings (see Set Up Email) for this option to function.

. Warning

If the size of the attachment exceeds your organization’s attachment size limit, you may get an “Out
of memory” error message.

ò Import Library Items

You can import library items using the standard Import toolbar option (see Import). You can download the MS
Excel Import Template, which shows the required format for importing library items.

You can also import the Connections in the same import as the library items, so in addition to the Library Import
columns, you can additionally define the Connection information using the following column headings:

• Library Connection.Connect To

• Library Connection.Workpack

• Library Connection.Asset Type

• Library Connection.Asset

• Library Connection.Event Type

• Library Connection.Event

• Library Connection.Anomaly

• Library Connection.Risk Model
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• `Library Connection.Function

Note that the Connect To column should only contain one of the following text items:

• Anomaly

• Asset

• Asset Type

• Event

• Event Type

• Function

• Risk Model

• Workpack

10.2.6.1.1 Double-click

The first time you double-click on a library item, NEXUS asks you whether you want to launch the library item in
an external editor, or edit the library item. If you want your choice to become permanent, tick the Always do this
checkbox. Note that if you hold down the Alt key while double-clicking, you will be asked again.

10.2.7 Asset History
The Asset History functionality allows you to record key events related to an asset or group of assets throughout their
lifecycle. These records capture important information for posterity and can be retrieved in report templates or accessed
via the user interface.

You can manage asset history records on the Asset History tab of the ASSETS screen. For details on customising the
tab layout, see Customise.

10.2.7.1 Add Asset History Record

1. On the ASSETS screen, select the relevant asset in the asset tree and open the Asset History tab.

2. Click Add in the toolbar.

3. In the Add Asset History dialog, enter data as required. For field descriptions, see Add/Edit Asset History
Dialog.

4. Save your entries.

10.2.7.2 Edit Asset History Record

1. On the ASSETS screen, select the relevant asset in the asset tree and open the Asset History tab.

2. Select the asset history record that you want to update.

3. Click Edit in the toolbar.

4. In the Edit Asset History dialog, update data as required. For field descriptions, see Add/Edit Asset History
Dialog.

5. Save your entries.
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10.2.7.3 Delete Asset History Record

1. On the ASSETS screen, select the relevant asset in the asset tree and open the Asset History tab.

2. Select the asset history record that you want to delete.

3. Click Delete in the toolbar.

4. In the confirmation dialog: - Click Check Connections to review any linked records. - Click Delete to confirm
deletion, or Cancel to abort.

� Hint

To bulk update or delete asset history items, use the Multi-Edit functionality.

10.2.7.4 Import Asset History Record

You can import asset history records using the standard import functionality available via the Import toolbar button.
The MS Excel Import Template details the required format for importing asset history records. For more information,
see Import.

10.2.7.5 Export Asset History Record

You can export asset history records using the standard export functionality. For more information, see Export.

10.2.7.6 Reporting on Asset History

To retrieve Asset History data in a report template, use the System Table titled Asset History.

10.2.8 Anomalies
Anomalies are records that identify discrete items or areas of concern. An anomaly record may have been originated
from an inspection item (which means that it will have a finding linked to it) or it may be a stand-alone record created
within the integrity and inspection cycle (ad-hoc).

Anomalies can be accessed from the ANOMALIES screen, or from the Anomalies tab on the ASSETS screen. The
functions that you can perform on the Anomalies tab of the ASSETS screen are basically the same as the ones you can
do on the ANOMALIES screen, the main differences are:

• On the ASSETS screen, you can only access anomalies that pertain to the asset you have selected in the asset
tree or, if you have clicked the Child Assets button, to this asset and all its children.

• On the ASSETS screen, you can see only a list of anomaly records and you cannot see the following:

– Actions, Findings and Library tabs, which you can see at the bottom of the ANOMALIES screen. How-
ever, if you create or edit an anomaly record from the Anomalies tab of the ASSETS screen, you can still
access these tabs from within the Add/Edit Anomaly dialog and you can perform any functions for these
records as required.

– The multimedia images assigned to the anomalies

– The risk matrix associated with the anomalies

• To close an anomaly, on the ASSETS screen, you choose Shortcuts → Close Anomaly from the toolbar, whereas
on the ASSETS screen, you choose Anomaly → Close Anomaly.

For detailed information about the anomalies functionality, see Anomaly Management.
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ã See also

• Anomaly Management

10.2.9 Risk
You can display risk assessment results for the currently selected asset and all its children on the Risk tab of the
ASSETS screen. Results are graphically represented in pre-configured risk matrixes and in the data grid as shown in
the example below:

10.2.9.1 Prerequisites

To enable displaying risk models for assets, you must have made the necessary configuration settings and assignments
as follows:

• You must set up risk charts and risk models (see Configure Risk Charts and Configure Risk Models).

• You must assign the risk model to the asset type of the asset (see Assign Risk Models to Asset Type).

• You must assign the risk model to the asset (see Assign Risk Models and Scenarios).

10.2.9.2 Display Options

When displaying risk models, note the following:

• Where there are several risks at the same location in the chart, the dot will be shown larger.

• Clicking on a row in the grid highlights that item in the matrix. Similarly, clicking on a result indicator in the
matrix will highlight the relevant row (or rows) in the grid.

• If you are using scenarios, each scenario will be shown in its own colour. Scenario dots may be offset within the
risk square. In this case, this does not indicate a difference in risk, it is merely for legibility.

• If you click on a scenario dot within the matrix, the relevant rows in the grid will be highlighted, and the relevant
dots for those assets’ other scenarios will be highlighted in the matrix.

• If you want to see the total number of risk assessments at the specific locations of the risk models, click Show
Count.
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10.2.9.3 Risk Toolbar

Toolbar Option Description
Assign → Risk Model Choose from the list of pre-configured risk models in the drop-down menu

to assign a risk model to the currently selected asset. For more information,
see Assign Risk Models and Scenarios.

Edit Launches the Risk Assessment dialog. Any values in the risk assessment
can be edited and saved from this dialog by clicking in the Value column
of any Value type row (white rows). Note that Pass Thru and Calculation
values can not be edited. Clicking on a Factor or Model row however,
allows you to view the function and the function results that have been
assigned to that row. From here you can also assign Scenarios to this risk
assessment.

Delete Deletes the currently selected Risk Assessment from the asset to which it
is assigned. Note that the asset and all information linked to that asset will
remain unchanged.

Export See Export for full description of the Export menu item.
Customise See Customise for full description of the Customise menu item.
Child Assets Select to include risk assessments on all this asset’s children.
Navigate to Asset Changes the active asset in the hierarchy to the currently selected risk-

assessed asset. Note that this will filter the Risk grid so that only assess-
ments for the active asset will be shown.

� Hint

Use the Back toolbar button on the Assets toolbar to return
to the previously selected asset.

Copy Assessment Launches a dialog to copy risk assessment to selected assets dialog. From
here, select the assets which you want to assign the currently selected risk
model to. For more information, see Assign Risk Models and Scenarios.

Copy To Clipboard Copies the risk chart to the clipboard as an image.
Show Count When active, the matrix will overlay the total number (count) of risk as-

sessments at that location in the matrix, as shown in the following image:
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10.2.9.3.1 Assign Risk Models and Scenarios

You can assign risk models to individual assets from the ASSETS, PLANNING or WORKPACKS screen as described
below.

10.2.9.3.1.1 Prerequisites

• You have set up risk charts and risk models as described in Configure Risk Charts and Configure Risk Models.

• You have assigned the risk model to the asset type of the asset (see Assign Risk Models to Asset Type).

10.2.9.3.1.2 Processes

ò Assign Risk Model to Individual Asset

1. Select the asset from the asset tree and go to the Risk tab.

2. Click Assign to <name of asset> from the toolbar of the tab.

3. Select the required risk model from the list. The available risk models depend on your configuration settings
(see Prerequisites above).

4. Choose OK.

ò Assign Risk Model to Assets in Bulk (Copy)

You can assign risk models to several assets at a time by copying the risk model assignment from an asset.

1. From the asset tree, select the asset whose risk model assignment you want to copy and go to the
Risk tab.

2. Select the risk models that you want to copy and choose Copy from the toolbar of the tab and
select whether you want to copy only the risk assessment or the risk assessment together with the
scenarios.

Note that you will only be able to select valid assets from this dialog, that is, assets that already
have the same risk model assigned cannot be selected.

3. In the dialog that appears, select the relevant assets from the asset tree. You can switch the asset
view if required.

4. Click OK.

ò Result

The risk models are assigned to the selected assets together with the values assigned to factors and
categories in the risk model.

ò Edit Risk Model Values and Assign Scenarios

You can edit values in the risk model and assign scenarios as required. Note that you cannot edit Pass Thru and
Calculation values.

If you are using more than one scenario for a single asset, you must store the information that varies from one
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scenario to another as values within the risk model.

1. Select the asset from the asset tree and go to the Risk tab.

2. Click Edit from the toolbar of the tab.

3. Make changes or view data as required:

• To change a value within the risk model, navigate to the relevant value node in the hierarchy (white
row) and click in the Value column to change the value:

• To assign a scenario, do the following:

1. Click Scenario.

2. In the dialog that opens, select from the available scenarios or click Add to define a new one.

3. Click OK. A new column is added to the dialog for the added scenario.

4. Change values for the new scenario column as required.

• To view the function and function results that have been assigned to a Factor or Model row, click the
at the end of the row.

4. Close the dialog.

ã See also
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• Risk

• Configure Risk Models

• Assign Risk Models to Asset Type

10.2.10 Sensors
Sensor data is periodically logged data (for example, once per hour) recorded against assets.

NEXUS IC allows you to store, view and aggregate sensor data for your assets. On the Sensors tab of the ASSETS
screen, you can import sensor data, display and export them as required.

The Sensors feature is separately licensed. Contact support@nexusic.com for details.

10.2.10.1 Prerequisites

To enable displaying and importing sensor data for assets, you must have created a sensor data form and must have
assigned the form to the asset type of the relevant asset. For more information, see Configure Sensors.

10.2.10.2 Import Sensor Data

You can import sensor data by selecting the relevant asset in the asset tree and using the standard import functionality
(see Import). You can only import one sensor data type at a time and it will be enabled only if the sensor data form has
been assigned to the asset type of the selected asset.

10.2.10.3 Display Sensor Data

Once you have imported sensor data against an asset, you can display it on the Sensors tab on the ASSETS screen.

Here you can see a summary of sensor data, including a “sparkline” chart showing the last 30 days of data. The dots
on each chart show the minimum and maximum (within the 30-day range). The two lines show the minimum and
maximum values for that particular range. If the chart is 90 pixels wide, each pixel represents a third of a day, so a
considerable range of values may occur within a single horizontal pixel.

Typically, a sensor will only have a single numeric field configured. However, if your sensor data type has more than
one field, then the Sparkline chart shown on the Sensors grid will display the data from the field that is ordered first.
See Configure Sensors for more information on Form Order.

To see row-by-row data for a sensor, select it in the grid and click View Data.
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10.2.10.4 Sensors Toolbar

Toolbar Option Description
Child Assets Displays all children of the currently selected asset (multiple levels of the

hierarchy) if it is selected. Note that if the selected asset has many children
that are sensors with large quantities of data, this may be slow.

Navigate to asset Changes the active asset in the asset tree to the currently selected asset in
the data grid. By navigating to a different asset in the hierarchy, this will
also update the contents of data grid.

View Data Displays the View Sensor Data dialog showing you the row-by-row data
for this sensor. Note that this dialog has a Shortcuts button which shows
any Sensor-specific On Focussed Item shortcuts.

Import This is shared functionality. Refer to Import for a full feature description.
Export This is shared functionality. Refer to Export for a full feature description.
Customise See Toolbar → Customise for information about the Customise toolbar

option.

10.2.11 Planning Templates
The planning template functionality on the ASSETS screen is the same as the planning template functionality on the
PLANNING screen. For more information about this functionality, see Planning Templates.

10.2.12 Children
The Children functionality in NEXUS IC allows you to display asset information data or perform actions for multiple
assets in bulk.

On the Children tab of the ASSETS screen, you can:

• View asset information in a tabular format for more than one asset at a time. For more information, see View
AIG Data for Multiple Assets.

• Edit asset information group (AIG) fields for more than one asset at a time. For more information, see Edit AIGs
for Assets in Bulk.

• Perform any actions available from under the Shortcuts toolbar button for more than one asset at a time.

• You can export all data in the grid to Excel, Text or CSV. For more information, see Export.

10.2.12.1 View AIG Data for Multiple Assets

You can display the AIG fields for multiple assets at a time as follows:

1. In the asset tree, select the high-level asset node that contains all the assets for which you want to
view the asset information data.

2. Go to the Children tab.

3. Under Filters, select whether you want to display all children (Show All Children) or only the direct
descendants (Show Selected Asset) of the selected asset.
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4. If required, you can filter your assets. For example, you can filter your assets based on the asset type
in the Asset Type column:

5. Choose Groups from the toolbar and select the AIG whose fields you want to display.
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ò Result

The AIG fields get added to the view. If required, you can further filter, group or sort your assets
based on the AIG field values.

³ Caution

If you elect to view complicated AIG forms that contain complex calculations and references, then the
data grid may take several minutes to load. This depends on the complexity of AIG forms and the
number of assets to view.

ò Note

In some circumstances (particularly if your database used to be a version 5 database) you may have AIG
records against assets whose type does not have that AIG assigned. This is because AIG records are
not deleted when you unassociate an asset type from an AIG. Any such “secret” records are displayed
on the Children tab with a purple border, to visually indicate that you won’t see this data as an AIG
form when you navigate to the asset.

10.2.12.2 Edit AIGs for Assets in Bulk

You can edit the AIGs of multiple assets in bulk as follows:

1. On the ASSETS screen, navigate to the high-level asset node that contains all the assets for which
you want to update the AIG data.

2. Go to the Children tab.

3. Under Filters, choose Show All Children.

4. If required, you can filter your assets. For example, you can filter your assets based on the asset type
in the Asset Type column:
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5. Choose Groups from the toolbar and select the AIG that you want to edit.

ò Result
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The AIG fields get added to the view. If required, you can further filter, group or sort your
assets based on the AIG field values.

6. Select all the items that you want to update from the displayed assets (for example, you can use
CTRL+A to select all items), and click Edit.

ò Result

A dialog appears that contains all the fields of the selected AIG. In case the assets have
different values for a given field, the value appears as (multiple values).

7. Edit the field values in the AIG as required. For more information about this tab, see Asset Information
Groups (AIGs).

8. Click OK to apply the changes.
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ò Note

To be able to edit AIG data for multiple assets, you must have exactly one asset information group
selected under Groups, and the assets you select must all be of types that have that AIG assigned to
them.

10.2.12.3 Children Toolbar

Toolbar Option Description
Children → Edit This button can be used to edit asset information. The Edit button is only

enabled if you have exactly one AIG group selected under the Groups
toolbar button, and you have one or more assets selected in the list, that
have that AIG assigned to them. This button is useful for editing asset
information data on many assets at once. When you have multiple assets
selected in the Children grid, it follows the usual rules of Multi-Edit. For
more information, see Edit AIGs (Individually/in Bulk).

Children → Export This is shared functionality. Refer to Export for a full feature description.
Children → Groups Shows all AIGs that are assigned to the asset types of the visible assets in

the grid. Select or deselect which AIGs or Sub-AIGs to view in the data
grid.

Children → Filters →
Show All Children

Displays all children of the currently selected asset (multiple levels of the
hierarchy) if it is selected.

Children → Filters →
Show Selected Asset

Displays the selected asset and its direct descendants if it is selected, if it
is not selected, the grid will only show the direct descendants without the
selected asset in the hierarchy.

Children → Navigate Changes the active asset in the asset tree to the currently selected asset in
the data grid. By navigating to a different asset in the hierarchy, this will
also update the contents of data grid.

Children → Customise See Toolbar → Customise for information about the Customise toolbar
option.

Children → Connections See Toolbar→Connections for information about the Connections toolbar
option.

Children → Shortcuts If your database has shortcuts on assets (which by default, databases do),
they will appear here, in addition to appearing in the ASSETS screen’s
main toolbar menu.

10.2.13 Charts
You can view charts that are relevant for the selected asset’s type on the Charts tab of the ASSETS screen.

10.2.13.1 Prerequisites

Charts are generated from preconfigured chart templates. To enable displaying charts for an asset, the relevant chart
templates must have been configured as described in Configure Chart Templates.

10.2.13.2 Display Charts

To expand/collapse each chart, click the button at the top right of that chart, or click the chart’s grey header row.

� Tip
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Click on the chart area and then, with the mouse cursor still inside the chart area, use your mouse wheel
to increase/decrease the chart scale.

Note the following:

• Available charts are listed alphabetically. The first chart will be automatically expanded.

• Events with findings are shown on the chart in red.

• For some chart templates, at the right or the bottom of the chart is the chart legend. If you hover the mouse over
an item on the legend, other series on the chart will fade out temporarily. If you click an item on the legend, that
series will be toggled on/off. If you export the chart, only series currently visible will be exported.

10.2.13.3 Chart Width

When the Charts tab is 1000 pixels wide or less, all charts are shown at the full width of the tab. When the Charts tab
is over 1000 pixels wide, some charts are shown full width, and some are shown half width, in order to fit more charts
side-by-side onto your screen.

Charts that have an X axis of type string, date, or date/time, or whose X axis includes ‘KP’ are always shown full width.
You can adjust the width of all charts by adjusting the width of the whole application window, adjusting other elements
such as the asset tree wider/narrower, and so on.

10.2.13.4 Zooming

At the bottom of most chart templates, below the horizontal scrollbar (if visible) is the Zoom Bar. You can hover the
mouse over the left or right end of the selected part of the Zoom Bar and drag to change the selection. Initially the
entire Zoom Bar will be selected, so hover the mouse over the left or right end of the bar and drag. Once a subset of
the chart is selected, you can use the scroll bar or the Zoom Bar to drag the whole selection area without zooming.

You can also zoom in or out by clicking in the chart area and (with the mouse cursor still inside the chart area) spinning
the mouse wheel. For charts with a lot of data (thousands of events) this can be slow, so the Zoom Bar may be faster.
You can zoom on a single axis by putting the mouse pointer over that axis and spinning the mouse wheel. Not all charts
support zooming in both axes.

You can also control zoom with toolbar buttons Zoom In, Zoom Out, and Reset Zoom.

10.2.13.5 Charts Toolbar

There is no toolbar for the whole Charts tab. Instead, each chart has its own toolbar.
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But-
ton

Description

Zooms the image in.
Zooms the image out.
Resets to default zoom level.
Opens the Export dialog, from which you can generate images from the chart. Ensure the
range you want is set correctly using the Zoom Bar. Ensure the series you want to export are
visible. If you want to export the chart as a series of images, each covering a smaller horizontal
range, enter the range you would like each chart to cover in the Range of X Axis per image
field. For example, if you have a 300 km pipeline and you enter “10” as the range per image,
it will be broken into 30 images, each covering 10 km.
Copies the chart, as you see it displayed, without the “zoom” section at the bottom, to the
clipboard.

Expands/collapses the display of this chart.

10.2.13.6 Report Table Sources

To extract chart template data into a report template, use a Chart Template element in the report, and use the appropriate
Event table as a source. For more information see Configure Report Templates.
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CHAPTER

ELEVEN

LIBRARY

The Library functionality allows you to link electronic documents (library items) to data and data types in NEXUS
IC.

The main functionality is available from the LIBRARY screen of NEXUS IC:

On this screen, you can maintain the following three types of data:

• Library types, which allow you to group several library items into categories (see Library Types)

• Library items, which are the actual electronic documents that you can assign to data records in NEXUS IC (see
Library Items)

• Library connections, which are the actual links between a library item and a record (see Library Connections)

ã See also

• Library Types

• Library Items

• Library Connections

11.1 Library Types
Library types are categories that are assigned to library items (see Library Items).

You can group several library items under a library type. Once you have created a library type, you can add library
items to it as required.
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You use the standard toolbar functions on the top of the LIBRARY screen to add, edit, delete, import, export library
types, customise the grid layout or generate reports. For more information about these functions, see Using the Grid.

ò Note

• From this toolbar, you can edit the properties of the selected library type, not the library item
properties or the document itself.

• If there are library items that have been assigned to the library type that you are attempting to
delete, you will be unable to delete the library type until all library items have been reassigned.

11.1.1 Add Library Types
To create a new library type, proceed as follows:

1. On the LIBRARY screen, choose Add from the top toolbar.

2. Enter a name for the library type (mandatory) and select whether you want the library items under the library
type to be displayed on the Drawings tab of the ASSETS screen (see Drawings).

3. Click OK.

4. Add library items to the library type on the Library Items tab (see Library Items).

11.1.2 Assign Library Items to Library Types
You can assign library items to library types in the following ways:

• On the LIBRARY screen, select the library type and on the Library Items tab, add a library item to it as required
(see Library Items). The selected library type is automatically filled in the Add Library dialog.

• You can assign/reassign a library type to a library item whenever you add or edit a library item from any screens.

ã See also

• Library

• Library Items

• Library Connections

11.2 Library Items
On the LIBRARY screen, library items are displayed on the Library Items tab and are filtered by the currently selected
library type. You can view the properties of a selected library item on the Details tab at the bottom of the screen.

Library items are electronic documents that can be linked to data and data types in NEXUS IC using connections (see
Library Connections).
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The electronic documents can be uploaded directly into the NEXUS IC database, or can be referenced using URL or
UNC paths.

11.2.1 Manage Library Items
You can manage library items from several screens within NEXUS IC, including:

• Library Items tab on the LIBRARY screen (see Library)

• Library tab on the ASSETS screen (see Library)

• Library tab on the INSPECTION screen (see INSPECTION)

• Library tab on the ANOMALIES screen (see ANOMALIES)

• Library tab under Configuration → General → Functions → Edit Function Definition

• Library tab on the Edit Asset Type dialog under Configuration → Assets → Types

• Library tab on the Edit Table Definition dialog under Configuration → Events → Event Types →
Edit Table Information

Example
If you upload company piping specifications to the NEXUS IC Library and assign it to the asset type
“Pipework”, the piping specifications will be available from the Library* tab of the ASSETS screen when-
ever the active asset is of type “Pipework”.

You can also maintain library items on the Library pane of IC-Inspection.

You use the standard toolbar functions on the Library/Library Items tab to add, edit, delete, import, export library items
or customise the grid layout. For more information about these functions, see Using the Grid.

ò Note

• You can edit the properties of the selected library item from the toolbar, but not the document
itself.

• Deleting a library item will also delete all its associated connections.

• The Export option only exports the grid contents, not the actual library documents.

See below for more information about some actions you can perform on library items:

ò Add Library Items

To create a new library item, proceed as follows:
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1. Start adding a new library item in one of the following ways:

• On the Library/Library Items tab, choose Add from the toolbar.

• Drag files from your file explorer onto the Library/Library Items tab.

ò Note

Drag-and-drop is not supported in remote environments (e.g., Remote Desktop).

2. Depending on the screen from which you accessed the Library tab, you may be prompted to select a con-
nection type. You can connect a library item to different types of data records:

Screen Connection Type
ASSETS

• Asset
• Asset Type

INSPECTION
• Asset
• Asset Type
• Event
• Event Type
• Workpack

ANOMALIES
• Anomaly
• Asset

ò Note

If you’re adding a library item from the LIBRARY screen, you add the connection to a data record from
the Connections tab after you have created the library item. For more information, see Add Library
Connections.

3. In the Add/Edit Library dialog, select the library type, enter a name for the library item (mandatory) and
enter other parameters as required. For information about filling in all the parameters, see Add/Edit Library
Dialog.

• If the document is to be uploaded into NEXUS IC, then click on the Attachment button, else enter a
Hyperlink location.

• When adding an attachment, you can either Import or Link it:

– If you import, the item will be saved to the database. If you subsequently change the original on
disk, the item in the database will not change to match.

– If you link the item, then when you change the original on your disk, the next time you view the
item within NEXUS IC, you’ll see the updated item.
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ò Note

• NEXUS IC still loads a copy of a linked item into the NEXUS database. This ensures
that if the original is unavailable (for example, because you are away from your network),
NEXUS IC can display the cached copy.
When you view the item, if the original has been updated, the database cached copy is
updated too. You can’t link items that are on your local hard disk, only items on network
drives can be linked. The Link feature is designed to keep you up-to-date with items
that may have been changed by others, and that is not possible on your local drive.

• If you drag and drop multiple files, they will be added, and then multi-selected in the
grid. You can then click Edit to multi-edit them (see Multi-Edit). Drag and drop will
import items, not link them.

4. Click OK.

On the LIBRARY screen, you can view the details of the library item by selecting it and checking the Details
tab under the Library Items tab.

ò Edit Library Items

To edit an existing library item, proceed as follows:

1. On the Library/Library Items tab, select the library item.

2. Choose Edit from the toolbar.

3. In the Edit Library dialog, update data as required. For more information, see Add/Edit Library Dialog.

4. Click OK to save your changes.

ò Delete Library Items

To delete an existing library item, proceed as follows:

1. On the Library/Library Items tab, select the library item.

2. Choose Delete from the toolbar.
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3. In the confirmation dialog, click Check Connections if you want to review any connections to this library
item before deletion.

4. If you want to proceed deleting the library item, click Delete, else, choose Cancel.

ò Launch Library Items

Use the Launch toolbar button to launch library items on the local machine. By default, NEXUS only launches
files with the following extensions: doc, docx, xls, xlsx, jpg, png, jpeg, jfif, bmp, tiff, gif, mpg, mp3, wav, ppt, pptx,
txt, pdf, emf, zip, dwg, avi, rtf, mp4, csv.

� Hint

Use the Space Bar on your keyboard to launch the currently selected library item.

Note that if the local machine does not have an associated viewer for the document type (for example, AutoCad
viewer for DWG type), then the document can not be launched.

ò Email Library Items

Use the Email toolbar button to send an email message with the selected library items attached to it.
You can select multiple library items to be sent in the same email message. Note that you must have
properly configured your email settings (see Set Up Email) for this option to function.

. Warning

If the size of the attachment exceeds your organization’s attachment size limit, you may get an “Out
of memory” error message.

ò Import Library Items

You can import library items using the standard Import toolbar option (see Import). You can download the MS
Excel Import Template, which shows the required format for importing library items.

You can also import the Connections in the same import as the library items, so in addition to the Library Import
columns, you can additionally define the Connection information using the following column headings:

• Library Connection.Connect To

• Library Connection.Workpack

• Library Connection.Asset Type

• Library Connection.Asset

• Library Connection.Event Type

• Library Connection.Event

• Library Connection.Anomaly

• Library Connection.Risk Model
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• `Library Connection.Function

Note that the Connect To column should only contain one of the following text items:

• Anomaly

• Asset

• Asset Type

• Event

• Event Type

• Function

• Risk Model

• Workpack

11.2.1.1 Double-click

The first time you double-click on a library item, NEXUS asks you whether you want to launch the library item in
an external editor, or edit the library item. If you want your choice to become permanent, tick the Always do this
checkbox. Note that if you hold down the Alt key while double-clicking, you will be asked again.

ã See also

• Library

• Library Types

• Library Connections

11.3 Library Connections
A library connection is a link between a library item and a data record. Each library item can have one or more
associated connections.

You can create the following types of connections:

• Asset: Links a library item to one or more specific assets.

• Asset Type: Links a library item to an asset type.

• Event: Links a library item to a discrete event.

• Event Type: Links a library item to an event definition.

• Workpack: Links a library item to one or more specific workpacks.

• Anomaly: Links a library item to an anomaly.

• Risk Model: Links a library item to a risk model.

• Function: Links a library item to a function.
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11.3.1 Manage Library Connections
Use the standard toolbar functions on the Connections tab of the LIBRARY screen to add, edit, delete, import, or
export library connections for the selected library item. You can also customise the grid layout. For more information,
see Using the Grid.

ò Note

• From this toolbar, you can edit the properties of the selected library connection, not the library
item properties or the document itself.

• Deleting a library connection only removes the selected connection. The library item itself re-
mains unaffected.

11.3.1.1 Add Library Connections

To create a new library connection, proceed as follows:

1. On the Library Items tab of the LIBRARY screen, select the library item for which you want to set up a library
connection.

2. Go to the Connections tab at the bottom of the screen and click Add in the toolbar.

3. From the drop-down menu, select the type of connection that you want to create.

4. Select the required connections from the selection dialog.

5. Click OK.

ã See also

• Library

• Library Types

• Library Items
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TWELVE

PLANNING AND WORKPACKS

During the planning phase, you set up the actual tasks to be carried out during inspections. Each task must be assigned
to a workpack, which is a collection of tasks and events and is a central part of planning. Optionally, you can set up
planning templates, which allow you to automatically set up future workpacks through the use of planning tasks that
repeat on either a fixed or dynamic (calculated) frequency.

For more information about how the planning phase is integrated into the whole workflow, see NEXUS Workflow.

You check and maintain all planning-related activities on the PLANNING and WORKPACKS screens as follows:

ã See also

• Configure Planning Data
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• PLANNING Screen

• WORKPACKS Screen

• Tasks

• Workpacks

12.1 PLANNING Screen
On the PLANNING screen, you can perform the following actions:

• Review the task schedule by asset tree (see Check Schedule by Asset Tree)

• Manage tasks (see Tasks)

• Manage planning templates and planning tasks (see Planning Templates)

• Assign and review risk models (see Risk)

• Schedule shutdowns (see Shutdowns)

• Edit task instructions (see Task Instructions)

12.1.1 Check Schedule by Asset Tree
The upper section of the PLANNING screen displays tasks in a calendar view, organised by asset. Each task appears
as a dot with two colours:

• Outer ring: Indicates task completion (green = complete, red = incomplete)

• Inner dot: Represents the event type (colour is configurable, see Configure Event Types).

The date shown for each task in the calendar corresponds to the actual start date of the associated workpack.

Hovering over a task dot reveals a tooltip with details such as the task description, workpack, event type, completion
status, and any linked anomaly actions.
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On this screen area, you have the following options:

• Assets Filter → Show Task Completion: Toggle the outer ring display to show task completion status.

• Calendar Granularity: Choose between Monthly, Quarterly, Half Yearly, or Yearly views to adjust the
calendar granularity. For example, if you select Monthly, there will be one column for each calendar month.

• Asset Views and Assets toolbar options: Use these options as on the ASSETS screen, see Asset Views and Assets
Toolbar. Note that on the PLANNING screen, not all options may be available.

12.1.2 Planning Toolbar

Toolbar Option Description
Asset Views See Asset Views.
Assets See Assets Toolbar.
Assets Filter → Show
Task Completion

Activates or deactivates the display of task completion in the outer ring
of the dot. When selected, each task in the calendar will be outlined with
a green (complete) or red (incomplete) circle identifying the completion
status of that task.

Monthly/Quarterly/Half
Yearly/Yearly

Allows you to choose the ‘resolution’ of the grid. For example, if you
select Monthly, there will be one column for each calendar month.

Reports See Reports.

ã See also

• Planning and Workpacks

• Tasks

• Planning Templates

• Risk

• Shutdowns

• Task Instructions

12.2 WORKPACKS Screen
On the WORKPACKS screen, you can perform the following actions:

• Add, edit or delete workpacks (see Workpacks)

• Review workpack details and check the schedule of tasks by workpacks (see Check Schedule by Workpack)

• Manage tasks (see Tasks)

• Assign and review risk models (see Risk)

• Schedule shutdowns (see Shutdowns)

• Export workpack summary (see Workpack Summary)
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12.2.1 Check Schedule by Workpack
In the top half of the WORKPACKS screen, you can see a list of workpacks with their details and a Gantt chart that
shows the start and end date for each workpack in a calendar form.

On this screen area, you have the following options:

• Add, edit, or delete workpacks: See Workpacks.

• Change calendar granularity: Use the Monthly, Quarterly, Half Yearly, or Yearly toolbar but-
tons to adjust the time scale. For example, selecting Monthly displays one column per calendar
month.

• Go to Today: Scrolls the calendar to the current date. This button is inactive if the calendar does
not cover today’s date (because all your workpacks are in the past, or all your workpacks are in the
future, or no workpacks have start/end dates).

• Go to Workpack: Scrolls the calendar to the start date of the selected workpack. If multiple work-
packs are selected, it scrolls to the last one selected.

� Tip

Use the grid Grouping functionality to group and filter workpacks. It is a quick and easy way to drill
down to the workpacks that you are particularly interested in reviewing. By default, this grid is grouped
by Revision.

If you select a workpack in the list, the tasks included in the workpack is displayed on the Tasks tab in the bottom half
of the screen. For more information, see Tasks.
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12.2.2 Workpack Toolbar

Toolbar Option Description
Add See Create Workpacks Manually.
Edit See Edit Workpacks.
Delete Deletes the selected workpack.
Monthly/Quarterly/Half
Yearly/Yearly

Allows you to choose the ‘resolution’ of the grid. For example, if you
select Monthly, there will be one column for each calendar month.

Go to Today Scrolls the calendar to the current date. This button is inactive if the cal-
endar does not cover today’s date (because all your workpacks are in the
past, or all your workpacks are in the future, or no workpacks have start/end
dates).

Go to Workpack Scrolls the calendar to the start date of the selected workpack. If multiple
workpacks are selected, it scrolls to the last one selected.

Connections See Connections.
Import See Import.
Export See Export.
Customise See Customise.
Reports See Reports.

12.2.3 Report Table Sources
To extract workpack data into a report template, use the System Table titled Workpack as the primary Table Source.
For more information see Configure Report Templates.

ã See also

• Planning and Workpacks

• Workpacks

• Tasks

• Risk

• Shutdowns

• Workpack Summary

12.3 Tasks
Tasks are work to be done. Often (but not always) this is inspection work. Typically, you specify an asset that the task
is to be done on, and an event type specifying the type of work to be done. For example, if the task is to carry out a
GVI of the asset, you would specify event type ‘GVI’.

Tasks are grouped into workpacks.

In NEXUS IC, you can maintain tasks on the Tasks tab page, which is available on the PLANNING and WORKPACK
screens. On this tab page, you can use the standard grid functions, including:

• Adding/Editing/Deleting tasks (see Using the Grid)

• Importing (see Import) and exporting tasks (see Export)

• Customising the layout of the grid (see Customise)
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• Checking the selected item’s connections (see Connections)

You can also show or hide the Task Instructions pane. Task instructions can come from the task’s event type, from its
planning template, or from the task itself. These instructions are shown in a pane on the right.

On the PLANNING screen, you have the option to show tasks for the currently selected asset and all the related child
or parent assets.

For detailed information about task-related activities, see the sections below:

• Create Tasks

• Assign Tasks

• Reschedule Tasks

• Complete Tasks

12.3.1 Report Table Sources
To extract task data into a report template, use the System Table titled Task as the primary Table Source. For more
information see Configure Report Templates.

ã See also

• Planning and Workpacks

• Workpacks

• PLANNING Screen

• WORKPACKS Screen

12.3.1.1 Create Tasks

You can create tasks in NEXUS IC in the following ways:

• You can manually create tasks on the PLANNING or WORKPACKS screen (see Create Tasks Manually).

• You can also import tasks from the Tasks tab page on the PLANNING or WORKPACKS screen (see Import).

• Tasks are automatically created when a planning template is applied (see Planning Templates).

• You can raise a task as a result of an anomaly action. For example, in a previous inspection, you might have
noted some fault by logging an event and logging a finding on that event, or NEXUS might have noticed that a
data value was outside acceptable bounds and log a finding for you. You may then create an anomaly to track
that problem, then create an anomaly action as your intended solution to the problem, and then create a task and
link it to that anomaly action, so that the remediation gets carried out as part of a particular workpack.

• You can also create a task as a continuation of an existing task: if you get partway through a task and are then
forced to stop (by end of day, by weather, etc.), you may log a continuation task for the remainder of the work.

12.3.1.1.1 Create Tasks Manually

1. On the PLANNING or WORKPACKS screen, go to the Tasks tab and choose Add.

2. In the Add Task dialog, select the asset to which you want to assign the task and specify other parameters as
required. Assigning a workpack and an event type is mandatory. For information about how to fill the fields in
the dialog, see Add/Edit Task Dialog.

3. Click OK to save the task.
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ò Result

The task is created and displayed in the list of tasks on the Tasks tab.

12.3.1.1.2 Create Ad Hoc Tasks

You can create ad hoc tasks when you create or edit a regular task and select the Adhoc Task checkbox in the Add
Task or Edit Task dialog (see Add/Edit Task Dialog). When you change a regular task to an ad hoc task, the available
fields and screen options change.

In IC-Inspector, when an inspector selects an ad hoc task and fills out the form, the task will not vanish from their list
— it will be available for them to complete again and again. You only need to create one ad hoc task of each type, as
a single ad hoc task will be available on all assets. You should create that task on the highest-level relevant asset that
has that event type available. Ad hoc tasks are suitable for events like “Damage”, where you want inspectors to be able
to note any damage they see, even if it’s not part of the explicitly-tasked scope.

12.3.1.2 Assign Tasks

To ensure that tasks appear on an inspector’s task list, you must assign tasks to the inspector. To do that, follow the
steps below:

1. On the PLANNING or WORKPACKS screen, on the Tasks tab, select the relevant tasks (you can use multi-
select) and choose Edit.

2. In the Edit Task dialog, select the required inspector in the Assigned To field. You can click Add on the picker
to create a new inspector.

3. Click OK to save the task.

ò Result

The next time the inspector clicks Sync in IC-Inspector, they will receive their tasks.

ò Note

In case you do not assign an ad hoc task to an inspector, it will still be synchronised to all inspectors
that have at least one assigned task in the same workpack.

12.3.1.3 Reschedule Tasks

Reschedule allows for planning template tasks to be moved from one workpack to another.

To reschedule tasks, proceed as follows:

1. On the PLANNING or WORKPACKS screen, on the Tasks tab, select the relevant tasks (you can
use multi-select) and choose Reschedule from the toolbar.

2. In the Select Workpack dialog, select the workpack to which you want to reassign the planning
template task.

3. Click OK to move the task to the selected workpack.
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4. On the PLANNING screen, go to the Planning Templates tab and select the planning template that
has been changed due to rescheduling.

5. Choose Update in the toolbar to update the planning template.

ò Note

You can only reschedule tasks that are associated with a planning template. The reschedule option is
not available for tasks that have been imported or manually created.

12.3.1.4 Complete Tasks

Tasks can be marked as completed in the following ways:

• Inspectors can directly complete tasks in IC-Inspector (see Complete Tasks).

• Tasks can get completed when an event is created directly from the task in IC-Inspection (see Complete Tasks).

• Tasks can get completed from the Incomplete Tasks pane on the INSPECTIONS screen of NEXUS IC when
you perform one of the following actions:

– You launch the task.

– You manually link the task to an existing event.

For more information, see Incomplete Tasks.

• You can complete ad hoc tasks in NEXUS IC when you edit the task on the PLANNING or WORKPACKS
screen and tick the Adhoc Complete checkbox in the Edit Task dialog.

12.4 Workpacks
A workpack is a collection of tasks and events.

Workpacks can be created in the following ways:

• Automatically by means of Planning Templates

• Manually created from the WORKPACKS screen or from wherever the Add Workpack dialog is triggered

• Bulk imported from MS Excel (see Import)

• Automatically via connection with a corporate ERP / CMMS

You perform workpack-related activities on the WORKPACK screen. For more information about navigating on the
screen, see WORKPACKS Screen.
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12.4.1 Configuration
You can set up cost codes, define workpack groups and workpack revisions in your configuration settings. For more
information, see Configure Planning Data. You can also make these settings when you’re editing workpacks.

12.4.2 Manage Workpacks
You can create, edit, delete, import or export workpacks from the main toolbar of the WORKPACKS screen. For more
information, see the sections below:

• Create Workpacks Manually

• Edit Workpacks

• Import

• Export

ã See also

• Planning and Workpacks

• WORKPACKS Screen

• Create Workpacks Manually

• Edit Workpacks
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12.4.2.1 Create Workpacks Manually

To create a new workpack, proceed as follows:

1. On the WORKPACKS screen, choose Add from the top toolbar. Alternatively, you can start creating a workpack
by choosing Add whenever you select a workpack from the Select Workpack dialog. (For example, this dialog
can be triggered when you assign a workpack to a task whenever you create or edit a task.)

2. In the Add Workpack dialog, enter a name for the workpack (mandatory) and specify other parameters as
required. For more information about specifying the parameters, see Add/Edit Workpack Dialog.

3. Click OK to save the workpack.

ò Result

The workpack is created and displayed in the list of workpacks on the WORKPACKS screen (see WORK-
PACKS Screen).

ã See also

• Workpacks

• WORKPACKS Screen

12.4.2.2 Edit Workpacks

Once you have created a workpack, you can update its properties, assign library items to it or check the planning
templates associated with it as follows:

1. On the WORKPACKS screen, select the relevant workpack and choose Edit from the top toolbar.

2. In the Edit Workpack dialog, you can:

• Update the properties, reassign workpack group, revision or asset on the Workpack tab.

• Review or add associated asset history records linked to the workpack asset on the Asset History tab.

• Add a library item to the workpack on the Library tab.

• Check the associated planning templates on the Associated Planning Templates tab.

For more information, see Add/Edit Workpack Dialog.

3. Click OK to save the workpack.

ã See also

• Workpacks

• WORKPACKS Screen

12.5 Planning Templates
Planning templates are records on which workpacks and tasks are generated.

Planning templates allow you to automatically set up future workpacks (groups of inspection or testing tasks). A
planning template is a group of planning tasks. When you apply the planning template, a planning task becomes a task
in a workpack.
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ò Note

By default, new workpacks are created when you apply planning templates, however, you can also
select existing workpacks to which you want to assign the future tasks.

You can manage planning templates on the Planning Templates tab either on the PLANNING screen or the ASSETS
screen. See below for more information:

• Create Planning Templates

• Check Summary

• Manage Planning Tasks

• Apply Planning Templates

• Update Planning Templates

See Worked Examples for step-by-step guide on how to configure and maintain planning templates.

12.5.1 Report Table Sources
To extract Planning Template data into a report template, use the System Table titled Planning Template as the primary
Table Source. For more information on Report Templates see Configure Report Templates.

ã See also

• PLANNING Screen

• WORKPACKS Screen

• Planning and Workpacks
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• Worked Examples

12.5.1.1 Create Planning Templates

To create a new planning template in NEXUS IC, follow the steps below:

1. On the ASSETS or PLANNING screen, go to the Planning Templates tab and choose Add.

2. In the Add Planning Template dialog, enter a name for the planning template (mandatory) and specify other
parameters as required. For more information about specifying the parameters, see Add/Edit Planning Template
Dialog.

3. Click OK to save the planning template.

ò Result

The planning template is created and displayed in the list of planning templates on the Planning Templates
tab.

ã See also

• Example: Create Planning Template and Asset Task with Manual Repeat

• Worked Examples

• Planning Templates

12.5.1.2 Check Summary

When editing a planning template, you can review the details of the planning template and its associated planning tasks
on the Summary tab of the Edit Planning Template dialog.

The screen on the Summary tab has two main parts:

• The top half of the dialog is a visual summary showing the tasks that will be created once the planning template
is applied (see below for more information).

• If you toggle the Tasks button in the toolbar on, you can see a list of the planning tasks at the bottom of the
dialog. Here you can create and manage planning tasks. For more information, see Manage Planning Tasks.

12.5.1.2.1 Visual Summary

In the top half of the dialog, you can see the asset tree, which is filtered from the Base Asset that you have set up in the
Planning Template properties (see Add/Edit Planning Template Dialog). If no Base Asset has been defined, then the
entire tree for the default Asset View is displayed.

Each planning task is represented by a coloured circle in the summary against their asset in the asset tree displayed in
a calendar form. Here you can see where the tasks will be created once the planning template is applied. The number
of Occurrence columns displayed on the right of the asset tree is equal to the number of Occurrences defined in the
planning template. Each occurrence will be represented by a workpack after the planning template has been applied.
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12.5.1.3 Manage Planning Tasks

You can create, update and delete planning tasks as described below:

• Create Planning Tasks

• Update Planning Tasks

• Delete Planning Tasks

• Assign Anomaly Action to a Planning Task

12.5.1.3.1 Create Planning Tasks

1. On the ASSETS or PLANNING screen, go to the Planning Templates tab.

2. Select the planning template to which you want to assign the planning task and choose Edit from the

toolbar .

3. In the Edit Planning Template dialog, go to the Summary tab and ensure that Tasks in the

toolbar is toggled on .

4. In the bottom part of the dialog, choose Add from the toolbar .

5. In the Add Planning Task dialog, you must specify the following (mandatory fields):

• You must define either the Asset or the Asset Type to which you want to assign the planning
task. If you specify an asset type, tasks will be created for all assets of the specified type using
the frequency.

• You must enter the event type.

6. Specify other parameters as required. For more information about specifying the parameters, see
Add/Edit Planning Task Dialog.

7. Click OK to save the planning task .
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ò Result

The planning task is created and displayed on the Summary tab of the Edit Planning Template
dialog.

12.5.1.3.2 Update Planning Tasks

1. On the ASSETS or PLANNING screen, go to the Planning Templates tab.

2. Select the planning template that contains the planning task and choose Edit from the toolbar.

3. In the Edit Planning Template dialog, go to the Summary tab and ensure that Tasks in the toolbar is toggled
on.

4. In the bottom part of the dialog, select the required planning task and choose Edit from the toolbar.

5. In the Edit Planning Task dialog, make your updates as required. For more information, see Add/Edit Planning
Task Dialog.

6. Click OK to save the planning task.

7. After each update of a planning task, you must update the relevant planning template as well. For more informa-
tion, see Update Planning Templates.

12.5.1.3.3 Delete Planning Tasks

Deletion of a planning task works slightly differently to the deletion of other items within NEXUS. For all other types of
items in NEXUS, clicking the Delete button deletes the item. However, if you have applied the planning task to create
one or more tasks, the planning task is not deleted directly but instead, an IsDeleted flag is applied to the planning task.
This ensures that NEXUS knows that those tasks were created from this planning task. Once all the tasks that were
created from that planning task are deleted, the planning task will also be removed from the underlying database table.
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Consider the case where you want to delete an event definition. First, you must delete everything that depends on that
event definition. This includes planning tasks which use this event definition, but the way to remove those planning
tasks is to remove the tasks that in turn relied on that planning task. Once this is done, you should be able to delete the
event definition (which will delete all events of that type, and so on).

To delete a planning task, proceed as follows:

1. On the ASSETS or PLANNING screen, go to the Planning Templates tab.

2. Select the planning template that contains the planning task and choose Edit from the toolbar.

3. In the Edit Planning Template dialog, go to the Summary tab and ensure that Tasks in the toolbar is toggled
on.

4. In the bottom part of the dialog, select the required planning task and choose Delete from the toolbar.

ò Result

If you have not applied the planning task to create one or more tasks, the planning task gets deleted. If,
however, you have tasks created based on the planning task, the planning task gets the IsDeleted flag:

12.5.1.3.4 Assign Anomaly Action to a Planning Task

In case a planning task needs to be created as a result of an anomaly action, you can link the anomaly action to the
planning task as described below.

1. On the ASSETS or PLANNING screen, go to the Planning Templates tab.

2. Select the planning template that contains the planning task and choose Edit from the toolbar.
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3. In the Edit Planning Template dialog, go to the Summary tab and ensure that Tasks in the toolbar is toggled
on.

4. In the bottom part of the dialog, select the required planning task and choose Edit from the toolbar.

5. In the Edit Planning Task dialog, in the Anomaly Action field, click to select the anomaly action as required.

ò Note

You can create a new anomaly and anomaly action from here or you can choose an existing one. You can
only assign an anomaly action that is linked to the same asset and has the same event type (if defined in its
action type) as the planning task.

6. Click OK to save your changes.

ã See also

• Worked Examples

• Planning Templates

12.5.1.4 Apply Planning Templates

When a planning template is applied, tasks are created based on the planning tasks and they are assigned to a workpack.

To apply a planning template, proceed as follows:

1. On the ASSETS or PLANNING screen, go to the Planning Templates tab and select the
planning template.

2. Click Apply in the toolbar to launch the Apply Planning Template wizard.

3. Set up the Occurrences to define how far into the future you want to create workpacks.
Specify either of the following:

• In the Specific Date field, enter the end date when the last workpack needs to be
created. This will automatically calculate the number of occurrences to apply based
on the frequency that you have set up for the planning template.

• In the Number of Occurrences field, define how many future workpacks you want be
created. This will automatically calculate the future dates for the workpacks based on
the frequency that you have set up for the planning template. For example, if you enter
10, and the frequency is Yearly, 10 years of future workpacks will be created.

4. Click Next.
5. Specify the workpack for each occurrence. You can choose either of the following:

• Create a new workpack for the tasks to be created in. In this case, leave the value
<New> in the Workpack column.
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• Choose an existing workpack. In this case, double-click the field in the Workpack
column, and choose the ellipsis to select a workpack.

6. Click Apply.

ò Result

The tasks and workpacks (if relevant) are created. You can now see them on the PLAN-
NING and WORKPACKS screens. You can check the workpacks that a planning tem-
plate has been applied to on the Applied To tab of the Edit Planning Template dialog
when editing a planning template.

ò Note

You can also use multi-select to apply several planning templates at once. In this case, all the selected
planning templates must have the same frequency, and you won’t be able to select workpacks to apply
the planning templates to, new workpacks will be created for each.

ã See also

• Worked Examples

• Planning Templates

12.5.1.5 Update Planning Templates

Whenever you change the schedule or frequency of planning tasks, you must update the relevant planning template
to ensure that previously generated workpacks and tasks are updated accordingly. To update the planning template,
proceed as follows:

1. On the ASSETS or PLANNING screen, go to the Planning Templates tab and select

the relevant planning template .

2. Choose Update from the toolbar.

3. In the dialog that pops up, review the proposed changes to existing tasks and view new

tasks. The dialog shows all changes that will be applied once you click the Update
button.

4. Click Update.

ò Result

Changes to the tasks are applied and the planning template is updated accordingly.

12.5. Planning Templates 419



NEXUS Documentation, Release 6.9.xxxxx.0

ò Note

• You can also use multi-select to update several planning templates at once. In this case, up-
dates to each planning template are represented on separate tab pages in the Update Planning
Template dialog.

• When you update a planning template, the changes are made inside a database transaction. This
means that changes can be rolled back in the event of a problem (such as loss of database con-
nection partway through the process). However, since SQL Server can handle at most one open
transaction at a time, any other copy of NEXUS IC that attempts to carry out updates (or poten-
tially other planning template changes) will be blocked until the update process completes.

ã See also

• Worked Examples

• Planning Templates

12.5.1.6 Worked Examples

See below for worked examples about managing planning templates and planning tasks:

• Example: Create Planning Template and Asset Task with Manual Repeat

• Example: Update Frequency for Planning Task

• Example: Change Manual Repeat to Lookup Repeat

• Example: Create Task for Asset Type with Lookup Repeat
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12.5.1.6.1 Example: Create Planning Template and Asset Task with Manual Repeat

In the following example, we create a ultrasonic testing inspection planning template for a subset of CML assets with
manual repeat.

1. Create a planning template.

a. On the ASSETS or PLANNING screen, go to the Planning Templates tab and choose

Add .

b. In the Add Planning Template dialog, enter data as follows:

• Name: Choose a name that best describes your planning template.

• Base Asset: Select a parent asset, which will behave as a filter in later screens.

• Frequency: Select Yearly, which means that a task will be created on a yearly basis.

• Occurrences: Enter 10, which means that we will be able to view 10 columns on the Sum-
mary tab (see next step).

• Format: Enter [yyyy] SPE Ultrasonic Testing, which means that when the workpacks are
automatically generated, they will be named 2024 SPE Ultrasonic Testing, 2025 SPE Ul-
trasonic Testing, 2026 SPE Ultrasonic Testing and so on.

For more information about the parameters in this dialog, see Add/Edit Planning Template
Dialog.

c. Click OK to save the planning template.

2. Create the planning template tasks.

a. Select the planning template you created in the previous step on the Planning Templates

tab and choose Edit from the toolbar .

b. In the Edit Planning Template dialog, go to the Summary tab and ensure that Tasks

in the toolbar is toggled on .
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c. In the bottom part of the dialog, choose Add from the toolbar .

d. In the Add Planning Task dialog, specify the following:

• Asset - Select the asset for which you want to create the task.

• Event Type - Select the Ultrasonic Testing event type.

• Start - Enter 1 as the first occurrence that this task should occur.

• Repeat - Enter 3 to indicate that you want this task to be created at every third occur-
rence. In this case, since the planning template’s frequency is yearly, a task will be
created every third year after the first occurrence.

For more information about specifying the parameters, see Add/Edit Planning Task
Dialog.

e. Click OK to save the planning task .

ò Result

On the Summary tab, you can see where the tasks will be created once the planning template
is applied. Note that there are altogether 10 occurrences shown on the screen, as we have
defined 10 occurrences for the planning template.
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3. Apply the planning template.

Applying the planning template creates the workpack and task records.

a. On the ASSETS or PLANNING screen, go to the Planning Templates tab and select the plan-
ning template.

b. Click Apply in the toolbar to launch the Apply Planning Template wizard.

c. Set up the Occurrences to define how far into the future you want to create workpacks. In this
example, we want to create 10 years of future workpacks, thus, we enter 10 in the Number of
Occurrences field. All future dates will be will automatically calculated.

d. Click Next.
e. In the next dialog, we can specify the workpacks for each occurrence, either by choosing an

existing workpack or electing to create a new workpack for the tasks to be created in. In this
example, we want to create new workpacks, one in each occurrence (year) for 10 occurrences
(years), thus, we leave the value <New> in the Workpack column for each occurrence.
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f. Click Apply.

4. Check the workpacks.

Select the newly created workpacks on the WORKPACKS screen and view the tasks in that work-
packs. In this example, tasks have been created in the 2024 SPE Ultrasonic Testing, 2027 SPE
Ultrasonic Testing, 2030 SPE Ultrasonic Testing and 2033 SPE Ultrasonic Testing workpacks
(the 1st occurrence, then every 3rd occurrence after that).

ã See also

• Planning Templates

• Create Planning Templates

• Apply Planning Templates
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12.5.1.6.2 Example: Update Frequency for Planning Task

In this example, we want to update the planning task that we created in the previous example by increasing the frequency
of the UT inspection campaigns to every second year instead of every third. To do this, we edit the planning template
task by editing the Repeat field from 3 to 2, as follows:

1. Edit the relevant planning template to get to the Edit Planning Template dialog and go to the Summary tab.

2. Edit the required planning task (double-click it or select it and choose Edit).
3. In the Edit Planning Task dialog, change the value of the Repeat (Manual) field to 2).

4. Click OK.

ò Result

On the Summary tab, you can see that a task will be created every second year now:
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5. Update the planning template to ensure that previously generated workpacks and tasks are updated with the
revised frequency.

Follow the steps below:

a. On the Planning Templates tab, select the planning template that contains the updated task.

b. Click Update in the toolbar.

c. In the dialog that appears, review the proposed changes.

You can see that a new task will be created for 2026, which will be the second repeat now that we’ve changed
the frequency to every second year and the first occurrence was in 2024. You can also see that the task that
was created for 2027 will be moved to 2028 and the task that was created for 2033 will be moved to 2032.
Tasks that are unchanged are not shown, thus, we do not see the tasks for 2024 and 2030.

6. Click Update to apply the changes to the workpacks and tasks.

ã See also

• Update Planning Templates

• Manage Planning Tasks

• Planning Templates
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12.5.1.6.3 Example: Change Manual Repeat to Lookup Repeat

Most commonly, inspection frequencies are a moving target, in that frequencies tend to increase or reduce depending
on inspection results. Where corrosion rates are low, then inspection can be less often; when high, then inspection
needs to occur more often.

NEXUS IC allows for the frequency (Repeat) field to be an input from a field in an Asset Information Group (AIG).
Using the previous example, we will change the Repeat from static 3 to use a field from the Remaining Life AIG. Note
that frequency will only be calculated if the CML is identified as an Active Monitoring Location:

To update the planning task with the new frequency, proceed as follows:

1. Edit the relevant planning template to get to the Edit Planning Template dialog and go to the Summary tab.

2. Edit the required planning task (double-click it or select it and choose Edit).
3. In the Edit Planning Task dialog, remove the value from the Repeat (Manual) field and in the Repeat (Lookup)

field, select the field Inspection Frequency under the AIG Remaining Life.
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4. Click OK.

ò Result

On the Summary tab, you can see that a task will be created every fourth year now, since the Inspection
Frequency field in the Remaining Life AIG was defined to be performed every fourth year.

5. Update the planning template to ensure that previously generated workpacks and tasks are updated with the
revised frequency.

Follow the steps below:

a. On the Planning Templates tab, select the planning template that contains the updated task.

b. Click Update in the toolbar.

c. In the dialog that appears, review the proposed changes.
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You can see that the task that was created for 2027 will be moved to 2028 and the task that was created for
2030 will be moved to 2032. The task for 2033 will be deleted. Tasks that are unchanged are not shown,
thus, we do not see the task for 2024.

6. Click Update to apply the changes to the workpacks and tasks.

ã See also

• Update Planning Templates

• Manage Planning Tasks

• Planning Templates

12.5.1.6.4 Example: Create Task for Asset Type with Lookup Repeat

You can also configure planning tasks for asset types, so that instead of defining the particular asset, you define the
asset type, and tasks will be created for all assets of the specified type using the frequency.

In this example, we use the planning template that we created in our previous example and create a new planning task
for the asset type CML. Thus, every asset with the asset type CML under our planning template’s base asset (PP-PG-
CL01-P01Medium) will have Ultrasonic Testing tasks created based on the frequency that we define. In this example,
we set the first occurrence to 1 and for the frequency, we set up a lookup repeat using the same Inspection Frequency
field in the Remaining Life AIG as in our other example.

In this way, a single asset type planning task can potentially configure tasks for thousands of individual assets, based
on the data in each one of those assets.

To create the planning task, proceed as follows:

1. On the ASSETS or PLANNING screen, go to the Planning Templates tab and edit the planning

template for which you want to create the planning task .

2. In the Edit Planning Template dialog, go to the Summary tab and ensure that Tasks in the
toolbar is toggled on.

3. In the bottom part of the dialog, choose Add from the toolbar .

4. In the Add Planning Task dialog, specify the following:

• Asset - Select the asset for which you want to create the task.

12.5. Planning Templates 429



NEXUS Documentation, Release 6.9.xxxxx.0

• Event Type - Select the Ultrasonic Testing event type.

• Start - Enter 1 as the first occurrence that this task should occur.

• Repeat - Enter 3 to indicate that you want this task to be created at every third occur-
rence. In this case, since the planning template’s frequency is yearly, a task will be
created every third year after the first occurrence.

For more information about specifying the parameters, see Add/Edit Planning Task Dialog.

5. Click OK to save the planning task .

ò Result

On the Summary tab, you can see where the tasks will be created once the planning template is applied.
You can see that under the base asset, each asset that had the asset type CML now has a new task
created for the first occurrence and based on the frequency that was defined for the specific asset in
the Inspection Frequency field on the Remaining Life AIG, additional tasks have been added. For
assets that had no value in this field, no additional tasks have been created.
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6. Update the planning template to update the workpacks and create the new tasks as required.

Follow the steps below:

a. On the Planning Templates tab, select the planning template that contains the new plan-
ning task.

b. Click Update in the toolbar.

c. In the dialog that appears, review the proposed changes.

You can see that new tasks will be created for each asset with the asset type CML.

d. Click Update to apply the changes to the workpacks and tasks.

ã See also

• Manage Planning Tasks

• Update Planning Templates

• Planning Templates

12.6 Risk
You can display risk assessment results on the Risk tab of the PLANNING and WORKPACKS screen:

• On the PLANNING screen, you can display the risk assessment results for the assets that you have selected in
the asset tree above, and, if you choose the Child Assets toolbar button, results are also shown for all that asset’s
children.

• On the WORKPACKS screen, you can display the risk assessment results for the currently selected workpack’s
assets, and, if you choose the Child Assets toolbar button, results are also shown for all that asset’s children.

Results are graphically represented in pre-configured risk matrixes and in the data grid as shown in the example below:
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12.6.1 Prerequisites
To enable displaying risk models for assets, you must have made the necessary configuration settings and assignments
as follows:

• You must set up risk charts and risk models (see Configure Risk Charts and Configure Risk Models).

• You must assign the risk model to the asset type of the asset (see Assign Risk Models to Asset Type).

• You must assign the risk model to the asset (see Assign Risk Models and Scenarios).

12.6.2 Display Options
When displaying risk models, note the following:

• Where there are several risks at the same location in the chart, the dot will be shown larger.

• Clicking on a row in the grid highlights that item in the matrix. Similarly, clicking on a result indicator in the
matrix will highlight the relevant row (or rows) in the grid.

• If you are using scenarios, each scenario will be shown in its own colour. Scenario dots may be offset within the
risk square. In this case, this does not indicate a difference in risk, it is merely for legibility.

• If you click on a scenario dot within the matrix, the relevant rows in the grid will be highlighted, and the relevant
dots for those assets’ other scenarios will be highlighted in the matrix.

• If you want to see the total number of risk assessments at the specific locations of the risk models, click Show
Count.
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12.6.3 Risk Toolbar

Toolbar Option Description
Assign → Risk Model Choose from the list of pre-configured risk models in the drop-down menu

to assign a risk model to the currently selected asset. For more information,
see Assign Risk Models and Scenarios.

Edit Launches the Risk Assessment dialog. Any values in the risk assessment
can be edited and saved from this dialog by clicking in the Value column
of any Value type row (white rows). Note that Pass Thru and Calculation
values can not be edited. Clicking on a Factor or Model row however,
allows you to view the function and the function results that have been
assigned to that row. From here you can also assign Scenarios to this risk
assessment.

Delete Deletes the currently selected Risk Assessment from the asset to which it
is assigned. Note that the asset and all information linked to that asset will
remain unchanged.

Export See Export for full description of the Export menu item.
Customise See Customise for full description of the Customise menu item.
Child Assets Select to include risk assessments on all this asset’s children.
Navigate to Asset Changes the active asset in the hierarchy to the currently selected risk-

assessed asset. Note that this will filter the Risk grid so that only assess-
ments for the active asset will be shown.

� Hint

Use the Back toolbar button on the Assets toolbar to return
to the previously selected asset.

Copy Assessment Launches a dialog to copy risk assessment to selected assets dialog. From
here, select the assets which you want to assign the currently selected risk
model to. For more information, see Assign Risk Models and Scenarios.

Copy To Clipboard Copies the risk chart to the clipboard as an image.
Show Count When active, the matrix will overlay the total number (count) of risk as-

sessments at that location in the matrix, as shown in the following image:
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ã See also

• PLANNING Screen

• WORKPACKS Screen

12.7 Task Instructions
In NEXUS IC, you can define instructions for tasks in the following ways:

• You can set up task-specific instructions for individual tasks when you create or edit tasks in the Add Task/Edit
Task dialog. For more information, see Create Tasks and Add/Edit Task Dialog.

• Task-specific instructions can also be derived from the planning template task that a task originates from. In
this case, the instructions are defined when creating or editing planning tasks (see Create Planning Tasks and
Add/Edit Planning Task Dialog).

• You can specify instructions for each event type on each asset type. For example, you might specify one set of
instructions for a GVI on a pressure vessel, and different instructions for a GVI on a piece of piping. For more
information, see Define Task Instructions by Event Type.

Instructions defined for a specific task, event type or derived from a planning template are all visible on the Tasks tab
of the PLANNING and WORKPACKS screens when you click the Instructions toolbar button:
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You can also have task instructions displayed in an additional column on the Tasks tab by choosing Customise →
Instructions Preview from the toolbar:

12.7.1 Define Task Instructions by Event Type
You can define instructions for each event type on each asset type on the Task Instructions tab of the PLANNING
screen.

This tab shows each event type that is associated with the asset type selected in the asset tree in the top half of the
screen. That is, if you’ve selected an asset of type Corrosion Loop, on this tab, you’ll see one row for each event type
that is associated with the Corrosion Loop asset type.

If you see nothing in the list on this tab, that likely means that there are no event types associated with the asset type of
the selected asset. You can change the associations between asset types and event types from Configure Asset Types or
Configure Event Types.

To change the instructions for a particular event type on a particular asset type, follow the steps below:

1. In the top half of the PLANNING screen, select an asset that has the required asset type from the
asset tree.

2. Go to the Task Instructions tab, which shows all the event type associated with that asset type, and
select the event type required.

3. Choose Edit from the toolbar and enter your required instructions. There is no limit to the amount
of text you can enter.

4. Optionally, enter an estimated time for this event type. This will be used to estimate the total duration
of workpacks.

5. Click OK to save your changes.

ò Result

On the Task tab, you can see the instructions you entered under Task Instructions (Event
Type) for each relevant event type.

ã See also

• PLANNING Screen
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• Planning and Workpacks

12.8 Shutdowns
You can record planned shutdown data against each asset on the Shutdown tab of the PLANNING or WORKPACKS
screen.

To record a new shutdown, proceed as follows:

1. On the PLANNING or WORKPACKS screen, go to the Shutdowns tab and choose Add.

2. In the Add Shutdown dialog, enter data as follows:

• Name: Enter a short name for the shutdown. The character limit is 50 characters.

• Asset: Specify the asset that will be shut down. You should choose as specific an asset as you can. This
field is mandatory.

• Start Date: This is the date the shutdown is scheduled to begin.

• End Date: This is the date the shutdown is scheduled to end.

3. Click OK to save the shutdown.

ã See also

• PLANNING Screen

• WORKPACKS Screen

12.9 Workpack Summary
You can review tasks that belong to a given workpack by a list of assets on the Workpack Summary tab of the
WORKPACKS screen.

On this tab, you can see the list of assets that have been tasked within the selected workpack. For each asset, you can
see the relevant asset type and the associated tasks shown by their event types in a grid view. You can also export this
list to an HTML, RTF or Text file.

ã See also

• Workpacks

• WORKPACKS Screen
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THIRTEEN

INSPECTION

Online inspection is generally carried out in IC-Inspection (see IC-Inspection) or IC-Inspector (see IC-Inspector) . In-
spection data is then synchronised and transferred to NEXUS IC, where you can perform an offline review of inspection
data on the INSPECTION screen.

The general process is depicted in the figure and described below.

ò Note

This workflow represents a simplified version of a basic inspection process. Your specific process may
vary based on your unique business requirements and implementation.
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1. In general, inspectors complete tasks in IC-Inspector or IC-Inspection and from the tasks, events are created.
Event data are then synchronised to NEXUS IC. However, it’s also possible to import events or create them
manually in NEXUS IC (see Create Events).

2. In case data in an event violates an anomaly trigger, a finding is automatically created.

3. Engineers or review teams review events in NEXUS IC (see Review Events) and if they have concerns or signif-
icant observations regarding an event, they can raise a finding manually (see Create Findings).

4. Findings are then reviewed to decide if they have to be escalated and linked to an anomaly (see Link Finding to
Anomaly).

5. In case you use the services of a survey company that performs the post-processing of survey data, you need to
perform track repositioning, that is, you need to update the survey data in the NEXUS IC database by importing
the smoothed survey data that they provided (see Track Repositioning).

6. After track repositioning, we recommend that you re-run the anomaly triggers (see Run Anomaly Triggers).

13.1 INSPECTION Screen
On the INSPECTION screen, you can review, analyse, upload or create inspection event or finding data.

The INSPECTION screen is made up of the following main elements:

• The asset tree (see Asset Tree) is a pivotal element of the screen as all event or finding records will be
filtered by the currently selected asset, or its children if Child Assets is enabled. You can also manage
asset data directly on this screen and perform the same actions as you can do on the ASSETS screen.

• The Listings screen area contains the Event Listing (see Event Listing) and Finding Listing tabs
(see Findings Listing), which are always visible. These tabs show all the event or finding records
related to the selected assets and its children (if you’ve selected the Child Assets toolbar button). On
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these tabs, you can review, create, update, delete or filter event or finding records. All data in the
panes are filtered based on your selection on the Event Listing tab.

• All the panes on the INSPECTION screen show data relevant to the selected events on the Event
Listing tab. These panes can be shown or hidden, dragged around, pinned or unpinned (see Manage
Your Desktop). The following panes are available:

– Alignment (see Alignment)

– Asset History (see Asset History)

– Asset Information (see Asset Information Groups (AIGs))

– Charts (see Charts)

– Drawings (see Drawings)

– Event Details (see Event Details)

– Finding - this pane is only available if the Finding Listing tab is active (see Findings)

– Findings - this pane is only available if the Event Listing tab is active (see Findings)

– Incomplete Tasks (see Incomplete Tasks)

– Library (see Library)

– Map (see Map)

– Multimedia (see Multimedia)

– Related Events (see Related Events)

– Review Status (see Review Status)

– Task (see Task)

– Video (see Video)

13.1.1 Manage Your Desktop
The INSPECTION screen offers a “desktop manager” functionality that allows you to set up your screen as required.
For example, you can view or hide panes, drag and drop them and create different desktop layouts for different purposes.
For more information, see Manage Your Desktop.

13.1.2 Inspections Toolbar
For detailed description about the options in the main toolbar of the INSPECTION screen, see Inspections Toolbar.

13.1.2.1 Manage Your Desktop

The “desktop manager” functionality in IC-Inspection and on the INSPECTION screen of NEXUS IC works in the
same way. It allows you to freely set up your screen based on your requirements, view or hide panes, drag and drop
them and save your layout as a desktop.

13.1.2.1.1 View/Hide Panes

You can make panes visible or invisible on the screen by selecting or deselecting the relevant option from under the
View toolbar button on the screen. You can also hide a pane by closing the pane with the icon at their top right
corner.
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13.1.2.1.2 Drag and Dock Panes

You can drag panes around the screen and dock them wherever you want to see them.

When you are dragging a pane over an existing pane, you will see a pale blue highlight and/or a set of icons:

If you drag the pane over one of the icons, the pale blue highlight shows where the pane will drop, and the new size
and shape it will take on. If you drop the pane onto one of the icons, the pane will dock appropriately: dropping it onto
the centre square icon will make this pane part of the tab group; dropping it on the left, right, top or bottom icons will
split the current pane and drop this pane to the left, right, top or bottom of it.

If you drop a pane outside the main pane, they will become “floating” panes.

Areas with no panes present are considered a ‘void’. If you drop a pane into the centre of that void, the dropped pane
fills the void, and subsequent drops can split that pane into parts. If you drop a pane into the left, right, top or bottom
of the void, then the void is split, but the right, left, bottom or top will still contain the void.

13.1.2.1.3 Pin/Unpin Panes

You can click on to “unpin” panels so that they collapse to an edge of the pane. To recover an unpinned pane, click
on the pane’s name at the edge of the pane, then click on the icon.

13.1.2.1.4 Resize Panes

You can resize panes with the “splitter” at each edge between two docked windows. When you move the mouse over a

splitter the mouse cursor will change to a or split arrow. Drag the splitter to resize the windows.

The difference between floating and docked windows is that docked windows will resize together. When you drag
a splitter, one window will get bigger while another gets smaller. Thus, docked windows never overlap each other.
Typically most or all of your windows will be docked.

13.1.2.1.5 Create/Save/Delete Desktop Layout

You may need different desktop layouts for different purposes. For example, if you’re performing a structural type
inspection, you may need to see multimedia images, however, if you’re reviewing corrosion growth rates and thickness
readings, you may not be interested in multimedia but you want to see the charts to view the trend lines and so on. You
can set up different desktop layouts and switch between using the toolbar buttons on the top of the screen:
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• To switch between desktops, select the required desktop from the drop-down list available under the
Desktop toolbar button.

• To save the changes that you’ve made to the current desktop, click the toolbar button for Save the
active desktop. Settings are not automatically saved when you close the program.

• To create a new desktop, arrange the desktop as required and click the toolbar button for Add a new
desktop with the current layout to save the current arrangement of panes. You can name the desktop
as required.

• To delete an existing desktop layout, click the toolbar button for Delete the currently active desktop.

• To restore the desktop to the default layout pre-delivered with the system, click the toolbar button
for Restore the default desktops. This option is available only in IC-Inspection.

� Tip

If you have two monitors, it may be useful to spread across both, either by clicking the “Restore Down”
button at the top right of the pane if necessary and then dragging the main application window larger,
or by floating panes such as Drawings and then dragging the floating panes onto the second monitor.

13.1.2.2 Inspections Toolbar

The main toolbar of the INSPECTION screen allows you to perform generic functions on the screen. Individual panes
have their own toolbar to perform functions specific to those panes.
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Toolbar Option Description
Back Allows you to return to assets that you had previously selected in the asset tree.
Forward Allows you to return to assets that you had previously selected in the asset tree,

after you’ve used the Back button.
Assets See Assets Toolbar.
Asset Views See Asset Views.
Traffic Lighting See Traffic Lighting.
Import See Import Events.
Custom Export See Custom Export Events.
Reports See Reports.
View → Toggle
Event/Findings

Switches between the Event Listing and the Finding Listing tabs. Equivalent
to clicking on the Event Listing tab or the Finding Listing tab. The menu item
allows attaching a shortcut key to this action: F10.

View The items under this menu option show the various panes available on the IN-
SPECTION screen. Click a menu item to show or hide them. Checked items are
visible.

Time Source If set to System Time, the date and time field visible to the right of this button shows
the current time according to this PC’s clock. If set to Video Time, it shows time
from the video player. As you move backwards and forwards through the video,
you will see this time move backwards and forwards in unison.

Time Source →
Synchronise KP

If selected, then as the video plays, KP on appropriate charts will be updated from
the video time. As the video plays, the system checks what time the video is up
to, then it checks what KP is associated with that time, and it updates charts that
have a KP axis to that KP. This only works if there is suitable survey data in the
database, allowing us to get KP from the current time. Updated charts include
Event type -v- KP, CP -v- KP, and Pipeline View, as these all have a KP axis. It
does not include the Cross-Profile chart, as this does not have a KP.

Desktops If you have several saved desktop configurations for this screen, select which one
is active here.

Save Desktop If you have made changes to the currently selected desktop, click this to save them.
Otherwise, when you restart the application, your changes will be lost.

Add Desktop You can add a new desktop layout using this option. Any changes that you made
to the visible/invisible panes and their location on the screen will be saved under
the name that you specify.

Delete Desktop Deletes the currently selected desktop from the list.

13.2 Events
Events are data records created during an inspection or maintenance activity on specific assets. Events can be created
in IC-Inspection, IC-Inspector, NEXUS IC and IC-Web (see Create Events).

Event data are synchronised or imported to NEXUS IC, where findings are automatically created in case the recorded
data violates any preconfigured anomaly triggers.

Reviewing engineers or review teams can then check and review events (see Review Events) on the INSPECTION
screen of NEXUS IC (see INSPECTION Screen) and if required, create a finding, if it hasn’t been created earlier. The
list of all event records can be viewed and managed on the Event Listing tab (see Event Listing) once the relevant asset
is selected in the asset tree.

ã See also
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• Event Listing

• Create Events

• Import Events

• Edit Events

• Review Events

• Delete Events

• Review and Update Event Times

• Change Event Type

• Match Tasks to Events

• Survey Data Processing

• Run Anomaly Triggers

• Custom Export Events

13.2.1 Event Listing
You can see the list of all events on the selected asset (and it’s children, if it’s enabled) on the Event Listing tab of the
INSPECTION screen.

13.2.1.1 Filter Events

The asset tree acts as the main filter for the events listed in the Event Listing grid. When you select an asset in the
asset tree, you can see the list of events recorded on the selected asset, and, if you selected Child Assets, the list will
include the events for all the children of the selected asset too.

You can further filter events in the grid based on:

• Workpacks: Choose Filter → By Workpack from the toolbar of the tab to select the workpacks based on which
you want to filter the events.

• Event Type: Choose Filter → By Event Type from the toolbar of the tab to select the event types based on which
you want to filter the events. If you have no event types selected, then all events will be shown, and no continuous
events will be shown. To view continuous events, you must explicitly select those event types in the filter.

ò Note

When filtering by a single event type, the Event Summary grid will automatically display additional columns
for fields specific to that event type. This enhanced view allows you to further sort and filter events based on
those specific fields, providing a more detailed and focused analysis.

All columns in the grid can also be filtered and sorted using the standard filtering (see Filtering) and sorting (see
Sorting) functionality.

13.2.1.2 Columns

By default, the Event Listing tab displays columns that are common to all event types displayed. The first six columns
in the grid represent the following:
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Column Description
F Shows a colour that indicates the existence and status of the Finding that is associated with

the event. See below for more information.
B Indicates if the event has been bookmarked with a star sign.
L An icon is shown if there’s a library item attached to the event.
V An icon is shown if there’s a video attached to the event.
M An icon is shown if there’s multimedia attached to the event.

13.2.1.2.1 Finding Statuses

The colours of the icons in the Finding column indicate the status of the finding, which can be the following:

Colour Meaning

(White) There are no findings on this event.
(Yellow) The finding needs to be reviewed.
(Green) The finding has been deemed insignificant and is not linked to an anomaly.
(Grey) The finding is linked to a closed anomaly.
(Red) The finding is linked to an open anomaly.

13.2.1.3 Perform Actions on Events

From the Event Listing tab, you can perform actions on events using the relevant toolbar buttons or right-clicking any
of the events, which offers most of the options that the Events toolbar menu has.

You can perform the following actions:

• Create events (see Create Events)

• Update events (see Edit Events)

• Bookmark events - Select Toggle Bookmark from under the Events toolbar button or from the context menu of
the event (available by right-clicking). This sets a star icon next to the event in the grid.

• Review events (see Review Events)

• Delete events (see Delete Events)

• Update event times (see Review and Update Event Times)

• Change event type (see Change Event Type)

• Match tasks to events (see Match Tasks to Events)

• Run anomaly triggers (see Run Anomaly Triggers)

13.2.1.4 Event Listing Toolbar

For information about the toolbar menu options in the Event Listing tab, see below:
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Toolbar Option Description
Add Event See Create Events.
Delete See Delete Events.
Filter → By Workpack
. . . /By Event Type . . .

See Filter Events.

Child Assets When enabled, events for the currently selected asset and all sub-assets
will be included in the Event Listing tab. When disabled, only events that
have been recorded on the currently selected asset will appear in the grid.

Events → Event Re-
viewed. . .

See Review Events.

Events → Navigate to the
event asset

Changes the focus in the asset tree to the asset on which this event has been
recorded. To change back, click on the back arrow (Previous Asset) in the
main toolbar above the asset tree.

Events → Update
Start/Update End

See Review and Update Event Times.

Events → Toggle Book-
mark

Bookmarks are flags on an event. Bookmarked events are identified by a
star symbol in the B column of the Event Listing tab. The use of book-
marks and the workflow around setting and removing bookmarks depends
on your own specific requirements.

Events → Match Task See Match Tasks to Events.
Shortcuts → Anomaly
Triggers

See Run Anomaly Triggers.

Shortcuts→Change Type See Change Event Type.
Connections See Connections.
Export See Export.
Customise See Customise.

13.2.2 Create Events
Events in NEXUS IC can be created through three main methods, depending on your workflow and tools:

• Synchronisation from Other Applications
In general, events are created during inspection campaigns using:

– IC-Inspector: See Sync to IC-Inspector for details on syncing event data from IC-Inspector to NEXUS IC.

– IC-Inspection: See Manage Subscriber Databases for syncing event data from IC-Inspection.

These tools allow inspectors to generate events directly from completed tasks or create ad hoc events during
inspections.

• Import from Excel
You can import event records into NEXUS IC from an Excel file. See Import Events for details instructions.

• Creation in NEXUS IC
If required, events can be created directly in NEXUS IC in one of the following ways:

– By manually adding events from the Event Listing tab of the INSPECTION screen (see below)

– By completing a task in the Incomplete Tasks pane of the INSPECTION screen (see Incomplete Tasks)
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13.2.2.1 Prerequisites

To be able to create event records, the required event types must have been configured (see Configure Event Types).

13.2.2.2 Add Events Manually

1. On the INSPECTION screen, select the relevant asset in the asset tree and on the Event Listing tab, click Add
Event in the toolbar.

2. From the drop-down list, select the event type for which you want to create the event. The available event types
depend on your configuration settings under Configure Event Types.

The submenu lists all event types stored in the database, grouped by event category. Event types that are not
permitted for recording on the currently selected asset are automatically disabled. The definition of ‘allowable’
event types depends on the asset type associated with the currently selected asset. This is configured in Configure
Asset Types.

At the top of the drop-down menu, you’ll see Hide Unavailable. If you select this, event types not relevant to
the asset type of the currently selected asset will be hidden. If you unselect it, those irrelevant event types will
be shown, but disabled. If you have too many event types to fit on your monitor, select Hide Unavailable.

3. Enter the event data in the event form as required.

The fields available in the dialog depend on the event type configuration settings. You can also enter additional
notes, such as a quick summary about the inspection activity that the event relates to or comments about anything
of interest or concern about this event. On the Summary tab, you must ensure that a workpack is linked to the
event and that the correct date and time is specified.

When adding a new event, the Workpack, Asset, and Survey Set fields will be pre-filled to match the event you
previously selected in the grid before clicking Add Event. You can also enter survey data for the new event. If
you specify a Start Clock or End Clock for which data already exists in the selected survey set, that existing data
will be displayed. Otherwise, you’ll have the option to manually enter survey data.

4. Click OK.

ò Result

The new event record is added to the list in the Event Listing tab.

13.2.2.3 Event Numbering

Whenever an event is created, either manually or through import, it is assigned an event number automatically. The
event number is incremented by one as compared to the last event created with the same event type. Thus, each event
has a unique number assigned to it based on its event type.

13.2.3 Import Events
You can import or bulk update events by choosing Import from the toolbar on the INSPECTION screen.

The format of the Excel workbook needs to be specific. We recommend that you use the Example button on the first
page of the Import wizard, to generate the workbook in the correct format for importing data.

During the import process, anomaly trigger checks are run on each event and if required, findings are automatically
generated. For more information, see Run Anomaly Triggers.
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ò Note

If you do not specify a survey set for event survey data to be imported into, it will be imported into
Raw Survey Data, which is the default set. If two different events have the same date/time, the second
one imported will overwrite the survey values of the first. To avoid this, don’t have two different events
in the same survey set at the same time with different survey data.

³ Caution

When creating a new event, Event.Start Clock must be earlier in time than Event.End Clock for the
import to succeed.

13.2.3.1 Import Files

ò Prepare Data for Import

Before you start the import, you must prepare the files in the required format. Compatible file types include .zip,
.xlsx (Excel), .csv, and .txt. Zip files can contain the xlsx/csv/txt file plus any additional files, for example, multi-
media images or electronic documents for importing into the library.

� Tip

• For very large imports, saving your Excel file as a .csv and then importing from the .csv may
be faster.

• The Asset Location.Full Location data can be defined in one of the following ways
(you can use only one option, not both):

– As a single column, where each level of the asset location is separated by the string “ /
“, for example, ‘My Field / My Platform / My Member’

– As multiple columns, where each level of the asset location is stored in a separate
sequential column, that is, for each node in the hierarchy, you create a separate column
with the name Asset Location.Full Location and with one asset hierarchy level
in each.

ò Note

Importing directly from .xlsx files is not supported for SaaS customers using the new virtualisation
technology (see SaaS Using Single Sign-On (SSO)). We recommend using .csv files instead.

Sub-Rows in Import Sheet
Sometimes a single row may have several sub-rows. For example, an AIG row might have several sub-AIG rows;
or an event might have several findings or several multimedia images or both. When this occurs, you must create
separate rows in the import sheet for each sub-item, with different “detail” values in each.

For example, if you have several multimedia images to import against a single event, your Excel sheet should
have several rows that are identical except for the Multimedia.Name and Multimedia.Image columns. If you have
specified an event number, and you use the same event number on each row, NEXUS will only create the event
once, but will create several multimedia items. If you do not specify an event number, NEXUS will instead create
several different events with one multimedia item each.
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You can also leave event fields blank for all except the last row. Under the hood, NEXUS is importing each Excel
row into the event, and only the last Excel row imported will “stick”. Note that if your event has a finding, you
should not repeat the finding data on each event row; if you do, NEXUS will create one finding for each Excel row
that has finding data filled in.

In some cases, you do want multiple findings on one event, and in that case you must fill in several rows as ap-
propriate. Similarly for sub-event data or sub-AIG data: if you want several different sub-events or sub-AIG rows
imported, you should repeat the event row or AIG row with different sub-event or sub-AIG data in each case. If you
are repeating an Excel row for another reason and you do not want several sub-event or sub-AIG rows imported,
you should fill in sub-event or sub-AIG data in only one of the Excel rows.

� Tip

You can find the next available event number for a given event type by creating an event of that type
using Add Event, noting the event number, then deleting that event. If you want the next available
event numbers for several event types, create a report template with a Simple Source on table Event
and a Pivot Table with a pivot row on Event Type and a value field on Event Number with aggregate
Max, then add 1.

ò Perform Data Import

1. Choose Import from the toolbar.

2. In the Import File dialog, choose to navigate to the file that you want to import and select it.

ò Note

By default, the dialog shows only CSV files.

3. If required, you can also verify the date and time format in this dialog and you can choose whether
you want to skip blank cells:

• If you select skipping blank cells, then any cells that are blank will be ignored during the
import.

• If you do not select skipping blank cells, then blank cells will update any existing data and
make it blank.

4. Click Next.

ò Result

The system reads the import file and uses the <table name>.<field name> naming con-
vention to map the headers in the import file to database fields in the NEXUS system.

5. In the Configure Import dialog, you can review the mapping proposed by the system and make
changes, if required:

• In the top Field row, you can see the fields to which the system proposes to map the column
headers from the import file. You can manually change the default mapping option for each
column by clicking on the title of the column in the top Field row and selecting one of the
following options:
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– Don’t Import - Does not import the selected column to the database.

– Common Fields - Allows you to select common fields in the database to which you want
to map the selected column instead of the database field proposed by the system.

– Other . . . - Allows you to search and select a field from a list of your field definitions as
required.

Note that if the system couldn’t match a column to a database field for some reason, the
column is displayed in red colour. By default, the system does not map these columns, you
can manually map them if required.

• In case there are required fields in the database for which the system couldn’t find any values
in your import sheet, the system prompts you to set these values in this dialog. In this case,
the relevant fields will be displayed on the right-hand side of the dialog under Required
Fields, where you have the option to set the value globally for this import as required.

• Under Settings, you can specify how many header rows your import sheet contains. For
example, you may have the table name as the first header row and the field name in the
second header row, in which case, instead of having a column title like Asset Location.
Asset View, you’d have a header row for Asset Location and second header row for Asset
View.

• If your import file contains multiple worksheets, ensure that you select the correct worksheet
in the Worksheet field.

Note that if the field type is set to change for an existing field, the import will abort as data loss
may occur.

6. Click Next.

ò Result

The system tests every single row in the import file and shows if there are any issues with
importing. You can abort the test import at any time by clicking Skip.

7. Once the import test is finished, you can see a log that shows any errors or warnings that the
system may have found during test import. In case of errors, you cannot proceed with the import
and the Import button will be inactive. In this case, you must rectify the errors in the import file
and start the import process again.

� Tip

You can copy and select import results from the dialog for review. For instance, it can be
helpful to paste all errors into a spreadsheet to make it simpler to methodically update them.
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8. If the import test is finished without errors, you can click Import to complete the process.

ò Result

Depending on your client, the following happens:
• If using a SaaS client, the import job is offloaded to the SaaS server and is started

remotely. It is then possible to close the current NEXUS IC session while the active
import job continues.

• If using a non-SaaS client, the import job is executed in the current NEXUS IC session
and you may continue using NEXUS IC. Closing the current NEXUS IC session will
cancel the active import job.

In both cases, the UI will refresh intermittently throughout the import, and there will be
delays between the import finishing and final refresh as NEXUS IC does not directly monitor
changes.

ò Note

When importing inspection event data, anomaly triggers are checked during the import and
findings created automatically from data which falls outside the data bounds.

6. Check the status and result of the import in the Job Management Console, which records the
status and history of all import jobs. The import job banner at the bottom of the window shows
the status of the import job and provides the option to dismiss the job or check the details. You
can double-click the job, which triggers a dialog that summarises the import. From this dialog,
you can click Details to show how many rows have been added to various forms or tables. If you
have multiple rows in your import sheet that update the same row, these rows will be counted
by the test import individually, whereas the final import statistics will only show 1 updated row.
You can also save the summary to file.

� Tip

• We highly recommend that you scrutinise the summary to ensure that the import has
performed the actions that you expected. Take note of the total rows for a specific item,
that is, add together the number added and updated and make sure that is equal to the
number you expect.

• If the importer encounters a completely blank row in an Excel file, it will stop import-
ing at that point, even if there are non-blank rows further down. This can provide an
easy way to test an import sheet: set it up, and then after just one or two rows of data,
insert a blank. Run the import to see if it’s doing what you expect, and if so, delete the
blank and run again. Similarly, if the importer encounters a blank column in an Excel
file, columns to the right of this will not be imported.

ò Note

During an import, NEXUS communicates with Excel in the background. NEXUS com-
mands Excel to open the file you want to import, and asks Excel what’s in each cell. If you
use Excel to modify the file while we’re importing it, even if you don’t hit Save, you may
confuse the import process. The same happens if you take a variety of other actions, such as
Save As, closing the Excel, and so on. If you see the error text “Call was rejected by callee”,
it means that Excel has stopped answering calls from NEXUS.
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13.2.4 Edit Events
You can update and edit the data of existing events on the Event Details pane (see Event Details) as follows:

1. On the Event Listing tab, select the events that you want to update. You can also multi-select events.

2. On the Event Details pane, update event-specific data on the Details tab, or survey data on the Survey tab as
required.

3. Click Save to save your changes, or, if you want to revert the changes back to the last saved state, click Revert.

13.2.4.1 Edit Graphical Markup On Images In Events

If one or more event types are configured to show graphical markup (see Enable Images with Graphical Markup for
Event Fields), you will see a region on the event form showing any multimedia attached to this event.

If there are no multimedia attached to this event, this region will show as white. If there are several multimedia, you
will see them all overlaid translucently, and you can use Multimedia toolbar option to untick the ones you don’t want.

You can perform the following actions on the image:

• You can pan the photo by using the left mouse button to drag it.

• You can zoom with the Zoom In/Zoom Out buttons, or by using the mouse wheel. You may need to click in
the image region before the mouse wheel will zoom for you; this is a focus issue related to Windows.

• You can do graphical markup on the photo. To do that, click the Redraw Layer button, then click in the drawing
region to mark up. If your markup type is Point, click just once, otherwise click several times. Then click Save
Layer to complete the shape.
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13.2.5 Review Events
Once event records are in NEXUS IC, the reviewing engineer or review team can review the inspection data. Typically,
a review of events may include ensuring the following:

• Any inspection events with findings have sufficient supporting evidence attached (for example, photos/videos
and event information)

• The date/timestamp of the inspection events recorded match the actual start date/timestamp and end
date/timestamp indicated on the digital video. If required, the event start/end time must be updated (see Re-
view and Update Event Times)

• The event form is complete and that all data and comments are accurate and concise. (see Event Details)

• Multimedia attached to inspection events are of good quality.

• Inspection events that have been specifically bookmarked by the online inspection engineers are reviewed.

The reviewer can then decide if a finding needs to be created from the event (if it hasn’t been created automatically) or
the event can be considered as insignificant.

13.2.5.1 Set Review Status for Events

To set the review status of an event or events, proceed as follows:

1. On the INSPECTION screen, select the relevant asset in the asset tree.

2. On the Event Listing tab, select the event or events that you want to review.
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3. From the toolbar, choose Events → Event Reviewed and select the required review status. You can
also access the same menu option from the context menu of the event (available when right-clicking).
You have the following options:

• Mark Event as reviewed - Sets the status of the selected events to reviewed.

• Mark Event as reviewed (move next) - Sets the status of the selected events to
reviewed and selects the next event in the event list.

• Mark Event as reviewed (with comment) - Sets the status of the selected events
to reviewed and shows a dialog where you can enter additional comments for the
event. We recommend that you keep your comments under 8000 characters.

• Mark Event as not reviewed - If an event has been reviewed, you can set its status
back to not reviewed using this option. In this case, the review record will be
deleted and will disappear from the Review Status pane.

� Tip

You can set up keybindings if you want to use keyboard shortcuts for the
different review actions under Tools → Options → Inspection. For ex-
ample, when the Ins keybinding is set up for the Mark Event as reviewed
action, you can quickly set the selected event to reviewed by pressing the
Ins keyboard button instead of navigating to the action from the toolbar.
For more information about setting up keybindings, see Setting Up Key-
bindings.

ò Result

• The status of the event gets updated in the Reviewed column of the Event Listing
tab.

• A new review record is created in the Review Status pane with your user and the
date and time when you set the status to reviewed. You can update this record
or add comments to it anytime. If you delete this record, the status of the event
changes back to not reviewed again.

ò Note

You can also add, update or delete review records for events on the Review Status pane on the IN-
SPECTION screen. For more information, see Review Status.
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13.2.6 Delete Events
You can delete existing event records on the Event Listing tab of the INSPECTION screen as follows:

1. On the Event Listing tab, select the events that you want to delete. You can also multi-select events.

2. Click Delete in the toolbar. You can also choose Delete from the context menu of the events (available when
right-clicking the events).

3. In the confirmation dialog that opens, you can check the existing connections before deleting the event. If you
are sure you want to delete the event, click Delete.

13.2.6.1 Delete Events in Bulk

If you want to delete events in bulk, we recommend that you follow the steps below:

1. Go to the WORKPACKS screen and create a workpack called DeleteMe (see Workpacks).

2. Return to the INSPECTION screen and on the Event Listing tab, multi-select the events you want to delete.

3. On the Event Details pane (see Event Details), go to the Survey tab.

4. In the Workpack field, click the ellipsis button and select the DeleteMe workpack.

5. Go to the WORKPACKS screen again.

6. From the mail menu, go to Database → Close, then Database → Reopen or Database → Connect. . . to clear
those events from NEXUS IC’s cache.

7. Delete the DeleteMe workpack from the WORKPACKS screen by selecting the workpack from the list and
choosing Delete from the toolbar.

13.2.7 Review and Update Event Times
When you’re reviewing events, you must ensure that the timestamps for the start event and end event match the actual
start and end timestamps indicated on the digital video. The start and end time of the event can be automatically updated
from the date and time of the digital video currently playing.

You can check the timestamps for the start and end of an event in the Start Clock and End Clock columns on the
Event Listing tab, or, in the respective fields on the Survey tab of the Event Details pane.

When reviewing events by video, ensure that in the main toolbar, the time source is set to Video Time. Else, the local
current time is displayed.

13.2.7.1 Update Event Times

To update the start and end time of the event based on the date and time of the digital video currently playing, on the
Event Listing tab, select the relevant event record and proceed as follows:
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• To update the start time of the event, choose Events from the toolbar of the Event Listing dialog or right-click
the event, and select Update Start from the drop-down menu.

• To update the end time of the event, choose Events from the toolbar of the Event Listing dialog or right-click
the event, and select Update End from the drop-down menu.

13.2.8 Change Event Type
You can change the event type of selected events while retaining the link to all associated survey data, multimedia, and
manually created findings. You can change the event type to any other preconfigured event types (see Configure Event
Types). Any auto-generated findings will be unlinked from the event, but not deleted.

To change the event type, follow the steps below:

1. On the Event Listing tab, select one or more events as required.

2. From the tab’s toolbar, choose Shortcuts → Change Type. You can also select the same option from the context
menu of the events (available by right-clicking).

3. In the dialog that appears, select the event type to which you want to switch.

4. Click OK.

ò Result

The type of the selected events get updated to the new event type. If the field names across event types match,
the data is retained. If the field names do not match, the values are added to the Notes, which you can check
on the Event Details pane. Note that if you change the event type back to the original, these values will not
be populated back to the original fields but will remain in the Notes section.

13.2.9 Match Tasks to Events
In general, when tasks are completed in IC-Inspection or IC-Inspector, an event is automatically created from the task
and they’re linked together.

In some cases, for example, when you created events manually, there may be no tasks associated with the event. In
NEXUS IC, you can check associated tasks when selecting the event on the Event Listing tab of the INSPECTION
screen and checking the record on the Task pane (see Task).

You can link incomplete tasks to an event in case they belong to the same asset and the same workpack and they have
the same event type. The same functionality is available on the Event Listing pane in IC-Inspection. To match tasks,
follow the steps below:

1. On the Event Listing tab, select one or more events as required.

2. From the tab’s toolbar, choose Shortcuts → Match Task. You can also select the same option from the context
menu of the events (available by right-clicking).

ò Result

The system automatically matches incomplete tasks to events in case all the following conditions
are met:

• The task doesn’t already have an event assigned to it.

• The task and the event have the same asset.
• The task and the event have the same workpack.
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• The event type of the event and the task match.

The task gets completed and disappears from the Incomplete Tasks pane. You can now see the
associated task on the Task pane.

ò Note

You can also manually link incomplete tasks to events. For more information, see Incomplete Tasks.

13.2.10 Survey Data Processing
Survey data - including KP, Easting, Northing, Latitude, Longitude, and Elevation - is stored in a survey set. Each
event in NEXUS references a survey set, and its positional data is retrieved by matching the Start Clock timestamp of
the event with a corresponding Date Time Stamp in the survey set.

In most cases, raw survey data is imported or synchronised to the NEXUS IC database together with the event records.
You can also import survey data manually. All survey data must be assigned to a survey set. For more information, see
Configure Survey Sets.

You can check survey data associated with specific events on the Event Details pane of the INSPECTION screen (see
Event Details).

13.2.10.1 Matching Survey Sets to Events

Events are matched to imported survey data based on time proximity. NEXUS uses a threshold of +3/-2 seconds to
find the closest survey data point:

• If survey data exists up to 2 seconds before or 3 seconds after the event’s timestamp, NEXUS will match the
event to the nearest available survey point.

• To ensure reliable matching, you must ensure that imported survey data include entries at least every 4 seconds.
This guarantees that each event will have a suitable survey point within the matching window.

ò Note

• Gaps in survey data are acceptable, provided there are no events within the time span of the gap that require
survey matching.

• Within a single survey set, each timestamp can only have one set of survey values. If you need to associate
different survey values with multiple events occurring at the same time, those events must reference different
survey sets.

13.2.10.2 Track Repositioning

In case you use the services of a survey company that performs the post-processing of survey data, you need to update
the survey data in the NEXUS IC database by importing the smoothed survey data that they provided. This is called
track repositioning.

When performing track repositioning, you create a new survey set for the smoothed survey data and reassign that survey
set to the relevant events. Track repositioning requires a CSV or MS Excel file of the processed survey data, most likely
in the format originally provided in the survey string.
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ò Note

Once you’ve performed track repositioning, consider re-running the anomaly triggers (see Run
Anomaly Triggers).

To perform the update of survey data in NEXUS IC based on the smoothed survey data, follow the steps below:

1. Create a new survey set for the smoothed data. You can create a new survey set in the following ways:

• In the main menu, go to Configuration → Events → Survey Sets and in the Configuration - Survey Sets
dialog, click Add to create a new survey set (see Configure Survey Sets)

• On the INSPECTION screen:

1. Select the relevant events on the Event Details tab.

2. On the Event Details pane, go the Survey tab.

3. In the Survey Set field, click .

4. In the Select Survey Set dialog, click Add and specify the name of the survey set.

2. Import the smoothed survey data into the new survey set. To do that, in the Configuration - Survey Sets or
Select Survey Set dialog (see step above), select the new survey set and click Import. Follow the steps in the
import wizard (see Import Events).

3. On the Event Details tab of the INSPECTION screen, select the events that you want to reposition. You can
filter events in the dialog (for example, by workpack) as required.

4. On the Event Details pane, go the Survey tab.

5. In the Survey Set field, click .

6. In the Select Survey Set dialog, select the new survey set.

ò Result

The survey data gets updated for all the selected events.

ã See also

Configure Survey Sets

13.2.11 Run Anomaly Triggers
In most cases, whenever anomaly triggers are violated, findings are automatically generated at the time when events are
added or imported. However, there are some scenarios in which you must run anomaly triggers manually, including:

• Anomaly triggers are updated and anomaly trigger limits have changed

• Anomaly triggers exist on a calculation field

• Before any finding review sessions

• After a bulk import of event data (particularly when anomaly triggers rely on events other than itself)

You can run anomaly triggers manually on the Event Listing tab of the INSPECTION screen by choosing Shortcuts
→ Anomaly Triggers from the toolbar. This will run the anomaly triggers functionality for the filtered events listed

13.2. Events 457



NEXUS Documentation, Release 6.9.xxxxx.0

in the Event Listing tab. If required, the system automatically creates findings on those events where the event data
exceeds specified criteria. If findings exist and event data no longer exceeds the criteria, then findings will be deleted.
For more information, see the process below.

13.2.11.1 Prerequisites

Anomaly triggers have been defined in either of the following ways:

• Generic anomaly triggers have been set up for fields in AIG forms or event forms as described in Set Up Anomaly
Triggers.

• Asset-specific anomaly triggers have been set up as described in Set Up Anomaly Triggers for Assets.

13.2.11.2 Run Anomaly Triggers Manually

1. On the INSPECTION screen, go to the Event Listing tab.

2. If required, filter the events or select those for which you want to run the anomaly triggers.

3. Choose Shortcuts → Anomaly Triggers from the toolbar.

4. In the confirmation dialog, choose Run Triggers.
5. The system uses the filtered list of events shown on the Event Listing tab to check event data against

pre-configured anomaly triggers and performs the following:

• If the event data exceeds specified criteria in the anomaly triggers:

a. It checks the following data to see if a finding already exists from this trigger for this event:

– Anomaly Trigger rule (Bound_ID)

– Is Auto Generated = true

b. If it finds no such finding, it creates a new finding.

• If the event data is within the specified limits in the anomaly triggers:

a. It checks if there’s a need to delete an existing finding by trying to match a finding based on
the following data:

– Anomaly Code (Code_ID)

– Anomaly Severity (Severity_ID)

– Reason (if there is an error message provided in the anomaly trigger)

– Anomaly Trigger rule (Bound_ID)

– Is Auto Generated = true

– That it has not been linked to an anomaly (Anomaly_ID is null)

– Anomaly Required is null

b. If it finds a matching finding, it deletes the finding.

This means that if a finding was automatically generated from a particular anomaly trigger
rule, and the event data no longer exceeds that rule (because the event data has been changed
or because the rule has been changed), and the error message in that rule still matches the
Reason in this finding, and the finding has not been linked to an anomaly and the user has
not marked whether it needs to be linked to an anomaly, the system will delete it.
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ò Note

If you delete an anomaly trigger, findings created from it won’t be deleted. If you want
to delete all findings created from an anomaly trigger, don’t delete the anomaly trigger.
Instead, modify it so that no data will be marked as anomalous (for example, you can set it
to only flag data between -2 and -1 on a field with no negative values), then run the anomaly
triggers functionality. Then, as a second step, you can delete the anomaly trigger.

13.2.12 Custom Export Events
The Custom Export functionality allows you to choose a subset of event data and export that to an Excel file.

You can perform custom export by choosing Custom Export from the toolbar on the INSPECTION screen.

The format in which the data is exported to Excel is the same format in which the data can be reimported (with some
exceptions). See Import Events for more information on importing data from Excel.

13.2.12.1 Perform Custom Export

1. On the INSPECTION screen, choose Custom Export from the toolbar.

ò Result

The Event Export Wizard opens.

2. Specify the name of the file and the location where you want it to be saved to. NEXUS proposes a
default path and name, which you can overwrite as required.

3. Click Next.
4. In the next dialog, specify the export options:
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Field Description
Columns Select one of the following options:

• All columns - includes all the relevant columns in the exported file.
• All visible columns - columns that have the Visible Grid or Visible Form

options ticked will be exported. Workflow rules affecting field visibility will
not be run.

• User selected - you can select which columns to include in the export. A
subsequent dialog will be shown later select those columns.

Asset Loca-
tion

Select one of the following options:
• Single column - the location of the assets will be included in a single column,

each node separated by “ / “ (note the space), for example, “Field / Asset /
Elevation / Member / Anode”

• Multiple columns - each node in the asset location hierarchy will have its
own column in the exported file.

Findings Select one of the following options:
• Include - finding data will be included in the export, in which case they will

get their own worksheet.
• Exclude - finding data will not be included in the exported file.
• Only export Findings - only finding data will be included in the exported

file.

Images Select whether you want to include the attached images in the exported file, and
if so, how. You can Embed thumbnails at various resolutions, Embed full size
images, Hyperlink to external images, or Do not export images. If an event has
several images, you will get several sets of Multimedia columns, with images for
an event shown horizontally within the event’s row.

Calculated
fields

Indicate whether you want to include calculated fields in the export.

Sub events Indicate whether you want to include sub-event data in the export. If you export
sub-events, the event data will be repeated in several rows, one for each sub-event.

Work-
sheets/One
per event
type

When ticked, a separate worksheet will be created for each event type. If you
untick this option, you will get one Excel worksheet with (potentially) many dif-
ferent event types mixed together.

Work-
sheets/Hide
Lookup
Lists

By default, extra worksheets are created for each lookup list used in the forms.
You can choose to hide these worksheets.

Date Specify the formatting of dates in the exported file.
Time Specify the formatting of times in the exported file.
Cell format-
ting

If you select this option, some cell formatting options will be applied, for exam-
ple, cells with invalid values will be shown in red, cells not relevant to this event
form will be greyed out, and so on.

5. Click Next.
6. In the next dialog, choose the Asset View and select which subset of assets you want to include in

the export.
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ò Note

Use the Select Children and Unselect Children toolbar buttons to include and exclude the visible
and non-visible child assets. Simply selecting an asset at the top level will not automatically select
all the child assets beneath it.

7. Click Next.
8. In the next dialog, select the workpacks that you want to include in the exported file.

9. Click Next.
10. In the next dialog, select the event types that you want to include in the exported file.

11. Click Export.

ò Result

The system generates the Excel file to the location that you specified. If required, you can
choose to open the document immediately.

� Hint

• The column order within the exported sheet is determined by the grid column order set within each form
under Configuration → Assets → Information (see Configure Asset Information Groups).

• The exported Excel sheet contains a Legend tab, which shows the meaning of various cell and row colours.

13.3 Findings
A finding is the link between an anomaly and an inspection or survey event. Findings are either escalated and linked
to an anomaly (see Link Finding to Anomaly) or deemed “insignificant” and remain simply as an observation on the
source event.

Findings are automatically created on events when event data meets or exceeds the pre-configured anomaly triggers.
Findings can be created also manually in IC-Inspection or NEXUS IC (see Create Findings).

The list of all finding records can be viewed and managed on the Finding Listing tab (see Findings Listing) of the
INSPECTION screen once the relevant asset is selected in the asset tree.

On the INSPECTION screen, you can view or manage data of finding records in two ways:

• If you want to review all the finding records created for specific events, you can select the events on the Event
Listing tab and check and manage the relevant findings on the Findings tab:
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• If you want to review the data of specific finding records, on the Finding Listing tab, you can select the findings
and check and update their data on the Finding tab:

ò Note

When the Finding Listing tab is active, then the Findings pane is hidden and the Finding pane is shown. When
the Event Listing tab is active, then the Finding pane is hidden and the Findings pane is shown.

13.3.1 Report Table Sources
To extract Finding data into a report template, use the System Table titled Finding as the primary Table Source, or
use the System Tables titled Event or Anomaly and then add fields from the Finding table. For more information see
Configure Report Templates.

ã See also
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• Findings Listing

• Create Findings

• Edit Findings

• Review Findings

• Link Finding to Anomaly

13.3.1.1 Findings Listing

You can see the list of all events that have associated findings on the selected asset (and it’s children, if it’s enabled) on
the Finding Listing tab of the INSPECTION screen.

ò Note

If you have selected an event with a finding on the Event Listing tab and you switch to the Finding
Listing tab, your selection will be carried over to the Finding Listing tab.

13.3.1.1.1 Filtering Findings

The asset tree acts as the main filter for the findings listed in the grid. When you select an asset in the asset tree, you
can see the list of events with findings recorded on the selected asset, and, if you selected Child Assets, the list will
include the findings for all the children of the selected asset too.

You can filter findings in the grid based on:

• Workpacks - Choose Filter → By Workpack from the toolbar of the tab to select the workpacks based on which
you want to filter the findings.

• Event Type - Choose Filter → By Event Type from the toolbar of the tab to select the event types based on which
you want to filter the findings. If you have no event types selected, then all findings will be shown.

ò Note

When findings are filtered by event type from the toolbar menu, and there are only events of
a single event type displayed in the grid, the fields of the specific event type will get added as
columns in the finding listing grid.

All columns in the grid can also be filtered and sorted using the standard filtering (see Filtering) and sorting (see
Sorting) functionality.

13.3.1.1.2 Columns

By default, the Finding Listing tab displays columns that are common to all findings displayed. The first columns in
the grid represent the following:

Column Description
F Shows a colour that indicates the status of the Finding. See below for more information.
M An icon is shown if there’s multimedia attached to the event.
V An icon is shown if there’s a video attached to the event.
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13.3.1.1.2.1 Finding Statuses

The colours of the icons in the Finding column indicate the status of the finding, which can be the following:

Colour Meaning

(Yellow) The finding needs to be reviewed. By default, all new findings get this status.
(Green) The finding has been deemed insignificant and is not linked to an anomaly. A

finding gets this status if you mark it as not requiring an anomaly when editing the
finding.

(Grey) The finding is linked to a closed anomaly.
(Red) The finding is linked to an open anomaly.

13.3.1.1.3 Perform Actions on Findings

From the Finding Listing tab, you can perform actions on findings using the relevant toolbar buttons or right-clicking
any of the events, which offers most of the options that the Finding toolbar menu has.

You can perform the following actions:

• Create findings (see Create Findings)

• Update findings (see Edit Findings)

• Review findings (see Review Findings)

• Link finding to an anomaly (see Link Finding to Anomaly)

• Delete findings - To delete findings, you can select or multiselect findings on the Finding Listing tab and click
Delete in the toolbar or choose this option from the context menu (available by right-clicking the item).

13.3.1.1.4 Findings Listing Toolbar

For information about the toolbar menu options in the Finding Listing tab, see below:
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Toolbar Option Description
Finding → Mark find-
ing as reviewed/reviewed
(with comment)/not re-
viewed

See Review Findings.

Finding → Launch
Anomaly

See Launch Anomaly.

Finding → Link Anomaly See Link Finding to Anomaly.
Finding → Unlink
Anomaly

See Unlink Anomaly.

Delete Deletes the currently selected finding records. If multiple findings have
been selected, then a dialog will show how many findings will be deleted
and prompt you to confirm by clicking on the Delete button.

Filter → By Workpack
. . . /By Event Type . . .

See Filtering Findings.

Child Assets When enabled, findings for the currently selected asset and all sub-assets
will be included in the Finding Listing tab. When disabled, only findings
that have been recorded on the currently selected asset will appear in the
grid.

Events → Event Re-
viewed. . .

See Review Events.

Events → Navigate to the
event asset

Changes the focus in the asset tree to the asset on which this event has been
recorded. To change back, click on the back arrow (Previous Asset) in the
main toolbar above the asset tree.

Events → Toggle Book-
mark

Bookmarks are flags on an event. Bookmarked events are identified by a
star symbol in the B column of the Event Listing tab. The use of book-
marks and the workflow around setting and removing bookmarks depends
on your own specific requirements.

Connections See Connections.
Export See Export.
Customise See Customise.

13.3.1.2 Create Findings

Findings can be created in the following ways:

• In case anomaly triggers have been set up for specific event fields and those triggers are violated (see Configure
Event Types), findings are automatically created when event data is created, saved or imported. For example,
when an anomaly trigger is defined on a CP event, where the CP reading value is outside -800mv and -1200mv,
NEXUS IC will automatically create a finding on that event when the event is created.

• Findings can be imported together with event import (see Import Events)

• Findings can be synchronised from IC-Inspection in case an inspection engineer created findings there.

• You can also manually create a finding from an event in NEXUS IC as described below.

13.3.1.2.1 Add Findings Manually

1. On the INSPECTION screen, select the relevant event on the Event Listing tab.

2. Go to the Findings pane and click Add in the toolbar.

3. In the Add Finding dialog, enter the details of the finding as required. For information about filling the fields in
this dialog, see Add/Edit Finding Dialog.
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4. Click OK.

ò Result

The new finding record is added to the list on the Finding Listing tab. On the Event Listing tab, the colour
of the icon in the F column becomes yellow and when selecting the event here, the finding record is visible
on the Findings pane.

13.3.1.3 Edit Findings

You can update the details of existing findings either on the Finding or on the Findings pane of the INSPECTION
screen, but only one of them is visible at a time:

• When the Event Listing tab is active, the Findings pane is visible, where you can see several findings for the
currently selected event (if they exist). This pane is hidden when the Finding Listing tab is active. You can
select a single event or multi-select events as required.

• When the Finding Listing tab is active, the Finding pane is visible, where you can see the details of the findings
that you selected in the Finding Listing grid. This pane is hidden when the Event Listing tab is active. You can
select a single finding or multi-select findings as required.

13.3.1.3.1 With Event Listing Tab Active

1. On the INSPECTION screen, select the relevant events on the Event Listing tab.

2. Go to the Findings pane and select the findings that you want to update. You can multi-select findings.

3. Choose in the toolbar.

4. In the Edit Finding dialog, update the details of the finding as required. You can also link the findings to an
anomaly or mark them as insignificant here using the Anomaly Required field. For information about filling
the fields in this dialog, see Add/Edit Finding Dialog.

5. Click OK to save your changes.

13.3.1.3.2 With Finding Listing Tab Active

1. On the INSPECTION screen, select the relevant findings on the Finding Listing tab. You can multi-select
findings.

2. Go to the Finding pane and update the details of the fields as required. You can also link the findings to an
anomaly or mark them as insignificant here using the Anomaly Required field. For information about filling
the fields on this pane, see Add/Edit Finding Dialog.

If you want to undo your changes, before choosing Save, you can set the values back to their original values by
choosing Revert.

3. Choose Save to save your changes.

13.3.1.4 Review Findings

Once findings have been created, the reviewing engineer or review team can review the findings to determine whether
the finding needs to be escalated to an anomaly or it can be deemed insignificant and remain simply as an observation
on the source event.

In NEXUS IC, you can perform the following actions during a finding review:

• If the finding needs to be escalated, you can link it to an anomaly as described in Link Finding to
Anomaly.
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• If the finding can be considered insignificant, you can indicate it by setting the value of the Anomaly
Required field to No when editing the finding (see Edit Findings).

• You can also track the status of findings by setting their review status and if necessary, add comments
to the review records created (see Set Review Status for Findings).

13.3.1.4.1 Set Review Status for Findings

1. On the INSPECTION screen, select the relevant asset in the asset tree.

2. On the Finding Listing tab, select the finding or findings that you want to review.

3. From the toolbar, choose Finding and select the required review status. You have the following
options:

• Mark Finding as reviewed - Sets the status of the selected findings to reviewed.

• Mark Finding as reviewed (with comment) - Sets the status of the selected findings to
reviewed and shows a dialog where you can enter additional comments for the finding.
We recommend that you keep your comments under 8000 characters.

• Mark Finding as not reviewed - If a finding has been reviewed, you can set its status
back to not reviewed using this option.

� Tip

You can set up keybindings if you want to use keyboard shortcuts for the differ-
ent review actions under Tools → Options → Inspection. For example, when
the F8 keybinding is set up for the Mark Finding as reviewed action, you can
quickly set the selected finding to Reviewed by pressing the F8 keyboard but-
ton instead of navigating to the action from the toolbar. For more information
about setting up keybindings, see Setting Up Keybindings.
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ò Result

• The status of the finding gets updated in the Reviewed column of the Finding Listing
tab.

• A new review record is created in the Review Status pane with your user and the
date and time when you set the status to reviewed. You can update this record or add
comments to it anytime. If you delete this record, the status of the finding changes
back to not reviewed again.

ò Note

You can also add, update or delete review records for findings on the Review Status pane on the
INSPECTION screen. For more information, see Review Status.

13.3.1.5 Link Finding to Anomaly

When reviewing findings, the reviewing engineer has to decide whether the finding needs to be escalated to an anomaly.
To do that, the finding record has to be linked to an anomaly.

If an event is recorded and raised to a finding over different inspection years, these findings can all be linked to the
same anomaly.
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Once linked, you can launch the anomaly from the INSPECTION screen to edit it (see Launch Anomaly), or you can
also unlink it (see Unlink Anomaly) any time.

Findings can be linked to anomalies from the INSPECTION screen in a number of ways:

13.3.1.5.1 Create Link With Event Listing Tab Active

When the Event Listing tab is active, the Findings pane is visible, where you can link findings to an anomaly in the
following ways:

• You can create the link whenever you create (see Create Findings) or edit (see Edit Findings) findings. To add
the link, in the Add/Edit Finding dialog, tick the Anomaly Required checkbox and from the Anomaly field,
click to select the anomaly or create a new one as required. You can also multiselect findings in the Findings
pane to add the link to multiple findings at once:
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• You can also select one or more findings directly in the Findings pane and choose Link Anomaly under the
Finding toolbar button. From the dialog that opens, you can select existing anomalies or create a new anomaly
as required:
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13.3.1.5.2 Create Link With Finding Listing Tab Active

When the Finding Listing tab is active, you can select one or more findings in the grid and link them to an anomaly in
the following ways:

• You can select one or more findings directly in the Finding Listing tab and choose Link
Anomaly under the Finding toolbar button. From the dialog that opens, you can select
existing anomalies or create a new anomaly as required.

• You can select one or more findings in the Finding Listing tab, then on the Finding pane
(visible only if the Finding Listing tab is active), tick the Anomaly Required checkbox
and from the Anomaly field, click to select the anomaly or create a new one as required.

13.3.1.5.3 Launch Anomaly

If a finding has been linked to an anomaly, you can launch the Edit Anomaly dialog for the linked anomaly and edit
the anomaly as required. You can do that in the following ways:

• When the Event Listing tab is active, you can choose Launch Anomaly under the Finding toolbar button
on the Findings pane.

• When the Finding Listing tab is active, you can directly choose Launch Anomaly under the Finding toolbar
button on the Finding Listing tab.

13.3.1.5.4 Unlink Anomaly

If a finding has been linked to an anomaly, you can unlink it any time as follows:

• When the Event Listing tab is active, you can choose Unlink Anomaly under the Finding toolbar button on
the Findings pane.

• When the Finding Listing tab is active, you can directly choose Unlink Anomaly under the Finding toolbar
button on the Finding Listing tab.

This will disassociate the linked anomaly from the currently selected finding. The previously linked anomaly will not
be deleted, and the finding will remain unchanged (other than not having a linked anomaly).
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ò Note

Link Anomaly, Unlink Anomaly and Close Anomaly are Shortcuts. As such, if necessary, they can be debugged
using the Shortcut debugger. When you select the menu item, hold down the Control key on the keyboard. After
you have given any necessary input (such as selecting an anomaly for Link Anomaly) the Debug Shortcut dialog
will appear. You can step through shortcut items one at a time, which may help to narrow down any problems.

13.4 Alignment
On the Alignment pane of the INSPECTION screen, you can align events in one workpack with events in another.
If you have carried out multiple inspections on an asset with KP (such as a pipeline), survey may have been cali-
brated differently in different years. Thus, the same physical object may be logged at slightly different KPs in different
inspections. This tool lets you bring all those subtly different KP measurements into alignment with each other.

To perform the alignment, follow the steps below:

1. Ensure that the events that you want to align on are visible on the Event Listing tab (see Event Listing), by setting
filters as required.

2. On the Alignment pane, choose a baseline workpack and an alignment workpack using the toolbar
buttons.

3. Check the suggestions of NEXUS for alignment.

The chart shows events from both workpacks, with the Provide Suggested Control Points section at the right.
This section lists the event types that NEXUS IC believes might be suitable for matching on, essentially, events
that have KP. Each event type has a checkbox and a slider. If you select the checkbox next to a given event type,
NEXUS IC suggests control points, in that event type’s colour.

The slider at the right of each event type controls sensitivity. If the slider is all the way to the left, it will only
suggest pairs of events that have identical KP. As you move the slider to the right, it suggests points that have
more and more KP difference, up to a maximum of 25 metres. The default slider position is 5 metres.

4. Select one or more event types by ticking the relevant checkboxes :

• We recommend that you select event types that represent static objects, such as pipeline features, anodes,
field joints.

• We don’t recommend selecting event types that represent things that might change location over time, such
as freespans and burials.

5. Adjust sliders as required . If the survey variation from one workpack to the other is more than 5 metres, you
will need to adjust sliders upwards.

6. NEXUS IC displays some suggestions for the pairing of events by connecting them with a line. These are only
suggestions, as yet, no links have been made.

7. To make the actual link, proceed as follows:

a. Zoom in on the chart (put the mouse over the KP axis and spin the mouse wheel, or adjust the zoom bar at
the bottom of the pane) far enough that you can select that individual point.

b. Click on one of the points to select the pair .

c. Click Link in the toolbar .
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You can also make a link that is not based on a suggestion. For example, suppose that a particular object has
been logged one year as a Feature and the next year as a Survey Note. NEXUS IC will not automatically suggest
a link if the event types are different, but you can still manually click those two events and click Link.

� Tip

If you change your mind, you can click Unlink to unlink a single pair of events, or Unlink All to start again
from scratch.

8. Once you are happy with the links you have made, click Align .

ò Result

NEXUS IC aligns events between the lowest and highest KPs you have created links for. Adjustments will be
made to the KPs of events in the Alignment Workpack. This may take some time, depending on the number
of events involved. If you are carrying out a test, we recommend that you do so on a small KP range.

Events will be adjusted based on the linked points nearest them. For example, if you have a point at KP
0 linked to a point at KP 0.004, and another point at KP 1 linked to a point at KP 1.004, all points in the
Alignment Workpack between KP 0.004 and KP 1.004 will have their KP decreased by 0.004 km. If your low
points were at KP 0 and KP 0.004 and your high points were at KP 1 and KP 1.008, then weighted scaling
would occur: a point halfway between at KP 0.506 would have a scaling halfway between 0.004 and 0.008
(that is, 0.006) applied; a point at KP 0.252 would have a scaling of 0.005 applied, and so on.

13.5 Asset History
See Asset History.

13.6 Asset Information
See Asset Information Groups (AIGs).
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13.7 Charts
On the Charts pane of the INSPECTION screen, you can review all the chart templates that are relevant for the events
listed on the Event Listing tab or the findings listed on the Findings Listing tab, whichever is active.

If you don’t see any charts listed, try different types of events, by changing the asset or by changing your filters. Charts
only show event data included in your filters (workpacks, event types, column-specific filters, etc), it doesn’t show data
for events or findings that you have filtered out on the Event Listing or Finding Listing tabs. If your chart template is
on continuous event data (such as cross-profiles), ensure that you select that Continuous Event in your event type filter.

13.7.1 Prerequisites
Charts are generated from preconfigured chart templates. To enable displaying charts for an asset, the relevant chart
templates must have been configured as described in Configure Chart Templates.

13.7.2 Display Charts

To expand/collapse each chart, click the button at the top right of that chart, or click the chart’s grey header row.

� Tip

Click on the chart area and then, with the mouse cursor still inside the chart area, use your mouse wheel
to increase/decrease the chart scale.

Note the following:

• Available charts are listed alphabetically. The first chart will be automatically expanded.

• Events with findings are shown on the chart in red.

• For some chart templates, at the right or the bottom of the chart is the chart legend. If you hover the mouse over
an item on the legend, other series on the chart will fade out temporarily. If you click an item on the legend, that
series will be toggled on/off. If you export the chart, only series currently visible will be exported.

Every client database includes:

• Baseline Chart, which shows events’ Easting and Northing, and optionally also shows a pipeline baseline track
(if you’ve set one up)

• Cross-Profile chart, which shows seabed profile for a single KP (if you have any PL - Cross Profile data imported)

• Event Type -v- KP chart, which shows what events are logged at what KP of a pipeline (if you have any KP-based
assets such as pipelines)

• Events by Type, a pie chart showing how many events you have of each type

• Longitudinal Profile, which shows top of pipe, bottom of pie, and left and right seabed versus KP (if you have
any PL - Profile data imported)

• Pipeline View, which shows events along your pipeline in a 3D view. This view can also show seabed profile (if
you have any PL - Cross Profile data imported), and animates motion along the pipeline as you select events. See
Charts Toolbar below for details of buttons that are used by the Pipeline View.

13.7.3 Chart Width
When the Charts tab is 1000 pixels wide or less, all charts are shown at the full width of the tab. When the Charts tab
is over 1000 pixels wide, some charts are shown full width, and some are shown half width, in order to fit more charts
side-by-side onto your screen.
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Charts that have an X axis of type string, date, or date/time, or whose X axis includes ‘KP’ are always shown full width.
You can adjust the width of all charts by adjusting the width of the whole application window, adjusting other elements
such as the asset tree wider/narrower, and so on.

13.7.4 Zooming
At the bottom of most chart templates, below the horizontal scrollbar (if visible) is the Zoom Bar. You can hover the
mouse over the left or right end of the selected part of the Zoom Bar and drag to change the selection. Initially the
entire Zoom Bar will be selected, so hover the mouse over the left or right end of the bar and drag. Once a subset of
the chart is selected, you can use the scroll bar or the Zoom Bar to drag the whole selection area without zooming.

You can also zoom in or out by clicking in the chart area and (with the mouse cursor still inside the chart area) spinning
the mouse wheel. For charts with a lot of data (thousands of events) this can be slow, so the Zoom Bar may be faster.
You can zoom on a single axis by putting the mouse pointer over that axis and spinning the mouse wheel. Not all charts
support zooming in both axes.

You can also control zoom with toolbar buttons Zoom In, Zoom Out, and Reset Zoom.

13.7.5 Charts Toolbar
There is no toolbar for the whole Charts tab. Instead, each chart has its own toolbar.

But-
ton

Description

Zooms the image in.
Zooms the image out.
Resets to default zoom level.
Opens the Export dialog, from which you can generate images from the chart. Ensure the
range you want is set correctly using the Zoom Bar. Ensure the series you want to export are
visible. If you want to export the chart as a series of images, each covering a smaller horizontal
range, enter the range you would like each chart to cover in the Range of X Axis per image
field. For example, if you have a 300 km pipeline and you enter “10” as the range per image,
it will be broken into 30 images, each covering 10 km.
Copies the chart, as you see it displayed, without the “zoom” section at the bottom, to the
clipboard.

Expands/collapses the display of this chart.

The following buttons are specific to the Pipeline View chart:
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But-
ton

Description

Tracks the current KP. This button is only available in IC-Inspection. When selected, the
pipeline view will move in time with the KP value coming in from survey. For NEXUS IC,
see Time Source → Synchronise KP on the Inspections Toolbar.
Exaggerates the scale to show more of the pipeline. When selected, the scale of the pipeline
will be distorted to make a greater KP range visible.
Toggles stacked series mode. When selected, events above the pipeline will be moved to make
them more obvious. Different events will be moved up different distances so that all are easily
distinguishable.
Toggles 3D perspective mode. When unselected, you will see the pipeline viewed from the
side. When selected, you will see the pipeline viewed from above and slightly off to one side.

13.7.6 Report Table Sources
To extract chart template data into a report template, use a Chart Template element in the report, and use the appropriate
Asset table or Event table as a source. For more information see Configure Report Templates.

13.8 Drawings
On the Drawings pane of the INSPECTION screen, you can view and manage drawings in the same way as you do
on the ASSETS screen. For more information, see Drawings.

On the INSPECTION screen, the following additional features are available:

• If you left-click on a drawing layer, you can create a new event on that layer’s asset.

• The additional Finding Status menu option is available from under the Layer Colour toolbar button. This shows
the following colours:

– Green - No findings, but events exist.

– Grey - No events exist.

– Yellow - Findings exist, but no severity.

– Other - Finding severity colour is shown.

ã See also

• Drawings

• Charts and Drawings

13.9 Event Details
You can review all the data related to events on the Event Details pane once you have selected the relevant event or
events on the Event Listing tab.

An event represents a discrete inspection or survey item. Each event record has (as a minimum) the following data
linked to it:

• Asset
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• Workpack

• Start Date/Time

• End Date/Time

• Survey Set

The Event Details pane contains two tabs:

• The Details tab shows the fields in the event form and a notes section.

• The Survey tab contains key data and survey values.
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13.9.1 The Event Form
The event form contains all the data fields specific to the event and is visible on the Details tab of the Event Details
pane. All the fields on the form are user-definable and can be configured from Configure Event Types.

Fields on event forms and sub-event forms follow the same rules and have the same features as fields on asset information
forms (see Field Types).

Event-specific data can be edited and saved on this tab as described in Edit Events.

The lower part of the Details tab contains a notes section where you can enter free text relating to this event.

13.9.2 Survey Data
At the top of the Survey tab, you can see the key data associated with this event. You can update all the values in these
fields.

Under the key fields, you can see the Survey section. This shows data for each survey field assigned to this asset type
(see Assign Survey Data to Asset Type). The data shown is related to the Start Clock and End Clock: if another event
has the same Start or End Clock, it will have the same survey data.

For information about how survey sets are matched to events, see Matching Survey Sets to Events.

Event forms for survey sets can be configured as described in Configure Event Types.

13.9.3 Report Table Sources
To extract event data (common to all events) into a report template, use the System Table titled Event as the primary
Table Source. To extract additional data from specific events, add fields from the relevant events that exist in the Event
category.
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For more information see Configure Report Templates.

13.10 Incomplete Tasks
In general, tasks are completed in IC-Inspection or IC-Inspector when an event is created from the task. In case tasks
haven’t been completed there, you can check them on the Incomplete Tasks pane of the INSPECTION screen in
NEXUS IC. This pane lists all tasks for the currently selected asset that have not been flagged as completed. Note that
the list is only valid for the selected asset in the asset tree and doesn’t include the incomplete tasks for its children.

13.10.1 Complete Tasks
From the Incomplete Task pane, you can complete tasks as follows:

• You can choose Link in the toolbar to link the currently selected event in the Event Listings pane to the currently
selected task in the Incomplete Tasks pane. When clicked, the task will be linked to the event, flagged as
completed and no longer shown in the Incomplete Tasks pane. Please note that the event type of the event and
the event type of the task need not necessarily match for them to be linked together.

• You can choose Launch in the toolbar to launch the event form for the currently selected task. Once you have
completed and saved the details in the event form, the task will be linked to the event, flagged as completed and
no longer shown in the Incomplete Tasks pane.

You can also match incomplete tasks to events on the Event Details tab, see Match Tasks to Events.

For more information, see Complete Tasks.

You can also use the standard grid toolbar buttons to add, edit or delete tasks, use the import or export functionality,
check connections, or customise layout. For more information, see Using the Grid.

13.10.2 Report Table Sources
To extract task data into a report template, use the System Table titled Task as the primary Table Source. For more
information see Configure Report Templates.
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13.11 Library
On the Library pane of the INSPECTION screen, library items are shown based on the event selected on the Event
Listing tab (see Event Listing).

If you have events in the event listing, and you select one, those library items will be displayed that are associated with
either of the following:

• Event

• Event type of the selected event

• Workpack of the selected event

• Asset of the selected event

13.11.1 Library Items
Library items are electronic documents that can be linked to data and data types in NEXUS IC using connections (see
Library Connections).

The electronic documents can be uploaded directly into the NEXUS IC database, or can be referenced using URL or
UNC paths.

13.11.2 Manage Library Items
You can manage library items from several screens within NEXUS IC, including:

• Library Items tab on the LIBRARY screen (see Library)

• Library tab on the ASSETS screen (see Library)

• Library tab on the INSPECTION screen (see INSPECTION)

• Library tab on the ANOMALIES screen (see ANOMALIES)

• Library tab under Configuration → General → Functions → Edit Function Definition

• Library tab on the Edit Asset Type dialog under Configuration → Assets → Types

• Library tab on the Edit Table Definition dialog under Configuration → Events → Event Types →
Edit Table Information

Example
If you upload company piping specifications to the NEXUS IC Library and assign it to the asset type
“Pipework”, the piping specifications will be available from the Library* tab of the ASSETS screen when-
ever the active asset is of type “Pipework”.
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You can also maintain library items on the Library pane of IC-Inspection.

You use the standard toolbar functions on the Library/Library Items tab to add, edit, delete, import, export library items
or customise the grid layout. For more information about these functions, see Using the Grid.

ò Note

• You can edit the properties of the selected library item from the toolbar, but not the document
itself.

• Deleting a library item will also delete all its associated connections.

• The Export option only exports the grid contents, not the actual library documents.

See below for more information about some actions you can perform on library items:

ò Add Library Items

To create a new library item, proceed as follows:

1. Start adding a new library item in one of the following ways:

• On the Library/Library Items tab, choose Add from the toolbar.

• Drag files from your file explorer onto the Library/Library Items tab.

ò Note

Drag-and-drop is not supported in remote environments (e.g., Remote Desktop).

2. Depending on the screen from which you accessed the Library tab, you may be prompted to select a con-
nection type. You can connect a library item to different types of data records:

Screen Connection Type
ASSETS

• Asset
• Asset Type

INSPECTION
• Asset
• Asset Type
• Event
• Event Type
• Workpack

ANOMALIES
• Anomaly
• Asset
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ò Note

If you’re adding a library item from the LIBRARY screen, you add the connection to a data record from
the Connections tab after you have created the library item. For more information, see Add Library
Connections.

3. In the Add/Edit Library dialog, select the library type, enter a name for the library item (mandatory) and
enter other parameters as required. For information about filling in all the parameters, see Add/Edit Library
Dialog.

• If the document is to be uploaded into NEXUS IC, then click on the Attachment button, else enter a
Hyperlink location.

• When adding an attachment, you can either Import or Link it:

– If you import, the item will be saved to the database. If you subsequently change the original on
disk, the item in the database will not change to match.

– If you link the item, then when you change the original on your disk, the next time you view the
item within NEXUS IC, you’ll see the updated item.

ò Note

• NEXUS IC still loads a copy of a linked item into the NEXUS database. This ensures
that if the original is unavailable (for example, because you are away from your network),
NEXUS IC can display the cached copy.
When you view the item, if the original has been updated, the database cached copy is
updated too. You can’t link items that are on your local hard disk, only items on network
drives can be linked. The Link feature is designed to keep you up-to-date with items
that may have been changed by others, and that is not possible on your local drive.

• If you drag and drop multiple files, they will be added, and then multi-selected in the
grid. You can then click Edit to multi-edit them (see Multi-Edit). Drag and drop will
import items, not link them.

4. Click OK.

On the LIBRARY screen, you can view the details of the library item by selecting it and checking the Details
tab under the Library Items tab.
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ò Edit Library Items

To edit an existing library item, proceed as follows:

1. On the Library/Library Items tab, select the library item.

2. Choose Edit from the toolbar.

3. In the Edit Library dialog, update data as required. For more information, see Add/Edit Library Dialog.

4. Click OK to save your changes.

ò Delete Library Items

To delete an existing library item, proceed as follows:

1. On the Library/Library Items tab, select the library item.

2. Choose Delete from the toolbar.

3. In the confirmation dialog, click Check Connections if you want to review any connections to this library
item before deletion.

4. If you want to proceed deleting the library item, click Delete, else, choose Cancel.

ò Launch Library Items

Use the Launch toolbar button to launch library items on the local machine. By default, NEXUS only launches
files with the following extensions: doc, docx, xls, xlsx, jpg, png, jpeg, jfif, bmp, tiff, gif, mpg, mp3, wav, ppt, pptx,
txt, pdf, emf, zip, dwg, avi, rtf, mp4, csv.

� Hint

Use the Space Bar on your keyboard to launch the currently selected library item.

Note that if the local machine does not have an associated viewer for the document type (for example, AutoCad
viewer for DWG type), then the document can not be launched.

ò Email Library Items

Use the Email toolbar button to send an email message with the selected library items attached to it.
You can select multiple library items to be sent in the same email message. Note that you must have
properly configured your email settings (see Set Up Email) for this option to function.

. Warning

If the size of the attachment exceeds your organization’s attachment size limit, you may get an “Out
of memory” error message.
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ò Import Library Items

You can import library items using the standard Import toolbar option (see Import). You can download the MS
Excel Import Template, which shows the required format for importing library items.

You can also import the Connections in the same import as the library items, so in addition to the Library Import
columns, you can additionally define the Connection information using the following column headings:

• Library Connection.Connect To

• Library Connection.Workpack

• Library Connection.Asset Type

• Library Connection.Asset

• Library Connection.Event Type

• Library Connection.Event

• Library Connection.Anomaly

• Library Connection.Risk Model

• `Library Connection.Function

Note that the Connect To column should only contain one of the following text items:

• Anomaly

• Asset

• Asset Type

• Event

• Event Type

• Function

• Risk Model

• Workpack

13.11.2.1 Double-click

The first time you double-click on a library item, NEXUS asks you whether you want to launch the library item in
an external editor, or edit the library item. If you want your choice to become permanent, tick the Always do this
checkbox. Note that if you hold down the Alt key while double-clicking, you will be asked again.

13.12 Map
On the Map pane, you can see the events visible on the Event Listing tab (see Event Listing) on a two-dimensional
map, based on their easting (x-coordinate) and northing (y-coordinate). Each event is a dot, coloured with the event
type’s colour. You can set the colour for each event as described in Configure Event Types.

13.12.1 Filtering
The Map pane only shows event data included in the filters you applied on the Event Listing tab (for example, work-
packs, event types, column-specific filters). You can also filter by event type using the Event Types toolbar button
options. If the events you are interested in are Continuous Event data (such as cross-profiles), ensure that you select
that Continuous Event in your event type filter.
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13.12.2 Zooming
You can zoom in or out by clicking in the map area and (with the mouse cursor still inside the map area) spinning the
mouse wheel. You can also control zoom with the relevant toolbar buttons.

13.12.3 Maps Toolbar
You can use the following toolbar menu options on the Map pane to manage the appearance of the map:

Toolbar
Option

Description

Zoom
In

Zooms the map in.

Zoom
Out

Zooms the map out.

Reset
Zoom

Resets the zoom so that all data points are visible.

Copy Copies the map, as currently displayed, to the clipboard.
Legend Shows or hides the legend of the events on the map either on the side or at the bottom. The

legend includes the event types that are selected and the layers that have their opacity set to
anything above 0%. Layers and event types can be switched off by clicking on the layer or
event on the legend. If you hover the mouse over an item on the legend, other series on the
map will fade out temporarily. If you export the map, only series currently visible will be
exported.

Map
Layers

Shows or hides layers on the map and controls their opacity. The menu options include free-
to-use map layers from the web, such as ESRI World Imagery, ESRI World Topographic,
ESRI Ocean Base Map, ESRI Street Map, and so on. The available map servers can be
configured under Configuration → General → Map Servers from the main menu. Each of
these layers has an opacity drop-down list to be selected from 0% to 100%. If you select
0% for any of the layers, it will not be included in the map legend.

Event
Types

Selects what event types are displayed. This is more persistent than clicking/unclicking
series on the map legend.

Inspec-
tion
Track

Selecting a workpack from under this toolbar option will show a line on the map connecting
events in the order they were logged. If the events were logged by a single ROV (or a single
human inspector), this track will show the path that the ROV (or inspector) took.

Base-
line

Shows or hides the baseline coordinates of the assets behind the events on the map. For
example, in case of a pipeline, a black line can be displayed that shows the position of the
pipeline. This is shown based on your settings for the asset’s coordinates under Assets →
Coordinates (also available in the context menu (right-click) of the selected asset).

Config-
ure

Shows the sources of the various fields used by the Map pane to display pipeline baseline
data and map data. “As Built - Easting”, “As Built - Northing” and “As Built - Order”
should all point to the same table, which is the table used to supply the pipeline baseline
track. Typically you would point these three fields at a sub-AIG. If you don’t configure these,
no as-built track will be displayed. If your pipeline has many events on it, not showing an
as-built may be OK. Users may be able to get a sense of the pipeline track from the events
on it. “Coordinates - Datum” and “Coordinates - UTM Zone” should point to fields that
provide these values. Typically they will be in an AIG. Only one datum and one UTM Zone
are necessary for an entire asset. Ask your surveyors for the values that you should fill in to
these fields.

Export
Image

Saves the map to an image file.
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13.13 Multimedia
Multimedia are electronic files that have been uploaded against an event.

You can view, add, edit or delete multimedia images associated with events on the Multimedia pane of the INSPEC-
TION screen after selecting the relevant events on the Event Listing tab. Multimedia items are then displayed as
thumbnails for the currently selected events.

ò Note

The following file formats are supported: GIF, JPG, JPEG, JFIF, TIF, BMP, PNG, PDF, DWG, CGM,
DXF, SVG, WMF or EMF.

13.13.1 Add Multimedia Items
Follow the steps below to add new multimedia items to events:

1. Select the relevant event or events on the Event Listing tab.

ò Note

If you select multiple events, the multimedia file will be attached to all selected events.

2. Open the Multimedia pane.

3. Use one of the following methods to upload the file:

• Choose Add on the Multimedia pane to upload the file manually.

• Drag & drop the multimedia file from Windows Explorer onto the Multimedia pane.
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4. In the Add Multimedia dialog, enter a name for the multimedia (mandatory) and enter other parameters as
required. For details, see Add/Edit Multimedia Dialog.

When adding the multimedia file manually, you can choose to Import or Link the file:

• Import: Saves the file to the NEXUS IC database. Changes made to the original file on disk will not affect
the stored version.

• Link: Links to the original file on disk. Any changes made to the file will be reflected the next time it is
viewed in NEXUS IC.

ò Note

If you drag and drop multiple files, they will be added, and then multi-selected in the grid. You can then click
Edit to modify them in buld (see Multi-Edit). Drag and drop will import items, not link them.

5. Click OK.

13.13.2 Edit Multimedia Items
To edit an existing multimedia item, proceed as follows:

1. On the Multimedia pane, select the multimedia item.

2. Choose Edit on the toolbar.

3. In the Edit Multimedia dialog, update data as required. For more information, see Add/Edit Multimedia Dialog.

4. Click OK to save your changes.

13.13.3 Preview Multimedia Items
If you click the Preview button on the Multimedia pane, you can open a floating window to display the selected image
in full size. If the selected events contain more images and you scroll from image to image on the Multimedia pane,
the Preview window gets refreshed with whatever image is selected.

13.13.4 Crop Multimedia Items
You can crop image files in the Multimedia pane as follows:

1. Select the file and click Crop in the toolbar.

2. Click Crop in the toolbar of the Edit Image dialog.

3. Click and drag a rectangle on the image as required.

4. Before completing the crop, click Keep Original if you want the new cropped image to be added to the event’s
collection of images without overwriting the existing image. If you want to replace the existing image with the
new cropped version, ensure Keep Original is not selected.

5. To complete the crop, click the button, or choose Crop To Selection from the toolbar.

13.13.5 Multimedia Toolbar
You can use the following options in the toolbar of the Multimedia pane to perform actions on multimedia files:
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Toolbar
Option

Description

Add See inspections.multimedia.add. You can only add new multimedia files to events on the
INSPECTION screen, you cannot add new multimedia files on the ANOMALIES screen.

Edit Launches the Edit Multimedia dialog. You can update and save the properties of the mul-
timedia file. See Add/Edit Multimedia Dialog.

Delete Deletes the currently selected multimedia records. If multiple multimedia items have been
selected, then a dialog pops up that shows how many multimedia items will be deleted and
prompts you to confirm by clicking Delete.

Launch Launches the currently selected multimedia file into the default Windows viewer for the
selected file type. Note that if your image viewer supplies “Next” and “Previous” buttons,
these will show you the next and previous files in the temp folder, which may not be the next
and previous images in NEXUS.

Preview See inspections.multimedia.preview.
Crop See inspections.multimedia.crop.
Export See Export.
Cus-
tomise

See Customise.

13.14 Related Events
On the Related Events pane of the INSPECTION screen, you can check events that are related to the currently selected
event on the Event Listing tab. Related events fulfil the following criteria:

• They have the same event type

• They are from a different workpack

• Their start and end KP overlap

If you click Navigate Event in the toolbar, the event selected on the Related Events pane will be selected on the Event
Listing tab.

13.15 Review Status
You can review the status of events or findings on the Review Status pane of the INSPECTION screen.

Whenever an event or a finding is marked as Reviewed (see Review Events and Review Findings), a review record is
automatically created in the Review Status pane. If you mark an event or finding as Not Reviewed, the review record
is automatically deleted.

The review record shows the date and time when the record was created and the username of the person who created
the record. If a comment has been entered, it is also shown there.

The list in the Review Status pane is dynamically refreshed based on your selection in the Event Listing or Finding
Listing tabs and only shows the review records for the selected event or finding. If you have selected multiple events
or findings, review records for all of them will be shown.

On this pane, you can do the following:

• Add new review records for the selected events or findings by choosing Add. If you select multiple events
or findings, a review record will be created for each. This is useful for marking numerous events as reviewed at
once.

• Update review records by choosing Edit.
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• Delete review records by choosing Delete. This will set the status of the selected items to not reviewed.

13.15.1 Report Table Sources
To extract review data into a report template, use the System tables titled Event Review and Finding Review as the
primary Table Source. For more information, see Configure Report Templates.

ã See also

• Review Events

• Review Findings

13.16 Task
On the Task pane of the INSPECTION screen, you can check the task that is linked to the event currently selected
on the Event Listing tab. In general, this is the source task based on which the event was created when the task was
completed.

From this pane, you can also edit task data (see Add/Edit Task Dialog) by choosing Edit and unlink the task from the
event by choosing Unlink from the toolbar. If you unlink a task, it will appear on the Incomplete Tasks pane (see
Incomplete Tasks).

13.17 Video
The Video pane allows the playback of centrally stored videos, which are linked via date-time stamp from the currently
selected event.

Events with associated video are identified with a small play icon on the Event Listing tab. When you select an event
on the Event Listing or Finding Listing tab, all videos associated with the relevant event are shown on the Video
pane:
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� Tip

• The Video pane can be undocked, resized and placed outside of the NEXUS application, on
another monitor for example.

• If you are experiencing degradation of video quality due to frame dropouts caused by insufficient
bandwidth, then disable one or more channels.

13.17.1 Configuration
You can tell NEXUS IC where to look for videos by setting the Global Video Path and/or Temporary Video Path in
your database properties settings (see Properties).

You can then parse the video files (see Parse Video) to store their properties in the database. You can further manage
video files under Tools → Video. . . (see Video. . . ).

For more information, see Managing Videos.

13.17.2 Video Toolbar
You can use the following toolbar menu options on the Video pane to manage videos:

490 Chapter 13. Inspection



NEXUS Documentation, Release 6.9.xxxxx.0

Toolbar Option Description
Play/Pause Starts playback at the current point in time. The video can be paused by pressing

this button again.
Play from Event
Start Time

Plays the video for the selected event starting at that event’s Start Clock time.

Play from Event
End Time

Plays the video for the selected event starting at that event’s End Clock time.

Auto Play When this button is toggled OFF, you will be required to click on one of the Play
toolbar buttons to start video playback. When toggled ON, then video playback
will automatically start when you select an event on the Event Listing tab.

Leap Backwards Steps back in the video by the selected time frame. You can choose the time frame
from 1 second, 5 seconds, 10 seconds, 30 seconds, 1 minute or 5 minutes from the
drop-down menu.

Rewind Rewinds the video with preview using the selected speed. Choose the required
speed from the drop-down menu. Depending on how the video has been en-
coded, some speeds may not be available. When the required position is reached,
the video can be played by pressing the Play button. You can also set fast for-
ward/rewind speed by putting the mouse cursor over the video pane and using the
mouse wheel.

Fast Forward Fast forwards the video with preview using the selected speed. Choose the re-
quired speed from the drop-down menu. Depending on how the video has been en-
coded, some speeds may not be available. When the required position is reached,
the video can be played by pressing the Play button. You can also set fast for-
ward/rewind speed by putting the mouse cursor over the video pane and using the
mouse wheel.

Leap Forward Steps forward in the video by the selected time frame. Choose the required time
frame (for example, 1 second, 5 seconds, 10 seconds, 30 seconds, 1 minute or 5
minutes) from the drop-down menu.

Step Backward Steps backward in the video by one frame. Depending on how the video has been
encoded, this button may step the video back to the previous key frame, which
might be several seconds back.

Step Forward Steps forward in the video by one frame.
Capture Image Captures an image from each of the playing video channels and attaches them to

the currently selected event as a multimedia item. Multimedia can be viewed from
the Multimedia pane (see Multimedia). Within the Video Frames dialog, you can
select, unselect and crop images. To crop, click the Crop button or Ctrl-X, then
click and drag a rectangle on the image. To complete the crop, click the button
or Crop To Selection. If you have selected Keep Original before cropping, the
cropped image will be saved as a new image and the original image will be kept
too.

Channels If multiple channels of video exist for a selected event, they will be listed in this
drop-down menu. For each channel, you may enable or disable the video and/or
audio. To enable or disable the audio or video, select or unselect the video or
audio from the drop-down menu. You can enable or disable each channel’s audio
by clicking the speaker icon next to the audio level meter. Also, you can disable a
video channel quickly using the X in the top right corner of each playing video.

Offset Offsets the playback of an individual video channel with the selected number of
seconds (+/-). This is useful in case you have multiple video channels and their
playback is out of sync. Use the drop-down menu to select the required number
of seconds with which you want to offset the playback of a given video channel.
This setting is then automatically saved for the selected video channel until you
change it.

Layout → Auto-
matic

This option will automatically size and position the channels (minimising unused
space) based on the size and proportions of the video pane.

Layout → Hori-
zontal

The channels will be displayed horizontally by selecting this option.

Layout → Verti-
cal

The channels will be displayed vertically by selecting this option.

Layout → Square The channels will be displayed in a square shape by selecting this option.
Configure →
Capture Set-
tings. . .

This option takes you to the Inspection tab of the Tools → Options menu, where
you can make settings for capturing images during video inspections. For more
information, see Options.

Configure →
Maintain Play-
back Rate

If you select the Maintain Playback Rate option, the current video playback
speed will be maintained when a new video loads.

Configure →
Show Thumbnails

If you select the Show Thumbnails option, hovering over the video trackbar will
show a thumbnail grab of the video at that position.

Configure →
Show Statistics

The statistics for each video will be displayed on the top left side of the video if
you select the Show Statistics option.

Configure → Use
Video Time

This option determines what is shown on the thumbnail when hovering over the
trackbar. When selected, the actual date and time of the video will be shown, when
unselected, the current video position will be shown (in minutes).

Configure → En-
able Time Sync

If you select the Enable Time Sync option, all the channels will be in sync (at the
same date/time in the video) when playing multiple channels.

Configure →
Copy Paths

Copies the paths of the displayed video files to the clipboard. These paths show
where the video files are stored. If you do not enable a channel on the pane, its
video path will not be copied.

13.17. Video 491



NEXUS Documentation, Release 6.9.xxxxx.0

ã See also

• Managing Videos

• Troubleshooting - Videos

13.17.2.1 Managing Videos

NEXUS allows you to record, parse and review video files during inspections. A typical process of managing video
files during inspections is depicted in the figure below and is followed by an explanation:

1. Specify the path to the project folder where videos will be recorded.

You must specify the recording folder location in your video device’s settings. For more information,
see Specify Project Path for Recording.

2. Optionally, you can configure relative asset-specific recording folder paths in NEXUS IC.

This allows videos to be recorded in separate folders for each asset. For more information, see Con-
figure Relative Recording Paths.

3. Record the videos files.

Use your video device to record video files. In IC-Inspection, you can set up video devices as de-
scribed in Add Video Devices.

4. Configure a Global or Temporary Video Path from where NEXUS IC should parse the video files.

For more information, see Configure Video Paths.

5. Ensure that the video files are accessible under the video paths that you configured for parsing.

If required, copy the video files under the relevant video path. For more information, see Copy Files
to Video Paths.

5. Parse the video files in NEXUS IC.

To ensure that NEXUS IC can play video for specific events, each new video file must be parsed. For
more information, see Parse Videos.

6. Play back and review the video files as required.

Once NEXUS has parsed the video files, it can determine which inspection events have associated
video and allows you to play the video from the INSPECTION screen. For more information, see
Video Playback.

ã See also

• Specify Project Path for Recording
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• Configure Relative Recording Paths

• Configure Video Paths

• Copy Files to Video Paths

• Parse Videos

• Video Playback

• Filename Formats

• Troubleshooting - Videos

13.17.2.1.1 Specify Project Path for Recording

Before you start recording your videos, you must define where you want the video files to be saved by your video device.

You must configure the project folder path for recording videos in the settings of the video device that you use.

If you use IC-Recorder, you specify the project path as follows:

1. In IC-Recorder, navigate to the Tools → Options menu option.

2. Go to the Project tab.

3. Enter the path to the video recording folder in the Project Location field.

4. Click OK to save your settings.

� Tip

We recommend that you record video to a local drive rather than a network drive to avoid issues related
to bandwidth, latency, and dropouts.

For more information, see Project Location.

13.17.2.1.2 Configure Relative Recording Paths

You can configure relative video recording folders in NEXUS IC, in which case, you specify an asset-specific folder
path to record video into for each asset. This path is then appended to the project path (configured in the video device’s
settings) as a subfolder. For example, if you use IC-Recorder, where you configured the recording folder path as
“E:\Video\,” and in NEXUS IC, you configured the “Main Pipeline” subfolder for a specific asset, videos will be
recorded to “E:\Video\Main Pipeline\”.

When you switch assets during an inspection and if a new relative recording folder is set, the video device will stop
recording any current video and start recording a new a video file in the folder for the current asset.

To set up a relative asset-specific recording folder path, proceed as follows:

1. Ensure that an Asset Information Group (AIG) field has been configured for storing the subfolder where the
videos should be recorded and that this AIG field is assigned to an AIG. You can configure AIGs in NEXUS IC
under Configuration → Assets → Information. For information, see Configure Asset Information Groups.

For example, the AIG called DVR, which is assigned to the asset type Pipeline, contains the field Relative
Recording Path and thus the field can be accessed for the Gas Transmission asset, which has this asset type:
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2. Under Configuration → Assets → Features, make sure that the AIG field above has been assigned to the Usage
DVR - Relative Folder. For more information, see Configure Features.

See below for an example:
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3. In the relevant AIG field, specify the relative folder path for each asset for which you want to record videos in a
specific subfolder. If you leave this field blank for an asset, the video file will be created under the project folder
path that you configured for your video device.

In the example below, you enter Wood\Gas Transmission in the Relative Recording Path field, which you have
configured above:

ò Note

When specifying the relative folder path, you must adhere to the standard naming rules for Win-
dows folder paths, for example, you must use backslashes to separate components, avoid spaces
before and after the backslashes, and so on.

Result
Using the example above, if you have specified the generic recording folder name F:\Recording in the settings
of your video device, video files will be stored under F:\Recording\Wood\Gas Transmission for this specific
asset.

13.17.2.1.3 Configure Video Paths

To ensure that NEXUS IC can parse video files, the electronic video files (wmv, mp4 etc.) must be stored in one or
more sub-folders under a network share location called the Global Video Path. Video files are NOT stored in the
NEXUS database.

If you are working offshore, in a subscriber database, or are otherwise working with video that has not yet been uploaded
to the Global Video Path, you can configure the Temporary Inspection Video Path to point to these video files.

To configure these video paths, follow the steps below:

1. In NEXUS IC, choose Database → Properties.

2. Go to the Properties tab.

3. Specify the video path for parsing as follows:

• In case of a hosted or on-premise environment, specify the global video path in the Global Video Path
field.
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• In case you’re working in an offshore environment, specify the local path where you store the videos in the
Temporary Inspection Video Path field. This will allow reviewing the videos offshore.

4. Click OK to save your changes.

13.17.2.1.4 Copy Files to Video Paths

Once you have specified the video paths from which NEXUS can parse videos (see Configure Video Paths), you must
ensure that the video files are available under these video paths. This can be done as follows:

• For hosted clients, videos are copied to the Global Video Path as part of the service.

• For clients on-premise, copying video files to the Global Video Path must be performed manually.

• If you use the Temporary Inspection Video Path in an offshore environment, you may have specified the Tempo-
rary Inspection Video Path as the folder location where videos are actually recorded, in which case, no copying
is required. However, you may have specified a secondary video location to which you’re copying the video files,
in which case, you must perform the copying to this location. It is recommended to copy the video files to a
secondary location to ensure that you have backups of them.

13.17.2.1.5 Parse Videos

Videos need to be parsed by NEXUS to ensure that NEXUS can extract key data.

13.17.2.1.5.1 Prerequisites

Before you start parsing videos, you must make sure that the video files are accessible to NEXUS IC. For information
about how you do that, check the sections below:

• Configure Video Paths

• Copy Files to Video Paths

13.17.2.1.5.2 Parsing

When new files are added under the Global Video Path or Temporary Inspection Video Path (usually after a subsea
or drone inspection has taken place), these need to be re-parsed by NEXUS. You can do this under Tools → Parse Video
from the main menu (see Parse Video). Already-parsed video will not be reparsed.

When a video is parsed, NEXUS incrementally searches all folders under the Global Video Path and/or Temporary
Inspection Video Path (if configured), searching for valid video files. NEXUS parses video files with specific filename
formats (see Filename Formats). As each file is found, NEXUS extracts the key information from each video file and
stores that key information in the database. Key information includes:

• Date-time: This information is compared with the date/time data of events to determine which events
contain the video.

• ROV name: This information is extracted from the video file name (for example, “Tiger”), and is
compared with the ROV associated with the event’s survey set to determine which videos to play for
the event.

• Channel name: This information is extracted from the video file name (for example, “Centre”,
“Port”, “Starboard”), and is used to determine which videos to turn on or off during video playback.

• Video attributes: Size, duration, and other data about the video file is retrieved.

ò Example

A video has the following name:

496 Chapter 13. Inspection



NEXUS Documentation, Release 6.9.xxxxx.0

2019-01-01 123456 - Port - [MINI ROV].wmv

From this file name, NEXUS IC determines the following:

• Date and time: 12:34 AM (and 56 seconds) on the 1st of January 2019

• Channel: ‘Port’

• ROV: ‘MINI ROV’. If the ROV name does not exist in the database, the ROV will be left empty
when the video is parsed.

Once parsed, NEXUS IC can determine which inspection events have associated video and allows the user to play the
Video from the INSPECTION screen. For more information, see Video Playback.

13.17.2.1.5.3 Tracking Parsing Progress

Video parsing is executed as a background job. When parsing is initiated, a blue ribbon appears above the Status Bar,
showing job progress and providing access to job actions.

You can also monitor and manage parsing jobs through the Job Management Console, which provides detailed status,
messages, and control options. For more information, see Job Management Console.

13.17.2.1.6 Video Playback

To review video files in NEXUS IC, you can play them back on the INSPECTION screen.

13.17.2.1.6.1 Prerequisites

You have parsed all the video files as described in Parse Videos.

13.17.2.1.6.2 Playback

When you select an event with video on the Event Listing tab of the INSPECTION screen, NEXUS will automatically
play the relevant part of the inspection video on the Video pane. Videos appear on this pane in case the following event
data and data extracted from the video match:

• Event start time

• Event end time

• ROV name

When comparing the ROV name, the following scenarios are possible:

Scenario Video Playback
The video file and the event both have no ROV set. The video plays.
Either the video file or the event has an ROV set, the other doesn’t. The video doesn’t play.
Both the video file and the event have an ROV set, but their ROVs are
different.

The video doesn’t play.

Both the video file and the event have the same ROV set. The video plays.

An event has an ROV set if it is linked to a survey set that is associated with an ROV. The ROV and event start/end date
of a video file is extracted by NEXUS IC from the filename (see Filename Formats).
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� Tip

To check if an event is associated with an ROV, select the event, go to the Survey tab of the Event
Details pane, and click in the Survey Set field. In the Select Survey Set dialog, you can see the
associated ROVs for each survey set in the ROV column:

You can also play back a series of still images. For more information, see Still Image Playback.

13.17.2.1.6.3 Still Image Playback

A series of individually timestamped images (image sequences captured via Fast Digital Imaging) can be played back
through NEXUS as if it were a video. NEXUS will play each frame at the correct time offset from the last. The
maximum acceptable gap between images is 10 seconds.

To enable NEXUS to play back the images, you must ensure the following:

• The images must be stored locally (on a computer hard drive or network drive) for self-hosted users, or are hosted
in the cloud for hosted users.

• Images must be named according to their timestamps (see Filename Formats for more information). If an image
timestamp can’t be parsed, the date/time can also be extracted from the image EXIF data. If neither of these are
present, it falls back to using the file creation time similar to parsing videos.

Depending on your environment, NEXUS can find image files as follows:

• For self-hosted users, point NEXUS to the files by setting the Global Video Path under Database→ Properties. . .
to the folder containing the images. All images in this folder and its subfolders will be included.

• For hosted clients, NEXUS will stream files from the cloud location in the Global Video Path under Database
→ Properties. . . . Only jpg format images are supported.

To view the image stream as a video, set an event within the time constraints of the series of images, and play the media
on that event.
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This feature was showcased in a video as part of What’s New 6.8.

13.17.2.1.7 Filename Formats

NEXUS IC parses the following filename formats:

• YYYY-MM-DD hhmmss - Channel Name.extension

• YYYY-MM-DD hhmmss - Channel Name - Ignored Text.extension

• YYYY-MM-DD hhmmss - Channel Name - [ROV Name].extension

• YYYY-MM-DD hhmmss - Channel Name - Optional Ignored Text[ROV Name]Optional Ignored Text.extension

• YYYY-MM-DD_hhmmss_Channel Name.extension

• DD-MM-YYYY hhmmss - Channel Name.extension

• DD-MM-YYYY hhmmss - Channel Name - Ignored Text.extension

• DD-MM-YYYY hhmmss - Channel Name - [ROV Name].extension

• DD-MM-YYYY hhmmss - Channel Name - Optional Ignored Text[ROV Name]Optional Ignored Text.extension

Note that day (DD) and month (MM) should be in double-digit format.

VisualSoft style:

• yyyymmddhhmmss.extension

• yyyymmddhhmmss@Channel Name.extension

• Ignored Text_yyyymmddhhmmss.extension

• Ignored Text_yyyymmddhhmmss@Channel Name.extension

The above formats may contain additional text or digits after the ‘ss’, which will be ignored.

• Recorded on yyyy-mm-dd at hhmmss with Channel Name.extension

PKT style:

• Ignored Text_yy-mm-dd_hh-mm-ss_z.extension

• Ignored Text_Channel Name~Ignored Text_yy-mm-dd_hh-mm-ss_z.extension

• Ignored Text~Ignored Text_Channel Name~Ignored Text_yy-mm-dd_hh-mm-ss_z.extension

In the above three formats, the ‘_z’ must be present, but ‘z’ represents a single character which will be ignored.

• Ignored Textyyyy-mm-dd hhmmssIgnored Text.extension

• Ignored Textyyyy-mm-dd_hhmmssIgnored Text.extension

• Ignored Textyyyy-mm-ddThhmmssIgnored Text.extension

• Ignored Textyyyy-mm-dd hhmmIgnored Text.extension

• Ignored Textyyyy-mm-dd_hhmmIgnored Text.extension

• Ignored Textyyyy-mm-ddThhmmIgnored Text.extension

• Ignored Textyyyymmddhhmmss_Channel Name.extension

• Ignored Textyy-mm-dd hh.mm.ss.extension

• Ignored Textyy-mm-dd hh.mm.ss_Channel Name.extension

• Ignored Textyyyy-mm-dd hh.mm.ss_Channel Name.extension
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ROV-first style:

• ROV Name_Optional Ignored Textdd-mm-yyyy hh-mm-ss.extension

• ROV Name_Optional Ignored Textyyyymmdd-hhmmss.extension

Filename formats that do not include a channel name are assigned to the channel “Digital Video”.

The ROV Name, if present, must be enclosed in square brackets. Any “Ignored Text” above may contain such a ROV
Name.

13.17.2.1.7.1 Exclude Characters

Some characters need to be excluded from filenames to ensure media Azure URLs can be constructed. If any of the
following characters are present in a video filename or anywhere in the full file path, your file may fail to upload, except
when these characters are used in the accepted filename formats.

These characters are not allowed and will cause an error:

Name Character Name Character Name Character Name Character
ampersand “&” dollar “$” plus sign “+” comma “,”
forward
slash

“/” colon “:” semi-colon “;” equals “=”

question
mark

“?” ‘At’ symbol “@” pound “#”

These characters are considered ‘unsafe’ and may cause an error:

Name Character Name Character Name Character Name Character
less
than/greater
than

“<>” open/close
brackets

“[]” open/close
braces

“{}” pipe “|”

backslash “\ “ caret “^” percent “%”

13.17.2.2 Troubleshooting - Videos

13.17.2.2.1 Video Icon Not Showing for Events with Video

Possible Causes:
The video may not have finished copying or parsing.

Solution:

• Wait for the video to be copied from your recorders to the network (if applicable).

• Check whether NEXUS can see the required video files under Tools → Video. . . (see Video. . . ).

• Confirm that the videos have been parsed successfully (see Parse Video).

13.17.2.2.2 Expected Videos Not Playing for Events with ROV

Possible Causes:
• If the event has a survey set associated with an ROV, only videos from that ROV will be played back (see Video

Playback). Your event may be associated with a survey set that specifies an ROV, but the available videos are
not from that ROV.
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• The required video files are not visible to NEXUS.

• The videos have not been parsed successfully.

• The filenames of the expected videos do not contain the name of the associated ROV.

Solution:

• Check whether NEXUS can see the required video files under Tools → Video. . . (see Video. . . ).

• Confirm that the videos have been parsed successfully (see Parse Video).

• Ensure that the filenames of all expected videos contain the name of the ROV associated with the survey set of
the selected event.

13.17.2.2.3 Expected Next Video Is Not Playing

Possible Causes:
NEXUS automatically plays the next video in a sequence if the following conditions are met:

• The start time of the next video file is less than 10 seconds after the end time of the current video, or
• The start clock of the next event is less than 10 seconds from the end clock of the current event, and
• The channel names in the video filenames match.

If the next video is not playing as expected, it may be due to one or more of the following:

• The time gap between the end of one video or event and the start of the next exceeds 10 seconds.

• The channel names in the video filenames do not match.

Solution:
• Ensure that the time gap between the end of one video and the start of the next is less than 10 seconds.

• Ensure that the start clock of the next event is less than 10 seconds from the end clock of the current event.

• Check that each video filename includes a channel name.

• Confirm that the channel names match exactly between the video files.

13.17.2.2.4 Video Plays on One Machine but Not on Another

Possible Causes:
This issue is most likely related to a missing or incompatible codec. NEXUS relies on Windows Media Player to play
videos within its video frame, and playback is limited to formats that Windows Media Player can decode. Many video
file extensions (such as .avi) are container formats that can encapsulate video streams encoded in various ways. As a
result, one .avi file may play successfully while another with the same extension may not, depending on the internal
encoding and available codecs on the system.

Solution:

Install the appropriate codec on the affected machine.

To determine which codec is required, use GSpot (GSpot), a reliable tool for inspecting codec details for a particular
file:

1. Run GSpot on both a machine where the video plays and one where it does not.

2. Drag the video file into GSpot on each machine.

3. Click the ‘1’ and ‘2’ buttons near the bottom (there are multiple sets - try them all).

4. Compare the output to identify differences in codec support.
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If the required codec cannot be identified, try installing the Shark Codec pack, which supports a wide range of video
formats.

13.17.2.2.5 Issues with the Audio

NEXUS allows you to control which channels play audio during video playback. This is useful when multiple channels
contain identical audio that may be slightly out of sync. For example, if filenames specify start times only to the nearest
second, two files could easily play 0.9 seconds apart. The audio controls also allow you to disable audio entirely or
selectively mute channels that contain audio.

Solution:

Try the following:

• If too many channels are playing audio simultaneously, turn off audio on all but one. You can do this using the
Channels toolbar menu options on the Video pane of the INSPECTION screen, or by clicking the speaker icon
on each channel to mute or unmute it.

• If no audio is playing, ensure that audio is enabled in the Video pane.

• If you’re using a headset or external speakers, try unplugging and reconnecting them. This can prompt Windows
to route audio correctly.

• Check the system volume controls in the Windows system tray (bottom-right corner of the screen). To determine
whether the issue is with NEXUS or your PC, try playing audio from another application (such as Windows
Media Player).

13.17.2.2.6 When Playing Video for an Event, Multiple Copies of a Single Video Channel Appear

Possible Causes:
This typically occurs when multiple copies of the same video file exist in one or both of the configured video paths.
For example, if your Global Video Path contained Folder1\\Video1.wmv and Folder2\\Video1.wmv (that is, two
copies of the same file), or there is one copy of Video1.wmv in the Global Video Path and another in the Temporary
Inspection Video Path, NEXUS will identify “both” files as being appropriate for the time range covered by that event,
and will therefore display both.

Solution:

Remove any duplicate video files from the configured video paths. The Windows Explorer search feature can help
locate files with the same name across multiple folders.
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CHAPTER

FOURTEEN

ANOMALY MANAGEMENT

Once the inspection process is completed and anomalies have been identified from findings, anomalies can be reviewed
and managed in NEXUS IC.

The general process is depicted in the figure and described below.

ò Note

This workflow represents a simplified version of a basic anomaly management process. Your specific
process may vary based on your unique business requirements and implementation.

1. Reviewing engineers can create anomalies directly from findings, in which case, a link is automatically created, or
they can create individual anomalies (see Create Anomalies) and link them from findings later (see Link Finding
to Anomaly). Anomalies can also be bulk imported to NEXUS IC.

2. Reviewing engineers must review each anomaly and create anomaly actions as required (see Anomaly Actions).

3. Anomaly actions can be assigned directly to an individual for execution with a specific due date. Alternatively,
if required, a task can be assigned to initiate an inspection process (see Assign Task to Anomaly Action).

4. The anomaly action or the task must be executed. In case of a task, once the inspector has completed it, an event
is generated, and the finding resulting from this event must be linked back to the original anomaly.

5. Once the anomaly action or task has been executed, a reviewing engineer must review the anomaly action and
determine if it can be marked as completed (see Complete Anomaly Actions).

6. After the anomaly actions have been completed, the anomaly undergoes another review to assess whether it can
be closed.

7. If the anomaly has been remediated, it can be closed (see Close Anomalies), signifying the end of the anomaly
management process.

14.1 ANOMALIES Screen
The ANOMALIES screen is made up of the following main parts:
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• The toolbar on the top of the screen area (see Anomalies Toolbar)

• The top left part of the screen shows you the list of anomaly records, where you can review and
manage them (see Anomalies). This grid contains columns for the main parameters of the anomalies
as well as some additional calculated columns, such as Action Status, Action Overdue and so on.

• The top right part of the screen shows any multimedia files that belong to the anomaly record selected
on the left part of the screen (see Multimedia).

• The bottom left part of the screen has three main tabs:

– Actions, where you can manage anomaly actions that belong to the anomaly selected on the top
of the screen (see Anomaly Actions).

– Findings, where you can check and manage findings that belong to the anomaly selected on the
top of the screen (see Findings).

– Library, where you can manage library items that belong to the anomaly selected on the top of
the screen (see Library).

• The bottom right part of the screen shows the anomaly risk matrix (see Risk Matrix).

14.1.1 Filter Anomalies
You can filter anomaly records in the grid based on:

• Workpacks - Choose Filter → Workpack . . . from the toolbar to select the workpacks based on which you want
to filter the anomalies. Workpacks are linked to anomalies via the linked findings and events.

• Event Type - Choose Filter → Asset . . . from the toolbar to select the assets based on which you want to filter the
anomalies. Assets are linked to anomalies by the asset chosen in the anomaly record itself AND by the linked
findings and events.

To clear all the filters by choosing Filter → No Filter from the toolbar.
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� Tip

Use the grid Grouping functionality to group and filter anomaly records. It is a quick and easy way
to drill down to the anomalies that you are particularly interested in reviewing. All columns in the
grid can also be filtered and sorted using the standard filtering (see Filtering) and sorting (see Sorting)
functionality.

14.1.2 Anomalies Toolbar
For information about the main toolbar menu options on the ANOMALIES screen, see below:

Toolbar Option Description
Add See Create Anomalies and Add/Edit Anomaly Dialog.
Edit Allows you to update the anomaly record. See Add/Edit Anomaly Dialog.

You can also bulk update anomalies using the standard grid functions (see
Multi-Edit).

Delete Deletes the records from the database. You can also bulk delete records
using the standard grid functions (see Multi-Edit).

Connections See Connections.
Import See Import.
Export See Export.
Customise See Customise.
Anomaly → Close
Anomaly

Closes the anomaly. See Close Anomalies.

Filter → No Filter/By
Workpack . . . /By Event
Type . . .

See Filter Anomalies.

Show Count Shows the number of anomalies with the specific risk score on the Anoma-
lies Risk Matrix (see Risk Matrix).

Reports See Reports.

14.2 Anomalies
Anomalies are records that identify discrete items or areas of concern. An anomaly is created when the finding is
deemed serious enough to require action, for example, monitoring, fabric maintenance, repair, replacement, and so on.
Anomalies are created and ranked in NEXUS IC to record areas of concern and prioritise actions to remediate to ensure
no further significant degradation.

An anomaly record may have been originated from an inspection item (which means that it will have a finding linked
to it) or it may be a stand alone record created outwith the integrity and inspection cycle (ad-hoc).

In NEXUS IC, you can manage anomalies either from the Anomalies tab on the ASSETS screen (see Anomalies), or
on the ANOMALIES screen (see ANOMALIES Screen).

You can perform the following actions on anomalies:

• Create, edit, or delete anomalies (see Create Anomalies and Add/Edit Anomaly Dialog).

� Tip

To bulk update or delete anomalies, use the Multi-Edit grid functionality.
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• Import (see Import) or export (see Export) anomalies.

• Close anomalies (see Close Anomalies).

• Create anomaly actions for anomalies (see Anomaly Actions).

• Check and edit findings associated with anomalies (see Findings).

• Attach or review library items associated with anomalies (see Library).

14.2.1 Report Table Sources
To extract anomaly data into a report template, use the System Table titled Anomaly as the primary Table Source. For
more information on Report Templates see Configure Report Templates.

14.2.1.1 Create Anomalies

Anomalies can be created in a number of ways within NEXUS IC, including:

• You can bulk import anomalies (see Import).

• You can create a new anomaly whenever you want to link it from a record, such as a finding record (see Link
Finding to Anomaly) or a library item in NEXUS IC, and you click Add in the dialog from which you want to
link it. This triggers the Add Anomaly dialog (see Add/Edit Anomaly Dialog).

• You can create new anomalies independently as described below.

14.2.1.1.1 Add Anomalies Manually

1. Start adding the anomaly in either of the following ways:

• On the ASSETS screen, choose Add on the Anomalies tab.

• On the ANOMALIES screen, choose Add from the main toolbar.

2. In the Add Anomaly dialog, enter the details of the anomaly as required. For information about
filling the fields in this dialog, see Add/Edit Anomaly Dialog.

When creating the anomaly, you must assign it to an asset and specify a unique name for that. The
Severity and Priority parameters are used for scoring the anomaly and thus, it’s recommended to
specify them to ensure the anomaly is correctly prioritised and can be accurately assessed.

3. Click OK.

ò Result

The new anomaly record is added to the list on the ANOMALIES screen and is also visible
on the Anomalies tab of the ASSETS screen if you select the asset which you linked the
anomaly to.

14.2.1.2 Close Anomalies

Once the anomaly actions have been completed and the anomaly has been remediated, you can close the anomaly. To
do that, follow the steps below:

1. Select the anomaly and proceed in either of the following ways:

• On the ASSETS screen, choose Shortcuts → Close Anomaly on the Anomalies tab.

• On the ANOMALIES screen, choose Anomaly → Close Anomaly from the main toolbar.
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2. In the Edit Anomaly Action dialog that appears, you can specify properties for the close-out anomaly
action that will be created, such as the reason and person responsible for the close-out, and so on.
The date of completion is automatically filled with the current date and the percentage of completion
is set to 100.

3. Click OK.

ò Result

The close-out status of the anomaly changes to Closed and is visible in the Closed Out col-
umn. The Closed Out checkbox in the Edit Anomaly dialog gets ticked. A new anomaly
action is created for the close-out, which you can see on the Actions tab on the ANOMA-
LIES screen.

ò Note

It is also possible to close an anomaly by ticking the Closed Out checkbox in the Edit Anomaly dialog (see Add/Edit
Anomaly Dialog), however, that does not create an anomaly action for the close-out, thus, it is not recommended.

14.3 Anomaly Actions
An anomaly may have one or more anomaly actions associated with it. These actions can be assigned to individuals,
teams, or departments, and may include a due date to ensure timely resolution of the anomalies.

You can assign tasks to anomaly actions that triggers an inspection process. However, anomaly actions are not neces-
sarily inspection type actions (for example, confirm WT reading). The anomaly actions functionality can be used as a
reminder to initiate a study with a vendor, or to have a discussion with an OIE about access.

You can perform the following actions on anomaly actions:

• Create, edit, or delete anomaly actions (see Create Anomaly Actions, Add/Edit Anomaly Action Dialog and
Add/Edit/Delete).

� Tip

To bulk update or delete anomaly actions, use the Multi-Edit grid functionality.

• Import (see Import) or export (see Export) anomaly actions.

• Assign tasks to anomaly actions (see Assign Task to Anomaly Action).

• Assign planning tasks to anomaly actions (see Assign Anomaly Action to a Planning Task).

• Complete anomaly actions (see Complete Anomaly Actions).

14.3.1 Report Table Sources
To extract anomaly action data into a report template, use the System Table titled Action as the primary Table Source.
For more information see Configure Report Templates.
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14.3.1.1 Create Anomaly Actions

Anomaly actions can be created through bulk import (see Import) or following the process below.

1. Start adding the anomaly action in either of the following ways:

• On the ANOMALIES screen, select the relevant anomaly and on the Actions tab, choose Add
from the tab’s toolbar.

• Edit the anomaly (either from the ASSETS or the ANOMALIES screen) and in the Edit
Anomaly dialog (see Add/Edit Anomaly Dialog), on the Actions tab, choose Add.

2. In the Add Anomaly Action dialog, enter the details of the anomaly action as required. For infor-
mation about filling the fields in this dialog, see Add/Edit Anomaly Action Dialog.

You can assign a due date for the action in the Action Before field and assign it to a user or user
group in the Assigned To field.

If you want to assign a task to the anomaly action later, you must assign an event type to the action
type in the Action Type field. To do that, when you select the action type using the in the Action
Type field and you add or edit an action type, ensure that you select an event type in the Event Type
field of the Edit Action Type dialog.

3. Click OK.

ò Result

The new action item gets listed on the Actions tab of the ANOMALIES screen and on the
Actions tab of the Edit Anomaly Action dialog.

14.3.1.2 Navigate to Anomaly

In case you have several anomaly actions displayed on the Actions tab of the ANOMALIES screen, which belong to
multiple anomalies in the anomaly list above, you can use the Navigate to Anomaly toolbar button to navigate directly
to an anomaly from a selected anomaly action.

On the Actions tab, select an anomaly action, and click Navigate to Anomaly.

In the anomaly list above, the grid will change so that the relevant anomaly gets selected. The actions tab will now
show only the anomaly actions related to the selected anomaly.

14.3.1.3 Assign Task to Anomaly Action

If required, you can assign one or more tasks to an anomaly action to trigger an inspection process. This task can then
be assigned to inspectors, who can execute the task and create the respective events. Findings created from these events
must be linked back to the original anomaly so that you can follow up the status of the anomaly action.

14.3.1.3.1 Prerequisites

To be able to link a task to an anomaly action, you must assign an event type to the action type of the anomaly action
in the Add/Edit Anomaly Action dialog (see Add/Edit Anomaly Action Dialog):
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14.3.1.3.2 Assign Task

1. Start assigning the task to the anomaly action in either of the following ways:

• On the ANOMALIES screen, select the relevant anomaly and on the Actions tab, choose Short-
cuts → Assign Task from the tab’s toolbar.

• Edit the anomaly action (either from the ASSETS or the ANOMALIES screen) and in the Edit
Anomaly Action dialog (see Add/Edit Anomaly Action Dialog) go to the Tasks tab.

2. Choose Add to create a new task.

3. In the Add Task dialog, enter the parameters of the task (see Add/Edit Task Dialog). You must assign
the task to a workpack.

4. Click OK.

ò Result

The task gets assigned to the anomaly task and it is visible on the Tasks tab of the Edit Anomaly
Action dialog. On the Actions tab of the ANOMALIES screen, the value of the Is Tasked?
column changes to Yes.

ò Note

• You can also assign an anomaly action to an existing task on the PLANNING or WORKPACKS
screen by editing the task and selecting the relevant anomaly action from the Anomaly Action
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field (see Add/Edit Task Dialog). Note that the task’s asset and the anomaly action’s asset must
match.

• You can assign the anomaly action also to a planning task (see Assign Anomaly Action to a
Planning Task).

14.3.1.4 Complete Anomaly Actions

Once the anomaly action has been completed, you can set its status to completed as follows:

1. On the ANOMALIES screen, select the anomaly action on the Actions tab and click Edit.
2. In the Edit Anomaly Action dialog (see Add/Edit Anomaly Action Dialog), enter the completion date in the

Completed At field.

3. Click OK.

ò Result

The status of the anomaly action changes to completed and the Completed At column on the Actions tab
displays the completion date you have specified. The status in the Is Due column of the Actions tab changes
to Action is complete and the status in the Action Status column in the anomaly grid changes to Complete.

ã See also

• Create Anomaly Actions

• Navigate to Anomaly

• Assign Task to Anomaly Action

• Complete Anomaly Actions

14.4 Findings
A finding is the link between an anomaly and an inspection or survey event. Findings are either escalated and linked
to an anomaly (see Link Finding to Anomaly) or deemed “insignificant” and remain simply as an observation on the
source event. For more information, see Findings.

You can check findings associated with selected anomalies on the Findings tab of the ANOMALIES screen. Findings
displayed on this tab have been “escalated” during the finding review process and linked to the selected anomalies.

The columns that you see on this tab mostly correspond to those on the Findings Listing tab of the INSPECTION
screen (see Findings Listing). On the right-hand side of the tab, you can see the details of the source event associated
with the finding, as well as the relevant survey data. This corresponds to the Event Details pane on the INSPECTION
screen (see Event Details).

14.5 Library
On the Library tab of the ANOMALIES screen, you can see and manage all the library items attached to the selected
anomalies as well as library items that are linked to the anomaly’s assets. This functionality corresponds to that of the
LIBRARY screen.
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Note that library items for anomalies are not inherited from the related event. If you want to attach the same library
item to an event and an anomaly, you can create a library connection from the library item to both the anomaly and the
event (see Library Connections).

14.5.1 Library Items
Library items are electronic documents that can be linked to data and data types in NEXUS IC using connections (see
Library Connections).

The electronic documents can be uploaded directly into the NEXUS IC database, or can be referenced using URL or
UNC paths.

14.5.2 Manage Library Items
You can manage library items from several screens within NEXUS IC, including:

• Library Items tab on the LIBRARY screen (see Library)

• Library tab on the ASSETS screen (see Library)

• Library tab on the INSPECTION screen (see INSPECTION)

• Library tab on the ANOMALIES screen (see ANOMALIES)

• Library tab under Configuration → General → Functions → Edit Function Definition

• Library tab on the Edit Asset Type dialog under Configuration → Assets → Types

• Library tab on the Edit Table Definition dialog under Configuration → Events → Event Types →
Edit Table Information

Example
If you upload company piping specifications to the NEXUS IC Library and assign it to the asset type
“Pipework”, the piping specifications will be available from the Library* tab of the ASSETS screen when-
ever the active asset is of type “Pipework”.

You can also maintain library items on the Library pane of IC-Inspection.

You use the standard toolbar functions on the Library/Library Items tab to add, edit, delete, import, export library items
or customise the grid layout. For more information about these functions, see Using the Grid.

ò Note

• You can edit the properties of the selected library item from the toolbar, but not the document
itself.

• Deleting a library item will also delete all its associated connections.
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• The Export option only exports the grid contents, not the actual library documents.

See below for more information about some actions you can perform on library items:

ò Add Library Items

To create a new library item, proceed as follows:

1. Start adding a new library item in one of the following ways:

• On the Library/Library Items tab, choose Add from the toolbar.

• Drag files from your file explorer onto the Library/Library Items tab.

ò Note

Drag-and-drop is not supported in remote environments (e.g., Remote Desktop).

2. Depending on the screen from which you accessed the Library tab, you may be prompted to select a con-
nection type. You can connect a library item to different types of data records:

Screen Connection Type
ASSETS

• Asset
• Asset Type

INSPECTION
• Asset
• Asset Type
• Event
• Event Type
• Workpack

ANOMALIES
• Anomaly
• Asset

ò Note

If you’re adding a library item from the LIBRARY screen, you add the connection to a data record from
the Connections tab after you have created the library item. For more information, see Add Library
Connections.

3. In the Add/Edit Library dialog, select the library type, enter a name for the library item (mandatory) and
enter other parameters as required. For information about filling in all the parameters, see Add/Edit Library
Dialog.
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• If the document is to be uploaded into NEXUS IC, then click on the Attachment button, else enter a
Hyperlink location.

• When adding an attachment, you can either Import or Link it:

– If you import, the item will be saved to the database. If you subsequently change the original on
disk, the item in the database will not change to match.

– If you link the item, then when you change the original on your disk, the next time you view the
item within NEXUS IC, you’ll see the updated item.

ò Note

• NEXUS IC still loads a copy of a linked item into the NEXUS database. This ensures
that if the original is unavailable (for example, because you are away from your network),
NEXUS IC can display the cached copy.
When you view the item, if the original has been updated, the database cached copy is
updated too. You can’t link items that are on your local hard disk, only items on network
drives can be linked. The Link feature is designed to keep you up-to-date with items
that may have been changed by others, and that is not possible on your local drive.

• If you drag and drop multiple files, they will be added, and then multi-selected in the
grid. You can then click Edit to multi-edit them (see Multi-Edit). Drag and drop will
import items, not link them.

4. Click OK.

On the LIBRARY screen, you can view the details of the library item by selecting it and checking the Details
tab under the Library Items tab.

ò Edit Library Items

To edit an existing library item, proceed as follows:

1. On the Library/Library Items tab, select the library item.

2. Choose Edit from the toolbar.

3. In the Edit Library dialog, update data as required. For more information, see Add/Edit Library Dialog.

4. Click OK to save your changes.
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ò Delete Library Items

To delete an existing library item, proceed as follows:

1. On the Library/Library Items tab, select the library item.

2. Choose Delete from the toolbar.

3. In the confirmation dialog, click Check Connections if you want to review any connections to this library
item before deletion.

4. If you want to proceed deleting the library item, click Delete, else, choose Cancel.

ò Launch Library Items

Use the Launch toolbar button to launch library items on the local machine. By default, NEXUS only launches
files with the following extensions: doc, docx, xls, xlsx, jpg, png, jpeg, jfif, bmp, tiff, gif, mpg, mp3, wav, ppt, pptx,
txt, pdf, emf, zip, dwg, avi, rtf, mp4, csv.

� Hint

Use the Space Bar on your keyboard to launch the currently selected library item.

Note that if the local machine does not have an associated viewer for the document type (for example, AutoCad
viewer for DWG type), then the document can not be launched.

ò Email Library Items

Use the Email toolbar button to send an email message with the selected library items attached to it.
You can select multiple library items to be sent in the same email message. Note that you must have
properly configured your email settings (see Set Up Email) for this option to function.

. Warning

If the size of the attachment exceeds your organization’s attachment size limit, you may get an “Out
of memory” error message.

ò Import Library Items

You can import library items using the standard Import toolbar option (see Import). You can download the MS
Excel Import Template, which shows the required format for importing library items.

You can also import the Connections in the same import as the library items, so in addition to the Library Import
columns, you can additionally define the Connection information using the following column headings:

• Library Connection.Connect To

• Library Connection.Workpack
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• Library Connection.Asset Type

• Library Connection.Asset

• Library Connection.Event Type

• Library Connection.Event

• Library Connection.Anomaly

• Library Connection.Risk Model

• `Library Connection.Function

Note that the Connect To column should only contain one of the following text items:

• Anomaly

• Asset

• Asset Type

• Event

• Event Type

• Function

• Risk Model

• Workpack

14.5.2.1 Double-click

The first time you double-click on a library item, NEXUS asks you whether you want to launch the library item in
an external editor, or edit the library item. If you want your choice to become permanent, tick the Always do this
checkbox. Note that if you hold down the Alt key while double-clicking, you will be asked again.

14.6 Multimedia
Multimedia are electronic images that have been uploaded against any of the events linked to the currently selected
anomalies. Anomaly records inherit all multimedia images from the events associated with them.

Multimedia items are displayed as thumbnails on the right side of the ANOMALIES screen for the anomaly or anoma-
lies that you have selected.
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14.6.1 Multimedia Toolbar
You can use the following options in the toolbar of the Multimedia pane to perform actions on multimedia files:

Toolbar
Option

Description

Add See inspections.multimedia.add. You can only add new multimedia files to events on the
INSPECTION screen, you cannot add new multimedia files on the ANOMALIES screen.

Edit Launches the Edit Multimedia dialog. You can update and save the properties of the mul-
timedia file. See Add/Edit Multimedia Dialog.

Delete Deletes the currently selected multimedia records. If multiple multimedia items have been
selected, then a dialog pops up that shows how many multimedia items will be deleted and
prompts you to confirm by clicking Delete.

Launch Launches the currently selected multimedia file into the default Windows viewer for the
selected file type. Note that if your image viewer supplies “Next” and “Previous” buttons,
these will show you the next and previous files in the temp folder, which may not be the next
and previous images in NEXUS.

Preview See inspections.multimedia.preview.
Crop See inspections.multimedia.crop.
Export See Export.
Cus-
tomise

See Customise.

14.6. Multimedia 517



NEXUS Documentation, Release 6.9.xxxxx.0

14.7 Risk Matrix
On the ANOMALIES screen, you can display the risk assessment results for anomalies on a risk matrix, which is
visible at the right or bottom right of the screen.

14.7.1 Prerequisites
To enable displaying the risk matrix on the ANOMALIES, you must set it up as described in Set Up Anomaly Risk
Matrix.

14.7.2 Display Options
When displaying the risk matrix, note the following:

• Where there are several risks at the same location in the chart, the dot will be shown larger.

• Clicking on an anomaly or anomalies in the grid highlights that item in the risk matrix. Similarly, clicking on a
result indicator in the matrix will highlight the relevant anomaly or anomalies in the grid.

• The matrix legend is displayed below the chart, with coloured indicators for open and closed anomalies. Legend
keys can be clicked to toggle showing their corresponding anomalies on the matrix.

• If you want to see the total number of risk assessments at the specific locations of the risk models, click Show
Count in the main toolbar of the screen.
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14.7.2.1 Set Up Anomaly Risk Matrix

To enable displaying the risk assessment results for anomalies on the ANOMALIES screen, you must set up the
functionality as described below.

1. Set up the risk chart, which determines the axes and the number of squares on the risk matrix as well as the risk
colours and risk values that belong to each square. For more information, see Configure Risk Charts.

For example, in the risk chart below, you want to have Severity on the X axis with a granulation of 3, and on the
Y axis, you want to have Priority on the Y axis with a granulation of 5.
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Severity and Priority are parameters of the anomaly (defined in Add/Edit Anomaly Dialog), but you can use other
parameters as required.

ò Note

Anomalies do not have a Likelihood or Consequence to give them an X/Y position on the diagram. Instead,
their placement is solely determined by the risk score, which is calculated using a specific function called
System - Anomaly - Risk Score (see next step). The numerical value of the risk score corresponds to the
square in the risk matrix where the anomaly will be positioned. The matrix must be defined to only have
unique values in each square.

2. Under Configuration → General → Functions, configure the System - Anomaly - Risk Score function, which
calculates the actual risk score of each anomaly. For more information, see Configure Functions. The result of
this function is a number that will be used to position the anomaly in the corresponding square inside the risk
matrix.

The System - Anomaly - Risk Score function is predelivered with the basic asset or anomaly parameters in-
cluded. You cannot add new parameters to this function, however, you must set up the connections for the
parameters that you want to use.

Using the example from the previous step, if you want to use the Severity and Priority parameters of the anomaly,
you can configure the function as follows:

In this example, you draw a connection from the Priority Level and Severity Level parameters as well as a default
constant value to a matrix element. In the matrix element, you set up the specific risk score values to be applied
for each combination of the Priority Level and Severity Level parameter values. You can also set up a default
value to be applied in case these input values are not accessible. From the matrix element, you draw a connection
to the result element to complete the configuration of the function.

3. In your database properties, specify the anomaly risk chart to be used when you open the ANOMALIES screen.
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To do that, under Database → Properties, go to the Settings tab and select the risk chart defined above in the
Anomaly Risk Chart field. For more information, see Properties Dialog.
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CHAPTER

FIFTEEN

IC-INSPECTION

IC-Inspection is an on-line eventing software application optimised for use in the offshore environment. IC-Inspection
is built around a Microsoft SQL Server relational database with events (items of inspection) referenced to positional
data and assets.

15.1 Offshore Deployment
In the majority of cases, IC-Inspection is set up in an offshore environment.

IC-Inspection is typically installed on a computer or laptop, which can then be configured to interface with the following:

• Survey systems, showing time, date, and ROV position

• ROV video inputs, enabling image and video sequence references to events

• Digital video recorders, such as IC-Recorder

• Other computers/laptops with NEXUS IC installed for offline data review

• Instruments, such as CP Probes, FMD, providing automatic data input of results

• Other digital input devices, through customisation of the software to suit the input string

For more information about setting up IC-Inspection in an offshore environment, see Offshore Deployment.

15.2 Using IC-Inspection
The IC-Inspection package is teamed with IC-Recorder to provide a digital recording package for real-time based
online eventing. Multi-camera, sonar and profiling data can be recorded digitally with positional data displayed by
IC-Recorder. NEXUS Integrity Centre (NEXUS IC) is used to configure the database, event definitions and other
relationships used within IC-Inspection. It is also used to perform offline inspection and anomaly management after
inspection has been completed in IC-Inspection.

See the image below for information about the whole inspection process using NEXUS IC, IC-Inspection and IC-
Recorder:

To perform inspection, you use IC-Inspection together with NEXUS IC and IC-Recorder as follows:

1. NEXUS IC Configuration:
Set up and configure the NEXUS IC database, including assets, event types, workpacks and optionally tasks,
drawings and anomaly triggers.
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2. IC-Inspection Setup and Configuration:
• Connect IC-Inspection to the same NEXUS IC database.

• Configure IC-Inspection settings, including desktops, devices, survey fields and optionally event templates.

3. Online Inspection in IC-Inspection:
• Use the task list or the drawings to drive the inspection, completing tasks until none remain (see Create

Event from Task).

• Launch ad hoc events when necessary (see Create Ad Hoc Event).

• Fill out event forms in IC-Inspection, optionally attaching still images from digital video recorders (see
Attach Multimedia to Event).

• If needed, raise findings from the events (see Create Findings).

4. Offline Review in NEXUS IC:
Perform an offline review of inspection data (see Inspection) and, if required, trigger an anomaly management
process (see Anomaly Management).

A training manual, showing how to use IC-Inspection for offshore eventing and NEXUS IC for offshore review, is
available.
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15.2.1 IC-Inspection Screen
The IC-Inspection screen is made up of the following main elements:

15.2.1.1 Main Menu

The main menu is similar to the main menu of NEXUS IC except for the Configuration menu option, which is only
available in NEXUS IC. In IC-Inspection, you can use the following menu options:

• Database (see Database)

• Tools (see Tools)

• Help
Allows you to open the NEXUS Online Help, email Support, or navigate to the NEXUS website.

15.2.1.2 Main Toolbar

For more information, see Main Toolbar.

15.2.1.3 Asset Tree

The asset tree (see Asset Tree) is a pivotal element of the screen as all event records will be filtered by the currently
selected asset, or its children if Child Assets is enabled. For more information, see Assets.

15.2.1.4 Panes

The panes on the IC-Inspection screen allow you to prepare and perform inspections and review inspection data. These
panes can be shown or hidden, dragged around, pinned or unpinned (see Manage My Desktop). For detailed information
about how to use the specific panes, see IC-Inspection Panes.
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15.2.1.5 Manage Your Desktop

The INSPECTION screen offers a “desktop manager” functionality that allows you to set up your screen as required.
For example, you can view or hide panes, drag and drop them and create different desktop layouts for different purposes.
For more information, see Manage My Desktop.

15.2.1.6 General Features

To learn how the grids and toolbar buttons presented in many of IC-Inspection’s panes work, see General Features.

15.2.1.6.1 Manage My Desktop

The “desktop manager” functionality in IC-Inspection and on the INSPECTION screen of NEXUS IC works in the
same way. It allows you to freely set up your screen based on your requirements, view or hide panes, drag and drop
them and save your layout as a desktop.

15.2.1.6.1.1 View/Hide Panes

You can make panes visible or invisible on the screen by selecting or deselecting the relevant option from under the
View toolbar button on the screen. You can also hide a pane by closing the pane with the icon at their top right
corner.

15.2.1.6.1.2 Drag and Dock Panes

You can drag panes around the screen and dock them wherever you want to see them.

When you are dragging a pane over an existing pane, you will see a pale blue highlight and/or a set of icons:

If you drag the pane over one of the icons, the pale blue highlight shows where the pane will drop, and the new size
and shape it will take on. If you drop the pane onto one of the icons, the pane will dock appropriately: dropping it onto
the centre square icon will make this pane part of the tab group; dropping it on the left, right, top or bottom icons will
split the current pane and drop this pane to the left, right, top or bottom of it.

If you drop a pane outside the main pane, they will become “floating” panes.

Areas with no panes present are considered a ‘void’. If you drop a pane into the centre of that void, the dropped pane
fills the void, and subsequent drops can split that pane into parts. If you drop a pane into the left, right, top or bottom
of the void, then the void is split, but the right, left, bottom or top will still contain the void.
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15.2.1.6.1.3 Pin/Unpin Panes

You can click on to “unpin” panels so that they collapse to an edge of the pane. To recover an unpinned pane, click
on the pane’s name at the edge of the pane, then click on the icon.

15.2.1.6.1.4 Resize Panes

You can resize panes with the “splitter” at each edge between two docked windows. When you move the mouse over a

splitter the mouse cursor will change to a or split arrow. Drag the splitter to resize the windows.

The difference between floating and docked windows is that docked windows will resize together. When you drag
a splitter, one window will get bigger while another gets smaller. Thus, docked windows never overlap each other.
Typically most or all of your windows will be docked.

15.2.1.6.1.5 Create/Save/Delete Desktop Layout

You may need different desktop layouts for different purposes. For example, if you’re performing a structural type
inspection, you may need to see multimedia images, however, if you’re reviewing corrosion growth rates and thickness
readings, you may not be interested in multimedia but you want to see the charts to view the trend lines and so on. You
can set up different desktop layouts and switch between using the toolbar buttons on the top of the screen:

• To switch between desktops, select the required desktop from the drop-down list available under the
Desktop toolbar button.

• To save the changes that you’ve made to the current desktop, click the toolbar button for Save the
active desktop. Settings are not automatically saved when you close the program.

• To create a new desktop, arrange the desktop as required and click the toolbar button for Add a new
desktop with the current layout to save the current arrangement of panes. You can name the desktop
as required.

• To delete an existing desktop layout, click the toolbar button for Delete the currently active desktop.

• To restore the desktop to the default layout pre-delivered with the system, click the toolbar button
for Restore the default desktops. This option is available only in IC-Inspection.

� Tip

If you have two monitors, it may be useful to spread across both, either by clicking the “Restore Down”
button at the top right of the pane if necessary and then dragging the main application window larger,
or by floating panes such as Drawings and then dragging the floating panes onto the second monitor.

In IC-Inspection, the following three desktop layouts are pre-delivered:

• Setup Desktop: Layout optimised for setting up IC-Inspection, including visible panes such us Devices or Sur-
vey Values.

• Pipelines Desktop: Layout optimised for the inspection of pipelines.

• Structures Desktop: Layout optimised for the inspection of structures.
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15.2.1.6.2 Main Toolbar

The main toolbar on the IC-Inspection screen allows you to control IC-Inspection in general. Individual panes have
their own toolbar to perform functions specific to those panes.

Toolbar Option Description
Back Allows you to return to assets that you had previously selected in the asset tree.
Forward Allows you to return to assets that you had previously selected in the asset tree,

after you’ve used the Back button.
Assets → Show
Asset Type

Toggles the display of the asset type in the hierarchy.

Assets → Expand
Children

Expands all subnodes (children, grandchildren) of the selected asset. You can also
press the * key on the numeric keypad.

Assets → Col-
lapse Children

Collapses all subnodes (children, grandchildren) of the selected asset.

Assets → Copy to
Clipboard

Copies either the asset name or full hierarchy location of the selected asset to the
clipboard.

Assets→ Show on
Drawing

Shows a list of drawings that have this asset as a layer. Click on a menu item to go
to that drawing. If the drawing name has “(Different Asset)” after it, the drawing
you will be taken to is not available on the current asset; thus, when you select the
menu option, you will not only be taken to that layer on that drawing, you will also
be navigated to the new asset. You can get back by using the Back toolbar button.

Assets → Other
Locations

Shows a list of other locations that this asset exists in on the asset tree (including
in other Asset Views). Click on a menu item to navigate there. If this asset does
not appear in any other locations, you will not see any items in this list.

Assets → Con-
nections

See Connections.

Asset Views See Asset Views.
Traffic Lighting See Traffic Lighting.
Start Starts the inspection.
Stop Stops the inspection.
Disable Survey
Logging

Toggles on or off survey logging during an inspection. This option can only be
toggled while an inspection is not running. IC-Inspection shows a warning if an
inspection is started with Survey Logging disabled and a survey device is enabled
(except for Scale devices).

View The items under this menu option show the various panes available on the IC-
Inspection screen. Click a menu item to show or hide them. Checked items are
visible.

Desktops If you have several saved desktop configurations for this screen, select which one
is active here. For IC-Inspection, the Setup Desktop, Pipelines Desktop and
Structures Desktop configurations are pre-delivered.

Save Desktop If you have made changes to the currently selected desktop, click this to save them.
Otherwise, when you restart the application, your changes will be lost.

Add Desktop You can add a new desktop layout using this option. Any changes that you made
to the visible/invisible panes and their location on the screen will be saved under
the name that you specify.

Delete Desktop Deletes the currently selected desktop from the list.
Restore Desktops Restores desktops to the factory defaults.
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15.2.1.6.3 Alerts

In specific situations, IC-Inspection provides notifications about changes in its status. Examples of such changes in-
clude inspection start/stop events, incoming survey start/stop events, and video recorder start/stop events. When these
notifications are low priority, they briefly appear in the bottom right corner of IC-Inspection’s main window. However,
if they require your immediate attention during an inspection, they appear in the center of the window, flash red, and
remain visible until the issue is resolved or you manually dismiss the warning.

Fig. 1: A low-priority notification and a high-priority notification

If you start an inspection, but a DVR (Digital Video Recorder) fails to start recording, a modal dialog will inform you
of this issue. If you decide that you no longer need that recorder, cancel the dialog and disable the device in the Devices
pane. Otherwise, every time you launch an event, IC-Inspection will warn you that the recorder is not started. These
dialogs and notifications serve to prevent accidental event triggering without video recording.

Other reasons for alert notifications include:

• Invalid survey values: This occurs when the incoming survey value does not match the expected data type (for
example, numeric, date/time).

• Survey database destination errors: These errors occur when unit conversions fail between the incoming value
and the database field.

• No survey data received in the last five seconds.

You can find this information reflected both in the notification messages and in the State column of the Survey Values
pane.

15.2.2 Configuration
Before you start using IC-Inspection, you must perform a number of configuration settings in IC-Inspection. These
include:

• Configure the connections to video devices (IC-Recorder or a third-party DVR device), survey devices and any
measurement or scale device that interface IC-Inspection. You must also set up text overlays. For more informa-
tion, see Set Up Devices.

• Map survey fields coming from survey devices to the survey fields in the NEXUS database. For more information,
see Map Survey Fields.

• Optionally, you can set up event templates to be used for creating ad hoc events. For more information, see Set
Up Event Templates.

15.2.2.1 Set Up Devices

Before you start using IC-Inspection, you must configure the connections to video devices (IC-Recorder or a third-party
DVR device), survey devices and any measurement or scale device that interface IC-Inspection. You must also set up
text overlays to be applied on the recorded videos. You make these configurations on the Devices pane of IC-Inspection
(see Devices).
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On the Devices pane, you can set up the following:

• Add connections to video devices (see Add Video Devices)

• Add connections to survey devices (see Add Survey Devices)

• Add connections to measurement or scale devices, specifically, to a “Sartorius Entris Balance” device, which
allows measuring the weight of very small things accurately. The device is usually connected through USB. This
feature was developed for a specific area. You set this up similarly to survey devices (see Add Survey Devices),
but instead of the Survey tab, you have the Input tab available, where you specify the parameters required for
getting the weight data from the device.

• Set up text overlays to be displayed on the videos (see Set Up Text Overlays)

In case of any issues with the connections, you can use the Device Diagnostics pane for debugging purposes (see
Device Diagnostics).

15.2.2.1.1 Add Video Devices

The offshore NEXUS package comes with the default IC-Recorder video device for recording videos and is optimised
to work with IC-Inspection. You can, however, also use a third-party video device that has implemented our standard
DVR control protocol.

15.2.2.1.1.1 Add IC-Recorder

To enable communication between IC-Inspection and IC-Recorder, set up the connection as described below:

1. On the Devices pane, choose Add from the toolbar.

2. In the Add New Device wizard, choose Video Device, and click Next.
3. Select IC-Recorder and click Next.
4. Specify the properties of IC-Recorder as required.

Note the following:

• If you’re adding several IC-Recorders, you should give each one a different Display Name so that you can
tell them apart.

• If IC-Recorder is running on the local machine, the Address value can be Localhost. If it’s running on
another machine, it can be the IP address of that machine.

• If you have several instances of IC-Recorder running on one PC, they will each have a different port number.
By default, the first run will have port 4500; the second, port 4501; and so on. You can change this in IC-
Recorder under the Tools → Options → Advanced menu option.

5. Click Finish to complete the setup.

ò Result

The IC-Recorder device is added to the list of devices on the Devices pane and the value in the Connection
Status column should show Connected in case of a successful connection. The Enabled toolbar button is
on by default. If the value in the Connection Status column is not Connected, then click Enabled twice, to
disable then re-enable the device. This forces a fresh attempt at connection.

When you click Start to start an inspection, all video devices will attempt to start recording. While the video devices
are in the process of starting recording, you will see a progress dialog. If this dialog persists for more than a couple of
seconds, this may indicate a problem with one or more of your video devices. Check the status of each device, both
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here in IC-Inspection, and on IC-Recorder’s own window (which may be on a different PC). When you click Stop to
stop the inspection again, all video devices will attempt to stop recording.

15.2.2.1.1.2 Add a Third-Party DVR Device

To enable communication between IC-Inspection and a third-party video recorder, follow the steps described above for
IC-Recorder, with the only exception of choosing Generic Video Recorder in the Add New Device wizard in step 3.

Any device that has implemented our standard DVR control protocol is supported. For information about supported
devices, see Third-party DVRs.

15.2.2.1.2 Add Survey Devices

15.2.2.1.2.1 Add a Custom Survey Device

Survey data is most often coming through a serial string from the ROV into the IC-Inspection machine. This is basically
text including positional data, which may be submitted through a survey device. Sometimes a survey company is on
board who smooths the data and sends us a clean serial string with exact positional information.

If there’s a serial string coming from the ROV into IC-Inspection, you must set up the survey device as described below.

1. On the Devices pane, choose Add from the toolbar.

2. In the Add New Device wizard, choose Survey Device, and click Next.
3. Select Custom Survey and click Next.
4. On the Properties tab, select the relevant COM port and specify the properties of the survey device as required.

Note the following:

• If you’re adding several survey devices, you should give each one a different Display Name so that you can
tell them apart.

• Most commonly, you use the following industry-standard attributes:

– Baud Rate: 9600

– Data Bits: 8

– Parity: None

– Stop Bits: 1

Double-check the values with the company supplying the survey string to you.

5. On the Survey tab, you specify the parameters required for interpreting the survey values.

• Under the Survey area, you can make entries as follows:

– End of Line Signal: Set the value of this field to be compatible with whatever is coming down the
survey string. To enter ASCII control characters, type a number prefixed with a #. For example,
carriage return is #13, line feed is #10, and carriage return followed by line feed (the most common
case) is #13#10.

– String Format: The following string formats are supported by IC-Inspection:

∗ Character Delimited: Each unique survey field in the incoming survey string is separated by a
character delimiter (usually a comma), and each survey field is defined by its index in the survey
string.

∗ Position and Length: Each survey field has a fixed length. If the survey field is less than this
defined length, it may be padded with either zeros or spaces as appropriate.
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∗ Identifier and Length: The start of each survey field is defined by an identifier, and the end of
the survey field is defined by its length. Again, the field may be padded with zeros or spaces as
appropriate.

∗ Identifier and Delimited: The start of each survey field is defined by an identifier, and a character
delimiter (usually a comma) separates each data field.

∗ Pre/Post Identifier and Delimited: The start and end of each survey field is defined by an identifier,
and a character delimiter (usually a comma) separates each survey field. Identifier and Delimited
is the most common format for an incoming survey string. If this format is used, then in a noisy
signal environment, IC- Inspection will still be able to correctly identify data even if only a partial
string was received.

– Delimiter: Set the value of this field to match whatever is coming down the survey string. Comma (,)
is the most common delimiter.

• Under the Survey Fields area, you can add survey fields to reflect the parts of the incoming survey string
you’re interested in. Exactly what you can configure for each field depends on the String Format selected,
but they all have Name, Type and Unit. If Type is Numeric, you can select a Unit for this field.

For example, if the survey string is sending you Depth in feet, select the unit to be Feet. In NEXUS IC,
under Configuration → Events → Configure Event Types, find your “Survey - Standard” form, edit the
Depth field, and ensure that its unit is set to metres. Now IC-Inspection will convert the incoming depth
from feet to metres before logging it in the database. Similarly if the survey string is sending you Heading
in hundredths of a degree or whatever, you can use Units to convert.

6. Click Finish to complete the setup.

ò Result

The custom survey device is added to the list of devices on the Devices pane and the value in the Connection
Status column should show Connected in case of a successful connection. The Enabled toolbar button is
on by default. If the value in the Connection Status column is not Connected, then click Enabled twice, to
disable then re-enable the device. This forces a fresh attempt at connection.

15.2.2.1.2.2 Add a Survey Output Device

The survey output device lets you send survey data out a serial port, for downstream consumption by another system.

To add a survey output device, follow the steps below:

1. On the Devices pane, choose Add from the toolbar.

2. In the Add New Device wizard, choose Survey Device, and click Next.
3. Select Survey Output and click Next.
4. On the Properties tab, select the relevant COM port for output and specify the properties of the

survey device as required.

Note the following:

• If you’re adding several survey output devices, you should give each one a different Display
Name so that you can tell them apart.

• Most commonly, you use the following industry-standard attributes:

– Baud Rate: 9600

– Data Bits: 8
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– Parity: None

– Stop Bits: 1

5. On the Survey tab, you make selections appropriate to what your downstream device is expecting.

• Under the Survey area, you can make entries as follows:

– Delimiter: Set the value of this field to match whatever is expected from the downstream
device. Comma (,) is the most common delimiter.

– End of Line Signal: Set the value of this field to be compatible with the requirements of
the downstream device.

– Include Identifiers: Tick this checkbox if you want data to be sent with identifiers
prepended, for example, “DateTime=01/01/2001 12:34:56, Depth=100”.

– Include null values: Controls what happens if some fields are null: do you want several
separators in a row in this case, for example, “1„3”?

– Null value replacement: This field is for downstream devices that cannot cope with this
case, so you can have the null field replaced with the value of your choice (“0”, “nbsp”, etc).

• Under the Survey Fields area, you can select fields that you want to be sent or deselect fields that
you don’t want to send. Use Move Up and Move Down to rearrange fields to suit the downstream
device.

6. Click Finish to complete the setup.

ò Result

The survey output device is added to the list of devices on the Devices pane and the value in
the Connection Status column should show Connected in case of a successful connection. The
Enabled toolbar button is on by default. If the value in the Connection Status column is not
Connected, then click Enabled twice, to disable then re-enable the device. This forces a fresh
attempt at connection.

ò Note

Date and Time format come from Windows settings. To change them, go to the Windows’ Region and
Language control panel.

15.2.2.1.2.3 Add a Survey Simulator

IC-Inspection comes with a survey simulator for testing purposes, which you can set up in case you want to get survey
data simulated by the system.

To add a survey simulator, follow the steps below:

1. On the Devices pane, choose Add from the toolbar.

2. In the Add New Device wizard, choose Survey Device, and click Next.
3. Select Survey Simulator and click Next.
4. On the Properties tab, specify basic parameters for the simulator, such as name or date and time settings.
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5. On the Survey tab, you can set up how the actual survey values are to be generated by the simulator. There are
some default settings delivered for a number of fields, which you can adjust, but you can also add additional
fields or delete them.

You can directly edit the values in each cell (including name, type, unit, value and increment) by double-clicking
within the specific cell.

6. Click Finish to complete the setup.

ò Result

The survey simulator is added to the list of devices on the Devices pane and the value in the Connection
Status column should show Connected in case of a successful connection. The Enabled toolbar button is
on by default. If the value in the Connection Status column is not Connected, then click Enabled twice, to
disable then re-enable the device. This forces a fresh attempt at connection.

15.2.2.1.3 Set Up Text Overlays

If you use IC-Recorder to record video with text overlays, you have two options for configuring the text overlays:

• Configuration in IC-Inspection:

You can set up text overlays in IC-Inspection by using the Text Overlays button on the Devices pane.

If you’re using IC-Recorder alongside IC-Inspection, we highly recommend setting up text overlays within IC-
Inspection. This ensures consistency when using multiple recorders since you can use the same overlay on each
recorder (except for channel name). When you configure the overlay in IC-Inspection, you only need to do it
once, and the settings will be applied to all connected recorders. If IC-Recorder is currently disconnected, it will
receive the configuration upon reconnection.

• Configuration in IC-Recorder:

You can also set up text overlays in IC-Recorder using the Edit Overlays button from the main toolbar.

We recommend using this option only if you’re using IC-Recorder as a standalone device. If you use IC-Recorder
alongside IC-Inspection, make the configurations in IC-Inspection to maintain uniformity across recorders.

15.2.2.1.3.1 Create a New Overlay

1. Start creating a new overlay in either of the following ways:

• In IC-Inspection, choose Text Overlays from the toolbar of the Devices pane.

• In IC-Recorder, choose Edit Overlays from the mail toolbar.

2. In the Edit Overlays dialog, choose Add.

3. In the Edit Overlay dialog, specify a name for the new overlay on the top of the Configuration screen area.
Here you can also select a background colour for designing the text overlay. By default, the colour is black.

� Tip

Drag the window larger to make the black overlay region larger. It doesn’t need to match the actual
size of your video feed, but it’s convenient for you if you drag it to approximately the same shape.

4. On the left-hand side of the screen, under the Available Regions section, ensure that you have all the fields that
you want to include in your text overlay.
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• In IC-Inspection, you can add additional asset information fields by choosing the Asset Information Fields
button on the top of the screen. Besides asset information, you can also see database fields, device infor-
mation, survey fields, as well as static text or image elements that you can include. If a survey field you
want is not shown in the list, ensure that the appropriate survey field is configured and has a value.

• In IC-Recorder, you can see device information fields and static text or image elements that can be retrieved
directly from IC-Recorder. Survey fields, database fields and asset information fields are all retrieved from
IC-Inspection. You cannot add new asset information fields in IC-Recorder. If you want to add a new field,
you have to do it in IC-Inspection.

5. Drag fields from the tree on the left onto the overlay layout region. Move them to the position where you want
to see the fields on the recorded video screen.

Any fields that you have dragged to the overlay layout region will appear in the list under the Regions section at
the bottom of the screen.

6. Customise the appearance of the fields.

When add your first field, you may want to customise it (colour, font, size, etc.), because additional fields you
add will inherit their settings from the previous field.

Once fields are on the overlay, you can configure them as follows:

• Selection: You can select fields by clicking them on the overlay or selecting them from the grid under
Regions.
You can also multiselect fields as follows:

– On the overlay, you can “lasso” several fields by click-dragging a box around them or use the Ctrl key
to select fields one after the other.

– In the grid, you can use the Ctrl key or Shift key to select multiple rows.

• Toolbar Buttons: You can use the toolbar buttons at the top of the Regions screen area to perform actions
on selected fields. You can nudge them, align them, change their font size, or delete them.

• In-grid editing: You can adjust settings specific to individual fields by double-clicking in the cell for the
required field and parameter. You can make the following settings:

– Specify a text for static texts and images

– Add a prefix or suffix text, for example, a short prefix “E: “ for Easting, etc.

– Define offset values for field placement (percentage from the top and left side of the captured screen).

– Specify font type, font size and font colour for the texts. Note that a 10-point font on a 576-pixel high
SD video will fill about 1/57th of the height of the image, which may be suitable, however, it would be
too small on a 1080-pixel high HD feed.

– Select a background colour for the field. By default, no background colour is applied (transparent).
This conceals less of the video, but may be less clear on certain video colours. Consider enabling the
Show Overlay Text Shadow option under Tools → Options → Advanced (see Advanced) for better
legibility with transparent-background fields. This option consumes additional CPU power, so if your
CPU is near 100% during recording, disable this option.

If you add an “Image” region, a file dialog will appear immediately. If you choose a .PNG file, its transparency
will be honoured. If the PNG has partial or full transparency, you’ll see the video through the image. You can
add multiple image regions if needed.

ò Note
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If you’re using a Marshall Encoder rather than a system hardware, some overlay configuration options are
ignored because the Marshall Encoder does not support them. Text, prefix, suffix, source, top, left, font size,
and font color are supported, but font choice (for example, Courier, Arial) is not. Additionally, the Marshall
Encoder supports a maximum of 16 overlaid fields.

7. Choose OK to save your changes and exit the dialog or Apply to save your changes and keep the dialog open.

After confirming your settings and closing the chain of dialogs, you’ll see real-time updates of survey values on
your recorders.

15.2.2.1.3.2 Edit Overlays

You can edit overlays only within the application where they were originally created. That is, in IC-Inspection, you can
edit overlays created in IC-Inspection, in IC-Recorder, you can only edit overlays created in IC-Recorder.

1. Start editing an overlay in either of the following ways:

• In IC-Inspection, choose Text Overlays from the toolbar of the Devices pane.

• In IC-Recorder, choose Edit Overlays from the mail toolbar.

2. In the Edit Overlays dialog, choose Edit.
3. Make your changes as required. For more information about the configuration options, see ic-

inspection.devices.text_overlay.create above.

4. Choose OK to save your changes and exit the dialog or Apply to save your changes and keep the dialog open.

15.2.2.2 Map Survey Fields

Before you start inspections, you must ensure that survey fields coming from survey devices are mapped correctly to
the survey fields in the NEXUS database and that survey values are coming through. You do that on the Survey Values
pane of IC-Inspection (see Survey Values).

The Survey Values pane displays all survey fields that are coming through the serial string. Survey fields are defined
in the Device Manager, within the device they are being received from. The system automatically maps these fields to
the survey fields in the system, however, you must check if it could perform the matching correctly.

15.2.2.2.1 Prerequisites

To ensure that incoming survey fields can be mapped to survey fields in the NEXUS database, you must have an event
type configured that contains the required database survey fields. This event type must have been created in NEXUS IC
under Configuration → Events → Event Types with event form type Survey Data. For more information, see Configure
Event Types.

15.2.2.2.2 Update the Source for a Survey Field

To change the source of a survey field, proceed as follows:

1. Select the field in the grid.

2. Choose Source from the toolbar of the pane.

3. Choose the relevant input device from the drop-down menu.
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15.2.2.2.3 Update the Destination for a Survey Field

You can log data from a source survey field into one or more survey fields in the database. The system tries to automat-
ically find a destination database field to which it can map the source survey field. To change the destination database
field, follow the steps below:

1. Select the field in the grid.

2. Choose Destinations → Database Fields from the toolbar of the pane.

3. In the dialog that pops up, select one or more fields under Survey Data as required. The dialog shows
all the fields that have been configured in NEXUS IC (see Example: Set Up Filling Event Fields with
Survey Data).

If you want incoming survey data to be automatically populated into event fields, you can choose the
required event field in this dialog. For more information, see Configure Event Types.

4. If required, you can also set up several “meta” destinations, which can be used when a real survey
field is not appropriate. To do that, choose Destinations from the toolbar of the pane and select one
of the following options:

• Survey Date/Time: You can use this as the destination for your DateTime field. Note that
there is no field called Survey - Standard.DateTime, Survey - Pipeline.DateTime, etc. because
date/time is the key value for every survey table, and it would be arduous and error-prone to
force you to select them all separately.

• Survey Heading: Use it if you do not wish to log Heading to a database field, but still want
things that rely on Heading (such as the Heading pane) to work.

• Survey KP: Use it if you do not wish to log KP to a database field but still want things that rely
on KP (such as the Charts pane or the Pipeline View pane) to work.

• Survey Depth: Use it if you do not wish to log Depth to a database field, but still want things
that rely on Depth to work.

ò Result

Now, during an inspection, the value of this survey field will be logged into the selected
destination survey field.

15.2.2.2.4 Worked Example

See Example: Set Up Filling Event Fields with Survey Data.

15.2.2.2.4.1 Example: Set Up Filling Event Fields with Survey Data

IC-Inspection allows you to configure automatic population of incoming survey data into discrete event fields. The
following example demonstrates the steps to set up this feature:

1. Configure the survey device.

Ensure that one of your survey devices contains the survey field name you want to map to your event
field:

a. On the Devices pane, select the relevant survey device.

b. Choose Edit.
c. In the Survey Simulator Properties dialog, on the Survey Values tab, ensure that the

required survey field is added and configured.
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2. Set the source for the survey field.

a. On the Survey Values pane, select the relevant survey field.

b. In the toolbar of the pane, click Source and select the survey device you’re using.

3. Set the destination for the survey field.

a. On the Survey Values pane, select the relevant survey field.

b. In the toolbar of the pane, click Destinations→Database Fields. . . and select the event
field that you want to map to the survey field.
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4. Test that the event field is automatically populated by the survey field value.

a. Click Start in the main toolbar of IC-Inspection to start the inspection.

b. Select an asset that has an asset type linked to the relevant event type.

c. In the Event Launcher, click the event type to launch an event.

d. In the Active Events pane, check that the database field that you mapped above gets
updated with the survey field value being logged.

You can choose Pause Event Fields in the toolbar to pause or resume automatic event
field updates. Toggling the (i) button next to the field will also perform the same func-
tionality.

Example Video
See the video below for a demonstration of a similar example.

15.2.2.3 Set Up Event Templates

Event templates allow you to pre-populate event forms with specific data, which enables the creation of ad hoc events
without the need to manually specify all the field values. You can also assign Shortcut Keys to event templates to enable
creating ad hoc events using shortcuts. For more information about creating ad hoc events, see Create Ad Hoc Event.

Once set up, event templates will be available in the Event Launcher (see Event Launcher), based on which you can
create ad hoc events (see Create Ad Hoc Event Using Event Templates).

You set up event templates as follows:

15.2. Using IC-Inspection 539



NEXUS Documentation, Release 6.9.xxxxx.0

1. In IC-Inspection, go to the Event Templates pane.

2. On the left-hand side of the pane, click Add to create an event template group and specify its name.
The event template group is just a grouping of similar event templates.

When recording events, this event template group must be specified in the Active Inspection pane
to enable creating ad hoc events using any of the event templates within this group.

You can add different event template groups for different inspectors (for example, “Alice’s Tem-
plates”, “Bob’s Templates”), different inspection types (for example, “Structures Templates”,
“Pipeline Templates”, etc.), or any other groups that fit your specific needs.

3. In the middle section of the pane, click Add to create the event template. You can add as many or as
few event templates to each group as you like. You can add multiple events of the same event type.

4. In the top part of the Add Event Template dialog, specify the following data:

• In the Name field, enter a name that identifies the event template. Try to place key information
near the start of the name, so that it’s easily visible in the Event Launcher pane.

• In the Event Type field, you must select the event type (preconfigured in NEXUS IC).

• In the Action field, you select how you want to create ad hoc events based on the event template.
Choose one of the following values:

– Launch: When clicking the event template in the Event Launcher pane, the event form will
appear in the Active Events pane pre-populated with the data you specified here. You can
review and adjust the entries as needed before saving the event.

– Launch with Image: When clicking the event template in the Event Launcher pane, the
event form will appear in the Active Events pane pre-populated with the data you specified
and it captures an instant image from the video recording to be attached to the event. You
can review and adjust the entries as needed before saving the event.

– One-Click Record: When clicking the event template in the Event Launcher pane, the event
will be created instantly with the preconfigured values without the event form appearing in
the Active Events pane for review.

• In the Shortcut Key field, you can specify a shortcut key, which allows performing the actions
above using a shortcut key instead of clicking the event template in the Event Launcher. To
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enter a key, click and press the required shortcut key on your keyboard. You can hold down
Shift, Ctrl or Alt while choosing a key if you prefer.

5. In the bottom part of the Add Event Template dialog, specify the default field values that you want
to be pre-populated in the event form. These fields appear once you have selected the event type in
the top part of the dialog. You can fill in as many or as few fields on each event form as you like.

6. Click OK to save the event template.

ò Result

• The new event template appears in the Event Templates pane and if you select it, the
preconfigured values are shown on the right-hand side of the pane.

• The event template will be available in the Event Launcher pane when you start the in-
spection and select to show event templates under the View toolbar button.
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15.2.3 General Features
IC-Inspection shares most of the general features with NEXUS IC, with only a few minor differences.

For a comprehensive overview of all the general features, see General Features. See below for differences in IC-
Inspection.

15.2.3.1 Searching

Similarly to NEXUS IC, you can perform database-wide search or asset-specific search as required (see Searching).
Note though that IC-Inspection searches the following items:

• Assets

• Asset Information

• Sub Asset Information
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• Event Templates

• Event Template Groups

• Anomaly Triggers - Only asset based anomaly triggers.

• Tasks - Only if the Task Workpack matches the selected Active Workpack.

• Events - If the event is in the selected active workpack, the event will be shown on the Event Listing (Workpack)
pane. If the event is not in the selected active workpack, the event will be shown on the Event Listing (Historical)
pane.

• Library, ROV, Workpack and Survey Set - These results will open the editor dialog.

15.2.3.2 Using the Grid

You can use the same grid functionality in IC-Inspection, except for Reports (see Using the Grid). In IC-Inspection,
you cannot generate reports.

15.2.3.3 Using the Status Bar

In IC-Inspection, you use the status bar in the same way as in NEXUS IC (see Using the Status Bar), except that in
IC-Incpection, the Job Management Console is not available.

15.2.4 Online Inspection
During online inspection, you perform online data capture for the selected asset and log events when required.

15.2.4.1 Prerequisites

Before you commence inspecting and logging inspection data, ensure the following:

• IC-Inspection has been set up and deployed in the offshore environment (see Offshore Deployment).

• Assets (see Asset Tree), event types (see Configure Event Types) and, optionally, tasks and drawings have been
set up and configured in NEXUS IC.

• In IC-Inspection, the necessary configurations have been performed:

– Device connections (video recorder, survey devices) have been set up (see Set Up Devices).

– Incoming survey fields have been mapped to survey fields in the database (see Map Survey Fields).

– Optionally, event templates have been set up for one-click eventing (see Set Up Event Templates).

• Your IC-Inspection desktop has been configured in accordance with your inspection requirements (see Manage
My Desktop).

• You have connected to the correct database (see Connect to Database).

15.2.4.2 Process

Follow the steps below to perform online inspection:

1. In the asset tree, select the asset for which you want to perform the inspection.

2. On the Active Inspection pane, ensure that the correct workpack and survey set is specified. These fields are
mandatory. The workpack contains all of the tasks for the current inspection and any events created will be
against this workpack. For more information, see Active Inspection.
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3. From the main toolbar of the IC-Inspection screen, click Start to start the inspection.

This action triggers the following:

• Any video recording devices that have been configured start recording.

• Survey data will commence logging.

4. You can commence video commentary and create events as required. If required, you can capture images to be
attached to the events. For more information about creating events, see Create Events. You log event details in
the Active Events dialog.

5. In case it’s necessary, you can create findings from the events (see Create Findings).

6. When you’ve completed the online data capture, from the main toolbar of the IC-Inspection screen, click Stop
to stop the inspection.

15.2.4.2.1 Create Events

During online inspection, you can create events in the following ways:

• You can create events by launching tasks (see Create Event from Task), which can be done using either of the
following options:

– Launch a task from the Task pane.

– Launch a task from the Drawing pane.

• You can create ad hoc events from the Event Launcher (see Create Ad Hoc Event).

Before saving the event, you can decide if you want the event to complete a task. For more information, see Complete
Tasks.

15.2.4.2.1.1 Create Event from Task

You can create an event from a task as described below.

15.2.4.2.1.2 Prerequisites

• A task exists for the relevant asset.

• You have selected the asset in the asset tree and ensured that data in the Active Inspection pane is filled correctly.

• You have started the inspection using the Start button in the main toolbar.

• The task has not been completed yet.

15.2.4.2.1.3 Process

1. Launch the task. You can launch a task in the following ways:

• On the Tasks pane, select the task from the list and click Launch from the pane’s toolbar, or double-click
the task.
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If you have set up an event template (see Set Up Event Templates) for the event type of the task, you can also
use the Launch Template toolbar button to create the event with the preconfigured values added. Note that
the relevant event template group must be assigned in the Active Inspection pane to enable this feature.

• On the Drawings pane, click the asset and click the task in the drop-down list.

� Tip

In the toolbar of the Drawings pane, click Layer Colour → Workpack Tasks to see layers coloured
according to the status of tasks assigned to specific assets in that workpack.

2. In the Active Events pane, a new event gets added. Enter event data on the Details tab. You can also capture
images or raise a finding as required. For more information about what you can do on this pane, see Active Events.

3. If you want the task to be completed when the event is created, ensure that the Complete Task checkbox is
selected at the top of the tab. This is selected by default.

4. To create the event record, save the active event in either of the following ways:

• Click Save in the toolbar to save the new event entry, which will be visible in the Event Listing pane. The
event gets closed in the Active Events pane.

• Click Save & New to save the new event entry and immediately create a new one with the same event type.
The created event will be visible in the Event Listing pane and disappears from the Active Events pane
and a new empty event record is added to the Active Events dialog.

• Click Save & Hold if you could not complete the work required by the task (for example, you have inspected
part of an asset but had to stop for some reason). This option saves the event, which will be visible in the
Event Listing pane and completes the task, however, it creates a new continuation task for the asset. For
the original task, the Is Held field gets the value Yes in the task’s parameters. The new task that is created
will have reference to the original task in its instructions and the Previous Task field will be populated
with reference to the original task.
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15.2.4.2.1.4 Create Ad Hoc Event

You are not restricted to eventing only from tasks. At any time, whilst IC-Inspection is in inspection mode, you can log
events against the currently selected asset, which is called ad hoc eventing.

You can create ad hoc events from the Event Launcher pane of IC-Inspection (see Event Launcher), which shows tiles
for each event type assigned to the asset type of the currently selected asset, as well as preconfigured event templates.
Based on the type of the tile in the Event Launcher*, you can create ad hoc events in one of the following ways:

• By manually entering all field values in the event form (see Create Ad Hoc Event with Manual Data Entry)

• By using event templates (if configured) that pre-populate some or all of the fields in the event form (see Create
Ad Hoc Event Using Event Templates)

15.2.4.2.1.5 Prerequisites

• You have selected the asset in the asset tree and ensured that data in the Active Inspection pane is filled correctly.

• You have started the inspection using the Start button in the main toolbar.

• If you’re using event templates, these event templates must have been set up (see Set Up Event Templates).

15.2.4.2.1.6 Create Ad Hoc Event with Manual Data Entry

1. In the Event Launcher, click the tile for the required event type.

This action opens the event form in the Active Events pane.

2. Enter event data on the Details tab. You can also capture images or raise a finding as required. For
more information about what you can do on this pane, see Active Events.

3. If the event can be matched to one or more existing tasks, you will see a Task Completion section at
the top of the event form indicating that this event can complete a task and a Task section with the
specific tasks listed. You can choose which tasks to complete using the checkboxes.

4. To create the event record, save the active event in either of the following ways:

• Click Save in the toolbar to save the new event entry, which will be visible in the Event Listing
pane. The event gets closed in the Active Events pane.

• Click Save & New to save the new event entry and immediately create a new one with the same
event type. The created event will be visible in the Event Listing pane and disappears from the
Active Events pane and a new empty event record is added to the Active Events dialog.
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15.2.4.2.1.7 Create Ad Hoc Event Using Event Templates

1. In the Active Inspection pane, ensure that you select the Event Template Group that contains the required event
template.

2. In the Event Launcher, make sure that the Show Event Templates option is enabled under the View toolbar
button.

3. In the Event Launcher, click the tile for the required event template or press the shortcut key indicated on the
tile.

You can identify event template tiles by the additional icons on the tile. If a shortcut key exists, that is also shown
on the tile. The icons indicate the type of the action assigned to the event template, which can be one of the
following:

• (tick): Indicates a One-Click Record action type.

• (arrow): Indicates a Launch action type.

• (image): Indicates a Launch with Image action type.

4. Depending on the event template type that you selected, you can proceed as follows:

• If you have selected an event template with a One-Click Record action type, the event will be created
instantly with the preconfigured values without the event form appearing in the Active Events pane. You
can review or update the event record from the Event Listing pane if required. The event creation process
ends here, ignore the next steps.

• If you have selected an event template with a Launch action type, a new event appears in the Active
Events pane, pre-populated with the preconfigured data. You can review and adjust the entries as needed,
capture images or raise a finding as required. For more information, see Active Events.

• If you have selected an event template with a Launch with Image action type, a new event appears in
the Active Events pane pre-populated with the data you specified and an instant image is captured from
the video recording to be attached to the event. You can review and adjust the entries as needed. For more
information, see Active Events.

5. If the event can be matched to one or more existing tasks, you will see a Task Completion section at the top of the
event form indicating that this event can complete a task and a Task section with the specific tasks listed. You
can choose which tasks to complete using the checkboxes.

6. To create the event record, save the active event in either of the following ways:

• Click Save in the toolbar to save the new event entry, which will be visible in the Event Listing pane. The
event gets closed in the Active Events pane.
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• Click Save & New to save the new event entry and immediately create a new one with the same event type.
The created event will be visible in the Event Listing pane and disappears from the Active Events pane
and a new empty event record is added to the Active Events dialog.

ã See also

• Create Events

• Set Up Event Templates

• Event Templates

• Event Launcher

15.2.4.2.2 Complete Tasks

Tasks in IC-Inspection can be completed once you have started creating an event (see Create Events) and in the Active
Events pane, you make the following selections before saving the event:

• If the event is launched from a task, it will have a Task section at the top of the event form with a Complete Task
checkbox. If you leave this checkbox selected, the task will be marked as completed when you save the event.

• If the event is not launched from a task, but matches an existing task, you will see a Task Completion section
at the top of the event form indicating that this event can complete a task and a Task section with the specific
task and a checkbox. Select this checkbox if you intend to use this event to complete the task. The task will be
marked as completed when you save the event.

• If there are multiple tasks that this event could complete, you will see a Task Completion section at the top of the
event form indicating that this event can complete a task and a Task section with the specific tasks listed. You
can choose which tasks to complete using the checkboxes. The selected task will be marked as completed when
you save the event.

15.2.4.2.3 Create Findings

In case an event records a situation that is out of specification or out of range, a finding can be raised for the event. If
a field has an anomaly trigger defined (see Anomaly Triggers), and the value for that field meets or exceeds the pre-
configured anomaly triggers, a finding is automatically raised. In case you deem it necessary, you can also manually
create a finding.

ò Note

Only one finding can be manually created for an event. Multiple findings can be created automatically

by anomaly triggers. If you see a yellow exclamation mark ( ) next to one or more fields in your
event form, this is because one or more anomaly triggers have been violated, and a finding will be
automatically created for each.

You can manually create findings in IC-Inspections as described below.

15.2.4.2.3.1 Create Finding from Active Event

You can raise a finding right when you’re recording an event in the Active Events pane:

1. In the Active Events pane, click Raise a Finding in the toolbar. This action adds the new Finding tab to the
Active Events pane.
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2. On the Finding tab, enter the details of the finding as required. For more information about the specific fields,
see Add/Edit Finding Dialog.

3. Save the event. When you save the event, the finding is created with the event record and is automatically attached
to it.

15.2.4.2.3.2 Create Finding from Event Listing

You can also create findings to existing event records created earlier as follows:

1. In the Event Listing (Workpack) pane, select the required event.

2. On the right side of the pane go to the Findings tab.

3. Click Add in the toolbar to start creating a finding.
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4. In the Add Finding dialog, enter the details of the finding. For more information, see see Add/Edit Finding
Dialog.

5. Click OK to save the finding.

15.2.4.2.4 Edit Events

To modify data for existing events in IC-Inspection, follow these steps:

1. On the Event Listing (Workpack) pane, select the event record that you want to update (only one at a time).

2. Click Edit in the pane’s toolbar.

3. The event record opens in the Active Events pane. Update data as required.

4. Save your changes.

ò Note

Event data cannot be modified directly on the Details tab of the Event Listing (Workpack) pane; that tab is for
display purposes only.

15.2.4.2.5 Attach Multimedia to Event

Multimedia are electronic files that have been uploaded against an event.

In IC-Inspection, you can attach multimedia to events as described below.

15.2.4.2.5.1 Add Images from Active Events

If your digital video recorders support it, you can capture images from the video recorder and attach it to the event
while creating events in the Active Events pane. Multimedia types can include images or video files. To add an image,
follow the steps below:

1. Start creating the event as described in Create Events.

2. In the Active Events pane, click the Capture Image toolbar button to capture a snapshot from the incoming
video signal. You can capture as many snapshots as you prefer.

3. If required, you can review and edit the image on the Multimedia tab of the Active Events pane. For more
information, see Active Events.

4. Select the images that you want to be attached to the event on the Multimedia tab.

5. Save the event record.

ò Result

The selected images are stored in the database against the event, which you can see on the Event Listing
pane.

15.2.4.2.5.2 Add Multimedia from Event Listing

You can attach multimedia to existing event records on the Multimedia tab of the Event Listing pane. To make the
Multimedia tab visible, ensure that you enable the Details toolbar button on the Event Listing pane.
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ò Note

The following file formats are supported: GIF, JPG, JPEG, JFIF, TIF, BMP, PNG, PDF, DWG, CGM,
DXF, SVG, WMF or EMF.

15.2.4.2.5.3 Add Multimedia Items

Follow the steps below to add new multimedia items to events:

1. Select the relevant event or events on the Event Listing tab.

ò Note

If you select multiple events, the multimedia file will be attached to all selected events.

2. Open the Multimedia pane.

3. Use one of the following methods to upload the file:

• Choose Add on the Multimedia pane to upload the file manually.

• Drag & drop the multimedia file from Windows Explorer onto the Multimedia pane.

4. In the Add Multimedia dialog, enter a name for the multimedia (mandatory) and enter other parameters as
required. For details, see Add/Edit Multimedia Dialog.

When adding the multimedia file manually, you can choose to Import or Link the file:

• Import: Saves the file to the NEXUS IC database. Changes made to the original file on disk will not affect
the stored version.

• Link: Links to the original file on disk. Any changes made to the file will be reflected the next time it is
viewed in NEXUS IC.

ò Note

If you drag and drop multiple files, they will be added, and then multi-selected in the grid. You can then click
Edit to modify them in buld (see Multi-Edit). Drag and drop will import items, not link them.

5. Click OK.

15.2.4.2.5.4 Edit Multimedia Items

To edit an existing multimedia item, proceed as follows:

1. On the Multimedia pane, select the multimedia item.

2. Choose Edit on the toolbar.

3. In the Edit Multimedia dialog, update data as required. For more information, see Add/Edit Multimedia Dialog.

4. Click OK to save your changes.
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15.2.4.2.5.5 Preview Multimedia Items

If you click the Preview button on the Multimedia pane, you can open a floating window to display the selected image
in full size. If the selected events contain more images and you scroll from image to image on the Multimedia pane,
the Preview window gets refreshed with whatever image is selected.

15.2.4.2.5.6 Crop Multimedia Items

You can crop image files in the Multimedia pane as follows:

1. Select the file and click Crop in the toolbar.

2. Click Crop in the toolbar of the Edit Image dialog.

3. Click and drag a rectangle on the image as required.

4. Before completing the crop, click Keep Original if you want the new cropped image to be added to the event’s
collection of images without overwriting the existing image. If you want to replace the existing image with the
new cropped version, ensure Keep Original is not selected.

5. To complete the crop, click the button, or choose Crop To Selection from the toolbar.

15.2.4.2.6 Change Event Type

You can change the event type of selected events while retaining the link to all associated survey data, multimedia, and
manually created findings. You can change the event type to any other preconfigured event types (see Configure Event
Types). Any auto-generated findings will be unlinked from the event, but not deleted.

To change the event type, follow the steps below:

1. On the Event Listing tab, select one or more events as required.

2. From the tab’s toolbar, choose Shortcuts → Change Type. You can also select the same option from the context
menu of the events (available by right-clicking).

3. In the dialog that appears, select the event type to which you want to switch.

4. Click OK.

ò Result

The type of the selected events get updated to the new event type. If the field names across event types match,
the data is retained. If the field names do not match, the values are added to the Notes, which you can check
on the Event Details pane. Note that if you change the event type back to the original, these values will not
be populated back to the original fields but will remain in the Notes section.

15.2.4.2.7 Match Tasks to Events

In general, when tasks are completed in IC-Inspection or IC-Inspector, an event is automatically created from the task
and they’re linked together.

In some cases, for example, when you created events manually, there may be no tasks associated with the event. In
NEXUS IC, you can check associated tasks when selecting the event on the Event Listing tab of the INSPECTION
screen and checking the record on the Task pane (see Task).

You can link incomplete tasks to an event in case they belong to the same asset and the same workpack and they have
the same event type. The same functionality is available on the Event Listing pane in IC-Inspection. To match tasks,
follow the steps below:
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1. On the Event Listing tab, select one or more events as required.

2. From the tab’s toolbar, choose Shortcuts → Match Task. You can also select the same option from the context
menu of the events (available by right-clicking).

ò Result

The system automatically matches incomplete tasks to events in case all the following conditions
are met:

• The task doesn’t already have an event assigned to it.

• The task and the event have the same asset.
• The task and the event have the same workpack.

• The event type of the event and the task match.

The task gets completed and disappears from the Incomplete Tasks pane. You can now see the
associated task on the Task pane.

ò Note

You can also manually link incomplete tasks to events. For more information, see Incomplete Tasks.

15.2.5 IC-Inspection Panes
In IC-Inspection, you utilise different panes on the screen to review data, make configuration, and perform inspections.
To learn how to set up your screen, see Manage My Desktop.

For detailed information about the specific panes, see the sections below:

• Active Events

• Active Inspection

• Alerts

• Anomaly Triggers

• Assets

• Asset Information

• Capture Preview

• Charts

• Devices

• Device Diagnostics

• Drawings

• Event Launcher

• Event Listing

• Event Templates

• Heading

• Library
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• Map

• Pipeline View

• Survey Values

• Tasks

15.2.5.1 Active Events

The Active Events pane displays all the events that have been launched but not saved, called the “active” events, and the
data entry tabs for the currently selected active event. If more than one event is active (that is, they have been launched
but not as yet saved), then you will see tabs on the top of the pane, with one tab for each active event. Each tab has the
name of the event type it contains, but no event number, since unsaved events do not yet have an event number.

An active event is created in the Active Events pane whenever an event is created either ad hoc, or from a task (see
Create Events).

To record details for the event, the following tabs are available:

• Details: On this tab, you can fill in event fields that are coming from the event form.

• Survey: This tab displays survey positional data. This survey data is filled automatically by the
incoming survey strings. When an event is triggered (the moment when the creation of the event
started), the start information is filled and when the event is saved, or when you click Pause Event
Fields, the end information is filled.

• Multimedia: Shows any multimedia files (normally photos) against the current event. Multimedia
types can include images or video files. If your digital video recorders support it, you can capture
images from each video recorder (Capture Image toolbar button) and store those images directly in
the database. When you capture an image, it instantly opens in the Multimedia tab.

To edit the image, click Image Editor in the toolbar, which allows you to crop the image as required.
Note the following:

– If you want to keep the original image as well as the edited image, click Keep Original in the
toolbar.

– To crop, select Image Editor from the toolbar and click the Crop button or Ctrl-X, then click
and drag a rectangle on the image. To complete the crop, click the button, or Crop To
Selection from the toolbar.

– If you want the captured image to be attached to the event, ensure that you select it before saving
the active event.

• Finding (if finding has been created): Shows the details of a finding associated with the event if such
exists. The fields on this tab correspond to the Findings dialog in NEXUS IC (see Add/Edit Finding
Dialog).

� Hint

IC-Inspection can be configured to auto-populate event fields with incoming survey data. See Example:
Set Up Filling Event Fields with Survey Data for more information.

15.2.5.1.1 Active Events Toolbar

You can perform actions on an active event using the following toolbar buttons:
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Toolbar Option Description
Save Commits the active event and associated data to the database. Once the event has

been saved, then it will no longer appear in the Active Events pane and a new
event record will be created in the Event Listing pane.

Save & New Saves the active event and associated data to the database and creates a new active
event of the same event type. Note that they will be two distinct events.

Save & Hold Saves the active event and associated data to the database and creates a new task to
represent the outstanding work. Use this button when you have completed some
but not all of the work represented by a single task; for example, you have inspected
part of an asset but have stopped because of bad visibility, etc. Save and Hold is
only available on events that were launched from tasks, not on events that were
launched ad hoc from the Event Launcher. When you use this option, the current
task will be completed (unless you deselect this default option) and the Is Held
field gets the value Yes in the task’s parameters. The new task that is created will
have reference to the original task in its instructions and the Previous Task field
will be populated with reference to the original task.

Cancel Cancels the active event without saving to the database.
Navigate to Asset This menu item will change the active asset in the asset tree to the asset of the

current event. By navigating to a different asset in the tree, this will also update
the tasks shown in the task list, the asset shown on the overlay, and so on.

Raise a Finding Launches the Findings tab in the Active Events pane. You can record the details
of the finding there, which will be saved against the current event.

Bookmark Creates a bookmark on the current event as a reference for the data reviewer.
Capture Image Captures a snapshot from the incoming video signal and attaches it to the active

event. The image will open on the Multimedia tab, where you can select/unselect
and crop images. If you want the captured image to be attached to the event, ensure
that you select it before saving the active event.

Update Start Updates the start survey information of the active event with the survey data gath-
ered at the time of the button click.

Pause End Pauses the end survey information of the active event. By default, the end survey
information is updated whilst the event is visible on the Active Events pane and
is updated by incoming serial survey information whilst the event is active. If you
don’t want survey data to keep updating, you can pause it using this option.

Pause Event
Fields

Pauses automatic updating of the value linked to the event’s survey field. By de-
fault, the value is updated by incoming serial survey information whilst the event
is active. This option is only available if you have assigned an event field to a
source survey field on the Survey Values pane (see Map Survey Fields).

ã See also

• Create Events

• Attach Multimedia to Event

15.2.5.2 Active Inspection

The Active Inspection pane displays the main inspection details for the currently selected asset. Once configured,
these selections persist across sessions based on the logged-in user ID. If you log out and log in as a different user, their
settings may differ.

When viewing data in any panes of IC-Inspection, it typically pertains to the active entities displayed in the Active
Inspection pane.
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When you enter new data, the data is recorded against the active entities displayed in the Active Inspection pane,
relevant to the specific entity. For example, if you launch an event, the event’s workpack and survey set will be the ones
selected here (if applicable).

Before you start an inspection, fill in the fields on this pane:

Field Description
Asset Displays the currently selected asset.
Workpack You must select the workpack against which inspection data is recorded.

This field is mandatory. Click the (ellipsis) in the field and select a
workpack from the list.

Survey Set You must select the survey set in which survey data is stored. Click the
(ellipsis) in the field and select a survey set from the list, or, create

a survey set by clicking Add in the toolbar. In general, survey sets are
preconfigured in NEXUS IC (see Configure Survey Sets).

ROV If you use multiple ROVs during an inspection, you can select the relevant
ROV in this field to make it clear to inspectors what ROV their video is
being recorded against. Click the (ellipsis) in the field, which takes
you to the same Select Survey Set dialog as above. If a ROV has been
linked to the survey set (in the Edit Survey Set dialog), it is displayed in
the ROV column.

Event Template Group If you want to use event templates to create ad hoc events, you must select
the relevant event template group here. For more information, see Create
Ad Hoc Event Using Event Templates and Set Up Event Templates.

. Warning

If you attempt to start inspections from two different IC-Inspection copies on the same survey set simultaneously,
an error message is triggered: “Another session is open with the same survey set selected.”

This practice is forbidden because both IC-Inspections would write to the same survey set concurrently, making
it impossible to associate events with accurate survey data afterward. To avoid this, move at least one of the IC-
Inspection instances to log data in a different survey set. Even if two events are logged at the exact same time,
correct survey data can be associated with each event because they draw from the appropriate survey set. For
clarity, ensure that you fill out the ROV value in each concurrent survey set, allowing reviewers to understand the
intended connections.

15.2.5.3 Anomaly Triggers

The Anomaly Triggers pane shows anomaly triggers assigned to the selected asset. It may also include a preview chart
indicating which triggers apply at specific KPs (Key Points) or depths.

This pane only shows asset-specific anomaly triggers; it does not display triggers that apply to event fields independently
of the asset. For example, if your Anode event is configured to raise a finding whenever its depletion exceeds 75%, that
information won’t appear on this pane.

Anomaly triggers consist of predefined upper and lower bounds applied to event data. When these bounds are exceeded,
IC-Inspection automatically generates a finding for the event.

The Is Active column indicates whether the anomaly trigger is currently triggered (Yes) or not (No). This is determined
based on the following criteria:

• The survey KP value will be compared against the Start KP and End KP values of the anomaly trigger.
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• The survey Date/Time will be compared against the Date From and Date To values specified for the anomaly
trigger.

15.2.5.3.1 Prerequisites

You can see asset-specific anomaly triggers only if they have been configured and enabled in NEXUS IC (see Set Up
Anomaly Triggers for Assets).

15.2.5.4 Assets

On the Assets pane, you can see the asset tree (see Asset Tree). The asset tree provides a visual representation of assets
in a hierarchical view, including their parent-child relationships. This hierarchy is set up in NEXUS IC.

When you select an asset in the asset tree, it filters event records based on that asset or its child assets (if Child Assets is
enabled on the pane). The asset tree’s selection affects other panes on the screen. For example, in the Event Launcher,
available buttons change based on the selected asset, the Tasks pane displays tasks related to the chosen asset, the
Drawings pane shows relevant drawings associated with the asset.

This pane cannot be hidden, but you can drag it or pin it to a specific location for convenience.

The toolbar at the top of the IC-Inspection screen has several items relevant to the asset tree. These toolbar options are
similar to the asset toolbar options in NEXUS IC (see Assets Toolbar), however, in IC-Inspection, you cannot directly
modify the asset tree; that capability is exclusive to NEXUS IC.

15.2.5.5 Asset Information

You can check asset-specific information for the currently selected asset on the Asset Information pane of IC-
Inspection. This pane corresponds to the Asset Information tab in NEXUS IC (see Asset Information Groups (AIGs))
except that the pane in IC-Inspection is read-only and you are not allowed to add or edit data.

15.2.5.6 Capture Preview

During inspection, if you’re using a device that is capable of showing still images (for example, it’s a DVR), you can
get IC-Inspection to capture a preview of the video as still images on the Capture Preview pane of IC-Inspection.

You can capture a preview in one of the following ways:

• If you want to capture a preview of the video instantly, you can choose Capture Now from the toolbar and
IC-Inspection will capture a snapshot of what is playing in the video recorder at the exact moment.

• You can specify a capture interval, and IC-Inspection will request an image from the device every time that
interval elapses. In this case, you:

1. Select the required interval under the Refresh: .. toolbar button, for example, 5 seconds.

2. Choose Start Preview. You’ll start seeing the captured image, which is refreshed every time the specified
interval elapses.

3. Choose Stop Preview to stop taking capture images.

You can export the captured image using the Export button visible at the top of the captured image.

15.2.5.7 Charts

The Charts panes show all the chart templates that are relevant for the events selected on the Event Listing panes (see
Event Listing).

There are two Charts panes in IC-Inspection:

• Charts (Workpack): This pane shows charts for the events selected on the Event Listing (Workpack) pane .

• Charts (Historical): This pane shows charts for the events selected on the Event Listing (Historical) pane.
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Charts only show event data included in the filters applied on the Event Listing panes (workpacks, event types, column-
specific filters and so on). If you don’t see any charts listed, try different types of events, by changing the asset or by
changing your filters. If your chart template is on continuous event data (such as cross-profiles), ensure that you select
that Continuous Event in your event type filter.

15.2.5.7.1 Prerequisites

Charts are generated from preconfigured chart templates. To enable displaying charts for an asset, the relevant chart
templates must have been configured as described in Configure Chart Templates.

15.2.5.7.2 Display Charts

To expand/collapse each chart, click the button at the top right of that chart, or click the chart’s grey header row.

� Tip

Click on the chart area and then, with the mouse cursor still inside the chart area, use your mouse wheel
to increase/decrease the chart scale.

Note the following:

• Available charts are listed alphabetically. The first chart will be automatically expanded.

• Events with findings are shown on the chart in red.

• For some chart templates, at the right or the bottom of the chart is the chart legend. If you hover the mouse over
an item on the legend, other series on the chart will fade out temporarily. If you click an item on the legend, that
series will be toggled on/off. If you export the chart, only series currently visible will be exported.

15.2.5.7.3 Chart Width

When the Charts tab is 1000 pixels wide or less, all charts are shown at the full width of the tab. When the Charts tab
is over 1000 pixels wide, some charts are shown full width, and some are shown half width, in order to fit more charts
side-by-side onto your screen.

Charts that have an X axis of type string, date, or date/time, or whose X axis includes ‘KP’ are always shown full width.
You can adjust the width of all charts by adjusting the width of the whole application window, adjusting other elements
such as the asset tree wider/narrower, and so on.

15.2.5.7.4 Zooming

At the bottom of most chart templates, below the horizontal scrollbar (if visible) is the Zoom Bar. You can hover the
mouse over the left or right end of the selected part of the Zoom Bar and drag to change the selection. Initially the
entire Zoom Bar will be selected, so hover the mouse over the left or right end of the bar and drag. Once a subset of
the chart is selected, you can use the scroll bar or the Zoom Bar to drag the whole selection area without zooming.

You can also zoom in or out by clicking in the chart area and (with the mouse cursor still inside the chart area) spinning
the mouse wheel. For charts with a lot of data (thousands of events) this can be slow, so the Zoom Bar may be faster.
You can zoom on a single axis by putting the mouse pointer over that axis and spinning the mouse wheel. Not all charts
support zooming in both axes.

You can also control zoom with toolbar buttons Zoom In, Zoom Out, and Reset Zoom.
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15.2.5.7.5 Charts Toolbar

There is no toolbar for the whole Charts tab. Instead, each chart has its own toolbar.

But-
ton

Description

Zooms the image in.
Zooms the image out.
Resets to default zoom level.
Opens the Export dialog, from which you can generate images from the chart. Ensure the
range you want is set correctly using the Zoom Bar. Ensure the series you want to export are
visible. If you want to export the chart as a series of images, each covering a smaller horizontal
range, enter the range you would like each chart to cover in the Range of X Axis per image
field. For example, if you have a 300 km pipeline and you enter “10” as the range per image,
it will be broken into 30 images, each covering 10 km.
Copies the chart, as you see it displayed, without the “zoom” section at the bottom, to the
clipboard.

Expands/collapses the display of this chart.

15.2.5.8 Devices

On the Devices pane, you can check or manage connections to video devices (IC-Recorder or a third-party DVR device),
survey devices and any measurement or scale device that interface IC-Inspection.

On this pane, you can use the respective toolbar buttons to do the following:

• Add, edit or delete connections to control video devices. For more information about adding a new device, see
Add Video Devices.

• Add, edit or delete connections to survey devices. For more information about adding a new device, see Add
Survey Devices.

• Add, edit or delete connections to measurement or scale devices, specifically, to a “Sartorius Entris Balance”
device, which allows measuring the weight of very small things accurately. For more information, see Set Up
Devices.

• Enable or disable any of the above connections by toggling the Enabled toolbar button on or off.

• Set up text overlays to be applied on the recorded videos. For more information, see Set Up Text Overlays.

In case of any issues with the connections, you can use the Device Diagnostics pane for debugging purposes (see
Device Diagnostics).

15.2.5.9 Device Diagnostics

You can use the Device Diagnostics pane to check the data flow and the status of any of the devices set up on the
Devices pane (see Devices). This feature is particularly useful when you encounter connection problems and need to
diagnose issues.

To verify the status, select the required device on the Devices pane and review all the details on the Device Diagnostics
pane. You can see there information about the device status as well as the incoming and outgoing messages coming in
or out of the device.

Scrolling down to the bottom of this pane reveals buttons that allow you to export incoming or outgoing messages,
apply filters, pause data flow, or clear messages as needed.
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15.2.5.10 Drawings

Drawings are essentially library records where the library type has the “Show as Drawings” flag selected.

IC-Inspection uses the same drawing functionality as NEXUS IC (see Drawings), except the following:

• In IC-Inspection, you can only view drawings and its layers, you cannot edit them.

• If you left-click on a drawing layer, you can create events by completing the tasks associated with the relevant
asset (see Create Event from Task).

• The additional Workpack Tasks menu option is available from under the Layer Colour toolbar button. It
displays distinct colours for layers based on the completion status of tasks assigned to the corresponding assets.
This is dependent on the workpack selected on the Active Inspection pane (see Active Inspection).

15.2.5.10.1 Drawings Toolbar

Toolbar Option Description
Launch Opens the drawing on the local machine using the default viewer.
Drawing Type You can select which library types appear here. To control what appears

on this list, go to Library, edit the library types in question, and tick or
untick Show As Drawings.

Include Parents If you tick Include Parents, drawings on this asset’s parents will be shown
in the thumbnail list for you to select.

Copy to Clipboard Copies the drawing to your clipboard at the current scale and offset shown.
The drawing thumbnail and layers will also be included.

Information Toggles a panel at the bottom of the Drawings tab showing EXIF data for
the drawing. Information is shown only for drawings with EXIF data.

Thumbnails Toggles a panel at the right side of the Drawings tab showing thumbnails
for all the images associated with the selected asset. You can customise
the layout of this panel using the Customise button in its toolbar.
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15.2.5.10.1.1 View Menu

Toolbar Option Description
View → Fit Width Changes the pan and zoom on the drawing so that it fits within the width

available on the Drawings tab.
View → Fit Height Changes the pan and zoom on the drawing so that it fits within the height

available in the Drawings tab.
View → Default Size Sets zoom to 100%. This may or may not fit in your Drawings tab, de-

pending on how big the drawing is.
View → Zoom In Zoom In.
View → Zoom Out Zoom Out.
View → Zoom Selection Click this, then in the drawing click and drag a rectangle. NEXUS IC will

then zoom to the area you’ve selected.
View → Increase Caption
Size

Increases the size of all captions on the drawing: on captions, buttons, and
regions.

View → Decrease Cap-
tion Size

Decreases similarly.

View → Caption → . . . If you select Default, captions will display the text you have set in Layer
Properties. If you select Asset Information or Event, NEXUS IC will
display a picker. You pick a field, and NEXUS IC will use values from
that field to fill captions. This only works for layers that have an asset set
in Layer Properties.

15.2.5.10.1.2 Layer Colour Menu

Toolbar Option Description
Layer Colour → Default Shows layers on drawings in the colours that you have selected in the Prop-

erties of each layer.
Layer Colour → Traffic
Lighting

Shows layers on drawings in the colours specified by the currently selected
Traffic Light.

Layer Colour → Trans-
parent

Shows layers on drawings as just an outline, in the colours that you have
selected in the Properties of each layer.

Layer Colour → Un-
known Asset

Shows layers that have an asset in the Known Asset Colour, and layers
that don’t have an asset assigned in the Missing Asset Colour. You can
configure these in Database → Properties.

Layer Colour → Work-
pack Tasks - [Selected
Workpack]

Displays distinct colours for layers based on the completion status of tasks
assigned to the corresponding assets. This is dependent on the workpack
selected on the Active Inspection pane (see Active Inspection).

15.2.5.11 Event Launcher

From the Event Launcher pane, you can launch ad hoc events while performing online inspection. For detailed
information about how to create ad hoc events from the Event Launcher, see Create Ad Hoc Event.

The tiles in the Event Launcher only get enabled when you are inspecting (you have clicked the Start button in the
main toolbar). If you are not inspecting, all tiles are disabled.

The Event Launcher contains the following two types of tiles:

• A tile is visible for each event type that is assigned to the asset type of the currently selected asset. This assign-
ment is configured in NEXUS IC, as described in Assign Event Types to Asset Type.
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• A tile is visible for predefined event templates (see Set Up Event Templates) in case the following conditions are
fulfilled:

– In the Active Inspection pane, you have selected the Event Template Group that contains the required
event template.

– The event type of the event template is assigned to the asset type of the currently selected asset.

– Under the View toolbar option of the Event Launcher pane, you have enabled the Show Event Templates
option.

You can identify event template tiles by the additional icons on the tile. If a shortcut key exists, that is also shown
on the tile. The icons indicate the type of the action assigned to the event template, which can be one of the
following:

– (tick): Indicates a One-Click Record action type.

– (arrow): Indicates a Launch action type.

– (image): Indicates a Launch with Image action type.

15.2.5.11.1 Event Launcher Toolbar

Toolbar Option Description
View → Grid
Layout

Each event type is shown as a square tile arranged adjacent to each other in a grid
of items.

View → List Lay-
out

Each event type is shown as a tile as tall as the text or icon, and as wide as the
Event Launcher, creating a vertical list of items.

View → Show
Event Templates

Shows tiles for event templates that have been preconfigured (see Set Up Event
Templates)

View → Captions
& Icons

Shows captions and icons on the tiles. Captions and icons are retrieved from the
name and icon configured for the event type in NEXUS IC (see Configure Event
Types and Add/Edit Table Definition Dialog).

View → Only
Captions

Shows only captions on the tiles without icons. Captions are retrieved from the
name of the event type configured in NEXUS IC (see Configure Event Types and
Add/Edit Table Definition Dialog).

View → Only
Icons

Shows only icons on the tiles without captions. Icons are retrieved from icon con-
figured for the event type in NEXUS IC (see Configure Event Types and Add/Edit
Table Definition Dialog).

Grouping →
None

Shows the event type tiles in the Event Launcher in alphabetical order without
grouping. Only tiles for event templates are grouped separately.

Grouping → Cat-
egory

Shows the event type tiles in the Event Launcher grouped by the category of
the event type configured in NEXUS IC (see Configure Event Types and Add/Edit
Table Definition Dialog).
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ã See also

• Create Ad Hoc Event

• Set Up Event Templates

15.2.5.12 Event Listing

The Event Listing panes allow you to view existing events for the selected asset (and it’s children, if it’s enabled) and
in the selected workpack.

There are two Event Listing panes in IC-Inspection:

• Event Listing (Workpack): This pane shows event records for the workpack selected on the Active Inspection
pane. On this pane, you can perform various actions on event records (see Perform Actions on Events)

• Event Listing (Historical): This pane allows you to select one or more workpacks to view event records from.
This is used only for reviewing data, you cannot perform any actions on the event records here.

15.2.5.12.1 Filter Events

You can filter events in the grid based on:

• Workpacks
– On the Event Listing (Workpack) pane, you can only see events associated with the workpack selected on

the Active Inspection pane. If you want to change the workpack, you must do it on the Active Inspection
pane.

– On the Event Listing (Historical) pane, choose Filter → By Workpack from the toolbar to select the
workpacks based on which you want to filter the events.

• Event Type - Choose Filter → By Event Type from the toolbar of the pane to select the event types based on
which you want to filter the events. If you have no event types selected, then all events will be shown, and no
continuous events will be shown. To view continuous events, you must explicitly select those event types in the
filter.

ò Note

When events are filtered by event type from the toolbar menu, and there are only events of a single event type
displayed in the grid, the fields of the specific event type will get added as columns in the event listing grid.

• Time - This option is available only on the Event Listing (Workpack) pane. You can filter events based on the
time they were created. For example, you can choose to display only events created within specific hours or days.

All columns in the grid can also be filtered and sorted using the standard filtering (see Filtering) and sorting (see
Sorting) functionality.

15.2.5.12.2 Columns

By default, the Event Listing tab displays columns that are common to all event types displayed. The first six columns
in the grid represent the following:
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Column Description
F Shows a colour that indicates the existence and status of the Finding that is associated with

the event. See below for more information.
B Indicates if the event has been bookmarked with a star sign.
L An icon is shown if there’s a library item attached to the event.
V An icon is shown if there’s a video attached to the event.
M An icon is shown if there’s multimedia attached to the event.

15.2.5.12.2.1 Finding Statuses

The colours of the icons in the Finding column indicate the status of the finding, which can be the following:

Colour Meaning

(White) There are no findings on this event.
(Yellow) The finding needs to be reviewed.
(Green) The finding has been deemed insignificant and is not linked to an anomaly.
(Grey) The finding is linked to a closed anomaly.
(Red) The finding is linked to an open anomaly.

15.2.5.12.3 Perform Actions on Events

From the Event Listing (Workpack) tab, you can perform actions on events using the relevant toolbar buttons or
right-clicking any of the events, which offers some of the options from the toolbar menu.

You can perform the following actions:

• Update events (see Edit Events)

• Bookmark events - Select Toggle Bookmark from under the Events toolbar button or from the context menu of
the event (available by right-clicking). This sets a star icon next to the event in the grid.

• Delete events

• Update event times - Allows you to update the Start Clock/End Clock survey data based on the incoming survey
data.

• Change event type (see Change Event Type)

• Match tasks to events (see Match Tasks to Events)
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15.2.5.12.4 Event Listing Toolbar

For information about the toolbar menu options on the Event Listing tab, see below:

Toolbar Option Description Available on
Panes

Edit See Edit Events. Event Listing
(Workpack)

Delete Deletes the currently selected event. If multiple events are
selected, it deletes all selected events.

Event Listing
(Workpack)

Events → Navigate
to the event asset

Changes the focus in the asset tree to the asset on which
this event has been recorded. To change back, click on the
back arrow (Previous Asset) in the main toolbar above the
asset tree.

Event Listing
(Workpack)

Events → Update
Start/Update End

Updates the Start Clock/End Clock in the survey data of
the currently selected event based on the incoming survey
data.

Event Listing
(Workpack)

Events → Toggle
Bookmark

Bookmarks are flags on an event. Bookmarked events
are identified by a star symbol in the B column of the
Event Listing tab. The use of bookmarks and the work-
flow around setting and removing bookmarks depends on
your own specific requirements.

Event Listing
(Workpack)

Filter See Filter Events. Event Listing
(Workpack) and
Event Listing
(Historical)

Child Assets When enabled, events for the currently selected asset and
all sub-assets will be included on the Event Listing tab.
When disabled, only events that have been recorded on
the currently selected asset will appear in the grid.

Event Listing
(Workpack) and
Event Listing
(Historical)

Export See Export. Event Listing
(Workpack) and
Event Listing
(Historical)

Customise See Customise. Event Listing
(Workpack) and
Event Listing
(Historical)

Connections See Connections. Event Listing
(Workpack) and
Event Listing
(Historical)

Event Details Toggles the display of additional tabs within the pane, in-
cluding Event Details, Survey, Multimedia and Find-
ing.

Event Listing
(Workpack) and
Event Listing
(Historical)

Shortcuts →
Change Type

See Change Event Type. Event Listing
(Workpack)

Shortcuts → Match
Task

See Match Tasks to Events. Event Listing
(Workpack)
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15.2.5.13 Event Templates

On the Event Templates pane, you can set up event templates that allow you to pre-populate event forms with pre-
defined values when creating ad hoc events. For detailed instructions about setting up event templates, see Set Up Event
Templates.

Once set up, event templates will be available in the Event Launcher (see Event Launcher), based on which you can
create ad hoc events (see Create Ad Hoc Event Using Event Templates).

The Event Templates pane is divided in three parts:

• The list of event template groups on the left-hand side

• The list of event templates within the selected group in the middle

• The event form for the selected template on the right-hand side. This section is read-only, to edit,
double-click the template or select it and click Edit.

ã See also

• Set Up Event Templates

• Create Ad Hoc Event Using Event Templates

15.2.5.14 Heading

The Heading pane provides a visual representation of the serial data collected in the Heading field, typically repre-
senting the ROV (Remotely Operated Vehicle) heading.

This view allows you to quickly determine compass directions, including:

• Compass direction relative to the ROV: You can easily identify which direction is left of the ROV and which is
to the right. This information is particularly useful during pipeline inspections.

• Structure orientation: You can determine which face of a structure you are likely looking at. This feature is
valuable for structure inspections.

The Heading pane offers two viewing modes:

• North Up: In this mode, the yellow heading indicator moves, ensuring that north remains at the top of the pane.

• Heading Up: In this mode, the yellow heading indicator remains stationary at the top of the pane, while the
compass points rotate accordingly.

To switch between North Up and Heading Up modes, simply right-click in the white space anywhere within the Heading
panel and choose the desired mode from the drop-down menu:
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15.2.5.15 Library

The Library pane shows all the library items attached to:

• The asset currently selected in the asset tree.

• The event currently selected on the Event Listing (Workpack) pane.

Library items are electronic documents that can be linked to data and data types in NEXUS IC using connections (see
Library Connections).

The electronic documents can be uploaded directly into the NEXUS IC database, or can be referenced using URL or
UNC paths.

15.2.5.15.1 Manage Library Items

You can manage library items from several screens within NEXUS IC, including:

• Library Items tab on the LIBRARY screen (see Library)

• Library tab on the ASSETS screen (see Library)

• Library tab on the INSPECTION screen (see INSPECTION)

• Library tab on the ANOMALIES screen (see ANOMALIES)

• Library tab under Configuration → General → Functions → Edit Function Definition

• Library tab on the Edit Asset Type dialog under Configuration → Assets → Types

• Library tab on the Edit Table Definition dialog under Configuration → Events → Event Types →
Edit Table Information

Example
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If you upload company piping specifications to the NEXUS IC Library and assign it to the asset type
“Pipework”, the piping specifications will be available from the Library* tab of the ASSETS screen when-
ever the active asset is of type “Pipework”.

You can also maintain library items on the Library pane of IC-Inspection.

You use the standard toolbar functions on the Library/Library Items tab to add, edit, delete, import, export library items
or customise the grid layout. For more information about these functions, see Using the Grid.

ò Note

• You can edit the properties of the selected library item from the toolbar, but not the document
itself.

• Deleting a library item will also delete all its associated connections.

• The Export option only exports the grid contents, not the actual library documents.

See below for more information about some actions you can perform on library items:

ò Add Library Items

To create a new library item, proceed as follows:

1. Start adding a new library item in one of the following ways:

• On the Library/Library Items tab, choose Add from the toolbar.

• Drag files from your file explorer onto the Library/Library Items tab.

ò Note

Drag-and-drop is not supported in remote environments (e.g., Remote Desktop).

2. Depending on the screen from which you accessed the Library tab, you may be prompted to select a con-
nection type. You can connect a library item to different types of data records:

Screen Connection Type
ASSETS

• Asset
• Asset Type

INSPECTION
• Asset
• Asset Type
• Event
• Event Type
• Workpack

ANOMALIES
• Anomaly
• Asset
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ò Note

If you’re adding a library item from the LIBRARY screen, you add the connection to a data record from
the Connections tab after you have created the library item. For more information, see Add Library
Connections.

3. In the Add/Edit Library dialog, select the library type, enter a name for the library item (mandatory) and
enter other parameters as required. For information about filling in all the parameters, see Add/Edit Library
Dialog.

• If the document is to be uploaded into NEXUS IC, then click on the Attachment button, else enter a
Hyperlink location.

• When adding an attachment, you can either Import or Link it:

– If you import, the item will be saved to the database. If you subsequently change the original on
disk, the item in the database will not change to match.

– If you link the item, then when you change the original on your disk, the next time you view the
item within NEXUS IC, you’ll see the updated item.

ò Note

• NEXUS IC still loads a copy of a linked item into the NEXUS database. This ensures
that if the original is unavailable (for example, because you are away from your network),
NEXUS IC can display the cached copy.
When you view the item, if the original has been updated, the database cached copy is
updated too. You can’t link items that are on your local hard disk, only items on network
drives can be linked. The Link feature is designed to keep you up-to-date with items
that may have been changed by others, and that is not possible on your local drive.

• If you drag and drop multiple files, they will be added, and then multi-selected in the
grid. You can then click Edit to multi-edit them (see Multi-Edit). Drag and drop will
import items, not link them.

4. Click OK.
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On the LIBRARY screen, you can view the details of the library item by selecting it and checking the Details
tab under the Library Items tab.

ò Edit Library Items

To edit an existing library item, proceed as follows:

1. On the Library/Library Items tab, select the library item.

2. Choose Edit from the toolbar.

3. In the Edit Library dialog, update data as required. For more information, see Add/Edit Library Dialog.

4. Click OK to save your changes.

ò Delete Library Items

To delete an existing library item, proceed as follows:

1. On the Library/Library Items tab, select the library item.

2. Choose Delete from the toolbar.

3. In the confirmation dialog, click Check Connections if you want to review any connections to this library
item before deletion.

4. If you want to proceed deleting the library item, click Delete, else, choose Cancel.

ò Launch Library Items

Use the Launch toolbar button to launch library items on the local machine. By default, NEXUS only launches
files with the following extensions: doc, docx, xls, xlsx, jpg, png, jpeg, jfif, bmp, tiff, gif, mpg, mp3, wav, ppt, pptx,
txt, pdf, emf, zip, dwg, avi, rtf, mp4, csv.

� Hint

Use the Space Bar on your keyboard to launch the currently selected library item.

Note that if the local machine does not have an associated viewer for the document type (for example, AutoCad
viewer for DWG type), then the document can not be launched.

ò Email Library Items

Use the Email toolbar button to send an email message with the selected library items attached to it.
You can select multiple library items to be sent in the same email message. Note that you must have
properly configured your email settings (see Set Up Email) for this option to function.

. Warning

If the size of the attachment exceeds your organization’s attachment size limit, you may get an “Out
of memory” error message.
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ò Import Library Items

You can import library items using the standard Import toolbar option (see Import). You can download the MS
Excel Import Template, which shows the required format for importing library items.

You can also import the Connections in the same import as the library items, so in addition to the Library Import
columns, you can additionally define the Connection information using the following column headings:

• Library Connection.Connect To

• Library Connection.Workpack

• Library Connection.Asset Type

• Library Connection.Asset

• Library Connection.Event Type

• Library Connection.Event

• Library Connection.Anomaly

• Library Connection.Risk Model

• `Library Connection.Function

Note that the Connect To column should only contain one of the following text items:

• Anomaly

• Asset

• Asset Type

• Event

• Event Type

• Function

• Risk Model

• Workpack

15.2.5.15.1.1 Double-click

The first time you double-click on a library item, NEXUS asks you whether you want to launch the library item in
an external editor, or edit the library item. If you want your choice to become permanent, tick the Always do this
checkbox. Note that if you hold down the Alt key while double-clicking, you will be asked again.

15.2.5.16 Map

On the Map pane, you can see the events visible on the Event Listing (Workpack) or Event Listing (Historical)
panes (see Event Listing) on a two-dimensional map, based on their easting (x-coordinate) and northing (y-coordinate).
Each event is a dot, coloured with the event type’s colour. The colour for each event is set up in NEXUS IC as described
in Configure Event Types.
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15.2.5.16.1 Filtering

The Map pane only shows event data included in the filters you applied on the Event Listing pane (for example,
workpacks, event types, column-specific filters). You can also filter by event type using the Event Types toolbar button
options. If the events you are interested in are Continuous Event data (such as cross-profiles), ensure that you select
that Continuous Event in your event type filter.

15.2.5.16.2 Zooming

You can zoom in or out by clicking in the map area and (with the mouse cursor still inside the map area) spinning the
mouse wheel. You can also control zoom with the relevant toolbar buttons.

15.2.5.16.3 Maps Toolbar

You can use the following toolbar menu options on the Map pane to manage the appearance of the map:

572 Chapter 15. IC-Inspection



NEXUS Documentation, Release 6.9.xxxxx.0

Toolbar
Option

Description

Zoom
In

Zooms the map in.

Zoom
Out

Zooms the map out.

Reset
Zoom

Resets the zoom so that all data points are visible.

Copy Copies the map, as currently displayed, to the clipboard.
Legend Shows or hides the legend of the events on the map either on the side or at the bottom. The

legend includes the event types that are selected and the layers that have their opacity set to
anything above 0%. Layers and event types can be switched off by clicking on the layer or
event on the legend. If you hover the mouse over an item on the legend, other series on the
map will fade out temporarily. If you export the map, only series currently visible will be
exported.

Map
Layers

Shows or hides layers on the map and controls their opacity. The menu options include free-
to-use map layers from the web, such as ESRI World Imagery, ESRI World Topographic,
ESRI Ocean Base Map, ESRI Street Map, and so on. The available map servers can be
configured under Configuration → General → Map Servers from the main menu. Each of
these layers has an opacity drop-down list to be selected from 0% to 100%. If you select
0% for any of the layers, it will not be included in the map legend.

Event
Types

Selects what event types are displayed. This is more persistent than clicking/unclicking
series on the map legend.

Inspec-
tion
Track

Selecting a workpack from under this toolbar option will show a line on the map connecting
events in the order they were logged. If the events were logged by a single ROV (or a single
human inspector), this track will show the path that the ROV (or inspector) took.

Base-
line

Shows or hides the baseline coordinates of the assets behind the events on the map. For
example, in case of a pipeline, a black line can be displayed that shows the position of the
pipeline. This is shown based on your settings for the asset’s coordinates under Assets →
Coordinates (also available in the context menu (right-click) of the selected asset).

Config-
ure

Shows the sources of the various fields used by the Map pane to display pipeline baseline
data and map data. “As Built - Easting”, “As Built - Northing” and “As Built - Order”
should all point to the same table, which is the table used to supply the pipeline baseline
track. Typically you would point these three fields at a sub-AIG. If you don’t configure these,
no as-built track will be displayed. If your pipeline has many events on it, not showing an
as-built may be OK. Users may be able to get a sense of the pipeline track from the events
on it. “Coordinates - Datum” and “Coordinates - UTM Zone” should point to fields that
provide these values. Typically they will be in an AIG. Only one datum and one UTM Zone
are necessary for an entire asset. Ask your surveyors for the values that you should fill in to
these fields.

Export
Image

Saves the map to an image file.

15.2.5.17 Pipeline View

On the Pipeline View panes, you can see a special chart that shows events along your pipeline in a 3D view. Each event
appears in the pipeline view when you click Save on the event form.

There are two Pipeline View panes in IC-Inspection:

• Pipeline View (Workpack): This pane shows the pipeline view chart for the event selected on the Event Listing
(Workpack) pane.

• Pipeline View (Historical): This pane shows the pipeline view chart for the event selected on the Event Listing
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(Historical) pane.

The pipeline view can also show seabed profile (if you have any PL - Cross Profile data imported), and animates motion
along the pipeline as you select events.

15.2.5.17.1 Prerequisites

To ensure that the Pipeline View (Workpack) and the Pipeline View (Historical) charts are displayed correctly, con-
figurations must be made in NEXUS IC as described in Configure Pipeline View Chart.

15.2.5.17.2 Zooming

You can zoom in or out by clicking in the chart area and (with the mouse cursor still inside the chart area) spinning the
mouse wheel.

You can also control zoom using the following toolbar buttons:

But-
ton

Description

Zooms the image in.
Zooms the image out.
Resets to default zoom level.

15.2.5.17.3 Pipeline View Toolbar

In addition to the toolbar buttons for zooming, the following buttons are available, which are specific to the pipeline
view chart:

But-
ton

Description

Tracks the current KP. This button is only available in IC-Inspection. When selected, the
pipeline view will move in time with the KP value coming in from survey. For NEXUS IC,
see Time Source → Synchronise KP on the Inspections Toolbar.
Exaggerates the scale to show more of the pipeline. When selected, the scale of the pipeline
will be distorted to make a greater KP range visible.
Toggles stacked series mode. When selected, events above the pipeline will be moved to make
them more obvious. Different events will be moved up different distances so that all are easily
distinguishable.
Toggles 3D perspective mode. When unselected, you will see the pipeline viewed from the
side. When selected, you will see the pipeline viewed from above and slightly off to one side.

15.2.5.17.4 Displaying Pipeline Views

To ensure that the Pipeline View (Workpack) and the Pipeline View (Historical) charts are displayed correctly, in
addition to the configurations in NEXUS IC (see Configure Pipeline View Chart), in IC-Inspection, you must perform
the following steps:

• Close and reopen the database in IC-Inspection whenever you have made a change to your Pipeline View chart
configurations in NEXUS IC.

• After reopening the database for the first time, perform the following:
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– For the Pipeline View (Workpack) chart, open the Event Listing (Workpack) pane before you check the
chart on the Pipeline View (Workpack) pane, and ensure that events are listed there. This pane must be
active so that the chart is displayed correctly on the Pipeline View (Workpack) pane:

– For the Pipeline View (Historical) chart, open the Event Listing (Historical) pane before you check the
chart on the Pipeline View (Historical) pane, and ensure that events are listed there. This pane must be
active so that the chart is displayed correctly on the Pipeline View (Historical) pane:
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15.2.5.18 Survey Values

The Survey Values pane displays all survey fields that are coming through the serial string. Survey fields are defined in
the Device Manager, within the device they are being received from. You can also see the field type, the current value,
the source of the serial input and the database field in which the survey value will be recorded into. For information
about updating the default mapping between the source and destination survey fields, see Map Survey Fields.

The State column shows a colour that reflects the status of survey value transmission. Click Legend to display an
explanation for each colour at the bottom of the pane. If the colour is red, it means that the value is invalid. This can
happen if the Value field contains a value that does not match its survey field type. For example, if the type is a Whole
Number and the value is “1-1-2017”, then that’s not valid.

15.2.5.19 Tasks

On the Tasks pane, you can see the list of tasks that are associated with the selected asset in the asset tree and included
in the workpack selected on the Active Inspection pane.

From this pane, you can use the toolbar options to perform various actions on tasks, such as review, edit or launch them.
For more information, see below.

15.2.5.19.1 Tasks Toolbar

Toolbar Option Description
Launch Launches the currently selected task and creates an event form in the Active Events

pane. For more information, see Create Event from Task.
Template You can use this option if you have set up an event template (see Set Up Event

Templates) for the event type of the task, and selected the event template group
in the Active Inspection pane. This allows you to launch the task and create the
event using the preconfigured event template.

Edit Allows you to edit the task in the Edit Task dialog. For more information, see
Add/Edit Task Dialog.

Navigate to Asset Changes the active asset in the asset tree to the currently selected task’s asset. Note
that this will change what tasks are visible in the Tasks pane.

Filter Allows you to filter the visible tasks in the Tasks pane. If you select Hide Com-
pleted, all completed tasks will be hidden.

Child Assets Toggles on and off the display of tasks on assets that are descendants of the cur-
rently selected.

Parent Assets toggles on and off the display of tasks on assets that are ancestors of the currently
selected asset.

Export See Export.
Customise See Customise. On this pane, the additional option Instructions Preview is avail-

able under Customise, which displays an additional column in the pane for In-
structions.

Connections See Connections.
Instructions Toggles the visibility of the Task Instructions pane within the Tasks pane.
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SIXTEEN

IC-INSPECTOR

IC-Inspector is a tablet application optimised for on-site or offshore inspection data collection. IC-Inspector commu-
nicates with a NEXUS REST server to receive tasks and drawings, and to upload inspection data. It can be used for
inspection with no internet connectivity, although it requires connectivity to initially receive tasks and finally send
inspection data.

16.1 IC-Inspector Platforms
IC-Inspector is compatible with different platforms, including iPad, Windows and Android tablets. For more informa-
tion, see IC-Inspector Platforms.

16.2 Prerequisites
Before using IC-Inspector, ensure the following:

• You have downloaded the IC-Inspector app on your tablet and deployed it as described in Install IC-Inspector.

• The necessary configurations have been made in the NEXUS IC database, including assets (see Asset Data
Management), event types (see Configure Event Types), and optionally drawings (see Drawings).

• You have set up the IC-Web URL, login name and password for IC-Inspector. The login name should match an
inspector who has tasks assigned to them.

• Ensure that you have Wi-Fi or mobile data connection to login and sync your data.

16.3 Using IC-Inspector
The following figure shows the basic process of using IC-Inspector and is followed by an explanation:

1. The integrity engineer/work planner creates and assigns tasks to inspectors using NEXUS IC or IC-Web (see
Create Tasks and Assigning Tasks).

2. The tasks are stored in the NEXUS IC database.

3. The inspector logs in to IC-Inspector (see Log In to IC-Inspector) and performs synchronisation to retrieve the
assigned tasks through the REST service (IC-Web). The synchronisation process also retrieves any unassigned
ad hoc tasks in case the inspector has at least one assigned task in the same workpack. For more information,
see Sync to IC-Inspector.
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4. The inspector accesses tasks in IC-Inspector (see View Tasks) and completes them by filling in event forms. They
can take or attach photos as desired. Optionally, they can create ad hoc (or unplanned) events to allow filling in
additional event forms over and above the tasks assigned. For more information, see Complete Tasks.

5. The inspector performs synchronisation in IC-Inspector again to send the events (completed task data) to the
database through the REST service (IC-Web). For more information, see Sync to NEXUS IC.

6. Engineers or review teams review events in NEXUS IC or IC-Web (see Inspection).

The app comes with demo data suitable for touring and learning the app. You can connect it to your actual database
via Settings.

16.3.1 IC-Inspector Platforms
IC-Inspector can run on three different platforms:

• iPad (but not on iPhone or iPod Touches)

• Windows tablet

• Android tablet (but not on Android phone)

16.3.1.1 IC-Inspector Feature Matrix

The availability of some features may vary across these platforms. The following figure shows the features supported
by different IC-Inspector platforms.

ò Note

Certain platform-specific functions (such as Camera or Library) may have varying appearances on the different
platforms.

16.3.2 Install IC-Inspector
To deploy IC-Inspector 6.9, ensure you have the required hardware and download the appropriate version of the app
for your device.

ò Note

Before installing IC-Inspector 6.9 on your device, you must delete version 6.8. Be sure to synchronise
your data before deletion to avoid data loss.

IC-Inspector can be installed on various platforms, including iPads, Android tablets, or Windows tablets. Select your
platform below for installation instructions:

ò Install IC-Inspector on iPad

IC-Inspector for iPad is available for free from the App Store.
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Requirements

• iPad with iPadOS 16 or later

• IC-Web Read/Write License

• IC-Web 6.9 or higher (6.9 recommended)

• NEXUS DB schema 8.210

• Deployment of IC-Inspector on multiple iPads for multiple inspectors in the field should be performed using
a Mobile Device Management (MDM) solution or by using a different Apple ID on each iPad.

. Warning

If multiple users are using IC-Inspector on different iPads but with the same Apple ID (which is not
recommended), then you must turn off iCloud synchronisation for IC-Inspector before synchronising
your data. Failure to do so may result in data loss.

Recommendations

• We recommend using the iPad Pro. IC-Inspector will run on any iPad (which can be useful for
testing and training), but will not run on iPhones or iPod Touches.

• If you expect inspectors to mark up photos, we suggest purchasing an Apple Pencil.

• If you expect inspectors to do significant quantities of typing, we also suggest purchasing a key-
board cover.

• Note that in quiet environments, you can use the iPad’s built-in speech-to-text dictation capabil-
ity. On some devices, this capability works independent of internet connection. You can go to
Settings → General → Keyboard and check the bottom of the screen for the message “You can
use Dictation for English when you are not connected to the Internet.”

� Tip

When using speech-to-text for numeric fields, use phrases like “numeral one” for
single-digit numbers; phrases like “one dot two three” for decimal numbers less
than 10; phrases like “twenty three dot one nine” for decimal numbers from 10 to
100; and phrases like “one two three dot four five” for decimal numbers greater than
100.

• If intrinsic safety is required, consider using intrinsically safe enclosures available from third-
party vendors. Be aware that some vendors may require you to ship your tablet to them for
installation.
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• Inspections are often conducted in extreme or hazardous environments. To ensure optimal per-
formance, make sure your tablets are rated for the specific environmental conditions of your site,
including temperature, pressure, humidity, and intrinsic safety.

³ Caution

Applications on iPads have a memory limit, which is specific to your device and iOS version.
In case the memory limit in IC-Inspector is exceeded, the app may close without warning. We
recommend that you regularly synchronise your data to free up space and avoid exceeding the
application memory limit.

Security
On iPads, the app performs a check for jailbroken devices upon launching. If it detects that the device is jailbroken,
it shows a notification and does not allow the user to proceed.

ò Install IC-Inspector on Android Tablet

IC-Inspector for Android tablet is available for free from the Google Play Store.

Requirements
• Android version 15 or later

• 6 GB RAM

• 128 GB Storage

• IC-Web Read/Write License

• IC-Web 6.9 or higher (6.9 recommended)

• NEXUS DB schema 8.210

Recommendations
• For integrated image markup capabilities, install the Google Photos app from the Google Play Store.

• If intrinsic safety is required, consider using intrinsically safe enclosures available from third-party vendors.
Be aware that some vendors may require you to ship your tablet to them for installation.

• Inspections are often conducted in extreme or hazardous environments. To ensure optimal performance,
make sure your tablets are rated for the specific environmental conditions of your site, including temperature,
pressure, humidity, and intrinsic safety.

ò Install IC-Inspector on Windows Tablet
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IC-Inspector for Windows tablet can be installed by requesting an installer package from support@nexusic.com.

Requirements
• Windows 10 tablet

• 6 GB RAM

• 128 GB Storage

• IC-Web Read/Write License

• IC-Web 6.9 or higher (6.9 recommended)

• NEXUS DB schema 8.210

Recommendations
• If intrinsic safety is required, consider using intrinsically safe enclosures available from third-party vendors.

Be aware that some vendors may require you to ship your tablet to them for installation.

• Inspections are often conducted in extreme or hazardous environments. To ensure optimal performance,
make sure your tablets are rated for the specific environmental conditions of your site, including temperature,
pressure, humidity, and intrinsic safety.

� Tip

You can check for app updates on the Settings screen by clicking About under APP INFO.

16.3.3 Log In to IC-Inspector
You can log in to IC-Inspector using one of the following methods:

• Single Sign-On (SSO): Use your company credentials for seamless authentication.

• Database-specific credentials: Use a dedicated account to access IC-Inspector.

Both login methods are described below.

16.3.3.1 Log In Using SSO

1. Launch the IC-Inspector app on your tablet.

2. Go to Settings.
3. Ensure that the Use Demo Data option is turned off.

4. Under SERVER, confirm that Corporate Credentials (SSO) is selected in the Sign in Using field.
This is selected by default.
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5. Each time you perform a sync (see Sync to IC-Inspector and Sync to NEXUS IC), IC-Inspector ini-
tiates the sign-in process unless you have already signed in and your SSO session and hash are still
active. You can also tap Test SSO on the Settings page to verify SSO connectivity.

6. When prompted, enter your company username and password, and complete any multi-factor au-
thentication steps required by your organisation’s standard login process.

7. If you have access to more than one database, you will be prompted to select the appropriate IC-
Inspector database by tapping its icon on the sign-in page.
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ò Result

A success message confirms that SSO authentication was successful. Your username appears in the
sidebar, and the Server and Login fields on the Settings page are automatically populated and locked.
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ò Note

• The SSO session and hash expire after a set period. After that, you’ll be prompted to sign in
again when performing a new sync.

• If you switch users or change the login method, the previous SSO session will be terminated.
Any unsynchronised data from the previous session will be lost.

16.3.3.2 Log In Using Database-Specific Credentials

1. Open the IC-Inspector app on your tablet.

2. Go to Settings.
3. Ensure that the Use Demo Data option is turned off.

4. Under SERVER, select Database Login in the Sign in Using field.

5. Enter data as follows:

• Server: Enter the name of the server as [database].nexusic.com.

• Login: Enter your username without the NEXUS IC domain using the format ‘username’.

• Password: Enter your password.

586 Chapter 16. IC-Inspector



NEXUS Documentation, Release 6.9.xxxxx.0

6. Tap Connect & Save.

16.3.4 Sync to IC-Inspector
Before inspectors can carry out their inspection activities, they must perform synchronisation to download their assigned
tasks from NEXUS IC through the REST service.

ò Note

You must have a stable internet connection to perform sync.

16.3.4.1 Initiating Sync

1. Click Sync in the sidebar of IC-Inspector.

2. In the pop-up dialog, click Sync to proceed.

. Warning
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If multiple users are using IC-Inspector on different iPads but with the same Apple ID (which is not
recommended), you must turn off iCloud synchronisation for IC-Inspector before synchronising your
data. Failure to do so may result in data loss.

16.3.4.2 Sync Operations

During sync, the following actions are performed:

• Any new tasks (and their associated drawings) assigned to you are downloaded to your tablet from the NEXUS
IC database.

• Any new unassigned ad hoc tasks within a workpack are also downloaded, but only if you already have at least
one assigned task in that same workpack.

• Any tasks no longer assigned to you are removed from your tablet.

ò Note

If any of these tasks are partially completed, that data will be lost.

• Tasks that you have completed are sent back to the NEXUS IC database.

• Any changes in task statuses are sent back to the NEXUS IC database.

ò Note

• Between synchronisations, you may operate outside of network range; you need coverage only during sync.

• In Demo mode, sync is disabled.

16.3.5 View Tasks
Once tasks have been synchronised to your tablet, you can view them in IC-Inspector through the following interfaces:

• Summary screen

Displays an overview of tasks using donut charts. See Summary Screen.

• Tasks screen

Shows a detailed list of all tasks. See Tasks Screen.

• Drawings screen

Allows you to view tasks directly from drawings. See Drawings Screen.

• Scan Code
Scan QR or barcodes affixed to physical assets to quickly locate linked tasks. See Scan Code.

16.3.5.1 Task Types

Records in IC-Inspector fall into three categories:

• Assigned Tasks
These are specific tasks allocated to you by an integrity engineer or work planner. For example, you may be
required to perform a general visual inspection (GVI) on a designated section of piping.
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• Ad Hoc Tasks
These are not assigned to individual inspectors but are available for use as needed. Engineers or work planners
can create ad hoc tasks for specific workpacks. If you have an assigned task within a workpack, any related ad
hoc tasks will also appear in your task list.

You can use ad hoc tasks to record observations that may require follow-up. For instance:

– If your GVI procedure indicates that corrosion should trigger a UT measurement, locate and complete the
relevant ad hoc UT task.

– If you observe a leak, use the corresponding ad hoc leak task to record the event.

You can record multiple events for a single ad hoc task. The task remains in your list even after events have been
recorded.

• Ad Hoc Events
These are created when you record an event using an ad hoc task. Each ad hoc event appears as a separate entry
in your task list, while the original ad hoc task remains available for future use.

� Tip

To easily distinguish between task types, we recommend assigning specific row colours to ad hoc tasks and ad hoc
events under Settings (see Settings).

16.3.5.1.1 Summary Screen

The Summary screen provides a visual overview of your assigned tasks and their completion status using doughnut
charts. Its layout is similar to the dashboard in NEXUS IC.

16.3.5.1.1.1 Available Views

From this screen, you can access four distinct views from the bottom menu. Each view groups tasks by a higher-order
category:

Task Displays doughnut chart pairs grouped by assigned tasks and ad hoc tasks.
Workpack Displays doughnut chart pairs for each workpack containing your assigned tasks.
Asset Displays doughnut chart pairs for each different asset you have assigned tasks on.
Status Displays doughnut chart pairs for each task status.

In each view:

• The left chart shows the number of tasks by type.

• The right chart shows the percentage of tasks completed.

16.3.5.1.1.2 Using the Summary Screen

From the Summary screen, you can perform the following actions:
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Action Result
Enter a search
term in the search
bar at the top of
the screen and hit
Enter

Allows you to search for tasks. On the Summary screen, the search function indexes the Task
Name, Asset Name or Location, the Event Type Name, and Workpack Name or abbreviation
depending on the ‘workpack display name’ setting.

Tap the icon
in the top left cor-
ner

Toggles between showing or hiding the sidebar on the screen.

Tap the ellip-
sis in the top right
corner

Gives you the option to toggle Show Tasks in Drawings and Show Ad Hoc Tasks on or
off. This can be used when you check a collection of tasks. When you toggle Show Tasks
in Drawings off, you will be shown a list of Tasks Screen, and if toggled on, you will see a
collection of Drawings Screen with tasks in layers on those drawings.

Tap the text at the
centre of a dough-
nut

Takes you to a new page that shows only the relevant collection of tasks. The way tasks are
shown on this page is determined by what you have selected under → Show Tasks in
Drawings.

Tap a segment of
a doughnut or its
name in the chart
legend

Shows the completion for a particular doughnut segment rather than the whole group. For
example, tapping the segment “Contact CP” on the left-hand chart will highlight the “Contact
CP” segment and show the number of Contact CP tasks, and the right hand chart will show
the proportion of Contact CP tasks complete.

Tap the top centre
of the screen

Quickly scrolls back to the top of the list.
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16.3.5.1.2 Tasks Screen

On the Tasks screen, you can see the complete list of tasks assigned to you, as well as ad hoc tasks and all ad hoc events
that you created from ad hoc tasks. Tasks are assigned to you by an integrity engineer or work planner in NEXUS IC
(see Assigning Tasks). The total number of all tasks is displayed next to Tasks in the sidebar.
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16.3.5.1.2.1 Filter Tasks

You can choose which tasks to show by tapping the ellipsis at the top right:

ò Note

• To make the Show Synced Tasks option visible, go to the Settings screen and disable Remove Completed
Tasks During Sync under SYNC.

• The filters Show Completed Tasks, Show Tasks With Status and Show Synced Tasks will only work if either
the Show Assigned Tasks filter, the Show Ad Hoc Tasks filter, or both are enabled.

16.3.5.1.2.2 Grouping of Tasks

Depending on the view selected in the bottom menu, tasks are grouped as follows:

View Grouping
Task Tasks are grouped based on their task type, that is, whether they are assigned or ad hoc. Ad hoc events

created for ad hoc tasks are also included in the task list.
Work-
pack

Tasks are grouped by the workpack the task is assigned to. This assignment is defined in the Workpack
field when a task is created in NEXUS IC (see Tasks).

Asset Tasks are grouped by the name and location of the asset to which the task belongs. This value is defined
in the Asset field when a task is created in NEXUS IC (see Tasks).

Status Tasks are grouped by their statuses. For more information about the available statuses, see Task Sta-
tuses.

By default, tasks within these groups will be ordered by the order number given to the task in NEXUS IC. If no order
number is defined, then they will be ordered by name.

You can expand or collapse the list of tasks under the grouping header they belong to. You can also see the number of
assigned tasks for each grouping next to the grouping header.
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16.3.5.1.2.3 Search Tasks

You can search for tasks by entering your search term in the search bar at the top of the screen. On the Tasks screen,
the search function indexes the Task Name, Asset Name or Location, the Event Type Name, and Workpack Name or
abbreviation depending on the ‘workpack display name’ setting.

16.3.5.1.2.4 Task Statuses

The task statuses are displayed in italics, next to each task in a task list. These statuses have either been manually
selected by the user or automatically determined by IC-Inspector, based on the actions performed on the task.

Tasks can be grouped by their status by selecting the Status view from the bottom menu on any screen that displays a
task list.

For detailed information about how tasks statuses are determined, see Set Status.
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ã See also

• Perform Actions on Tasks

• Complete Tasks

• Maintain Event Details

• Edit and Markup Images

16.3.5.1.2.5 Perform Actions on Tasks

You can perform various actions on the Tasks screen by tapping or swiping an item in the list of tasks.

16.3.5.1.2.6 Tapping a Task

When you tap a task, it results in the following:

• In the case of an assigned task, the Event Details screen opens, where you can fill out more information (see
Maintain Event Details).

• In the case of an ad hoc task, besides being able to enter data on the Event Details screen, a new ad hoc event
item is created under the task list.

16.3.5.1.2.7 Swiping a Task

You can perform the following actions when swiping a task’s row:

Mark as Complete
Mark a task as complete. For more information, see Complete Tasks.

Mark as Incomplete
Change a task that has already been completed back to incomplete status.
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Create Event
Create an event for an ad hoc task. When you create an event for an ad hoc task, a new ad hoc event item is
created and is visible under AD HOC EVENTS on the Task screen when you use grouping by Task. You can
enter event details or complete a task from there.

Missing Information
See if a task has missing information in its event details. This means that either there is no value defined for a
required field, or there is an incorrect value for a field (for example, the value is outside of the minimum and
maximum value range). Go to the event details of the task to enter or correct field values.

Clear Status
Remove the status that was assigned to the task on the Event Details screen (see Set Status).

Delete Task
Delete ad hoc events from IC-Inspector. You can also delete posted tasks, that is, tasks that have been completed
and synchronised but not deleted from IC-Inspector (probably due to the fact that the option of deleting completed
tasks upon synchronisation has been disabled in your settings).
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Bookmark Task
Add a task to your bookmarks. You can remove the bookmark by tapping this button again.

16.3.5.1.3 Drawings Screen

The Drawings screen shows a collection of drawings linked to assets in NEXUS IC. If you have tasks associated with
an asset that has a drawing, you can access those task details directly from the drawing.

16.3.5.1.3.1 Using the Drawings Screen

• Scroll to browse available drawings

• View task counts: The number of incomplete tasks is shown in the top-right corner of each drawing.

• Open drawing details: Tap a drawing to view its layers and associated tasks (see Drawing Details)

• Search drawings: Use the search bar at the top to find drawings by entering keywords. The search indexes the
following fields:

– Drawing Name

– Task Name

– Asset Name or Location

– Event Type Name

– Workpack Name or abbreviation (based on the ‘workpack display name’ setting)
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16.3.5.1.3.2 Drawing Details

When you tap a drawing on the Drawings screen, the drawing’s details are shown where you can see its layers and
associated tasks.

Layers are created in NEXUS IC (see Manage Layers in Drawings) and may contain links to specific assets. If a layer
is linked to an asset, you can view the number of tasks associated with that asset directly from the drawing layer.

16.3.5.1.3.3 Screen Options

At the top right of the Drawing screen, tap the ellipsis icon to reveal display and filtering options.
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You can also collapse or expand the drawing height using the corresponding icon.

16.3.5.1.3.4 Layer Colours

The colour of each layer indicates the task status:

Grey Layer has no task
Red All tasks are incomplete
Orange Some tasks are incomplete
Green All tasks are complete

16.3.5.1.3.5 Interacting with Layers and Tasks

• Tap a layer to view its tasks in a task list at the bottom of the screen.

• Tap a task in the task list to launch it and maintain its event details. For more information, see Maintain Event
Details.
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16.3.5.1.4 Scan Code

If your NEXUS database has a field (such as an asset information field) configured to contain an asset tag, you can affix
QR codes or bar codes to your physical assets, then scan them in IC-Inspector.

16.3.5.1.4.1 Prerequisites

To use this functionality, the following configuration must have been made in NEXUS IC:

1. A field must be available in an asset information group (AIG), where the QR code or bar code can be assigned
to a specific asset.
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2. This specific field must have been assigned to the usage Asset - Tag under Configuration → Assets → Features.
For more information, see Configure Features.

16.3.5.1.4.2 Process

To scan a code, proceed as follows:

1. Tap Scan code, then point the iPad’s camera at the QR code or bar code.

2. If the code is found in your NEXUS database, and IC-Inspector currently has one or more tasks for
that asset, you can see the asset name that matches this code at the bottom of the screen.

3. Tap the asset name to see its list of tasks.

4. Select tasks from the list as required.

ò Note

You can use the buttons at the top of the screen as follows:

• To display the actual QR or bar code, tap the i info button.

• To scan another code, tap Continue.

• To cancel scanning and go back to the task list, tap Cancel.

16.3.6 Complete Tasks
Completing a task in IC-Inspector involves the following key steps:

1. Launch the task.
Open the Event Details screen by launching a task.

See Launch Tasks.

2. Enter inspection data (event details).
Fill in the required inspection details. This action creates an event record.

See Maintain Event Details.

3. Attach multimedia (optional).
You may attach photos or other multimedia files to the event record.

See Add and Manage Multimedia.
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4. Set task status.
Update the task status as needed. To sync the event record with the NEXUS IC database, the task must be marked
as Complete.

See Set Status.

16.3.6.1 Launch Tasks

When you launch a task, the Event Details screen opens where you can record data against the task (see Maintain
Event Details).

You can launch a task in several ways in IC-Inspector:

• From the Tasks screen: Tap the task in the task list.

• From the Drawing details screen: Tap the task in the task list that opens when you click a layer.

• From the Summary screen: Tap the task in the task list that opens when you click the centre of a donut.

ò Note

If you tap an ad hoc task, besides being able to enter data on the Event Details screen, a new ad hoc event item is
created under the task list. Even after completing an ad hoc event, the original ad hoc task remains in your task list
for future use.

16.3.6.2 Maintain Event Details

Once you have launched a task (see Launch Tasks), you can enter data against the task on the Event Details screen.
Data entered for a task is then saved as an event record.

For each type of task, there’s a corresponding event form. These forms can be designed in NEXUS IC. For more
information, see Configure Event Types.

You can fill details into the form as required. Note the following:

• A red icon indicates that there is no value entered for a field that is required, or an invalid value is defined
for the field (for example, the text is too long in an edit box).

• You can clear a non-required field by tapping the clear icon.

• If a field has a field help, you can view it by clicking the icon visible next to the field.
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� Tip

You can change the text size on event forms (and therefore how much of the form fits on your screen
at once) in your tablet’s Settings, under Display & Brightness → Text Size.
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16.3.6.2.1 Delete Ad Hoc Events

For ad hoc events, the Delete button is visible, which you can use to delete the ad hoc event from IC-Inspector.

16.3.6.2.2 Check Task Information

Tap on TASK INFORMATION to see details of this task (the asset name, event type, asset location, any task instruc-
tions, and any drawings directly linked to this asset). If any Asset Information Group is configured to be shown in
IC-Inspector (see Configure Asset Information Groups), it will be shown on this screen.
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Note that the Task Instructions section is shown only if there’s actual task instruction data assigned to the task.
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16.3.6.2.3 Convert Unit for Numeric Fields

If a unit value has been assigned to a numeric field in NEXUS IC, you can convert it to another unit on the Event
Details screen. To do this, click on the blue unit value next to the field and choose the required unit from the context
menu. The field’s value will then update to reflect the selected unit.
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16.3.6.2.4 Bookmark Events

You can “bookmark” an event by tapping . The icon will change to . You can tap again to remove the bookmark.

Bookmarking is used for user-defined purposes, its purpose is defined by the requirements of your organisation. Its
usual use is to flag events which require review, for example, checking grammar, checking that you are on the correct
asset, sense-checking data recorded. You can also add text in the Notes field indicating the reason you have bookmarked
this event. Bookmarked events will be flagged with a green star in NEXUS IC’s Event Listing.

16.3.6.3 Add and Manage Multimedia

You can add multimedia files (for example, photos, drawings, sketches) to your event records on the Event Details
screen when maintaining event data (see Maintain Event Details).

16.3.6.3.1 Add Multimedia

To add multimedia, tap the button at the bottom of the Event Details screen. A menu will appear with the following
options:

• Camera: Take a photo using your device’s camera.

Note: If you enabled it under Settings, photos are automatically saved to your tablet’s photo library when taking
new photos.

• Library: Select one or more images from your device’s photo library.

• Drawings: Choose a drawing with layers linked to this task’s asset. If no linked drawings are available,
this option will be disabled.

• Sketch: Open a markup canvas to create a sketch using your device’s native markup tools. The sketch is
saved as an image and attached to the Event Details. For more information, see Markup.

All added images appear in a banner along the bottom of the Event Details screen.

608 Chapter 16. IC-Inspector



NEXUS Documentation, Release 6.9.xxxxx.0

16.3.6.3.2 View and Edit Images

Tap any image in the banner on the Event Details screen to view it fullscreen. You can swipe between images and use
markup tools to mark up or edit them.

For more information, see Edit and Markup Images.

16.3.6.3.3 Delete or Share Multimedia Files

When you tap the selection button at the bottom right of the Event Details screen, you can select multiple images
and perform either of the following actions:

• Delete images by tapping the trash can icon.

• Share images (for example, to a message or email, to the Photos app, to a printer, to your file directory,
etc.) by tapping the share icon.

ò Note

On Windows tablets, you can only delete or download the images. Sharing is not supported.

16.3.6.3.3.1 Edit and Markup Images

When you tap an image on the Event Details screen (see Maintain Event Details), the image editing screen opens.
From here, you can view, edit, and mark up images attached to the event.

16.3.6.3.3.2 Using the Image Editor

• Swipe left or right to browse through attached images.

• Rename the image by tapping its name. By default, the image name matches the task it was created from.

• Toggle “Can Report” to set the Can Report status of an image. This optional flag can be used in report templates
to include only key images.

• Use the toolbar at the top of the screen to:

– Mark up the image (see Markup)

– Rotate (see Rotate)

– Crop and rotate (see Crop and Rotate)

– Share (see Share)

– Delete (see Delete)
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When you’re finished editing, tap Done to save your changes or Cancel to discard them.

16.3.6.3.3.3 Markup

Tap on to open the markup screen. Here, you can draw on the image, add text, shapes, and more.

The available markup tools vary depending on your platform:

• iPad: Use Apple’s standard markup tools to edit your image.

• Android: When you start editing, choose from the installed image editing apps. We strongly recommend using
Google Photos for seamless integration with IC-Inspector. If you don’t have Google Photos, install it from the
Google Play Store.

• Windows: Use Microsoft Paint’s standard markup tools.

For more information on using the markup tools, refer to the platform-specific guidelines.

Below is an example of using markup tools on an iPad:
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16.3.6.3.3.4 Rotate

You can rotate the image right or left by tapping or respectively. This rotates the image in 90° steps.

16.3.6.3.3.5 Crop and Rotate

On Android and Windows platforms, you can crop and rotate images using the markup tool of the platform (see above).

On iPads, you can tap at the top of the screen to access the crop-and-rotate screen.

Use the slider at the bottom of the screen to rotate the image by an arbitrary angle, from 180° anticlockwise to 180°
clockwise. Or tap any of the five buttons below the slider to select specific angles.

ò Note

• Using angles other than -180°, -90°, 0°, 90° or 180° will crop away part of your image.

If required, you can also crop your image.

16.3.6.3.3.6 Share

To share the marked-up image, tap and choose from the available sharing options provided by your platform.

ò Note

On Windows tablets, you can only save the marked-up image.

16.3.6.3.3.7 Delete

Tap to delete this image and return to the Event Details screen (see Maintain Event Details). This is different from
tapping the Event Details button at the top left, which will return you to Event Details without deleting the photo.

16.3.6.4 Set Status

Task statuses in IC-Inspector are either:

• Automatically applied based on user actions, or

• Manually selected by inspectors on the Event Details screen.

16.3.6.4.1 Automatically Applied Statuses

The following statuses are set by IC-Inspector based on specific actions:
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Failed to
Sync

Applied when the task could not be sent to the database server during synchronisation.

In
Progress

Applied under the following conditions:
• The user has started editing the task and updated and saved any field value.
• If the user views an event and navigates back from the Event Detail screen without making any

changes:
– No fields with default values: In Progress status is not applied.
– Default field values present: Fields are auto-populated and In Progress status is applied.

Not
Started

Status is applied when the task has been synchronised to the tablet but no action has been recorded on
it.

• This status appears only as a grouping header in the Status view.
• Tasks with this status do not display a status label in the task list.

Task
Status:
<Custom
Status>

Applied based on custom statuses defined in your NEXUS IC database configuration. In the Status
view, these appear with the prefix “TASK STATUS:” in grouping headers.

Com-
pleted

Applied when the task is marked as complete (see Complete Tasks).

Synchro-
nised

Applied when the task has been successfully sent to the database server after synchronisation.

16.3.6.4.2 Change Status Manually

After completing all required fields on the Event Details screen, you can update the task’s status as follows:

1. Tap the Status button at the top of the screen.

2. Choose an option from the drop-down list.

The available status options depend on your organisation’s configuration in NEXUS IC (see Task Status).

Once updated, the status will be sent to the master database during the next synchronisation. This helps planners track
progress and determine whether tasks need reassignment or further action. The task will continue to appear on your
task list in IC-Inspector until it has been reassigned or marked as Completed.

ò Note

Ad hoc events can only be completed or deleted, they cannot have any other statuses.

16.3.6.4.3 Set Status to Completed

In IC-Inspector, you can mark a task as Completed in one of the following ways:

• By swiping the task’s row on the Tasks screen (see Tasks Screen) and tapping on Mark as Complete:
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• By changing the status of the task on the Event Details screen (see Maintain Event Details).

To set the status to completed, tap Status on the top of the screen and select Mark as Complete. You can get to
the Event Details screen by launching the task as described in Launch Tasks.

Once marked as completed, the task will be uploaded to the server during the next synchronisation (see Sync to IC-
Inspector).

16.3.7 Sync to NEXUS IC
Once you mark your tasks as Completed, you can sync them to the NEXUS IC database using one of the following
methods:

• Two-way sync
Tap Sync in the sidebar. This will upload your completed tasks to the database and download any assigned or ad
hoc tasks to your tablet. For more information about two-way sync, see Sync to IC-Inspector.

• One-way sync
1. Go to the Settings screen.

2. Tap Upload Completed Tasks under SYNC.
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ò Note

One-way sync provides a faster sync process by only uploading your completed tasks.

16.3.8 Settings
On the Settings screen, you can define various settings for the usage of IC-Inspector.

16.3.8.1 Server Settings

Under SERVER, you can control whether you want to use IC-Inspector with demo or real data.

If you would like to try IC-Inspector with demo data, tap the Use demo data switch. Note that using demo data will
erase any local data currently in the app.

If you are planning to use real data, sign in to IC-Inspector. For more information, see Log In to IC-Inspector.

ò Note
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• If you change user credentials, the previous user’s data (for example, tasks, events) will be cleared, and the
new user’s data will be loaded from the server.

• Ensure that the account you use has an IC-Web Read/Write license in NEXUS. If it does not have this license,
you will not be able to synchronise your work back to the server. You get the message “This account has a
readonly license.”

16.3.8.2 Clearing Data

If you tap Clear Data, it erases all the data stored on your mobile device, including any task and event data, photos or
configuration data.

16.3.8.3 General Settings

Under GENERAL, you can customise how certain elements are displayed in IC-Inspector:

• Workpack Display Name
Choose how workpack names appear in the app: by Workpack Name, Abbreviation, or a combination of both.

• Sections Collapsed by Default
Use this toggle to control whether task groupings are collapsed by default. When enabled, task lists under each
header will be collapsed initially; otherwise, all tasks will be expanded.

• Save Captured Photos to Photo Library
Enable this option to automatically save photos taken in the app to your tablet’s photo library.

• Ad Hoc Tasks Colour and Ad Hoc Events Colour
Use these settings to assign colours for distinguishing ad hoc tasks and events in the task list view. By default,
no colour is applied.

16.3.8.4 Sync

Under SYNC, you can manage and monitor data synchronisation between your device and the NEXUS IC database. It
includes the following options:

• Remove Completed Tasks During Sync
Enable this switch to automatically remove tasks from your device that are no longer available (either because
you have completed them or they’ve been removed in NEXUS IC).

• Upload Completed Tasks
Use this option to upload completed task data (events) to the NEXUS IC database. This is a one-way sync: it
sends data to the server but does not retrieve new tasks.

• Send Sync Log to Support
If you encounter sync issues, use this option to send a sync log to NEXUS Support. It becomes available after a
partial or full sync. You can also add comments before sending the log, which is recommended to help Support
understand the issue. Once the log is sent, the option is disabled.

16.3.8.5 App Info

Under APP INFO, click About for the following options:

• View the current app version

• Navigate to IC-Web
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• Access the documentation

• Check for available app updates

16.3. Using IC-Inspector 617



NEXUS Documentation, Release 6.9.xxxxx.0

618 Chapter 16. IC-Inspector



CHAPTER

SEVENTEEN

IC-RECORDER

IC-Recorder is a Digital Video Recorder software application capable of overlaying text onto video as it is recorded.
It can accept video from a variety of sources (USB cameras, SD cameras, HD SDI cameras, etc) depending on the
capture hardware available to the PC. A single IC-Recorder instance captures a single channel of video, but several
IC-Recorder instances can be run on one PC, enabling multi-channel capture on a single PC.

17.1 Communication with IC-Inspection
IC-Recorder is designed to work seamlessly with IC-Inspection to deliver the most efficient offshore campaigns possible
and the software is provided free-of-charge as a companion product to IC-Inspection. Contact us to request a copy.

IC-Recorder can be used as a standalone application but it works best in conjunction with IC-Inspection.

A connection to IC-Inspection is necessary for the following functionality:

• Synchronise stop/start recording across multiple video channels.

• Display survey and asset data on overlays.

• Capture images from IC-Inspection.

17.2 Prerequisites
Before you start using IC-Recorder, you must:

• Make the necessary installations (see Deployment)

• Set up a project location where video files will be stored and make other configurations as per your requirements
(see Configuration)

• If you’re using IC-Recorder together with IC-Inspection, set up IC-Recorder as a device in IC-Inspection (see
Add Video Devices)

17.3 Using IC-Recorder
For information about how you can use IC-Recorder, see Using IC-Recorder.

ã See also
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• Deployment

• Configuration

• IC-Recorder Screen

• Using IC-Recorder

• IC-Inspection

17.3.1 Deployment
IC-Recorder is a single-channel recording application. However, it is designed to allow several copies to run smoothly
on one or more PCs for multi-channel recording scenarios.

When deploying IC-Recorder, you have two options:

• Deploy the software on existing DVR hardware.

• Obtain dedicated hardware specifically for video recording.

The type of hardware you require depends on the number of channels to be recorded and the required video resolution
and frame rate (SD or HD). Use the information provided below to guide your selection.

For more information about offshore deployment of IC-Recorder together with IC-Inspection and NEXUS IC, see
Offshore Deployment.

. Warning

Disable “Automatically adjust clock for Daylight Saving Time” on DVR computers. IC-Recorder peri-
odically syncs time with IC-Inspection but dead-reckons between updates. Sudden clock adjustments
during operations can lead to issues. We strongly recommend that you avoid daylight saving adjust-
ments.

17.3.1.1 PC-based Video Capture Devices

IC-Recorder supports a variety of video capture hardware, both internal and external. If a device supports “Direct-
Show,” it is likely to work seamlessly with IC-Recorder. Below are some recommended options:

• Startech S-Video Composite to USB Video Capture Cable (SVID2USB23) (Startech)

– An external USB device suitable for laptops and any machine requiring single-channel recording.

– Captures full analog resolution (720x576 for PAL).

– Devices with a “2861” or “EM2861” chip or chipset are also compatible.

– While not broadcast quality, image degradation happens anyway due to electrical noise and signal attenu-
ation by the time the signal reaches the capture device, so the quality of the capture device becomes less
critical.

– We have encountered challenges when connecting multiple of these USB devices to a single machine, but
using just one device has consistently worked well

• Osprey Analog Series (e.g., 260e and 210e) (Osprey)

– Internal broadcast-quality cards.

– Positive experiences with the 260e and its older sibling. The 100e model is likely suitable as well.
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– For multi-channel recording, consider the 4-channel 460e. Note, however, that there’s a known PCIe bus
issue: Windows infrequently allocates IRQs on the PCIe bus, resulting in frame drops for the 460e. To
address this, navigate to Options → Hardware → Properties → Device, move the slider on the ‘PCIe Bus
Usage’ section (up or down), and click Apply. After next reboot, the problem may recur though.

• Blackmagic DeckLink Cards (Blackmagic)

Blackmagic offers suitable cards, but they may be more finicky to set up than Osprey devices and are
less heavily tested with IC-Recorder.

• Osprey HD Devices
For HD capture, Osprey provides both USB 3.0 devices (USB 3.0 devices) and internal cards (internal cards).

ò Note

If you need to edit recording profiles, install Windows Media Encoder (Windows Media Encoder) and copy
its WmProEdt.exe (usually located under C:\Program Files (x86)\Windows Media Components\Encoder) to IC-
Recorder’s Profiles folder (usually located under C:\Users\Public\Documents\IC-Recorder\Profiles).

17.3.1.1.1 Computing power

When using these video devices, the processing power of your PC plays a crucial role as video is converted into WMV
format by the PC’s own CPU. Thus, the CPU needs to be powerful enough to do the conversion work. Consider the
following:

• For a single channel of HD video at 1080p25, your CPU should have a multi-CPU score of approximately 11,000
on Geekbench. If you’re dealing with two channels, aim for twice that score (around 22,000). Doubling the frame
rate (e.g., 1080p50) doubles the CPU requirements. An SD channel (with about one-fifth the pixels of 1080p25)
needs roughly one-fifth the CPU power.

• If you’re buying an Intel CPU, consider an LGA 2066 socket paired with an X299 chipset (as of 2018). The
number of PCIe lanes required depends on the number of hard disks connected to the motherboard NVMe con-
nectors. If you’re using only one NVMe port, a 28-lane CPU should suffice. For multiple NVMe SSDs, more
lanes may be advisable. Check your motherboard documentation to understand which PCIe card slots will be
activated under different circumstances (often expressed as “×16/×0/×8/×0” or “×8/×0/×8/×8”). Keep in mind
that as of 2018, AMD CPUs may offer better performance per dollar compared to Intel.

• Regarding capture cards, an Osprey 460e-equipped modern PC can handle recording up to 4 channels of SD
video. For the Osprey 825e, expect it to handle 2 channels of HD video.

17.3.1.1.2 Hardware

When choosing PC hardware for video processing, consider the following factors:

• Ensure that your hardware provides an adequate number of PCIe lanes. These lanes are essential for various
components, including capture cards, optional graphics cards, and RAID controllers. Keep in mind that SATA,
M.2 drives, and other peripherals also consume PCIe lanes. After selecting a CPU, consult the motherboard
documentation. If the CPU has a limited number of lanes (e.g., less than 44), not all PCIe slots may be active or
may operate at reduced physical width.

• As of 2019, we recommend the X299 chipset as a suitable choice for video processing. High-end graphics
cards are unnecessary; focus on how many monitors the graphics card can support simultaneously (referred to
as “heads”). Some cards have more output connectors than they can drive concurrently. Consider the i7-7800X
CPU for your setup.
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• Avoid using RAID directly on the encoding machines. RAID introduces potential failure points and complicates
troubleshooting. Instead, transfer video data off the encoding machines and onto a redundant storage system like
a NAS.

• If you’re using SSDs, ensure that their sustained write speed can handle the maximum video capture rate. Record-
ing multiple HD channels may exceed the sustained write capabilities of certain SSDs. Mitigate this by installing
several SSDs and distributing different channels across them. Spinning hard disks are also a viable option for
video storage. Consider using a small SSD for the operating system, plus a hard disk for the video data.

17.3.1.2 Non-PC based Video Capture Devices

IC-Recorder also supports the Marshall VS-103E-3GSDI encoder (Marshall VS-103E-3GSDI encoder). The Marshall
encoder handles digital video conversion using its own hardware, bypassing the PC or laptop’s CPU. Although its
text overlay capabilities are slightly less robust, they remain perfectly adequate. This device captures either standard-
definition composite analog video or HD digital video via SDI or HDMI (though not both simultaneously). When
controlled by IC-Recorder, the Marshall Encoder records exclusively to AVI format.

17.3.1.2.1 Computing power

The Marshall device digitises and encodes video, significantly reducing the load on the PC or laptop. The PC’s primary
role becomes simple video decoding for viewing the video stream. In general terms, a single PC can control and preview
up to 4 channels of video from 4 encoders.

17.3.1.2.2 Hardware

Whenever possible, use a Power over Ethernet (PoE)-capable Ethernet switch for your Marshall encoders. This elimi-
nates the need for separate wall-wart power bricks for each unit. As long as the switch receives good-quality power, it
minimizes power-related issues.

Remember that the limitations of SSD write speed described earlier also apply in this context.

17.3.1.2.3 Preview

When using a Marshall encoder in IC-Recorder, you can preview video complete with overlay. However, under certain
circumstances, this preview may stutter or skip. It’s important to note that this preview is separate from the recorded
stream. Skipping during preview does not imply skipping in the final recorded video. To verify the actual recorded
content, play back the recorded video.

If you want an accurate video reference, use VLC Player and connect to the following URL: rtsp://<IP ad-
dress>/video1_audio1. Alternatively, connect a monitor directly to the Marshall encoder’s HDMI Out port. Keep
in mind that HDMI Out only provides pass-through video without text overlay.

17.3.1.3 Storage & Redundancy

IC-Recorder stores video in the location that you have configured. Ensure sufficient storage space for the recorded video.
Implement robust security measures and backup strategies for video data. Note that there are no inherent archiving or
backup routines within IC-Recorder. We recommend using network-based archiving utilities or PowerShell scripts to
manage video data effectively.

Always prioritize hardware redundancy to ensure uninterrupted operation in case of hardware failures.

17.3.2 Configuration
Before you start using IC-Recorder, you must make a number of configurations:

• You make generic configurations for video recording and image capture under the Tools → Options menu option
in IC-Recorder. For more information, see Configuration Options.
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• You set up text overlays to be displayed on the videos. For more information, see Set Up Text Overlays.

17.3.2.1 Configuration Options

To make generic configurations for video recording and image capture, navigate to the Tools → Options menu option
in IC-Recorder. This launches the Options dialog, where you can make settings on various tabs as described below.

17.3.2.1.1 Hardware

On the Hardware tab, you make settings related to the hardware used during recording.

In the Input field under Source, select one of the following options:

• Video Hardware

• Still Camera

• Marshall Encoder

The available fields on the tab depend on your selection in this field. See below for detailed information about each.

17.3.2.1.1.1 Video Hardware

Video Hardware can be any device that implements Microsoft’s DirectShow interface. This includes nearly every
video capture card, sound card, or USB capture device. A video hardware device begins recording when an inspection
is started.

If you choose Video Hardware from the Input field, you can make settings in the following fields:

Field/Checkbox
Name

Description

Select
Devices -
Video

Select the device that you use for video capture. If you are running several IC-Recorders,
you should choose a different video capture device for each. In general, you can’t use
one video capture device twice.
Click the Properties button to make settings specific for the device. This opens a dialog
provided by the hardware driver. Note that this dialog is not designed by us, and its
appearance will vary based on your specific capture device. In some cases, certain device
drivers may not offer a Properties dialog at all, resulting in no action when clicking.

Select
Devices -
Audio

Optionally, select the device that you use for audio capture. For the primary video chan-
nel, it’s advisable to record audio. However, for other channels, you can consider not
recording audio to prevent echo during multi-channel playback caused by slight syn-
chronization differences. When in doubt, prioritize recording audio on the main video
channel.
Click the Properties button to make settings specific for the device. This opens a dialog
provided by the hardware driver. Note that this dialog is not designed by us, and its
appearance will vary based on your specific capture device. In some cases, certain device
drivers may not offer a Properties dialog at all, resulting in no action when clicking.

Video Pre-
view - Type

This option controls certain behaviours of the underlying Windows Media encoder. Its
default setting, labelled as “Software - Most CPU for compression/Some CPU for Pre-
view,” is suitable for most scenarios. With this configuration, if your CPU lacks sufficient
power, the preview may appear jerky, displaying only a few frames per second. However,
the recorded video will still be smooth. If you encounter jerky preview, consider record-
ing a test video with substantial movement and then play it back using Windows Media
Player or another tool to assess its smoothness. Even if you experience no preview at
all, perform a test recording and playback, as there are cases where the Windows Media
encoder fails to deliver a preview but still records flawlessly.
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17.3.2.1.1.2 Still Camera

Still Camera mode allows IC-Recorder to treat the camera device as a snapshot-taking device, rather than a video
recorder. This means that if you start an inspection in IC-Inspection, the device will not begin recording immediately.

If you choose Still Camera from the Input field, you can select the relevant device from the Camera field. Click the
Properties button to make settings specific for the device. This opens a dialog provided by the hardware driver. Note
that this dialog is not designed by us, and its appearance will vary based on your specific capture device. In some cases,
certain device drivers may not offer a Properties dialog at all, resulting in no action when clicking.

17.3.2.1.1.3 Marshall Encoder

The Marshall VS-103E Encoder is an external hardware device that takes a single video signal, converts it into a digital
stream, and transmits it to IC-Recorder over an Ethernet connection. IC-Recorder then saves this stream to disk as a
file. The key advantage of this setup is that it minimises CPU overhead on the computer running IC-Recorder, as most
of the processing is handled by the Marshall Encoder. Additionally, the Marshall Encoder can overlay text onto the
video feed under the direction of IC-Recorder.

If you choose Marshall Encoder from the Input field, you can set up Marshall Encoder as follows:

Field/Checkbox
Name

Description

IP Address Specify the IP address of the Marshall Encoder.
Username Enter the username that you set up in your Marshall Encoder.
Password Enter the password that you set up in your Marshall Encoder.
Use Au-
thentica-
tion

Enable this option to allow authentication.

Channel Set the value to 1.

The remaining fields on this tab are informational only.

Once you’ve made these adjustments, clicking OK displays a preview of the video feed from the Marshall Encoder.

17.3.2.1.2 Video Format

The Format tab allows you to configure video format settings. Note that this tab is not relevant if you’ve selected Still
Camera mode on the Hardware tab.

If you’ve selected Marshall Encoder on the Hardware tab, there are no format options because the encoding is
performed by the Marshall Encoder itself, not by IC-Recorder. When controlled by IC-Recorder, Marshall Encoder
video recordings will always be in AVI format.

For system hardware (cards or USB devices directly connected to this PC), there are a variety of video format options
to configure.

Under Video Format, select one of the following options:

• AVI
• WMV

Your choice determines the fields available on this tab. Think of this choice as an “envelope” for digital video. Just like
a paper letter can be placed in different envelopes, digital video can be encoded with various codecs and then wrapped
in different video format “envelopes” (such as AVI or WMV). When a computer plays back a video file, it first handles
the envelope (format), and then processes the video streams within. If you’re certain that the video will only be played
back on Windows computers, WMV is a good choice because all Windows systems have pre-installed WMV support.
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However, support for other formats depends on the operating system version and the installed codecs. Installing a codec
on a specific client computer may require cooperation from corporate IT.

ò Note

Whichever format you choose, during recording, IC-Recorder creates a file with a “.part” extension
(for example, “video.part”). Once recording completes, the “.part” extension is removed, resulting in
a final file (for example, video.wmv or video.avi). Configure backup processes to ignore “.part” files.

17.3.2.1.2.1 AVI

If you choose AVI, make settings as follows:

Field/Checkbox
Name

Description

Video
Input -
Resolution

Shows the default resolution of the video. If you click Change next to this field, you
can configure “Capture Pin Properties”. The term “Capture Pin” is specific to Win-
dows Media and refers to a concept related to video capture. The options available for
modification here may be restricted by the codec you are using. If possible, ensure that
the device resolution and frame rate match the actual input from the device. Note that
“Capture Pin Properties” is quite technical, and in most cases, you won’t need to adjust
or delve into these settings.

AVI Set-
tings -
Codec

For video files to be playable on a specific client computer, an appropriate codec must
be installed on that machine. Therefore, selecting a widely supported codec is crucial.
Next to the Codec field, you’ll find an Advanced button. Clicking this button reveals the
configuration dialog provided by the codec. Note that the appearance and functionality
of this dialog will vary depending on the specific codec, and some codecs may not offer
a configuration dialog at all.

Audio Under Audio, you can find a number of fields that allow you to make settings for cap-
turing audio during video recording.

17.3.2.1.2.2 WMV

If you choose WMV, make settings as follows:
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Field/Checkbox
Name

Description

Video
Input -
Resolution

Shows the default resolution of the video. If you click Change next to this field, you
can configure “Capture Pin Properties”. The term “Capture Pin” is specific to Windows
Media and refers to a concept related to video capture.

WMV Set-
tings

You must select a profile, which defines encoding settings, including resolution, frame
rate, and quality.
Ensure that the incoming video resolution and frame rate match those specified in the
chosen profile. If they match, a green message confirms the validity; if not, a red message
indicates an invalid configuration. Adjust either the incoming resolution or the profile
settings to achieve a match. Note that if the resolution does not match, you will not be
able to record.
IC-Recorder is shipped with a predefined set of profiles. Profiles are stored in the
Profiles folder (usually located at C:UsersPublicDocumentsIC-RecorderProfiles). If
you’ve installed Windows Media Encoder and copied WmProEdt.exe ((usually found
in C:\Program Files (x86)\Windows Media Components\Encoder) to the Profiles folder,
you can edit settings within a profile using the Edit button.
You can also use the Open Folder button to access the Profiles folder conveniently,
making it easier to copy profiles into the designated location.

Video Standards
See below for information about supported video standards:

• Standard Definition (SD) Video:

– NTSC video operates at 60 interlaced fields (equivalent to 30 full frames) or 59.94 fields (approximately
29.97 frames) per second. Its vertical resolution is around 486 lines.

– PAL video runs at 50 interlaced fields (25 full frames) per second, with a vertical resolution of 576 lines.

– Analogue video lacks a fixed number of horizontal pixels, but common values during conversion to digital
include 768, 720, and 704.

– NTSC and PAL encode colour differently, so if you choose the wrong format, you may get black and white
video.

• High Definition (HD) Video:

– HD video has a minimum height of 720 pixels, with 1080 pixels being the most common resolution. The
aspect ratio is typically 16:9 (e.g., 1280x720 or 1920x1080).

– HD video can be either interlaced (“i”) or progressive (“p”).

– Common frame rates include 25, 29.97, 30, 50, 59.94, or 60 fields per second. For instance, “1080p25”
refers to a 1920x1080 pixel image delivered 25 times per second, while “1080i50” delivers 50 interlaced
fields per second (equivalent to one full frame). So when using progressive video, it is fine for the final
number to be half the size. Progressive video is generally preferred over interlaced video due to easier
encoding and avoidance of artefacts like “combing.”

SD video is typically delivered as analogue video, often using composite connections. HD video is commonly trans-
mitted via SDI (Serial Digital Interface), a digital format. That is, SD usually isn’t SDI. SDI intentionally uses the same
cable types and connectors as analogue video, allowing TV studios to reuse existing infrastructure. However, mixing
digital and analogue signals (for example, feeding a digital signal into an analogue capture device) will not result in
successful video capture.
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17.3.2.1.3 Project Location

On the Project tab, you specify the location of the created video files as well as the camera name as follows:

Field/Checkbox
Name

Description

Project Lo-
cation

Determines where IC-Recorder saves video files as they are created. It’s recommended
to record video to a local drive rather than a network drive to avoid issues related to
bandwidth, latency, and dropouts.
The path that you set up here will be the generic recording folder. In NEXUS IC, you
can also set up relative asset-specific recording subfolders, if necessary. For more infor-
mation, see Specify Project Path for Recording.
If you’re running multiple IC-Recorders, you can specify the same recording folder for
all IC-Recorders, in which case each recorder will have a different camera name to dis-
tinguish files. Alternatively, you can assign a different folder for each recorder (for ex-
ample, “C:\Video\Port\”, “C:\Video\Centre\”). Note that if two copies of IC-Recorder
attempt to record the same filename at the same time (for example, “C:\Video\2018-01-
01 120000 Digital Video.wmv”), one of them will fail.

Camera Specifies the name that will be used in video files. It’s a free-text field with some presets
available. Note that if your IC-Recorder is controlled by IC-Inspection (which is the
common use case), file names are determined by IC-Inspection. Therefore, configure the
camera name in IC-Inspection, not here. For more information, see Add Video Devices.

17.3.2.1.4 Recording

The Recording tab allows you to configure various settings related to recording:

Field/Checkbox
Name

Description

Recording
Settings

Allows you to select whether to include the video count in the video filename.

Filename
Offset

You can select to automatically calculate the recording start time and include it in the
filename.

Hard Disk
Space

Allows you to set thresholds for when the system should trigger a warning or stop record-
ing based on available disk space. By default, a warning triggers when there are 500 MB
remaining, and recording stops when only 100 MB are left.

Borderless When enabled, IC-Recorder hides its border, toolbars, etc., when you start recording.
This can be useful if you want to maximise the amount of monitor space devoted to
video. To revert, right-click the video area and deselect Borderless Mode in the pop-up
menu or double-click within the video area.

Record
Limits

Allows you to reduce the video to manageable “chunks” based on time or file size. For
example, if you want files to stay below 2GB (to fit FAT32 file size limits), specify a
time limit that ensures files remain within this size. Alternatively, use a File Size Limit.
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17.3.2.1.5 Remote Access

On the Remote tab, you can specify settings for remote access of your recording device.

Field/Checkbox
Name

Description

Remote
Access

You can specify a port to listen on (the default port is 4500).

Time Sync Allows you to enable IC-Recorder to synchronise its time with IC-Inspection when con-
nected.

17.3.2.1.6 Advanced

On the Advanced tab, you can make some advanced configurations for IC-Recorder.

Field/Checkbox
Name

Description

Show
Over-
lay Text
Shadow

When enabled, this feature adds a white border around dark text or a black border around
light text in your overlay. This enhances text legibility when the underlying video colour
is similar to the text colour. Note that enabling this option consumes slightly more CPU
power. If your CPU usage is near 100% during recording, consider disabling this option.

JPEG
Quality

This percentage value determines the image quality of JPEGs captured by IC-Recorder.
Even if you manually capture a frame in IC-Recorder, it will always be in JPG format,
regardless of the file type specified in IC-Inspection’s frame capture settings.

Logging You can set the logging level for debugging purposes. The higher the level, the more
verbose the logging becomes. As a general practice, leave the logging level setting at its
default unless directed otherwise by technical support. While more verbose logging can
provide detailed information helpful for identifying and resolving bugs, overly verbose
logging may slow down the system.

17.3.2.2 Set Up Text Overlays

If you use IC-Recorder to record video with text overlays, you have two options for configuring the text overlays:

• Configuration in IC-Inspection:

You can set up text overlays in IC-Inspection by using the Text Overlays button on the Devices pane.

If you’re using IC-Recorder alongside IC-Inspection, we highly recommend setting up text overlays within IC-
Inspection. This ensures consistency when using multiple recorders since you can use the same overlay on each
recorder (except for channel name). When you configure the overlay in IC-Inspection, you only need to do it
once, and the settings will be applied to all connected recorders. If IC-Recorder is currently disconnected, it will
receive the configuration upon reconnection.

• Configuration in IC-Recorder:

You can also set up text overlays in IC-Recorder using the Edit Overlays button from the main toolbar.

We recommend using this option only if you’re using IC-Recorder as a standalone device. If you use IC-Recorder
alongside IC-Inspection, make the configurations in IC-Inspection to maintain uniformity across recorders.
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17.3.2.2.1 Create a New Overlay

1. Start creating a new overlay in either of the following ways:

• In IC-Inspection, choose Text Overlays from the toolbar of the Devices pane.

• In IC-Recorder, choose Edit Overlays from the mail toolbar.

2. In the Edit Overlays dialog, choose Add.

3. In the Edit Overlay dialog, specify a name for the new overlay on the top of the Configuration screen area.
Here you can also select a background colour for designing the text overlay. By default, the colour is black.

� Tip

Drag the window larger to make the black overlay region larger. It doesn’t need to match the actual
size of your video feed, but it’s convenient for you if you drag it to approximately the same shape.

4. On the left-hand side of the screen, under the Available Regions section, ensure that you have all the fields that
you want to include in your text overlay.

• In IC-Inspection, you can add additional asset information fields by choosing the Asset Information Fields
button on the top of the screen. Besides asset information, you can also see database fields, device infor-
mation, survey fields, as well as static text or image elements that you can include. If a survey field you
want is not shown in the list, ensure that the appropriate survey field is configured and has a value.

• In IC-Recorder, you can see device information fields and static text or image elements that can be retrieved
directly from IC-Recorder. Survey fields, database fields and asset information fields are all retrieved from
IC-Inspection. You cannot add new asset information fields in IC-Recorder. If you want to add a new field,
you have to do it in IC-Inspection.

5. Drag fields from the tree on the left onto the overlay layout region. Move them to the position where you want
to see the fields on the recorded video screen.

Any fields that you have dragged to the overlay layout region will appear in the list under the Regions section at
the bottom of the screen.

6. Customise the appearance of the fields.

When add your first field, you may want to customise it (colour, font, size, etc.), because additional fields you
add will inherit their settings from the previous field.

Once fields are on the overlay, you can configure them as follows:

• Selection: You can select fields by clicking them on the overlay or selecting them from the grid under
Regions.
You can also multiselect fields as follows:

– On the overlay, you can “lasso” several fields by click-dragging a box around them or use the Ctrl key
to select fields one after the other.

– In the grid, you can use the Ctrl key or Shift key to select multiple rows.

• Toolbar Buttons: You can use the toolbar buttons at the top of the Regions screen area to perform actions
on selected fields. You can nudge them, align them, change their font size, or delete them.

• In-grid editing: You can adjust settings specific to individual fields by double-clicking in the cell for the
required field and parameter. You can make the following settings:

– Specify a text for static texts and images

– Add a prefix or suffix text, for example, a short prefix “E: “ for Easting, etc.
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– Define offset values for field placement (percentage from the top and left side of the captured screen).

– Specify font type, font size and font colour for the texts. Note that a 10-point font on a 576-pixel high
SD video will fill about 1/57th of the height of the image, which may be suitable, however, it would be
too small on a 1080-pixel high HD feed.

– Select a background colour for the field. By default, no background colour is applied (transparent).
This conceals less of the video, but may be less clear on certain video colours. Consider enabling the
Show Overlay Text Shadow option under Tools → Options → Advanced (see Advanced) for better
legibility with transparent-background fields. This option consumes additional CPU power, so if your
CPU is near 100% during recording, disable this option.

If you add an “Image” region, a file dialog will appear immediately. If you choose a .PNG file, its transparency
will be honoured. If the PNG has partial or full transparency, you’ll see the video through the image. You can
add multiple image regions if needed.

ò Note

If you’re using a Marshall Encoder rather than a system hardware, some overlay configuration options are
ignored because the Marshall Encoder does not support them. Text, prefix, suffix, source, top, left, font size,
and font color are supported, but font choice (for example, Courier, Arial) is not. Additionally, the Marshall
Encoder supports a maximum of 16 overlaid fields.

7. Choose OK to save your changes and exit the dialog or Apply to save your changes and keep the dialog open.

After confirming your settings and closing the chain of dialogs, you’ll see real-time updates of survey values on
your recorders.

17.3.2.2.2 Edit Overlays

You can edit overlays only within the application where they were originally created. That is, in IC-Inspection, you can
edit overlays created in IC-Inspection, in IC-Recorder, you can only edit overlays created in IC-Recorder.

1. Start editing an overlay in either of the following ways:

• In IC-Inspection, choose Text Overlays from the toolbar of the Devices pane.

• In IC-Recorder, choose Edit Overlays from the mail toolbar.

2. In the Edit Overlays dialog, choose Edit.
3. Make your changes as required. For more information about the configuration options, see ic-

inspection.devices.text_overlay.create above.

4. Choose OK to save your changes and exit the dialog or Apply to save your changes and keep the dialog open.

17.3.3 IC-Recorder Screen
The IC-Recorder screen is made up of the following main elements:

17.3.3.1 Main Menu

From the main menu of IC-Recorder, you can access the following options:
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Menu Option Description
File → Change
Project Location

Allows you to change the folder where the recorded video files are stored. You
specify the default location under Tools → Options → Project. If you want to
change this location for a specific recording before starting the inspection, you can
go to File → Change Project Location and select the folder from the file explorer
window.

File → Open
Project Location

Launches the file explorer where you can view the folder where the recorded video
files are stored.

File → Open
Video

Allows you to select a video file from the file explorer and play it in IC-Recorder.

File →
Show/Hide
Status Bar

Shows or hides the status bar from the bottom of the IC-Recorder screen.

File → Exit Closes the IC-Recorder application.
View → Captured
Videos

Select to display or deselect to hide the Captured Videos pane on the IC-Recorder
screen.

View → Captured
Images

Select to display or deselect to hide the Captured Images pane on the IC-Recorder
screen.

View → Border-
less

If you select this option, IC-Recorder will hide its border, toolbars, and other el-
ements when you start recording (either by clicking the Record button or by ini-
tiating an inspection in IC-Inspection). This feature can be useful if you want to
maximize the monitor space dedicated to video. To revert to the default view,
simply right-click on the video area and deselect ‘Borderless Mode’ in the context
menu, or double-click within the video area.

View → Log File Allows you to open the trace log file, which shows a technical log of changes made
in the current session. This can be useful for debugging purposes.

Tools → Options Allows you to set up and customise IC-Recorder as per your requirements. For
more information see Configuration.

Help You can access the online help documentation, the official NEXUS website, or
contact support from this menu option.

17.3.3.2 Panes

There are three main panes available on the screen of IC-Recorder:

• Captured Video pane: Shows all the video files that have been recorded in the current session. From this pane,
you can play these videos or open the file location where they are stored.

• Main recording pane: Allows you to view and manage the video files that are recorded by IC-Recorder.

• Captured Images pane: Shows all the images that have been captured in the current session. From this pane,
you can launch these image files in the default image viewer or open the file location where they are stored.

17.3.3.3 Main Toolbar

The toolbar on the main recording pane contains the following options:
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Menu Option Description
Record Starts recording video directly from IC-Recorder.

ò Note

Use this option only if you use IC-Recorder as a standalone application. If you
use IC-Recorder together with IC-Inspection, we recommend that you start
video recording by initiating an inspection from within IC-Inspection. This
will trigger video recording in IC-Recorder.

Stop Stops the recording of video.

ò Note

Use this option only if you started video recording from IC-Recorder. If you
started recording from IC-Inspection, stop the inspection within IC-Inspection,
which stops video recording in IC-Recorder as well.

Frame Captures an instant image of what you can currently see in the recording pane.
Overlay Allows you to select the text overlay option to be applied for the current video.

These available text overlays are set up either in IC-Inspection (see Set Up Text
Overlays) or in IC-Recorder (see Set Up Text Overlays).

Refresh Allows you to refresh the video stream or image in the current pane.
Edit Overlays Allows you to configure text overlays. For more information, see Set Up Text Over-

lays.
Time Source If set to System Time, the date and time field visible to the right of this button

shows the current time according to this PC’s clock. If set to IC-Inspection Time,
it shows time from IC-Inspection.

ROV If you use multiple ROVs during inspection, you can select the ROV from this
menu to display the relevant video channel.

17.3.3.4 Status Bar

The status bar at the bottom of the IC-Recorder screen shows the following:

• Whether IC-Inspection is connected

• The port that you are connected to

• The status of video recording

• The path to the project location folder where the recorded videos will be stored. You can click this path to open
the folder or change the project location.

• The resolution of the video

• The available HD space

• Software Version

You can hide the status bar from the View menu option.

17.3.4 Using IC-Recorder
In IC-Recorder, you can perform the following activities:

• Record videos (see Record Video)

• Capture images (see Capture Images)
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17.3.4.1 Record Video

The main function of IC-Recorder is recording video during an inspection campaign.

When you launch IC-Recorder, if the default TCP port (4500) is unavailable, IC-Recorder will sequentially ‘probe’
higher port numbers (such as 4501, 4502, and so on) to find an available port. This allows you to run multiple instances
of IC-Recorder, each using a different port. IC-Recorder loads a settings file based on the discovered port number,
enabling using different capture hardware and output recording folders for each IC-Recorder.

The typical scenario involves having several capture devices on a single PC or a multi-channel capture device. In such
cases, you can run multiple copies of IC-Recorder on that PC. For instance, in the first IC-Recorder instance, select the
first capture device (or the initial channel on your multi-channel device), and repeat this process for additional instances.

17.3.4.1.1 Prerequisites

To be able to record video, you must ensure the following:

• You have set up a project location where video files will be stored and made other configurations as required.
For more information, see Configuration.

• If you’re using IC-Recorder together with IC-Inspection, you must have set up IC-Recorder as a device in IC-
Inspection. For more information, see Add Video Devices.

17.3.4.1.2 Video Recording

1. Start video recording in one of the following ways:

• If you’re using IC-Recorder as a standalone device, simply click the Record toolbar button in the main
recording pane of IC-Recorder.

• If you’re using IC-Recorder alongside IC-Inspection, initiate an inspection in IC-Inspection by clicking
Start. This action will automatically trigger IC-Recorder to start video recording.

ò Note

If you use IC-Recorder with IC-Inspection, we strongly recommend that you start video recording by starting
the inspection in IC-Inspection. This not only initiates video recording but also begins survey data logging.

2. During video recording, you can see the video in the main recording pane of IC-Recording and perform video
commentary, capture images or create events in IC-Inspection as required. For more information, see Online
Inspection.

3. When you’ve completed online data capture, stop the recording in either of the following ways:

• If you’ve started video recording directly in IC-Recorder, click the Stop toolbar button in the main recording
pane of IC-Recorder.

• If you’ve started video recording by initiating an inspection from IC-Inspection, click Stop from the main
toolbar of the IC-Inspection screen to stop the inspection. This action will automatically stop the recording
in IC-Recorder.

4. Once you’ve stopped video recording, the recorded video file will be stored under the project location that you’ve
configured. You can also see the captured video file in the Captured Video pane of IC-Recorder.

When IC-Inspection communicates with IC-Recorder, it sends the timestamp, which IC-Recorder uses to create
a filename for the recording. Throughout the recording process, this filename remains in use. After recording
completes, IC-Recorder checks for any time discrepancy between when it generated the video file and actual
recording starting. If a difference exists, IC-Recorder adjusts the filename accordingly — usually by just one
second, depending on machine load.
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³ Caution

During an inspection campaign, if Windows automatically switches to daylight saving time, it can potentially
lead to confusingly named video files. For example, at the beginning of daylight saving in spring, your video
recordings may appear to have a one-hour gap when, in reality, there was none. This discrepancy occurs
because your PC clocks have moved forward by one hour. Similarly, during autumn/fall, video files might
seem to be recorded at the same time as videos actually recorded an hour earlier. This happens because clocks
have fallen back by an hour.

For this reason, we recommend disabling automatic daylight saving adjustment on PCs running IC-Inspection
or IC-Recorder. This also applies to any third-party systems that supply time via a survey string. Set your
timezone at the start of any inspection campaign and remain consistent throughout.

17.3.4.2 Capture Images

You can capture a snapshot from a video at any time during video recording.

You can capture images during video recording in the following ways:

• In IC-recorder, you can click the Frame toolbar button in the main recording pane. The captured image file will
be stored under the same project location that you’ve configured for video files. You can also see the captured
images in the Captured Images pane of IC-Recorder.

• In IC-Inspection, you can capture an image when you’re creating an event in the Active Events pane of IC-
Inspection. For more information, see Attach Multimedia to Event.
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EIGHTEEN

IC-WEB

18.1 Technical Specifics
Due to the technical differences between IC-Web and NEXUS IC, some features work differently and are specific to
IC-Web.

These differences are listed below:

• After 1 hour of inactivity, your IC-Web session will automatically log you out. Additionally, if there is 10 minutes
(by default) of inactivity across the entire web server, you will also be logged out. If this occurs, the next time
you attempt to click on a new item or access non-cached information using IC-Web, you will receive a message
indicating that you have been logged out and will be redirected to the login page.

• A variety of tabs, panels, and pop-ups will briefly display a ‘Loading’ indicator when selected.

• A variety of forms (for example, Asset Information Groups) in NEXUS IC allow in-place editing. In IC-Web,
you will instead see an Edit button, which will pop up a modal form for you to do the editing in. This ensures
that when you complete editing, IC-Web can immediately commit your changes to the REST service.

• In some areas, when creating or editing a new item, IC-Web will implement the changes but the changes will not
immediately become visible. A banner proposing a refresh will appear and allow the user to refresh the page via
hyperlink.

• When another user changes data, NEXUS IC will automatically prompt you to refresh the information on your
screen with the latest version. IC-Web, however, does not automatically detect that the current on-screen data is
outdated. To ensure you have the most up-to-date information, re-select an item in IC-Web (that is, select another
item and then return to the previous item).

• Reports and imports in IC-Web (a SaaS-only feature) create jobs that are processed on the server. Any import or
report you generate during your session will be available from the notification bar that appears at the bottom of
the screen. However, once this bar is dismissed, you will no longer be able to access the results through IC-Web.
Note that reports set to be emailed will still be sent upon successful completion of the job, regardless of whether
the notification bar is dismissed.

18.2 User Interface Features
Even though the user interface (UI) of IC-Web is similar to that of NEXUS IC, there are some differences to consider.
Refer to the documentation below for information about these differences and some UI features specific to IC-Web.

18.2.1 Basic Differences
• IC-Web pop-up “windows” are not actual windows, and cannot be moved outside the bounds of the web browser.

• On the ASSETS screen, the options for adding, editing, and removing assets are slightly limited. There is no
option to add a linked asset (with children) or to edit asset type properties.
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• IC-Web displays version information at the top right instead of the bottom right. Other NEXUS IC status bar
fields are not applicable to IC-Web and are not shown.

• Some data entry controls, such as date/time pickers, will look and work slightly differently in IC-Web.

• Shortcuts cannot be manually run from IC-Web, so the Shortcuts toolbar button is not available in IC-Web.

• The History button on forms is not available.

• The Connections toolbar button is not available.

• The Forward and Backward toolbar buttons on the Asset Information tab of the ASSETS and INSPECTION
screen are not available.

• Unlike in NEXUS IC, the location of panes on the screen cannot be changed (except for the Event Details pane
on the INSPECTION screen), but they can be resized.

• On the Children tab, the full location of assets is displayed, as opposed to the relative location shown in NEXUS
IC.

• When you generate a report or import in IC-Web, a notification bar appears at the bottom of the screen showing
the job details. Note, however, that if you reload the page, this bar will disappear. You can check all the basic
job details though from the IC-Web → Jobs menu option.

18.2.2 Main Menu
The available options under the main menu of IC-Web are different as compared to NEXUS-IC. For IC-Web, you can
perform the following actions from the IC-Web menu:

• Under the Your Profile. . . option, you can view or change your own user account details or specify your favourite
reports similarly to the Database → Your Profile. . . option in NEXUS IC (see Your Profile). Note that the
Settings tab is not available in IC-Web.

• You can view your job details or dismiss them from the Jobs menu option.

• Under Date and Time Format Options, you can change the date and time settings.

• Under Reset All Local Settings, you can reset all your local user settings including the currently selected view,
selected rows, expanded trees, open tabs, and reset them to default.

• You can log out of the IC-Web session using the Logout option.

Additionally, you can access the online help documentation or information about IC-Web from the Help menu.

18.2.3 Grid Pagination
IC-Web paginates grids across multiple pages when there are a large number of rows.

By default, IC-Web grids display 100 rows per page. If the grid contains more rows, they will be spread across multiple
pages. The pagination UI element includes Previous and Next buttons, as well as options to navigate to the first and
last pages.
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ò Note

The pagination functionality refers to the new type of grid format. Since grid styles are being changed
over from the previous format, IC-Web grid pagination will not apply to all grids in IC-Web.

18.2.4 Multiple Column Sorting
IC-Web grids can be sorted by multiple columns at once. Sorting the grid is performed by clicking a column header
and toggling between ascending (arrow up) and descending (arrow down). Grids can be sorted by multiple columns
by selecting an initial column, followed by holding down the CTRL key and selecting a second column. This will sort
the grid by the first column, then sort by the second column.

The grid sorting should persist locally and can be cleared via the customise > reset to default option.

18.2.5 INSPECTION Screen Layout
You can view the INSPECTION screen in IC-Web using the following two layouts:

• Default view: Contains the Events Details pane in the middle.

• Alternate view: Contains the Events Details pane on the right.

You can choose the layout from the drop-down menu of the Layout toolbar button on the INSPECTION screen.
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18.3 Importing and Exporting in IC-Web
The import and export functionality in IC-Web is similar to that of NEXUS IC (see Import and Export).

However, some features may work differently in IC-Web:

18.3.1 Importing
• Importing using IC-Web is only available for Wood-hosted clients and the logged-in user will require an IC-Web

Read/Write license to perform imports.

• IC-Web does not support Excel file formatted import sheets. You will need to convert your import file to csv /
tsv / txt. If your import includes external files (for example, event multimedia files or library items), then you
must zip your import sheet and files first. When you choose the zip file, the IC-Web Import Wizard will extract
the contents, and confirm the contents with you before proceeding.

• When attempting to upload a zip file larger than 500MB, you will receive a warning that it may fail.

18.3.2 Exporting
• In IC-Web, exporting only provides a summary export. If you have multiple pages in the grid, it will only export

items from the currently selected page.

• IC-Web editing grids support exporting to CSV with grouping enabled. Editing grids are any grid that appears
after clicking add or edit on a row. In these grids, export to email is not available.

18.4 Searching in IC-Web
In IC-Web, the Search box is located above the asset tree (as opposed to the top right in NEXUS IC). This search
function searches only asset names (see Searching in Different Solutions).

18.4.1 Grid Search
Some IC-Web grids are now searchable.

Grids can be searched when a search bar is present to the bottom right of the grid. To run a each query, enter three or
more characters into the search bar, then click or press Enter. To cancel the search, click next to search or press
ESC.
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18.5 Navigating and Sharing via URL
In IC-Web, you can use URLs to navigate to or share specific sections of IC-Web.

18.5.1 Navigating via URL
It is possible to navigate to sections of IC-Web and select page elements via URL parameters. The URL parameters
direct the browser towards an area of the database via GET request. The key searchKey refers to a table and the value
searchValue refers to the numeric ID of the element in the table. An overview of inputs can be seen below.

<table> value <value> meaning
Asset Component_ID
Library Library_ID
Planning Component_ID
Workpack Workpack_ID
Review Header_ID
Anomaly Anomaly_ID

These parameters can be appended to the IC-Web URL as follows:

https://demo.nexusic.com/?searchKey=<table>&searchValue=<value>

Example:
Using the Expert Systems database, the following URL will direct to the Gas Transmission asset.

https://demo.nexusic.com/?searchKey=Asset&searchValue=2638

ò Note

For Asset, Planning and Review, a random view may be picked if the component exists in multiple
views.

18.5.2 Sharing via URL
IC-Web assets, library items, workpacks, events, anomalies, dashboards and items on the PLANNING screen can be
shared via URL.

To generate this URL for sharing, select the row you would like to share on the page meant for viewing and in the
toolbar, choose Navigation Link → Copy to Clipboard. You can then share this link as required; the user of this link
will be directed to the row and page you selected.

18.6 Drawings in IC-Web
In IC-Web, some features related to drawings work differently as compared to NEXUS IC.

18.6.1 3D CAD Drawings
In IC-Web, 3D drawings are supported via a conversion process. To convert the drawing, follow the steps below:

1. Prepare the 3D CAD drawing in AutoCAD and ensure that you have set up any required tags for navigation as
described in 3D Drawing Preparation in Autocad.

2. Send the drawing to NEXUS support.
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3. NEXUS support converts your CAD file to DAE, a 3D format that works well in web browsers and which is
understood by IC-Web.

4. You (or NEXUS support) can then load that file into your NEXUS library as a drawing on the same asset in the
same Library Category group as your original CAD drawing.

5. NEXUS IC lists both files in the drawing panel but only the CAD files render in 3D; DAE is an unsupported
drawing format for NEXUS IC. IC-Web, however, displays the DAE file as a 3D scene.

In IC-Web, you can use your mouse for 3D drawings as follows:

Action Mouse
Rotate Hold left mouse button and drag
Pan Hold right mouse button and drag
Zoom Use mouse wheel or hold middle mouse button and move up/down

IC-Web is a web-based version of NEXUS IC, running in Chrome, Edge, Safari or Firefox. It aims to replicate the
functionality of NEXUS IC in a web browser, using JavaScript and REST, with the exception of Configuration, which
is available only from NEXUS IC.

IC-Web addresses the following main two use cases:

• Read-only access for a large number of users

• Read/Write access for a smaller number of users with an IC-Web read/write license

18.7 Prerequisites
Before using IC-Web, ensure the following:

• Your organisation has an IC-Web license. Contact support@nexusic.com for details.

• You have deployed IC-Web as described in IC-Web Deployment or you are hosting the IC-Web server in Wood
infrastructure. See Software as a Service (SaaS) for Wood hosting details.

• You have logged in to IC-Web as described in Logging In to IC-Web if you use SaaS with RemoteApp or as
described in SaaS Login if you use SaaS with Single Sign-On (SSO).

18.8 Features
Mostly, IC-Web has the same features as NEXUS IC. However, there are a variety of differences related to the different
implementation challenges in JavaScript/REST versus Windows/SQL. Recent changes in NEXUS IC may not yet be
reflected in IC-Web, and vice versa. For detailed information about the main features of IC-Web, see the documentation
of NEXUS IC (NEXUS IC Overview).

ò Note

Some features in IC-Web are only available in Software as a Service (SaaS) deployments. For more
information, see NEXUS Feature Matrix.

. Warning
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When using IC-Web v6.9 for the first time after upgrading from IC-Web v6.8 or lower, your local user
settings will be automatically deleted for compatibility reasons.

The following sections describe the features that are specific to IC-Web and different from NEXUS-IC:

• Technical Specifics

• User Interface Features

• Importing and Exporting in IC-Web

• Searching in IC-Web

• Navigating and Sharing via URL

• Drawings in IC-Web
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CHAPTER

NINETEEN

DATA CONNECTORS

NEXUS offers a robust REST API library designed to facilitate seamless connection to external data sources. Using
external connectors provided by Wood, organisations can efficiently integrate their systems, ensuring smooth data
exchange and enhanced operational workflows.

19.1 External System Connectivity
NEXUS IC provides a diverse range of external data connectors, each tailored to connect with specific types of external
systems. These connectors enable integration with the following types of external data sources:

• Computerized Maintenance Management Systems (CMMS), such as SAP, Maximo, Oracle

• Digital Twins, for example, Open Wells, Wellview, EDM

• Digital Data Collection (tablets, import data)

• Data Lakes, for example, sensors, sampling, historians

• Electronic Document Management Systems (EDMS)
• Visualisation Tools, such as GIS

• Dashboards (Power BI, Spotfire, Tableau)

• Calculation Engines (FEA Engines, FFS Analysis, ECE)

19.2 Data Connector Types
NEXUS supports a flexible integration model, allowing data connectors to be aligned with specific stages of the asset
integrity management lifecycle. Each stage can be associated with connectors designed to handle particular data types,
enabling targeted and efficient data exchange with external systems.

The diagram below illustrates the main workflow stages and examples of data connector types that can be integrated at
each point:

These connectors are intended to support the flow of structured data between NEXUS and external platforms, enhancing
the precision and efficiency of asset integrity processes.
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For further details on connector design and implementation, refer to the relevant documentation sections.

19.3 Accessing Data Connectors
NEXUS data connectors are available as subscription-based services. Developed and maintained by Wood, each
connector is part of an off-the-shelf framework that can be tailored to fit client-specific systems and workflows.

Wood handles the setup, configuration, and ongoing support, ensuring smooth integration with minimal effort from
the client. Connectors can be deployed in the cloud or on-premises, depending on operational needs.

For more information or to request a connector, contact your Wood representative.

19.4 Integration Architecture
Connection to NEXUS through third-party software can be performed using the REST API, which provides the capa-
bility to read, add, edit, or delete information within any NEXUS database.

NEXUS IC is cloud-based and hosted on Wood’s provided Azure data centres. Connection to NEXUS is facilitated
through the provision of a dedicated ‘REST User’ account with an API key. This secure setup ensures that data exchange
is reliable and efficient.

To facilitate ease of integration and alignment with external systems’ workflows, NEXUS offers an enhanced automation
core connector service with a dedicated REST endpoint to NEXUS. This service can also be deployed on client
premises to support transition over client firewalls when required.

The diagram below demonstrates the different ways client systems can connect to NEXUS:
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19.4.1 Asset Data Connectors
Asset data connectors are designed to facilitate the exchange of asset-specific information - such as asset hierarchies
and attributes - between NEXUS and external systems.

The following connectors are currently available:

Connector Purpose Direction
Asset Tree Connector Aligns source asset locations and parent relationships with

NEXUS Component IDs to maintain a consistent asset hierarchy
across systems.

Single
External
Source ->
NEXUS

Asset Attribute Connector Maps data from Asset Information Groups (AIGs) and sub-AIGs
into NEXUS.

Single
External
Source ->
NEXUS

ã See also

• Asset Tree Connector
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• Asset Attribute Connector

19.4.1.1 Asset Tree Connector

19.4.1.1.1 Overview

The Asset Tree Connector ensures alignment between asset locations in a CMMS (for example, SAP Functional Loca-
tions or FLOCs) and the asset locations in the NEXUS environment. This synchronisation is essential for the correct
functioning of other workflow connectors that rely on accurate asset location data.

19.4.1.1.2 Functionality

In NEXUS, assets are organised within a hierarchical tree structure. Each asset’s location is represented by the Full
Location field, which is derived from its parent assets. For example, an asset might have the following structure:

In this case, the Full Location would be:

Company / Platform / System / Well
At this level within the asset tree, inspectable components (such as vessels, tanks, and piping corrosion circuits) must
be mapped to the corresponding asset locations in the CMMS system.

The Asset Tree Connector ensures that a one-to-one relationship exists between each relevant CMMS asset location and
a NEXUS Component_ID (the unique identifier in NEXUS). Every applicable CMMS asset location must be linked
to a corresponding asset location in NEXUS.

19.4.1.1.3 Example: SAP Integration

The method for mapping NEXUS Full Locations to CMMS asset locations depends on the specific CMMS in use.

For example, when integrating with SAP, the connector maps NEXUS Full Locations to SAP FLOCs. NEXUS provides
a custom Asset Information Group (AIG) form that includes fields for storing asset attributes retrieved from SAP. The
connector populates these fields, which are then used to calculate the Full Location in NEXUS. This approach allows
asset trees to be constructed in NEXUS from a vertical list of components, provided that the necessary parent attributes
are available to define the hierarchy.

The mapping process typically involves the following steps:

1. Data Synchronisation
Populate designated fields in NEXUS with asset-level information from SAP FLOCs.

2. Tier Mapping
Use the populated fields to determine the hierarchical tier levels required to construct the Full Location in
NEXUS.

3. Asset Creation
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For any SAP FLOCs that do not yet have a corresponding NEXUS asset (specifically for asset types such as
“vessel”, “tank”, or “corrosion circuit”), create the asset in NEXUS. Its location is derived from the tier structure
defined in the previous step.

19.4.1.2 Asset Attribute Connector

19.4.1.2.1 Overview

The Asset Attribute Connector simplifies the process of mapping data from Asset Information Groups (AIGs) and sub-
AIGs into NEXUS. It simplifies the external payload required to push attribute data into NEXUS, making integration
more efficient.

19.4.1.2.2 Functionality

Once a unique identifier is established for the external source, the connector can receive a JSON payload containing
asset attributes and map them to specific fields within NEXUS.

The core connector service enhances this process by handling:

• Unit conversions

• Lookup list mappings

• Sub-AIG change management

This approach simplifies and enhances connection over the direct NEXUS REST route.

19.4.2 Planning Data Connectors
Planning data connectors enable the exchange of planning-related information - such as Planned Maintenance (PM) data
and workpacks - between NEXUS and CMMS systems. These connectors support efficient coordination of inspection
and maintenance activities across platforms.

The following connectors are currently available:

Connector Purpose Direction
Planned Maintenance (PM)
Connector

Enables creation of PMs in the CMMS directly from the NEXUS
inspection planner.
Also supports updates to existing PMs, including revised inter-
vals and start dates.

Dual

Workpack Connector Facilitates the creation of workpacks in NEXUS, triggered by the
CMMS, and compatible with Wood’s mobility solution.

Single
CMMS ->
NEXUS

ã See also

• PM Connector

• Workpack Connector
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19.4.2.1 PM Connector

19.4.2.1.1 Overview

The PM connector ensures that Planned Maintenance (PM) data in NEXUS reflects PM data within a CMMS environ-
ment and that the data in both systems is kept accurate and up-to-date without having to enter data into both systems.

By automating the synchronisation process and ensuring data consistency, the connector enhances the efficiency and
reliability of PM management within the organisation.

ò Note

The functionality described below reflects the standard behaviour of the connector. However, work-
flows and features can be highly customised to meet specific client requirements.

19.4.2.1.2 Functionality

NEXUS provides an Asset Information Group (AIG) form, which stores PM data, including the following key fields:

• PM Number

• Function fields (used to calculate RBI interval and next inspection date)

• CMMS Start Date

• CMMS Interval

Additional fields can be mapped to NEXUS as needed as part of the configuration process.

The connector operates by identifying PM records where:

• The PM Number is blank, or

• The Next PM Date and Interval fields in NEXUS do not match the CMMS Start Date and CMMS Interval
fields.

For each PM that meets these criteria, the connector sends a request to the CMMS system, including the unique Sub-
AIG Row ID. Once the PM is created or updated in the CMMS, a payload is returned to NEXUS containing:

• The unique PM ID

• The CMMS Start Date

• The CMMS Interval

This data is then used to update the corresponding PM record in NEXUS.

The following diagram summarises the standard example workflow:
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1. NEXUS periodically checks for PMs that either lack a PM Number or have mismatched start dates or intervals
compared to the CMMS.

2. The connector sends the Sub-AIG Row ID to the CMMS system, where a new PM will be created.

3. Upon receiving a response from the CMMS, NEXUS updates the PM Number, CMMS Start Date, and CMMS
Interval fields accordingly.

4. If an existing PM has changes to its interval or start date in NEXUS, the connector detects the discrepancy and
pushes the update to the CMMS.

5. If PM details are modified in the CMMS, these changes are automatically pushed back to NEXUS.

19.4.2.2 Workpack Connector

19.4.2.2.1 Overview

The Workpack Connector ensures that when work orders are released from a CMMS system, a corresponding workpack
is automatically created in NEXUS, along with the required tasks. If a work order is later updated in the CMMS (for
example, revision status changes), the associated workpack in NEXUS is also updated accordingly.

This integration removes the need for manual data entry in NEXUS and ensures that work orders in the CMMS remain
aligned with their corresponding workpacks in NEXUS.

ò Note

The functionality described below reflects the standard behaviour of the connector. However, work-
flows and features can be highly customised to meet specific client requirements.
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19.4.2.2.2 Prerequisites

Before the connector can operate, the following conditions must be met:

• At least one planning template (see Planning Templates) exists in NEXUS, which can be used to generate tasks
in a workpack based on the asset types of the relevant assets.

• The CMMS asset location has a unique corresponding asset location in NEXUS.

• The CMMS asset has a Start Date specified.

19.4.2.2.3 Functionality

When a work order is generated in a CMMS system, work order data is sent to NEXUS, including the planning template
reference, asset locations and work order number. Additional fields - such as target dates, scheduled dates, and final
dates - can also be mapped as required during configuration. This data may be stored in an Asset Information Group
(AIG) form in NEXUS.

The Workpack Connector then:

1. Generates the workpacks based on the incoming workpack creation request.

2. Triggers the associated planning template, which:

• Identifies child assets under the parent asset associated with the work order.

• Generates tasks based on the asset types and other AIG configuration.

Users may also manually create and modify workpack tasks in NEXUS. If this occurs, the connector can re-process
the original workpack creation request and add, update or remove any tasks accordingly.

ò Note

Task assignment for workpacks is primarily controlled by NEXUS through planning templates and
rule sets defined in AIGs, not by the connector itself.

If the work order is later updated in the CMMS, the connector ensures that the corresponding workpack in NEXUS is
updated to reflect those changes.

The following diagram summarises the standard workflow:
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ò Note

An additional NEXUS-to-CMMS connection can be configured to notify the CMMS when inspection-related tasks
have been completed in NEXUS. This can be configured as required as an additional connection point.

19.4.3 Inspection Data Connectors
The NEXUS REST API library enables direct entry of inspection and sensor data into NEXUS. While this method offers
powerful flexibility, it requires a solid understanding of both the REST library and the underlying NEXUS database
structure.

To simplify this process, the core connector services provide enhanced capabilities, including:

• Unit type and lookup list management

• Multimedia and library item attachments with a single payload

In cases where inspection or sensor data is collected from external sources, it can be automatically imported into
NEXUS. This ensures that all relevant data is available for follow-on analysis as required.

19.4.4 Anomaly Data Connectors
Anomaly data connectors enable the exchange of anomaly-related information - such as anomalies, associated actions,
and tasks derived from those actions - between NEXUS and external systems.

The following connectors are currently available:
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Connector Purpose Direction
Anomaly Action Connector Creates notification requests in the CMMS based on anomaly ac-

tions recorded in NEXUS.
Also supports updating anomaly actions in NEXUS with infor-
mation received from CMMS notifications.

Dual

Corrective Maintenance (CM)
Connector

Facilitates the creation of corrective workpacks in NEXUS based
on work orders created in the CMMS.
The corrective workpack includes tasks linked to the original
anomaly.

Dual

ã See also

• Anomaly Action Connector

• Corrective Maintenance (CM) Connector

19.4.4.1 Anomaly Action Connector

19.4.4.1.1 Overview

The Anomaly Action Connector enables the automatic creation of notification requests in a CMMS system when an
anomaly action is raised in NEXUS with the action type set to a specified value. It also supports updates to anomaly
actions in NEXUS when corresponding notifications are modified in the CMMS, ensuring both systems remain syn-
chronised.

ò Note

The functionality described below reflects the standard behaviour of the connector. However, work-
flows and features can be highly customised to meet specific client requirements.

19.4.4.1.2 Functionality

The connector operates on a scheduled basis and retrieves anomaly actions from NEXUS where:

• Action Type is set to a specified value (for example, “Notification Request”)

• Completed At and Reference Number fields are empty

For each matching anomaly action, a notification request is created in the CMMS.

Any updates made to the notification request in the CMMS are sent back to NEXUS, updating the corresponding
anomaly action. This ensures NEXUS mirrors the current state of the notification in the CMMS.

The following diagram summarises the standard workflow:

652 Chapter 19. Data Connectors



NEXUS Documentation, Release 6.9.xxxxx.0

1. On a scheduled interval, the connector identifies anomaly actions in NEXUS where:

• Action Type = “Notification Request”`

• Completed At is empty

• Reference Number is empty

2. For each identified anomaly action, the connector sends a notification request to the CMMS.

3. Users manage and update the notification in the CMMS to track progress and resolution.

4. Updates from the CMMS are sent back to NEXUS, ensuring the anomaly action reflects the current state of the
notification. No manual action is required in NEXUS during this process.

19.4.4.2 Corrective Maintenance (CM) Connector

The Corrective Maintenance Connector operates similarly to the Workpack Connector. When a corrective work order is
created in the CMMS, and a valid planning template reference is provided, a corresponding workpack is automatically
generated in NEXUS. This workpack includes tasks linked to the original anomaly record.

Once the corrective workpack is created, it is managed using the same process and logic as standard workpacks, as
outlined in Workpack Connector.
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CHAPTER

TWENTY

REST SERVICE SPECIFICATIONS V2.0

20.1 Version
Returns the current REST service version and Database schema.

20.1.1 HTTP Request
GET /icweb.dll/version

20.1.1.1 URI Parameters

None

20.1.1.2 Responses

Name Type Description
200 OK Version OK

20.1.2 Version
Contains the REST service version and database schema.

Name Type Description Optional
version String Version and build of REST service. No
schema String Database schema version No

20.1.3 Example
20.1.3.1 Request

GET /icweb.dll/version

20.1.3.2 Response

{
"version": "6.6.35223.0",
"schema": "8.198"

}
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20.2 Login
Validates the supplied credentials, and if valid returns a hash to be used on subsequent REST api requests.

20.2.1 HTTP Request
POST /icweb.dll/security/login
Authorization {type} {value}

20.2.1.1 URI Parameters

Name In Re-
quired

Type Description

type HeaderYes String Style of authorization. This can be one of either BASIC, APIKEY, TOKEN.
valueHeaderYes String This is the base 64 encoded authorization key, it is a string containing

username:password for BASIC, apiKey for APIKEY, or the emailToken for TO-
KEN.

20.2.1.2 Responses

Name Type Description
200 OK SecurityHash OK
401 An attempt was made to validate an invalid token/apiKey/username and password.

20.2.2 SecurityHash
Contains the temporary hash that can be used with subsequent REST api calls.

Name Type Description Op-
tional

hash String Temporary security hash, that can then be used in subsequent REST api re-
quests, expires 60 minutes after last use.

No

id Inte-
ger

Key associated with the user that this hash is associated with. No

username String Username associated with the user that this hash is associated with. No
license String Type of license the user has assigned to them. Possible values are ‘write’ or

‘readonly’.
No

allowPasswordChangeBooleanTrue if this user’s accounts password can be changed by the end user. No
name BooleanFull name of the user from the Personnel table. If it is blank it won’t be re-

turned.
Yes

20.2.3 Example
Request authentication via a users username and password.

20.2.3.1 Request

POST /icweb.dll/security/login
Authorization BASIC YWRtaW46cGFzc3dvcmQ=
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Note ‘YWRtaW46cGFzc3dvcmQ=’ is the BASE64 encoded equivalent to the string ‘admin:password’

20.2.3.2 Response

{
"hash":

→˓"E05DEB57605BA82CD1A0C130B38C7BC1415BA094B28D73B03577B7CAB438834E6B680B437C85A65CA796AB6E7DC8545555CC
→˓",

"id": 4,
"username": "admin",
"license": "write",
"allowPasswordChange": false

}

20.2.4 Example
Request authentication via an API Key.

20.2.4.1 Request

POST /icweb.dll/security/login
Authorization APIKEY RTA1REVCNTc2MDVCQTgyQ0QxQTBDMTMwQjM4QzdCQzE0MTVCQTA5NEIyOEQ3M0IwMw==

Note: the APIKey is shown BASE64 encoded.

20.2.4.2 Response

{
"hash":

→˓"E05DEB57605BA82CD1A0C130B38C7BC1415BA094B28D73B03577B7CAB438834E6B680B437C85A65CA796AB6E7DC8545555CC
→˓",

"id": 4,
"username": "admin",
"license": "write",
"allowPasswordChange": true

}

20.2.5 Example
Request authentication via an email token.

20.2.5.1 Request

POST /icweb.dll/security/login
Authorization TOKEN RTA1REVCNTc2MDVCQTgyQ0QxQTBDMTMwQjM4QzdCQzE0MTVCQTA5NEIyOEQ3M0IwMw==

Note: the APIKey is shown BASE64 encoded.

20.2.5.2 Response

{
"hash":

(continues on next page)
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(continued from previous page)

→˓"E05DEB57605BA82CD1A0C130B38C7BC1415BA094B28D73B03577B7CAB438834E6B680B437C85A65CA796AB6E7DC8545555CC
→˓",

"id": 4,
"username": "admin",
"license": "write",
"allowPasswordChange": false

}

20.3 Logout
Invalidates the hash passed so that it can no longer be used for any subsequent requests.

20.3.1 HTTP Request
GET /icweb.dll/security/logout?hash={hash}

20.3.1.1 URI Parameters

Name In Required Type Description
hash Url Yes String hash to be logged out/invalidated.

20.3.1.2 Responses

Name Type Description
200 OK OK
404 An attempt was made to invalidate an invalid hash.

20.3.2 Example
Invalidate a valid hash token.

20.3.2.1 Request

GET /icweb.dll/security/logout?
→˓hash=E05DEB57605BA82CD1A0C130B38C7BC1415BA094B28D73B03577B7CAB438834E6B680B437C85A65CA796AB6E7DC8545555CC

20.3.2.2 Response

200 OK

20.4 Business Objects
Retrieves information about a business object.
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20.4.1 HTTP Request
GET /icweb.dll/bo/{tableName}

Additionally you can lookup a business object by it’s key, this is useful when you only have the key from a
foreignTableId field from within BusinessObjectField

GET /icweb.dll/boByKey/{keyValue}

20.4.2 URI Parameters

Name In Re-
quired

Type Description

tableNamePath Yes String tableName of the business object to be returned
keyValue Path Yes Inte-

ger
key value of the business object to be returned, this can be obtained from Busi-
nessObjectField foreignTableId

20.4.3 Responses

Name Type Description
200 OK BusinessObject OK
404 Not Found Business object with specified tableName was not found.

20.4.4 BusinessObject
The business object result type, describes a business object, henceforth referred to as meta table.

Name Type Description Op-
tional

De-
fault

key Integer Key value for this meta table, unique No
tableName String Table Name for this meta table, used to generate REST

requests
No

name String Display / Friendly name for this meta table No
description String Description of this meta table, omitted if null Yes
category String Category of this meta table, omitted if null Yes
tableTypeId Integer Id value of the type of meta table, omitted if null Yes
tableType String Name of the table type, omitted if null Yes
defaultNameFieldNameString Field Name of the field that should be used as the display

name for rows in this object
No

uniqueFieldNameString Field Name of the field that contains the unique row
identifier

No

permissions String Permissions the user has on the BO. None / Read / Write No
categories BusinessObject-

FieldCategory
Array of Business Object Field Categories, defines all
the visible categories

Yes

fields BusinessObject-
Field []

Array of Business Object Fields, defines all fields in
Business Object.

Yes
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20.4.5 BusinessObjectField
The business object field result type, describes a field in a business object, henceforth referred to as meta field.

Name Type Description Optional Default
name String Default display name of the field No
fieldName String Field Name used in REST requests No
fieldTypeId Integer Type of data the field stores in the database. See Field Types No
displayFieldTypeId Integer The display type of the field type, this may differ to fieldTypeId, for example fieldTypeId may be calculated, but displayFieldTypeId may be string, must be a simple type. Yes fieldTypeId
editorTypeId Integer Type of control that should be used to allow the user to edit raw data for this field. No
displayEditorTypeId Integer Type of control that should be used to allow the user to edit the display value of this field, used for filtering, reports Yes editorTypeId
fieldSize Integer Maximum size of a string field Yes 0
comments String Long comments describing use of the field Yes
defaultValue String Contains the default value that should be given to this field when creating a new row in a client UI. Yes undefined
required Boolean Defines if the can be set to ‘null’. Yes No
lowerValue Float Defines the absolute minimum value for an Integer/Float field Yes undefined
upperValue Float Defines the absolute maximum value for an Integer/Float field Yes undefined
format String Defines the display format for a field Yes undefined
preventEditing Boolean Prevent the user from editing the value in this field, only valid for native field types. Yes No
category String Category of the field, used to group like categories into ‘groups’ Yes BusinessObject.Name
blankText String Value displayed in edit field, when the field value is null Yes undefined
formColumns Integer Number of columns the field should consume on the form Yes 1
formVisible Boolean Is the field visible on the form Yes True
formOrder Integer Order of the field when displaying as a form Yes 0
formCaption String Caption used as the form caption Yes BusinessObjectField.name
formShowCaption Boolean Should the caption be shown for the field on the form. Visible by default. Yes True
gridVisible Boolean Is the field visible on the grid, True, visible by default, False, not visible, null, not visible by default but can be turned on. Yes null
gridOrder Integer Order of the field when displaying as a grid Yes 0
gridCaption String Caption used as the grid caption Yes BusinessObjectField.name
mobileVisible Boolean Should the field be visible for mobile style UIs Yes No
mobileOrder Integer Order of the field when displaying on a mobile UI. Yes 0
mobileCaption String Caption used as the field caption for mobile UI’s. If not defined, use Name. Yes BusinessObjectField.name
booleanTypeId Integer The display type for Boolean fields Yes undefined
isBooleanTypeImage Boolean Is the above display type for boolean fields an image. Yes No
foreignTableId Integer The key for the foreign meta table this field refers to. Yes undefined
subTableId Integer The key for the sub event/aig table this field refers to. Only valid when field type is FT_TABLE. See Field Types Yes undefined
unitId Integer The key for the unit assigned to this field, only relevant for Float fields. Yes undefined
lookupListId Integer The key for the lookup list assigned to this field Yes undefined
isLookupListImage Boolean Is the display type for the lookup list. Yes No
multiValue Boolean If this field is a PassThru field, it may be a one-to-many relationship, in which case this will be true, as the values for this field will be the display values of each row ‘,’ separated. Yes No
nestedField BusinessObjectField If this field is linked to another business object field, such as PassThru or Global Lookup, then this contains the information about the nested field for formatting and display. No undefined
businessObjectName string If this is a nested field, then the Business Object Name will be included here to allow further requests. No undefined
supportsApprovers Boolean Does this meta table support approvers being configured, also see approversConfigured. Yes No
approversConfigured Boolean Does this meta table have approvers configured, when true, change requests can be submitted for rows in this table if the user has read-only permissions. Yes No

20.4.6 BusinessObjectFieldCategory
The business object fields category type, describes a category for a field, used when displaying the fields in a form, and
optionally in a grid.
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Name Type Description Op-
tional

De-
fault

name String Display name of the category. No
alignTopBoolean Determines if the fields are positioned above the control, or to the left. Yes No
commentsString Comments/Description that is displayed at the top of the category group,

before any fields.
Yes unde-

fined
columns Inte-

ger
Number of columns of fields to display in categories. Yes 2

hasImageBoolean Determines if the category has an image that should be displayed at the top
of the category group.

Yes No

imageUrlString Specifies the relative Url to retrieve the image data for the category image,
only valid if hasImage is Yes.

Yes unde-
fined

20.4.7 Example
20.4.7.1 Request

GET /icweb.dll/bo/Workpack

20.4.7.2 Response

{
"key": 136,
"tableName": "Workpack",
"name": "Workpack",
"defaultNameFieldName": "Name",
"uniqueFieldName": "Workpack_ID",
"category": "Work Scoping",
"tableTypeId": 11,
"tableType": "System Table",
"permissions": "write",
"categories": [{

"name": "Budget"
}, {

"name": "Status"
}, {

"name": "Timing"
}],
"fields": [{

"name": "",
"fieldName": "Guid",
"fieldTypeId": 17,
"editorTypeId": 3,
"formVisible": false,
"gridVisible": false

}, {
"name": "Workpack_ID",
"fieldName": "Workpack_ID",
"fieldTypeId": 3,
"editorTypeId": 4,
"fieldSize": 4,

(continues on next page)

20.4. Business Objects 661



NEXUS Documentation, Release 6.9.xxxxx.0

(continued from previous page)

"formColumns": 1,
"formVisible": false,
"gridVisible": false

}, {
"name": "Workpack Group",
"fieldName": "WPG_ID",
"fieldTypeId": 3,
"displayFieldTypeId": 1,
"editorTypeId": 13,
"fieldSize": 4,
"formColumns": 2,
"formOrder": 1,
"foreignTableId": 138

}, {
"name": "Cost Code",
"fieldName": "CC_ID",
"fieldTypeId": 3,
"displayFieldTypeId": 1,
"editorTypeId": 13,
"fieldSize": 4,
"category": "Budget",
"formColumns": 1,
"formOrder": 20,
"gridVisible": false,
"foreignTableId": 31

}, {
"name": "Revision",
"fieldName": "Revision_ID",
"fieldTypeId": 3,
"displayFieldTypeId": 1,
"editorTypeId": 13,
"fieldSize": 4,
"category": "Status",
"formColumns": 2,
"formOrder": 5,
"foreignTableId": 97

}, {
"name": "Name",
"fieldName": "Name",
"fieldTypeId": 1,
"editorTypeId": 3,
"fieldSize": 50,
"required": true,
"formColumns": 2

}, {
"name": "Abbreviation",
"fieldName": "Abbreviation",
"fieldTypeId": 1,
"editorTypeId": 3,
"fieldSize": 10,
"formColumns": 2,
"formOrder": 2,

(continues on next page)
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"gridVisible": false
}, {

"name": "Actual Start",
"fieldName": "Actual_Start",
"fieldTypeId": 9,
"editorTypeId": 8,
"fieldSize": 16,
"category": "Timing",
"formColumns": 2,
"formOrder": 7

}, {
"name": "Description",
"fieldName": "Description",
"fieldTypeId": 1,
"editorTypeId": 3,
"fieldSize": 100,
"formColumns": 2,
"formOrder": 3,
"gridVisible": false

}, {
"name": "Read Only",
"fieldName": "ReadOnly",
"fieldTypeId": 5,
"editorTypeId": 5,
"fieldSize": 1,
"required": true,
"category": "Status",
"formColumns": 2,
"formOrder": 6,
"booleanTypeId": 9

}, {
"name": "Personnel",
"fieldName": "SU_ID",
"fieldTypeId": 3,
"displayFieldTypeId": 1,
"editorTypeId": 13,
"formColumns": 1,
"formVisible": false,
"gridVisible": false,
"foreignTableId": 86

}, {
"name": "Task Time",
"fieldName": "Task_Time",
"fieldTypeId": 40,
"displayFieldTypeId": 6,
"editorTypeId": 11,
"displayEditorTypeId": 4,
"category": "Timing",
"formColumns": 1,
"formOrder": 8,
"gridVisible": false

}, {

(continues on next page)
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"name": "Work Hours (per day)",
"fieldName": "Hours_Per_Day",
"fieldTypeId": 6,
"editorTypeId": 4,
"category": "Timing",
"blankText": "Number of effective work hours per day.",
"formColumns": 1,
"formOrder": 9,
"gridVisible": false

}, {
"name": "Duration (Estimated)",
"fieldName": "Estimated_Duration",
"fieldTypeId": 40,
"displayFieldTypeId": 6,
"editorTypeId": 11,
"displayEditorTypeId": 4,
"category": "Timing",
"formColumns": 1,
"formOrder": 10,
"gridVisible": false

}, {
"name": "Duration (Contingency)",
"fieldName": "Duration_Contingency",
"fieldTypeId": 6,
"editorTypeId": 4,
"category": "Timing",
"blankText": "Enter a value to add a contingency to the estimated␣

→˓duration",
"formColumns": 1,
"formOrder": 11,
"gridVisible": false,
"unitId": 36

}, {
"name": "Duration (Override)",
"fieldName": "Override_Duration",
"fieldTypeId": 6,
"editorTypeId": 4,
"category": "Timing",
"blankText": "Enter a value to override the estimated duration",
"formColumns": 1,
"formOrder": 12,
"gridVisible": false,
"unitId": 36

}, {
"name": "Actual End",
"fieldName": "Actual_End",
"fieldTypeId": 40,
"displayFieldTypeId": 9,
"editorTypeId": 11,
"displayEditorTypeId": 8,
"category": "Timing",
"formColumns": 2,

(continues on next page)
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"formOrder": 13
}, {

"name": "Day Rate",
"fieldName": "Day_Rate",
"fieldTypeId": 6,
"editorTypeId": 4,
"category": "Budget",
"blankText": "Used to calculate cost based on day rate",
"formColumns": 1,
"formOrder": 14,
"gridVisible": false

}, {
"name": "Cost based on Day Rate",
"fieldName": "Cost_Day_Rate",
"fieldTypeId": 40,
"displayFieldTypeId": 6,
"editorTypeId": 11,
"displayEditorTypeId": 4,
"category": "Budget",
"formColumns": 1,
"formOrder": 15,
"gridVisible": false

}, {
"name": "Costs (Fixed)",
"fieldName": "Fixed_Cost",
"fieldTypeId": 6,
"editorTypeId": 4,
"category": "Budget",
"formColumns": 1,
"formOrder": 16,
"gridVisible": false

}, {
"name": "Cost (Total)",
"fieldName": "Total_Cost",
"fieldTypeId": 40,
"displayFieldTypeId": 6,
"editorTypeId": 11,
"displayEditorTypeId": 4,
"category": "Budget",
"formColumns": 1,
"formOrder": 17,
"gridVisible": false

}, {
"name": "Cost (Override)",
"fieldName": "Override_Cost",
"fieldTypeId": 6,
"editorTypeId": 4,
"category": "Budget",
"blankText": "Enter a value to override the calculated total cost",
"formColumns": 1,
"formOrder": 18,
"gridVisible": false

(continues on next page)
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}, {
"name": "Final Estimate",
"fieldName": "Cost",
"fieldTypeId": 40,
"displayFieldTypeId": 6,
"editorTypeId": 11,
"displayEditorTypeId": 4,
"category": "Budget",
"formColumns": 1,
"formOrder": 19,
"gridVisible": false

}, {
"name": "Asset",
"fieldName": "Component_ID",
"fieldTypeId": 3,
"displayFieldTypeId": 1,
"editorTypeId": 13,
"formColumns": 2,
"formOrder": 4,
"gridVisible": false,
"foreignTableId": 30

}, {
"name": "Tasks",
"fieldName": "Task_Count",
"fieldTypeId": 3,
"editorTypeId": 4,
"formColumns": 1,
"formVisible": false

}, {
"name": "Task Breakdown",
"fieldName": "Task_Breakdown",
"fieldTypeId": 1,
"editorTypeId": 3,
"formColumns": 1,
"formVisible": false,
"gridVisible": false

}]
}

20.5 Get Row
Retrieve a single row from a business object. The result can be used to display or update the row.

20.5.1 HTTP Request
GET /icweb.dll/bo/{tableName}/{keyValue}?calculateValues={true|false}
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20.5.1.1 URI Parameters

Name In Re-
quired

Type Description

tableNamePath Yes String Table Name of the business object
keyValue Path Yes In-

te-
ger

Id of the row to be returned, if you specify 0 as the key value (this can’t exist) then
getRow returns you a blank row with the default values for all fields populated, ready
to be used to insert a new row.

calculateValuesPath No BooleanThis can be used to disable returning calculated fields. By default this is true, if you
supply false, then no calculated fields will be returned.

20.5.1.2 Responses

Name Type Description
200 OK TableData OK
404 Not Found No row found for specified keyValue

20.5.2 TableData
Contains the row data for the requested row for the specified business object.

Name Type Description Op-
tional

Default

key Inte-
ger

Key value for this business object, unique. No

stamp String Stamp for this row set, can be used to re-request the data or request
the next page of data. If omitted row set can’t be paged or re-
requested.

Yes

startRowInte-
ger

Starting row for this set of paged data. Yes 0

pageSizeInte-
ger

Number of rows in each page of data. Yes 100

totalRowsInte-
ger

Number of rows total across all pages, this value may change
on subsequent page retrievals if modifications are made by other
users.

Yes null

rows TableRow
[]

Array of fields/values. Fields are defined by the BusinessObject. Yes Any field not speci-
fied is assumed to be
null.

20.5.3 TableRow
The business object data row, describes a row of data in a TableData result set. The fields that are defined in TableRow
are based on the BusinessObject.

ò Note

The fields are dynamic and can change. Each and every NEXUS database may have slightly different fields in the
System Tables. The custom tables (Asset Information, Events etc) may differ significantly between databases, and
can change between calls to the REST service if the users are actively making changes. It is expected that any client
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consuming data from the NEXUS REST service is able to cope with this. Either by ignoring additional fields in
the TableRow or by assuming a field value is null if the field does not exist.

Additionally, there is a special field returned, @permissions for each row. The two values available for this field
are: write and read. write is the default value.

write means the user has permission to read and write to the row. read means the user only has permission to
read the row, but not write.

Name Type Description Op-
tional

Default

{fieldName}Any Contains the value for the specified field, see BusinessObject-
Field. If this is a non-stored field, then this will contain the
display value.

Yes If a field is omitted, it is
because the fields value is
null.

{fieldName}Er-
ror

If the field is in an error state, then an error object is returned. Yes

20.5.4 Error
The error object, contains a single value for the error message

Name Type Description Optional
error string Error string to be shown to the user No

20.5.5 Example
20.5.5.1 Request

GET /icweb.dll/bo/Workpack/4

20.5.5.2 Response

{
"rows": [{

"Guid": "{35809A21-9174-4B56-AD5F-F3930DE24A2D}",
"Workpack_ID": 1,
"Name": "2015 ROV Inspection",
"Actual_Start": "2015-05-15T00:00:00.000Z",
"Description": "Annual 2015 full field rov inspection",
"ReadOnly": false,
"Task_Time": 0,
"Hours_Per_Day": 12,
"Estimated_Duration": 0,
"Actual_End": "2015-05-15T00:00:00.000Z",
"Total_Cost": 0,
"Cost": 0,
"Component_ID": 1,
"Task_Count": 0

}],
"key": 136

}
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20.6 Get Row Field
Retrieve a single field value from a row from a business object. The result is not JSON encoded, and is the literal value.

20.6.1 HTTP Request
GET /icweb.dll/bo/{tableName}/{keyValue}/{fieldname}?format={format}

20.6.1.1 URI Parameters

Name In Re-
quired

Type Description

tableNamePath Yes String Table Name of the business object.
keyValuePath Yes In-

te-
ger

Id of the row to be returned.

fieldNamePath Yes String Field Name within the business object.
format Path No string Format of results. Possible values are value, png, and thumbnail, but depends

on the field type. FT_CALC supports png, some Repository items support png and
thumbnail.

page Path No In-
te-
ger

Where this is a multi-page document, such as PDF, return the specific page rendered
as png.

20.6.1.2 Responses

Name Type Description
200 OK Literal Value OK
404 Not Found No row found for specified keyValue
404 Not Found Field fieldName not found in tableName

20.6.2 Literal Value
The response contains the literal value of the field. The content type in the response header describes the type of content
returned.

20.6.3 Example
Retrieve the name of a workpack.

20.6.3.1 Request

GET /icweb.dll/bo/Workpack/4/Name

20.6.3.2 Response

Content-Type: text/plain
2015 ROV Inspection
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20.6.4 Example
Retrieve the icon for an Asset

20.6.4.1 Request

GET /icweb.dll/bo/Comp_Icon/4/Icon

20.6.4.2 Response

Content-Type: image/png
{binaryData}

20.7 Get Rows
Retrieve a 0 or more rows from a business object. This can either return all rows, or rows that match a specified filter.

20.7.1 HTTP Request
GET /icweb.dll/bo/{tableName}/

20.7.1.1 URI Parameters

Name In Re-
quired

Type Description De-
fault

tableNamePath Yes String Table Name of the business object
startRow Query No In-

te-
ger

Starting row to be returned, when using paged datasets this sets the first
row returned.

0

pageSize Query No In-
te-
ger

The number of rows in each page. Determines the maximum number of
rows to return in the requests, starting at startRow.

100

pageWithKeyQuery No In-
te-
ger

Returns the page of data, that contains the specified key value in
pageWithKey.

stamp Query No String Specifies the existing result set to return more rows from. This must come
from a prior request.

20.7.1.2 Request Headers

Name Re-
quired

Type Description

X-NEXUS-FilterNo BusinessObject-
Filters

Filter that should be used to select rows. If this is not specified, then
all rows are returned.

X-NEXUS-Sort No BusinessObject-
Sort []

List of fields and direction to sort the resulting dataset.
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20.7.1.3 Responses

Name Type Description
200 OK TableData OK

20.7.2 BusinessObjectFilters
Specifies the filter that should be used to return rows.

Name Type Description Optional Default
operator string Specifies the type

of operator used to
join filters together.
There are two possi-
ble values:

• and
• or

Yes and

where BusinessObjectFil-
ter

List of filters to be
used

Yes

nested BusinessObjectFil-
ters

Nested list of filters
to be used

Yes

distinct boolean Specifies that only
distinct rows should
be returned.

Yes False

20.7.3 BusinessObjectFilter
Specifies a single filter.
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Name Type Description Optional Default
field string Name of the field to

apply a filter on.
No

method string Filter method:
• eq Equals
• lt Less Than
• gt Greater

Than
• le Less than

or Equal
• ge Greater

than or Equal
• like Like

(Use %
characters
as wildcard
matching)

• in In (Use
items)

• pa Parents Of
• ch Children

Of

Yes eq

value string String represen-
tation of the filter
value. (Ignored
when the method is
in)

Yes null

items Integer[] List of values to be
used when method
is in.

Yes null

not boolean Inverts the method,
ie eq becomes not
eq, in becomes not
in

Yes False

20.7.4 BusinessObjectSort
Specifies a sort, defines a field and direction to sort by.

Name Type Description Op-
tional

De-
fault

field string Name of the field to sort on No
ascending boolean Specifies the order to sort, when true sort is in ascending order, when false

descending order.
Yes True

20.7.5 Example (Lookup_Item)
Return Lookup Items for Lookup List with LL_ID of 4. Page Size is set to 5, so the first response only returns 5 rows.
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20.7.5.1 Request

GET /icweb.dll/bo/Lookup_Item/?pageSize=5

20.7.5.2 Request Header

X-NEXUS-Filter: {"where":[{"field": "LL_ID", "value": "4"}]}

20.7.5.3 Response

{
"pageSize": 5,
"startRow": 0,
"totalRows": 12,
"rows": [{

"Guid": "{A348BB1B-4DD4-494A-8A26-51746F2BE1A8}",
"LL_ID": 4,
"LI_ID": 506,
"Value": "0",
"Comments": "Item 0",
"Item_Order": 0

}, {
"Guid": "{049D6A48-DFFF-4C37-8C91-5EF4C4C26BDA}",
"LL_ID": 4,
"LI_ID": 507,
"Value": "1",
"Comments": "Item 1",
"Item_Order": 1

}, {
"Guid": "{01AB1DDC-5909-434A-A441-CFB592FC2960}",
"LL_ID": 4,
"LI_ID": 508,
"Value": "2",
"Comments": "Item 2",
"Item_Order": 2

}, {
"Guid": "{8975DF1F-C06B-4B43-ADA1-5E549F846B3E}",
"LL_ID": 4,
"LI_ID": 509,
"Value": "3",
"Comments": "Item 3",
"Item_Order": 3

}, {
"Guid": "{D601759D-C2D5-4DBD-856A-EC2063138443}",
"LL_ID": 4,
"LI_ID": 510,
"Value": "4",
"Comments": "Item 4",
"Item_Order": 4

}],
"key": 67

}

20.7. Get Rows 673



NEXUS Documentation, Release 6.9.xxxxx.0

20.7.6 Example (Lookup_Item)
Return Lookup Items for Lookup List with LL_ID of 4 and (Item_Order < 5 OR Item_Order > 10). Page Size is set to
5, so the first response only returns 5 rows.

20.7.6.1 Request

GET /icweb.dll/bo/Lookup_Item/?pageSize=10

20.7.6.2 Request Headers

X-NEXUS-Filter: {"where": [{"field": "LL_ID","value": "4"}],"nested": [{"operator": "or",
→˓"where": [{"field": "Item_Order","method": "lt","value": "5"}, {"field": "Item_Order",
→˓"method": "gt","value": "10"}]}]}
X-NEXUS-Sort: [{"field": "LL_ID", "ascending": false}]

20.7.6.3 Response

{
"pageSize": 10,
"startRow": 0,
"totalRows": 12,
"rows": [{

"Guid": "{DE2042D6-D988-43B2-9097-3BE8130DE9A7}",
"LL_ID": 4,
"LI_ID": 506,
"Value": "0",
"Comments": "Item 0",
"Item_Order": 0

}, {
"Guid": "{13C2D078-B8E7-4A77-BF2C-15EF131618DB}",
"LL_ID": 4,
"LI_ID": 507,
"Value": "1",
"Comments": "Item 1",
"Item_Order": 1

}, {
"Guid": "{4BD34909-E95A-413C-BD43-6936BF1D5728}",
"LL_ID": 4,
"LI_ID": 508,
"Value": "2",
"Comments": "Item 2",
"Item_Order": 2

}, {
"Guid": "{918A854C-718C-4AA1-AC98-4C781F4985B9}",
"LL_ID": 4,
"LI_ID": 509,
"Value": "3",
"Comments": "Item 3",
"Item_Order": 3

}, {
"Guid": "{B3234C2F-3C0C-46CD-B125-715DDC686786}",
"LL_ID": 4,

(continues on next page)
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"LI_ID": 510,
"Value": "4",
"Comments": "Item 4",
"Item_Order": 4

}, {
"Guid": "{EEE0268D-B3F3-45F7-B8CE-A88989C9A1BB}",
"LL_ID": 4,
"LI_ID": 517,
"Value": "11",
"Comments": "Item 11",
"Item_Order": 11

}, {
"Guid": "{080A5FC0-DF25-44DE-896F-25EB95B28E74}",
"LL_ID": 4,
"LI_ID": 518,
"Value": "12",
"Comments": "Item 12",
"Item_Order": 12

}, {
"Guid": "{ABFDFC1C-8C31-4DC7-A0AE-0A3174A0C30F}",
"LL_ID": 4,
"LI_ID": 519,
"Value": "13",
"Comments": "Item 13",
"Item_Order": 13

}, {
"Guid": "{4758598E-5008-4008-A4A6-0EB4697D98C9}",
"LL_ID": 4,
"LI_ID": 520,
"Value": "14",
"Comments": "Item 14",
"Item_Order": 14

}, {
"Guid": "{7010FCB9-E0DC-409B-8C4F-2A6B81769852}",
"LL_ID": 4,
"LI_ID": 521,
"Value": "15",
"Comments": "Item 15",
"Item_Order": 15

}],
"key": 67

}

20.7.7 Example (complex expression)
For following filter:

((Field_A = Column_A AND Column_B = Value_B) OR (Column_C = Value_C AND Column_D = Value_D))

the syntax is:

{
"operator": "or",

(continues on next page)
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(continued from previous page)

"nested": [
{
"operator": "and",
"where": [

{
"field": "Column_A",
"value": "Value_A"

},
{
"field": "Column_B",
"value": "Value_B"

}
]

},
{
"operator": "and",
"where": [

{
"field": "Column_C",
"value": "Value_C"

},
{
"field": "Column_D",
"value": "Value_D"

}
]

}
]

}

The above expression has been unpacked onto multiple lines and indented for easy reading; you will of course need to
deliver the expression in a single X-NEXUS-Filter.

20.8 Create / Update Row
Create a new row or update an existing row in a business object.

ò Note

Some tables are read-only and cannot be modified. For more information, see Read-Only Tables.

20.8.1 Read-Only Tables
In REST API, certain tables are designated as read-only and you are prohibited from writing to these tables. Below is
a list of the read-only tables:
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Category Table Name
Charts Tables Axis_Kind

Axis_Type
Line_Weight
Point_Style
Series_Type

Component Tables Info_Def
Drawing Tables Layer_Type
Event Data Tables MM_Type
Function Tables Function_Definition

Function_Part
Function_Part_Input
Part_Option

Library Tables Lib_Conn_Type
Metadata Tables Boolean_Exception

Default_Column
Editor_Type
External_Provider_Type
Field_Def
Field_Layout
Field_Type
Map_Direction
MT_Action
Table_Def
Text_Align

Planning Tables LTIP_Frequency
LTIP_Task_Task
LTIP_Workpack

Reports Tables Schedule_Repeat
Synchronisation Tables Operation

Sync_Change
Workflow Tables Trigger_Type

Workflow_Filter
Workflow_Item
Workflow_Item_Input
Workflow_Item_Type

20.8.2 HTTP Request
Create:

PUT /icweb.dll/bo/{tableName}/{keyValue}?calculateValues={true|false}&request=
→˓{true|false}

Update:

POST /icweb.dll/bo/{tableName}/{keyValue}?calculateValues={true|false}&request=
→˓{true|false}
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20.8.2.1 URI Parameters

Name In Re-
quired

Type Description

tableName Path Yes String Table Name of the business object
keyValue Path Yes In-

te-
ger

For PUT (create) use 0, for POST (update) use the existing primary key value.

calculateValuesPath No BooleanThis can be used to disable returning calculated fields. By default this is true,
if you supply false, then no calculated fields will be returned.

request Path No BooleanThis is used to submit a change request for creating/deleting a row. By default
this is false.

20.8.2.2 Request Body

This contains fields and values for the new/updated row. For simplicity, you should only include fields that have a value
other than null. You should also exclude any non-stored field, as these will be ignored.

Name Type Description Op-
tional

Default

{fieldName}Any Should contain the new value for the specified field, see
BusinessObjectField.

Yes You can omit a field if the
value is null.

ò Note

If a field has a default value, then if you want to set the value of that field to null, you must include the field in the
request body with a null value. If you omit the field then the new row will have the default value inserted.

20.8.2.3 Responses

Name Type Description
200 OK TableData OK
403 An attempt was made to set a value for a read-only field.
422 An attempt was made request changes to a row that was not allowed.

20.8.3 Example
Create a new Workpack. Response will contain the new row that was created in the database.

20.8.3.1 Request

PUT /icweb.dll/bo/Workpack/0

20.8.3.2 Request Body

{
"Name": "2015 ROV Inspection",
"Actual_Start": "2015-05-15T00:00:00.000Z",

(continues on next page)
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"Description": "Annual 2015 full field rov inspection",
"ReadOnly": false,
"Component_ID": 1

}

20.8.3.3 Response

{
"rows": [{

"Guid": "{35809A21-9174-4B56-AD5F-F3930DE24A2D}",
"Workpack_ID": 1,
"Name": "2015 ROV Inspection",
"Actual_Start": "2015-05-15T00:00:00.000Z",
"Description": "Annual 2015 full field rov inspection",
"ReadOnly": false,
"Task_Time": 0,
"Hours_Per_Day": 12,
"Estimated_Duration": 0,
"Actual_End": "2015-05-15T00:00:00.000Z",
"Total_Cost": 0,
"Cost": 0,
"Component_ID": 1,
"Task_Count": 0

}],
"key": 136

}

20.8.4 Example
Request creation of a new workpack. Note the response will be a copy of the Approval record, rather than the newly
created Workpack.

20.8.4.1 Request

PUT /icweb.dll/bo/Workpack/0?request=true

20.8.4.2 Request Body

{
"Name": "2015 ROV Inspection",
"Actual_Start": "2015-05-15T00:00:00.000Z",
"Description": "Annual 2015 full field rov inspection",
"ReadOnly": false,
"Component_ID": 1

}

20.8.4.3 Response

{
"rows": [{

(continues on next page)
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"Guid": "{962496F3-8B3C-4B34-BA06-7E0F4AFED05C}",
"Approval_ID": 1,
"Requested": "2024-11-12T01:14:23.880Z",
"TD_ID": 136,
"SU_ID": 4,
"Row": "{8099539E-0865-4FC3-9D94-2E06F4DE30DB}",
"Operation_ID": 1

}
],
"key": 266

}

20.9 Validate Row
Validate updates to a new or existing row in a business object.

20.9.1 HTTP Request
POST /icweb.dll/bo/{tableName}/validate/{keyValue}

20.9.1.1 URI Parameters

Name In Re-
quired

Type Description

tableName Path Yes String Table Name of the business object
keyValue Path Yes Inte-

ger
For new rows (create) use 0, for existing rows (update) use the existing pri-
mary key value.

20.9.1.2 Request Body

This contains fields and values for the new/updated row. For simplicity, you should only include fields that have a value
other than null. You should also exclude any non-stored field, as these will be ignored.

Name Type Description Op-
tional

Default

{fieldName}Any Should contain the new value for the specified field, see
BusinessObjectField.

Yes You can omit a field if the
value is null.

20.9.1.3 Responses

Name Type Description
200 OK Validation Data OK
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20.9.2 Validation Data
Contains the data for a row validation requests. Including invalid fields, the overall validation status of each field, and
any updated values after the field actions have been executed.

Name Type Description Op-
tional

De-
fault

validationString Contains the validation status. vtOk, vtWarning, vtError. vtOk and vtWarning are
able to be submitted as a row request, vtError will be rejected by the rest service
if submitted as an update.

No null

invalidFieldsIn-
valid
Field
[]

Contains a list of any invalid fields, and the reason the field is invalid. No null

updateStatesUp-
date
Status
[]

No null

updateValuesUp-
date
Value
[]

Contains an array of field/values for any fields that need their values updated by
field action shortcuts. Fields omitted from this response are not changed by the
validation request.

No null

20.9.3 Invalid Field
Contains the data for an invalid field.

Name Type Description Op-
tional

De-
fault

field String Field name No null
state String State for the field, vtWarning or vtError. No null
message String Message containing why the field is invalid and how to resolve the issue, can

be shown to the user.
No null

20.9.4 Update Status
Contains the data for any changes to the state of a field, ie visible, read-only.

Name Type Description Op-
tional

De-
fault

fieldName String Name of the field. No null
readOnly Bool Is the field read-only, ie prevent the user from editing the field value. Yes False
visible Bool Is the field visible, ie it should be shown or hidden from the user editing

the form.
Yes True

20.9.5 Update Value
Contains the data for any changes to the value of a field.
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Name Type Description Op-
tional

De-
fault

{fieldName} Any Should contain the new value for the specified field, see BusinessOb-
jectField.

No null

20.10 Delete Row
Delete a single row from a business object.

ò Note

Some tables are read-only and cannot be modified. For more information, see Read-Only Tables.

20.10.1 HTTP Request
DELETE /icweb.dll/bo/{tableName}/{keyValue}

20.10.1.1 URI Parameters

Name In Required Type Description
tableName Path Yes String Table Name of the business object
keyValue Path Yes Integer Id of the row to be deleted

20.10.1.2 Responses

Name Type Description
204 No Content Row Deleted The server successfully processed the request, but is not returning any content.
404 Not Found No row found for specified keyValue
500 Error Error An error occurred details in Error object.

20.10.2 Example
20.10.2.1 Request

DELETE /icweb.dll/bo/Workpack/4

20.10.2.2 Response

204 No Content

20.11 Request Cookie Token
Requests the REST service generates a single use token to be emailed to the user to then request a permanent access
token.
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20.11.1 HTTP Request
GET /icweb.dll/security/requestCookieToken?{parameters}

20.11.1.1 URI Parameters

Name In Required Type Description
email Query Yes String Email address of existing user.

20.11.1.2 Responses

Name Type Description
200 OK OK
404 An attempt was made for an unknown email address.

20.11.2 Example
20.11.2.1 Request

GET /icweb.dll/security/requestCookieToken?email=joe.bloggs@nexusic.com

20.11.2.2 Response

200 OK

20.12 Validate Cookie Token
Validates a generated single use token, and if valid, responds with a permanent token lasting 90 days for subsequent
authorisation.

20.12.1 HTTP Request
GET /icweb.dll/security/validateCookieToken?{parameters}

20.12.1.1 URI Parameters

Name In Required Type Description
token Query Yes String Single-use token

20.12.1.2 Responses

Name Type Description
200 OK SecurityToken OK
401 An attempt was made to validate an invalid token.
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20.12.2 SecurityToken
Contains the permanent security token

Name Type Description Op-
tional

token String Permanent security token, that can then be used in subsequent REST api requests, ex-
pires in 90 days.

No

20.12.3 Example
20.12.3.1 Request

GET /icweb.dll/security/validateCookieToken?
→˓token=C45CB5E015A81801327672766615578D6B4C37D69BBB43D74C9A3E4907676CD1C53EADC408A6B41B2B58DD3A6B500A7D0898

20.12.3.2 Response

{
"token":

→˓"E05DEB57605BA82CD1A0C130B38C7BC1415BA094B28D73B03577B7CAB438834E6B680B437C85A65CA796AB6E7DC8545555CC
→˓"
}

20.13 Post Blob
Post a blob to the REST service, that can then be used in subsequent operations, such as adding library items, multi-
media, and importing.

If you attempt to add a blob, that already exists in the database, the request will return the existing blob id.

20.13.1 HTTP Request
POST /icweb.dll/postBlob

20.13.1.1 URI Parameters

None

20.13.1.2 Request Body

This contains the binary data for the blob.

20.13.1.3 Responses

Name Type Description
200
OK

Blob OK

403 Not authorised An attempt was made to upload a blob when you do not have permissions.
404.13 File exceeds maxi-

mum IIS size.
An attempt was made to upload a file larger than the IIS setting. See: https://msdn.
microsoft.com/en-us/library/ms689462%28VS.90%29.aspx

684 Chapter 20. REST Service Specifications v2.0

https://msdn.microsoft.com/en-us/library/ms689462%28VS.90%29.aspx
https://msdn.microsoft.com/en-us/library/ms689462%28VS.90%29.aspx


NEXUS Documentation, Release 6.9.xxxxx.0

20.13.2 Blob
The Blob object, contains information about the uploaded Blob.

Name Type Description Op-
tional

ExpiryDate
Time

Date and Time the blob will expire and be removed from the server if it has not be persisted
using another REST api.

No

Guid string Unique Identifier for this blob No
md5 string MD5 checksum for this blob to ensure that the server received the blob correctly, you should

check this against your local md5 and if it does not match, re-post the blob using another
request.

No

20.13.3 Example
20.13.3.1 Request

POST /icweb.dll/postBlob

20.13.3.2 Request Body

binary data

20.13.3.3 Response

{
"expiry": "2018-11-01T00:05:13.000Z",
"guid": "{69EA081E-84ED-4504-B15D-14BC7A020E49}",
"md5": "cf894da06f793ed73d841c72dd0bfde3"

}

20.13.3.4 Request

The guid can then be used to insert a row in Repository, passing the guid for the File_Data field.

PUT /icweb.dll/bo/Repository/0

20.13.3.5 Request Body

{
"UNC": "file.pdf"
"File_Data": "{69EA081E-84ED-4504-B15D-14BC7A020E49}"

}

20.13.3.6 Response

{
"rows":[{

"Guid":"{71DEE3A8-5BD9-4651-8807-3213A67AFF4E}",
"Repository_ID":1152,
"Cached":false,
"File_Checksum":"9a990adf862d59c4a21e5d12e8ef8f5c",

(continues on next page)
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"UNC":"20191122_113302.jpg",
"File_Size":4504068,
"RD_ID":213

}],
"key":96

}

20.14 Get Function Object
Get information about a NEXUS function from the REST service, that can then be used to call the function via REST
to execute.

20.14.1 HTTP Request
GET /icweb.dll/function/{functionName}

20.14.1.1 URI Parameters

Name In Re-
quired

Type Description

functionName |
functionKey

Path Yes String | Inte-
ger

Specify the function name or function key to be
returned.

20.14.1.2 Responses

Name Type Description
200 OK FunctionObject OK
403 Not authorised An attempt was made to access a function when you do not have permissions.

20.14.2 FunctionObject
The Function object, contains information about the function.

Name Type Description Op-
tional

name string Name of the function. No
key Integer Key value for this function, unique. No
resultTypeId Integer Result type of the result from executing this function. See Field

Types.
No

parameters FunctionParameter
[]

List of parameters for this function. No

20.14.3 FunctionParameter
The Function Parameter object, contains information about each parameter in a function.
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Name Type Description Op-
tional

De-
fault

name string Name of the parameter No
parameterTypeId Integer Result type of the result from executing this function. See Field

Types
No

allowsNull Boolean If this parameter allows a null input value Yes Yes

20.14.4 Example
20.14.4.1 Request

GET /icweb.dll/function/Compare A = B

20.14.4.2 Response

{
"name": "Compare A = B",
"key": 57,
"resultTypeId": 5,
"parameters": [{

"name": "A",
"parameterTypeId": 0

}, {
"name": "B",
"parameterTypeId": 0

}]
}

20.15 Execute Function
Execute a NEXUS function.

20.15.1 HTTP Request
POST /icweb.dll/function/{functionName}/?format={format}

20.15.1.1 URI Parameters

Name In Re-
quired

Type Description

functionName
|
functionKey

Path Yes String
| In-
teger

Specify the function name or function key to be executed .

format Path No String Possible values are value or png. value is the default if omitted, and ensures
the result of the function is returned. If png is specified then the result will be
a png containing the function preview with results.
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20.15.1.2 Request Body

This contains parameters and their values to use to execute the function. For simplicity, you should only include fields
that have a value other than null.

Name Type Description Op-
tional

Default

{parameterName}Any Should contain the new value for the specified
field, see FunctionParameter.

Yes You can omit a parameter if
the value is null.

20.15.1.3 Responses

Name Type Description
200 OK FunctionResult OK
200 OK image/png An image containing the function layout with results
403 Not authorised An attempt was made to access a function when you do not have permissions.

20.15.2 FunctionResult
The Function result, contains the result of the function execution, or if an error occurred the message.

Name Type Description Op-
tional

state string State of the function call, ok or error. No
value Any If state is ok then this will hold the result of the function execution. Yes
message String If state is error then this will contain the error message returned from the function. Yes

20.15.3 Example
20.15.3.1 Request

POST /icweb.dll/function/Compare A = B/

{
"A": 5,
"B": 3.4

}

20.15.3.2 Response

{
"state": "ok",
"value": false

}

20.15.3.3 Request

POST /icweb.dll/function/Compare A = B/?format=png
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{
"A": true
"B": 4

}

20.15.3.4 Response

20.16 Dashboards
Generate the data required to display a dashboard, response data contains all information required for displaying the
dashboard. The response may be quite large, depending on the dashboard that is requested. Charts especially may
contain a large number of points.

20.16.1 HTTP Request
GET /icweb.dll/dashboard/{key}

POST /icweb.dll/dashboard/{key}
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20.16.1.1 URI Parameters

Name In Required Type Description Default
key Path Yes Integer Key associated with dashboard.
parameters Body Yes Parameter [] List of parameters that the report requires. No

20.16.1.2 Responses

Name Type Description
200 OK Dashboard OK
404 Not Found String Dashboard identified by key was not found.

20.16.2 Dashboard
Contains the data associated with a dashboard, there is a name as well as a list of elements, each element identifies an
element in the dashboard, these elements are extensible, and can be customised by the user within NEXUS IC itself.

Name Type Description Optional
name string Name of the dashboard No
elements Dashboard Element [] List of elements in the dashboard. No

20.16.2.1 Dashboard Element

Specifies an element in the dashboard, each element contains some base configuration, but each element also contains
a data element, and the contains of this JSON object is based entirely on the type of dashboard element. Those
elements that you don’t understand can be skipped and not displayed.

Name Type Description Optional
caption string Caption used for the dash-

board element.
No

type string Specifies the type of ele-
ment this represents.

• table Table Ele-
ment

• chart Chart Ele-
ment

• paragraph Para-
graph Element

• section Section
Element

• image Image Ele-
ment

No

data object Contains the data associ-
ated with the element, this
is dependant on the ele-
ment type defined in type

No
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20.16.3 Table Element
Contains the data for a table, a table can be either a normal table, a vertical table or a pivot table. A table may not
have any columns, categories or rows, but will have at least columns or ``rows defined. It is assumed that the
columns and rows are in matched order, so the first item in each TableRow is the value for the first column.

Name Type Description Op-
tional

De-
fault

sourceBusinessObjectString If there are source rows for Table Row entries, then this will contain
the name of the business object that the key values are from.

Yes null

columns Table
Column
[]

Contains a list of columns for the table. Yes

categories Table
Category
[]

Contains a list of optional categories for the table columns, generally
this are output above the columns, grouping them together.

Yes

rows Table
Row []

Contains the rows of data for the table. Yes

20.16.3.1 Table Column

Name Type Description Op-
tional

De-
fault

caption String Caption for the column. No
alignment String Specifies the way the caption should be align, center, right, left. Yes left

20.16.3.2 Table Category

Name Type Description Op-
tional

De-
fault

caption String Caption for the column. No
spanColumns Inte-

ger
Number of columns this category spans. Yes 1

alignment String Specifies the way the caption should be align, center, right,
left.

Yes left

style Style Defines the style of this cell. Yes

20.16.3.3 Table Row

Name Type Description Op-
tional

De-
fault

cells Table Cell
[]

Contains the data for each of the cells of the Table Row. No

sourceKey Integer Contains the primary key for the source row applicable to this Ta-
ble Row.

Yes null
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20.16.3.4 Table Cell

Name Type Description Op-
tional

De-
fault

value String Contains the value for the column, if a datetime, contains an ISO 8601 for-
matted date/time. If the time is 00:00:00 it should be omitted from display.

No

alignment String Specifies the way the cell value should be align, center, right, left Yes left
style Style Defines the style of this cell. Yes
sourceBusinessObjectString If there are source rows for this Table Cell then this will contain the name of

the business object that the key values are from.
Yes null

sourceKey Inte-
ger
[]

Contains 0 or more primary key values for the source rows applicable to this
Table Cell.

Yes null

20.16.4 Image Element
Contains an embedded image, with a caption, should be displayed to the end-user with no interactivity.

Name Type Description Optional Default
type String Mime Type of format of image. No
image String Base64 encoded imaged No

20.16.5 Chart Element
Specifies the data that is produced when the dashboard element is a chart, a chart can be rendered as either a table of
data or a chart itself, decision should be made by the client. A chart element may contain more than 1 Chart, if more
than one is output then the Charts will take on the same structure, they will just contain a differing set of data.

Name Type Description Optional Default
charts Chart [] 1 or more charts defined in this Chart Element. No

20.16.6 Chart
Contains a the data for a single chart, for the Chart Element. Each chart can have 1 x and y axis, and then 1 or more
series. Eachs series will have a specific type, such as bar, line etc and contain the data for that series.

Name Type Description Op-
tional

De-
fault

x-axis Chart Axis Defines the x-axis for this chart. No
y-axis Chart Axis Defines the y-axis for this chart. No
series Chart Series

[]
Defines the series data for this chart. No

seriesSourcesChart Series
Source []

Defines the source data used for each of the chart series. No

zoomBar Boolean Determines if a zoombar is visible. Yes No
showCount string One of 3 values, none (don’t display count), series (display the count

per series) or chart (show total for all series).
Yes none
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20.16.7 Chart Axis
Chart Axis defines the specific axis for a chart, such as title and format of data.

Name Type Description Op-
tional

De-
fault

title String Title for the axis. Yes null
showTitle Bool Should the title be shown for this axis. Yes True
autoScale Bool Specifies whether this axis should auto-scale to fit the data. Yes True
scale Float When autoScale is False, then this contains the scale at which the axis

should display the data.
Yes null

format String Specifies the type of data in the axis, float, int, datetime, string. No
granulationInte-

ger
Where this is a risk chart, this specifies the number of sections on the axis
that have defined ticks.

No

labels String[] Specifies the labels of each section on the axis, used in conjunction with
granulation.

No

20.16.8 Chart Series
Contains the data for each chart series. A chart series is visually defined by the type that determines how the series
points should be displayed to the user.

Name Type Description Op-
tional

De-
fault

type String Type of Series, point, line, bezier, bar, gantt, verticalLine, horizontalLine, pie,
disjointedLine, histogram, shadedSection, polygon, minMax, average, standard-
Deviation, trendFirstLast, trendLastTwo, trendAll, leastSquares, heatMap

No null

id String Contains a global unique identifier to allow matching to the seriesSources
containing the source rows used to generate the series data.

No null

name String Name of the series, to be shown in any legend. Yes null
colour String Web Colour Yes null

(use
series
colour)

points Chart
Point
[]

Contains the series points to be displayed in the chart series. No

opacityFloat 0 to 1 determining the opacity of the point, 0 is completely transparent, 1 is not
transparent at all.

Yes 1

pointStyleString Style of points for series that have points, circle, square, diamond, cross Yes null
border Bool For points, should a border be painted. Yes True
pointSizeNum-

ber
Size of points, in pixels. Yes 1

lineWeightNum-
ber

Weight of lines, in pixels for series that draw lines. Yes 1

displayPointsBool For line series, do we show points for each point on the line. Yes False
shaded Bool Should the space between the line and where X = 0, be shaded. Yes False
showMeshBool For heatMap and contour series, should a mesh be shown. Yes False
ganttStyleString For Gantt charts, should it be painted as line or bar. Yes bar
shadeInsideString For shaded section series, should the shading occur between the bound lines, or

outside the bounding lines.
Yes False

gradientFloat For trend line chart series, this specifies the gradient of each line, if 0, then the
trend line is horizontal.

Yes 0
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20.16.9 Chart Point
Contains the data for each series point. Depending on the series type, it may contain different fields

Name Type Description Op-
tional

Default

opacity Float 0 to 1 determining the opacity of the point, 0 is completely trans-
parent, 1 is not transparent at all.

Yes 1

label String Point Label Yes null
id Number Unique key for this point in this series. Yes 0
colour String Web Colour Yes null (use series

colour)
x Float X-Value Yes null
y Float Y-Value Yes null
z Float Z-Value Yes null
x2 Float Secondary X-Value Yes null
y2 Float Secondary Y-Value Yes null
z2 Float Secondary Z-Value Yes null
coordinatesCoordi-

nate []
Polygon series require an array of X,Y points to plot the polygon. Yes null

20.16.10 Chart Series Source
Contains the data for the raw data used to generate the chart series.

Name Type Description Op-
tional

De-
fault

seriesIdString Series identifier to match to the chart series No
sourcesChart

Point
Source []

Contains a list of sources for each point. This may not contain an item for
each point in the chart series if the source isn’t able to be determined.

Yes null

20.16.11 Chart Point Source
Contains the data for a single point in a chart series. To match a chart point to a point source, the seriesId and pointId
need to both match to first find the Chart Series Source and then the corresponding Chart Point Source

Name Type Description Op-
tional

De-
fault

pointId Number Id of the point this source corresponds to. No
sourceBusinessObjectString Name of the business object the sourceKey are contained

in.
No

sourceKey Number
[]

List of 0 or more keys that were used to generate the chart
series point.

Yes null

20.16.12 Coordinate
Simple array of X,Y coordinates for polygon series.
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Name Type Description Optional Default
x Float X-Value Yes null
y Float Y-Value Yes null

20.16.13 Paragraph Element
A paragraph element contains text, generally it does not have a title for the dashboard element, the text may be formatted.
It may contain 1 or more paragraphs within it.

Name Type Description Optional Default
text Paragraph Text [] Contains the values for the paragraph. No

20.16.14 Paragraph Text
Specifies text within a paragraph, including any styling.

Name Type Description Optional Default
value String Contains a text string for a paragraph. Yes
color String Contains a web colour in #AARRGGBB form. Yes
alignment String Alignment, left, center, right. Yes left
text-bold Bool Determines if the text is bold. Yes False
text-underline Bool Determines if the text is underlined. Yes False
text-italic Bool Determines if the text is italic. Yes False
text-size Bool Determines the point size of the text Yes

20.16.15 Section Element
Specifies a new section starts in the elements, allowing the section to define the number of columns the elements are
displayed in

Name Type Description Op-
tional

De-
fault

columns Inte-
ger

Number of columns the elements should be split into. Columns are consumed,
top to bottom, left to right.

Yes 1

20.16.16 Style
Specifies style of an element.text within a paragraph, including any styling.
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Name Type Description Op-
tional

Default

color String Contains a web colour in #AARRGGBB form. Yes
alignment String Alignment, left, center, right. Yes left
text-bold Bool Determines if the text is bold. Yes False
text-underlineBool Determines if the text is underlined. Yes False
text-italic Bool Determines if the text is italic. Yes False
text-size Bool Determines the point size of the text Yes
background-colorString Contains a web colour in #AARRGGBB form. Yes
font-name String Contains the name of the font to be used. Yes
space-before String Number of pixels before element. Yes
space-after String Number of pixels after element. Yes
padding-left String Number of pixels inside the element on the left before content. Yes
padding-right String Number of pixels inside the element on the right after content. Yes
vertical-alignString Vertical alignment of element (top, middle, bottom). Yes top
text-orientationString Orientation of text (leftToRight, topToBottom, bottomToTop). Yes left-

ToRight
border-xxx-colorString Colour of the border in web format (xxx is left, top, right, bottom,

inner-vert, inner-horz).
Yes

border-xxx-widthString Width of the border in pixels (xxx is left, top, right, bottom, inner-
vert, inner-horz)

Yes

20.16.17 Example
Generate and return the dashboard for the dashboard identified by the key of 3

20.16.17.1 Request

GET /icweb.dll/dashboard/3

20.16.17.2 Response

{
"name": "Test Dashboard",
"elements": [{

"type": "section",
"data": {

"columns": 2
}

}, {
"type": "table",
"caption": "Workpack Listing",
"data": {

"columns": [{
"caption": "Name"

}, {
"caption": "Description"

}, {
"caption": "Read Only"

}, {
"caption": "Actual Start",

(continues on next page)
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(continued from previous page)

"alignment": "right"
}, {

"caption": "Hours (per day)",
"alignment": "center"

}, {
"caption": "Workpack Group"

}
],
"rows": [{

"cells": [{
"value": "Workpack A"

}, {
"value": "This is the␣

→˓description for WA"
}, {

"value": "No"
}, {

"value": "2019-08-
→˓26T00:00:00.000Z",

"alignment": "right"
}, {

"value": "8",
"alignment": "center"

}, {
"value": "Group A"

}
]

}, {
"cells": [{

"value": "Workpack B"
}, {

"value": "This is the␣
→˓description for WB"

}, {
"value": "No"

}, {
"value": "2019-08-

→˓26T00:00:00.000Z",
"alignment": "right"

}, {
"value": "6",
"alignment": "center"

}, {
"value": "Group B"

}
]

}
]

}
}, {

"type": "paragraph",
"data": {

(continues on next page)
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(continued from previous page)

"text": [{
"value": "The above table displays all␣

→˓workpacks.\r",
"color": "#0055FF3A",
"alignment": "center",
"text-bold": true

}, {
"value": "There should be 2 workpacks in␣

→˓this test."
}

]
}

}, {
"type": "image",
"caption": "Drawing Details",
"data": {

"type": "image\/png",
"image": "iVBORw0KGgoAAAANSUh..."

}
}, {

"type": "chart",
"caption": "Test Chart",
"data": {

"charts": [{
"x-axis": {

"title": "Anomaly Code",
"format": "label"

},
"y-axis": {

"title": "Count",
"format": "integer"

},
"series": [{

"id": "{860BF005-A81D-
→˓45A9-B57E-7F0497347442}",

"type": "pie",
"name": "Anomaly Code",
"points": [{

"label":
→˓"C3",

"id": 3,
"x": 3,
"y": 1

}, {
"label":

→˓"C2",
"id": 2,
"x": 2,
"y": 2

}, {
"label":

→˓"C1",

(continues on next page)
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(continued from previous page)

"id": 1,
"x": 1,
"y": 3

}
]

}
],
"seriesSources": [{

"seriesId": "{860BF005-
→˓A81D-45A9-B57E-7F0497347442}",

"sources": [{
"pointId

→˓": 3,

→˓"sourceBusinessObject": "Anomaly",

→˓"sourceKey": [6]
}, {

"pointId
→˓": 2,

→˓"sourceBusinessObject": "Anomaly",

→˓"sourceKey": [4, 5]
}, {

"pointId
→˓": 1,

→˓"sourceBusinessObject": "Anomaly",

→˓"sourceKey": [1, 2, 3]
}

]
}

]
}

]
}

}
]

}

20.17 Report Details
Request information about a report, including the parameters the report requires to be executed.

Only available to hosted SaaS clients
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20.17.1 HTTP Request
GET /icweb.dll/report/{key}

20.17.1.1 URI Parameters

Name In Required Type Description Default
key Path Yes Integer Key associated with report.

20.17.1.2 Responses

Name Type Description
200 OK Report OK
404 Not Found String Dashboard identified by key was not found.

20.17.2 Report
Contains the information associated with a report.

Name Type Description Op-
tional

name string Name of the report No
parameters Parameter

[]
List of parameters that the report requires. No

excludable Excludable Defines the elements in the report that can be excluded from being gen-
erated

Yes

20.17.2.1 Parameter

Specifies a parameter for a report, a report may have 0 or more parameters, these parameters contain information on
allowing the user to select or enter an appropriate value.
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Name Type Description Op-
tional

De-
fault

parameterNamestring Name of the parameter. No
displayNamestring Display caption used when displaying the parameter to the user for them to

enter/select a value.
No

order inte-
ger

Display order of the parameter. No

columns inte-
ger

The number of display columns that this column consumes, report parame-
ters should be displayed in a 2 column form.

No 1

blankText string Text that can be used, in a greyed-out embedded in the control for the pa-
rameter.

Yes

fieldType Inte-
ger

Field Type of the parameter, determines what data can be entered by the user. No

editorType Inte-
ger

Editor that should be used for the parameter. No

foreignTableInte-
ger

If this is a foreign key, then this specifies the table that should be used to
provide a selection dialog.

Yes

multiSelectBooleanDoes this parameter allow multiple values to be selected. No No
lookupList Inte-

ger
Specifies the key of the lookup list to use, if fieldType is a lookup list. No No

required BooleanIs a value required to be provided for this report parameter. No True
previousValueAny Contains the previously selected value from the last time this report was

executed.
Yes Null

20.17.2.2 Excludable

Specifies a report element that may be excluded and defines children that may also be excluded.

Name Type Description Op-
tional

De-
fault

name string Name of the report element. No
descriptionstring Description of the report element. No
canExcludebool True if the element can be excluded from the report No
key integer Key associated with the element, when excluding elements from a report

job, this key should be specified.
No

elements Exclud-
able []

List of child elements that may be excluded. Yes

20.17.3 Example
Retrieve the name and parameters for the report identified by the key of 3

20.17.3.1 Request

GET /icweb.dll/report/3

20.17.3.2 Response

{
"name": "Test Report",
"parameters": [{

(continues on next page)
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(continued from previous page)

"parameterName": "Component_ID",
"displayName": "Asset",
"order": 0,
"columns": 1,
"fieldType": 3,
"editorType": 13,
"foreignTable": "Component",
"multiSelect": true,
"previousValue": 2

}, {
"parameterName": "Workpack_ID",
"displayName": "Workpack",
"order": 0,
"columns": 1,
"fieldType": 3,
"editorType": 13,
"foreignTable": "Workpack",

}
],
"excludable": {

"name": "Test Report",
"canExclude": false,
"key": 9,
"elements": [{

"name": "Repeat Assets",
"canExclude": false,
"key": 10,
"elements": [{

"name": "Tasks",
"canExclude": true,
"key": 11,
"elements": []

}
]

}
]

}
}

20.18 Report
Submit a job to generate a report template.

Only available to hosted SaaS clients

20.18.1 HTTP Request
POST /icweb.dll/report/
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20.18.1.1 URI Parameters

Name In Re-
quired

Type Description De-
fault

reportTemplateBody Yes In-
te-
ger

Key associated with report.

outputTypeBody No String Format that the report should be generated in, JSON, html, xlsx, rtf are ac-
cepted types.

JSON

excludedGroups
[]

Body No In-
te-
ger

Contains a list of groups (obtained from Excludable) to exclude from report
generation.

recipientsBody No String List of comma separated email address to send the report to, if omitted then
the report isn’t emailed and is available for download.

embedHtmlBody No BooleanIf outputType is ‘html’ and recipients contains a valid email address,
then this determines whether the html report is sent as the body of the email
(true) or as an attachment (false).

False

subject Body No String Subject used in the email generated if the report is sent to recipients.
parametersBody No JSON A JSON object of all the parameter values used in the report.

20.18.1.2 Responses

Name Type Description
200
OK

Server Job Report job created, response contains information on the job.

400 Validation Er-
ror

Configuration provided for report is invalid, further information on what part was invalid
is provided.

404 Not found The specified reportTemplate was not found.

20.18.2 Example
Ask the server to generate the report identified by the key of 3, using the values of the passed parameters

20.18.2.1 Request

POST /icweb.dll/report

{
"reportTemplate": 3,
"outputType": "html"
"parameters": [{

"parameterName": "Component_ID",
"value": [4, 3]

}, {
"parameterName": "Workpack_ID",
"value": 35

}
]

}
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20.18.2.2 Response

{
"id": "{7945AE0D-BB7D-4D7C-AF68-175C74CF02D5}",
"percentComplete": 0

}

20.19 Import

20.19.1 Contents
Asks the server to enumerate the files in a compressed zip file that was uploaded for importing.

Only available to hosted SaaS clients

20.19.1.1 HTTP Request

To retrieve files in an archive:

POST /icweb.dll/import/contents/{file}

20.19.1.1.1 Request Body

Contains information on how to parse the import file to detect the columns.

Name Required Type Description Default
file Yes String Specifies the import file previously uploaded.

20.19.1.1.2 Responses

Name Type Description
200
OK

Files Contains a list of files found in the uploaded file.

400 Validation Er-
ror

Configuration provided for import is invalid, further information on what part was invalid
is provided.

404 Not found The blob id was not found.

20.19.1.2 Files

The Files object, contains a list of files in the uploaded archive.

Name Type Description Optional
files string [] List of files found in the uploaded archive. No

20.19.2 Detect Columns
Asks the server to detect the columns in the import sheet, the server will attempt to match each column with an asso-
ciated business object field. A base business object needs to be specified.

Only available to hosted SaaS clients
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20.19.2.1 HTTP Request

To retrieve detected columns from import file:

POST /icweb.dll/import/columns

20.19.2.1.1 Request Body

Contains information on how to parse the import file to detect the columns.

Name Re-
quired

Type Description De-
fault

file Yes String Specifies the import file previously uploaded.
files Yes String[] Specifies a number of import files that have previously been uploaded. This can

be used instead of file where there are multiple zip files (exceeding 500mb)
to allow larger uploads.

fileName No String If the import file was a zip file, this specifies a file within the zipfile that is used
as the import file. (Where multiple zipfiles are specified in files this file can
be in any of them)

businessObjectYes String The base business object for the server to use to perform column detection with.
The server will attempt to match columns in this table first.

headerRowsYes Inte-
ger

The number of rows that relate to column headers in the import file. 1

delimiterYes String Column delimiter ‘,’
qualifierYes String String qualifier to denote start/end of strings, possible values, ‘quote’, ‘double-

Quote’, ‘none’
quote

consecutiveAsOneNo Boolean Treat consecutive delimiter as a single delimiter. False
columnMapsNo Col-

umn
Map
[]

Contains a list of desired column mappings as a starting point for the detection
of further columns, and/or receiving a list of required fields for these mappings.

[]

ignoreColumnsNo inte-
ger[]

List of column indexes from source file that should be ignored. Yes

ignoreBlanksNo Boolean Lets the importer know whether to ignore blank cells from the import sheet and
not modifying existing data, or (the default) when a blank is found, to set the
existing data to null.

False

20.19.2.1.2 Responses

Name Type Description
200
OK

Import
Columns

Contains a list of columns detected in the import sheet, mappings that are detected based on
those columns as well as required fields.

400 Validation
Error

Configuration provided for import is invalid, further information on what part was invalid is
provided.

404 Not found Either the blob id was not found or the businessObject specified was not found.

20.19.2.2 Import Columns

The Import Columns object, contains information about the auto-detected columns from the import sheet, as well as a
list of column maps to business object fields that have been detected.
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Name Type Description Op-
tional

sourceColumnsSource
Column []

List of columns detected No

columnMapsColumn
Map []

List of column maps detected No

requiredFieldsRequired
Field []

List of fields that are required to be provided, either via a static value, or a
mapping for the import, based on other fields that have been mapped.

Yes

ignoreColumnsinteger[] List of column indexes from soure file that should be ignored. Yes
preview Source

Row []
Contains at most 50 rows from the source row, converted to a json object. No

commonFieldsCommon
Category []

This contains a list of common fields that can be used as a destination for column
mappings.

No

20.19.2.3 Source Column

The source column object, contains information about the columns detected in the import sheet.

Name Type Description Op-
tional

columnIndexIn-
te-
ger

Column index, 0 is the first, left-most column. No

columnNamestring Name of the column that was detected from the header rows, where there are no header
rows in the import sheet, this will be blank.

Yes

20.19.2.4 Column Map

Contains information to map a column in the import sheet, with a business object field.

Name Type Description Op-
tional

businessObjectstring Name of the business object No
fieldNamestring Field name of the field to map this column to. No
path string Path to join from the base businessObject to the destination businessObject. Effectively when

businessObject is not in the base table, NEXUS may not be able to correctly determine a path
to the destination field. path helps NEXUS decide on the best path to join between the
businessObjects.

Yes

columnIndexIn-
te-
ger

Column index, 0 is the first, left-most column. Yes

staticValueany This will provide a static value for the business object to be imported with, use this instead of
a columnIndex to provide the same value to be imported for each row created in the business
object.

Yes

optionalBooleanDetermines if this field mapping should create a row, a new row won’t be inserted if it only
contains values for ‘optional’ field mappings, default value is False.

Yes
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20.19.2.5 Required Field

Contains information about fields that are required to be provided, either by a column mapping or static value for the
import to succeed.

Name Type Description Optional
businessObject string Name of the business object No
fieldName string Field name of the field to map this column to. No
isMapped Boolean Specifies if a mapping exists for this field, default False Yes

20.19.2.6 Source Row

Contains a preview of up to 50 rows from the source row, as parsed using the submitted settings.

Each column will have a property in the JSON object, the name of the JSON pair will be columnX, where X is a zero
based index, and the value will be of type string and contain the raw characters from the source file.

20.19.2.7 Common Category

Contains a list of categories, and a list of business objects and fields for each category.

Name Type Description Optional
category string Name of the category of business objects. No
businessObjects Common BusinessObject [] Details on each business object in this category. No

20.19.2.8 Common BusinessObject

Contains a reference to a business object, and a list of fields in that business object that can be chosen as a destination
field map for importing.

Name Type Description Op-
tional

name string Display Name of the business objects. No
businessObject string Name of the business objects. No
fields Common Field [] Details on field that can be imported to in this business object. No

20.19.2.9 Common Field

Contains a reference to a field in a business object.

Name Type Description Optional
fieldName string Field Name No
name string Display Name of the field, not returned if it is the same as fieldName. Yes
path string Path helper for the import, to return if this column is provided. Yes

20.19.3 Import
Import data into 1 or more tables from a previously posted blob, the blob must be a text file containing data in a tabulated
format, such as TSV or CSV.

Only available to hosted SaaS clients
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20.19.3.1 HTTP Request

To start a new import job:

POST /icweb.dll/import

To retrieve detail on an existing import job, see Job Status

20.19.3.1.1 URI Parameters

Name In Re-
quired

Type Description

fileId Path Yes String Specifies the import file previously uploaded.
fileName Path No String If the import file was a zip file, this specifies a file within the zipfile that is used

as the import file.

20.19.3.1.2 Request Body

This contains parameters for how to import the the data from the blob.
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Name Type Description Optional De-
fault

file String Contains an identifier previously returned by a
Post Blob call.

No

fileNameString Where the blob is a compressed zipfile containing
multiple files, this is the name of the actual text
file containing the import data.

Yes null

businessObjectString Name of the primary business object that the im-
port is to be performed on. This forms the basis
of the rows in the text file, other objects can be
mapped using column mappings.

No

dateFormatString Date format used when converting dates in the
import sheet, acceptable values: ‘dd/MM/yyyy’,
‘MM/dd/yyyy’, ‘yyyy/MM/dd’, ‘dd-MM-yyyy’,
‘MM-dd-yyyy’, ‘yyyy-MM-dd’.

Yes yyyy/mm/dd

timeFormatString Time format used when converting times in
the import sheet, acceptable values: ‘hh:nn:ss
AM’, ‘HH:nn:ss’, ‘HH:nn:ss.zzz’, ‘hh:nn AM’,
‘HH:nn’.

Yes HH:nn:ss

timeZoneOffsetString Timezone offset of date/times when being im-
ported, a shift will be performed to convert it to
UTC for Date & Time fields, Date or Time fields
won’t have any conversion performed.

Yes 0

headerRowsIn-
te-
ger

The number of rows that relate to column headers
in the import file.

Yes 1

delimiterString Column delimiter Yes ,
qualifierString String qualifier to denote start/end of strings, pos-

sible values, ‘quote’, ‘doubleQuote’, ‘none’
Yes quote

consecutiveAsOneNo Boolean Treat consecutive delimiter as a single de-
limiter.

False

startRowIn-
te-
ger

Start row of data to import, row numbers start at
0, after the header rows. So if there are 2 header
rows, and the 3rd line in the file is the first data
row, that is considered row 0.

Yes 0

endRowIn-
te-
ger

End row of data to import, omit this field to import
until the end of rows. The importer determines the
end of rows by either the end of file, or a blank line.

Yes

columnMapsCol-
umn
Map
[]

List of columns for the import sheet, mapping
to business object fields. This is optional, and
recommended that you rely on the auto-detect
columns, and only pass column maps you want to
override in the detection.

Yes

ignoreColumnsin-
te-
ger[]

List of column indexes from soure file that should
be ignored.

Yes

ignoreBlanksNo Boolean Lets the importer know whether to ignore
blank cells from the import sheet and not
modifying existing data, or (the default)
when a blank is found, to set the existing
data to null.

False

test BooleanRun a test of the import as a job. Yes False
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20.19.3.1.3 Responses

Name Type Description
200
OK

Server Job Import job created, response contains information on the job.

400 Validation Er-
ror

Configuration provided for import is invalid, further information on what part was invalid
is provided.

404 Not found Either the blob id was not found or the businessObject specified was not found.

20.19.3.2 Example

Example to submit an import job for the Task business object.

20.19.3.2.1 Request

POST /icweb.dll/import

20.19.3.2.2 Request Body

{
"file": "{69EA081E-84ED-4504-B15D-14BC7A020E49}",
"businessObject": "Task",
"qualifier": "quote",
"dateFormat": "dd/mm/yyyy",
"timeFormat": "HH:mm:ss"

}

20.19.3.2.3 Response

{
"id": "{7945AE0D-BB7D-4D7C-AF68-175C74CF02D5}",
"percentComplete": 0

}

An example to detect the columns in a CSV file, using Header as the base business object.

POST /icweb.dll/importColumns`

20.19.3.2.4 Request Body

{
"file": "{A29C4D22-214C-4DD6-9ED1-8F7FE084E1AA}",
"fileName": "Rest - Multi Header - Events - Multimedia.csv",
"businessObject": "Header",
"headerRows": 1

}
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20.19.3.2.5 Response

{
"columnMaps": [{

"businessObject": "View_Node",
"fieldName": "Full_Location",
"columnIndex": 0

}, {
"businessObject": "View_Node",
"fieldName": "Full_Location",
"columnIndex": 1

}, {
"businessObject": "Comp_Type",
"fieldName": "Name",
"path": "Component",
"columnIndex": 2

}, {
"businessObject": "Workpack",
"fieldName": "Name",
"columnIndex": 3

}, {
"businessObject": "Table_Def",
"fieldName": "Name",
"path": "TD_ID",
"columnIndex": 4

}, {
"businessObject": "EVT_Span",
"fieldName": "Length",
"columnIndex": 5

}, {
"businessObject": "SDT_STD_KP",
"fieldName": "KP",
"path": "Start_Clock_SD_ID",
"columnIndex": 6

}, {
"businessObject": "SDT_STD_KP",
"fieldName": "KP",
"path": "End_Clock_SD_ID",
"columnIndex": 7

}, {
"businessObject": "Multimedia",
"fieldName": "Name",
"columnIndex": 8

}, {
"businessObject": "Repository",
"fieldName": "UNC",
"path": "Multimedia",
"columnIndex": 9

}
],
"sourceColumns": [{

"columnName": "Asset Location.Full Location",
"columnIndex": 0

(continues on next page)
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(continued from previous page)

}, {
"columnName": "Asset Location.Full Location",
"columnIndex": 1

}, {
"columnName": "Asset.Asset Type",
"columnIndex": 2

}, {
"columnName": "Workpack.Name",
"columnIndex": 3

}, {
"columnName": "Event.Event Type",
"columnIndex": 4

}, {
"columnName": "Span.Length",
"columnIndex": 5

}, {
"columnName": "Start - Survey - Pipeline.KP",
"columnIndex": 6

}, {
"columnName": "End - Survey - Pipeline.KP",
"columnIndex": 7

}, {
"columnName": "Multimedia.Name",
"columnIndex": 8

}, {
"columnName": "Multimedia.Image",
"columnIndex": 9

}
],
"requiredFields": [{

"businessObject": "View_Node",
"fieldName": "CV_ID"

}, {
"businessObject": "EVT_Span",
"fieldName": "Header_ID",
"isMapped": true

}, {
"businessObject": "Multimedia",
"fieldName": "Name",
"isMapped": true

}
],
"commonFields": [{

"category": "Event",
"businessObjects": [{

"businessObject": "EVT_Span",
"name": "Span",
"fields": [{

"fieldName": "Length"
}

]
}

(continues on next page)
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(continued from previous page)

]
}, {

"category": "Continuous Event",
"businessObjects": [{

"businessObject": "EVT_Pipeline_Profile",
"name": "PL - Profile",
"fields": [{

"fieldName": "Top_Of_Pipe",
"name": "Top of Pipe"

}, {
"fieldName": "Bottom_Of_Pipe",
"name": "Bottom of Pipe"

}, {
"fieldName": "Left_Seabed",
"name": "Left Seabed"

}, {
"fieldName": "Right_Seabed",
"name": "Right Seabed"

}
]

}
]

}, {
"category": "Sub Event",
"businessObjects": [{

"businessObject": "SET_Cross_Profile",
"name": "PL - Cross Profile",
"fields": [{

"fieldName": "Header_ID"
}, {

"fieldName": "X"
}, {

"fieldName": "Y"
}

]
}

]
}, {

"category": "System Table",
"businessObjects": [{

"businessObject": "Commentary",
"name": "Commentary",
"fields": [{

"fieldName": "Header_ID",
"name": "Event"

}, {
"fieldName": "Notes"

}
]

}, {
"businessObject": "Signoff",
"name": "Event Review",

(continues on next page)
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(continued from previous page)

"fields": [{
"fieldName": "Signed",
"name": "Date \/ Time"

}, {
"fieldName": "Description"

}, {
"fieldName": "SU_ID",
"name": "Personnel"

}
]

}, {
"businessObject": "Finding",
"name": "Finding",
"fields": [{

"fieldName": "Finding_ID"
}, {

"fieldName": "Header_ID",
"name": "Event"

}, {
"fieldName": "Anomaly_ID",
"name": "Anomaly"

}, {
"fieldName": "Bound_ID",
"name": "Trigger"

}, {
"fieldName": "Code_ID",
"name": "Code"

}, {
"fieldName": "Is_Bound",
"name": "Is Auto Generated"

}, {
"fieldName": "Remedial_Action",
"name": "Remedial Action"

}, {
"fieldName": "Anomaly_Required",
"name": "Anomaly Required"

}, {
"fieldName": "Severity_ID",
"name": "Severity"

}, {
"fieldName": "Reason"

}, {
"fieldName": "Is_Finding_Reviewed

→˓",
"name": "Is Finding Reviewed"

}, {
"fieldName": "Finding_Number",
"name": "Finding Number"

}, {
"fieldName": "Has_Comments",
"name": "Has Review Comments"

}

(continues on next page)
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]
}, {

"businessObject": "View_Node",
"name": "Asset Location",
"fields": [{

"fieldName": "CV_ID",
"name": "Asset View"

}, {
"fieldName": "Component_ID",
"name": "Asset"

}, {
"fieldName": "Is_Dynamic",
"name": "Is Dynamic"

}, {
"fieldName": "Dynamic_Filter",
"name": "Dynamic Filter"

}, {
"fieldName": "Link_ID",
"name": "Parent"

}
]

}, {
"businessObject": "BookMark",
"name": "Bookmark",
"fields": [{

"fieldName": "Header_ID",
"name": "Event"

}, {
"fieldName": "Description"

}
]

}, {
"businessObject": "Multimedia",
"name": "Multimedia",
"fields": [{

"fieldName": "Name"
}, {

"fieldName": "Can_Report",
"name": "Can Report"

}, {
"fieldName": "Repository_ID",
"name": "Image"

}, {
"fieldName": "X"

}, {
"fieldName": "Y"

}, {
"fieldName": "pppX",
"name": "Pixels per Point (X)"

}, {
"fieldName": "pppY",
"name": "Pixels per Point (Y)"

(continues on next page)
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(continued from previous page)

}
]

}
]

}, {
"category": "Survey Data",
"businessObjects": [{

"businessObject": "SDT_STD_KP",
"name": "Survey - Pipeline",
"fields": [{

"fieldName": "KP"
}

]
}, {

"businessObject": "SDT_STD_NORM",
"name": "Survey - Standard",
"fields": [{

"fieldName": "Easting"
}, {

"fieldName": "Northing"
}, {

"fieldName": "Depth"
}, {

"fieldName": "Elevation"
}

]
}, {

"businessObject": "SDT_STD_KP",
"name": "Survey - Pipeline",
"fields": [{

"fieldName": "KP"
}

]
}, {

"businessObject": "SDT_STD_NORM",
"name": "Survey - Standard",
"fields": [{

"fieldName": "Easting"
}, {

"fieldName": "Northing"
}, {

"fieldName": "Depth"
}, {

"fieldName": "Elevation"
}

]
}

]
}

],
"preview": [{

"Column0": "Pipelines",

(continues on next page)
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"Column1": "10\" Production Pipeline",
"Column2": "Flexible Pipe",
"Column3": "2012 ILI Inspection",
"Column4": "Span",
"Column5": "0.012",
"Column6": "3.56",
"Column7": "3.61",
"Column8": "Logo",
"Column9": "Logo.png"

}, {
"Column0": "Pipelines",
"Column1": "10\" Production Pipeline",
"Column2": "Flexible Pipe",
"Column3": "2012 ILI Inspection",
"Column4": "Span",
"Column5": "0.0253",
"Column6": "3.77",
"Column7": "3.78",
"Column8": "",
"Column9": ""

}, {
"Column0": "Pipelines",
"Column1": "10\" Production Pipeline",
"Column2": "Flexible Pipe",
"Column3": "2012 ILI Inspection",
"Column4": "Span",
"Column5": "0.0043",
"Column6": "4.8",
"Column7": "4.93",
"Column8": "WGIM",
"Column9": "wgim.bmp"

}, {
"Column0": "Pipelines",
"Column1": "10\" Production Pipeline",
"Column2": "Flexible Pipe",
"Column3": "2012 ILI Inspection",
"Column4": "Span",
"Column5": "0.122",
"Column6": "7.12",
"Column7": "7.35",
"Column8": "",
"Column9": ""

}, {
"Column0": "Pipelines",
"Column1": "10\" Production Pipeline",
"Column2": "Flexible Pipe",
"Column3": "2012 ILI Inspection",
"Column4": "Span",
"Column5": "",
"Column6": "7.42",
"Column7": "7.85",
"Column8": "",

(continues on next page)
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"Column9": ""
}, {

"Column0": "",
"Column1": "",
"Column2": "",
"Column3": "",
"Column4": "",
"Column5": "",
"Column6": "",
"Column7": "",
"Column8": "",
"Column9": ""

}
]

}

20.20 Job Status
Request information about a job, including current progress. If no id is supplied a list of all jobs for the user are returned.

Only available to hosted SaaS clients

20.20.1 HTTP Request
GET /icweb.dll/jobStatus/{Id}

20.20.1.1 URI Parameters

Name In Re-
quired

Type Description

id Path No String Specifies the job to retrieve the Server Job object for, containing the current
progress.

20.20.1.2 Responses

Name Type Description
200 OK Server Job When an individual job is requested.
200 OK Server Jobs When all jobs are requested.
404 Not Found String Job identified by id was not found.

20.20.2 Server Jobs
The Server Jobs object, contains information about the jobs the user has initiated.

Name Type Description Optional
jobs Server Job [] An array of jobs that are associated with the current user. No
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20.20.3 Server Job
The Server Job object, contains information about the job that was specified.

Name Type Description Op-
tional

De-
fault

id string Unique Identifier for this job, can be used to request updated information
on status.

No

percentCompletein-
te-
ger

0 - 100 percent complete of the job. Yes 0

summary string Contains a summary of the job, thus far. Yes Un-
avail-
able

status in-
te-
ger

Current status of the job, 1 = Waiting to Start, 2 = Starting, 3 = Running,
4 = Completed, 5 = Failed, 6 = Paused

No

startClock String Date and time the job started. Yes False
endClock String Date and time the job finished. Yes False
dismissed bool Has this job been dismissed by the user. Yes False
canDismiss bool Can this job be dismissed? Yes False

Note under some circumstances, the percentComplete value returned may exceed 100. This is caused by NEXUS
underestimating the total row count at the commencement of the generation job.

20.20.4 Example
Retrieve the job status, with the id of ‘{FAAF7FBC-0475-45ED-A148-02238E75C395}’.

20.20.4.1 Request

GET /icweb.dll/jobStatus/{FAAF7FBC-0475-45ED-A148-02238E75C395}

20.20.4.2 Response

{
"id": "{FAAF7FBC-0475-45ED-A148-02238E75C395}",
"percentComplete": 35,
"summary": "",
"status": 3

}

20.20.5 Example
Retrieve all jobs the user has initiated.

20.20.5.1 Request

GET /icweb.dll/jobStatus
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20.20.5.2 Response

{
"jobs": [{

"id": "{DD89258A-F8FD-4629-9B7E-569EDA31387E}",
"percentComplete": 100,
"status": 4

}, {
"id": "{D561361F-FD3A-492A-AE35-B6B77B28B2E0}",
"percentComplete": 100,
"status": 4

}
]

}

20.21 Job Dismiss
Dismiss a job so that it is no longer showon in the UI of NEXUS IC or IC-Web.

Only available to hosted SaaS clients

20.21.1 HTTP Request
GET /icweb.dll/jobDismiss/{Id}

20.21.1.1 URI Parameters

Name In Required Type Description
id Path Yes String Specifies the job dismiss.

20.21.1.2 Responses

Name Type Description
200 OK Job was successfully dismissed.
403 Forbidden Job is not able to be dismissed.
404 Not Found String Job identified by id was not found.

20.22 Job Content
Request the content from a completed job, some jobs may not provide any content.

Only available to hosted SaaS clients

20.22.1 HTTP Request
GET /icweb.dll/jobContent/{id}
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20.22.1.1 URI Parameters

Name In Re-
quired

Type Description

id Path Yes String Specifies the job to retrieve the content for. The content will be returned, pay im-
portant attention to the response type.

20.22.1.2 Responses

Name Type Description
200 OK Binary / Text - see mime type of response. OK
404 Not Found String Job identified by id was not found.

20.22.2 Example
Retrieve the job content, with the id of ‘{FAAF7FBC-0475-45ED-A148-02238E75C395}’.

20.22.2.1 Request

GET /icweb.dll/jobContent?id={FAAF7FBC-0475-45ED-A148-02238E75C395}

20.22.2.2 Response

content-type: application/json
content-disposition: attachment;filename="report.json"

{
"elements": [{

"type": "table",
"caption": "Table of Data",
"data": {

"sourceBusinessObject": "Task",
"columns": [{

"caption": "Asset"
}, {

"caption": "Event Type"
}, {

"caption": "Workpack"
}

],
"rows": [{

"sourceKey": 1,
"cells": [{

"value": "Test Asset"
}, {

"value": "GVI"
}, {

"value": "Workpack A"
}

]
(continues on next page)
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}, {
"sourceKey": 2,
"cells": [{

"value": "Test Asset"
}, {

"value": "GVI"
}, {

"value": "Workpack B"
}

]
}

]
}

}, {
"type": "paragraph",
"data": {

"text": [{
"value": "Report generated in 00:00:01"

}
]

}
}

]
}

20.23 License
Returns the license information for the current user.

20.23.1 HTTP Request
GET /icweb.dll/license

20.23.1.1 URI Parameters

None

20.23.1.2 Responses

Name Type Description
200 OK License OK

20.23.2 License
Contains the license information for the current user.
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Name Type Description Optional
license String readonly for a readonly only license, write for a write license No
risk Bool True if the user has a license to display the risk module. No
sensors Bool True if the user has a license to display the sensors module. No
saas Bool True if the user has a license to perform SaaS only functions. No
name String Display name of the current user. No
username String Username of the current user. No

20.23.3 Example
20.23.3.1 Request

GET /icweb.dll/license

20.23.3.2 Response

{
"license": "write",
"risk": true,
"sensors": true,
"saas": true,
"username": "bob.smith@here.com",
"name": "Bob Smith"

}

20.24 Settings
Request settings for a user.

20.24.1 HTTP Request
GET /icweb.dll/setting/{category}/{subCategory}/{identifier}/{source}

20.24.1.1 URI Parameters

Name In Re-
quired

Type Description

categoryPath No String Specifies the category to retrieve the Setting objects for. Common values: Form, Grid,
Options, Tree, Window.

subCategoryPath No String Specifies the sub category to retrieve the Setting objects for. Value here is related to
category, Form, Grid, Tree and Window usually use the subcategory relating to the
name of the business object. For example ‘Asset Location’.

identifierPath No String Specifies the identifier to retrieve the Setting objects for, identifier refers to the
specific item, such as focusedRow, layout, selectedItes, expandedNodes for grid/tree
category items.

sourcePath No String Specifies the source to retrieve the Setting objects for, source is used to differentiate the
setting on use. For example for Grid/Tree, a blank source refers to the defaults for that
Grid/Tree, ‘Selector’ is used in source when the Grid/Tree is within a selection dialog.
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20.24.1.2 Responses

Name Type Description
200 OK Setting [] One or more settings matching search criteriea.

20.24.2 Setting
The Setting object, contains information about the setting.

Name Type Op-
tional

Description

categoryString No Specifies the category of this setting, common values: Form, Grid, Options, Tree, Window.
subCategoryString No Specifies the sub category of this setting, value is related to category: Form, Grid, Tree and

Window usually use the subcategory relating to the name of the business object. For example
‘Asset Location’.

identifierString No Specifies the identifier of this setting, identifier refers to the specific item, such as fo-
cusedRow, layout, selectedItes, expandedNodes for grid/tree category items.

source String Yes Specifies the source to retrieve the Setting objects for, source is used to differentiate the setting
on use. For example for Grid/Tree, a blank source refers to the defaults for that Grid/Tree,
‘Selector’ is used in source when the Grid/Tree is within a selection dialog.

value String Yes Specifies the value for the setting. For complex settings this may contain JSON within a string,
that may have to be parsed.

defaultValueString Yes Specifies the default value for the setting. This is used if value is null.

20.24.3 Example
Retrieve the all settings for the Grid associated with ‘Anomaly’

20.24.3.1 Request

GET /icweb.dll/setting/Grid/Anomaly

20.24.3.2 Response

[{
"category": "Grid",
"subCategory": "Anomaly",
"identifier": "expandedNodes",
"value": "-1073741841,-1073741851"

}, {
"category": "Grid",
"subCategory": "Anomaly",
"identifier": "filters",
"value": "{}"

}, {
"category": "Grid",
"subCategory": "Anomaly",
"identifier": "focusedRow",
"value": "-1073741832"

}, {
"category": "Grid",

(continues on next page)
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"subCategory": "Anomaly",
"identifier": "groupedColumns",
"value": "Closed_Out,Code_ID"

}, {
"category": "Grid",
"subCategory": "Anomaly",
"identifier": "layout",
"value": "{\"columns\":[{\"fieldName\":\"AC_ID\",\"order\":19,\"visible\

→˓":false},{\"fieldName\":\"AS_ID\",\"order\":15,\"visible\":true},{\"fieldName\":\
→˓"Action_Overdue\",\"order\":21,\"visible\":false},{\"fieldName\":\"Action_Status\",\
→˓"order\":22,\"visible\":false},{\"fieldName\":\"Anomaly_ID\",\"order\":0,\"visible\
→˓":false},{\"fieldName\":\"Anomaly_No\",\"order\":13,\"visible\":true},{\"fieldName\":\
→˓"Asset_Location\",\"order\":3,\"visible\":false},{\"fieldName\":\"Asset_Type\",\"order\
→˓":7,\"visible\":true},{\"fieldName\":\"Assigned_To_ID\",\"order\":2,\"visible\":false},
→˓{\"fieldName\":\"CV_ID\",\"order\":1,\"visible\":false},{\"fieldName\":\"Closed_Out\",\
→˓"order\":9,\"visible\":true},{\"fieldName\":\"Code_ID\",\"order\":12,\"visible\":true},
→˓{\"fieldName\":\"Comments\",\"order\":20,\"visible\":false},{\"fieldName\":\"Component_
→˓ID\",\"order\":6,\"visible\":true},{\"fieldName\":\"Created_By_ID\",\"order\":18,\
→˓"visible\":true},{\"fieldName\":\"Date_Created\",\"order\":17,\"visible\":true},{\
→˓"fieldName\":\"Date_Found\",\"order\":23,\"visible\":false},{\"fieldName\":\
→˓"Description\",\"order\":11,\"visible\":true},{\"fieldName\":\"Most_Recent_Workpack\",\
→˓"order\":24,\"visible\":false},{\"fieldName\":\"Name\",\"order\":4,\"visible\":true,\
→˓"sortIndex\":0,\"sortDirection\":\"Ascending\"},{\"fieldName\":\"Original_Workpack\",\
→˓"order\":25,\"visible\":false},{\"fieldName\":\"Primary_Asset\",\"order\":26,\"visible\
→˓":false},{\"fieldName\":\"Ref_No\",\"order\":16,\"visible\":true},{\"fieldName\":\
→˓"Risk_ID\",\"order\":5,\"visible\":true},{\"fieldName\":\"Risk_Score\",\"order\":10,\
→˓"visible\":true},{\"fieldName\":\"Severity_ID\",\"order\":14,\"visible\":true},{\
→˓"fieldName\":\"Status_ID\",\"order\":8,\"visible\":true}]}"

}, {
"category": "Grid",
"subCategory": "Anomaly",
"identifier": "selectedItems",
"value": "6"

}
]

20.25 Update Settings
Update settings for a user.

20.25.1 HTTP Request
POST /icweb.dll/setting/

20.25.1.1 URI Parameters

Name In Required Type Description
settings Body Yes Setting [] Specifies the list of settings to update/save for the current user.
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20.25.1.2 Responses

Name Type Description
200 OK

20.25.2 Example
Create/update a setting for Grid -> Anomaly. Request ^^^^^^^

POST /icweb.dll/setting/

20.25.2.1 Body

[
{

"category": "Grid",
"subCategory": "Anomaly",
"identifier": "selectedItems",
"value": "6"

}
]

20.26 Setting Value Json Format
The following provides a base specification for the JSON that may be included for different settings.

20.26.1 Grid / ? / Layout

Name Required Type Description
columns Yes Grid Column [] Specifies the list of settings for a grid/tree.

20.26.1.1 Grid Column

Name Re-
quired

Type Description

fieldNameYes String Name of the field from the BusinessObject that this column refers to.
order Yes In-

te-
ger

Display index of the column. 0 denotes the left-most column in the grid/tree.

visible Yes BooleanIs the column visible in the grid/tree.
sortIndexNo In-

te-
ger

If specified, this column is being to specify the sorting in the grid, multiple columns can
be specified, the index is 0 based, and denotes the first column to sort upon, followed by
1 etc.

sortDirectionNo String Specifies the sort direction for the column, either Ascending ie A thru Z (0 thru 9), or
Descending ie Z thru A (9 thru 0).
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20.27 Change Requests
Request a list of change requests that the current user has the ability to approve or reject. It may contain already
approved/rejected items.

Only available to hosted SaaS clients

20.27.1 HTTP Request
GET /icweb.dll/approval/

20.27.1.1 Responses

Name Type Description
200 OK changeRequest [] When the change requests are requested.

20.27.2 Change Request
This contains a change request and information associated with what data has been requested to be changed.

Name Type Description Op-
tional

De-
fault

id inte-
ger

Unique Identifier for this change rquest, used to approve/reject the request. No

requested string Date/Time the change request was submitted. Not
object string Name of the object/table that the change request relates to. Yes
requestedBy string Name of the person that submitted the change request. No
isApproved bool Determines if the change request has been approved. If this is false but

approvedRejectedBy is not null, then the change has been rejected.
No

approvedRejectedByString Name of the person that approved or rejected the change request, null if the
change has not been rejected or approved.

Yes

comments String Comments provided by the person requesting the change. No
operation string One of three operations, Add, Update, Delete. No
currentValuesTableRowContains the data associated with the current state of the row. This will not

be available for ‘Add’ operations.
Yes

newValues TableRowContains the data associated with the desired state of the row. This will not
be available for ‘Delete’ operations.

Yes

20.27.3 Example
Retrieve all the approvals for the current user.

20.27.3.1 Request

GET /icweb.dll/approval/

20.27.3.2 Response

[{
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“id”: 1, “requested”: 45960.1359869213, “object”: “Workpack”, “requestedBy”: “Administrator”,
“isApproved”: false, “approvedRejectedBy”: “”, “comments”: “Please create this new workpack for
me.”, “operation”: “Add”, “newValues”: {

“Workpack_ID”: -2, “Name”: “Test Workpack”, “Actual_Start”: “2025-10-
30T00:00:00.000Z”, “Description”: “This is a new workpack”, “ReadOnly”: false,
“Task_Time”: “0.0”, “Hours_Per_Day”: 12, “Estimated_Duration”: “0.0”, “Actual_End”:
“2025-10-30T00:00:00.000Z”, “Total_Cost”: “0.0”, “Cost”: “0.0”

}

}

]

20.28 Approve/Reject Change
Approve or Reject a change request, and if relevant make the applicable changes to the row.

Only available to hosted SaaS clients

20.28.1 HTTP Request
POST /icweb.dll/approval/{Id}/{approve|reject}

{
“comments”: “Please update change request with correct information”

}

20.28.1.1 URI Parameters

Name In Re-
quired

Type Description

id Path Yes String Specifies the change request
action Path Yes String Specifiy whether to approve or reject the change request. In the case of reject a

comment may be supplied in the json body of the POST
commentsBody Yes String Specifies a comment when a change request is rejected.

20.28.1.2 Responses

Name Type Description
200 OK Change request was successfully approved/rejected.
404 Unsup-
ported

String Unsupported action for change request, neither approve or reject was specified.

404 Invalid String Change request has already been actioned, You can’t approve or reject a change request that
has already been approved or rejected.

404 Not
Found

String Unknown change request, the id provided was not found or you don’t have permissions to
action it.
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20.29 REST Examples
The following are some examples of different interactions with the REST service using Powershell commands.

ò Note

It is suggested that interactions with the REST API are thoroughly tested prior to use in a Production environment.
Modifying data directly via the REST APIs can have a destructive effect on a NEXUS database if not tested properly.

20.29.1 Authenticating
The following provides an example of how to authenticate against the REST API using powershell. This is required
before any other interaction with the REST API.

$baseUri = "https://{icWebUrl}/data/icweb.dll/"
$loginUri = $baseUri + "security/login"

# API Key from the user account in NEXUS. We need to base64 encode it for the␣
→˓authentication request.
$apiKey = {apiKey}

$apiKeyBytes = [System.Text.Encoding]::UTF8.GetBytes($apiKey)
$apiKeyEncoded = [System.Convert]::ToBase64String($apiKeyBytes)

# Build "Authorization" header for login request.
$headers = New-Object "System.Collections.Generic.Dictionary[[String],[String]]"
$headers.Add("Authorization", "apikey " + $apiKeyEncoded)

# Login to the REST API, result is JSON containing the authentication hash.
$hash = Invoke-RestMethod -method GET -uri $loginUri -Headers $headers

20.29.2 Request a list of Rows
Following on from the above authentication, we now have a valid hash to be able to query other items from the REST
API. The below requests all rows from the Workpack business object.

# Base BO REST API
$boUri = $baseUri + "bo/"

# Build the URI to request all the rows from the Workpack business object.
$uri = $boUri + "Workpack/" + "?hash=" + $hash.hash
$workpackJson = Invoke-RestMethod -method GET -uri $uri

# Output the list of Workpacks
$workpackJson.rows | Format-Table -Property Workpack_ID, Name

ò Note

If there are more than 100 rows in the workpack table you will need to make subsequent requests to retrieve the rest
of the rows.
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20.29.3 Request a list of rows with a filter
If you wanted to only return a list of workpacks where the Revision is set to “Planning” we would do that using a filter.

# Create filter object
$filter = @{

where =
@(

@{
field = "Revision_ID.Name"
value = "Planning"

}
)

}

# Convert filter object to Json.
$filterJson = $filter | ConvertTo-Json

# Add the filter as a X-NEXUS-Filter http header.
$headers = New-Object "System.Collections.Generic.Dictionary[[String],[String]]"
$headers.Add("X-NEXUS-Filter", $filterJson)

# Build the REST uri for the Workpack business object and Invoke the REST method.
$uri = $boUri + "Workpack/?hash=" + $hash.hash
$workpacks = Invoke-RestMethod -method GET -uri $uri -Headers $headers

# Output the list of workpacks
$workpacks.rows | Format-Table

20.29.4 Generate a Report Template
The following generates a report template and emails it to a specified person.

# Base report REST URI
$reportUri = $baseUri + "web/generateReport"

# Set the recipient for the report email/
$recipient = "joe.bloggs@nexusic.com"

# Set the report format to RTF - You can use HTML and XLSX as well.
$format = "RTF"

# Set the report template key to 16, this specifies the report template to generate.
$reportTemplate = "16"

# Generate Report Template with ID of 16, using RTF format and email it to a specific␣
→˓person.
$uri = $reportUri + "?key=" + $reportTemplate + "&format=" + $format + "&recipient=" +
→˓$recipient + "&hash=" + $hash.hash
Invoke-RestMethod -method POST -uri $uri
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20.29.5 Insert a New Row
The following creates a new Workpack, setting the initial values of that Workpack.

# Build an object that contains the specified values for Name, Actual_Start, Description␣
→˓and ReadOnly
$workpackRow = @{

Name = "2015 ROV Inspection"
Actual_Start = "2015-05-15T00:00:00.000Z"
Description = "Annual 2015 full field rov inspection"
ReadOnly = $false
}
$body = $workpackRow | ConvertTo-Json

# Build the URI to request all the rows from the Workpack business object.
$uri = $boUri + "Workpack/0?hash=" + $hash.hash
$newRow = Invoke-RestMethod -method PUT -body $body -uri $uri

# Output the the new Workpack row
$newRow.rows | Format-Table -Property Workpack_ID, Name

20.29.6 Updating an existing Row
Following on from the insert, we can use the row in $newRow.Rows to then update the name of the workpack and
abbreviation.

# Update Workpack Abbreviation and Name
$workpackRow = @{

Abbreviation = "2015_ROV"
Name = "2015 - Annual ROV Inspection"

}
$body = $workpackRow | ConvertTo-Json

# Build the URI - must include the Workpack_ID from the new row so the REST api knows␣
→˓what row we are updating.
$uri = $boURI + "Workpack/" + $newRow.rows[0].Workpack_ID + "?hash=" + $hash.hash
$updatedRow = Invoke-RestMethod -method POST -body $body -uri $uri

$updatedRow.rows

20.29.7 Getting information on a Function
$functionName = "Compare A = B"
$functionUri = $baseUri + "function/"

# Build the URI - must include the Workpack_ID from the new row so the REST api knows␣
→˓what row we are updating.
$uri = $functionURI + "/" + $functionName + "?hash=" + $hash.hash
$function = Invoke-RestMethod -method GET -uri $uri

$function

The REST service provides an API consisting of a set of HTTP endpoints(methods) with the ability to create, retrieve,
edit, or delete access to information stored in a NEXUS IC database. The REST service ensures all request are made
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through the NEXUS Storage engine which allows security and cohesion to be maintained and respected within the
NEXUS database data.

ò Note

As of NEXUS version 6.9, REST Service Specifications v1.0 is no longer supported.

20.30 Components of a REST API request/response
1. The request URI, which consists of: {uri scheme} :// {uri host} /icweb.dll/ {resource-path}

? {query-string}

• URI scheme: Indicates the protocol used to transmit the request. This is either http or https. We highly
recommend using https in your deployments.

• URI host: Specifies the domain name or IP address of the server where the REST service endpoint is
hosted, such as sample.nexusic.com

• Resource path: Specifies the resource or resource collection, as detailed below in the API

• Query string (optional): Provides additional parameters as required.

2. HTTP request message header fields:

• A required HTTP method (or verb), which tells NEXUS what type of operation you are requesting. The
NEXUS REST service support GET, PUT, POST, and DELETE.

• Optional additional header fields, as required by the specified URI and HTTP method. For example, an
Authentication token that can be used for client authorization.

3. An Optional HTTP request message body, to support the URI and HTTP operation. For POST or PUT operations,
the request body is required to have a MIME-type of application/json.

4. A HTTP status code, this may be from the 2xx, 4xx or 5xx codes. Each service will indicate what possible
returns are available.

5. Optional HTTP response message body, MIME-encoded response objects are returned in the HTTP response
body, such as a response from a GET method that is returning data. All results are return in the format JSON.

20.30.1 Authentication
There are 3 authentication options available using Login:

1. Username/password request

2. API Key, that is associated with any user account with NEXUS, this provides permanent access until the API
Key is changed in NEXUS

3. Email based login, that provides the capability for the REST api to email a request token to the user, this is then
used to have the REST api issue a token lasting 90 days.

All three of these authorization methods, issue a temporary HASH that expires 60 minutes after the last request.

Once the HASH is received from a valid authorization request to the server, this must be specified in subsequent requests
via a query string parameter.

GET /icweb.dll/bo/?hash={value}
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20.30.2 Examples
Extensive examples of using the REST API with powershell scripting are available in the below topic.

REST Examples

20.30.3 API Reference

Login Logout Business Objects Get Row
Get Row Field Get Rows Create / Update Row Delete Row
Request Cookie Token Validate Cookie Token Post Blob Get Function Object
Execute Function Version Import Report Details
Job Status License Settings Change Requests

20.30.4 Field Types

Name Value Native/JSON Type Display Field Type
FT_STRING 1 string string
FT_NUMBER 3 integer (whole number) integer
FT_NUMERIC 6 float float
FT_BOOLEAN 5 bool bool
FT_CURRENCY 7 float float
FT_DATE 9 string (iso 8601

date/time)
string

FT_TIME 10 string (iso 8601
date/time)

string

FT_DATETIME 11 string (iso 8601
date/time)

string

FT_POSITION 39 string (iso 8601
date/time)

string

FT_LOOKUP 37 integer string
FT_IMAGE 15 binary binary
FT_MEMO 16 string string
FT_PASSTHRU 18 non-stored based on field type of the destination field. (this is recur-

sive)
FT_GUID 17 string string
FT_TABLE 38 non-stored not-visible
FT_CALC 40 non-stored based on result type of assigned function.
FT_GLOBALTABLE 42 non-stored based on field type of global field.
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CHAPTER

TWENTYONE

EXPERT SYSTEMS OVERVIEW

Expert system configurations for NEXUS IC are managed by subject matter experts within Wood and are maintained
to the latest standards/codes and/or best industry practice.

Click below to find out more about expert systems, how they are used and the benefits they offer.

ò What is an Expert System?

Expert systems configurations are essentially predefined database configurations, which any NEXUS IC client can
subscribe to. When you elect to subscribe to an expert system configuration, the asset types, asset information
groups, risk models, event definitions and associated outputs of the expert system (reports, charts, traffic lights and
dashboards) are added to your database.
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ò Getting Started

When you create your database with the help of expert systems, you do not have to start from scratch.
Expert systems provide the most common configurations that you can use as a basis for your client-
specific configurations, which can significantly reduce the time and effort that you must invest in
setting up your database. If you use expert systems, the process of creating your database will be as
simple as shown in the figure below:
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ò Keep Your Database Up-to-Date

Expert systems are live, that is, Wood regularly maintains and updates them in line with the evolution
of relevant codes, standards and industry best practices.

Changes are managed by Wood and distributed to all NEXUS users that subscribe to the expert system.
Updates are synchronised with minimal operations downtime and do not require a software upgrade.
Updates do not overwrite the client-specific configurations that you have added to the expert system
configurations.
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ò Extend Your Portfolio

You can add further expert system configurations to your portfolio any time. There is no limit to the
number of expert system configurations you can subscribe to. Subscribing to each expert system builds
a seamless single database.

21.1 Expert Systems Hierarchy
The diagram below represents the hierarchy of expert system inheritance. Each expert system inherits the configurations
above it, starting with the Base Expert System at the root. Click a node for more information about a specific expert
system.

Besides expert systems, the following calculators are under planning:

• ECE (expert_systems.ece)

• FMECA (expert_systems.fmeca)

• IOW (expert_systems.IOW)

• Metal Loss Analysis (expert_systems.metalloss)

• FFS (expert_systems.ffs)

For frequently asked questions, see FAQs.
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21.1.1 Default Configuration
21.1.1.1 Overview

The Default Configuration (also known as the “Base” Expert System), is a foundation level configuration for all other
expert system configurations to subscribe to.

This expert system contains generic and commonly used elements, such as chart and report templates, which reference
the generic system tables (for example, anomalies, findings, events) as well as several database administration reports
providing information on user login activity, database configuration data and commonly used functions.

All other expert systems inherit from this Default Configuration.

21.1.1.2 Content

The following figure shows the elements that are delivered with the Default Configuration. For more information, click
on the nodes of the figure below or see Default Configuration Content.

21.1.1.3 Deployment Prerequisites

The following configuration is not automatically deployed as part of the “out-of-the box” expert system and needs to
be configured manually:

• Client corporate logos (used in header/footers in reports)
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• Report styles (corporate fonts and colours used in reports)

• Client risk matrix (corporate risk matrix)

• Security groups (Wood can recommend typical security groups if required)

21.1.1.4 Revision History

21.1.1.4.1 Default Configuration Content

The Default Configuration comes with the following elements:

21.1.1.4.1.1 Asset Information Groups (AIGs)

AIG Name Category Description
Availability / Operability Sta-
tus

General Data Captures and stores availability statistics from facility to com-
ponent to track and report on availability across the asset pool.
Find more information below the table.

MAXIMO External Refer-
ences

Standard Maximo Asset Identification attributes

Risk Assessment Sign off /
Actions

Approvals Sign-off or approvals for risk assessments with an action regis-
ter and re-assessment scheduling information. Facilitates the
approval and sign-off process for digitally stored risk assess-
ments. Captures actions associated with the risk assessments
the risk result on approval to profile risk over the life of the
facility. Find more information below the table.

ò Availability / Operability Status
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Tracks availability and operability of any asset in the hierarchy. Information stored in this AIG is used to visualise
historical and current status of the assets. Uptime statistics are calculated for the asset life, the past year and past 5
years on a rolling basis.

ò Risk Assessment Sign off / Actions
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This AIG comprises two main parts:

• Risk Review History

The agreed assessment approval process is configured in the Base ExSys Configuration global table. The
Risk Assessment Sign-off functionality works on either a two-step or three-step approval process:

– The two-step approval process requires a Prepared and Approved record.

– The three-step process requires a Prepared, Accepted and Approved record.

A risk assessment revision cycle is fully approved when:

– The relevant Review History records have been created (according to the agreed approval process)

– The Completed field of each of the revision history records is set to Yes.

– The Revision number of each of the records in this revision cycle match. Where the highest revision
number represents the latest revision cycle.
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Deferrals are treated in the same way as prepared risk assessments. The agreed deferral process can be differ-
ent from the approval process. For example, you can have a two-step approval process for risk assessments,
but a three-step process for deferrals. This Risk Assessment Sign Off / Actions AIG functionality requires
client-specific setup. Risk-Based Inspection (RBI) re-assessment dates are calculated based on either the
latest approved deferral date, a prescriptive interval or the time since the latest inspection. The risk review
re-assessments are forecast and can be visualised in pre-configured charts, reports and dashboards.

• Risk Assessment Review Actions
Any action associated with a risk assessment are captured here and can be forecast and visualised in pre-
configured charts, reports and dashboards.

Back to Overview

21.1.1.4.1.2 Functions

There are some generic, commonly used functions available in the Default Configuration database.

Not all functions contained in the Default Configuration are described here. The following, commonly used generic
functions can be used in any databases that inherit from this Default Configuration:
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Relevance Function Name Description
Colour Due / Overdue Traffic

Light to Colour
Takes a <No. days> and <due date> as input parameters. Re-
turns Green, Amber, Red based on Not due, Due within and
Overdue.

Colour Yes/No to Colour Takes a <Yes/No> type input and returns either NEXUS
Green (Yes), NEXUS Orange (No) or Grey (null) from the
NEXUS colour palette.

Colour Anomaly Action Over-
due Status to Colour

Takes the <Anomaly.Action Overdue Status> text ‘No Ac-
tions’, ‘Overdue’ or ‘Upcoming’ and returns a colour for
charting.

Colour Anomaly Action Status
to Colour

Takes the <Anomaly.Action Status> text ‘Complete’, ‘Incom-
plete’ or ‘No Action Assigned’ and returns a colour.

Database Configuration Normalise Axis Value Takes the Risk Assessment <value> as a whole number, and
the maximum number matrix <granules> on this axis and re-
turns a value between 0 and 1.

Date and Duration Days from Today Takes <Input Date> and calculates the number of days from
today’s date. A negative result is number of days elapsed
from the <Input Date> to today, a positive result is number of
days from today to the <Input Date> (in the future).

Date and Duration Today’s Date (as Date) Returns today’s date in Date format.
Date and Duration Today’s Date (as

Date/Time)
Returns today’s date in Date/Time format.

Formatting Date (MM-DD) as
String

Takes a <Date> type input and returns MM-DD with alphanu-
meric type.

Formatting Date (YYYY) as String Takes a <Date> type input and returns YYYY with alphanu-
meric type.

Formatting Date (YYYY) as String Takes a <Date> type input and returns YYYY-MM with al-
phanumeric type.

Formatting Date (YYYY-MM) as
String

Takes a <Date> type input and returns YYYY-MM with al-
phanumeric Type

Formatting Pad Leading Zeroes Takes the <Integer> number to pad and the <Total Length
(1..10)> of the whole number. For example, input Integer
355 padded to 6 will output “000355”.

Miscellaneous Current user name Returns the name of the user that is logged into this session.
No inputs required.

Miscellaneous Is Current User? Takes the <SU_ID> or <Personnel.Name> and determines if
the input SU_ID or Personnel.Name matches the currently
logged in user. Returns “Yes” or “No”.

Miscellaneous Is this asset Risk As-
sessed?

If the input Asset <Component_ID> has a Risk Assessment
assigned to it, then it returns “Yes”, else it returns “No”.

Miscellaneous Is AIG Assigned to this
Asset Type?

Returns “Yes” if the <AIG Name> is assigned to the <Asset
Type Name>, else it returns “No”.

Miscellaneous Date of most recent
Event (by Event Type)

Takes the Asset <Component_ID> and <Event Type> name
and returns the most recent event date (including child as-
sets).

Miscellaneous Return Value from
Named Value Pair

Returns the Value from the Base ExSys Configuration Global
Table. It passes in the <parameter> Name.

Miscellaneous Due / Overdue Traffic
Light to Text

Takes a <No. days> and <due date> as inputs. Returns “Over-
due”, “Due within <No. Days> days”, “Not due for more
than <No. Days> days” or “No Due Date or Due Window
defined”.

Miscellaneous No. Layers Returns the number of Drawings layers that are associated
with this asset <Component_ID>.

Miscellaneous No. Linked Drawings Returns the number of Drawings that are linked to this asset
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Back to Overview

21.1.1.4.1.3 Reports and Dashboards

Report Name Description
Base ExSys Report Elements A report containing sample tables and charts from the core database schema that

can be used to help accelerate construction of other reports. Use the Retrieve
Element button to transfer the selected items to your new report. Example charts
and tables of the report elements are shown below.

Database Configuration Lists key configuration elements of the database including the dynamic table
definitions, Security Groups and User Lists, Lookup Lists, Expert System revi-
sions, Triggers and Configuration Issues.

Report elements are put into the following categories (click the items to see examples for each category):

ò Anomaly / Anomaly Actions

ò Availability / Operability Status
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ò Events / Findings

ò “My” Actions
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ò Risk

ò Risk Sign-Off / Actions and Re-assessment Forecasting
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Back to Overview

21.1.1.4.1.4 Traffic Lights

Whilst traffic lights can be configured to suit specific client requirements, there are a selection of traffic lights that are
included in each database deployment.

Traffic Light Name Description
Anomalies Displays traffic lights based on Anomaly Count of this asset and all child assets.
Event History Shows where inspection data exists on this asset and child assets.
Incomplete Tasks Highlights where incomplete tasks are the active workpack on the asset tree.
Risk Displays the worst-case risk from this asset and all its child assets.
Rolled up Risk Shows the rolled up (maximum) risk for an asset and all of its children.
RBI Assessment Review Status Displays the status of the latest revision cycle (Prepared, Accepted or Accepted).
RBI Deferral Date Status Where an RBI assessment has been deferred, it shows the Deferral Due Date

Status (Red = Overdue, Amber = Due within 90 Days, Green Due > 90 Days).
RBI Re-assessment Due Date
Status

Shows the Re-assessment Date Status (Red = Overdue, Amber = Due within 90
Days, Green Due > 90 Days).

Example

Back to Overview
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21.1.1.4.1.5 Client-Specific Lists

Wood delivers “out-of-the-box” configuration for the global tables and lookup lists listed below. These tables and
lookup lists are delivered without data. To ensure that the system works effectively, customers must populate them with
their own company-specific data upon deployment. Wood can provide sensible default data if required.

Type Name Description
Lookup List Risk Assessment Engineer To be populated with a list of engineers who might be respon-

sible for preparing, accepting or approving risk assessments,
or engineers who can create or be assigned risk assessment
actions. When the engineer name matches a user name in the
database, then these records are visualised in My Dashboard
for that logged in user.

Lookup List Availability / Operability Sta-
tus

A list of operability statuses. It is used in conjunction with the
global lookup table to calculate and visualise asset or compo-
nent availability. For example, Available; Available with con-
cerns; Unavailable; Maintenance PM; Decommissioned.

Global Table Base ExSys Configuration
Global Table Availability / Operability Sta-

tus Traffic Lights
For each of the availability/operability statuses defined in the
lookup list (above), indicates if the status is Available and the
colour assigned to the status. For example, Available, Yes,
Green; Available with concerns, Yes, Yellow; Unavailable,
No, Red; Maintenance PM, No, Blue; Decommissioned, No,
Grey.

Global Table Approval Status Traffic Light Depending on the For example, No revision history, Grey; Pre-
pared | Accepted Approved, Green; Deferred | Accepted | Ap-
proved, Green;

Back to Overview

21.1.2 Civils and Structures Expert System
21.1.2.1 Overview

The Civils and Structures Expert System is configured to assist in the management of clients’ onshore structural as-
sets. This expert system has been configured to allow storage of each structural components general, location, design,
baseline, inspection, and risk data. A structural components inspection plan is automatically calculated following a
probability of failure and consequence of failure risk assessment.

21.1.2.2 Codes / Standards

N/A

21.1.2.3 Asset Types

Asset Type Description
Associated Infrastructure Roads and Associated Infrastructure
Bridges Civil Infrastructure
Bunds and Dykes Spill Containment Structure
Buried Sewers Drainage Network
Catch Basin Drainage Network

continues on next page
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Table 1 – continued from previous page
Asset Type Description
Client
Concrete Pavings Civil Infrastructure
Concrete Pavings Major Concrete Structure and Foundation
Concrete Sleepers Major Concrete Structure and Foundation
Cooling Water Structures Civil Infrastructure
Culverts and Tunnels Civil Infrastructure
Deflection Wall Civil Infrastructure
Drainage System Drainage Network
Electrical and Instrument Support Major Steel Structure and Foundation
Equipment Foundations Major Concrete Structure and Foundation
Facility
Firewalls and Blastwalls Fire and Blast Protection
Flare Structure Major Steel Structure and Foundation
Gates and Fences Major Steel Structure and Foundation
Ground Flare Structure Major Steel Structure and Foundation
Guy Wire Major Steel Structure and Foundation
Lifting and Handling Support Major Steel Structure and Foundation
Manhole Drainage Network
Non-Process Building Buildings
Passive Fire Protection Fire and Blast Protection
Permanent Safety Barriers Roads and Associated Infrastructure
Piperack Structures Major Steel Structure and Foundation
Process Building Buildings
Process Drain Sumps Drainage Network
Retaining Walls Civil Infrastructure
Roads and Car Parks Roads and Associated Infrastructure
Sanitary Sewer System Drainage Network
Secondary Steel Structure Major Steel Structure and Foundation
Service Pits and Trenches Major Concrete Structure and Foundation
Shelter or Shed Buildings
Standalone/Off-Skid Pipe Supports Major Steel Structure and Foundation
Structural Component CSIM
Structural Steel Member
Structural System CSIM
System
Tall Structures Major Steel Structure and Foundation
Tank Foundations Major Concrete Structure and Foundation
Tertiary Steelwork Major Steel Structure and Foundation
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21.1.2.4 Asset Information

Asset Information Group Description
CSIM Baseline SAT S.A.T details, scope, interfaces, design data, risk data, inspection meth-

ods and requirements including any additional data relevant to the base-
line.

CSIM General Information Area and block information, description of asset, associated equipment,
and related documentation.

CSIM Location Information Location name, eastings and northings.
CSIM Design Data Wall thickness, load, foundation, drainage, and guy wire design criteria.
CSIM Probability of Failure Civils and structures probability of failure assessment.
CSIM Consequence of failure Civils and structures consequence of failure assessment.
CSIM Inspection Requirements Inspection scope, interfaces, limits, specific instructions, preparation,

tools and inspection considerations.
CSIM Inspection Plan Risk assessment results, inspection plan (including last inspection date,

calculated and override frequencies and next inspection dates) and ap-
proved inspection plan.

21.1.2.5 Risk Models
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21.1.2.6 Inspection / Maintenance Events

Event Type Description
Bolt Integrity Inspection Bolt condition
Bund Integrity Test Bund type, volumes, water level readings, duration of test
Buried Sewer and Drainage Visual Sur-
vey

Overall condition of the drainage system

Close Visual Inspection - Concrete Close Visual Inspection (CVI) of concrete condition
Close Visual Inspection - Masonry Close Visual Inspection (CVI) of Masonry condition
Close Visual Inspection - Steel Close Visual Inspection (CVI) of Steel condition
Close Visual Inspection - Tertiary Steel-
work

Close Visual Inspection (CVI) of Tertiary Steelwork condition

Concrete Crack Inspection Inspection technique, dimensions of crack and pH readings
General Area Walk-Around Inspection Area code and name, general visual inspection of the area
General Movement Survey Type of inspection, dimensions of the deviation
General Visual Inspection - Concrete General Visual Inspection (GVI) of concrete condition
General Visual Inspection - Masonry General Visual Inspection (GVI) of Masonry condition
General Visual Inspection - Steel General Visual Inspection (GVI) of steel condition
General Visual Inspection - Tertiary
Steelwork

General Visual Inspection (GVI) of Tertiary Steelwork

Ground Movement Survey Type of inspection, reason for movement and general
Groundwater Survey Type of inspection and water level readings
Guy Wire Close Visual Inspection Design and measured dimensions, general condition, and structural de-

viation details
Guy Wire Tension Check Design tension and tension readings
Level Survey Monitoring location details and measured height
Local Deformation Survey Type of inspection and overall condition
Post Event Walk-Around Inspection Type of event recorded and overall condition
Wall Thickness Readings Feature details, readings at clock positions and wall thickness design

data
Weld Integrity Check NDT technique carried out, position of reading and dimensions of flaw

21.1.2.7 Dashboards / Reports

Report Description
CSIM Dashboard For the selected structural component, this report displays a table of

child assets and their risk results, risk matrix, inspections due chart and
table of inspection types and the next inspection due dates

CSIM IMR Report [Select a ‘Structural Component’ grouping] Generates an Excel listing
of IMR Last Inspection dates, Frequencies and Next Dates

CSIM Structural Assessment Table Re-
port

[Generate in MS Word] This report generates a Structural Assessment
Table (S.A.T) template containing an asset description of the compo-
nent to be inspected, scope of inspection, interfaces, as well as PoF and
CoF values

CSIM Workpack Instruction Report [Select a Workpack] Asset data, task listing, limits, open anomalies,
historical inspections, documents and drawings.
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21.1.3 EEHA Expert System
21.1.3.1 Overview

The EEHA (Electrical Equipment in Hazardous Area) Expert System is configured to assist in the management of
electrical equipment in hazardous areas. The large volume of Ex equipment that typically exist on many sites can often
lead to difficulties in performing inspections and managing the data associated with them. The EEHA expert system
can assist by providing a mobile electronic inspection solution that will instantly feed to the database. From here, the
data may be used to demonstrate KPIs, perform RBI assessments and plan/create of work pack. Allowing the user to
reduce the inspection load and manage the data effectively to meet the required regulations.

21.1.3.2 Codes / Standards

• Australian/New Zealand Standard Explosive Atmosphere Part 17: Electrical installations inspection and main-
tenance (IEC 60079-17:2013 (ED.5.0) MOD) - AS/NZS 60079.17: 2017.

• Guidelines for managing inspection of Ex electrical equipment ignition risk in support of IEC 60079-17.

21.1.3.3 Asset Types

Asset Type Description
Lot Groups Ex electrical equipment together by zone, type of protection, environmental

condition, and equipment age. The RBI assessment is performed at this level with an
inspection interval applying to the Ex-equipment below.

Ex Electrical Equipment Defines the physical assets present on site. The inspections are recorded at this level.

21.1.3.4 Asset Information

Asset Information
Group

Description Assigned to Type(s)

Defining Features of Lot Summarises the type of equipment within a lot. Lot
Frequency of Inspection Demonstrates the calculations performed to determine

the frequency of inspection.
Lot

Lot Equipment Informa-
tion

The asset data relevant to Ex electrical equipment. Ex Electrical Equipment

Sample Size The determination of the number of children assets to be
inspected at a given frequency.

Lot

Sampling Plan A summary of the current key parameters of the lot. Lot

# Risk Models # ^^^^^^^^^^^ # High level diagram summarising risk assessment approach. (Should identify each
damage mode/mechanism as a single item & also call out compliance with individual codes)
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21.1.3.5 Inspection / Maintenance Events

Event Type Description Assigned to Asset
Type(s)

EEHA Close Inspection
Form

Ex Electrical Equipment

EEHA Detailed Inspec-
tion Form

Ex Electrical Equipment

EEHA Inspection Form Ex Electrical Equipment
EEHA Visual Inspection
Form

Ex Electrical Equipment

Lot Inspection Calculates the results of most recent inspection Lot
Review of Sampling Plan Lot

21.1.3.6 Traffic Lights

ò Note

Traffic Lights are currently not distributed with the Expert System.

21.1.3.7 Dashboards / Reports

Report Name Comments
EEHA - Charts
EEHA - Inspection Checklist Form
Ex ‘i’ Detailed Inspection

21.1.4 Pipeline Expert Systems
NEXUS offers the following expert systems for pipelines:

• Pipeline Base expert system (see Pipeline Expert System)

• Onshore Pipeline expert system (see Onshore Pipeline Expert System)

• Subsea Pipeline expert system (see Subsea Pipeline Expert System)

21.1.4.1 Pipeline Expert System

This expert system is currently under construction.

21.1.4.2 Onshore Pipeline Expert System

This expert system is currently under construction.

21.1.4.3 Subsea Pipeline Expert System

This expert system is currently under construction.
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21.1.5 PRD Expert System
21.1.5.1 Overview

The PRD (Pressure Relief Device) Expert System is configured to assist in the management of clients’ pressure relief
devices. This expert system has been configured to allow storage of each PRDs general, design and process data, as
well as display each PRD’s inspection history. A PRD inspection plan is automatically calculated following a PRD
criticality assessment.

21.1.5.2 Codes / Standards

N/A

21.1.5.3 Asset Types

Asset Type Description
PRD Pressure Relief Device
PVRD Pressure Vacuum Relief Device

21.1.5.4 Asset Information

Asset Information Description Assigned to
Type(s)

PRD General Information General PRD information including tag no., location, as-
sociated pipework etc.

PRD, PVRD

PRD Design Data Valve and body trim data. Sizing basis data. PRD, PVRD
PRD Process Data Fluid type and state, pressure, temperature, liquid, and

vapor data.
PRD, PVRD

PRD Inspection History Last inspection data, count of defaults etc. PRD, PVRD
PRD Criticality Assessment Criticality, consequence, and confidence grading includ-

ing justifications.
PRD, PVRD

PRD Inspection Plan Criticality assessment result, calculated and approved in-
spection plan (intervals, last inspection date and next rec-
ommended date plus overrides).

PRD, PVRD
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21.1.5.5 Risk Models

21.1.5.6 Inspection / Maintenance Events

Event Type Description Assigned to
Type(s)

PRD Inspection PRD Inspection form - As-received condition and initial
test results, strip down internal condition, final test data
after overhauling/repairs.

PRD, PVRD

PRD Change Out Used when the PRD has been changed out. Includes the
reason for change out plus serial number removed and
installed.

PRD, PVRD

21.1.5.7 Traffic Lights

ò Note

Traffic Lights are currently not distributed with the Expert System.
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21.1.5.8 Dashboards / Reports

Event Type Description
PRD overview For each PRD asset, this report displays general PRD information, inspection

history, criticality assessment, risk chart and the inspection plan.

21.1.6 RCM Expert System
21.1.6.1 Overview

The RCM expert system is an “off-the-shelf” configuration in NEXUS IC that facilitates efficient deployment and
management of a company’s Reliability-Centered Maintenance (RCM) strategies.

The RCM expert system provides the following:

• An RCM library that categorises assets based on subclasses and provides Failure Mode Effect and Criticality
Analysis (FMECA) functions.

• You can link this RCM library to your asset register and get recommended failure modes and maintenance tasks.

• You can easily customise and extend the library based on your specific requirements.

• You can generate an output ready to be uploaded to CMMS systems.

21.1.6.2 Benefits

The RCM expert system offers the following benefits:

• Streamlines RCM data entry and management, reducing manual effort

• Enhances data quality and reliability by minimizing errors

• Facilitates the setup of efficient, standardised maintenance strategies

• Ensures consistency with RCM industry standards

21.1.6.3 Content

The following figure shows the elements that are delivered with the RCM expert system. For more information, click
on the nodes of the figure below or see RCM Expert System Content.

21.1.6.4 Codes/Standards

• SAE JA1012 (“A Guide to the Reliability-Centered Maintenance (RCM) Standard”)

• SAE JA1011 (“Evaluation Criteria for RCM Processes”)

• ISO 14224:2016 - Petroleum, petrochemical and natural gas industries — Collection and exchange of reliability
and maintenance data for equipment

• CFIHOS - Capital Facilities Information Handover Specification

• ISO 8000-100 - Data quality - Part 100: Master data: Exchange of characteristic data: Overview
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21.1.6.5 Deployment Prerequisites

The following configuration is not automatically deployed as part of the “out-of-the box” expert system and needs to
be configured manually:

• Client corporate logos (used in header/footers in reports)

• Report styles (corporate fonts and colours used in reports)

• Client risk matrix (corporate risk matrix)

• Security groups (Wood can recommend typical security groups if required)

21.1.6.6 Revision History

This is the first major release of the expert system.

21.1.6.6.1 RCM Expert System Content

The RCM expert system comes with the following elements:

21.1.6.6.1.1 Asset Types

Asset Type Description
Equipment Class Represents an RCM Equipment Class
Subclass A Subclass of an Asset Class
Subclass Category A category of a Subclass. Used to assign a maintenance strategy.
Subunit A Subunit of a Subclass Category
Function A Function of a piece of Equipment
Functional Failure A Functional Failure of a Function
Failure Mode A Failure Mode of a Functional Failure
Maintenance A Maintenance task to mitigate a Failure Mode

Back to Overview
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21.1.6.6.1.2 Asset Information Groups (AIGs)

AIG Name Category Description
Equipment
Class

RCM Library Defines key attributes of an Asset Class for exporting to Global Library.

Subclass RCM Library Combination of Equipment Class and Equipment Type information.
Subclass Cate-
gory

RCM Library

Subunit RCM Library Information about this Subunit of the parent Equipment
Function RCM Library
Functional Fail-
ure

RCM Library

Failure Mode RCM Library
Maintenance
Task

RCM Library Information about what Maintenance Task should be performed and when

RCM Library
Asset

RCM Links the selected asset to the appropriate part of the RCM Library.

Failure Modes RCM Key information about Failure Modes assigned to the selected asset.
Maintenance
Tasks

RCM Information about Maintenance Tasks assigned to the selected asset.

Back to Overview

21.1.6.6.1.3 Functions

The table below outlines several frequently used functions delivered with the RCM expert system. Please note that this
list does not cover all available functions.

Function Description
Proposed Task Type from FM_ID Returns the Proposed Task Type field for a Library Failure Mode with

the matching FM_ID. If it is not found, returns null.

Back to Overview

21.1.6.6.1.4 Shortcuts

Shortcut Description
Add Next RCM Library Node Adds the next level of the RCM Library hierarchy, based on the cur-

rently selected level.

Back to Overview

21.1.6.6.1.5 Client-Specific Lists

Wood delivers “out-of-the-box” configuration for the global tables and lookup lists listed below. These tables and
lookup lists are delivered without data. To ensure that the system works effectively, customers must populate them with
their own company-specific data upon deployment. Wood can provide sensible default data if required.
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Type Name Description
Global Table Allowable RCM Library Asset

Types
Used to override the default RCM Library allowable asset types.

Global Table Failure Mode Library A library of failure modes that can be applied to assets.
Global Table Library Revision Status Stores valid Status values for RCM Library data that can have

multiple Revisions.
Global Table Maintenance Library A library of maintenance tasks for each library Subclass Cate-

gory.
Global Table Subclass Category Codes Stores valid Subclass Category Codes in the RCM library.
Global Table Subclass Mapping to Asset

Type
Maps Subclasses or Subclass Categories to Asset Types.

Lookup List Craft
Lookup List Failure Characteristic
Lookup List Failure Occurrence
Lookup List RCM Discipline
Lookup List Revision Status
Lookup List Task Type

Back to Overview

21.1.7 Static Pressure Equipment (SPE) Expert Systems
NEXUS offers the following expert systems for Static Pressure Equipment (SPE):

• The SPE expert system contains all necessary functionality to manage pressure equipment risk assessment,
inspection enactment and dashboarding. For more information, see SPE Expert System.

• The SPE Plus expert system contains the SPE configuration and adds on a semi-quantitative Risk Based Inspec-
tion Methodology that integrates with the SPE AIGs and enhances the assessment of equipment probability of
failure. For more information, see SPE Plus Expert System.

• The API 581 expert system incorporates the SPE and SPE Plus expert systems and provides a fully compliant
API 581 assessment tool for analysis of equipment risk and inspection planning. The API 581 expert system also
contains the SPE++ asset types. For more information, see API 581 Expert System.

The following table shows the differences among the various methodologies supported by the expert systems for Static
Pressure Equipment:
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21.1.7.1 SPE Expert System

21.1.7.1.1 Overview

The Static Pressure Equipment (SPE) Expert System contains all necessary functionality to manage pressure equipment
risk assessment, inspection enactment and dashboarding. It is seamlessly integrated with NEXUS standard function-
ality such as anomaly management and libraries.

The SPE expert system is tailored to piping, vessels, tanks and heat exchangers. It can be configured to suit any client
risk matrix and can perform qualitative, semi-quantitative or fully quantitative Risk-Based Inspection (RBI) (API 581)
interchangeably.

The SPE expert system includes:

• In-built material specifications

• tmin calculation

• All API 571 DMs assessed

• All API 581 corrosion models

• CML trending and remaining life calculation

• Alignment to any risk matrix

• Automatic inspection planner

• CML distribution tool

• Report generator

21.1.7.1.2 Benefits

The SPE expert system offers the following benefits:

• Fully pre-constructed and tested methodology aligned to industry standards

• Access to API 581 (and other) engineering calculations/tools as standard

• Software-led RBI provides:

– Fast application of RBI rule set and assumptions

– Quickly identify areas of high risk

– Consistent report content

– Repeatability: update of RBI with minimal effort

As a consequence, using the SPE expert system can provide the following commercial benefits:

• Direct RBI cost reduction (no methodology development time, minimal configuration time)

• 80% reduction in report cost

• Follow-up RBI cost reduction of over 50%

21.1.7.1.3 Content

The following figure shows the elements that are delivered with the SPE expert system. For more information, click on
the nodes of the figure below or see SPE Expert System Content.
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21.1.7.1.4 Codes/Standards

• “Risk-Based Inspection”, API Ref. API RP 580, 4th Edition, Addendum 1, March 2025

• “Risk-Based Inspection Methodology”, API Ref API RP 581, 3rd Edition 2019

• “Damage Mechanisms Affecting Fixed Equipment in the Refining Industry”, API ref. API RP 571, 3rd Edition,
2020

• “Guidelines for management of coatings for external corrosion protection”, The Energy Institute, 1st Edition,
January 2012.

21.1.7.1.5 Deployment Prerequisites

The following configuration is not automatically deployed as part of the “out-of-the box” expert system and needs to
be configured manually:

• Client corporate logos (used in header/footers in reports)

• Report styles (corporate fonts and colours used in reports)

• Client risk matrix (corporate risk matrix)

• Security groups (Wood can recommend typical security groups if required)

21.1.7.1.6 Revision History

The following table summarises new and updated features that have been included in major releases of the expert
system:

21.1. Expert Systems Hierarchy 763



NEXUS Documentation, Release 6.9.xxxxx.0

Revision No. Description
85-106

• New Asset Type named ‘Anode’ and new Event Type ‘Anode Condition’ used to track
depletion of internal vessel anodes.

• New AIG ‘Anode Inspection Plan and History’ interrogates and summarises latest anode
condition.

• CVI (Internal) campaign interval now considers internal vessel anodes when deriving
inspection interval.

• AS1210 Structural Minimum Thickness calcs updated for Post 2010 nozzles.
• RBI Update - Ensures all inspections meet a user configurable maximum interval criteria

from new field ‘Maximum Allowable Interval’.
• RBI Update - Allow a default interval to be defined to non RBI’d assets
• Minor bug fixes and improvements

33-84
• Rationalisation of design data AIGs to minimise duplication of data entry and visualisa-

tion.
• Upgraded inspection schemes to align with API 581 based logic.
• Removal of fixed ‘SPE reports’ and creation of a configurable ‘report elements’ reporting

template
• Created new Grid UT event
• Vessel Data AIG transferred to tube bundles (previously used piping data AIG)
• Vessel Data AIG: Component geometry types added to vessel data (Piping, tubes, header

box, flat head) inclusive of tmin calcs
• (Optional) Structural min thickness for vessels added based on AS1210
• Rationalisation of lookup functions to improve performance

Customers with a current subscription to this expert system can access a comprehensive (technical) list detailing all
minor UI changes and bug fixes. You can email support@nexusic.com to request the complete list.

21.1.7.1.6.1 SPE Expert System Content

The Static Pressure Equipment (SPE) expert system comes with the following elements:
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21.1.7.1.6.2 Asset Types

Asset Type Description
CML Condition Monitoring Location
Corrosion Circuit (lvl 0) RBI Component (API 580)
Corrosion Loop Corrosion Loop Grouping
Dead Leg Piping Dead Leg
Fired Heater Pressure Systems Equipment Parent
Fired Heater Segment (lvl 0) RBI Component (API 580)
Heat Exchanger Pressure Systems Equipment Parent
Heat Exchanger Bundle (lvl 0) RBI Component (API 580)
Heat Exchanger Vessel (lvl 0) RBI Component (API 580)
Nozzle Nozzle
Piping Pressure Systems Pipework Parent
Piping Line Line level piping (below Corrosion Circuits - NOT RBI’d)
Storage Tank Pressure Systems Equipment Parent
Storage Tank Segment (lvl 0) RBI Component (API 580)
Vessel Pressure Systems Equipment Parent
Vessel Component Line level vessel (below Vessel Component (lvl x)- NOT RBI’d)
Vessel Segment (lvl 0) RBI Component (API 580)
WML Weld Monitoring Location

Back to Overview
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21.1.7.1.6.3 Asset Information Groups (AIGs)

AIG Name Category Description
Availability / Operability Status General Data
Calculation Parameter General Data
CML Inspection Plan Inspection / Mitigation
CML WT History Inspection / Mitigation
CoF Review CoF
Dead Leg Assessment
External Inspection Plan Inspection / Mitigation
External: Metal Loss / Cracking DM Review
General Data Pressure Systems Model
HE External Cracking DM Review Identical to IC, but for outside of HE tube

bundles
HE External Metal Loss DM Review Identical to IML, but for outside of HE tube

bundles
Inspection History Inspection / Mitigation
Inspection Planner Inspection / Mitigation Layout of individual inspection tasks
Inspection Scheme Inspection / Mitigation Summarises the inspection requirement for

the asset
Internal: Cracking DM Review
Internal: Metal Loss DM Review
Metallurgical / Mechanical DM Review Metallurgical / Misc Damage Mechanisms

from API 571
Piping Data General Data
Risk Overview RBI
Vessel Data General Data
WML History Analysis
WML Inspection Plan Inspection / Mitigation

Back to Overview

21.1.7.1.6.4 Risk Models

High-level diagram summarising risk assessment approach. It should identify each damage
mode/mechanism as a single item and also call out compliance with individual codes.

Back to Overview
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21.1.7.1.6.5 Inspection / Maintenance Events

Event Type Description Assigned to Types
Ad-Hoc Updates All
Anomaly (Ad-Hoc) All
CML - Grid UT CML
CML - WT Reading CML
CML - WT Reading
Rejected

CML

Coating Application RBI Level, Piping Line, Vessel Component, CML,
WML, Dead Leg, Nozzle

Cracking Inspection RBI Level
CUI Visual Inspec-
tion

RBI Level, Piping Line, Vessel Component

CVI (External) RBI Level, Piping Line, Vessel Component, CML,
WML, Dead Leg, Nozzle

CVI (Internal) Invasive Visual inspection of
Equipment

RBI Level, Piping Line, Vessel Component

Dead Leg Survey RBI Level, Piping Line, Vessel Component, CML,
WML, Dead Leg, Nozzle

DPI Pre-Inspection RBI Level, Piping Line, Vessel Component, CML,
WML, Dead Leg, Nozzle

ECI Pre-Inspection RBI Level, Piping Line, Vessel Component, CML,
WML, Dead Leg, Nozzle

FM RBI Level, Piping Line, Vessel Component, CML,
WML, Dead Leg, Nozzle

GVI RBI Level, Piping Line, Vessel Component
Lining Visual In-
spection

RBI Level, Piping Line, Vessel Component

MPI Pre-Inspection RBI Level, Piping Line, Vessel Component, CML,
WML, Dead Leg, Nozzle

RT Pre-Inspection RBI Level, Piping Line, Vessel Component, CML,
WML, Dead Leg, Nozzle

Surface Prep RBI Level, Piping Line, Vessel Component, CML,
WML, Dead Leg, Nozzle

UT Pre-Inspection RBI Level, Piping Line, Vessel Component, CML,
WML, Dead Leg, Nozzle

WML - Cracking In-
spection

WML

WT Survey RBI Level

Back to Overview

21.1.7.1.6.6 Dashboards

Template Name Description Category
Anomaly Dashboard Primary interface for anomaly status, assignment and ac-

tions
Inspection Dashboard For inspection scheduling and task assignment
Risk Dashboard Overview and interface for high level risk assignment
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Back to Overview

21.1.7.1.6.7 Reports

Template Name Description Category
SPE - CML WT Tasks Generates CML WT Tasks as import sheet for selected

workpack, with guidance included
SPE Reports

SPE - CML/WML IMR Listing [Generate in Excel] For child assets of the asset selected,
this report displays a listing of the
Inspection Plan for CMLs

SPE Reports

SPE - Dead Leg Register [Generate in Excel] For child assets of the asset selected,
this report displays a list of dead legs
along with dead leg details and last/next inspection date.

SPE Reports

SPE - DLR/TR Register For child assets of the asset selected, this report displays
a list of defined life
repair and temporary repair actions as well as the corre-
sponding anomaly details including anomaly risk score

SPE Reports

SPE - Inspection Plan Listing For child assets of the asset selected, this report displays
a listing of
the Inspection Plan

SPE Reports

SPE - Inspection Plan Report This report displays Asset
Description, Design Information, Current Condition,
RBI Summary, Inspection Plan, Examination Scheme
and associated Drawings

SPE Reports

SPE - RBI Summary Report For Corrosion Circuits select the RBI Asset only. For
Pressure Vessels or Heat
Exchangers select the Parent level Vessel or Heat Ex-
changer to generate for each RBI child asset. This report
displays the PoF’s
and CoF’s for RBI’ed Assets

SPE - Elements A report containing multiple reports from the base sys-
tem that can be used to help accelerate construction of
other reports.
Use the “Retrieve Element” button to transfer selected
items to your new report.

Miscellaneous

ò Note

All dashboards and reports are present within the ‘SPE Elements’ report template and are created as required by
the customer during configuration and are therefore editable.

Back to Overview

21.1.7.1.6.8 Client-Specific Lists

Wood delivers “out-of-the-box” configuration for the global tables and lookup lists listed below. These tables and
lookup lists are delivered without data. To ensure that the system works effectively, customers must populate them with
their own company-specific data upon deployment. Wood can provide sensible default data if required.
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Type Name Description
Lookup List Coating Type A list of client specific coatings which map to None, Medium,

High
eg. Epoxy Phenolic; Epoxy Zinc Phosphate; Asphalt Mastic

Lookup List CoF Scores List of CoF categories to suit client Risk Matrix
eg. A;B;C;D;E

Lookup List Condition of Work List of shutdown conditions required for enactment of inspection
eg. Total plant shutdown; Online inspection

Lookup List Material Spec and Grade - Pip-
ing

List of Client Piping Material Specs
eg. ASTM A105 / Gr. . . ; ASTM A106 Gr A; ASTM A106 Gr B;
ASTM A106 Gr C

Lookup List Material Spec and Grade -
Storage Tank

List of Client Tank Material Specs
eg. A36; A131-A, B, CS; A131-EH 36; A573-58

Lookup List Material Spec, Grade and Con-
dition

List of Client Vessel Material Specs
eg. SA/GB 713 / Gr Q370R / Normalized; SA/JIS G3118 / Gr
SGV480 / . . . ; SA–1008 / Gr CS–A / . . .

Lookup List PoF Scores List of PoF categories to suit client Risk Matrix
eg. 1;2;3;4;5

Lookup List System Type / Fluid - Lookup Client System Types
eg. Isomerization; Sour Water Stripper; Sulfur Recovery

Lookup List/s Inspection Event Attributes There are ~50 lookup lists which are used in inspection
event definitions that can be populated to suit existing client prac-
tices/procedures.
eg. Coating Types; Coating Condition; Insulation Type

Global Table Applicable Damage Mecha-
nisms

For each System Type add applicable DMs from set list
eg. Isomerization; 09. Hydrochloric Acid Corrosion

Global Table Database Configuration High level database specific info
Global Table Inspection Effectiveness Assigns Effectiveness A..D for each Cof/PoF combination

eg. 1,1,D; 1,2,D; 1,3,D
Global Table Inspection Frequency Matrix Assigns Frequency (in days) CoF/PoF combination

eg. 1,1,144; 1,2,144; 1,3,120
Global Table Remaining Life Factor Assigns RL ranges for each PoF
Global Table Risk Rank Categories / Scor-

ing
Assigns PoF and CoF ranges for failures/year,
Consequence Area, Financial Consequence, Spill Volume, No.
Affected personnel etc.

Global Table Risk Rank Categories / Scor-
ing (Tube Bundle)

Assigns PoF and CoF ranges for failures/year,
Consequence Area, Financial Consequence for Tube Bundles
only

Global Table Risk Rank to Risk Score Assigns text value to each PoF/CoF combination
Global Table Stress Value and MDMT List of Client Material Types with associated From/To Temps and

From/To Stress Values
eg. SA 240 Gr 2507 UNS S32750, 204.44, 260, 242005.99,
237869.13

Global Table Table 1A ASME BPVC II Part
D and DM Applicability

Global Table Table 4-1 - Max Allowable
Shell Stresses and DM

Global Table Table 5A ASME BPVC II Part
D

Global Table YS and TS (Piping) and DM
Applicability

Global Ta-
ble/s

Inspection Plan - There are 12 lookup tables which are used for the generation of
inspection schemes, they include
Inspection Plan - External Cracking and Inspection Plan - In-
ternal Metal Loss etc.21.1. Expert Systems Hierarchy 769
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Back to Overview

21.1.7.2 SPE Plus Expert System

21.1.7.2.1 Overview

The Static Pressure Equipment Plus (SPE+) Expert System contains the SPE configuration and adds on a semi-
quantitative Risk Based Inspection Methodology that integrates with the SPE AIGs and enhances the assessment of
equipment probability of failure.

This methodology enables semi-quantitative assessment of all damage mechanisms identified within API 571. Where
possible, elements of API 581 are used for definition of probability of failure; when not assessed by API 581, alternative
guidance is deployed based in line with API RP 571 guidance and Wood’s engineering experience.

21.1.7.2.2 Codes / Standards

In addition to the references listed here, SPE Plus includes Codes/Standards defined in the SPE Expert System.

“Managing Sand Production and Erosion”, DNV ref. DNV-RP-O501, 2015 (amended2021) “Petroleum and Natural
Gas Industries —Materials for use in H2S-containing environments in oil and gas production”, NACE reference, MR-
0175 / ISO 15156, 2020 “Guidelines for the avoidance of vibration induced fatigue failure in process pipework”, The
Energy Institute, 2nd Edition, January 2008 “Calculation of Heater Tube Thickness in Petroleum”, API Ref. APISTD
530,7th Edition, 2015. Andijani, S. Turgoose, Prediction of oxygen induced corrosion in industrial waters, Water
Science and Technology, 2004, Vol 49, Iss 2, pp 115-120.

21.1.7.2.3 Asset Types

In addition to the Asset Types listed in the follow table, SPE Plus includes Asset Types defined in the SPE Expert
System.

Asset Type Description
Corrosion Circuit (lvl 0+) RBI Component (SPE+)
Fired Heater Segment (lvl 0+) RBI Component (SPE+)
Heat Exchanger Bundle (Lvl 0+) RBI Component (SPE+)
Heat Exchanger Vessel (lvl 0+) RBI Component (SPE+)
Storage Tank Segment (lvl 0+) RBI Component (SPE+)
Vessel Segment (lvl 0+) RBI Component (SPE+)

21.1.7.2.4 Asset Information

Asset Description Assigned to
Type(s)

Creep (API 530) Tmin and accumulated damage calculations for RBI RBI Level
EML/EC PoF Semi-quantitative data for External Metal Loss and Cor-

rosion
RBI Level

HE EC PoF Semi-quantitative data for External Corrosion on Heat
Exchanger components

RBI Level

HE EML PoF Semi-quantitative data for External Metal Loss on Heat
Exchanger components

RBI Level

IC PoF Semi-quantitative data for Internal Corrosion RBI Level
IML PoF Semi-quantitative data for Internal Metal Loss RBI Level
MET PoF Semi-quantitative data for Metalurgical damage mecha-

nisms
RBI Level
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21.1.7.2.5 Risk Models

High level diagram summarising risk assessment approach. (Should identify each damage
mode/mechanism as a single item & also call out compliance with individual codes)

21.1.7.2.6 Inspection / Maintenance Events

There are no additional event definitions in SPE Plus over and above the Inspection / Maintenance Events defined in
the SPE Expert System.

21.1.7.2.7 Dashboards / Reports

Template Name Description Category
SPE+ (semi-quantitative POF)
Analysis

‘How to’ Guides

CML WT Tasks Generates CML WT Tasks for selected workpack Inspection

21.1.7.2.8 Client Specific Lists

An implementation of SPE Plus will require the population of the Client-Specific Lists defined in the SPE Expert
System.

21.1.7.2.9 Revision History

The following table summarises new and updated feature sets that have been included in major releases of the Expert
System.

Revision No. Description
23-43

• Assessment of Liner condition is now included in the Internal Metal Loss Assess-
mentnLiner condition is assessed in accordance with API 581 - a damage factor (and
equivalent PoF) is calculated based on the time since last inspection. As time since last
inspection increases, so does PoF of the liner condition. Theoretical PoF is calculated as
the minimum of Liner PoF and PoF of the baseline material based on exposure to process
fluids.

• Assessment of Internal Anode condition now included within Internal Metal Loss Assess-
ment. CP condition is used as a ‘PoF multiplier’ where a ratio of expected remaining life
(based on degradation to date vs. installation date) to required remaining life is calculated.
Theoretical PoF (the output of Liner / base material POF) is reduced progressively based
on the remaining life ratio of the internal anodes.

• New Quantitative Inspection Interval Calculation option created - Interval can be defined
as a multiple of calculated remaining life, where the multiple can be determined based on
the risk of the asset.

• All changes in SPE to Rev 106 (Revision History)

1-22
• Inspection scheme logic updated to align to API581 logic.
• Inspection Coverage recommendations provided and based on 581 logic.
• All changes in SPE to Rev 84 (Revision History)

A comprehensive (technical) list detailing all minor UI changes and bug fixes can be made available to customers who
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have a current subscription to this Expert System. You can email support@nexusic.com to request the complete list.

21.1.7.3 API 581 Expert System

21.1.7.3.1 Overview

The API 581 expert system incorporates the SPE and SPE+ expert system and provides a fully compliant API 581
assessment tool for analysis of equipment risk and inspection planning. This methodology is integrated into the SPE
API 580 RBI functionality such that qualitative override – or assessment of non-API581 damage mechanisms – is
possible. In addition to this, an API581 / SPE+ hybrid functionality is used which deploys SPE+ PoF assessment and
API581 CoF assessment in the event that damage mechanisms are present that are NOT covered by API 581.

API 581 provides additional fully quantitative RBI methodology on top of SPE Plus.

21.1.7.3.2 Codes / Standards

“Risk-Based Inspection Methodology”, API Ref API RP 581, 3rd Edition 2019

21.1.7.3.3 Asset Types

In addition to the Asset Types listed in the follow table, API581 includes Asset Types defined in the SPE Expert System
and Asset Types defined in the SPE Plus Expert System

Asset Type Description
AST Bottom (lvl 1) RBI Component (API 581)
AST Course (lvl 1) RBI Component (API 581)
Corrosion Circuit (lvl 1) RBI Component (API 581)
HE Tube Bundle (Contained)(lvl 1) RBI Component (API 581)
HE Tube Bundle (Uncontained)(lvl 1) RBI Component (API 581)
Heat Exchanger Vessel (lvl 1) RBI Component (API 581)
Inventory Groups RBI Component (API 581)
PRD (lvl 1) RBI Component (API 581)
Vessel Segment (lvl 1) RBI Component (API 581)
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21.1.7.3.4 Asset Information

Asset Description Assigned to
Type(s)

External Metal Loss / Cracking PoF Calculation using API RP 581 3rd Edition
HTHA and Brittle Fracture PoF Calculation using API RP 581 3rd Edition
Internal Cracking PoF Calculation using API RP 581 3rd Edition
Internal Metal Loss PoF Calculation using API RP 581 3rd Edition
Inventory Group Information
L2 CoF Calculations (1)
L2 CoF Calculations (2)
L2 CoF Calculations (3)
L2 CoF Calculations (4)
L2 CoF Calculations (5) -
Flammable
L2 CoF Calculations (6) - Toxic
L2 CoF Calculations (7) -
NFNT, Area, Financial
L2 CoF Calculations Summary
L2 CoF Inputs
Mechanical Fatigue PoF Calculation using API RP 581 3rd Edition
PRD Data and Assessment
PRD RBI - Protected Compo-
nent

21.1.7.3.5 Inspection / Maintenance Events

In addition to the events listed below, SPE Plus includes Inspection / Maintenance Events defined in the SPE Expert
System and Inspection / Maintenance Events defined in the SPE Plus Expert System.

Event Type Description Assigned to
Type(s)

Defect Assessment (Part 5 Lvl1) API 579 Part 5 level 1 defect Assessment
Defect Assessment (Pt4 lvl1) -
GWL

General Wall Loss

PRD Inspection
Tube Bundle Inspection or
Record

21.1.7.3.6 Dashboards / Reports

Template Name Description Category
API 581 COF Analysis ‘How to’ Guides
API 581 POF Analysis ‘How to’ Guides
API 581 Risk Assessment Re-
sults

‘How to’ Guides
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21.1.7.3.7 Client Specific Lists

An implementation of API581 will require the population of the Client-Specific Lists defined in the SPE Expert System.

21.1.7.3.8 Revision History

The following table summarises new and updated feature sets that have been included in major releases of the Expert
System.

Revision No. Description
1-10

• Refined inspection plan output to based coverage on risk as calculated at the target risk
date and not immediate risk

• Inspection Coverage recommendations provided and based on 581 logic
• Hybrid asset (SPE+ PoF and API 581 CoF) created
• All changes in SPE to Rev 84 ( Revision History )
• All changes in SPE+ to Rev 22 ( Revision History )

A comprehensive (technical) list detailing ALL minor UI changes and bug fixes can be made available to customers
who have a current subscription to this Expert System. Please email support@nexusic.com to request the complete list.

21.1.8 Wells Expert System
21.1.8.1 Overview

The Wells Expert System is an “off the shelf” configuration in NEXUS IC that is tailored to Oil and Gas, Geothermal and
UGS Operations in both onshore and offshore locations. It is seamlessly integrated with NEXUS standard functionality
such as anomaly management, workpacks and inspection data.

It can be configured to suit any client risk matrix or severity grading profile and provides all necessary functionality to
define and manage safe operating limits.

The Wells expert system includes:

• Barrier integrity status monitoring (OLF 117)

• MAASP Calculation (ISO 16530-1)

• Well Failure Scenario Analysis

• Risk Assessment

• Well Barrier Schematic generation

• Configurable performance traffic lighting

• Dispensation management

• Erosion and Corrosion modelling

• Inspection planning

• Dashboard generator

• Report generator

If you have been using the iWIT well integrity management software, migrating to the NEXUS Wells expert system
provides a number of benefits. For more information, see Migrating from iWIT to Wells Expert System.
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21.1.8.2 Benefits

The Wells expert system offers the following benefits:

• Fully pre-constructed and tested methodology aligned to industry standards

• Access to ISO16530/API 6A (and other) engineering calculations and tools as standard

• Automated process workflows, which reduce engineering resource burden

• Interactive dashboard allows you to focus on priorities as they arise

• Get a ‘helicopter view’ of each region

• Highlight high-risk areas easily

As a consequence, using the Wells expert system can provide the following commercial benefits:

• Direct RBI cost reduction (no methodology development time, minimal configuration time)

• 80% reduction in reporting cost

• 40% reduction in inspection reporting costs (through digital enactment)

21.1.8.3 Content

The following figure shows the elements that are delivered with the Wells expert system. For more information, click
on the nodes of the figure below or see Wells Expert System Content.

21.1.8.4 Codes/Standards

• ISO 16530-1 1st ed. Well Integrity – Part 1: Life cycle governance

• NORSOK D-010 Corr 2. Well Integrity in Drilling and Well Operations
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• NORSOK U-001 5th ed. Subsea Production Systems

• API Spec 17D 3rd ed. Specification for Subsea Wellhead and Tree Equipment

• API Spec. 6A 21st ed. Specification for Wellhead and Tree Equipment

• API Spec. 5CT 10th ed. Casing and Tubing

• API RP 14A 12th ed. Specification for Subsurface Safety Valve Equipment

• API RP 14B 6th ed. Design, Installation, Operation, Test, and Redress of Subsurface Safety Valve systems

• API STD 6AV2 2nd ed. Installation, Maintenance, and Repair of Safety Valves

• API RP 90-1 2nd ed. Annular Casing Pressure Management for Offshore Wells

• OLF 117 rev 6 Recommended guidelines for Well Integrity (Norwegian Oil Industry Association)

21.1.8.5 Deployment Prerequisites

The following configuration is not automatically deployed as part of the “out-of-the box” expert system and needs to
be configured manually:

• Client corporate logos (used in header/footers in reports)

• Report styles (corporate fonts and colours used in reports)

• Client risk matrix (corporate risk matrix)

• Security groups (Wood can recommend typical security groups if required)

21.1.8.6 Revision History

This is the first major release of the expert system.

21.1.8.6.1 Wells Expert System Content

The Wells expert system comes with the following elements:

21.1.8.6.1.1 Asset Types

Some predefined asset types are available for Wells assets and the components underneath it. A complete list of available
asset types can be provided upon request.

Back to Overview

21.1.8.6.1.2 Asset Information Groups (AIGs)

AIG Name Category Description
Qualitative Risk Assessment Risk Inputs into the Base Qualitative Risk Model
Risk Assessment Sign off / Ac-
tions

Approvals Sign off / approvals for Risk assessments
with action register

Drilling Programme Informa-
tion

Design Data Drilling Programme

Tubing Design Design Data Tubing
Packers Design Data
Perforations Design Data
Well Overview Design Data Well Overview

continues on next page
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Table 2 – continued from previous page
AIG Name Category Description
Xmas Tree Installation Design Data Xmas Tree
Valve Performance Inspection Results
Inspection / Test Plan Inspection
Well Component - General Data Design Data SCE Component - General Data (Wells)
Annulus Data Design Data
Deviation Survey Design Data Deviation Survey
Casing Design Design Data Casing Summary
MAASP Inputs Design Data
MAASP Summary Design Data
Pressure Test Performance Inspection Results
Weak Point Formation Design Data
Integrity Status Configuration Integrity Status
Well Integrity Status Wells
MAASP Results Design Data
Well Risk Assessment Well Risk Assessment
MAXIMO External References Standard Maximo Asset Identification at-

tributes
ExSys Revision History
Well Barrier Schematic Well Barrier Schematic
FMECA Probability Assessment
Failure Assumptions Consequence Assessment
FMECA General Information General Information
Asset Configuration Probability Assessment
Annulus Performance Inspection Results
Cement Data Design Data
Mud Data Design Data
Sensor General Information Design Data
IOW ML Information IOW IOW ML information, allowing connection

to external source
IOW Management IOW
Reminders Wells
Availability / Operability Status Maintenance
ECE Sensor Configuration ECE - Expert System
ECE Calculator Analysis
Corrosion Analysis Analysis
Well KPIs
WBS Element Reference

Back to Overview
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21.1.8.6.1.3 Inspection / Maintenance Events

Event Type Description
Well - Annulus Leak Test
Well - Caliper Log
Well - Component Pressure Test
Well - Elevation Monitoring
Well - Integrity Test
Well - Leak Test
Well - Marine Survey
Well - Sub Surface Integrity Test
Well - Sustained Annulus Pressure Test
Well - Valve Function Test
Well - Visual Inspection

Back to Overview

21.1.8.6.1.4 Dashboards

The Wells Expert System inherits all the dashboards from the Default Configuration (see Reports and Dashboards). In
addition, the Wells - Dashboard Elements template is available, from which you can pick Wells-specific dashboard
elements to create your own dashboard as required.

See examples for Wells-specific dashboards below:

ò Wells Integrity Overview Dashboard
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Back to Overview

21.1.8.6.1.5 Reports

The Wells Expert System inherits all the reports from the Default Configuration (see Reports and Dashboards). In
addition, the Wells - Report Elements template is available, from which you can pick Wells-specific report elements
to create your own reports as required.

See examples for Wells-specific reports below:

Back to Overview

21.1.8.6.1.6 Client-Specific Lists

Wood delivers “out-of-the-box” configuration for the global tables and lookup lists listed below. These tables and
lookup lists are delivered without data. To ensure that the system works effectively, customers must populate them with
their own company-specific data upon deployment. Wood can provide sensible default data if required.
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Type Name Description
Lookup List WFAM Severity
Global Table Annulus Pressure Traffic Light
Global Table Inspection Intervals
Global Table Inspection Windows
Global Table MAASP Components
Global Table MAASP Pressure Derating

Factors
Global Table MAASP Safety Factors
Global Table Performance Standards
Global Table Well Anomaly Asset Applica-

bility Matrix
Global Table Well Traffic Light Configura-

tion
Global Table WFAM Scenarios

Back to Overview

21.1.8.6.2 Migrating from iWIT to Wells Expert System

The Wells expert system of NEXUS is replacing the iWIT well integrity management software as the main Well integrity
management software offering and Wood plans to end support for iWIT at the end of 2024.

21.1.8.6.2.1 Benefits

Migrating to the NEXUS Wells expert system from iWIT offers a number of direct improvements and benefits to you,
including:

• NEXUS Integrity Centre is developed on SQL Server, which means that you won’t be required to have an Oracle
application available (which is the current database structure for iWIT).

• Moving to the NEXUS IC system will provide you with the flexibility to either internally host the database as an
on-premise application, or subscribe to a SaaS cloud-based system. IWIT currently only provides on-premise
deployment options.

• The NEXUS IC infrastructure allows you to subscribe to the Wells Integrity Expert System, which allows us to
rapidly deploy enhancements, upgrades, changes to codes and standards in an efficient manner.

• NEXUS IC accommodates bespoke modifications to suit your own business needs (for example, bespoke dash-
boards, reporting, notifications) while leveraging all the benefits associated with the expert system subscription.

• NEXUS IC is designed to accommodate considerable end-user modifications, which avoids the need for person-
alised modifications having to be an expensive programmer involved process. Expert users in your own organi-
sation or our extensive team of operational support and deployment technicians can perform rapid modifications
to the system (for example, adding a new report function).

• NEXUS IC has a number of expert systems covering a wide range of applications and as such has a large global
development support team and our ability to quickly provide operational support which will greatly enhance your
current support network.
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21.1.8.6.2.2 Additional Features

NEXUS provides all iWIT functionality with the following additional features:

• Digital workpack management and enactment through IC Inspector (see IC-Inspector)

• Inspection management interface to store multimedia, trend data and identify anomalies

• Library functionality to capture drawings and documentation referenced by components

• Anomaly management interface to ensure well failures are appropriately risk assessed and remediated

• Customisation reporting engine to enable creation of bespoke reports independently

• Enhanced, configurable dashboarding system (including ISO compliant WBS dashboard) to create your own
bespoke interfaces

For detailed information about the features offered by iWIT as compared to the NEXUS software suite, see iWIT-NEXUS
Feature Comparison.

21.1.8.6.2.3 iWIT-NEXUS Feature Comparison

See the tables below for a comparison of features offered by iWIT versus the NEXUS Software Suite.

ò Note

The NEXUS Software Suite offers different solutions and deployment options and there may be differ-
ences in the features that they support. For more information, see NEXUS Feature Matrix.
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21.1.8.6.2.4 Generic Features
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21.1.8.6.2.5 Fixed Reports (Legacy iWIT Reports)
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21.1.8.6.2.6 Configuration/Administration Features

21.1.8.6.2.7 Migration Process

There are two different migration processes from iWIT to NEXUS depending on the deployment option you select.

21.1.8.6.2.8 Migration - SaaS Deployment

1. You contact Wood to request migration.

2. Based on your requirements, a SaaS agreement is prepared and executed.

3. You take the iWIT database offline and provide a copy of it to Wood.

4. Wood migrates your data to NEXUS. This process may take approximately one to two weeks.

5. Wood provides training and handover.

21.1.8.6.2.9 Migration - On-Premises Deployment

1. You contact Wood to request migration.

2. You take the iWIT database offline and provide a copy of it to Wood.

3. Wood migrates your data to NEXUS. This process may take approximately one to two weeks.

4. Wood sends you an installer for NEXUS software and the migrated SQL database backup.

5. You deploy the NEXUS infrastructure (see Deployment On-Premises).

6. You restore the NEXUS SQL database backup.

7. Wood provides training and handover.
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CHAPTER

TWENTYTWO

FAQS

Q: I have an on-premise NEXUS implementation, can I subscribe to an Expert System?

A: Yes, you can.

Q: How can I purchase an Expert System configuration?

A: Email support@nexusic.com. Someone from our team will contact you to let you know the one-off
cost of the Expert System configuration. Each Expert System will attract a nominal annual subscription
fee to allow you to obtain future updates to the Expert System. Expert System costs will depend on the
complexity of the configuration.

Q: I want to request a change to an Expert System, can I?

A: Certainly, email support@nexusic.com and the SME responsible for the Expert System will evaluate
all requests from the subscribers. If the request is generic and all other subscribers would benefit from
the change, then it is likely that the change will be implemented and an new revision published to the
subscribers.

Q: I have a subscription to an Expert System, how will I know when there is an update available?

A: You will be notified by Wood when an Expert System update is available. To get the latest version of
the Expert System, a person with sufficient permissions in your NEXUS IC database can login to NEXUS
and download it. The changes will be applied to your database and details of the revision are shown.

Q: Will the Expert System subscription process work with different versions of NEXUS?

A: It depends, the Expert System subscription process checks the database Schema version to determine
whether or not the subscription update is allowed. As a general rule, database schema versions will not
change between major releases. For example, if you are running v6.8.14587 and the Expert System is
currently on v6.8.25897, then the subscription will be allowed because both versions will be running on
the same database schema version (8.211).

Q: Can I add new attributes to Asset Information forms which belong to the Expert System?

A: Yes, you can. Adding new fields will not break the link between your database and the Expert System
you have subscribed to. However, we recommend that if you need additional attributes, then you should
create new Asset Information forms.

Q: Can I edit attributes of an Asset Information form which belongs to an Expert System?

A: No, not without breaking the link between your database and the Expert System you have subscribed
to. If you decided that you want to obtain future updates to the Expert System, then changes that you made
will revert back to the Expert System configuration.
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CHAPTER

TWENTYTHREE

GENERAL INFORMATION

The following topics contain information relating to software deployment, technical and release information.

23.1 Technical Information
You can find additional technical information as described below:

• NEXUS provides support for a number of command-line switches. For more information, see Command-Line
Switches.

• You can download the latest version of the database schema diagram from Database Schema Diagram.

• To understand the mechanics of the solution, visit the Software Based Licensing page.

• For information about common administration tasks in NEXUS, see NEXUS Administration Tasks.

• IC-Web includes a REST API. For more information, see REST Service Specifications v2.0.

• If you want to understand the technical background behind the way video playbacks work, see Managing Videos.

• A PDF version of these Help pages can be downloaded from https://docs.nexusic.com/6.9/nexus.pdf.

23.1.1 Command-Line Switches
You can launch NEXUS IC with various command-line switches. The NEXUS IC executable is named ‘IntegrityCen-
tre.exe’. This can be useful when launching NEXUS IC from a Windows Explorer shortcut, or when configuring a
RemoteApp icon.

Below is an example of how to run NEXUS IC with debugging information enabled. These steps can also be used for
IC-Inspection, by using the ‘Inspection.exe’ instead of ‘IntegrityCentre.exe’.
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Method 1: Launch NEXUS via Desktop Shortcut

• Create a desktop shortcut to Integrity Centre

• Right click on the shortcut and select ‘Properties’.

• On the ‘Shortcut’ tab page add -debug after the location in the Target field - See image on right

• Click Ok to save the changes.

• Run the shortcut to launch Integrity Centre with debugging enabled.

Method 2: Launch via Command Prompt

• Click Start - type ‘cmd’ and press enter to open Command Prompt.

• Paste the following and press enter:

start "" "C:\Program Files (x86)\NEXUS\IntegrityCentre.exe" -debug

You must include the “” (empty double quotes) before the exe location in your command. The file path
must point to your local installation path for NEXUS.

Log File:
The log file is located at:

C:\Users\[username]\AppData\Roaming\NEXUS

For Integrity Centre, the log file is named ‘IntegrityCentre_Trace.log’, for IC-Inspection the log file is
‘Inspection_Trace.log’

A shortcut to this location is:

%AppData%\NEXUS
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23.1.1.1 General Options

Name Command Example Usage Description
Dock -dock IntegrityCentre

-dock=Anomalies
If you use a command-line switch beginning with ‘-dock=’
and ending with a dock name, NEXUS IC will launch with
that dock open. Valid dock names are ‘Dashboards’, ‘Assets’,
‘Library’, ‘Planning’, ‘Workpacks’, ‘Inspection’, and ‘Anoma-
lies’. They are case-insensitive.

Disable
Single
Sign-
On

-DisableSSO IntegrityCentre
-DisableSSO

If you have previously logged in to a NEXUS database using
domain credentials, then on subsequent runs you will be au-
tomatically logged in again with those credentials. You can
either select Database → Close, or you can run NEXUS IC
with the command-line switch ‘-DisableSSO’.

Offline
Mode

-offline IntegrityCentre
-offline

When limited/no internet connection is available, startup
times can be reduced by running NEXUS IC in ‘offline’ mode.
This will prevent NEXUS from re-validating the license. The
licenses check will still fail if the grace period has been ex-
ceeded.

Prevent
display
of
Library
dock or
Export
Reposi-
tory

/iad IntegrityCentre
/iad

You can use command-line switch /iad to prevent NEXUS IC
displaying the Library dock or Database → Export Reposi-
tory.

23.1.1.2 Debugging and Tracing

NEXUS IC and IC-Inspection log information to the folder C:Users[username]AppDataRoamingNEXUS. Note that
you should only use debug switches if instructed to do so by Wood technical support, as they can significantly impact
performance. If you start NEXUS IC with a debug switch, you will see a dialog reminding you of this.
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NameCommand Example Usage Description
In-
for-
ma-
tional

-informationalIntegrityCentre
-informational

Log informational messages.

Er-
ror

-error IntegrityCentre -error Log error messages and everything less verbose

De-
bug

-debug IntegrityCentre -debug Log debug, informational and warning messages.

De-
bug
(1-
4)

-debug1
-debug2
-debug3
-debug4

IntegrityCentre
-debug#

Log debug information. These are ordered here from least
verbose to most verbose.

Launch
with
cre-
den-
tials

/dbuser=
/dbpass=

IntegrityCentre /
dbuser=username /
dbpass=pA55w0rd

Log in with predefined username and password. If, in the Con-
nect to Database wizard you have selected “Specific Windows
/ Domain User”, the dbuser and dbpass you specify will be
passed to SQL Server as domain credentials.

Launch
with
cre-
den-
tials
(SQL
Server
Au-
then-
ti-
ca-
tion)

/dbuser=
/dbpass=
/sqlauth

IntegrityCentre /
dbuser=username /
dbpass=pA55wOrd /
sqlauth

If you would like to connect to the database using SQL Server
Authentication, then use the /sqlauth switch along with the
username and password. The user will still be given a login
prompt allowing them to provide NEXUS credentials, which
will determine which NEXUS user account will be used to
identify any changes they make to the database.

23.1.2 Utility Tools
You can use a database management utility tool to perform database backups and restores. This tool can be operated
via the command line and is available in the base installation folder (where IntegrityCentre.exe is stored). Therefore,
this tool is only available for On-Premise or Offshore deployments, it’s not available for Software as a Service (SaaS).

See below for detailed information about its usage:

792 Chapter 23. General Information



NEXUS Documentation, Release 6.9.xxxxx.0

Name Com-
mand

Example Usage Description

Help -h DBManagement.exe -h Provides information about usage, example
and parameters for each of the Backup, Re-
store, and Restore (with Credentials) com-
mands.

Backup /
backup

DBManagement.exe /backup /
sql=MySQLServer /db=MyDatabase
/username=admin /password=admin
/path="C:\Database Backups"

Tells NEXUS IC to backup a database. For
example, it can be used for automated back-
ups of a live database.

Restore /
restore

DBManagement.exe /restore /
sql=MySQLServer /db=NewDatabase
/path="C:\Database Backups\
MyDatabase.nexus-backup"

Tells NEXUS IC to restore a database. For
example, it can be used for automated re-
freshing of a sandpit database.

Restore
(with
Creden-
tials)

/
restore

DBManagement.exe /restore /
sql=MySQLServer /db=NewDatabase
/path="C:\Database Backups\
MyDatabase.nexus-backup" /
username=admin /password=admin

If you are overwriting an existing database,
you must additionally supply credentials, to
demonstrate that you have the appropriate
authority to overwrite.

23.1.3 Database Schema Diagram
Click to download a copy of the latest core database schema diagram pdf

23.1.3.1 Change History

23.1.3.1.1 8.216

• Removed Report_Parameters.Last_Value

• Added Multimedia.Source

• View_Node.Has_Children changed to a calculated field

23.1.3.1.2 8.215

• Added Approval_Group table

• Added Approval.Operation

23.1.3.1.3 8.214

• Added Report_Template.Asset_Dashboard

• Removed Report_Template.Is_Asset_Dashboard

• Removed Signoff.Description

• Added Signoff.Comments

• Removed Finding_Signoff.Description

• Added Signoff.Comments

• Removed Header.HasComments

• Removed Finding.HasComments
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• Added Repository_Data.Thumbnail_Data

• Added Personnel.Job_Title

• Added Description, Category to Chart

• Added Vertical_Align, Text_Orientation and numerous field changes to Report_Style

• Added Form_Page.Page_Order

• Added Table_Def.Supports_Attributes

• Added Comp_Type.Prevent_Duplicates

• Added Report_Category.Enabled

• Added Finding_Status table and Finding.FS_ID

• Added Drawing_Properties, Client.Job_Retention, remove unused fields.

23.1.3.1.4 8.211

• Added User_Setting table.

23.1.3.1.5 8.210

• Added table indexes to optimise some calculations and row retrievals.

• Updated ‘Library’ icon.

23.1.3.1.6 8.209

• Added Comp_Type.Category

• Added Action.Is_Due

• Added Anomaly.Assigned_To_ID

• Renamed Anomaly.Created_By to Anomaly.Created_By_ID

• Added Anomaly.CV_ID

23.1.3.1.7 8.208

• Added Report_Schedule.SU_ID

23.1.3.1.8 8.207

• Increased Session.IP_Address to 45 characters

23.1.3.1.9 8.206

• Added Security_Hash.Session_ID

23.1.3.1.10 8.205

• Added Visible and Order (IC-Inspector) to Field Definition as passthrus

• Changed Personnel.Email to be 254 characters

• Added Category to Scenario

• Added RBI_Model_Comp_Type table
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• Added Filter_Order to Workflow_Filter

23.1.3.1.11 8.204

• Added Server_Job table

• Added Est_Timing_FD_ID and Requires_Shutdown_FD_ID to LTIP_Task

• Added Allow_Adhoc to LTIP_Task

• Added Enabled to Workflow

• Added LinkTD_ID to Field_Def

• Added Include_Timestamp to Report_Schedule

23.1.3.1.12 8.201

• Increase Workpack.Abbreviation to 15 characters

23.1.3.1.13 8.199

• New chart series types

• Added Function_Definition.Readonly

• Added Approval.Link_ID

• Added Active_Inspection.Is_Inspecting

23.1.3.1.14 8.198

• Increased size of Library.Name to 100 characters

23.1.3.1.15 8.196

• Added Layer.Auto_Layer_Id

23.1.3.1.16 8.195

• Added Expert_System.Signature

• Added Expert_System_Row.Manual

• Added Task.Retasked_Same

• Added Task.Is_Held

23.1.3.1.17 8.194

• Added Form_Caption, Visible_Mobile, Mobile_Order and Mobile_Caption to Field_Layout

• Added LTIP.WPG_ID and LTIP.Revision_ID

• Added Series.Opacity

• Added Chart.Available

• Added Layer.Relative_Asset

• Change Action.Created_By and Assigned_To to FK’s to Personnel

• Added Table_Def.Allow_History
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• Added Finding.Status

• Added LTIP_Task.Instructions_FD_ID

• Added Bound.Include_Bounds

• Added Report_Schedule.FD_ID

• Added Overlay_Value.Legend_Order

• Added Finding.Finding_Number

• Added Finding.Has_Comments

• Added Export_System, Expert_System_Row, and Expert_System_Version tables.

23.1.3.1.18 8.193

• Added Table_Def.Auto_Calculate field

23.1.3.1.19 8.191

• Added Keepalive to Report_Schedule

23.1.3.1.20 8.188

• Added Field_Def.Require_Unique and Field_Def.Unique_FD_ID

• Added Task.Reference_Number

• Added Line Weights for Series

• Added Planning Task.Asset_Location

23.1.3.1.21 8.187

• Added Library.Force_2D

• Added Bound.Date_From, Bound.Date_To

23.1.3.1.22 8.186

• Added Workflow_Item_Input.Attribute_Name

• Added Approval, Approval_Note and Approval_Field tables

• Added Client.Secondary_Logo

23.1.3.1.23 8.185

• Added Asset_Location to Task, Finding, Event, Anomaly

• Added Asset_Location to Library_Conn

• Added Asset_Location to Component

• Added RS_ID to Report_Template, and Report_Status table

• Added Unit.Description

• Added Workpack.Event_Count
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23.1.3.1.24 8.184

• Added Report_Schedule.Status

23.1.3.1.25 8.181

• Removed Report_Template.IsWelcomePage

• Renamed Report_Template.IsDashboard to Is_Asset_Dashboard

• Added Chart.Show_X_Axis_Title and Chart.Show_Y_Axis_Title

23.1.3.1.26 8.180

• Renamed function GetDate to ‘Current Date/Time’, added ‘Current Date’.

• Removed Range Event Type.

23.1.3.1.27 8.179

• Removed Report_Template.Last_Generation_Time

• Added new Report_Generation table.

23.1.3.1.28 8.178

• Added FP_ID to Workflow_Item_Input.

23.1.3.1.29 8.177

• Changed Report_Part.Name to 200 characters.

• New calculated fields for Library_Conn and Library.

23.1.3.1.30 8.176

• Added Allow_Adhoc (bit) to Task.

• Added Adhoc_Complete (bit) to Task.

• Added Report_Favourite table.

• Added Dashboard_Report (bit) to Report_Template.

• Added Supports_Dashboard (bit) to Report_Part_Type.

• Added Schedule_Repeat table.

• Added Report_Schedule table.

23.1.3.1.31 8.174

• Added Map_Server table.

23.1.3.1.32 8.173

• Added Expiry (datetime) field to Repository_Data table.

• Added Text_Align table and TA_ID (int) field to Field_Layout table.

• Added Allow_Add (bit) to Form_Page table.
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23.1.4 Software Based Licensing
Licenses are controlled in NEXUS through a software license key and occasional communication with a License Server.
The NEXUS application contacts the software license server using the standard HTTPS protocol. All information is
encrypted in transit between your computer and the NEXUS License Server.

23.1.4.1 Validate the Software Based License

1. Launch NEXUS.

2. When you connect to the database the first time, you will be prompted to enter the license key. This
brings up the dialog under Database → Properties → License.

3. Enter the license key that was provided by Wood.

4. Click on Request License.

5. NEXUS communicates with the NEXUS License Server via the internet and exchanges license
information associated with your implementation including:

• Server Name

• Database Name

• License type

• Number of licenses available to your organisation
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• [GRACE PERIOD] in days. Usually this is set to 30 days.

6. This information is then stored (encrypted) in the database, and is shown in the dialog:

23.1.4.2 Assign Licenses to Users

If you are using Named Users licensing, a Named Users section will appear at the bottom of the License tab in the
Properties dialog. In this case, you can assign licenses to one or more users as follows:

1. Select the row of the module you want to assign licenses for, for example, NEXUS IC.

2. Click Assignment.
The Select Users dialog appears, showing accounts that currently have licenses assigned. To remove an assign-
ment, select a user and click Exclude.

3. To assign licenses to new users, click Include in the Select Users dialog.

4. In the Select Personnels dialog, select the users to whom you want to assign the licenses.
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ò Note

If the license limit has been reached and you select more users than the available licenses, the system will
assign licenses to the users that were selected last during the selection process.

5. Click OK.

Users who are not selected will get a message saying that they are not authorised. This includes the user account that
you are logged in under when you set up this license.

23.1.4.3 Subsequent License Validations

Each time a user launches the NEXUS application, it will contact the NEXUS License Server to validate the license
stored in the database against the license issued from the server. Upon successful connection and validation, the grace
period is re-set.

If NEXUS is unable to contact the NEXUS License Server for some reason (external Internet connection is not avail-
able, for example), then NEXUS will still run providing the license has been validated within the grace period.

ò Note

If nobody launches NEXUS for more days than the grace period, the next time NEXUS is launched, it
will contact the NEXUS License Server to validate and reset the grace period.
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23.1.4.4 Re-authentication

The only circumstances under which re-authentication is required is when the database name OR the database server
name is changed.

ò Note

Your license validation is tied to your database server name. If the database server name changes, the
license will show as invalid. This can happen if you have two different client executables (NEXUS
IC, IC-Inspection, etc.) connecting to the same server under different names. For example, one might
be connecting to a server named “.” while the other is connecting to a server named “127.0.0.1” or
“localhost” or “192.168.0.1” or “databaseservername”. If this happens, ensure that all clients are using
the same database server name, and validate the license again.

23.1.4.5 Offshore Use

Software licensing is designed with offshore use in mind. Note the following:

• If you plan to use NEXUS IC in an offshore area without internet connectivity, it is important to connect a single
workstation to the internet before leaving the internet range. You can do this by hot-spotting it to a mobile phone.
After connecting to the internet, start NEXUS IC on that workstation to validate the license. This will ensure
that you have your full grace period. If you expect to be without internet access for more than the grace period,
please contact support@nexusic.com, and we can temporarily increase your grace period.

• While backing up your database from one server and restoring it to another, you will be asked to re-validate the
license. To do this, you will need to connect a workstation to the internet temporarily. This usually happens
during mobilisation, but may also occur in case of catastrophic failure of the primary database server. Please
note that complete failure of a database server is rare.

23.1.5 NEXUS Administration Tasks
The following sections describe common administration tasks around the deployment and maintenance of NEXUS IC.

23.1.5.1 Regular Backups

Daily scheduled SQL backups should be performed by an SQL Maintenance job. Retention policy is at your discretion.

23.1.5.2 Ad Hoc Backups

Standard NEXUS users can take backups as and when required using Database → Backup menu item. Backups are
recommended prior to imports or large scale database changes. For more information, see Create a Backup.

23.1.5.3 Database Restores

Database restores must be performed by the NEXUS SQL Admin. We recommend using the NEXUS application to
perform database restore of the proprietary .nexus-backup (or .aimbak for older versions) files. If restoring from
the daily backup then restore should be performed using SQL tools. Confirm that the User Group has [dbowner]
permissions on any restored databases.

23.1.5.4 Restore a Database

Set up a shared network folder, which is accessible to both the database server and to NEXUS IC. This may be a UNC
path (like ‘\\MyServer\MyShare’) or, if the database server and NEXUS IC are running on the same machine, it may
be a Windows path (like ‘C:\Database Backups’). Copy the NEXUS IC database backup file into this folder.
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ò Note

When restoring the NEXUS IC Database to the SQL Server, you may not have sufficient permissions to create
databases on the SQL Server. In this case, contact your SQL Administrator to restore the database using SQL
Management Studio (or similar).

23.1.5.5 Add a User

There are two steps to adding a new user to the NEXUS database:

1. In Active Directory, add the user to NEXUS Users Group.

2. In NEXUS IC, go to Database → Security and add a new user as described in Create a New User.

23.1.5.6 Edit User’s NEXUS Permissions

In NEXUS IC, go to Database → Security and set up permissions as described in Set Up Permissions for User/User
Group.

23.1.5.7 Remove a User

Although it is possible in NEXUS we do NOT recommend deleting a user because this will delete all audit history
associated with that user. To disable a user:

1. In NEXUS IC, go to Database → Security and edit the user profile. On the Login tab, deselect the enabled
checkbox.

2. In Active Directory, remove the user from the NEXUS Users Group (or disable the user account).

23.1.5.8 Refresh or Update Software License

If the database name or SQL server name change, then the NEXUS licensing will become invalidated. To refresh the
license, proceed as follows:

1. Navigate to Database → Properties (see Properties Dialog).

2. Go to the License tab.

3. Enter the unique license key, overwriting whatever text is presently there.

4. Press the Request License button.

License information will be retrieved over the internet within a minute or so.

23.2 Frequently Asked Questions
• User Management

• Usability

• Performance

• Integration

• Support

• Data Integrity

• Data Validation

• Security
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• Encryption Protocols

• Accreditation

• Mobility

23.2.1 User Management

Question Answer
Are there definable and config-
urable user roles and permis-
sions?

We provide fully configurable security groups and associated permissions de-
fined at table level. For more information, see Manage User Security and Per-
missions.

How does security event logging
work?

Audit log tracks sessions, create, update and delete actions. Read actions are not
tracked, but logins and logouts are.

How does user authentication
take place: local AD domain
(for example, integration with
Purchaser’s environment)/cloud
domain (for example, Azure
AD)/other?

• SaaS via RemoteApp: Wood provides the service of managing user ac-
counts and responding to password reset requests. Integration with cus-
tomer AD is not available.

• SaaS via SSO: Authentication is managed through a cloud domain using
Microsoft Entra ID. Users are authenticated via Single Sign-On (SSO)
with their company user accounts. SSO has to be set up by the company
as described in Software as a Service (SaaS) Deployment. Note that for
security reasons, authentication is restricted to a single customer domain.

Does the system enable enforc-
ing password complexity? If
so, what parameters can the Pur-
chaser control and what are the
standard/initial settings?

Yes, per Microsoft Azure AD standards.

23.2.2 Usability

Question Answer
Can the NEXUS suite be used
offline? • A number of applications in the NEXUS suite are specifically designed

for offline use - for example, IC-Inspection and IC-Inspector.
• Web-based applications require an internet connection to function.
• For field-based campaigns, a “subscriber” database can be used as an of-

fline copy that can be synced into the master on return to base.

What help tools and informa-
tion are available? Are they
database-specific or generic to
all databases?

• Typically training material is customised to the final configuration of the
customer database.

• System help is provided in the form of hover-hints and labels for fields.
• Generic application help is available online via the online documentation

and accessible from within the app.

Is the software for mobile use or
desktop use? • NEXUS IC and IC-Web are primarily designed for desktop use.

• IC-Inspector is our mobility app which is specifically designed for field-
based data acquisition in tablet-sized screens.

• There are no apps designed for smartphone-sized devices.
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23.2.3 Performance

Question Answer
How is software performance af-
fected by customer configuration
changes?

• Performance optimisation is a key element of testing and development.
• Complexity of customer-specific configuration can have a performance

impact. Wood will work with the client to ensure reasonable system per-
formance.

Where are the reports and RBI
calculations done, are they per-
formed in the Client or in the
DB?

Calculations are performed in the Client, not in the database.

Does the solution have the abil-
ity to refresh information, run
reports and calculation updates
quickly without causing system
crashes or long delays?

Performance of the calculations depend on calculation complexity.

What is the general system avail-
ability/uptime? • SaaS hosting is deployed in MS Azure and has a proven history of greater

than 99.9% uptime.
• Access to NEXUS via SaaS may be temporarily unavailable for scheduled

maintenance or for unscheduled emergency maintenance due to causes
beyond Wood’s control. The window for daily automated maintenance of
servers is typically out of hours (for example, 0200 to 0400) and will NOT
always result in service downtime. This maintenance window allows crit-
ical security issues to be addressed promptly after the release of a relevant
patch. Any necessary ‘non-routine’ downtime during business hours is
scheduled and approved with client contact.

23.2.4 Integration

Question Answer
Does the system have integration
APIs?

NEXUS has a published REST API for data-level integration with third-party
systems. For more information, see REST Service Specifications v2.0.

What ports are required to pro-
vide the service?

Port 443 (using HTTPS).

What’s the process for CMMS
PM/MM integration?

Experience has shown us that the most effective system connectors are imple-
mented in a collaborative partnership between the company technical experts and
NEXUS technical experts. The scope of the CMMS integration will be guided
by company requirements, which may or may not include two-way communica-
tion.
Our standard approach for creating system connectors is the following:

• Workshop workflows and data flows between systems
• Identify each connector and their requirements
• Implement any required changes in NEXUS and/or other system (for ex-

ample, SAP)
• Collaboratively define, configure and test the connector script (with each

expert team writing the appropriate section of the connector)
See integration.connector.example for an example of the workflow.
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23.2.5 Support

Question Answer
On solution upgrades, can the
process be performed without
vendor participation, unless re-
quested?

• For on-premise deployments: The upgrade process is performed by run-
ning the new setup file. The setup process will automatically handle all
changes needed including database schema updates.

• For SaaS deployments: The NEXUS infrastructure team will handle the
upgrades with minimal interruption to operations.

How are support tickets sent by
clients processed?

There are 2 tiers of support:
1. Tier 1 - Regional office support: The regional Wood office can be sup-

ported any time (via phone, or email) to provide support.
2. Tier 2 - Global support system: Tickets are raised and managed in a central

tracking system that is monitored by Wood’s NEXUS team globally. This
allows prompt response.

What is the escalation process of
a sustainment ticket? • Support requests are logged into central tracking system and monitored by

global support personnel.
• Support tickets are triaged and either addressed, or assigned to relevant

person/team for investigation.

Is there a regular release cycle?
• Typical release cycle sees a minor point release every 6 to 12 months.
• Major releases are typically issued every 3 to 5 years.

What support hours do you offer
your global customer base?

The Support Portal is monitored office hours 9:00am to 5:00pm by personnel in
4 main regions:

• Perth - GMT +8
• Brisbane - GMT +10
• Aberdeen - GMT
• Houston - GMT -6

What type of support is pro-
vided?

Support is typically provided via email, screen share, or phone where necessary.

How long does it take to get a re-
sponse and a resolution for an is-
sue that we are experiencing?

Normal response time is within 24 hours, with a target maximum resolution time
of 72 hours. User management requests and other high priority issues are usually
addressed within 24 hours.
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23.2.6 Data Integrity

Question Answer
How do you ensure zero data
loss system failure/data redun-
dancy?

MS SQL database backend stores all data after commit. SaaS via MSAzure pro-
vides levels of redundancy and recovery. The hosted service is resilient to single
server failures through the use of redundant Azure infrastructure and provides
coverage in the event that a data centre goes offline. Wood replicates database
backups to other geographical regions.

Where is my data stored? SaaS hosting is deployed in MS Azure, at data centres appropriate to the client
solution. Wood currently has deployments in UK South, South Central US and
Australia East. See Data residency in Azure.

How are actions logged for au-
diting?

Audit log tracks sessions, create, update and delete actions. Read actions are not
tracked.

How is the backup task exe-
cuted?

Database backups are taken automatically each business day.

Who can configure a backup
task?

End users with appropriate permissions can initiate a backup from within the
application on demand.

How long is the backup stored? Backups are retained for 14 calendar days. Additional backups for longer term
retention can be held by agreement or transmitted to customer. This may have a
cost impact.

How are backups secured? All backups are retained in dedicated storage secured for each customer. Storage
is encrypted using AES256-based encryption keys.

Are there separate development,
testing and production environ-
ments available?

Yes. We provide a test database by default. Development environment is avail-
able upon request. This may have a cost impact.

What is the backup/data restora-
tion methodology? Are disas-
ter recovery tests conducted reg-
ularly?

Yes, tests are performed at least annually. The service level objectives are:
• Restore Point Objective: maximum 24 hours
• Restore Time Objective: maximum 48 hours

What is the procedure for man-
aging client data after the termi-
nation of a SaaS contract?

Upon the conclusion of a SaaS contract, we adhere to a stringent data manage-
ment protocol to ensure the security and integrity of client data. The process is
as follows:

1. Transmit final database backup and any video files to customer.
2. Confirm receipt.
3. Delete all virtual machines and client data.

23.2.7 Data Validation

Question Answer
What data is validated? All input data is validated for type consistency (numeric, Boolean, and so on).

Field-specific validation rules can be defined.
Import utilities must provide
logging or an audit trail of both
success and errors encountered
during import. How do you en-
sure this?

Import engine performs test import before modifying data. If errors are found,
the import process is aborted and user must rectify errors before data will be
modified.

What data export utilities are
available to extract data in stan-
dard formats (that is, Excel or
CSV)?

Almost anything in the database can be dumped to CSV, or push/pulled from
REST calls, provided users have appropriate permissions.
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23.2.8 Security

Question Answer
What is your application secu-
rity model that ensures avoiding
unauthorized access and/or dele-
tion of data?

Users are assigned to security groups. Security groups have permissions to ta-
bles allowed/restricted. Users can only access or edit tables permitted by their
security permissions.

Is the solution able to lock down
fields coming from Maximo in-
terface?

Specific fields can be configured to be Read-Only, regardless of the data source.

Can NEXUS track changes
within the database for reporting
and audit purposes?

The Audit log in NEXUS logs every change to every field in the database.

Does the solution have the abil-
ity to secure data modifications
on specific fields to only Admin
or defined User Roles?

Specific fields can be configured to be Read-Only based on a pre-defined work-
flow logic. This includes the logged-in user.

How do you ensure Incident Re-
sponse Compliance? • Wood has developed its security infrastructure using industry standards

and guidelines to be complaint with ISO27001/27002, cyber essentials,
NIST, government, and department of defense information technology and
European union (EU) general data protection regulations (GDPR).

• Wood has a global procedure for crisis and emergency management, which
supports a robust IT and information security incident response process
that covers all levels of security incident or data breaches scenarios. Wood
has third-party forensics capabilities, ERS and incident response resources
and will ensure that the customer is notified of any breach and the follow-
ing actions.

How are systems patched to
avoid system downtime?

Under SaaS deployment, the application and/or server infrastructure may be
patched automatically as required. The window for daily automated mainte-
nance of servers is typically out of hours (for example, 0200 to 0400) and will
NOT always result in service downtime. This maintenance window allows criti-
cal security issues to be addressed promptly after the release of a relevant patch.
Any necessary ‘non-routine’ downtime during business hours is scheduled and
approved with client contact.

What is the average patch time
for systems and service applica-
tions?

Typically patches are applied within maintenance window and takes 10-15 min-
utes.

Do you offer network segmen-
tation to protect individual ser-
vices and databases?

Every customer has its own dedicated server cluster to ensure data security.

Can users be authenticated
against an external identity
management system? For exam-
ple, Microsoft Active Directory
(AD) for on-premise, Azure
Active Directory (AAD) via
SAML2 for cloud hosted, Single
Sign-On (SSO).

• SaaS via RemoteApp: This deployment does not offer SSO.
• SaaS via SSO: Authentication in SaaS deployments is managed through a

cloud domain using Microsoft Entra ID. Users are authenticated via Single
Sign-On (SSO) with their company user accounts.

Who controls access to our data
under SSO?

With SSO, your organisation will have complete control over user access. Your
IT team will manage domain accounts and, if configured, Active Directory (AD)
group memberships that determine access to NEXUS.

Can third-party contractor
domains be granted access to
NEXUS?

No, Wood cannot grant access. Allowing access to third-party contractor do-
mains poses a security risk and may lead to unintended data exposure. For
example, if your organisation grants access to AAA Inspection Company, and
another NEXUS client also uses AAA, inspectors from AAA could potentially
access data from both organisations. To maintain data integrity and security, ac-
cess must be managed strictly within your organisation’s domain.
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23.2.9 Encryption Protocols

Question Answer
What data encryption practices
do you follow?

All data is encrypted in motion and at rest. Data will likely be travelling over pub-
lic networks and is protected from unauthorised viewing and tampering. Web
app and hosted solution both use HTTPS, which encrypts data in flight. Our
Azure VMs are encrypted using Azure Platform Managed Keys. These are en-
cryption keys that are generated, stored, and managed entirely by Azure. Cus-
tomers do not interact with platform-managed keys (PMKs).

How is data encrypted in mo-
tion?

Data transmitted over public networks is protected from unauthorised viewing
and tampering. Our web and desktop apps use HTTPS, which encrypts data in
flight using the cryptographic protocol TLS 1.2 or higher.

How is data encrypted at rest? Data at rest is stored in Microsoft Azure virtual machines using Server Side
Encryption (SSE) with Platform Managed Keys (PMKs).
Data on Azure-managed disks is encrypted transparently using 256-bit AES en-
cryption, which is compliant with Federal Information Processing Standards
(FIPS) 140-2. By default, managed disks use PMKs, which are managed by
Microsoft. All managed disks, snapshots, images, and data written to existing
managed disks are automatically encrypted-at-rest with PMKs. Customers do
not have to interact with these keys.

23.2.10 Accreditation

Question Answer
What certification or accredita-
tion of the solution is main-
tained?

The NEXUS team is currently working towards obtaining ISO27001:2022 ac-
creditation for the NEXUS solution.

Are there independent audits of
security practises?

Third-party threat detection tools are used as an automated part of the build
process to provide security scorecard and vulnerability detection. Any newly
identified risks are promptly reviewed and mitigated. Additionally, both internal
and independent audits and penetration testing are carried out to maintain the
ISO27001:2022 accreditation.

23.2.11 Mobility

Question Answer
Can you describe the mobil-
ity capabilities of your solu-
tion? Can tablets be used as
Read/Write vehicles?

• IC-Inspector is the fully integrated mobility solution. IC-Inspector is a
tablet application optimised for inspection data collection using an iPad.

• IC-Inspector communicates with a NEXUS REST server to receive tasks
and drawings, and to upload inspection data. It can be used for inspec-
tion with no Internet connectivity, although it does require connectivity to
initially receive tasks and finally sync inspection data back to the master
database.

What platforms are supported
for using IC-Inspector?

iPad, Windows tablet, Android tablet
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23.3 Known Issues

Description Wood
Internal
Refer-
ence

The playback quality of high-definition video files from Azure blob storage can sometimes be sub-
optimal, resulting in occasional pixelation and jerkiness. The recommended best practice is to use IC-
Web for playback, where the quality is as recorded.

#55164

To fix the display high DPI display issue:
1. Press Ctrl+Alt+End to sign out of your NEXUS application.
2. Go to the desktop.
3. Right-click and choose Display Settings from the context menu.
4. Set the scale to 100% for ALL displays.
5. Choose a display resolution that works for you with the scale set to 100%.
6. Close the Settings dialog.
7. Reboot the machine (this is important).

#53354

For hosted clients only: Reports generated from NEXUS sometimes display Date fields in an unexpected
format. As a workaround, pass the Date field into a function that force formats the dates to the required
format.

#48638

Sorting by the Connected To column in the Library grid for grids with more than ~500 rows will take
some time to complete. Clicking the Cancel button will not successfully cancel the sort action once it
is in progress.
Recommendations:

• Hide the Connected To column if possible.
• Do NOT sort by the Connected To column unless absolutely necessary.
• If you must sort by the Connected To column, wait patiently for the sort to complete (it may take up

to 30 minutes) then take the necessary action and then IMMEDIATELY sort by another column
(for example, Name or Doc Ref or Doc Date).

Warning:
If you fail to sort by a different column, then, when you navigate away from the LIBRARY screen or
exit the application, these sort settings will be saved and you will have to wait for the sort to complete
again on next load.

#45063

Electronic Corrosion Engineer (ECE) is not supported in the 64-bit version of NEXUS IC. #42062
NEXUS IC, IC-Inspection and IC-Recorder does not fully support the Dark mode colour feature setting
available in Windows.

N/A

SVG Grey scale issue: If you view SVG images and you select the Grey Scale option, the image may
appear with a solid black background, and thus black portions of the image may be obscured.

#8358

3D drawing not displayed: 3D drawings originally drawn with SESAM GeniE jacket and then converted
to DWG may not display. This is because our third-party 3D DWG viewer does not cope with these
DWG files. (It is possible that these particular files do not adhere to the DWG standard.)

#8331

Layer hovering doesn’t work with 2D DWG file: when you hover over a region on a regular drawing
(JPG, PDF), the opacity of the region changes slightly. When you hover over a region of a 2D DWG file,
the opacity does not change.

#7725

3D drawing structure error: Some 3D DWG files show minor rendering errors when viewed in NEXUS.
Again, this is a limitation of our third-party 3D DWG viewer.

#7630
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ã See also

Migration to SSO - Known Issues

23.4 Upgrading

23.4.1 IC-Inspection 5 Users
If you’ve upgraded from IC-Inspection version 5 to version 6, here are some quick things that you should know:

• The window manager has been replaced with the same panel manager used in NEXUS IC 6’s Inspections screen.
See Manage My Desktop for more details.

• All grids in version 6 work in the same way. Once you’ve learned one of them, you’ve essentially learned them
all. (Exception: There are one or two grids where the new multi-edit feature doesn’t work.)

• The Events toolbar is gone — use the Event Launcher and/or shortcut keys set up through Event Templates
instead.

• The Events pane is now called Active Events.

• The Database Information pane is now called Active Inspection.

• The Assets window no longer has a column to show the number of remaining tasks. An Incomplete Tasks traffic
light has been created to replace this feature.

• Asset information is now editable in IC-Inspection, if the user has that security permission.

• Text overlay is now part of Devices. Text Overlay Server is gone, as text overlay functionality is now incorporated
directly into IC-Recorder (and some other third-party DVRs).

• The following windows are removed: CP Stab, Operation, Survey Charts, Video, Video Recorder. (If you want
video preview, just run an IC-Recorder.)

• The Task Information summary showing number of tasks remaining has been removed. If you want similar
functionality back, add a traffic light.

• Pipeline View (and Pipeline View Secondary) have been replaced with the all-new 3D Pipeline View.

• We now support 3D DWG drawings. (Bear in mind that large 3D DWGs may be slow.)

• If you are using a third-party DVR, you should test its integration with IC-Inspection 6 well ahead of your inspec-
tion. Third-party DVRs must now support our generic DVR control protocol to be supported in IC-Inspection.

See also NEXUS IC 5 Users upgrade notes.

23.4.2 NEXUS IC 5 Users
If you’ve upgraded from NEXUS IC version 5 to version 6, here are some quick things that you should know:

• All grids in version 6 work in the same way. Once you’ve learned one of them, you’ve essentially learned them
all. (Exception: There are a couple of grids where the new multi-edit feature doesn’t work.)

• Speaking of which, multi-edit is new and very powerful.

• The list of major areas at the left of NEXUS IC 6 should be immediately familiar, but there are now no sub-
selections within each of those areas. Configuration is moved to the Configuration menu. (Of course all those
Configuration screens are made of standard grids, and all work in the same way.)

• Some areas are missing because they’ve been incorporated into other screens. For example, 4-Site has now been
incorporated into the Assets → Risk screen.
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• The old Scheduling → Schedules screen’s View → Assets and View → Workpacks are now the Planning and
Workpacks screens respectively.

• Tools → Options is where it’s always been, but there’s less in it. Things specific to your database are now in
Database → Properties.

• You can rearrange Asset Information tabs by drag-dropping them.

• We now support 3D DWGs. (Bear in mind that large 3D DWGs may be slow.)

• Drawings are now a special kind of Library Item. If you add one drawing to several different assets, it now gets
added as a library item once, and connected to those several different assets, thus saving database space.

• Setting up a sheet for import is a bit different: in version 5, you created a sample sheet for import by exporting
something. In version 6, you instead use the Import wizard’s Example button.

• Configure Chart Templates and Configure Traffic Lights are configured differently in version 6.

23.4.3 Upgrading from an earlier v6 version
1. Ensure that you have a NEXUS user account which is in the Administrators Security Group, and that the account

has read/write access to special permission Upgrade Schema.

2. In your current version of NEXUS, perform a backup of the database (we suggest that this backup file is perma-
nently archived).

3. Run the installer on the Application Server (or on users’ individual PCs).

4. Have one of the users from Administrators security group launch NEXUS IC v6 from the desktop shortcut and
click on OK to update the database schema. The schema update will take some time to complete (about 1-10
minutes), so please be patient when the Status dialog appears.

ò Note

If you are currently using a HASP key license, you will need to switch to Software Based Licensing.

ò Note

If you’re upgrading from 6.0, 6.1 or 6.2, see this note about SQL Server permissions.

See the relevant What’s News for highlights of changes.

23.4.4 Upgrading from v5
If you are upgrading from NEXUS IC version 5:

• We suggest consulting with us. Email us at support@nexusic.com.

• Ensure that you have used NEXUS 5’s Database Backup feature to take a backup of your version 5 database and
have put the backup in a safe place. We suggest that this backup file is permanently archived.

• In NEXUS IC 5, ensure that a user account exists that has permission to upgrade the database. In Database →
Security, check Security Areas → Asset Integrity Manager → Schema Update for both the Administrators group
and the user account you plan to use. If in doubt, set both to read/write.

• Make another backup.
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• In NEXUS IC 5, set the security permission back to forbid the Schema Update permission. The reason for this is
to prevent a user who is experimenting with version 6 from accidentally upgrading your live version 5 database.
Once a particular database is upgraded to version 6, version 5 software will be unable to open it.

• Restore the database with NEXUS IC 6 from the backup which has its security permissions set to allow the
upgrade. We recommend not just connecting to the existing database, because if you do this you will not get an
option to set a backup path. This backup path is necessary for the upgrade to work correctly.

You will receive an upgrade prompt. Note that the upgrade is irreversible (which is why you took a backup) and may
take some time. (It’s OK to kick it off in the evening and check the results in the morning — it doesn’t need watching.)

At the end of the upgrade, NEXUS IC 6 will have written a log, giving details of its actions. This log is named
IntegrityCentre_Trace.log and can be found in C:\Users\[USER_NAME]\AppData\Roaming\NEXUS.

Search this for the word “Warning” or the phrases “Warning[tab]Storage Engine” or “Warning[tab]Schema”. This
latter phrase covers the most important issues. All these are warnings, not errors — they are merely here to let you
know about changes that were made. Information messages can be safely ignored. Preserve a copy of this log file —
otherwise it will be overwritten next time you restart NEXUS IC.

If you run into any problems, contact us with a pre-upgrade backup of the database and/or a copy of the log file.

Traffic lights and report templates will not be ported from version 5 — you will need to recreate these afresh in your
new version 6 database. (This is because these features work in a different way in version 6, for speed reasons.)

23.4.5 Upgrading IC-Web to v6.6 (or later)
IC-Web 6.6 is now running a 64-bit rest service ISAPI module. Previous versions were 32-bit.

What needs to change? - You need to ensure that the “Enable 32-bit applications” attribute for the application pool
running IC-Web is set to False.

For New Website Setup
1. If you are setting up IC-Web for the first time or created a new website for 6.6, the installer will handle this for

you just run the installer and install the new site by following the instructions in the installer.

For Existing Website Upgrade
If you have IC-Web 6.5 (or earlier) installed and use the “update” option in the installer, these extra steps need to be
undertaken manually when the installer is finished running.

1. Open IIS and expand node on the left until you see “Applications Pools” and select it.
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2. Select the application pool that the IC-Web website is using (default application pool name is “ICWeb”) and
right click on this application pool and select “Advanced Settings. . . ”.

3. Find “Enable 32 Bit Applications” and change the value from True to False.
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4. Double check “Enable 32 Bit Applications” is definitely now set to “False” and press “Ok” on the Advanced
Settings window to save that change.

5. Restart your IIS service.

23.5 Third-party DVRs
IC-Inspection can be used to remote control digital video recorders during online inspection (see Add a Third-Party
DVR Device), providing a permanent link between the inspection data and the video record. In addition to controlling
our own IC-Recorder, the following DVRs are also controlled by IC-Inspection 6:

• EdgeDVR (Digital Edge)

• Fugro DVR

• NETmc DVR

• Seascape DVR

• SIMS Offshore

• SubC DVR

• VisualDVR (FET)

A standard DVR control protocol has been developed and is available for purchase.

To configure a VisualDVR to accept commands via the protocol, perform the following steps:

1. Left-click on the main video preview.

2. In the dialog that appears, select Systems Setup & Admin → Advanced → NEXUS IC DVR control.

3. Tick Enable NEXUS IC DVR control.
For other products, consult manufacturer documentation.

23.5. Third-party DVRs 815

http://www.nexusic.com/dvr-protocol


NEXUS Documentation, Release 6.9.xxxxx.0

23.6 Other Documentation
A training manual, showing how to use IC-Inspection for offshore eventing and NEXUS IC for offshore review, is
available.

23.7 Dialog Helps
Find below the list of help pages that describe settings in specific dialogs in NEXUS. These help pages are available
when you click the Help button in these dialogs.

23.7.1 Add/Edit Anomaly Dialog
See below for the description of fields in the Add Anomaly/Edit Anomaly dialogs.

In the Add Anomaly dialog, only the Anomaly tab is visible, the other tabs get displayed once you have saved a new
anomaly and start editing it.

• Anomaly tab:
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Field/Checkbox
Name

Description

Asset The name of the asset that the anomaly is attached to. This is a required field.
Name A name that uniquely identifies the anomaly. Note that the name cannot exceed 50 characters.
Description A 100-character field that provides more descriptive information of the anomaly.
Code A code that identifies the type of anomaly. Anomaly codes are customizable by users and can

be configured as explained in Configure Anomalies. Typical examples of anomaly codes are
“CD”, “PD” or “VIB” (Coating Damage, Physical Damage or Vibration).

Severity You can choose from a list of pre-defined severity levels. These severity levels are customiz-
able by users and can be configured as explained in Configure Anomalies. Examples of sever-
ity levels include:

– “Level 1 - Contributor”
– “Level 2 - Degraded”
– “Level 3 - Damaged”
– “Level 4 - Danger”
– “Level 5 - Extreme Danger”

Anomaly severities can also be assigned to anomaly triggers and will be pre-populated from
the initial automatically generated finding, through the anomaly that the finding is linked to.

Anomaly
Number

A numerical property that can be used to store a number against the anomaly. This number is
not automatically populated.

Reference
Number

A 200-character limit field that can be used to reference or cross-reference anomalies.

Date Cre-
ated

The initial creation date for the anomaly, which defaults to today but is editable afterward.

Created By The name of the person creating the anomaly record. This defaults to the currently logged-in
user, but is editable afterward.

Anomaly
Set

The value of this field can be used as an alternative option for grouping anomalies. Anomaly
sets are customizable by users and can be configured as explained in Configure Anomalies.
Typical examples of anomaly sets include “Topside” and “Subsea”.

Assigned To The name of the person to which the anomaly record is assigned.
Comments A large free-text field designed to capture additional information about the anomaly, which

may not be adequately represented in the anomaly’s properties.
Priority You can choose from a list of pre-defined priorities. These priorities are customizable by

users and can be configured as explained in Configure Anomalies. Examples of priorities
may include “Very High”, “High”, “Medium”, “Low” or “Very Low”.

Status You can choose from a list of pre-defined statuses. These statuses are customizable by users
and can be configured as explained in Configure Anomalies.

Risk Score This is a calculated field, the function assigned to this field is named “System - Anomaly
- Risk Score” and must be configured (see Set Up Anomaly Risk Matrix). Different fields,
such as “Severity” and “Priority”, of the anomaly can be used as the input parameters for the
function.

Closed Out Indicates whether the anomaly is open or closed. Closed anomalies are normally excluded
from anomaly statistical reporting. If you use this checkbox to close an anomaly, no anomaly
action will be created for the close-out of the anomaly. We recommend that you close an
anomaly as described in Close Anomalies.

• Attributes tab:

This tab is visible only if the Anomaly system table has been extended with additional fields in your configuration.
You can fill those custom fields on this tab. For more information, see Configure Attributes.

• Findings tab:

On the Findings tab, you can see the findings linked to the anomaly being edited. This corresponds to
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the finding records that are shown on the Findings tab of the ANOMALIES screen when you select
the same anomaly in the anomaly list above. Note that on this tab, however, you cannot see the source
event information that you see on the Findings tab of the ANOMALIES screen. The columns that
you see on this tab mostly correspond to those on the Findings Listing tab of the INSPECTION
screen (see Findings Listing).

• Actions tab:

On the Actions tab, you can see the anomaly action items linked to the anomaly being edited. This
corresponds to the anomaly action items that are shown on the Actions tab of the ANOMALIES
screen when you select the same anomaly in the anomaly list above.

• Library tab:

On the Library tab, you can see the library items linked to the anomaly being edited. This is similar to the
Library tab of the ANOMALIES screen when you select the same anomaly in the anomaly list above, however,
in this specific dialog, you cannot see the library items that are linked to the anomaly’s asset, but only the library
items that are directly attached to the anomaly. If you want to see the library items attached to the relevant asset,
check the Library tab of the ANOMALIES screen.

• History tab:

See Checking History.

ã See also

Anomalies

23.7.2 Add/Edit Anomaly Action Dialog
See below for the description of fields in the Add Anomaly Action/Edit Anomaly Action dialogs.

In the Add Anomaly Action dialog, only the Anomaly Action tab is visible, the other tabs get displayed once you have
saved a new anomaly action and start editing it.

• Anomaly Action tab:

818 Chapter 23. General Information



NEXUS Documentation, Release 6.9.xxxxx.0

Field/Checkbox
Name

Description

Anomaly The name of the anomaly that this action belongs to. To change the anomaly that the action
is assigned to, click the button to the right.

Name A name that uniquely identifies the anomaly action. Note that the name cannot exceed 50
characters.

Status You can optionally select a status for the anomaly action. This list is user-definable and you
can add/edit/delete statuses from the Select Status dialog that is triggered when you click the

button in the field.
Reference
Number

A number that can be used to reference (or cross reference) the anomaly action. For example,
the number may relate to a Work Order number in your Planned Maintenance System.

Action Type Allows you to categorise your actions. Click the button in the field to select an action type
to be assigned to the anomaly action. The list is user-definable and you can add/edit/delete
action types as required. You can also assign an event type to the anomaly action by selecting
one in the Event Type field when creating or editing an action type. If you want to assign a
task to the anomaly action, you must assign an event type to the action type here.

Created At Enter the date when the anomaly action is created. This defaults to the current date, but is
editable thereafter.

Created By Select the name of the person creating the anomaly action. This defaults to the currently
logged in user, but is changeable thereafter.

Action Be-
fore

Enter a due date that the anomaly action should be completed by.

Assigned To Select the name of an individual or department that is responsible for progressing or complet-
ing the anomaly action.

Completed
At

Enter the date when the anomaly action was completed. Note that an anomaly action is not
deemed “completed” until there is a valid date entered in this field.

Percent
Complete

Enter a value between 0 and 100. This is for reporting and information purposes only.

Comments A large free text field that allows you to specify additional information about the anomaly
action, which could not be captured in the properties of the anomaly action.

• Attributes tab:

This tab is visible only if the Anomaly Action system table has been extended with additional fields in your
configuration. You can fill those custom fields on this tab. For more information, see Configure Attributes.

• Tasks tab:

Shows tasks associated with the anomaly action. You can also add a new task here, which opens the Add Task
dialog (see Add/Edit Task Dialog).

• Planning Tasks tab:

Shows planning tasks associated with the anomaly action. Anomaly actions can be assigned to a planning task
when editing the planning task (see Assign Anomaly Action to a Planning Task).

• History tab:

See Checking History.

ã See also

Anomaly Actions
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23.7.3 Add/Edit Asset History Dialog
The Add/Edit Asset History dialog appears when you create or edit an asset history record for an asset on the Asset
History tab on the ASSETS screen (see Asset History).

See below for the description of fields in the Add/Edit Asset History dialog:

Field/Checkbox
Name

Description

Title The title of the asset history record, for example, De-rated Pipeline.
Asset The asset associated with the history record. By default, this is set to the selected asset

in the asset tree. You can change it by clicking the ellipsis (. . . ) button.
Date Com-
pleted

The date when the recorded event occurred.

Comments Additional information or context relevant to the recorded event.
Workpack (Optional) Select the relevant Workpack if the asset history record relates to specific

Workpack data.
Event Type (Optional) Select the relevant Event Type if the asset history record corresponds to a

specific event category.
Calculated
Date

This field is automatically populated and may reflect one of the following:
• The Date Completed, if specified.
• The Workpack Date, if specified and Date Completed is not provided.

23.7.4 Add/Edit Chart Template Dialog
See below for the description of fields in the Add Chart Template/Edit Chart Template dialogs.

• Chart Template tab:

Field/Checkbox
Name

Description

Name Enter a name that uniquely identifies the chart template.
Description You can optionally provide more descriptive information about the chart template. This can

be a maximum of 100 characters.
Category You can optionally define a category for grouping chart templates.
Available Controls whether the chart is available for display in the relevant Charts panes on the AS-

SETS and INSPECTION screens. All chart templates are available for use in Configure
Report Templates, regardless of this setting.

Show Zoom
Bar

Controls whether a mini version of the chart will be shown at the bottom of the chart on the
INSPECTION screen. This is useful if you want to zoom a long way into the chart (which
is often the case on KP-based charts, for example).

Show Draw-
ings

Shows a drawing as the background of the chart. See Charts and Drawings for more details.

Show X
Axis Ti-
tle/Show Y
Axis Title

Controls whether the chart will contain text showing a title for each axis.

• Series tab:

You can assign series to the chart template from this tab. For more information, see Maintain Series for Chart
Templates.
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ã See also

Configure Chart Templates

23.7.5 Add/Edit Field Definition Dialog
See below for the description of fields in the Add Field Definition/Edit Field Definition dialogs. Self-explanatory
fields are not explained.

This dialog is triggered when you configure fields for Asset Information Groups (AIGs) (see Configure Asset Informa-
tion Groups), global tables (see Configure Global Tables) or event types (see Configure Event Types).

Note that depending on where you trigger this dialog from, some tabs may or may not be visible.

• Field Definition tab:

On this tab, you must specify a name and a field type. The remainder of the tab will change, depending
on the field type you select. The fields described below are common to all field types.
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Field/Checkbox
Name

Description

Name Enter a name that uniquely identifies the field. This will appear on the user interface.
Field Type You must specify the type of the field, which determines the behaviour of the field.
Allow
User
Com-
ments

This feature is not supported currently.

Default
Value

Specifies the value of the field if the user doesn’t specify any other values.
You can also use this field as follows:

– Auto-increment fields: It’s possible to set a field to auto-increment. For ex-
ample, if you want each new anomaly you created to automatically have an
as-yet-unused anomaly number pre-populated, you would do this by setting
the Anomaly Number field to be an auto-increment field. To do this, set the
field’s default value to @autoinc. For system tables like Anomaly, you can’t
do this through the NEXUS IC user interface, so ask support@nexusic.com for
assistance.

– Auto-populate date/time or user name: Similar to @autoinc, you can set a
field to pre-populate with the date/time the record was created by setting its de-
fault value to @now. This works for any sub-event, AIG or sub-AIG field. You
can also set a field to pre-populate with the logged-in user’s name by setting
its Default to @user. This works for any event, sub-event, AIG or sub-AIG
field. These default values are populated when the row is created. For an AIG,
that’s when the asset is created. For an event, it’s when the event is created.
For a sub-event or sub-AIG, it’s when the user clicks the ‘+’ to create the new
sub-event or sub-AIG row.

Format This field is visible when you selected the Numeric field type. This field determines
in what format the numeric value will be displayed.

Number
of Deci-
mal Places

This field is visible when you selected the Numeric field type. This field determines
the number of decimal places that is displayed for a numeric field. NEXUS IC still
allows entering more decimal places in the numeric field, however, when the value
is displayed, it will be truncated based on the value that you configured here. Note
that IC-Inspector handles this setting differently; it may not allow you to enter more
decimals than what you have configured here.

Survey In-
put

If you want this field to be automatically populated from an incoming ROV survey
string (such as KP or Depth), then enter the name of the matching survey string field
which is configured in IC-Inspection (see Survey Values).

Com-
ments

Provides additional information about the field, which is displayed as a hint when
the user hovers over the field.

Minimum
Value

If the field has the type ‘number’, then you can define a minimum value that must
be entered for this field. The user will be required to enter a value greater than or
equal to the minimum value. If the value entered is less than the minimum value,
then the record cannot be saved until a valid number is entered.

Maximum
Value

If the field has the type ‘number’, then you can define a maximum value that must
be entered for this field. The user will be required to enter a value less than or equal
to the maximum value. If the value entered is greater than the maximum value, then
the record cannot be saved until a valid number is entered.

Required If your configuration requires that this field must have a value entered, then tick this
checkbox. A field is typically marked as required if key calculations are dependant
on the data entered in this field.
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• External Connection tab:

If you have configured a point-to-point connector for an AIG field (see Configure Connec-
tions), this connection is displayed on this tab.

• Field Layout tab:

This tab has various sections that control the display of the field in different modes.

Grid

Field/Checkbox
Name

Description

Visible Determines whether this field will be visible when the form data is viewed
as a grid (for example, on the Children tab for asset forms, or in the Event
Listing for events). You have the following options to choose from:

– Yes - The field is always visible.

– No - The field is always hidden.

– Yes, with Customisation - The field is hidden by default, but can be
made visible by the user by selecting the field under the Customise →
Columns toolbar option.

Order Controls the column order within the grid. The column with the lowest
Column Order will be at the left of the grid, and so on. Grid order is also
used to set the order of columns in a Custom Export of assets or events.

Text
Align-
ment

Controls whether this field aligns left, centre or right. If you do not set an
alignment, text fields will default to left, numeric fields to right, and date
fields to centre.

Caption Allows you to have a title on the grid column for this field that is different
from the field’s underlying name.

Form
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Field/Checkbox
Name

Description

Visible
Form

Determines whether this field is visible on the form.

Order Controls the order of fields within categories, and the order of categories
on the form. The category that contains the field with the lowest order will
be displayed first. Within the category, the field with the lowest order will
be displayed first.

Show
Caption

Untick this checkbox if you want this field to appear without a caption next
to it on forms.

Columns Controls how wide this field appears on a form: if this is a two-column-
wide form, setting this field’s columns to 1 will cause the field plus caption
to fill 50% of the width of the form; setting it to 2 will cause it to fill the full
width. Forms default to two columns wide, unless you specify otherwise in
a Category.

Form
Caption

Allows you to have a title on the form next to the field that is different from
the field’s underlying name.

Cate-
gory

Groups fields within a form. You can create a new category or edit an
existing one and set its columns. While editing the category, you can also
set an image or descriptive text to appear at the top of this category. This
might be instructions on how to fill in the form, details of how calculations
on the form are worked out, and so on.

Report

The Visible checkbox controls whether this field will be shown when the table is exported
in a report template.

IC-Inspector

The Visible checkbox controls whether this field will be shown in IC-Inspector. If you
set an event field to visible, it will be available to inspectors to fill in. If you set an asset
information field to visible, it will be displayed to inspectors above any forms they may
be filling out. Use this sparingly: a long list of visible asset information fields will fill the
inspector’s screen and force them to scroll to reach the form they are trying to fill out.

Order and Caption work analogously to those in Grid and Form.

General

Field/Checkbox
Name

Description

Editor
Type

Controls what type of editor the user will see when they edit the value in
this field.

Blank
Text

If you enter a text here, this text will be displayed greyed out whenever the
field is empty. You can see several fields with Blank Text set right here on
the Field Layout tab.

• Workflow Rules tab:

If you want a field’s properties to be controlled by other data, you can set up workflow rules for the
field. For information about setting up workflow rules, see Set Up Workflow Rules.

• Field Specific Units tab:
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This feature works in coordination with Configure Unit Groups. For example, if you want Easting
and Northing to display in metres, even when US Weights and Measures are selected, you can specify
that on this tab. You’ll need to specify it once for the Easting field, and once for the Northing field.

• Function tab:

This tab is available only if you selected the Calculation or the Global Lookup field type on the Field
Definition tab. You can assign a function to a field if you want the system to calculate the value of
the field based on the function you specify. You can select predelivered system functions or custom
functions that you configured (see Configure Functions).

• Anomaly Triggers tab:

On this tab, you can set up anomaly triggers for fields on an AIG or an event form. When an anomaly

trigger is violated, a yellow exclamation mark ( ) will appear next to the field. For information
about setting up anomaly triggers, see Set Up Anomaly Triggers.

� Hint

As you add (or edit) fields, you can see a preview next to the dialog, showing how the fields will appear

on either a form or a grid. Fields that are selected will be shown with a exclamation mark next
to them in the form preview. If the field is a lookup list, you can drop down the lookup list to see its
values. (You can also see and edit a lookup list’s values when choosing the lookup list: on the “Select
Lookup List” dialog, click Edit, click Items.)

ã See also

• Configure Global Tables

• Configure Asset Information Groups

• Configure Event Types

23.7.6 Add/Edit Finding Dialog
See below for the description of fields in the Add Finding/Edit Finding dialogs.

In the Add Finding dialog, only the Finding tab is visible, the other tabs get displayed once you have saved a new
finding and start editing it.

• Finding tab:
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Field/Checkbox
Name

Description

Event Specifies the event which the finding is connected to.
Code A code that identifies the type of finding. These are the same codes that are used to classify

anomalies. For example, a code can be “CD”, “PD” or “VIB” (Coating Damage, Physical
Damage or Vibration); however, anomaly codes are user-definable and can be configured un-
der Configure Anomalies.

Severity Choose from a list of pre-defined severity levels. For example, severity levels can be “Level
1 - Contributor”, “Level 2 - Degraded”, “Level 3 - Damaged”, “Level 4 - Danger” and “Level
5 - Extreme Danger”. Severity levels are user-definable and can be configured as described
in Configure Anomalies. These are the same severities that are used to classify anomalies.
Anomaly severities can also be assigned to anomaly triggers.

Status Choose from a list of pre-defined finding statuses. Finding statuses are user-definable and can
be configured as described in Finding Status.

Finding
Number

Optional. This field can be used to label findings.

Reason You can enter a reason for creating the finding. There’s no character limit for this text field.
Remedial
Action

You can enter possible actions to resolve the finding. There’s no character limit for this text
field.

Anomaly
Required

If you want to link the finding to an anomaly, tick this checkbox. In this case, a new Anomaly
field appears in the dialog, from which you can select the anomaly that you want to link to
(see Link Finding to Anomaly). If you deselect this checkbox, it indicates that the finding can
be considered as insignificant and the status of the finding changes to green colour.

Anomaly Specifies the anomaly that this finding is linked to. This field only appears if the Anomaly
Required checkbox is ticked. When you click the ellipsis, you can select an existing
anomaly or create a new anomaly to which you want to link the finding.

Trigger If this finding was automatically generated by an anomaly trigger, that trigger is shown in this
field. This field is filled automatically and cannot be changed manually.

Is Auto
Generated

If this finding was automatically generated by an anomaly trigger, this checkbox is selected.
This field is filled automatically and cannot be changed manually.

• Review tab:

Allows you to view, edit or create review records for the finding. This tab corresponds to the Review Status
pane, see Review Status for more information about its functionality.

• History tab:

See Checking History.

ã See also

• Create Findings

• Edit Findings

23.7.7 Add/Edit Layer Dialog
The Add/Edit Layer dialog appears when you create or edit a layer for a drawing on the Drawing tab on the ASSETS
screen (see Create Layers or Edit Layers).

See below for the description of fields in the Add/Edit Layer dialog:
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Field/Checkbox
Name

Description

Layer Type Specifies the way the layer will be rendered on the drawing. Only Region and Button
with Region let you create complex outlines.

Colour Indicates the colour of the layer. This colour is used for both the outline and the fill.
Opacity Specifies the opacity of the filled part of the layer. 0 is transparent; 100 is solid.
Show Cap-
tion

Indicates if the caption (defined below) is visible on the drawing.

Caption Specifies the text string to show for this layer. This caption text grows/shrinks as you
zoom in/out. It can be moved using the “grab point” at its top left. The text can be
replaced with other text when the drawing is used in a report template or the drag AIG
feature is used.

Caption
Colour

Indicates the colour of the caption text.

Caption
Angle

0° is horizontal, right way up. Positive angles rotate the text anticlockwise.

Associated
Field

You can select an an Asset Information Group (AIG) field whose value can be displayed
in the caption on this layer. The text will be appended after the fixed text specified in
Caption.

Asset If you want the layer to link to an asset, select the relevant asset from this field. For more
information, see Direct Asset Reference.

Relative
Asset

Instead of specifying a particular asset, you can enter text here. NEXUS will search for
children that match that name. If multiple children match and the user clicks this layer
and chooses Navigate to, there will be one entry for each in the context menu. This field
is automatically filled with the name of the relevant asset if you extract layers from a
PDF drawing. For more information, see Relative Asset Reference.

Associated
Drawing

You can link to another drawing from this layer. When you click this layer and choose
Navigate to, you will be navigated to the relevant asset and its specified drawing. That
drawing must be available on that asset. This field is only visible if you have specified
a direct asset reference in the Asset field. You can then select any drawings that are
associated with that asset from the Select Associated Drawing dialog.

ã See also

Manage Layers in Drawings

23.7.8 Add/Edit Library Dialog
See below for the description of fields in the Add/Edit Library dialog:

• Library tab:
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Field/Checkbox
Name

Description

Library
Type

Select the library type to which you want to assign the library item.

Name Enter a name that identifies the library item. This is a 100-character mandatory field. Most
often, you use either the document title or the document number as the name of the library
item.

Description A 100-character field that provides more descriptive information of the library item.
Document
No.

A 50-character field that stores the Document Number or Reference.

Revision Can indicate at what stage the library item is based on your own requirements (for example,
‘01’ or ‘A’).

Reference
Date

You can assign a specific date to the library item as required.

Physical
Location

If this library item is a reference to a hard copy document, then enter the physical location of
the document.

Hyperlink When linking this document to a UNC or URL, you can specify the full hyperlink in this field.
Examples of valid URL and UNC paths:

– https://www.<webpage>.com/
– \\example.com\groups\eng\this_doc.docx

ò Note

If you define a mapped drive as a hyperlink location (for example, H:\Working\
document.docx), then you must ensure that the drive letter H:\ is mapped for every
other potential NEXUS IC user. Instead of mapped drives, we recommended that you use
UNC paths for network drive locations.

Attachment Allows you to add an attachment to the library item in one of the following ways:
– Import - Loads a document into the NEXUS IC database, or replaces an existing docu-

ment.
– Link - Links to a file on a mapped drive. A copy of the file will be stored in the NEXUS

database and updated when the file changes.
– Export - Saves the document to a folder location of your choice.
– Launch - Launches the attached item in the default Windows viewer.
– Copy - Copies the attachment to your clipboard.
– Clear - Removes the attachment from the library item.

Show Grey
Scale

When enabled, DWG or DXF drawing layers are displayed in black and white instead of de-
signed colours. This is only applicable to documents that are selected to be shown as drawing.

Show Cap-
tions

Shows or hides caption layers of a DWG or DXF drawing. This is only applicable to documents
that are selected to be shown as drawing.

Show Di-
mensions

Shows or hides dimension layers of a DWG or DXF drawing. This is only applicable to doc-
uments that are selected to be shown as drawing.

Use in Re-
ports

Determines if the library item is output to reports.

Force 2D If you have DWG or DXF drawings which NXUS detects as 3D, and you’d prefer NEXUS to
treat them as 2D, tick this checkbox on those drawings.

Back-
ground
Colour

Allows you to define the background colour of a document. Note that this functionality only
works on drawing types that support transparency (for example, DXF, DWG, GIF).

• Attributes tab:
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This tab is visible only if the Library system table has been extended with additional fields in your configuration.
You can fill those custom fields on this tab. For more information, see Configure Attributes.

ã See also

• Library Items

• Manage Drawings

23.7.9 Add/Edit Multimedia Dialog
The Add/Edit Multimedia dialog appears when you create or edit a multimedia image for an event on the INSPEC-
TION screen or you edit a multimedia image on the ANOMALIES screen (see Multimedia (INSPECTIONS) or Mul-
timedia (ANOMALIES)).

See below for the description of fields in the Add/Edit Multimedia dialog:

Field/Checkbox
Name

Description

Name A name that uniquely identifies the multimedia file.
Can Re-
port

Adds or removes a flag for the file, which can be used to include or exclude the multime-
dia file from reports when configuring report templates. You can add the Can Report
column to the Multimedia pane under Customise → Columns.

Image Allows you to upload or manage the multimedia file in one of the following ways:
• Import - Uploads the file into the NEXUS IC database or replaces an existing one.
• Link - Links to a file on a mapped drive. A copy of the file is stored in the NEXUS

database and updated when the file changes.
• Export - Saves the file to a folder location of your choice.
• Launch - Opens the file in the default Windows viewer.
• Copy - Copies the file to the clipboard.
• Clear - Removes the file attachment from the event record.

If you add a file using drag and drop, it is automatically imported (not linked).
Source Indicates the platform from which the multimedia file originated. If uploaded using IC-

Inspector, this field is auto-filled (for example, iOS, Android, Windows). Otherwise,
you can enter a source manually (for example, NEXUS IC).

ã See also

• Multimedia (INSPECTIONS)

• Multimedia (ANOMALIES)

23.7.10 Add/Edit Planning Task Dialog
See below for the description of fields in the Add Planning Task/Edit Planning Task dialogs.
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Field/Checkbox
Name

Description

Asset Indicates where the task is to be completed. Choose an asset from the hierarchy. You must either
specify and asset or an asset type for a planning task.

Ad Hoc
Task

If you this checkbox, the task generated from this planning task will be flagged as an ad hoc task.

Start
KP/EL
/ End
KP/EL

Defines the starting and ending kilometre point (KP) or the elevation location where the task is to be
performed. These fields are optional.

Asset Type If this task is not relevant to a single asset, but rather a group of assets of a particular type, then choose
the asset type by clicking on the ellipsis button.

Event
Type

Choose the type of event to be scheduled. The event type identifies the inspection method to be
scheduled and carried out. This field is mandatory.

Schedule
Type

A non-required field, used for grouping or categorising.

Category You may optionally create task categories to further group your tasks (for example, tasks that require
rope access, tasks that should only be undertaken on days ending in a ‘y’, etc.).

Requires
Shutdown
(Manual)

Indicates whether the asset requires shutdown prior to being completed.

Requires
Shutdown
(Lookup)

Choose a Yes / No AIG field that contains the Shutdown flag for this task.

Order
Number

Specifies the order in which the tasks are to be completed (for information purposes only). For ex-
ample, if an asset should be cleaned and then GVI’ed, give the Cleaning task a lower order number
than the GVI task. Repeated numbers are OK. Specifying the Order No attribute for individual tasks
determines the order they appear in the IC-Inspector Tasks Screen list.

Approx
Timing
(Manual)

This value is used to estimate the overall duration (and optionally, cost) of workpacks.

Approx
Timing
(Lookup)

Choose a Numeric AIG field (if any) that contains the estimated time to complete this task.

Instruc-
tions
(Manual)

Enter any specific task instructions here. If you create a workpack report, this can provide guidance
to the inspection engineer.

Instruc-
tions
(Lookup)

Choose the AIG field (if any) that contains the instructions for this task.

Start
(Manual)

Enter a value that defines the first occurrence (or workpack) to create this task. This can either be
a number type field which specifies the first occurrence, or a date type field (such as “last inspected
date”). The Update/Apply process will work out the occurrence based on the date.

Repeat
(Manual)

Enter a value that defines the frequency that the task is to be created. This can be either a number type
field (which will be considered a frequency), or a date type field (such as “next inspection date”). For
example, if you enter 3 in this field, a task will be created at every third occurrence. The Update/Apply
process will figure out the occurrence based on the date.

Start
(Lookup)

Choose the AIG field that defines the first occurrence (or workpack) to create this task. This can
either be a number type field which specifies the first occurrence, or a date type field (such as “last
inspected date”). The Update/Apply process will work out the occurrence based on the date. If a
date type field is used, it will auto-populate the Due Date field of planning tasks generated by this
template.

Repeat
(Lookup)

Choose the AIG field which defines the frequency that the task is to be created. This can be either a
number type field (which will be considered a frequency), or a date type field (such as “next inspection
date”). The Update/Apply process will figure out the occurrence based on the date.

Create Ac-
tion

Determine when exactly a task should be created. Choose from the following options:
• Always create task when Start Occurrence is valid, regardless of Repeat Occurrence value.
• Only create task when Start Occurrence and Repeat Occurrence are valid.

Anomaly
Action

If this planning task is related to a specific anomaly action, then click on the ellipsis button and choose
the relevant anomaly action from the list.

Details You can specify a reference or source for the planning template task, for example, “Risk Based As-
sessment” or a “company procedure number”.
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ã See also

• Manage Planning Tasks

• Planning Templates

23.7.11 Add/Edit Planning Template Dialog
See below for the description of fields in the Add Planning Template/Edit Planning Template dialogs.

In the Add Planning Template dialog, only the Planning Template tab is visible, the other tabs get displayed once
you have saved a new planning template and start editing it.

• Planning Template tab:

Field/Checkbox
Name

Description

Name Enter a name that uniquely identifies the planning template. Note that the name cannot exceed
50 characters.

Base Asset This field is non-required. However, if you select an asset here, then the planning template
tasks will be limited to the assets for the Base Asset and all child assets of the Base Asset.

Frequency Determines how often tasks in the planning template should be completed. Options are Yearly,
Half Yearly, Quarterly or Monthly. For example, a planning template set up for Annual Subsea
ROV Inspections could be set to Yearly, however, a planning template set up for quarterly oil
change on a gear box would be set to Quarterly.

Occur-
rences

The number of occurrences defines how many times the tasks in the planning template should
be completed. This is equal to the number of columns displayed on the Summary tab when
editing planning templates.

Format Specifies the naming convention used for creating new workpacks when applying the planning
template. Using [yyyy] inserts the year into the workpack name, or [yy] the abbreviated year.
Using [mm] inserts the month in the workpack name. For example, workpacks generated
where the format is defined as “[yyyy]-Annual UT”, will be titled “2018-Annual UT”, “2019-
Annual UT”, and so on. [oc] represents the Occurrence Number and will increment as the
workpack is generated.

Workpack
Group

When workpacks are created from this planning template, they will be created in the workpack
group that you specify here.

Revision When workpacks are created from this planning template, they will be created with the revi-
sion that you specify here.

Read Only If you tick this checkbox, the workpacks are created from this planning template will be created
as read-only.

Respect
Task Move

If you tick this checkbox and tasks (which are generated from a planning template) are resched-
uled, the subsequent tasks are moved relative to the date of the moved task based on their fre-
quency. If you do not tick this checkbox, then tasks are simply created in the predetermined
occurrences.

ò Note

The Respect Task Move option is selected by default for all new planning templates. For
databases converted from v5, the Respect Task Move option will be deselected by default.

• Attributes tab:

This tab is visible only if the Planning Template system table has been extended with additional fields in your
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configuration. You can fill those custom fields on this tab. For more information, see Configure Attributes.

• Summary tab:

On the Summary tab, you can do the following:

– In the top half of the tab, you can check a visual summary of the planning tasks, which shows where the
tasks will be created once the planning template is applied. For more information, see Check Summary.

– In the bottom half of the tab, you can manage planning tasks. For more information, see Manage Planning
Tasks.

• Applied To tab:

On this tab, you can check the name of each of the workpacks that has been created from, or linked to this
planning template, as well as the planning template occurrence number relevant to that workpack. Note that it is
possible for a workpack to contain tasks from multiple planning templates.

ã See also

• Planning Templates

• Manage Planning Tasks

• PLANNING Screen

• Apply Planning Templates

23.7.12 Add/Edit Report Template Dialog
See below for the description of fields and screen areas in the Add Report Template/Edit Report Template dialogs.

This dialog is triggered when you configure report templates (see Configure Report Templates) and you add a new or
edit an existing report template.

23.7.12.1 Report Template Screen Area

Field/Checkbox
Name

Description

Name Enter a name that uniquely identifies the report template. This will appear on the user
interface.

Status You can assign a status to the report template. You can choose from the statuses that you
defined under Configure Report Statuses.

Category You can assign a category to the report template. You can choose from the categories
that you defined under Configure Report Categories.

Dashboard
Report

Select this checkbox if you want the template be available as a dashboard when nav-
igating to the DASHBOARDS screen. If you select this checkbox, Section Heading,

Multimedia Thumbnails and Table of Contents types will be marked with a sign to
indicate that these elements will not be displayed in a dashboard template.

Asset
Dashboard

Select this checkbox if you want the template be available as a dashboard on the Dash-
board tab of the ASSETS screen.

Comments Enter any information that you want to be stored with the report template.
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23.7.12.2 Template Definition Screen Area

In the bottom half of the dialog, you can set up the actual design of the report template. This screen area is split into
two main parts:

• On the left-hand side of this screen area, you can see a view of available elements. There are two types of
available elements:

– Elements contains all the visual elements of the report, that is, things that you can display in the report
(with the exception of elements group).

– Sources contains the things you can get data from, these are the links between the database data and the
visual elements. Most elements need a source to get data from. A single source can give data to more than
one element.

• On the right-hand side, you’ll see the Report Layout tree showing all the elements currently in the report. This
is the area where you design the actual structure of the report template. You can drag and drop the available
elements to this screen area or use the toolbar buttons to add or move around elements in the report template.
For more information, see

From the toolbar of this screen area, you can perform the following functions:
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Toolbar Option Description
Add/Edit/Delete Performs the selected operation on the element currently selected in the

Report Layout tree. For example, when you select an element and choose
Add, it inserts the element to the Report Layout structure above the ele-
ment that was selected there.

Retrieve Element You can copy elements or sources from other report templates into this re-
port template. Note that “child” elements will be brought across too, that
is, if you copy an element group that contains other elements, all those
other elements will be copied in at the same time. Your new element
will have “Copy of” prepended to its name. Filter values may not be fully
copied across, so check your simple sources’ Filter tabs after copying.

Parameters This function allows you to configure selection parameters for the report.
Each time the user generates the report, they can select values for these
parameters before the actual report is generated.
Selection parameters are created when you set up a filter for a Simple
Source in your report template (see filter). A selection parameter is also
created when you add a Multimedia Thumbnails element to your report
parameter, in which case the parameter MergeLastRow is created with a
checkbox assigned.
Using this toolbar button, you can configure how these selection parame-
ters actually appear when the user generates the report. Double-click the
parameter or select it and choose Edit to make changes. You can configure
the following:

• In the Name field, you can specify the actual text of the selection
parameter as it appears on the selection screen.

• In the Blank Text field, you can enter a hint text to be displayed for
the user.

• In the Order field, you can specify the actual place of the selection
parameter among other parameters on the selection screen. For ex-
ample, if you enter 1, this parameter will appear as the first field on
the selection screen.

• In the Columns field, you can specify the width of the field for the
selection parameter. For example, if you enter 2 in this field, the field
for this parameter will be two-column wide.

ò Note

• Dashboard reports should not use parameters.
• Asset Dashboard reports should use a parameter that specifies

the asset. NEXUS will automatically supply this value to the
template based on the user’s selection in the Asset tree when the
asset dashboard report is run.

Generate You can generate output from your report template from here without hav-
ing to click OK and go back to the Configuration - Templates dialog.
Note that when you generate the report with this option, no selection pa-
rameters will be displayed even if you have set up parameters for the report.
Your report will be generated with the previously selected parameter val-
ues. This option is only used for testing.

Move Up Moves the element selected in the Report Layout tree up by one spot within
the same element group. You can also do this with Ctrl-Up arrow.

Move Down Moves the element selected in the Report Layout tree down by one spot
within the same element group. You can also do this with Ctrl-Down ar-
row.

� Tip

You can also move items up and down by drag-dropping them within
the Report Layout tree. You can also reparent items by drag-dropping
them onto an element group.

Copy/Paste You can copy an element and paste it to another location within the Report
Layout structure.
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ã See also

• Configure Reports and Dashboards

• Configure Report Templates

• Elements

• Sources

23.7.13 Add/Edit Series Dialog
See below for the description of fields in the Add Series/Edit Series dialogs. Fields that are self-explanatory are not
explained.

• Series tab:

The availability of fields on this tab depends on the type of the chart that you choose in the Series Type field.
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Field/Checkbox
Name

Description

Name Enter a name that uniquely identifies the series within the chart template. If your chart has
just one series (this is common), you’ll often give the series the same name as the chart.

Series Type Specifies the type of the chart that you want to use for the series data display.
Shaded If you tick this checkbox, the area between your line series and the horizontal axis will be

shaded in a paler version of the series’ colour. This checkbox is available only for the Lines,
Horizontal Lines, Bezier Lines and Polygon series types.

Check-
boxes under
Statistics
and Trend
Line screen
areas

If you tick the checkboxes under these screen areas, you will see the corresponding lines
displayed on your chart. Standard Deviation shows horizontal lines one deviation above and
one deviation below the mean. These screen areas are available only for the Lines, Horizontal
Lines, Bezier Lines, Bubble and Points series types.

• Axis tab:

On this tab, you can configure one or more axes for a series. For more information, see Configure Axes for a
Chart Template Series.

ã See also

• Maintain Series for Chart Templates

23.7.14 Add/Edit Table Definition Dialog
See below for the description of fields in the Add Table Definition/Edit Table Definition dialogs.

This dialog is triggered when you configure tables for Asset Information Groups (AIGs) (see Configure Asset Informa-
tion Groups), global tables (see Configure Global Tables) or event types (see Configure Event Types).

Note that depending on where you trigger this dialog from, some tabs may or may not be visible.

• Table Definition tab:
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Field/Checkbox
Name

Description

Name Enter a name that uniquely identifies the table. This will appear on the user interface.
Description If required, describe the main purpose of the table.
Category If required, enter a category to classify the table. The category of a table may help in grouping,

for example, asset information groups with the same category will appear grouped together.
In IC-Inspection, event types can be grouped by category in the Event Launcher pane.

Icon If you’re configuring an event for use in IC-Inspection, the icon that you upload here will
appear in the Event Launcher pane of IC-Inspection. The recommended size for event icons
is 24x17 pixels.

Colour The colour that you specify here can be referenced in charts using the Colour axis. A common
use case would be a pie chart that shows the events recorded by event type.

Shape This function is not in use currently.
Auto Calcu-
late

Disables the automatic execution of calculated fields when editing this item.

Allow Secu-
rity

If you tick this checkbox, then in the Database → Manage User Security and Permissions
menu, you can control which users (and groups of users) will have what type of access to this
form or table (no ability to view, ability to view but not modify, or ability to view and modify).

• Library tab:
On this tab, you can optionally add one or more Library Items to the form or table. This might be useful if
you want instructions for filling out the form to be stored in the database.

• Form Pages tab: This tab is used only for non-configurable system tables. It is not relevant for a typical end-user
configuration scenario.

• Asset Types tab: On this tab, you can select the asset types for which the form will be available. This tab is
relevant only for AIGs. By default, no asset types are selected, so this form won’t be available anywhere in the
database.

ã See also

• Configure Global Tables

• Configure Asset Information Groups

• Configure Event Types

23.7.15 Add/Edit Task Dialog
See below for the description of fields in the Add Task/Edit Task dialogs.

• Task tab:
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Field
Name

Description Optional
Lookup

Asset Indicates where the task is to be completed. Enter the relevant asset and its loca-
tion.

Ad Hoc
Task

Some tasks are used to create multiple events in IC-Inspector. Tick this checkbox
to indicate if this is an ad hoc task. A task generated by a planning template with
the ad hoc attribute selected will have this checkbox selected by default.

Start
KP/EL
/ End
KP/EL

Defines the starting and ending kilometre point or elevation of a task (if required).

Work-
pack

You must specify a workpack to contain your task.

Event
Type

The type of event that is to occur to complete this task. This field is optional.

Schedule
Type

A non-required field, used for grouping or categorising.

Category You may optionally create task categories to further group your tasks (for example,
tasks that require rope access, tasks that should only be undertaken on days ending
in a ‘y’, etc.).

Reference
Number

If you use a company-specific reference number for the task, enter it in this field.

Assigned
To

You can assign particular tasks to particular personnel. See Assigning Tasks.

Requires
Shutdown

In plant inspection, some work requires the asset to be shut down — for example,
inspecting the interior of a vessel. Tick this checkbox for such tasks.

Yes

Order Specifies the order in which the tasks are to be completed (for information pur-
poses only). For example, if an asset should be cleaned and then GVI’ed, give
the Cleaning task a lower order number than the GVI task. Repeated numbers are
OK. Specifying the Order No attribute for individual tasks determines the order
they appear in the IC-Inspector Tasks Screen list.

Approx
Timing

This value is used to estimate the overall duration (and optionally, cost) of work-
packs.

Yes

Due Date You can optionally set a due date by which you want this task to be completed. If
this task is generated by a planning template, and the template’s Start field is in
the form of a date lookup, the Due Date will be filled with this date value.

Instruc-
tions

Any descriptive text relating to this task that may assist the inspector. If you
find you are using the same instruction for every event of this type, you should
instead put those instructions on the Event Type. (It is similarly possible to put
instructions on a planning template.)

Task Ori-
gin

Specifies where the task is originated from. You cannot exceed 150 characters.

Anomaly
Action

If this task was created from an anomaly action, the name of the anomaly action
is displayed.

Planning
Template

If this task was created from a planning template, the name of the planning tem-
plate is displayed.

Event If an event has been used to complete this task, the name of the event is displayed.
Task Sta-
tus

You can optionally create task statuses to classify your tasks.

Is Com-
pleted

If an event has been used to complete this task, the value of this field is Yes.

Is De-
ferred

If the task has been deferred to another inspection, the value of this field is Yes.

Is Held If the task has been held and a new subsequent task has been created for it, the
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• Attributes tab:

This tab is visible only if the Task system table has been extended with additional fields in your configuration.
You can fill those custom fields on this tab. For more information, see Configure Attributes.

ã See also

• Tasks

• Create Tasks

23.7.16 Add/Edit Workpack Dialog
See below for the description of fields in the Add Workpack/Edit Workpack dialogs.

In the Add Workpack dialog, only the Workpack tab is visible, the other tabs get displayed once you have saved the
workpack and edit it in the Edit Workpack dialog.

• Workpack tab:
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Field/Checkbox
Name

Description

Name Enter a name that uniquely identifies the workpack. Note that the name must be unique and
cannot exceed 50 characters.

Workpack
Group

You can optionally define a workpack group to group work as per your own requirements. For
example, you can have different groups for different geographical areas, different groups for
different kinds of inspections (GVI, non-destructive measurement, destructive measurement,
etc.) and so on.

Abbrevia-
tion

You can specify a short name for the workpack that may be useful, for example, in reports.
The character limit is 15 characters.

Description A 100-character field that provides more descriptive information of the workpack.
Asset Indicates the asset that the workpack is attached to. You should choose as specific an asset as

you can, while still including all the assets that tasks in this workpack will be on. For example,
if all the tasks in this workpack were within MyCompany / MyField / Gas Plant, you could
specify that as your asset for the workpack.

Revision This field is used for quickly managing the status of workpacks. For example, when a work-
pack is complete, you can change its revision to Completed. Workpack Revisions are user-
definable.

Read Only When this option is enabled, users will be restricted from adding or editing any records linked
to the workpack. This includes tasks, events, findings, multimedia, and other related items.
Users will only be able to modify the basic properties of the workpack.

Actual
Start

Specifies the date when the workpack is scheduled to commence.

Task Time A sum of how long all the tasks in this workpack will take to complete. For this to be mean-
ingful, you must have given each task an Approx Timing.

Work
Hours (per
day)

Used to estimate duration, based on Task Time.

Duration
(Estimated)

The result of Task Time divided by Work Hours (per day).

Duration
(Contin-
gency)

You can optionally add a value onto the estimated duration here, to allow for downtime.

Duration
(Override)

You can optionally enter a value here instead of relying on the calculated process above. This
would be useful if, for example, you have another management system that estimates duration
for you.

Actual End The result of Actual Start plus Duration.
Day Rate If you would like NEXUS IC to estimate cost, enter a day rate here. This should be the full

cost of one inspector if inspectors will be working on different tasks in parallel, or the full
cost of the team if they are not.

Cost based
on Day Rate

The result of Day Rate x Duration.

Costs
(Fixed)

You can optionally enter any fixed costs here (for example, cost of mobilisa-
tion/demobilisation).

Cost (Total) The result of Cost based on Day Rate + Costs (Fixed)
Cost (Over-
ride)

You can optionally enter a value here instead of relying on the calculated process above. This
would be useful if, for example, you have another management system that estimates cost for
you.

Final Esti-
mate

If you have entered an override value, Final Estimate will be the override value. Otherwise,
it will be the Cost (Total) value.

Cost Code Cost Codes are optional and user-definable and can be used to group workpacks based on your
requirements.
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• Attributes tab:

This tab is visible only if the Workpack system table has been extended with additional fields in your configu-
ration. You can fill those custom fields on this tab. For more information, see Configure Attributes.

• Asset History tab:

On this tab, you can view, add or edit asset history records that are linked to the workpack asset. You can also
import or export these records as required.

• Library tab:

On this tab, you can manage library items linked to the workpack (see Library Items).

• Associated Planning Templates tab:

On this tab, you can check planning templates that are associated with the workpack. For example, if
the workpack was created from a planning template, the originating planning template will be shown
here.

ã See also

• Create Workpacks Manually

• Edit Workpacks

23.7.17 Audit Log Dialog
You can access the audit log under the Database menu.

The Audit Log dialog shows you a list of user sessions. Each time a user logs in, a session is created, with a login time.
When they log out, a logout time is recorded.
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During a user’s session, they may edit data in the database. The Audit Log dialog displays a row for each data row
they change.

Under Changes, you can select and view changes from the list of changes that were made during the selected user
session.

The Table Definition column shows the name of the table that the change was made in. These tables can be:

• ‘System’ tables: for example, if a user moves an asset, you’ll see a record for ‘Asset Location’.

• ‘User’ tables: for these tables, you will see the name of your Asset Information Group, Event, etc.

The left section lists in tabular form all changes made to a record:

• Operation - Insert indicates the creation or addition of a record, Update indicates that the data was changed
from a pre-existing value to a new value, and Delete indicates the deletion of a record.

• Date Changed - Shows the date and time the change was made in the database. The table is ordered chronolog-
ically by default.

• The Table Definition column can be added via Customise to show which table the change was applied to.

The right section displays the name of the user, the form and the values of each field relevant to the change. Fields

within the form that were changed are marked with a blue highlight. For an ‘Update’, the following tabs will be
displayed:

• Original Values - Makes visible the values as they were prior to the change, with the changed values visible by

hovering over the .
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• Changed Values - Makes visible the values as they were after the change, with their original values visible by

hovering over the .

• Summary - The summary will show all changes within the change record in an easy to read, written format.

For changes with Operation type Insert, the following tab will be displayed in place of Original Values:
• Form - Shows the form and field values in the initial state, as it was created.

See also Checking History.

23.7.18 Configuration - Lookup Lists Dialog
From this dialog, you can add or edit lookup lists (top part of the dialog) or add or edit items to a selected lookup list
(bottom part of the dialog).

You can use the standard grid functions (see Using the Grid) in the Configuration - Lookup Lists dialog to edit,
delete, import, export lookup lists or lookup list items or check their connections.

23.7.18.1 Add/Edit Lookup List Dialog

See below for the description of fields in the Add Lookup List/Edit Lookup List dialogs.

• Lookup List tab:

Field Name Description
Name Enter a name that uniquely identifies the lookup list.
Category If required, enter a category to classify the lookup list.

• Items tab:

This tab is only visible once you saved the new lookup list. See Add/Edit Lookup List Item Dialog for information
about the fields on this tab.

23.7.18.2 Add/Edit Lookup List Item Dialog

See below for the description of fields in the Add Lookup List Item/Edit Lookup List Item dialogs.
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Field
Name

Description

Value The value that is passed to functions that use this lookup list field as an input. If the
lookup list item has some sensible numeric value, this is often specified in the Value field.
For example, if the lookup list is “Anode depletion”, and the first item has a Comment
of “0 - 25%”, the Value might be “25”. If the lookup list items don’t have a sensible
numerical value, the Value is often set to the same text as the Comment.

Comment The descriptive text visible to users in the field on the form.
Icon Optional field. You can import icons or images, which the users can see in the field on

forms and in the drop-down list when they are picking an item.
Note: The size of the image boxes in the drop-down list is adjusted to the size of the
largest image in the lookup list. Thus, we recommend that you use the same image size
for all the images.

Item Or-
der

Optional field. It controls the order in which items are shown in the drop-down list when
users pick an item. If no order is specified in this field, then the system orders items by
the Comments field, using alphabetical order.
You can also click the Item Order button at the top of the Configuration - Lookup
Lists dialog, which opens the Item Order dialog. From there, you can move the item
with the Move Up or Move Down buttons available in the toolbar.

ã See also

Configure Lookup Lists

23.7.19 Configuration - Traffic Lights Dialog
From this dialog, you can add or edit traffic lighting rules (top part of the dialog) or add or edit overlay values for a
selected traffic lighting rule (bottom part of the dialog).

You can use the standard grid functions (see Using the Grid) in the Configuration - Traffic Lights dialog to edit,
delete, import, export traffic lights or check their connections.

23.7.19.1 Add/Edit Traffic Light Dialog

See below for the description of fields in the Add Traffic Light/Edit Traffic Light dialogs:

• Traffic Light tab:

Field Name Description
Name Enter a name that uniquely identifies the traffic light.
Description Describe the main purpose of the traffic light.
Value Field Specify the field from which the system retrieves the value to determine the traffic light colour.
Colour
Field

Specify the field in the asset’s asset information group (AIG) that calculates the traffic light
colour. If you select a colour field from the AIG, the calculated value of this field is directly
taken to determine the traffic light colour and you don’t need to set up overlay values. If you
leave this field empty, you must define the rules for determining the traffic light colours using
overlay values as described below.

Hint Field Specify the text that you want to appear when the user hovers over the traffic light in the asset
tree. If you leave this field empty, the hint text will be the value of the Value Field.

• Permissions tab:
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For information about setting up permissions for traffic lights, see Set up Permissions.

23.7.19.2 Add/Edit Overlay Value Dialog

See below for the description of fields in the Add Overlay Value/Edit Overlay Value dialogs:

Field
Name

Description

Name Enter a name that uniquely identifies the overlay value. This text is used as the label of
the traffic light colour in the legend that appears under the asset tree.

String
Value

If the Value Field is an alphanumeric field, specify the actual field value for which the
given traffic light colour should be applied.

Min Value If the Value Field is a numeric field, specify the minimum value for which the given
traffic light colour should be applied. The traffic light colour will be used in case the
value in the Value Field is larger than or equal to the minimum value you specify here.

Max Value If the Value Field is a numeric field, specify the maximum value for which the given
traffic light colour should be applied. The traffic light colour will be used in case the
value in the Value Field is less than the maximum value you specify here.

Colour Select the colour to be used as the traffic light colour for this item.
Legend
Order

Controls the order of the item in the traffic light legend that appears under the asset tree.

ã See also

Configure Traffic Lights

23.7.20 Edit Lookup Dialog
See below for the description of fields in the Edit Lookup dialog:
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Field/Checkbox
Name

Description

Name Enter a name that uniquely identifies the lookup function.
Result
Field

Specifies the field from which you want to fetch values for the lookup function. Almost
any field from almost any table can be used as the Result Field.

Aggregate Allows you to aggregate data from the Result Field by selecting a value from this field.
If you select an aggregate, NEXUS IC will make a list of all the results and aggregate as
appropriate. For example, if you chose a field from an event form as your Result Field
and Min as your Aggregate, then NEXUS IC will look through all the events on that
asset, and return the minimum value from that field in that list of events.
If you choose the value None, you must ensure that your filters allow only one value to
be returned. If multiple values exist, the Lookup will return the first value it finds.

Return
Type

If the Result Field you select has a display type different from its field type, then you
can set the Return Type to be either the functional value or the display value. The
display value is usually a readable text, whereas the functional value is the underlying
numeric key value, which may be useful for feeding into subsequent function elements
for comparisons.

Asset In-
put

You can specify an Asset Input, if the result table you have selected has Asset or Com-
ponent_ID as a key field (for example, if your Result Field is an asset information field).
Only use this for Asset or Component_ID. For any other table’s key field, add a Filter,
as shown below. An Asset Input must have a type of whole number (not numeric).

Asset Fil-
ter

You can choose from the following values:
• The default, No Children value returns results from only the single asset specified

by the Asset Input.
• This Asset and dependent Assets returns results from the asset specified, and also

from that asset’s children, grandchildren, great-grandchildren, and so on.
• Dependant Assets but not this Asset does almost the same thing, but leaves out

results for the asset specified.
• Immediate Children returns results from the specified asset’s immediate de-

scendants, but not from the asset itself, nor from any grandchildren, great-
grandchildren, and so on.

• Parent Assets looks up the tree instead of down, returning results from the specified
asset’s parent, grandparent, great-grandparent, and so on, all the way to the root of
the asset tree.

• Direct Parents returns results from the specified asset’s immediate parent.
If you are using an Asset Filter option other than No Children or Direct Parents, you will
typically also want to specify a value for Aggregate.
If an asset appears in multiple asset views, it may have different parents and different
descendants in different views. These asset filters will match parents and descendants in
all asset views.

Workpack
Filter

You can set up a workpack filter if the Result Field is an event field. Choose a filtering
option from the drop-down list as required.

Filters Allows you to filter the list of results that would otherwise be returned to a shorter list
(possibly containing exactly one item, thus avoiding the requirement to use an Aggre-
gate). You can drag extra inputs onto the Lookup element for use as Filter inputs. You
can choose from the following comparison options:

• Use the first six comparisons (=, <>, >, >=, <, <=) as usual.
• The various closest filters (closest (either), closest (lower or equal), closest (higher

or equal), closest (lower) and closest (higher)) are special. For example, if you
want to find the event whose KP is closest to a particular value, use closest (either).
Or if you want to find the event just before this one, that is, the event with KP
closest to a particular value, but lower, use closest (lower). And similarly, use
closest (higher) to find the next event after a particular KP.

• For highest and lowest, you need to specify no input. These simply return the
single result that has the highest or lowest value in whatever field you specified in
the filter. Note though that using an Aggregate of Max or Min is usually faster than
using a filter for highest or lowest.

• contains lets you search for a substring within an alphanumeric input. You can
use “_” and “%” as wildcard characters, with “_” matching any single character
and “%” matching several characters, so “abcde” contains “a_c”, and also contains
“a%d”.

All filters must be matched for results to be returned; in other words, filters are implicitly
connected by ANDs.
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ã See also

Function Elements

23.7.21 Properties Dialog
See below for the description of fields in the Properties dialog under Database → Properties. Self-explanatory fields
are not explained.

• Properties tab:

On this tab, you can set up various properties related to your database, such as client name, client logo, paths for
videos or risk models.

Field/Checkbox
Name

Description

Name You can enter a client name but this value is not used anywhere.
Details You can enter any details or comments here but this value is not used anywhere.
User Up-
graded

Identifies the name of the logged in user that instigated the latest database schema update.

Date Up-
grade

The date that the latest schema update was performed.

Retention
(Jobs)

Determines the retention period for job history, measured in days. Any job history records
older than the specified number of days will be automatically purged.

Global
Video Path

The root folder or UNC path for all inspection video that may be linked to inspection events
under INSPECTION. This could also be an Azure SAS URL (https://docs.microsoft.com/
en-us/azure/storage/storage-dotnet-shared-access-signature-part-1 ), which links to cloud
based storage. See Managing Videos for more information.

Temporary
Inspection
Video Path

This field is typically filled during offshore inspection campaigns for offline video review. It
specifically pertains to videos that will be local to this instance of NEXUS IC. See Managing
Videos for more information.

Filename
Format

Defines the file naming format to be used with IC-Recorder/DVR.

Anomaly
Risk Chart

Allows you to select the anomaly risk chart that you want to be displayed on the ANOMA-
LIES screen. To ensure that you can select the anomaly risk chart in this dialog, you must
have configured the anomaly risk chart as described in Configure Risk Charts. You must also
set up the System - Anomaly - Risk Score function that calculates the Risk Score for each
anomaly. For more information, see Set Up Anomaly Risk Matrix.

Logo You can upload logos (primary and secondary) to be used in the headings of report templates.
The logo is included in the Dashboards Page report and the Asset Dashboards report by de-
fault.

• Drawings tab:

On this tab, you make settings specific to drawings, such as a variety of default colours associated with drawings
and settings associated with 3D or SVG drawings.
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Field/Checkbox
Name

Description

Default
Traffic
Light
Colour

If the currently selected traffic lighting (see Traffic Light) does not specify a colour to go with
the traffic light’s actual value on the asset for a drawing region or button, then the relevant
layer will be shown using the colour that you specify in this field. This layer is visible when
you select Layer Colour→ Traffic Light from the toolbar of the Drawings tab on the ASSETS
or INSPECTION screen.

Known As-
set Colour

On the Drawings tab of the ASSETS or INSPECTION screen (see Drawings), when you
select Layer Colour→Unknown Asset from the toolbar, this colour will be shown for drawing
regions and buttons if the relevant layer is connected to an asset and the linked asset can be
found in the database.

Unknown
Asset
Colour

On the Drawings tab of the ASSETS or INSPECTION screen (see Drawings), when you
select Layer Colour→Unknown Asset from the toolbar, this colour will be shown for drawing
regions and buttons if the relevant layer is connected to an asset but the linked asset cannot
be found in the database.

Missing As-
set Colour

On the Drawings tab of the ASSETS or INSPECTION screen (see Drawings), when you
select Layer Colour→Unknown Asset from the toolbar, this colour will be shown for drawing
regions and buttons if the relevant layer is not connected to any asset.

Attribute
(3D)

In 3D DWGs, you can use a tag in the DWG to specify what asset the element refers to.
NEXUS IC will then match that tag to the field you specify under Configuration → Assets
→ Features → Asset Serial Number → Edit (see Configure Features). In this field, you are
specifying the DWG tag that NEXUS IC will attempt to match on. See 3D Drawing Setup
Example for more information on how to configure 3D drawings.

Attribute
(SVG)

In SVG drawings, you can use an attribute to specify what asset the element refers to. NEXUS
IC will then match that attribute to the field you specify under Configuration → Assets →
Features → Asset Serial Number → Edit (see Configure Features). In this field, you are
specifying the attribute that NEXUS IC will attempt to match on.

Missing
Attribute
Colour

If NEXUS IC finds an attribute in the 3D/SVG drawing but is unable to find an asset with a
matching 3D/SVG attribute in the database (as specified above), it will highlight the asset in
the colour you select here.

Grid Size Specifies the size of a grid cell at scale 1 for the 3D drawings.
Grid
Colour

Determines the colour of the grid for 3D drawings.

North
Layer
Name

Name of the ‘True North’ layer for 3D drawings.

• Email tab:

On this tab, you can set up the email host that allows NEXUS IC to send emails (for example, to email a generated
report or the contents of any of the grids). For more information, see Set Up Email.

• License tab:

This tab contains details of your license key. As part of Software Based Licensing, this is where you will enter
that license information.

ã See also

• Properties
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23.8 What’s New
NEXUS 6.9 introduces a range of new features and enhancements, delivering significant updates across various modules
to ensure better performance, enhanced functionality, and greater ease of use. Key highlights of this release include:

• NEXUS IC changes:

– Improved grid functionality

– Better search and filtering functions

– Better memory of grid settings and the ability to transfer user profile settings between users

– New and improved features for dashboards, asset information management, workpack management, plan-
ning, and inspection functionality

– Refined permission settings

– You can now extend several system tables with additional fields. This will add an Attributes tab in the
corresponding create/edit dialogs, where users can fill in the new custom fields.

– New and enhanced configuration options

• IC-Inspector is now available for Android tablets. Further key enhancements include improved management of
ad hoc tasks and events, optimised synchronisation, as well as enhanced settings and task management.

• For IC-Web, several improvements are available, including enhanced functionalities for grids, maps, charts, and
multimedia.

• A new Software as a Service (SaaS) authentication model with Single Sign-On (SSO) will be introduced later in
this release.

For a detailed description of changes, see the sections below.

23.8.1 NEXUS Applications
• What’s New in NEXUS IC

• What’s New in IC-Inspector

• What’s New in IC-Web

23.8.2 Software as a Service (SaaS)
In this release, we are introducing a new SaaS authentication model that supports Single Sign-On (SSO) with your
company user account. This will also allow you to access NEXUS applications directly through a web browser via a
single link, providing seamless access to all available applications. SaaS customers currently using RemoteApp will
be gradually migrated to this new solution. An official announcement will be sent once the new solution is available.

For more information, see Software as a Service (SaaS).

23.8.3 External Tools and Calculators
Integration with auxiliary applications extends NEXUS IC capabilities:

• ECE: Closer integration with Wood’s Electronic Corrosion Engineer (ECE) Web API and Data Historians (PI)
to calculate real-time corrosion rates based on live process data. This update also facilitates the estimation of
cumulative corrosion and the determination of corrosion profiles along the length of pipelines and tubing strings.

• FFS: Integration with Wood’s Fitness for Service (FFS) Web API application enables API 579 calculations. This
application is fully compatible with the Static Pressure Equipment (SPE).
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• Well Barrier Schematics: Connection to Wood’s well barrier schematic generator tool, which enables the cre-
ation of well schematics directly from your well asset tree.

23.8.4 Upgrade Warnings
• After the upgrade, all user profile settings in the application will be reset.

• System table extensions previously requested through change requests will revert to the default state. These
custom fields will now appear on the Attributes tab of the corresponding create/edit dialog. Please ensure that
all references to these custom fields (for example, from reports, functions, or shortcuts) are updated.

• By default, all three-state checkboxes have changed as described above. If you want to retain a three-state check-
box, you must change the default control for that specific field.

• Drawings now display only the first page of any multi-page PDF files. This provides a better and more consistent
user experience. We recommend reviewing your database for multi-page PDF drawings and splitting them into
individual files before upgrading. Please note that any marked-up layers on subsequent pages will need to be
recreated.

• v1.0 REST calls are no longer supported. If you have used v1.0 REST calls in building connections to external
systems, you will need to update those connectors to use the v2.0 REST commands. Note that changing passwords
in IC-Web will no longer be possible.

23.8.5 SQL Server Support
Version 6.9 officially supports Microsoft SQL Server 2019 and newer.

23.8.6 Version Upgrade Information
To simplify our code, version 6.9 only includes the ability to upgrade from version 6.7 or 6.8. If you are running an
older version (v6.6 or earlier), backup your database, upgrade to 6.8, then upgrade to 6.9.

If you’re upgrading from 6.0, 6.1 or 6.2, see this note about SQL Server permissions.

What Was New in 6.8, 6.7, 6.6, 6.5, 6.4, 6.3, 6.2, 6.1.

23.8.6.1 What’s New in NEXUS IC

The following new or enhanced features are available for NEXUS IC in release 6.9:

23.8.6.1.1 Features

• Grid controls have been replaced, which offers the following improvement in grid functionality:

– Faster processing of large data sets

– Better fitting of data to the columns, less need to manually resize columns

– The possibility to quickly hide and reorder columns

– Non-editable rows are now shown in italics

– Text wrapping within a cell enabled for large text fields

– Status bar showing information about the number of items selected or filtered, for example:
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For detailed information about the grid functionality, see Using the Grid.

• User profile settings are now stored directly in the database instead of settings files in Windows. Under Database
→ Your Profile. . . , new toolbar options are available on the Settings tab of the Profile dialog, which enable the
following:

– Reverting user profile settings to default values

– Copying a user’s profile settings to another user

– Set a user’s profile settings as default for all users

– Export user profile settings to a file or an email

• Three-state checkboxes have been replaced with fields that allow you to select from three values (Yes, No, and
empty value) from a drop-down list:

• For improved filtering and sorting capability, the Asset column in all the asset grids now shows the full location
of the asset instead of only the asset name:
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• When using the Search functionality, you can edit or navigate to items in the search results using the new Edit
and Navigate To.. toolbar buttons as well as the new Edit and Navigate To.. options in the context menu that
opens when you right-click the selected item:

• You can now cancel the search process using the new Cancel button in the search line of the Search Results
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dialog:

• Certain screens and tabs on the user interface are now hidden if the user lacks the necessary permissions for the
underlying tables. For more information, see Permission Requirements for User Interface Elements.

• You can now navigate back and forward between AIGs using the new buttons, which are available from
the toolbar of the Asset Information tab on the ASSETS and INSPECTION screen.

• On the ASSETS, PLANNING and INSPECTION screens, the standard Find As You Type grid functionality
for the asset tree has been replaced by an asset search function. For more information, see Searching.

• The dialog for Asset Selection has been improved.

When selecting assets (for example, while performing custom export for assets and events, asset selection in the
report template wizard, or anomaly asset filtering), the status bar in the dialog for Asset Selection now shows
the total number of assets selected in all asset views (including the asset view currently displayed and other asset
views that are not visible):

23.8. What’s New 853



NEXUS Documentation, Release 6.9.xxxxx.0

• When creating a database backup, the name of the backup file no longer includes the MD5 checksum (32 hex-
adecimal characters). Instead, the checksum is now embedded in the file using an SQL Server feature. For more
information, see Create a Backup.

• You can now assign a function to validate the value of individual AIG fields. A visual indicator is shown on the
form when the entered data is invalid:

For more information, see Add/Edit Field Definition Dialog.

• On the Drawings tab of the ASSETS screen, the following new functions are available:

– You can view EXIF data for 2D drawings using the new Information toolbar button.

– Thumbnails for image files associated with the selected asset are now stored in the database after the initial
load, resulting in significantly faster thumbnail loading the next time you open the tab. Additionally, you
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can use the new Thumbnails toolbar button to toggle the display of thumbnails on or off.

For more information, see Drawings Toolbar.

• On the Dashboard tab of the ASSETS screen, you can now select from multiple asset dashboards using the
drop-down list under the Dashboard toolbar button in case the relevant report templates have been marked as
asset dashboards.

• In the Edit Workpack dialog (see Add/Edit Workpack Dialog), you can now view, add or edit asset history
records associated with the workpack on the new Asset History tab. For more information, see Edit Workpacks.

• The character limitation for entering review comments for events and findings (see Review Events and Review
Findings) has been removed. You can now enter over 100 characters (we recommend that you do not exceed
8000 characters though).

Due to performance reasons, the Comments column is no longer available on the Event Listing (see Event
Listing) and Finding Listing (see Findings Listing) tabs.

• In the toolbar of the Video pane on the INSPECTION screen, a new Offset button is available with a drop-down
menu, which allows you to select the required number of seconds with which you want to offset the playback of
a given video channel:

• On the INSPECTION screen, the History button is now available on the Finding pane (visible when the Finding
Listing tab is active).

• On the Tasks tab of the PLANNING screen, a new toolbar menu option, Customise → Instructions Preview, is
now available. This option adds an Instructions column to the grid, displaying any instructions defined for the
tasks in the list. This new option is also available in IC-Inspection.

• In AIG and event forms, fields with “Large Text” field type now dynamically adjust their height based on the
content. This enhancement ensures a better user experience by providing a more flexible and readable layout.

• Video parsing is now executed as a background job, allowing users to monitor progress and status via the blue
ribbon above the Status Bar or through the Job Management Console.
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23.8.6.1.2 Configuration

• In your report category configuration settings, you can now enable or disable report categories from being dis-
played when generating reports using the Reports toolbar button. For more information, see Configure Report
Categories.

• You can now extend the following system tables with additional fields:

– Anomaly (Anomaly_ID)

– Anomaly Action (Action_ID)

– Library (Library_ID)

– Planning Template (LTIP_ID)

– Task (Task_ID)

– Workpack (Workpack_ID)

When you extend any of these tables, an additional Attributes tab will appear in the corresponding create/edit
dialog. This tab allows users to fill in the fields you have configured. For more information, see Configure
Attributes.

• A new configuration option is available for AIG and event forms, which allows fields to be hidden by default
in the grid but then be made visible by the user under the Customise → Columns toolbar option. This can be
configured using the new Yes, with Customisation option under the Visible field of the Field Layout tab of the
Edit Field Definition dialog (see Add/Edit Field Definition Dialog).

• In the Configuration - Templates dialog (accessible via Configuration → Reports and Dashboards → Tem-
plates), the following two new columns are available:

– Last Generated - Displays the date and time when the report was last run.

– Average Duration - Displays the average time taken to generate the report.

• The way you mark a report template as an asset dashboard has changed. In the Configuration - Templates dialog
(accessible via Configuration → Reports and Dashboards → Templates), the Asset Dashboard toolbar button
has been removed and you can no longer use the right-click menu either. Instead, to mark the report template as
an asset dashboard, you must edit the template from the Configuration - Templates dialog and tick the Asset
Dashboard checkbox in the Edit Report Template dialog.

• A new configuration option allows you to define internal statuses for findings. These statuses can be assigned
to findings, which can be useful in your review and approval workflows. To enable this feature, the new Con-
figuration → Anomalies → Finding Status menu option is available, where you can define your own status list.
When creating or editing findings in the Add Finding/Edit Finding dialog (see Add/Edit Finding Dialog), you
can assign these statuses using the new Status field.

23.8.6.2 What’s New in IC-Inspector

The following new or enhanced features are available for IC-Inspector in release 6.9:

23.8.6.2.1 Platform Compatibility

• IC-Inspector for Android is now available. It is available for free from the Google Play Store.

• IC-Inspector is now compatible with iPadOS 16 or later.
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23.8.6.2.2 Single Sign-On (SSO)

You can now use your company credentials to log in to IC-Inspector using Single Sign-On (SSO). See Log In to IC-
Inspector.

23.8.6.2.3 Improved Synchronisation

• Sync has been optimised resulting in faster sync times that conserve both battery life and bandwidth.

• The app’s reliability in low-connectivity environments has been enhanced, allowing it to manage brief dropouts
more effectively.

• The handling of background sync has been refined. When the app enters background mode during sync, it will
now retry syncing once focus is restored.

23.8.6.2.4 User Interface Enhancements

• The new icon is available in the top left corner of each screen, which allows you to toggle between showing
or hiding the sidebar.

• A new Status view is now available at the bottom of all screens that display task lists, such as Summary, Tasks
and Drawings. This feature allows you to group tasks by their current status, such as In Progress, Completed, or
Failed to Sync (see Grouping of Tasks).

• The total number of all assigned tasks are now displayed next to the Tasks element of the sidebar, and the task
count is also shown for each grouping header visible on the Task, Workpack, Asset, and Status screens.

• You can expand or collapse the list of tasks under the grouping header they belong to.

For each group, a new drop-down icon is visible for the headers on the Tasks and Summary screens, which you
can use to expand or collapse the list of tasks under that.
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• The Search icon at the top of the Summary, Tasks and Drawings screens has been replaced with a search bar.

23.8.6.2.5 Task Management Improvements

• You no longer need to assign ad hoc tasks to each inspector. Any unassigned ad hoc tasks in a workpack will be
synchronised to all inspectors that have at least one assigned task in that workpack.

• Global Table Link field types are now supported in IC-Inspector.

• The new AD HOC EVENTS grouping is available on the Tasks screen when you’re grouping by tasks. Any ad
hoc event items that you create from ad hoc tasks are now inserted under this grouping.
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• You can now delete ad hoc events using the new Delete button on the top of the Event Details screen.

• On the Event Details screen, you can now perform unit conversion for numeric fields (see Convert Unit for
Numeric Fields).

• You can now add multiple photos from your tablet’s photo library. You can then scroll through the images using
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the scrollbar.

23.8.6.2.6 New Settings Options

The following new options are available on the Settings screen:

• The new Sign In Using field is available under SERVER, which allows you to choose whether you want to sign
in to IC-Inspector using SSO or using your database-specific credentials.

• The new Sections Collapsed by Default option is available, which allows you to determine whether you want
the tasks to appear collapsed on the screens by default.

• The new Save Captured Photos to Photo Library option is available, which enables automatically saving
photos to your iPad’s photo library when taking new photos. This ensures that photos are not lost when tasks are
removed from the iPad.

• You can set up a colour for distinguishing ad hoc tasks and events. The new Adhoc tasks colour and Adhoc
events colour options are available, which allow you to select a colour to be applied for the relevant rows of the
ad hoc tasks and events in the task list view. By default, no colour is applied.

• Under SYNC, the following new options are available:

– Upload Completed Tasks enables you to upload completed task data to the NEXUS IC database without
synchronising in the opposite direction. This means you can upload data without retrieving new tasks from
the database.

– Send Sync Log to Support allows you to send a sync log to NEXUS Support in case of issues with sync.

• Under APP INFO, you can click About for the following options:

– View the current app version

– Navigate to IC-Web

– Access the documentation

– Check for available app updates

23.8.6.3 What’s New in IC-Web

The following new or enhanced features are available for IC-Web in release 6.9:

• You can now multi-select, multi-edit or multi-delete items in all the grids.

• You can no longer change the username or password in IC-Web.

• You can drag and drop single or multiple files onto the library grids of the ASSETS, LIBRARY and
ANOMALIES screens.

• The following new features are available on the INSPECTIONS screen:

– On the EVENTS pane, the Event Reviewed option is now available under the Events button,
which allows you to mark an event as reviewed, reviewed with comments, or not reviewed.

– The map functionality is now available under the new Map tab:
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• The Charts functionality has been enhanced to align with the features of charts in NEXUS IC
(DASHBOARD and INSPECTION screens). This includes improvements in appearance, inter-
activity, or zooming capabilities. Additionally, new or improved chart types are now available, such
as Polygon, Bézier lines, and Gantt charts.

• The main menu of IC-Web has been redesigned offering new features under the IC-Web menu option:

– You can now make changes to your profile settings and specify your favourite reports similarly
to the Database → Your Profile. . . option in NEXUS IC (see Your Profile).

– You can view the details of your jobs under the new Jobs menu option.

– Instead of closing the database, you can now log out from IC-Web using the new Logout option.

For more information, see Main Menu.

• The toolbar option for sharing URLs has been updated. You can now copy the URL to your clipboard
by choosing Navigation Link → Copy to Clipboard from the toolbar.

• On the Drawings pane of the ASSETS and INSPECTION screens, thumbnails for PDF documents
no longer appear with a PDF placeholder image. Instead, the thumbnail now displays the first page
of the PDF, similar to NEXUS IC, and you don’t need to click the thumbnail to view the actual image
on the Drawings pane.

• The appearance of the notification bar showing job details at the bottom of the screen has been
updated. You can check the job details or download generated reports from this notification bar.
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CHAPTER

TWENTYFOUR

DEPLOYMENT

24.1 Hardware and Software Prerequisites

24.1.1 Client Software
• Client Operating System:

See the list of supported operating systems below:

– Windows 10 x86 (32-bit) and x64 (64-bit)

– Windows 11 x86 (32-bit) and x64 (64-bit)

– Windows Server 2016 (or higher)

• ODBC Drivers: Version 17 required. (Download)

• Windows Media Foundation: For clients running Windows Server, use the ‘Add Roles and Features’ wizard
from the Server Manager. Skip through to ‘Features’ and select ‘Media Foundation’.

• Desktop Experience: For clients running Windows Server, the Desktop Experience feature needs to be installed
(Desktop Experience Overview)

• Oracle Instant Client: Only required if Oracle connectors are configured (Oracle Instant Client).

24.1.2 Other Client Software
Other software applications commonly installed on client machines include:

• Microsoft Excel: Used for viewing reports that are exported to XLS format. Also commonly used to compile
source input files for bulk data imports and updates (CSV or TXT can be used as an alternative).

• Microsoft Word: Used for viewing Reports that are exported to RTF format (alternative viewer is WordPad).

• Any web browser: Used for viewing Reports that are exported to HTML format.

• Any PDF reader: Used for viewing PDF format reference documents that may have been uploaded to the
NEXUS IC Library.

24.1.3 Client Hardware
• Processor: Minimum Core i5 / i7

• Graphics card: If 3D support is required, then the graphics card must support OpenGL.

• Memory: Minimum 4GB RAM

• Hard Disk: Minimum 30GB
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• Video Resolution: Recommended: 1920 x 2000 or higher at 100% scale (dual monitors recommended for IC-
Inspection)

24.1.4 Network
We recommend network latency is maintained at < 4ms. Latency is displayed in the application status bar, as well as
Memory Overhead and Memory used. Tasks within NEXUS can take a varying amount of time (from milliseconds to
minutes) depending on complexity. Increased network latency can degrade performance. Some tasks will suffer barely
at all from increased latency; some tasks will suffer much more. (Degradation is never worse than linear: double the
latency will cause at most double the time to be taken by the application.)

24.1.5 IC-Web
24.1.5.1 IC-Web Supported Browsers

• Chrome 54.0 or above

• Microsoft Edge 79 or above

• Safari 9.1 or above

• Firefox 53.0 or above. 3D drawings may be slower in Firefox.

24.1.5.2 IC-Web Server

• Processor: Minimum Core i5 / i7

• Memory: Minimum 4GB RAM

• Hard Disk: Minimum 30GB

• Server OS: Microsoft Windows Server 2016 (or higher) supported.

• Web server software: Microsoft Internet Information Services (IIS) 8.5 with

– ISAPI Extensions

– IIS Management Studio (highly recommended)

• ODBC Drivers: Version 17 required. (Download)

• Connection to SQL server running a NEXUS IC database

24.1.6 SQL Server
• Version: SQL Server 2019 or higher

Note that NEXUS does not support connections to Azure SQL Managed Instances.

• Processor: Multi-core CPU

• Memory: 4GB+

• Separation of System, Database and Transaction Log storage

24.1.7 Internet Connectivity
• Software Based Licensing requires access to Internet (standard HTTPS port 443)

• Automatic Crash Logs requires access to Internet (standard HTTPS port 443)
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24.2 Deployment On-Premises

24.2.1 Create Active Directory Groups and Service Accounts
Wood recommends that the following Active Directory groups and service accounts are created in advance of the
NEXUS IC software installation process. These Active Directory groups and service accounts enable streamlined
management of the security permissions on the database and the database backup location.

24.2.1.1 Create Active Directory Groups

1. Create a new Windows Active Directory group called NEXUS Backup Folder (or similar). This
group will contain users who will be permitted to perform NEXUS Database Backups using the
NEXUS IC software interface.

2. Create a new Windows Active Directory group called NEXUS Users (or similar), make it a member
of NEXUS Backup Folder Active Directory Group. The NEXUS Users group will contain all users
who require access to NEXUS.

3. If it doesn’t already exist, create a new Windows Active Directory group called SQL Admins. This
group will contain users in your organisation who have been identified as the SQL Administrators.

ò Note

During SQL Server Setup, add the SQL Admins Active Directory group as an Administrator in the
Setup Dialog.

24.2.1.2 Create Service Accounts

1. Create a new service account for running SQL Server called NEXUS_SQL_Account. The password on this
account should not expire.

2. Add this service account to the NEXUS Backup Folder Active Directory group and the NEXUS Users Active
Directory group.

3. When installing SQL Server, choose this account as the account to run the services, including SQL Agent and
Browser.

4. For companies deploying IC-Web, create a new service account called NEXUS_Web_Account. The password
on this account should not expire.

5. Add this service account to the NEXUS Users Active Directory group.

24.2.2 Set Up Backup Folder
1. Create a Windows folder called NEXUS_SQL_Backups on a file server for storing database backups generated

by users and the first time NEXUS database to restore from (we recommend that this folder location is NOT on
the SQL Server itself).

2. Share this folder by granting read/write permissions to the NEXUS Backup Folder Active Directory group.

3. Copy the initial NEXUS database backup file into this folder for first time restoration.

24.2.3 Install NEXUS Software
1. Select a member of the SQL Admins Active Directory group to install NEXUS IC (using the nexus

setup nnnnnnnn.exe file provided to you by Wood) and ensure that this account is also a member of
the NEXUS Backup Folder Active Directory group.
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• Genuine NEXUS setup installers are digitally signed by Wood Australia PTY LTD.

• If you are installing via command line, see the installer manufacturer’s website for details of command
line parameters.

2. After installation, launch NEXUS application to trigger the Database Connection Wizard.

3. On the first page of the wizard, choose Specific Windows / Domain User authentication and provide
the username and account password of a user in the SQL Admins Active Directory Group as shown
below:

4. Click Next.
5. On the second page of the wizard, enter the following:

• The full path to the NEXUS backup file. This may be a UNC path (such as
‘\\FILE_SERVER\NEXUS_SQL_Backups’) or if the database server and NEXUS IC are run-
ning on the same machine, it may be a Windows path (like ‘C:\Database Backups’).

• The name for the new database (for example, “NEXUS”).
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6. Click Next to restore the database and confirm connection to the newly restored database.

7. In the Licence prompt that appears, enter a valid license key and choose Request License.

24.2.4 Set Up Permissions
Your SQL Server Administrator must make sure that users or user groups have the necessary permissions for the
database server and the NEXUS database. The way security is set up is entirely up to the requirements of your company.
The processes below show just one possible way of setting up these permissions.

24.2.4.1 Set Up Permissions on the Database Server

1. Using SQL Management Studio, navigate to Security → Logins under the database server.

2. Right-click the Logins node and choose New Login. . . to create a new login for the NEXUS Users Active
Directory group.

3. In the Login - New dialog, under the Server Roles node, ensure that public is selected.

4. Under the Securables node, on the Explicit tab, ensure that the following options are selected:

• Grant permission for View server state. This is required for the logged in user to query the active logins to
display in the status bar, in addition to determining forced log-offs for Audit Log sessions.

• Grant permission for Administer bulk operations. Select this permission to grant bulk updates during import
on some tables.
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24.2.4.2 Set Up Permissions on the NEXUS Database

1. Using SQL Management Studio, navigate to the NEXUS database.

2. Add NEXUS Users Active Directory group to the “public” Database Role.

3. Add NEXUS Users Active Directory group to the “db_owner” Database Role.

24.2.5 Deployment Configuration File
On the first run of NEXUS on a particular PC under a particular user account, NEXUS will ask the user for details
of the database to connect to: server name, database name (along with options to create a new database or restore a
database from a backup file). This can be intimidating to new users. Instead, you can (optionally) supply these details
in a databases.xml file, in the same folder as the IntegrityCentre.exe executable. If NEXUS finds this file during startup,
it will connect to the named server and database. If SSO is specified for the user, no user interaction is necessary. If
SSO is not specified, the user will be shown a NEXUS login dialog, to enter their NEXUS credentials.

The format of the databases.xml file is:
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<databases Force="[force restricted?]" AdministratorEmail="[email]" allowedExtensions=
→˓"[list]">
<database server="[server name]" name="[DisplayName]" database="[database name]"␣

→˓NetworkPath="[backup path]" SkipValidation="[skip validation?]"/>
</databases>

Force: determines whether users are restricted to only being able to connect to databases listed. If Force is Yes, they
will be so restricted; if Force is No, users can use the Database → Connect menu to choose a different database to
connect to. Force defaults to Yes.

AdministratorEmail: the email address shown when users attempt to connect to a database that they don’t have access
to.

allowedExtensions: a list of file extensions that can be launched by the user e.g. from library items. Defaults to
“doc;docx;xls;xlsx;jpg;png;jpeg;bmp;tiff;gif;mpg;mp3;wav;ppt;pptx;txt;pdf;emf;zip;dwg;avi;rtf;mp4;csv;wmv”.

If allowedExtensions includes a blank extension (e.g. “doc;docx;;”) then users can launch library items that are just
folders (e.g. “C:\myfolder\”). These will be opened in Windows Explorer. A single trailing semicolon in allowedEx-
tensions is insufficient — you must use two, or use two at some other point in the string, e.g. “doc;;docx”.

Server: Full SQL server name including instance. e.g. .\sql2019 or sqlserver\sql2019 or sqlserver (for the default
instance).

Name: Name shown to the user when connecting.

Database: Physical database name.

NetworkPath: provides the path required for the user to perform a database backup. The SQL Service user account
needs read/write permissions on this Network share. The users performing backups also need read/write permissions.

SkipValidation: if Yes, NEXUS will not attempt to verify the NetworkPath. This means that non-admin users can still
carry out backup and restore operations.

Here’s an example file:

<databases Force="Yes" AdministratorEmail="support@nexusic.com" allowedExtensions="doc;
→˓xls">

<database server="." name="Client Database 1" database="Database1" NetworkPath="C:\
→˓Backups"/>

<database server="." name="Client Database 2" database="Database2" NetworkPath="C:\
→˓Backups"/>

<database server="." name="Client Database 3" database="Database3" NetworkPath="\\
→˓server\backupfolder" SkipValidation="Yes"/>
</databases>

24.2.6 IC-Web Deployment

• Requirements

• Installation

• Updating

• Configure IIS

• Configure IC-Web
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• Authentication

• Common Errors and Troubleshooting

24.2.6.1 Requirements

24.2.6.1.1 IC-Web Supported Browsers

• Chrome 54.0 or above

• Microsoft Edge 79 or above

• Safari 9.1 or above

• Firefox 53.0 or above. 3D drawings may be slower in Firefox.

24.2.6.1.2 IC-Web Server

• Processor: Minimum Core i5 / i7

• Memory: Minimum 4GB RAM

• Hard Disk: Minimum 30GB

• Server OS: Microsoft Windows Server 2016 (or higher) supported.

• Web server software: Microsoft Internet Information Services (IIS) 8.5 with

– ISAPI Extensions

– IIS Management Studio (highly recommended)

• ODBC Drivers: Version 17 required. (Download)

• Connection to SQL server running a NEXUS IC database

24.2.6.2 Installation

Perform the following steps on the web server:

1. Run ICWebSetup.exe.

2. Accept the License Agreement.

3. If you don’t have Internet Information Service (IIS) installed, then select Yes, otherwise select No.

4. Select New Website.

5. On the New Website Details page, enter data as follows:

• New Website Name - Enter the name of the website in IIS.

• New Website App Pool Name - Specify the name of the Application Pool the website will use.

• Run Website as - Specify the username of an account with rights to connect to the SQL server
and DB_OWNER of the NEXUS IC database. Note that in case of a domain account, this must
be in the format domain\username.

• User’s Password - Specify the password of that account specified above.
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6. On the destination page, specify the IC-Web path where the website will be installed to.

7. On the Website Bindings page, specify the following:

• Website Binding URL Name - Set the URL of the website binding. Normally it is fine to leave
as *.

• Port - Leave it as port 80 unless your web server listens on a non-standard port.

8. On the NEXUS Database Connection Details page, enter data as follows:

• Specify Microsoft SQL Server - Specify the IP address or domain name, and database server
instances.

• Specify NEXUS Database - Enter the name of the NEXUS IC database hosted on the SQL server.

24.2. Deployment On-Premises 871



NEXUS Documentation, Release 6.9.xxxxx.0

9. Click Install to set up the file and complete the configuration.

10. The last step contains a link to a driver for ODBC Driver 17 for SQL Server (Download). This must
be downloaded and installed on the server before you run IC-Web.

24.2.6.3 Updating

If you have installed IC-Web once and just want to update to a new version without having to reconfigure the web
server, follow the steps below on the web server:

1. Stop the World Wide Web Publishing Service via services.msc.

2. Run ICWebSetup.exe.

3. Accept the License Agreement.

4. Select No to install IIS (as you already have IIS installed).

5. Select Update Existing when asked if you want to update you existing version.
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6. Click Next.
7. Click Install.

This will install the new version of IC-Web but will leave the web server settings and configurations settings as
they are.

8. Start the World Wide Web Publishing Service via services.msc.

24.2.6.4 Configure IIS

Once installed, IIS should be set up and IC-Web should be running on the HTTP protocol on port 80 of your web
server. Running IIS on HTTP should only be done for initial testing. As soon as you are happy with the deployment,
you must modify the IC-Web website to use Secure HTTP (HTTPS) and stop the IC-Web HTTP protocol or redirect
it to HTTPS. Not doing this step is a security risk and exposes users’ passwords so it is vital that this is done straight
away.

24.2.6.4.1 HTTPS Configuration

1. Open IIS Manager, expand out the website tree and select the IC-Web website.

2. On the Actions section on the right of IIS Manager click on Bindings. . . .
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3. Remove the HTTP item. (Note: you may leave this if you intend to redirect HTTP to HTTPS and understand the
security ramifications. This is not covered by this deployment guide.)

4. Add an HTTPS item. This will require at least one SSL certificate on your server to do this without errors. Your
bindings should now look like this:
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5. You should now be able to browse to your website via https://<your site>, and http://<your site> should give you
a 404 file not found error.

24.2.6.4.2 Web server

If you want to manually check server settings, follow the steps below:

1. Open IIS Manager and open the ISAPI and CGI Restrictions.

2. Make sure there is an entry for <the_path_you_set_during_installation>\webroot\data\ICWeb.dll.

3. Double click Feature Delegation. Make sure Handle Mapping is set to Read/Write.

4. Select Application Pools and select the ICWeb application pool.

5. Click on the Advanced Settings. Make sure Enable 32-Bit Application is set to False.

6. Ensure that the Identity in the application pool advanced settings is set to the correct username and password.

7. Open the ICWeb website in the IIS tree.

8. Expand out the tree and select the data directory under the ICWeb website.

9. Open Handle Mappings.

10. Click on Edit Feature Permissions on the right. Make sure Execute is ticked.

24.2.6.4.3 Website

The installer performs these settings for you, however, if you want to check the settings, follow the steps below:

1. Select the IC-Web website and select Advanced Settings in IIS Manager.

2. Check that the Physical Path is correct. Note that this should correspond to the destination path specified during
installation with “\webroot” added. For example, if it was “c:\Websites\ICWeb”, the physical path should be
“c:\Websites\ICWeb\webroot”.

3. Check the Physical Path credentials.

24.2.6.5 Configure IC-Web

The installer automatically configures IC-Web and populates the fields for you. However, if you want to check or modify
these settings, proceed as described below.

1. Open the ICWeb website in the IIS tree.

2. Expand the tree and select the data directory under the ICWeb website.

3. Double-click the Configuration Editor.

4. Open the Collection. The Collection contains the following 6 entries (4 mandatory and 2 optional
parameters):

• Server - This is the domain name or IP address and instance of the SQL server.

• DatabaseName - This is the name of the NEXUS IC database on the SQL server.

• Username - This attribute contains the username of a NEXUS account that exists and is enabled
in the Database.

• InstallPath - This is the directory location of the directory that holds the IC-Web \webroot
directory.

• LogLevel - (optional) Allows you to specify the log level of the ICWeb.dll.
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• TokenUrl - (optional) The URL address of the ICWeb homepage - this is used by email/token
authentication methods.

If you want to use SQL authentication instead of Windows authentication for the SQL connection
between IIS and the SQL server, then the following parameters must be added:

• sqlUserName - User name used to authenticate to a database server.

• sqlPassword - Password used to authenticate to a database server.

ò Note

These values are case-sensitive.

24.2.6.6 Authentication

Authentication can be performed via a local NEXUS account or a Single Sign On account.

• If your IC-Web account is a local NEXUS IC account, just enter this as the username and password.

• If your account has been set up in NEXUS as a SSO account, then your username must be in full
UPN format username@domain. Your password is just your normal SSO password.

24.2.6.7 Common Errors and Troubleshooting

24.2.6.7.1 Test the REST service

Test the REST services is working:

1. Turn on Error Pages by opening IIS manager and selecting the web server.

2. Open Error Pages.

3. Click Edit Feature Settings and set it to Detailed Errors.
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4. Open ICWeb.dll by browsing to your website address and adding /data/ICWeb.dll to the end of the
address URL. This should bring up a default page for the ICWeb.dll rest service similar to the image
below. If there are any errors with the DLL, they should show here.

If you get a completely blank screen here, ensure that you have installed the ODBC Driver 17 for SQL Server (https:
//www.microsoft.com/en-us/download/details.aspx?id=56567).

If the ICWeb.dll tries to download instead of run, ensure that the web server is configured to execute ISAPI extensions.
See the last item under Configure IIS -> Web server.

24.2.6.7.2 File Size Errors

You may encounter a “File Size Error” when uploading files:

In this case, you may need to adjust a setting on your IIS server to allow your users to upload larger files as described
below:

1. Locate the web.config file.

On your web server, navigate to the location where you installed IC-Web. Look for the <installedLoca-
tion>webrootdatadirectory, which contains the web.config file.
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2. Open the web.config file with a text editor and make sure that the line circled below is included. If it’s not
included, you must add it there:

The maxAllowedContentLength value represents the maximum file size allowed to be loaded onto the server
and thus inserted into the NEXUS IC database, measured in bytes. In this example, it’s set to 1073741824 Bytes
(which is 1GB).

3. Save the modified file.

24.2.6.7.3 IIS Server Modules

Ensure the following modules are installed and running in IIS through the Add Roles and Features sections of your
server:

• Default Document

• HTTP Errors

• Static Content

• Static Content Compression

• HTTP Logging

• ISAPI Extensions

• IIS Management Console

Ensure that the Application Pool and the website account have rights to run the website and connect to the SQL server
and NEXUS Database.
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24.2.7 Troubleshooting
Initial connection to a new database server can stumble at various points. Network connectivity might be a problem, or
a firewall might be preventing access, or the database server might not be configured to listen for network connections,
or authentication might not be configured correctly.

24.2.7.1 Firewall 1

Windows firewall, by default, blocks everything. If it is safe for you to turn off the firewall on the database server
machine while troubleshooting connectivity issues, you should do so. (If there are several problems, you must have all
the problems fixed simultaneously to succeed.) Then, once you have succeeded, configure the firewall to allow SQL
Server, and turn it back on.

On the database server machine, to turn the firewall off, go to Control Panel. (On Windows 10, be sure to go to Control
Panel, not Settings.) Look for Windows Firewall. (There is a search box at the top right — you can type “firewall”
into it.) Click it. At the left, you will see Turn Windows Firewall on or off. Click this. For each of several locations
you see here, select “Turn off Windows Firewall (not recommended)”. (Note that you should not do this if you believe
that you are connected to a network that might contain anything malicious.) Click OK. Remember that later you will
need to turn these back on (or at least back into the state you found them in).

24.2.7.2 Network Connectivity

On the machine running NEXUS IC, open a cmd prompt. (Click the Windows Start button, type cmd, press Enter.)
Ping the database server machine:

ping machinename

or:

ping ipaddress

If the machine responds, this is good: it means that you have basic connectivity to the database server machine. If you
see “request timed out”, you do not have connectivity. See your local TCP/IP guru for assistance.

24.2.7.3 Anti-virus

If you are using a third-party firewall, anti-virus, anti-malware, “optimiser”, “cleaner”, etc. product, we recommend
disabling it while troubleshooting. (Windows Defender is fine.)

24.2.7.4 SQL Server Configuration Manager

On the database server machine, open Computer Management: click the Windows Start button, type manag and click
on Computer Management. In the tree at left, expand Services and Applications. You should see one or more
entries for SQL Server Configuration Manager. (There will be more than one if you have more than one SQL Server
installed on this machine.) Fully expand each of these (for example by clicking on each one and then pressing the
numeric * key on the keyboard). (Size the window larger as required.)

For each entry that mentions “Protocols”, click on it. Ensure that “TCP/IP” is set to Enabled in each case. (Right-click
and choose Enable as necessary.)

If you enabled any, you will see a message telling you that you’ll need to restart the service. Once you’ve gone through
the list, if you enabled any, click on Services in the tree at the left. Scroll down to SQL Server in the list. (You may
need to set the Name column wider.) (You may have several SQL Servers in the list.) Right-click on each and choose
Restart. (Note that this may interrupt any users who were using those database servers.)
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24.2.7.5 Allow remote connections

In SQL Studio, right-click on the database server name in the Object Explorer at the left. Choose Properties. Go to the
Connections page. Ensure “Allow remote connections to this server” is ticked. (It is ticked by default, so you’re just
checking that no-one’s changed it.)

24.2.7.6 No default instance

If your SQL Server is set up with an instance name like “SQLExpress”, “SQL2019”, etc., and does not have a “default”
instance (i.e. one without an instance name) then when requests come in on the default port (1433), none of your
instances may be listening. You can fix this by re-installing the database server as the default instance, by installing an
additional database server as the default instance, or by reconfiguring the ports your existing server instance is listening
on:

https://learn.microsoft.com/en-us/sql/database-engine/configure-windows/configure-a-server-to-listen-on-a-specific-tcp-port?
view=sql-server-ver15

24.2.7.7 Firewall 2

Configure the firewall to allow inbound connections to your SQL Server executables:

https://learn.microsoft.com/en-us/sql/sql-server/install/configure-the-windows-firewall-to-allow-sql-server-access?
view=sql-server-ver15

http://go.microsoft.com/fwlink/?LinkId=94001

24.2.7.8 Permissions

Set Up Permissions

24.2.7.9 Firewall 3

Now that you have fixed your connectivity issues (hopefully) or have temporarily admitted defeat and are returning to
a secure state, it’s time to turn the firewall back on. Once again, go to Control Panel, then to Windows Firewall. At
the left, you will see Allow a program or feature through Windows Firewall. Click it. If there is a button marked
Change Settings, and it is enabled, click it.

Click Allow another program. . . . Click Browse. Browse to the folder that contains your sqlservr.exe. This might be
a path like C:\Program Files\Microsoft SQL Server\MSSQL11.MSSQLSERVER\MSSQL\Binn. This path may
vary with your SQL Server version. In particular, x86 versions will be in “Program Files (x86)”. Select sqlservr.
exe and click Open. Click Add.

The list of allowed programs and features should now contain an entry like “SQL Server Windows NT - 64 Bit” (or
similar). There may be two or three columns to the right of it, with checkboxes for Domain, Home/Work (Private), and
Public (or just Private and Public). The process we have just stepped through should have ticked the required boxes.

Now click Turn Windows Firewall on or off and turn the firewall back on for each of the several locations. Check
that you still have database connectivity: in NEXUS IC click Database → Close, then Database → Reopen and ensure
the database can still be connected to.

To set up NEXUS on-premises, including best practice security recommendations, see the steps described below.

24.2.8 Prerequisites
Ensure that the minimum software and hardware requirements are met. For more information, see Hardware and
Software Prerequisites.
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24.2.9 Process
1. Create the required active directory groups and service accounts (see Create Active Directory Groups and Service

Accounts).

2. Set up the backup folder (see Set Up Backup Folder)

3. Install NEXUS software (see Install NEXUS Software).

4. Set up permissions on the database server and the NEXUS database (see Set Up Permissions).

5. Set up the NEXUS single sign-on accounts. Refer to Manage User Security and Permissions section for instruc-
tions on SSO configuration.

6. Optionally, set up a deployment configuration file (see Deployment Configuration File).

7. If you want to use IC-Web, ensure that you make the steps described in IC-Web Deployment.

If you run into problems, see the Troubleshooting guide.

24.3 Offshore Deployment
When deploying NEXUS, IC-Inspection, and IC-Recorder in an offshore environment, there are some differences to
consider compared to a Wood-hosted or on-premise deployment. The main difference is the use of non-SSO user
accounts to log in to the NEXUS database and the setup of SQL Server security.

The instructions and recommendations below assume that all machines on the inspection network are on a self-contained
network with no internet access access and accessible only by trusted users. For ease of setup, the same credentials
can be used to log in to all machines on the inspection network. Alternatively, if this is not an option, ensure that any
of the logged-in users have sufficient permissions to connect to the SQL Server database from each machine on the
inspection network.

24.3.1 Prerequisites
Ensure that the minimum software and hardware requirements are met. For more information, see Hardware and
Software Prerequisites.

24.3.2 Physical Setup of Equipment
An offshore setup typically includes equipment for IC-Inspection that performs online inspection, video recorders
(such as IC-Recorder) for recording video, NEXUS IC for offshore data review and survey sensors. These can all work
together with a ROV (remotely operated vehicle) equipped with cameras.

The following image shows an example equipment spread, which is installed on a boat performing offshore inspection:

This example setup involves the following:

• An underwater ROV that has multiple cameras, for example, a forward-facing camera and a manipulator camera
installed. These cameras feed into a digital video recorder that has multiple instances of IC-Recorder running on
it.

• An IC-Recorder, which is recording the video from the ROV.

• Survey sensors that feed survey data, such as depth or position into IC-Inspection. Usually this is going through
a serial string.
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• An online inspection station with an inspection engineer, who is performing online inspection through IC-
Inspection installed on a computer. The inspection engineer is looking at the video, may be adding audio com-
ments through a headset and recording events as required. The audio data is transmitted to IC-Recorder.

• A network switch, which is installed on the boat and connects the online inspection station with IC-Recorder,
and two offline inspection stations.

• One inspection station with NEXUS IC installed for offline data review. An inspection engineer is reviewing the
video and events that the online inspection engineer has logged. In case anything has been missed, this engineer
can update or create new event records as required.

• Another station with NEXUS IC installed, where a client can view what happened on the job.

24.3.3 Software Installations
Software installations must be performed on all online data acquisition and offline review PCs/laptops, including SQL
Server, NEXUS IC, IC-Inspection and, if applicable, IC-Recorder.

1. Set up the database backup folder location.

a. Create a Windows folder called NEXUS_Backups on any of the machines on the inspection network.

If you are not moving the backup files periodically to an external or NAS drive, then ensure that the machine
with the NEXUS_Backups folder has enough storage space to store daily backups for the duration of the
inspection campaign. For redundancy, we recommend having multiple copies of the database backup files.

b. Share this folder with everyone by granting read/write permissions to Everyone.

2. Install SQL Server.

When installing SQL Server, select Mixed Mode Authentication (both SA and Windows Authentication) and
grant the current Windows user administrator privileges on the SQL Server Instance.

. Warning

Confirm that you are using the same major version of SQL Server that is being used by the client.
This ensures that the client is able to perform the synchronisation on completion of the campaign
in the client environment once back onshore.

3. Set up permissions on the SQL Server Instance.

Using SQL Management Studio, add the Windows user from the inspection network as a new Login by navigating
to Security → Logins under the database server.

4. Install NEXUS software using the Offshore Setup n.n.nnnnn.exe file provided to you by Wood.

ò Note

• This installer should be executed on all online data acquisition PCs and offline review PCs.

• We recommend using the defaults in the installation wizard.

5. Restore the NEXUS IC database backup file to the SQL Server.

Launch NEXUS to restore the NEXUS backup to the SQL Server. A typical NEXUS backup file will have a
“nexus-backup” file extension. For more information about restoring the database from a backup file, see Connect
to Database.
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When entering the network path in the database connection wizard, use the shared folder that you set up in the
first step of this process.

ò Note

• When you are prompted to enter credentials to log in to the database, use the non-SSO
credentials that have been provided for the client for use during this inspection campaign.

• Schema updates should never be applied in the offshore environment unless explicitly ap-
proved by the client NEXUS focal point.

6. Validate the Software License.

For detailed instructions, see Validate the Software Based License. When performing this step, consider the
following:

• The machine that you are logged into on the inspection network needs to have temporary connection to the
internet. After the license is validated, the internet connection can be disabled.

• You will need the software license key issued to you from the client for use during this inspection campaign.
Contact support@nexusic.com if you don’t have a license key or if it does not work for you.

7. Setup NEXUS IC Logins.

After performing the steps above, you should now be logged into the NEXUS IC database using non-SSO cre-
dentials that you have been provided for offshore use. Perform the steps below:

• From the menu, navigate to Database → Security and check that there are non-SSO login accounts for
each of the users that will be logging in to NEXUS and IC-Inspection over the course of this inspection
campaign.

• If required, add new users to the Inspectors Security Group (or similar). For more information about adding
new users, see Manage User Security and Permissions.

24.4 Software as a Service (SaaS) Deployment
When deploying NEXUS as a Software as a Service (SaaS), you must meet certain requirements. These requirements
vary based on how you access SaaS applications:

• For access via RemoteApp and IC-Web, refer to SaaS Deployment - RemoteApp.

• For access through a web browser using Single Sign-On (SSO), refer to SaaS Deployment - SSO.

ã See also

• Software as a Service (SaaS)

24.4.1 SaaS Deployment - RemoteApp
If you use RemoteApp and IC-Web for Software as a Service (SaaS), ensure that you meet the deployment requirements
listed below.

884 Chapter 24. Deployment

mailto:support@nexusic.com


NEXUS Documentation, Release 6.9.xxxxx.0

24.4.1.1 RemoteApp

For the RemoteApp, consider the following requirements and recommendations:

24.4.1.1.1 Supported Operating Systems

For the RemoteApp, the following client operating systems are supported:

• Windows 8

• Windows 10. x86 (32-bit) and x64 (64-bit)

• Windows Server 2012 R2 (or higher)

ò Note

Windows 7 is no longer supported. If you use it anyway, you will at minimum need to install the
Microsoft patches for KB2830477 and then update by following the Microsoft patch notes here:
KB2923545.

24.4.1.1.2 Required Ports

RemoteApp requires client access to port 443 and can (optionally) use UDP 3389 for bet-
ter RemoteApp performance. (See https://social.technet.microsoft.com/wiki/contents/articles/16164.
rds-2012-which-ports-are-used-during-deployment.aspx.)

24.4.1.1.3 Recommended Bandwidth

The recommended minimum bandwidth is 5 Mbps.

24.4.1.1.4 Recommended Latency

Wood recommends <120ms latency for acceptable performance with RemoteApp.

24.4.1.2 IC-Web

For IC-Web, consider the following requirements and recommendations:

24.4.1.2.1 Supported Browsers

For IC-Web, the following browsers are supported:

• Chrome 54.0 or above

• Microsoft Edge 79 or above

• Safari 9.1 or above

• Firefox 53.0 or above. 3D drawings may be slower in Firefox.

Internet Explorer is not supported.

24.4.1.2.2 Recommended Latency

Wood recommends <300ms latency for acceptable performance with IC-Web.
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24.4.2 SaaS Deployment - SSO
If you use Single Sign-On (SSO) for Software as a Service (SaaS), ensure that you meet the deployment requirements
listed below. Additionally, your company must complete the necessary setup steps to enable SSO.

24.4.2.1 Supported Browsers

The following browsers are supported:

• Chrome 127 or above

• Microsoft Edge 127 or above

• Safari 17.6 or above

• Firefox 128 or above.

Internet Explorer is not supported.

24.4.2.2 Set Up Single Sign-On (SSO)

When logging in, users are authenticated using Single Sign-On (SSO) with their company user account. SaaS supports
SSO via Microsoft Entra ID. Your company must set up SSO as follows:

1. Add an application registration for NEXUS in the Microsoft Entra admin center.

a. Go to https://entra.microsoft.com/ to access the admin center.

b. In the sidebar, go to Applications → App registrations.

c. Click New registration on the top of the page.

d. On the page that opens, enter data as follows:

• Name: Enter a display name, for example, NEXUS IC.

• Supported account types: Select Accounts in this organizational directory only (Single
tenant)

• Redirect URI (optional): Select Single-page application (SPA) and enter
https://license.nexusic.com/login/

e. Click Register.

ò Note

Under Authentication, ensure that the options Access tokens (used for implicit flows) and ID
tokens (used for implicit and hybrid flows) are NOT selected.

2. To enable secure logout from accounts, update token configuration as follows:

a. In the sidebar of the new app registration page, go to Manage → Token configuration.

b. Click Add optional claim.

c. Select ID for the token type.

d. Select the login_hint option an click Add.
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3. Verify API permissions:

a. In the sidebar, go to Manage → API permissions.

b. Ensure that the default API permission User.Read under Microsoft Graph is added:
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c. To require users to request access during their initial login, set the Admin consent required
value to Yes. This is optional and the default setting is No.

4. Once the application has been registered, provide Wood with the required data, see Information Required by
Wood for SSO Setup.

5. Wood configures the authentication records and informs the company when it is completed.

24.4.2.2.1 Information Required by Wood for SSO Setup

Once the application has been registered, you must provide Wood with the following information:

1. The domain name of your User Principal Name (UPN) and any subdomain that your user accounts use, for
example, *@woodplc.com, or *@contractor.woodplc.com.

2. Application (client) ID from the app registration

3. Authority URL (Accounts in this organizational directory only) from the app registration

Before you use NEXUS, you must ensure that the software is deployed as required. See the sections below for infor-
mation about on-premises, offshore or Software as a Service (SaaS) deployment:

• Hardware and Software Prerequisites

• Deployment On-Premises

• Offshore Deployment

• Software as a Service (SaaS) Deployment
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CHAPTER

TWENTYFIVE

SOFTWARE AS A SERVICE (SAAS)

Wood offers a Software as a Service (SaaS) solution hosted on Microsoft Azure’s cloud-based servers.

Currently, you can access SaaS applications via RemoteApp and our web app, IC-Web. For more information, see SaaS
Using RemoteApp.

In this release, we are introducing a new SaaS authentication model that supports Single Sign-On (SSO) with your
company user account. This will enable direct access to NEXUS applications through a web browser via a single link.
SaaS customers currently using RemoteApp are being gradually migrated to this new solution. For more information,
see Migration to SSO and SaaS Using Single Sign-On (SSO).

25.1 Prerequisites
Before using the SaaS solution for NEXUS, ensure that you comply with the requirements as described in Software as
a Service (SaaS) Deployment.

25.2 Features
When using SaaS, consider the following features:
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Location Wood currently operates cloud hubs in the UK, USA and Australia. We can deploy services
in any Microsoft Azure data centre as required for clients with specific geographic restric-
tions on data storage. Note though that this may incur additional costs.

Sign-on
• SaaS via RemoteApp: NEXUS has the ability to authenticate users via Active Direc-

tory connection.
• SaaS via SSO: NEXUS supports Single Sign-on (SSO) via OAuth through Azure

AD (Entra ID). Note that for security reasons, authentication is restricted to a single
customer domain.

Availability System availability is historically greater than 99.9%.
Downtime Access to NEXUS via SaaS may be temporarily unavailable for scheduled maintenance or for

unscheduled emergency maintenance due to causes beyond Wood’s control. The window for
daily automated maintenance of servers is typically out of hours (e.g. 0200 to 0400) and will
NOT always result in service downtime. This maintenance window allows critical security
issues to be addressed promptly after the release of a relevant patch. Any necessary ‘non-
routine’ downtime during business hours is scheduled and approved with client contact.

Response times &
latency

Tasks within NEXUS can take a varying amount of time (from milliseconds to minutes)
depending on complexity. Increased network latency can degrade performance. Wood rec-
ommends <120ms latency for acceptable performance with NEXUS IC and <300ms for
IC-Web.

Backup regime Database backups are carried out each business day and retained for 14 calendar days. Addi-
tional backups for longer term retention can be held by agreement or transmitted to customer.
This may have a small cost impact.

Disaster Recovery
(DR) & Business
Continuity (BC)

There is no client side requirement for DR/BC. The hosted service is resilient to hardware
failures through the use of redundant Azure infrastructure and provides coverage in the event
that a data centre goes offline. Wood uses Microsoft Azure geo-redundant storage for all
database backups. The DR/BC Plan calls for automated deployment of new cloud server
infrastructure and restoration of the most recent database backup. Restore Point Objective
is a maximum of 24 hours. Restore Time Objective is a maximum of 48 hours.

Privacy & Confi-
dentiality

Data is stored securely in Microsoft SQL Server and access is only granted to authenticated
users.

Security Access to data within NEXUS is controlled by in-built functional security. In case of SaaS
with SSO, logged in users are authenticated by SSO with the customer’s domain. In case of
SaaS with RemoteApp, logged in users are authenticated by username/password. Each user
is assigned security permissions. Security permissions can be defined for roles (for a group
of users) or single users. Security for the overall service is built in Microsoft Azure, which
meets a broad set of international and industry-specific compliance standards.

Scalability The SaaS service can be scaled both horizontally and vertically for expansion of scope and
increased number of users.

25.3 Administration Services provided under SaaS
Because we have the ability to more closely manage cloud instances of NEXUS IC than we do for instances deployed
on client’s own infrastructure, we are able to offer these additional administration features:

• Scheduled reports

• Import and export jobs are offloaded to a separate server, allowing users to exit NEXUS while jobs continue to
execute

• REST API requests which generate and download reports are only available for SaaS clients

• Database maintenance
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• Infrastructure optimisation

• Database configuration management across regions

• Wood users supporting your database will not consume a NEXUS license

• Software update service, including early access to Beta releases

• Subscriber database creation and database synchronisation management services

25.3.1 SaaS Using RemoteApp
When you use this solution, access to SaaS applications is provided via RemoteApp and our web app, IC-Web.

ò Note

This solution is being replaced with the new SaaS solution that utilises a new authentication model
supporting Single Sign-On (SSO). Customers are being gradually migrated to the new solution in the
current release. For more information, see Migration to SSO.

The following image shows the high-level architecture of SaaS when using RemoteApp/IC-Web:
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ã See also

• SaaS Logins

• Troubleshooting

25.3.1.1 SaaS Logins

25.3.1.1.1 Changing Temporary Password

Before you log in to any of the solutions via Software as a Service (SaaS) for the first time or if you have requested a
password reset, you must change the temporary password that you received from NEXUS Support.

To do that, follow the steps below:

25.3.1.1.1.1 Process

1. To launch remote access to NEXUS from your browser, click the relevant link below:

• For APAC: https://remote-ae.nexusic.com

• For UK: https://remote-uks.nexusic.com

• For US: https://remote-scus.nexusic.com

2. Enter your username only (without domain) and the temporary password provided to you by the NEXUS support
team:

3. Click Sign in.

4. Click the hyperlink under ‘here’ to change your temporary password:
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5. Enter your username with the NEXUSIC domain (NEXUSIC\username), the temporary password, then your
new password (twice to confirm):

ò Note

When setting up your new password, you must follow the Windows password rules (see
password rules). In summary:

• Your new password must contain at least 10 characters.

• It must include at least three of the following:
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– Uppercase letters

– Lowercase letters

– Digits

– Non-alphanumeric characters (~! @#$%^&*_-+=`|(){}[]:;”’<>,.?/)

– Alphabetic characters that are not uppercase or lowercase, for example, Unicode
characters from Asian languages

• You cannot use any of your previous 24 passwords.

• The password cannot include any parts of your user account name.

6. Click Submit.
7. When you see the message that your password has been successfully changed, click OK:

25.3.1.1.1.2 Result

Your password has now been changed. You can continue logging in as described in the section relevant for your solution
below:

• Logging In to NEXUS IC (Windows/macOS)

• Logging In to NEXUS IC (iOS/iPadOS)

• Logging In to IC-Web

• Logging In to IC-Inspector

25.3.1.1.2 Logging In to NEXUS IC (Windows/macOS)

Follow the procedure below to log in to NEXUS IC using RemoteApp and Desktop Connections.
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25.3.1.1.2.1 Prerequisites

• For information about the general prerequisites of using Software as a Service (SaaS), see Prerequisites.

• If you are using macOS, download the Microsoft Remote Desktop app from the Mac App Store.

• If you have been issued a temporary password by NEXUS Support, you must change it before logging in. For
more information, see Changing Temporary Password.

25.3.1.1.2.2 Process

1. To launch remote access to NEXUS from your browser, click the relevant link below:

• For APAC: https://remote-ae.nexusic.com

• For UK: https://remote-uks.nexusic.com

• For US: https://remote-scus.nexusic.com

2. Enter your username only (without domain) and your password:

3. Click Sign in.

4. Click on the RemoteApp icon:
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5. A remote desktop configuration (RDP) file is automatically downloaded. Open the file from your Downloads
folder.

6. The system prompts you to enter your credentials and, in case it is not your first login, it automatically fills
your username with the NEXUSIC domain (nexusic\username). Ensure that your username is entered in the
‘nexusic\username’ format and enter your password:

7. The remote app for NEXUS IC opens.

25.3.1.1.3 Logging In to NEXUS IC (iOS/iPadOS)

If you use iOS or iPadOS, follow the procedure below to log in to NEXUS IC.

25.3.1.1.3.1 Prerequisites

• Download the Microsoft Remote Desktop app from the App Store.

• For information about the general prerequisites of using Software as a Service (SaaS), see Prerequisites.

• If you have been issued a temporary password by NEXUS Support, you must change it before logging in. For
more information, see Changing Temporary Password.

25.3.1.1.3.2 Process

1. Launch the Microsoft Remote Desktop app.

2. At the bottom right, tap +.

3. Choose Workspace.

4. Enter the relevant URL for remote access:

• For APAC: https://remote-ae.nexusic.com

• For UK: https://remote-uks.nexusic.com

• For US: https://remote-scus.nexusic.com

5. Tap Next.
6. Enter your username with the NEXUS IC domain in the format ‘nexusic\username’, and your password.
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25.3.1.1.4 Logging In to IC-Web

To log in to IC-Web, follow the steps below.

25.3.1.1.4.1 Prerequisites

• For information about the general prerequisites of using Software as a Service (SaaS), see Prerequisites.

• If you have been issued a temporary password by NEXUS Support, you must change it before logging in. For
more information, see Changing Temporary Password.

25.3.1.1.4.2 Process

1. Enter the IC-Web URL.

2. Enter your username with the NEXUS IC domain in the format ‘username@nexusic.com’, and your password.

ã See also

IC-Web

25.3.1.1.5 Logging In to IC-Inspector

To log in to IC-Inspector, follow the steps below.
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25.3.1.1.5.1 Prerequisites

• Download the IC-Inspector app on your tablet and deploy it as described in Install IC-Inspector.

• For information about the general prerequisites of using Software as a Service (SaaS), see Prerequisites.

• If you have been issued a temporary password by NEXUS Support, you must change it before logging in. For
more information, see Changing Temporary Password.

25.3.1.1.5.2 Process

1. Open the IC-Inspector app.

2. Go to Settings.
3. Under Server, enter data as follows:

• Server: Enter the name of the server.

• Login: Enter your username with the NEXUS IC domain in the format ‘username@nexusic.com’.

• Password: Enter your password.

ò Note

The credentials you enter here are typically the same as those you enter when you start NEXUS IC. (If you
don’t enter any credentials when you start NEXUS IC, you may be using Single Sign-on; enter your Windows
domain credentials here instead.)

4. Click Connect & Save.
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ã See also

IC-Inspector

If you are using RemoteApp to access Software as a Service (SaaS) and your NEXUS IC instance is hosted by Wood,
the following guides to logins apply. If your NEXUS IC instance is not hosted by Wood, parts of the guides may still
be applicable.

25.3.1.1.6 First-time Login

When you log in for the first time, you must first change the temporary password provided by NEXUS Support. For
more information, see Changing Temporary Password.

25.3.1.1.7 Subsequent Logins

For information about logging in, see the section that applies to your solution:

• Logging In to NEXUS IC (Windows/macOS)

• Logging In to NEXUS IC (iOS/iPadOS)

• Logging In to IC-Web

• Logging In to IC-Inspector

25.3.1.2 Troubleshooting

If you are having difficulty connecting to a Wood NEXUS IC cloud instance via RemoteApp, the problem may be your
corporate firewall. Try connecting from a device not connected via the corporate internet connection, and not running
corporate software that may interfere with the connection. For example, try connecting from home via a personal
computer, or try connecting from your smartphone via the phone network.

If the corporate infrastructure is blocking the connection, note the following:

• Check which ports are used during deployment. For information about the requirements, see Software as a
Service (SaaS) Deployment.

• RDP (Remote Desktop Protocol) files are used to specify remote connections. Some browsers may flag these
files as potentially dangerous due to security concerns. Ensure that you don’t block the download of RDP files.

• If you or your IT department have set policy “Network security: LAN Manager authentication level” away from
its default, you must set this back, via domain policy or Local Security Policy (secpol.msc). Under Local Policies
→ Security Options ensure that Network security: LAN Manager authentication level is set to “Not Defined”
or “Send NTLMv2 response only”.

25.3. Administration Services provided under SaaS 899



NEXUS Documentation, Release 6.9.xxxxx.0

• Deep-packet inspection and modification tools may prevent connections from completing, for example if they
find an RDP connection inside an HTTPS stream and decide to rewrite it. See diagram below for the steps
involved behind the scenes in an Azure RemoteApp connection:
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ã See also

• Software as a Service (SaaS) Deployment

• Software as a Service (SaaS)

25.3.2 SaaS Using Single Sign-On (SSO)
This solution enables remote access to NEXUS IC and IC-Web through a web browser, utilising Single Sign-On (SSO)
for seamless and secure login.

25.3.2.1 Prerequisites

Before using this SaaS solution for NEXUS, ensure that you comply with the requirements as described in SaaS De-
ployment - SSO.
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25.3.2.2 Architecture

The following image shows the high-level architecture of SaaS when using SSO:

25.3.2.3 Features

Once you have been migrated to SaaS using SSO (see Migration to SSO), you’ll have direct access to NEXUS appli-
cations through a single link using your company user account. For more information, see SaaS Login.

User management tasks can be handled either by your company’s administrative personnel or by Wood, depending on
the terms of the service agreement. For more information, see User Management.

ã See also

• Software as a Service (SaaS)

• SaaS Login

• Launch NEXUS IC as an App

• Keep NEXUS Active in Browser

• User Management
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25.3.2.3.1 SaaS Login

When you use Software as a Service (SaaS) with Single Sign-On (SSO), you can access NEXUS applications as
described below.

25.3.2.3.1.1 Log In to NEXUS IC and IC-Web

1. Open your web browser and navigate to https://license.nexusic.com/.

2. On the sign-in page, enter your company username (for example, username@company.com), pass-
word and click Sign in.

If you have previously signed in and selected the option to stay signed in, this step is skipped.

3. On the next page, click the application that you want to launch.

4. The application opens in your web browser.

ò Note

When you log in for the first time, default security permissions are assigned to your user account. To
change your security permissions and assign licenses, contact your administrator. For more informa-
tion, see User Management.

� Tip

• Launch NEXUS IC as an app to open it in its own window. For detailed steps, see Launch
NEXUS IC as an App.

• If you are using NEXUS applications in a browser, you may need to adjust your browser settings
to prevent disconnection in background tabs. For more information, see Keep NEXUS Active in
Browser.

25.3.2.3.1.2 Log In to IC-Inspector

You can log in to IC-Inspector using one of the following methods:

• Single Sign-On (SSO): Use your company credentials for seamless authentication.

• Database-specific credentials: Use a dedicated account to access IC-Inspector.

Both login methods are described below.

25.3.2.3.1.3 Log In Using SSO

1. Launch the IC-Inspector app on your tablet.

2. Go to Settings.
3. Ensure that the Use Demo Data option is turned off.

4. Under SERVER, confirm that Corporate Credentials (SSO) is selected in the Sign in Using field.
This is selected by default.
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5. Each time you perform a sync (see Sync to IC-Inspector and Sync to NEXUS IC), IC-Inspector ini-
tiates the sign-in process unless you have already signed in and your SSO session and hash are still
active. You can also tap Test SSO on the Settings page to verify SSO connectivity.

6. When prompted, enter your company username and password, and complete any multi-factor au-
thentication steps required by your organisation’s standard login process.

7. If you have access to more than one database, you will be prompted to select the appropriate IC-
Inspector database by tapping its icon on the sign-in page.
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ò Result

A success message confirms that SSO authentication was successful. Your username appears in the
sidebar, and the Server and Login fields on the Settings page are automatically populated and locked.

25.3. Administration Services provided under SaaS 905



NEXUS Documentation, Release 6.9.xxxxx.0

ò Note

• The SSO session and hash expire after a set period. After that, you’ll be prompted to sign in
again when performing a new sync.

• If you switch users or change the login method, the previous SSO session will be terminated.
Any unsynchronised data from the previous session will be lost.

25.3.2.3.1.4 Log In Using Database-Specific Credentials

1. Open the IC-Inspector app on your tablet.

2. Go to Settings.
3. Ensure that the Use Demo Data option is turned off.

4. Under SERVER, select Database Login in the Sign in Using field.

5. Enter data as follows:

• Server: Enter the name of the server as [database].nexusic.com.

• Login: Enter your username without the NEXUS IC domain using the format ‘username’.

• Password: Enter your password.
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6. Tap Connect & Save.

25.3.2.3.2 Launch NEXUS IC as an App

After you log in and open the NEXUS IC application (see SaaS Login), it runs in a browser tab by default. If you prefer,
you can launch NEXUS IC as an app in its own window using the Thinfinity Remote Workspace app.

25.3.2.3.2.1 Install and Launch for the First Time

The first time you launch NEXUS IC as an app, you need to install the Thinfinity Remote Workspace app. The steps
below use Microsoft Edge as an example:

1. Log in and open NEXUS IC in a browser tab following the standard process (see SaaS Login).

2. In the address bar, click the icon with the tooltip Install Thinfinity Remote Workspace.

3. In the dialog that appears, click Install.

ò Result

The application opens in a new Thinfinity Remote Workspace window. Depending on your browser, you may
see a message confirming the installation. You may also be asked to allow actions such as creating a desktop
shortcut, pinning the app to the taskbar or enabling auto-start on device login. We recommend not pinning
the app to the taskbar because it will not launch NEXUS IC automatically. You must open NEXUS IC as an
app from the browser each time.
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� Tip

If the application does not fill the entire window, resize the window to refresh the display.

25.3.2.3.2.2 Launch After Installation

Once the Thinfinity Remote Workspace app is installed, you can launch NEXUS IC as an app using the steps below
(examples from Microsoft Edge):

1. Log in and open NEXUS IC in a browser tab following the standard process (see SaaS Login).

2. In the address bar, click the icon with the tooltip Open in app.

3. If prompted, click Open in the dialog that appears.

ò Result

The application opens in a new Thinfinity Remote Workspace window.

25.3.2.3.3 Keep NEXUS Active in Browser

Some browsers have power-saving settings that may cause NEXUS to disconnect when left open in the background.
You can resolve this issue by adjusting your browser settings to keep tabs active.

The steps below show examples for Microsoft Edge and Google Chrome. If you use a different browser, look for similar
settings that prevent sites from being put to sleep or allow tabs to stay active.

25.3.2.3.3.1 Example: Microsoft Edge

1. Open the browser settings (click Settings under the three dots in the top right corner).

2. Navigate to System and performance → Optimise Performance → Never put these sites to sleep.

3. Click Add and enter the following sites:

• https://app.nexusic.com/

• https://app-scus.nexusic.com
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• https://app-uks.nexusic.com

25.3.2.3.3.2 Example: Google Chrome

1. Open the browser settings (click Settings under the three dots in the top right corner).

2. Navigate to Performance → General → Always keep these sites active.

3. Click Add and enter the following sites:

• https://app.nexusic.com/

• https://app-scus.nexusic.com

• https://app-uks.nexusic.com

ò Note

Modifying these settings may result in increased power consumption and could prevent screensaver activation.

25.3.2.3.4 User Management

When using Software as a Service (SaaS), user management tasks can be handled either by your company’s adminis-
trative personnel or by Wood, depending on the terms of the service agreement.

User management tasks may involve changing security permissions or assigning licenses.

25.3.2.3.4.1 Prerequisites

Before being able to change security permissions or assign licenses, ensure the user has logged in with their company
credentials at least once and launched any of the applications.

25.3.2.3.4.2 Change Security Permissions

When users log in and launch an application for the first time, default security permissions are assigned to their user
account. Administrators can manually change the user’s security group and permissions at any time within NEXUS IC
as described in Set Up Permissions for User/User Group.

25.3.2.3.4.3 License Management

Users are assigned a license in either of the following ways:

• If a spare NEXUS named-user license is available, it will be automatically assigned to the new user when the
user first logs in and launches an application.

• If no spare licenses are available, administrators can reassign licenses from the available pool within NEXUS IC
(see Software Based Licensing).
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25.3.3 Migration to SSO
We are introducing a new SaaS deployment technology, which supports Single Sign-On (SSO) with your company
user account (see SaaS Using Single Sign-On (SSO)). SaaS customers currently using RemoteApp are being gradually
migrated to this new solution.

Below are the key changes and improvements you can expect following the migration:

25.3.3.1 Key Differences

• Unified Login Portal: You will now have a single login portal for both NEXUS IC and IC-Web. For more
information about the new login process, see SaaS Login.

• Corporate Credentials: Use your corporate credentials for SSO, eliminating the need to remember separate
login details or contacting Wood for password resets.

• Local File System Access: You can now upload and download files directly to and from your local file system.
Files saved out of NEXUS will be saved to your local Downloads folder.

• Local Browser URLs: URLs will load in your local browser for a more seamless experience.

• File Import Format: Imports can only be performed using the CSV file format (importing directly from XLSX
files is not supported).

• Application Window Extents: The application window is limited to the extents of the browser window, meaning
dialogs within the application cannot be dragged outside of the browser’s window.

25.3.3.2 Known Issues

Feature Issue Wood
Inter-
nal
Refer-
ence

INSPECTION
Screen

Panes can be docked between locations. However, floating panes cannot be re-
docked without loading the saved desktop.

#76018

Copy & Paste To enable copying and pasting data from NEXUS to other applications, you must
first ensure that the clipboard is enabled in your browser. Some browsers prompt
you if it is not allowed, but others, such as Safari, deny it by default. In this case,
disable any content blockers for the NEXUS application in your browser settings.

#72409

4K and 5K Mon-
itors

On very high resolution monitors at maximum display setting, the application win-
dow may not extend to fill the full-screen browser window.

#76037

Application Win-
dow

After maximising the application window, it may appear cropped within the browser
window. To resolve this, click the Restore Down button and then maximise the
window again, or manually resize the browser window to force the application to
redraw correctly.

#80327

910 Chapter 25. Software as a Service (SaaS)



NEXUS Documentation, Release 6.9.xxxxx.0

25.3.3.3 Frequently Asked Questions (FAQs)

Question Answer
What changes in user access
when transitioning from Re-
moteApp to SSO?

Once the transition to SSO is complete, all users accessing your data, including
contractors and inspectors using the IC-Inspector app, will need to log in using
a domain account from your organisation. This replaces the current setup where
Wood manages access via nexusic domain accounts.

Why are we switching to SSO? There are two key reasons for this transition:
1. Cybersecurity – SSO enforces strict access controls. This prevents unau-

thorised users, whether external attackers or internal personnel, from gain-
ing access to confidential or sensitive information.

2. Access Control – Your organisation will now have full control over who
can access your data.

Who controls access to our data
under SSO?

With SSO, your organisation will have complete control over user access. Your
IT team will manage domain accounts and, if configured, Active Directory (AD)
group memberships that determine access to NEXUS.

What login credentials will users
need?

Users must authenticate using a corporate domain account created by your IT
team. Temporary or transient users can be provisioned without Office 365 li-
censes or email accounts, if needed, however, these accounts must still be cre-
ated and managed within your company’s domain.

Can third-party contractor
domains be granted access to
NEXUS?

No, Wood cannot grant access. Allowing access to third-party contractor do-
mains poses a security risk and may lead to unintended data exposure. For
example, if your organisation grants access to AAA Inspection Company, and
another NEXUS client also uses AAA, inspectors from AAA could potentially
access data from both organisations. To maintain data integrity and security, ac-
cess must be managed strictly within your organisation’s domain.

Do you support any identity
providers other than Microsoft
Entra ID?

No. SaaS customers must register the application using Microsoft Entra ID.
However, it is possible to retain your own authentication application (for exam-
ple, Ping Federate, Shibboleth, Okta). Microsoft Entra ID supports federation
with other identity providers using OpenID Connect (OIDC) and SAML 2.0
protocols.

Can we continue using Re-
moteApp?

No. All customers are required to migrate to SSO. The RemoteApp system will
be decommissioned as soon as practically possible.

25.3. Administration Services provided under SaaS 911
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TWENTYSIX

NEXUS SUPPORT

26.1 Creating User Account for NEXUS Support
When you send an email to support@nexusic.com from an email address that has not yet been registered, a new user
account is automatically created for the NEXUS Support Portal as follows:

1. You send an email to support@nexusic.com.

2. The system automatically creates an account for you using your email address as your username and generates a
ticket for the issue.

3. You receive an email about the account activation, which includes the credentials for logging on to the NEXUS
Support Portal.

ò Note

The credentials that you get in this email are relevant only for the NEXUS Support Portal and are different
from the credentials that you use to access NEXUS IC, IC-Web or IC-Inspector.

4. You can log on to the NEXUS Support Portal using the link and credentials provided in the email (see Log In to
NEXUS Support Portal).

5. You can change the password as required.

Alternatively, you can create a new account for the NEXUS Support Portal on the https://support.nexusic.com/ page
by clicking Register and submitting your data from there. However, we recommend that you use the process described
above.

If you’d like to change your credentials in the future, choose MY ACCOUNT in the NEXUS Support Portal.

26.2 Log In to NEXUS Support Portal
Once you have an account in NEXUS Support (see Creating User Account for NEXUS Support), you can log in to the
NEXUS Support Portal as follows:

1. Open your web browser and navigate to https://support.nexusic.com/.

2. In the Login field, enter your email address. This must correspond to the email address you used to create your
account or submit an issue, for example, test.user@company.com.

3. In the Password field, enter your password.

913

mailto:support@nexusic.com
mailto:support@nexusic.com
https://support.nexusic.com/
https://support.nexusic.com/


NEXUS Documentation, Release 6.9.xxxxx.0

ò Note

An initial password was sent to your email address when your account was activated. If you can’t find this
email, click Lost password to have a new password sent to your email address.

4. If you want your credentials to be remembered for future logins, select Stay logged in.

5. Click Login.

26.3 Creating a New Issue
When you send an email to support@nexusic.com, a new issue is generated automatically.

You can also create a new issue in the NEXUS Support Portal (https://support.nexusic.com/) in one of the following
ways:

• On the HOME page, choose Log a new support request.

• Go to PROJECTS on the top of the page, choose Issues and select the button in the top right
corner of the page.

• Go to PROJECTS, jump to a project on the top right corner of the page (for example, Support) and choose NEW
ISSUE under the + sign in the top left corner of the screen:

Once you have created an issue, you receive an email notification with the issue details. You can track your issue as
described in Tracking an Issue.

26.4 Tracking an Issue
Once you have created an issue, you can track its status in the NEXUS Support Portal (https://support.nexusic.com/).

You can track your issues in one of the following ways:

• On the HOME page, you can click View your support requests. This takes you to the Issues page.

• On the MY PAGE page, you can see all your reported issues, issues assigned to you or issues that you’re watching.

• On the PROJECTS page, you can choose ISSUES to navigate to the Issues page.

From the Issues page, you can set up any filter to restrict the list of issues that you want to see based on your require-
ments:

1. Under Filters, in the Add filter field, select the criteria based on which you want to filter the issues. You can
add as many filters as many you require.

2. Select the values for each filter. If you want to select multiple values for a filter, use the + sign next to the values
and press the Shift or Ctrl button on your keyboard for selecting multiple items as required.

3. Under Options, choose Apply to execute the filtering of issues.

4. If you want to use the same filtering criteria in the future, choose Save and specify a name for your filtering.
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Whenever an issue is updated by you or the support team, you will receive an email notification detailing the update
along with a hyperlink to the issue in the NEXUS Support Portal. To make settings to your email notification settings,
choose MY ACCOUNT on the top of the NEXUS Support Portal page.

You can contact NEXUS Support to:

• Ask our support team for help when you encounter an issue

• Report a bug

• Request a feature

• Request new user accounts (SaaS customers only)

To use NEXUS Support, you need a user account for the NEXUS Support Portal. A new user account is automatically
created when you first write an email to support@nexusic.com. For more information, see Creating User Account for
NEXUS Support.

You can contact NEXUS Support in one of the following ways:

• Send an email to support@nexusic.com

• Log in to the NEXUS Support Portal (see Log In to NEXUS Support Portal) and create an issue (see Creating a
New Issue)

For information about how to track your issues, see Tracking an Issue.
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TWENTYSEVEN

LEGAL INFORMATION

The following pages contain pertinent legal information.

27.1 End User License Agreement
END-USER LICENSE AGREEMENT FOR: NEXUS INTEGRITY CENTRE
IMPORTANT: PLEASE READ THE TERMS AND CONDITIONS OF THIS LICENSE AGREEMENT CARE-
FULLY BEFORE CONTINUING WITH THIS PROGRAM INSTALL.

This End-User License Agreement (“EULA”) is a legal agreement between you (either an individual or a single entity)
and Wood Australia Pty Ltd of [Level 3, 171 Collins Street, Melbourne, VIC 3000] (“Wood”), for the supplied software
product(s) identified above which may include associated software components, media, printed materials, and “online”
or electronic documentation (“SOFTWARE PRODUCT”).

By installing, copying, or otherwise using the SOFTWARE PRODUCT, you agree to be bound by the terms of this
EULA. The following terms of this EULA govern your access and use of each SOFTWARE PRODUCT, except to the
extent: (a) there is a separate signed contract between you and Wood governing your use of the software, or (b) the
software includes a separate “click-accept” license agreement or third party license agreement as part of the installation
and/or download process governing your use of the software. To the extent of a conflict between the provisions of the
foregoing documents, the order of precedence shall be (1) the signed contract, (2) the click-accept agreement or third
party license agreement, and (3) this EULA.

The SOFTWARE PRODUCT is protected by copyright laws and international copyright treaties, as well as other
intellectual property laws and treaties. The SOFTWARE PRODUCT is licensed, not sold.

1. GRANT OF LICENSE.
The SOFTWARE PRODUCT is licensed as follows:

a) Installation and Use:

Wood grants you the right to install and use the SOFTWARE PRODUCT on your computer running a validly
licensed copy of the operating system for which the SOFTWARE PRODUCT was designed.

b) Activation:

While you may install as many copies of the SOFTWARE PRODUCT as you wish, some or all of the SOFT-
WARE PRODUCT requires activation at runtime by access to an internet accessible license server operated by
Wood (https://license.nexusic.com/LicenseManager/Licenseserver.dll/test/). The software license key permits a
limited number of users to access the SOFTWARE PRODUCT on either a ‘named’ or ‘concurrent’ user basis.
Each software license key is designed to activate only the number of users and those features of the SOFTWARE
PRODUCT for which you have purchased a license. You must not attempt to subvert licensing restrictions by
any means including, but not limited to, reverse engineering, decompilation, or disassembly of the SOFTWARE
PRODUCT or licensing system.
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c) Loss of License Key:

The software license key can be invalidated and replaced if it is lost or if its security has been compromised.

d) Backup Copies:

You may also make copies of the SOFTWARE PRODUCT as may be necessary for backup and archival purposes.

2. DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS.
a) Maintenance of Copyright Notices:

You must not remove or alter any copyright notices on any and all copies of the SOFTWARE PRODUCT.

b) Distribution:

You may not distribute copies of the SOFTWARE PRODUCT to third parties.

c) Prohibition on Reverse Engineering, Decompilation, and Disassembly:

You may not reverse engineer, decompile, or disassemble the SOFTWARE PRODUCT, except and only to the
extent that such activity is expressly permitted by applicable law notwithstanding this limitation.

d) Rental:

You may not rent, lease, or lend the SOFTWARE PRODUCT without Wood’s prior written consent.

e) Onsale:

You may not on-sell the SOFTWARE PRODUCT without Wood’s prior written consent.

f) Support Services:

Wood may provide you with support services related to the SOFTWARE PRODUCT (“Support Services”). Any
supplemental software code provided to you as part of the Support Services shall be considered part of the
SOFTWARE PRODUCT and subject to the terms and conditions of this EULA.

g) Compliance with Applicable Laws:

You must comply with all applicable laws regarding use of the SOFTWARE PRODUCT.

3. TERMINATION
Without prejudice to any other rights, Wood may terminate this EULA if you fail to comply with the terms and con-
ditions of this EULA. In such event, you must destroy and uninstall all copies of the SOFTWARE PRODUCT in your
possession and your software license will be revoked.

4. COPYRIGHT
All title, including but not limited to copyrights, in and to the SOFTWARE PRODUCT and any copies thereof are
owned by Wood or its suppliers. All title and intellectual property rights in and to the content which may be accessed
through use of the SOFTWARE PRODUCT is the property of the respective content owner and may be protected
by applicable copyright or other intellectual property laws and treaties. This EULA grants you no rights to use such
content. All rights not expressly granted are reserved by Wood.

5. PRIVACY
The application may anonymously track your usage and send it to Wood for analysis. We use this analysis to make
improvements to the software. The application may also capture information relating to unhandled errors and may
capture a screen image in this specific scenario. Any user identifiable information is blurred. No personally identifying
information is tracked, and nothing about your usage can be tracked back to you.

6. NO WARRANTIES
Wood expressly disclaims any warranty for the SOFTWARE PRODUCT. The SOFTWARE PRODUCT is provided ‘As
Is’ without any express or implied warranty of any kind, including but not limited to any warranties of merchantability,
non-infringement, or fitness of a particular purpose. Wood does not warrant or assume responsibility for the accuracy
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or completeness of any information, text, graphics, links or other items contained within the SOFTWARE PRODUCT.
Wood makes no warranties respecting any harm that may be caused by the transmission of a computer virus, worm, time
bomb, logic bomb, or other such computer program. Wood further expressly disclaims any warranty or representation
to Authorized Users or to any third party.

7. LIMITATION OF LIABILITY
In no event shall Wood be liable for any damages (including, without limitation, lost profits, business interruption, or
lost information) rising out of ‘Authorized Users’ use of or inability to use the SOFTWARE PRODUCT, even if Wood
has been advised of the possibility of such damages. In no event will Wood be liable for loss of data or for indirect,
special, incidental, consequential (including lost profit), or other damages based in contract, tort or otherwise. Wood
shall have no liability with respect to the content of the SOFTWARE PRODUCT or any part thereof, including but not
limited to errors or omissions contained therein, libel, infringements of rights of publicity, privacy, trademark rights,
business interruption, personal injury, loss of privacy, moral rights or the disclosure of confidential information.

27.2 Cryptography Declaration
This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.
org/)

This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This product includes
software written by Tim Hudson (tjh@cryptsoft.com).

27.3 Third-Party Libraries
IC-Web uses third-party libraries that come with the following licenses:

Library License Copyright Year Copyright Owner

GeoJson.js MIT 2019 Casey Cesari

DateJS Apache License 2.0 2008-2015 Object.NET, Inc.

Plotly.js MIT 2022 Plotly, Inc

String Natural Com-
pare

MIT 2015-2016 Nathan Woltman

three.js MIT 2010-2023 three.js authors

NPM packages See legal.npm.licenses for information about licenses and copyright notices for each library
included.

Find below the relevant copyright notices. For each library, you can substitute the <Year> and <Copyright Owner>
values with the data provided above.
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27.3.1 Apache License 2.0
Copyright <Year> <Copyright Owner>

Licensed under the Apache License, Version 2.0 (the “License”); you may not use this file except in compliance with
the License. You may obtain a copy of the License at

https://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software distributed under the License is distributed on an
“AS IS” BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied. See the
License for the specific language governing permissions and limitations under the License.

27.3.2 MIT License
Copyright (c) <Year> <Copyright Owner>

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documen-
tation files (the “Software”), to deal in the Software without restriction, including without limitation the rights to use,
copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom
the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the
Software.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PAR-
TICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT
HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION
OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFT-
WARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.
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Ad Hoc Event
A record created when an observation is logged using an ad hoc task. Each ad hoc event appears as a separate
entry in an inspector’s task list, while the original ad hoc task remains available for future use. Multiple ad
hoc events can be recorded against the same ad hoc task, allowing inspectors to document related observations
efficiently.

Ad Hoc Task
A task that is not assigned to a specific inspector but is available for use as needed. These tasks are created
by engineers or work planners and linked to specific workpacks. If an inspector has an assigned task within a
workpack, any related ad hoc tasks will also appear in their task list. When inspectors create an event for an
ad hoc task and complete it, the ad hoc task stays in their list and they can create new and multiple events for
that. Ad hoc tasks are useful, for example, for recording events like a damage, where inspectors must record any
damage they see, even if it’s not part of their assigned tasks.

Anomaly
A record that represents a highlighted item of concern on the asset, which has deviated from the intended design
or changes the risk and therefore requires to be remediated. You can add actions to associated anomalies within
NEXUS and assign completion dates to ensure anomalies are being remediated.

Asset Information Group (AIG)
A form that stores attributes associated with an asset. The visibility of AIGs against each asset is determined
based on the asset type of the asset and whether this AIG has been assigned to this asset type. Typically, risk
assessment information is stored in AIGs. The relationship between an asset and an AIG is 1-to-1.

Asset Tree
A hierarchy of asset nodes where each asset node represents an individual asset and stores all data related to
that specific asset. Each asset node has a single direct parent, and may have multiple children or siblings in the
hierarchy. You can build several asset trees and switch between them by selecting the relevant asset view.

Electronic Corrosion Engineer (ECE)
A tool provided by Wood that assists corrosion engineers through the quantitative estimation of corrosion rates
and selection of corrosion-resistant materials.

Event
An inspection observation or measurement, or a record of a type of inspection or observation on a specific asset.
The attributes of an event are configurable and can be aggregated. Its values can be used, for example, to calculate
risks. You can import events in bulk, add them manually or create them from Tasks using IC-Inspector.

Expert System
Predefined database configurations that clients can subscribe to. Expert system databases are maintained by
Wood engineers in-house and are kept up-to-date in line with the latest codes, standards and industry best prac-
tices. Once subscribed, clients can get the expert system configurations or their new versions imported into their
own databases and can customize them as required.
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Failure Mode Effect and Criticality Analysis (FMECA)
An analytical tool that helps the identification and evaluation of a system’s potential failures.

Field
Single data point or attribute in an AIG or Event table. The value of the field can be defined by the user or
calculated dynamically by the system. Each AIG and event consists of one or more fields.

Finding
A record created to highlight possible concerns or significant observations associated with an event. Each finding
is reviewed to determine if it has to be escalated and linked to an anomaly or it remains an observation on the
source event. A finding can be raised on each event in NEXUS.

Fitness-for-Service (FFS)
An assessment used to determine whether an equipment or a structure is suitable for its intended use and is fit to
continue operation.

Global Table
A configuration lookup table in NEXUS that does not have any referential integrity to any other data objects (for
example, assets, workpacks). It is primarily used to store lookup values in drop-down lists.

Integrity Operating Window (IOW)
Sets of limits that ensure the safe operation of equipments and acceptable levels of equipment degradation to
meet reliability expectations.

Library Item
A record that stores document metadata. Library items are electronic documents that can be linked to data and
data types in NEXUS IC. Library item documents can be uploaded in the NEXUS IC library or linked using a
URL.

Planning Task
A task in a planning template. Once a planning template is applied, a planning task becomes a task in a workpack.

Planning Template
A record that allows you to set up future workpacks and tasks. Once a planning template is applied, tasks in that
planning template are created and assigned to a workpack.

Risk-Based Inspection (RBI)
A risk assessment and management process that aims to manage the risks of equipment failure through methods
and inspection plan optimisation.

Reliability-Centred Maintenance (RCM)
A customised maintenance methodology that aims to optimise maintenance programs through the analysis of
potential failure modes and their impact on system performance.

Shortcut
Shortcuts in NEXUS IC are sequences of actions that users can activate with a single menu item click.

Task
Represents the requirement for a specific inspection activity (event) to be carried out on a specific asset. Tasks
are usually created by an integrity engineer/work planner using NEXUS IC or IC-Web and are completed by
inspectors using IC-Inspector.

Sub Asset Information Group (Sub AIG)
A table within an AIG, which allows for a 1-to-many relationship between an asset and sub AIG rows.

Workpack
An umbrella record for a collection of events and tasks.
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